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Introduction

Introduction

Welcome, and thank you for selecting Fortinet products for your network.

The FortiADC family of application delivery controllers (ADC) optimizes the availability, user experience, performance
and scalability of enterprise application delivery.

An ADC is like an advanced server load balancer. An ADC routes traffic to available destination servers based on health
checks and load-balancing algorithms; full-featured ADC like FortiADC also improve application performance by
assuming some of the server task load. Server tasks that can be handled by the FortiADC appliance include SSL
encryption/decryption, WAF protection, Gzip compression, and routing processes, such as NAT.

Features

FortiADC uses Layer 4 and Layer 7 session information to enable an ADC policy and management framework for:

l Server load balancing
l Link load balancing
l Global load balancing
l Security

The FortiADC family includes physical appliances and virtual appliances.

Basic network topology

Your network routing infrastructure should ensure that all network traffic destined for the backend servers is directed to
the FortiADC appliance. Usually, clients access backend servers from the Internet through a firewall such as a FortiGate,
so the FortiADC appliance should be installed between your servers and the firewall.

Basic network topology on page 14 shows a basic Router Mode deployment.

Basic network topology
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Introduction

Note: The deployment topology might be different for global load balancing (GLB) or high availability (HA) clusters. Refer
to those chapters for a description of features and illustrations.

Scope

This document describes how to use the web user interface to:

l Get started with your deployment.
l Configure feature options.
l Configure network and system settings.
l Monitor the system.
l Troubleshoot issues.

The following topics are covered elsewhere:

l Appliance installation—Refer to theQuickStart Guide for your appliance model.
l Virtual appliance installation—Refer to the FortiADC-VM Install Guide.
l CLI commands—Refer to the FortiADC CLI Reference. In parts of this manual, brief CLI command examples or CLI
syntax are shown to help you understand how the web UI configuration pages are related to the CLI commands.
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What’s New

What’s New

FortiADC7.4.3 offers the following new features and enhancements:

Server Load Balancing

Auto Populate Real Servers

Introduced in FortiADC version 7.2.3, the Auto Populate Real Servers functionality is now supported in FortiADC7.4.3.
This allows you to auto-populate real servers using the real server's FQDN. When the real server has more than one IP
address for DNS server responses, the auto-populate feature allows FortiADC to automatically generate additional real
servers with these IP addresses.

Scripting

New load balancing command

The new LB:set_real_server() command allows you to specify a real server from the configured pool directly. It can be
called in the following events: HTTP_REQUEST, HTTP_DATA_REQUEST, BEFORE_AUTH, AUTH_RESULT,
PERSISTENCE, and POST_PERSIST.

Example for events with manual routing selection:

when HTTP_REQUEST {
debug("===>>============begin HTTP scripting============\n")
-- routing to set
sr = "test07"
s = LB:get_current_routing()
if (s == nil or s == "") then

debug("===>>set routing to be '%s'\n", sr)
LB:routing(sr)
s = sr

end
debug("===>>current routing: %s\n", s)

-- Real Server name
rs = "rs05"
ret = LB:set_real_server(rs)
if ret then

debug("LB:set_real_server(%s) Success.\n", rs);
else
debug("LB:set_real_server(%s) Failed.\n", rs);
end
debug("===>>============end HTTP scripting============\n")

}

Example for events without manual routing selection:
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when PERSISTENCE {
debug("===>>============begin scripting============\n")
-- Real Server name
rs = "rs06"
ret = LB:set_real_server(rs)
if ret then

debug("set_real_server(%s) Success.\n", rs);
else
debug("set_real_server(%s) Failed.\n", rs);
end
debug("===>>============end scripting============\n")

}

New SSL command

The new SSL:disable() command allows you to disable SSL dynamically. This is useful when a virtual server supports
both SSL and non-SSL services. Disabling SSL only takes effect before the SSL handshake starts. On the client side,
the SSL will be disabled right after the TCP connection is established within the TCP_ACCEPTED event. On the server
side, SSL will be disabled before a real server connection has established, including the following events: HTTP_
REQUEST, BEFORE_AUTH, AUTH_RESULT, PERSISTENCE, POST_PERSIST, and SERVER_BEFORE_
CONNECT.

--Client side must be TCP ACCEPTED
when TCP_ACCEPTED {

debug("------> TCP accepted begin:\n");
srcIP = IP:client_addr();
srcPort = IP:client_port();
debug("------> Client ip:port %s:%s\n", srcIP, srcPort);

destIP = IP:local_addr();
destPort = IP:local_port();
debug("------> Local ip:port %s:%s\n", destIP, destPort);

if tonumber(destPort) == 80 then
ret = SSL:disable("clientside");
if ret then

debug("------> SSL disable clientside successfully.\n");
else

debug("------> SSL disable clientside failed.\n");
end

else
debug("------> SSL disable clientside skipped.\n");

end

debug("------> TCP accepted end.\n");
}

--Server side can be called within many events
when HTTP_REQUEST {

debug("------> HTTP Request begin:\n");
srcIP = IP:client_addr();
srcPort = IP:client_port();
debug("------> Client ip:port %s:%s\n", srcIP, srcPort);

destIP = IP:local_addr();
destPort = IP:local_port();
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debug("------> Local ip:port %s:%s\n", destIP, destPort);

if tonumber(destPort) == 80 then
ret = SSL:disable("serverside");
if ret then

debug("------> SSL disable serverside successfully.\n");
else

debug("------> SSL disable serverside failed.\n");
end

else
debug("------> SSL disable serverside skipped.\n");

end

debug("------> HTTP Request end.\n");
}

Enhanced TCP command

The TCP:sockopt() command has been enhanced to read the Client Address from the TCP socket option by adding the
"type" option that can get the information. This is useful for passing the original client IP to the server side after the client
IP has already gone through NAT.
Note: Currently only the GET operation is supported for "type".

when HTTP_REQUEST {
debug("============begin scripting.\n")

clientip = nil
t = {}
t["op"] = "get"
-- Set the custom TCP option type
t["type"] = 28
ret = TCP:sockopt(t)
if ret and (string.len(ret)>=4) then

debug("------> TCP get sockopt(%d): (returned %d bytes) successfully.\n", t["type"],
string.len(ret));

print_byte_array(ret)
clientip = binStrToIpAddress(ret)
debug("clientip = %s\n", clientip)

else
debug("------> TCP get sockopt(%d) failed.\n", t["type"])

end

if clientip then
res = HTTP:header_insert("X-Forwarded-For", clientip)
if res then

debug("------> Header inserted successfully.\n")
else

debug("------> Header failed to insert.\n")
end

end

debug("============end scripting.\n")
}

function binStrToIpAddress(binStr)
return tostring(string.byte(binStr,1)) .. "." .. tostring(string.byte(binStr,2)) ..
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"." .. tostring(string.byte(binStr,3)) .. "." .. tostring(string.byte(binStr,4))
end

function print_byte_array(s)
for i=1, string.len(s) do

debug("0x%x.", string.byte(s,i))
end
debug("\n")

end

Troubleshooting

Client URL support in CLI

New CLI commands have been added to support curl (Client URL) troubleshooting:

l execute curl allows you to set the Client URL.
l execute curl-option allows you to set the Client URL options listed in the following table.

Option Description

header Specify the curl header(s) or set as "auto". Multiple headers can be separated
by three colons,":::".

http-version Specify the HTTP version: 0.9, 1.0, 1.1, or 2. The default version is 1.1.

interface Specify the interface or IP, or set as "auto".

raw Enable this option to disable all internal HTTP decoding of content or transfer
encodings to allow them to pass unaltered in its "raw" form.

raw-data Specify the raw body data or set as "auto". The allowable content length is 1-
8192 characters.

reset Reset settings.

timeout Specify the connection timeout in seconds. Range is 1-120 seconds, and the
default is 10 seconds.

view-settings View the current options of the curl.

64-bit SNMP MIB ifXTable support for higher speed interfaces

FortiADC 7.4.3 introduces the new SNMPMIB ifXTable with 64-bit counters to allow users to query 10 G statistics.
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Key Concepts and Features

This section includes the following topics:

l Server load balancing on page 21
l Link load balancing on page 24
l Global load balancing on page 24
l Security on page 24
l High availability on page 25
l Virtual Domain (VDOM) and Administrative Domain (ADOM) on page 25

Server load balancing

Server load balancing (SLB) features are designed to give you flexible options for maximizing performance of your
backend servers. The following topics give an overview of SLB features:

l Feature summary
l Authentication
l Caching
l Compression
l Decompression
l Content rewriting
l Content routing
l Scripting
l SSL transactions

Feature summary

The table below summarizes server load balancing features.

Features Summary

Methods l Round robin
l Weighted round robin
l Least connections
l Fastest response
l Hash of URI, domain, host, destination IP

Health check Checks based on Layer 3, Layer 4, or Layer 7 data.

Server management l Warm up
l Rate limiting

Server load balancing features
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Features Summary
l Maintenance mode with session ramp down

Persistence Based on:
l Cookies
l TCP/IP header matches
l A hash of TCP/IP header values
l TLS/SSL session ID
l RADIUS attribute
l RDP Session Broker cookie
l SIP caller ID

Layer 7 Profiles: HTTP, HTTPS, HTTP Turbo, RADIUS, RDP, SIP, TCPS, SMTP, FTP, Diameter,
RTSP, RTMP, MySQL, MSSQL
Content routing: HTTP Host, HTTP Referer, HTTP Request URL, SNI hostname, Source IP
address
Content rewriting: URL redirect, 403 Forbidden, or HTTP request/response rewrite

Layer 4 Profiles: FTP, TCP, UDP
Content routing: Source IP address

Layer 2 Profiles: HTTP, HTTPS, TCP, TCPS, UDP
Note: Layer 2 load balancing is useful when the request’s destination IP is unknown and
you need to load balance connections between multiple next-hop gateways.

For detailed information, see Server Load Balance.

Authentication

FortiADC SLB supports offloading authentication from backend servers. The auth policy framework supports
authentication against local, LDAP, and RADIUS authentication servers, and it enables you to assign users to groups
that are authorized to access protected sites.

For configuration details, see Authentication Policy.

Caching

FortiADC SLB supports both static and dynamic caching. Caching reduces server overload, bandwidth saturation, high
latency, and network performance issues.

When caching is enabled for a virtual server profile, the FortiADC appliance dynamically stores application content such
as images, videos, HTML files and other file types to alleviate server resources and accelerate overall application
performance.

For configuration details, see Using caching features.
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Compression

FortiADC SLB supports compression offloading. Compression offloading means the ADC handles compression
processing instead of the backend servers, allowing them to dedicate resources to their own application processes.

When compression is enabled for a virtual server profile, the FortiADC system intelligently compresses HTTP and
HTTPS traffic. Reducing server reply content size accelerates performance and improves response times. FortiADC
supports both industry standard GZIP and DEFLATE algorithms.

For configuration details, see Configuring compression rules.

Decompression

FortiADC SLB also supports decompression of HTTP request body before sending it to the Web Application Firewall
(WAF) for scanning according to the content-encoding header. Upon receiving a compressed HTTP request body,
FortiADC first uses the zlib library to extract the HTTP body to a temporary buffer and then sends the buffer to the WAF
engine for scanning.

Content rewriting

FortiADC SLB supports content rewriting rules that enable you to rewrite HTTP requests and responses so that you can
cloak the details of your internal network. You can also create rules to redirect requests.

For configuration details and examples, see Using content rewriting rules.

Content routing

FortiADC SLB supports content routing rules that direct traffic to backend servers based on source IP address or HTTP
request headers.

For configuration details, see Configuring content routes.

Scripting

FortiADC SLB supports Lua scripts to perform actions that are not currently supported by the built-in feature set. Scripts
enable you to use predefined script commands and variables to manipulate the HTTP request/response or select a
content route. The multi-script support feature enables you to use multiple scripts by setting their sequence of execution.

For configuration details, see Using HTTP scripting.

SSL transactions

FortiADC SLB supports SSL offloading. SSL offloading means the ADC handles SSL decryption and encryption
processing instead of the backend servers, allowing the backend servers to dedicate resources to their own application
processes.
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SSL offloading results in improved SSL/TLS performance. On VMmodels, acceleration is due to offloading the
cryptographic processes from the backend server. On hardware models with ASIC chips, cryptography is also hardware-
accelerated: the system can encrypt and decrypt packets at better speeds than a backend server with a general-purpose
CPU.

FortiADC SLB also supports SSL decryption by forward proxy in cases where you cannot copy the server certificate and
private key to the FortiADC, either because it is impractical or impossible (in the case of outbound traffic to unknown
Internet servers).

For detailed information, see SSL Advanced Services.

Link load balancing

Link load balancing (LLB) features are designed to manage traffic over multiple ISP or WAN links. This enables you to
provision multiple links, resulting in reduced risk of outages and additional bandwidth to relieve traffic congestion.

For detailed information, see Link Load Balance.

Global load balancing

Global load balancing (GLB) makes your network reliable and available by scaling applications across multiple data
centers to improve application response times and be prepared for disaster recovery.

You can deploy DNS to direct traffic based on application availability and location.

For detailed information, see Global Load Balance.

Security

In most deployment scenarios, we recommend you deploy FortiGate to secure your network. Fortinet includes security
functionality in the FortiADC system to support those cases when deploying FortiGate is impractical. FortiADC includes
the following security features:

l Firewall—Drop traffic that matches a source/destination/service tuple you specify.
l Security connection limit—Drop an abnormally high volume of traffic from a source/destination/service match.
l IP Reputation service—Drop or redirect traffic from source IPs that are on the FortiGuard IP Reputation list.
l Geo IP—Drop or redirect traffic from source IPs that correspond with countries in the FortiGuard Geo IP database.
l Web application firewall—Drop or alert when traffic matches web application firewall attack signatures and
heuristics.

l AntiVirus—Provide protection against a variety of threats, including both known and unknown malicious codes
(malware) and Advanced Target Attacks (ATA).

l Denial of service protection—Drop half-open connections to protect the system from a SYN flood attack.

For detailed information, see Network Security.
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High availability

The FortiADC appliance supports high availability features like active-passive, active-active cluster, active-active-VRRP
cluster, failure detection, and configuration synchronization. High availability deployments can support 99.999% service
level agreement uptimes. For detailed information, see High Availability.

Virtual Domain (VDOM) and Administrative Domain (ADOM)

A Virtual Domain (VDOM) is a complete FortiADC instance that runs on the FortiADC platform. VDOM configuration
objects contain all of the system and feature configuration options of a full FortiADC instance and can be used to divide a
FortiADC into two or more virtual units that function independently, allowing it to support multi-tennant deployments.

The VDOM feature supports two Virtual Domain Modes that allow the VDOMs to function independently with its own
networking or as Administrative Domains (ADOMs) with shared networking between all ADOMs. When the VDOM is in
the Independent Network mode, you can provision an administrator account with privileges to access and manage only
their assigned VDOM. The VDOM user can then configure their VDOM as desired untethered to other VDOMs.
Alternatively, when the VDOM is in Share Network mode, it functions as an ADOM that shares the same networking
interfaces and routing between all the ADOMs. The ADOM functionality enables the administrator to constrain access
privileges to a subset of server load-balancing servers by defaulting all interface settings to the root ADOM. For detailed
information, see Virtual Domain.
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Getting Started

This section provides the basic workflow for getting started with a new deployment.

Basic steps:

1. Install the appliance.
2. Configure the management interface.
3. Configure the following basic network settings:

l New administrator password (required)
l System date and time
l Network interfaces
l DNS

4. Test connectivity.
5. Complete product registration, install your license, and update the firmware.
6. Configure a basic load balancing policy.
7. Test the deployment with load to verify expected behavior.
8. Back up this basic configuration so that you have a restore point.

Tips:
l Configuration changes are applied to the running configuration as soon as you
save them.

l Configuration objects are saved in a configuration management database. You
cannot change the name of a configuration object after you have initially saved
it.

l You cannot delete a configuration object that is referenced in another
configuration object (for example, you cannot delete an address if it is used in a
policy).

Step 1: Install the appliance

This Handbook assumes you have already installed the appliance into a hardware rack or the virtual appliance into a
VMware environment.

For information on hardware appliances, refer to the FortiADC hardware manuals.

For information on the virtual appliance, refer to the FortiADC-VM Install Guide.

To download these documents, go to:

http://docs.fortinet.com/fortiadc-d-series/hardware
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Step 2: Configure the management interface

You use the management port for administrator access. It is also used for management traffic (such as SNMP or syslog).
If your appliance has a dedicated management port, that is the port you configure as the management interface;
otherwise, it is the convention to use port1 for the management interface.

You configure the following basic settings to get started so that you can access the web UI from a remote location (like
your desk):

l Static route—Specify the gateway router for the management subnet so you can access the web UI from a host on
your subnet.

l IP address—You typically assign a static IP address for the management interface. The IP address is the host
portion of the web UI URL. For example, the default IP address for the management interface is 192.168.1.99 and
the default URL for the web UI is https://192.168.1.99.

l Access—Services for administrative access. We recommend HTTPS, SSH, SNMP, PING.

Before you begin:

l You must know the IP address for the default gateway of the management subnet and the IP address that you plan
to assign the management interface.

l You need access to the machine room in which a physical appliance has been installed. With physical appliances,
you must connect a cable to the management port to get started.

l You need a laptop with an RJ-45 Ethernet network port, a crossover Ethernet cable, and a web browser (a recent
version of Chrome or Firefox).

l Configure the laptop Ethernet port with the static IP address 192.168.1.2 and a netmask of 255.255.255.0. These
settings enable you to access the FortiADC web UI as if from the same subnet as the FortiADC in its factory
configuration state.

To connect to the web UI:

1. Use the crossover cable to connect the laptop Ethernet port to the FortiADCmanagement port.
2. On your laptop, open the following URL in your web browser:

https://192.168.1.99/
The system presents a self-signed security certificate, which it presents to clients whenever they initiate an HTTPS
connection to it.

3. Verify and accept the certificate, and acknowledge any warnings about self-signed certificates.
The system displays the administrator login page. See Login page on page 27.

Login page
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4. Enter the username admin and set up a new password.

The system displays the dashboard. See Dashboard after initial login on page 28.

Dashboard after initial login
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To complete the procedures in this section using the CLI:

1. Use an SSH client such as PuTTY to make an SSH connection to 192.168.1.99
(port 22).

2. Acknowledge any warnings and verify and accept the FortiADC SSH key.
3. Enter the username admin and create a new password.
4. Use the following command sequence to configure the static route:

config router static

edit 1

set gateway <gateway_ipv4>

end

end
5. Use the following command sequence to configure the management interface:

config system interface

edit <interface_name>

set ip <ip&netmask>

set allowaccess {http https ping snmp ssh telnet}

end

end
The system processes the update and disconnects your SSH session because
the interface has a new IP address. At this point, you should be able to connect
to the CLI from a host on the management subnet you just configured. You can
verify the configuration remotely.

Step 3: Configure basic network settings

The system supports network settings for various environments.

To get started, you configure the following basic settings:

l Administrator password—You must change the password for the admin account.
l System date and time—We recommend you use NTP to maintain the system time.
l Network interfaces—You must configure interfaces to receive and forward the network traffic to and from the
destination servers.

l DNS—You must specify a primary and secondary server for system DNS lookups.

Before you begin:

l You must know the IP address for the NTP servers your network uses to maintain system time.
l You must know the IP addresses that have been provisioned for the traffic interfaces for your FortiADC deployment.
l You must know the IP address for the primary and secondary DNS servers your network uses for DNS resolution.
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To change the admin password:

1. Go to System > Administrator to display the configuration page.

2. Double-click the key icon in the row for the user admin to display the change password editor. See System
administrator change password editor on page 30.

3. Change the password and save the configuration.

For detailed information on configuring administrator accounts, see Managing administrator users on page 197.

System administrator change password editor

CLI commands:
FortiADC-VM # config system admin
FortiADC-VM (admin) # edit admin
FortiADC-VM (admin) # set password <string>
Current password for 'admin':
FortiADC-VM (admin) # end

To configure system time:

1. Go to System > Settings.
2. Click theMaintenance tab to display the configuration page. See System time configuration page on page 30.
3. Enter NTP settings and save the configuration.

For detailed information, see Configuring system time.

System time configuration page
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CLI commands:
config system time ntp
set ntpsync enable
set ntpserver {<server_fqdn> | <server_ipv4>}
set syncinterval <minutes_int>
end

Or use a command syntax similar to the following to set the system time manually:

config system time manual
set zone <timezone_index>
set daylight-saving-time {enable | disable}
end
execute date <MM/DD/YY> <HH:MM:SS>

To configure network interfaces:

1. Go to Networking > Interface to display the configuration page.
2. Double-click the row for port2, for example, to display the configuration editor. See Network interface configuration

page on page 31.
3. Enter the IP address and other interface settings and save the configuration.

For detailed information, see Configuring network interfaces.

Network interface configuration page
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CLI commands:
config system interface

edit <interface_name>

set ip <ip&netmask>

set allowaccess {http https ping snmp ssh telnet}

end

end

To configure DNS:

1. Go to System > Settings to display the Basic configuration page. See  DNS configuration page on page 32.
2. Enter the IP address for a primary and secondary DNS server; then save the configuration.

For detailed information on configuring DNS, refer to the online help or see Configuring basic system settings.

 DNS configuration page
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CLI commands:
config system dns

set primary <address_ipv4>

set secondary <address_ipv4>

end

Step 4: Test connectivity to destination servers

Use ping and traceroute to test connectivity to destination servers.
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To test connectivity from the FortiADC system to the destination server:

Run the following commands from the CLI:

execute ping <destination_ip4>

execute traceroute <destination_ipv4>

To test connectivity from the destination server to the FortiADC system:

1. Enable ping on the network interface.
2. Use the ping and traceroute utilities available on the destination server to test connectivity to the FortiADC network

interface IP address.

For troubleshooting tips, see Troubleshooting.

Step 5: Complete product registration, licensing, and upgrades

Your new FortiADC appliance comes with a factory image of the operating system (firmware). However, if a new version
has been released since factory imaging, you might want to install the newer firmware before continuing the system
configuration.

Before you begin:

l Register—Registration is required to log into the Fortinet Customer Service & Support site and download firmware
upgrade files. For details, go to http://kb.fortinet.com/kb/documentLink.do?externalID=12071.

l Check the installed firmware version—Go to the dashboard. See Step 5: Complete product registration, licensing,
and upgrades on page 34.

l Check for upgrades—Major releases include new features, enhancements, and bug fixes. Patch releases can
include enhancements and bug fixes.

l Download the release notes at http://docs.fortinet.com/fortiadc-d-series/.
l Download firmware upgrades at https://support.fortinet.com/.

To upgrade your license:

1. Go to the System > FortiGuard.
2. Under Status, click Upgrade License to upload or locate the license file.

To upgrade your firmware:

1. Go to the System > FortiGuard.
2. On theMaintenance tab, navigate to the Firmware section.
3. Click Upgrade Firmware.

For detailed information, refer to the online help or see Updating firmware.
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Validating a VM license with no internet connection

If a FortiADC-VM is in a standalone environment with no Internet connection, it will not be able to connect to the
FortiGuard Distribution Network (FDN) to validate its license. To validate the license of a standalone FortiADC-VM with
no Internet connection, you must configure the FortiADC-VM to send the license request to a proxy server that is
connected to the Internet. The proxy server will then send the license request to the FDN and return the license status to
the FortiADC-VM.

Before you begin, you must:

l Have a proxy server connected to the Internet.
l Have Read-Write permission for System settings.

To configure a proxy server to validate a FortiADC-VM license:

1. Go to System > FortiGuard.
2. Under the Update Schedule pane, find the edit function (pencil icon) on the top right.
3. Go into the window enable Tunneling status.
4. Complete the configuration as described in the table below.

Settings Guidelines

Tunneling address Enter the IP address of the proxy server.

Tunneling port Enter the port of the proxy server.

Tunneling
username

If access control is enabled on the proxy server, enter the proxy server's username.

Tunneling password If access control is enabled on the proxy server, enter the proxy server's password.

Proxy server configuration

5. Click Save.

You can also configure the FortiADC-VM to communicate with the proxy server using the CLI. For more information, see
the CLI Reference:

http://docs.fortinet.com/fortiadc-d-series/reference

Step 6: Configure a basic server load balancing policy

A FortiADC server load balancing policy has many custom configuration options. You can leverage the predefined health
check, server profile, and load balancing method configurations to get started in two basic steps:

1. Configure the real servers and the real server pool.
2. Configure the virtual server features and options.

For complete information on server load balancing features, start with Server load balancing basics.
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To configure the real server and server pool:

1. Go to Server Load Balance > Real Server Pool and click the Real Server tab to display the configuration page.
2. Click Create New to display the configuration editor. See Real server configuration page on page 36
3. Complete the configuration and click Save. Repeat the steps to create more real servers as needed.
4. Click the Real Server Pool tab to display the configuration page.
5. Click Create New to display the configuration editor. See Step 6: Configure a basic server load balancing policy on

page 35Real server configuration page on page 36
6. Complete the configuration and click Save.
7. Under Member, click Create New to display the Edit Member configuration editor. See Real server pool member

configuration page on page 37.
8. Complete the member configuration and click Save.

For detailed information, refer to the online help or see Using real server pools on page 448 and Configuring real servers
on page 454

Real server configuration page

  Real server pool basic configuration page
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Real server pool member configuration page
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To configure the virtual server:

1. Go to Server Load Balance > Virtual Server to display the configuration page.
2. Click Create New to display the configuration editor. Choose between Advanced Mode and Basic Mode. See

  Virtual server configuration page on page 38.
3. Complete the configuration and click Save.

For detailed information, refer to the online help or see Configuring virtual servers.

  Virtual server configuration page

Step 7: Test the deployment

You can test the load balancing deployment by emulating the traffic flow of your planned production deployment.  Basic
network topology on page 38 shows a basic network topology.

 Basic network topology
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To test basic load balancing:

1. Send multiple client requests to the virtual server IP address.
2. Go to the dashboard to watch the dashboard session and throughput counters increment.
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3. Go to Log & Report > Log Browsing > Event Log > Health Check to view health check results.
4. Go to Log & Report > Log Browsing > Traffic Log > SLB HTTP (for example) to view traffic log. It includes throughput

per destination IP address.
5. Go to Log & Report > Report to view reports. It has graphs of top N policies and servers.

Step 8: Back up the configuration

Once you have tested your basic installation and verified that it functions correctly, create a backup. This “clean” backup
is a reference point that has many benefits, including:

l Troubleshooting—You can use a diff tool to compare a problematic configuration with this baseline configuration.
l Restarting—You can rapidly restore your system to a simple yet working point.
l Rapid deployment—You can use the configuration file as a template for other FortiADC systems. You can edit use
any text editor to edit the plain text configuration file and import it into another FortiADC system. You should change
unique identifiers, such as IP address and sometimes other local network settings that differ from one deployment to
another.

To backup the system configuration:

1. Go to System > Settings.
2. Click the Backup & Restore tab to display the backup and restore page.
3. Click Back Up.

For detailed information, refer to the online help or see Backing up and restoring configuration.
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Dashboard

The default Dashboard page opens when you log into the system root (or a virtual domain). You can also navigate to the
Dashboard from any other pages of the GUI by selecting Dashboard > Main on the navigation bar.

This section covers the following topics:

l Widgets on page 41
l Dashboard management tools on page 42

Widgets

The default Dashboard page displays a collection of 13 widgets, which fall into three categories: Information,
Configuration, and Statistics.

The following table highlights the information contained in each of the widgets.

Widget Category Description and Utilities

System Info Information Lists the following information about the system:
l Hostname
l Serial Number
l Firmware version, build number, and version
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Widget Category Description and Utilities

maturity (Feature or Mature).
Feature— New features are included in this version.
Mature— This version primarily includes bug fixes
and/or vulnerability patches, and no new or major
features.

l System Time
l Up Time

License Info Information Lists the FortiGuard Service Licenses and their status.

HA Info Information Lists the information about the HA Cluster.

Interface Summary Configuration Shows type, name, mode, IP address, status and allowed
forms of access for each port, as well as its virtual
domain.

Virtual Server Summary Configuration Shows the status of your virtual servers, including health,
throughput, and pool number.

Security Fabric Configuration Shows the Security Fabric connectors and their
connection status.

System Event Statistics Shows the number of system events that has occurred
within a specified interval.

Log Event Statistics Tells you how many emergencies, alerts, and warnings,
etc., that are going on.

Resources Usage Statistics Shows the resource usage in percentage for CPU, RAM,
and Disk.

Server Load Balance Statistics Shows your throughput, concurrent, and connections,
while displaying the inbound/outbound throughput as a
graph.

Security Logs Statistics Shows the number of security events that has triggered
the WAF within a specified interval.

OWASP Top 10 Threats Statistics Shows the OWASP Top 10 Threats that has been
detected within a specified interval.

Global Load Balance Statistics Shows the host and response per second.

Click See Detail to see more, it should show up when you hover over the widget.

Dashboard management tools

When you click the Dashboard bar on the very left column, it will drop down and likely show the default dashboard,Main.

Dashboard pop-up list menu
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Adding a dashboard

This option allows you to create your own dashboard with widgets of your choice.

To add a custom dashboard:

1. Click Create Dashboard.
2. Specify a unique name for the dashboard.
3. Click save. The name of the dashboard appears under Dashboard>Main on the navigation bar.

Editing a dashboard

Note: This option only applies to custom dashboards that you have created. The Main (default) dashboard cannot be
edited.

To edit a custom dashboard:

1. On the navigation bar, select the name of the dashboard.

2. Hover over the dashboard until you see the gear icon appear in the bottom right corner. Click to view the
dashboard modification options.

3. Click Edit to display the dashboard editor.
4. Rename the dashboard, if you like. (Note: If you change the name, be sure to click the Save button.)

FortiADC Handbook 43
Fortinet Technologies Inc.



Dashboard

Deleting a dashboard

Note: This option only applies to custom dashboards that you have created. The Main (default) dashboard cannot be
deleted.

To delete a custom dashboard:

1. On the navigation bar, select the name of the dashboard.

2. Hover over the dashboard until you see the gear icon appear in the bottom right corner. Click to view the
dashboard modification options.

3. Click Delete as shown in the illustration above.
4. Read the warning message onscreen.
5. Click Delete if you've decided to remove the selected dashboard.

Adding Features

Note: You can add onto the dashboard various summaries and reports, say, on Server Load Balance, thus allowing you
to have 'one look' at many of the FortiADC's features.

To add or remove features: 

1. On the navigation bar, select the name of the dashboard.

2. Hover over the dashboard until you see the gear icon appear in the bottom right corner. Click to view the
dashboard modification options.
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3. Click Edit to display the dashboard editor.

4. Decide which widget to display on the dashboard by selecting or deselecting the widget name.
5. Click Save when done.
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Security Fabric

The Fortinet Security Fabric provides an intelligent architecture that interconnects discrete security solutions into an
integrated whole to detect, monitor, block, and remediate attacks across the entire attack surface. All elements in the
Security Fabric work together as a team to share policy, threat intelligence, and application flow information that expand
network visibility to provide fast threat detection in real time and the ability to initiate and synchronize a coordinated
response, no matter which part of the network is being compromised.

This section describes the following topics:

l Automation on page 46— Automation Stitches pair an event trigger with one or more actions to monitor the network
and take the designated actions automatically when the Security Fabric detects a threat.

l Fabric connectors on page 81— Fabric connectors provide integration with Fortinet products to automate the
process of managing dynamic security updates without manual intervention.

l External connectors on page 94— External connectors provide integration with public and private cloud solutions to
ensure changes to cloud environment attributes are automatically updated in the Security Fabric.

Automation

Automation Stitches automate the activities between the different components in the Security Fabric, which decreases
the response times to security events. Events from any source in the Security Fabric can be monitored, and action
responses can be set up to any destination.

An automation stitch consists of two parts: the trigger and the actions. The trigger is the condition or event on the
FortiADC that activates the action, for example, a specific log or a failed login attempt. The action is what the FortiADC
does in response to the trigger. This allows you to monitor your network and take appropriate action when a threat is
detected by automating certain actions in response to certain triggers. For example, you can automate alert emails to be
sent in response to specific security events, which allows for far more granular log-based alerting than Alert Emails
configured under the Log & Report settings.

This section includes:

l Creating automation stitches
l Configuring Automation Triggers on page 58
l Configuring Automation Actions on page 71
l Diagnose commands

Creating automation stitches

Automation stitches pair a trigger with one or more response actions to allow FortiADC to automatically respond with the
action(s) once the trigger condition is met.

From the GUI, Security Fabric > Automation page, you can create an automation stitch by selecting a Trigger event
type and the corresponding Action that you would like to automate from the same configuration editor.

FortiADC supports eight trigger event types and six response actions for automation.
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l Triggers: Security Events, SLB Metrics, Period Block IP, HA Failover, SystemMetrics, System Events, Interface
Metrics, Schedule and FortiADC Log.

l Actions: CLI Script, Email, Syslog, SNMP Trap, Webhook, and FortiGate IP Ban.

However, some response actions are only supported for certain trigger types. The table below lists each trigger type and
their available response actions.

Security
Events

SLB
Metrics

Period
Block
IP

HA
Failover

System
Metrics

System
Events

Interface
Metrics

Schedule FortiADC
Log

CLI
Script

Email

Syslog

SNMP
Trap

Webhook

FortiGate
IP Ban

FortiADC offers Predefined Automation Stitch configurations on page 54 you can use to get started.

Before you begin:

l You must have Global Administrator access. Ensure that your admin account settings hasGlobal Admin set to
Yes. For more information, see Creating administrator users on page 199.

To configure an automation stitch:

1. Go to Security Fabric > Automation.
The configuration page displays the Stitch tab.
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2. Click Create New to display the configuration editor.

3. Configure the following settings for the Automation Stitch:

Setting Description

Name Enter a name for the new automation stitch. The configuration name cannot be
edited once it has been saved.

Status Enable/disable the automation stitch.

Egress VDOM The Egress VDOM determines the VDOM from which the alert packets will be
sent, regardless of the local VDOM from which the automation is configured.
This affects automation actions that require alert packets to be sent, which
include Syslog, SNMP Trap, Webhook, and Email. Actions such as Syslog,
SNMP Trap, andWebhook can egress from either the local or root VDOM.
However, for Email actions, the Egress VDOMmust be Root to correspond
with the SMTP server configured in Global Settings.
Select the Egress VDOM from which the alert packets will be sent:
l Local — Alert packets will be sent from the local VDOM from which the
automation is configured.

l Root — Alert packets will be sent from the Root VDOM.

4. Under the Stitch section, click Add Trigger to select an Automation Trigger event and configure the settings
specific to each trigger event type. Some trigger events are predefined while some trigger events are user-defined.

FortiADC Handbook 48
Fortinet Technologies Inc.



Security Fabric

For example, the System Event trigger provides a list of predefined system events for selection, whereas the SLB
Metrics trigger requires users to define the alert metrics. For details about each trigger event type, see Configuring
Automation Triggers on page 58.

Trigger Description

Security Events

Apply to Select whether to apply the security events automation stitch to All or VS:
l All — All related events will trigger the Alert action.
l VS—Only specified Virtual Server related events will trigger the Alert action.

Virtual Server The Virtual Server option appears if Apply to is VS.
Specify the virtual server. This is required.

Event Select the security events (such as DDoS SYNFLOOD attack start, bot detected,
etc.) that will trigger the action. The list of available security events is predefined. For
details, see Configuring Automation Triggers on page 58.

Advanced Settings Click Advanced Settings to display additional settings for Rolling Window.

Rolling Window Enable to define a Rolling Window Time and Number of Occurence.
The Rolling Window Time sets a period of time in which a number of events must
take place for an action to be triggered. The number of events that must take place
within this period of time is set in the Number of Occurrences option.
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Trigger Description

Rolling Window Time The Rolling Window Time option appears if Rolling Window is enabled.
Specify the range of time (in seconds) for the rolling window.

Number of Occurrences The Number of Occurrences option appears if Rolling Window is enabled.
Specify the number of events that must take place before FortiADC will trigger the
action.

SLB Metric

Alert Select a user-defined Alert trigger or create a new alert trigger for SLB Metrics. For
details, see Configuring Automation Triggers on page 58.

Period Block IP

Period Block IP Select this trigger to retrieve the Source IP addresses from the Period Block list.

HA Failover

Event Select the HA failover events (such as HA peer lost) that will trigger the action. The
list of available HA failover events is predefined. For details, see Configuring
Automation Triggers on page 58.

Advanced Settings Click Advanced Settings to display additional settings for Rolling Window.

Rolling Window Enable to define a Rolling Window Time and Number of Occurence.
The Rolling Window Time sets a period of time in which a number of events must
take place for an action to be triggered. The number of events that must take place
within this period of time is set in the Number of Occurrences option.

Rolling Window Time The Rolling Window Time option appears if Rolling Window is enabled.
Specify the range of time (in seconds) for the rolling window.

Number of Occurrences The Number of Occurrences option appears if Rolling Window is enabled.
Specify the number of events that must take place before FortiADC will trigger the
action.

System Metrics

Alert Select a user-defined Alert trigger or create a new alert trigger for SystemMetrics.
For details, see Configuring Automation Triggers on page 58.

System Events

Apply to Select whether to apply the system events automation stitch to All, VS or Real
Server:
l All — All related events will trigger the Alert action.
l VS—Only specified Virtual Server related events will trigger the Alert action.
l Real Server —Only the specified Virtual Server, Pool, and Real Server related
events will trigger the Alert action.

Virtual Server The Virtual Server option appears if Apply to is VS or Real Server.
Specify the virtual server. This is required if Apply to is VS.

Pool The Real Server option appears if Apply to is Real Server.
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Trigger Description

Specify the pool. This is optional.

Real Server The Real Server option appears if Apply to is Real Server.
Specify the real server. This is required.

Event Select the system events (such as bad PSU fan, good device fan, etc.) that will
trigger the action. The list of available System events is predefined. For details, see
Configuring Automation Triggers on page 58.

Advanced Settings Click Advanced Settings to display additional settings for Rolling Window.

Rolling Window Enable to define a Rolling Window Time and Number of Occurence.
The Rolling Window Time sets a period of time in which a number of events must
take place for an action to be triggered. The number of events that must take place
within this period of time is set in the Number of Occurrences option.

Rolling Window Time The Rolling Window Time option appears if Rolling Window is enabled.
Specify the range of time (in seconds) for the rolling window.

Number of Occurrences The Number of Occurrences option appears if Rolling Window is enabled.
Specify the number of events that must take place before FortiADC will trigger the
action.

Interface Metric

Alert Select a user-defined Alert trigger or create a new alert trigger for Interface Metrics.
For details, see Configuring Automation Triggers on page 58.

Schedule

Schedule Select a user-defined Alert trigger or create a new alert trigger for Schedule. For
details, see Configuring Automation Triggers on page 58.

FortiADC Log

Event Select a user-defined Event trigger or create a new alert trigger for FortiADC Log.
For details, see Configuring Automation Triggers on page 58.

5. ClickOK to commit the Automation Trigger selection and exit from the dialog.
Once an Automation Trigger has been selected, you can now add an automation response action.
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6. Under the Stitch section, Click Add Action to select a response action supported for the selected trigger event.
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Configure the settings specific to each response action. Each Action is user-defined. For details about each
response action, see Configuring Automation Actions on page 71.

7. Click OK to commit the Automation Action selection and exit from the dialog.
Once the first Automation Action has been added, you have the option to stitch more actions to the trigger.

8. Optionally, you can add a delay to trigger the response action, or delay between multiple response actions. After
adding an Automation Action to your Trigger or a second Action, the Add Delay option appears.
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Click Add Delay to specify the delay (in seconds) to trigger the response action or between multiple response
actions. The default is 0 second delay, and any configuration changes to the Trigger or Action in the stitch will set
the delay back to default.

9. ClickOK to save the Automation Stitch.
The newly created automation stitch appears on the Security Fabric > Stitch page, under its trigger event type.

After configuring the automation stitch, you may test it through CLI command diagnose debug module alertd.

Predefined Automation Stitch configurations

The following Automation Stitch configurations have predefined trigger events but no response actions selected. You
may clone these predefined configurations and use them as a template.

Name Type Trigger events

HA_Template HA Failover HA Peer Lost
HA Master Failover

Admin_Template System Events User Login
User Logout

Configuration_Template System Events Config Create
Config Delete
Config Update

System_basic_Template System Events Lost Log Disk
High CPU Usage
High Disk Usage
High Memory Usage
SSDMWI Near Threshold
SSDMWI Reached Threshold
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Name Type Trigger events

Health_check_Template System Events Real Server HC Down
Real Server HC Up
Virtual Server Down
Virtual Server Up
Gateway HC Down
Link Group HC Down
Gateway HC Up
Link Group HC Up
GLB Real Server Not Available
GLB Real Server Available
GLB Virtual Server Not Available
GLB Virtual Server Available
GLB GWNot Available
GLB GWAvailable

Certificate_Template System Events Certificate Expire

SNMP_sys_event_Template System Events High CPU Temp
Normal CPU Temp
High Device Temp
Normal Device Temp
High PSU Temp
Normal PSU Temp
Slow PSU Fan
Slow Device Fan
Bad PSU Fan
Good PSU Fan
Bad Device Fan
Good Device Fan
High Voltage
Low Voltage
High Power Supply
Low Power Supply
High PSU Voltage
Low PSU Voltage
PSU Failure
Lost Log Disk
High CPU Usage
High Disk Usage
High Memory Usage
SSDMWI Near Threshold
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Name Type Trigger events

SSDMWI Reached Threshold
Device Rebooted
Device Upgrade Completed
User Login
User Logout
ARP Conflict
Logical Interface Up
Logical Interface Down
Logical Interface Disabled
Log Full
FW SNAT Port Exhausted
Real Server HC Down
Real Server HC Up
Real Server Enabled
Real Server Disabled
Real Server Maintain Mode
Real Server Connection Rate Start
Real Server Connection Rate Stop
Real Server Connection Limit Start
Real Server Connection Limit Stop
Virtual Server Down
Virtual Server Up
Virtual Server Enabled
Virtual Server Disabled
Virtual Server Maintain Mode
Virtual Server Connection Rate Start
Virtual Server Connection Rate Stop
Virtual Server Connection Limit Start
Virtual Server Connection Limit Stop
Virtual Server Transaction Rate Start
Virtual Server Transaction Rate Stop
Virtual Server IP Pool Limit
Certification Expire
Gateway HC Down
Link Group HC Down
Gateway HC Up
Link Group HC Up
Gateway Inbound Bandwidth
Gateway Outbound Bandwidth
Gateway Inbound Spillover
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Name Type Trigger events

Gateway Outbound Spillover
Gateway Total Spillover
GLB Real Server Not Available
GLB Real Server Available
GLB Virtual Server Not Available
GLB Virtual Server Available
GLB GWNot Available
GLB GWAvailable
Config Create
Config Delete
Config Update
OCSP Response Expires
SSL Certificate Revoked
CRL Expires

SNMP_sec_event_Template Security Events DDoS SYNFLOOD attack start
DDoS SYNFLOOD attack stop
Request Blocked
XSS Attack Detected
SQL Injection Attack Detected
Generic Attack Detected
URL Pattern Violate Detected
Protocol Constraint Detected
Bot Detected
Geo Violate Detected
Reputation Violate Detected
Virtual Server Authentication Failed
JSON Violate Detected
XML Violate Detected
SOAP Violate Detected
Web Anti Defacement Detected
CSRF Violate Detected
Brute Force Detected
Data Leak Violate Detected
HTML Validation Detected
DDoS IP Fragmentation
DDoS TCP Slow Data Attack
DDoS TCP Access Flood
DDoS HTTP Connection Flood
DDoS HTTP Request Flood
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Name Type Trigger events

DDoS HTTP Access Limit
OPENAPI Violate Detected
CORS Violate Detected
SEC Threshold Violate Detected
SEC Biometrics Base Detected

SNMP_HA_event_Template HA Failover HA Peer Lost
HA Master Failover

Configuring Automation Triggers

On the Security Fabric > Automation > Trigger tab, you can view the list of available automation trigger events that
are predefined or user-defined. After defining your automation triggers, you can combine them with response actions to
create an automation stitch. For details, see Creating automation stitches on page 46

FortiADC supports eight trigger event types, wherein some events are predefined and some must be user-defined.

Predefined Triggers:

l Security Events — Uses security events such as "DDoS SYNFLOOD attack start" or "bot detected" as the alert
trigger.

l HA Failover — Uses HA failover events such as "HA peer lost" as the alert trigger.
l System Events — Uses system events such as "bad PSU fan" or "good device fan" as the alert trigger.

See Predefined automation trigger events on page 68 for the full list of predefined events available for each trigger type.

User-defined Triggers:

l SLB Metrics on page 59—Uses server load balance performance metrics as the alert trigger.
l Period Block IP—Uses the FortiADC Source IP addresses that have been blocked by WAF as trigger events for
the automated response actions. To view or release the blocked IPs, see Blocked IP on page 132.

l SystemMetrics on page 61—Uses systemmetrics such as "average CPU usage" or "average memory usage" as
the alert trigger.

l Interface Metrics on page 63—Uses network interface events as the alert trigger.
l Schedule on page 65—Uses user-defined schedules as the alert trigger.
l FortiADC Log on page 66—Uses a specific FortiADC logged event occurrence (identified through log ID) as the
alert trigger.
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Before you begin:

l You must have Global Administrator access. Ensure that your admin account settings hasGlobal Admin set to
Yes. For more information, see Creating administrator users on page 199.

SLB Metrics

To configure an SLB Metrics trigger alert:

1. Go to Security Fabric > Automation.
2. Click the Trigger tab.
3. Click Create New to display the Create New Automation Trigger configuration page.
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4. Under the System section, click SLB Metrics to display the configuration editor.

5. Configure the following trigger alert settings:

Setting Description

Name Enter a name for the new SLB Metrics trigger alert. The configuration name
cannot be edited once it has been saved.

Description Optionally, you can add a description about this trigger alert configuration.

SLB Instance Select the virtual server on which the SLB Metrics trigger applies.

Duration Specify the metric duration in seconds. Range: 5-3600 seconds.

6. ClickOK to commit the SLB Metrics trigger settings.
Once the SLB Metrics trigger alert configuration has been saved, you can then add the alert member configurations
under the Alert Metric Expire Member section.
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7. Under the Alert Metric Expire Member section, click Create New to display the configuration editor.

8. Configure the following trigger alert member settings:

Setting Description

Name Enter a name for the new SLB Metrics trigger alert member. The configuration
name cannot be edited once it has been saved.

Metric Occurs Select the server load balance performance metric events that will trigger the
action.

Comparator The metric is compared to the Value field according to the selected option:
l Ge—greater than
l Le—less than
l Eq—equal to

The action will be triggered if the specified value satisfies the selected option.

Value Specify the metric value that the Comparator uses to determine if the metric
triggers an action (for example, 2 milliseconds).

9. ClickOK to commit the trigger alert member settings.
The newly created trigger alert member is added under the Alert Metric Expire Member section.

10. ClickOK to save the SLB Metrics trigger alert configuration.

System Metrics

To configure a System Metrics trigger alert:

1. Go to Security Fabric > Automation.
2. Click the Trigger tab.
3. Click Create New to display the Create New Automation Trigger configuration page.
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4. Under the System section, click System Metrics to display the configuration editor.

5. Configure the following trigger alert settings:

Setting Description

Name Enter a name for the new SystemMetrics trigger alert. The configuration name
cannot be edited once it has been saved.

Description Optionally, you can add a description about this trigger alert configuration.

Duration Specify the metric duration in seconds. Range: 5-3600 seconds.

6. ClickOK to commit the SystemMetrics trigger settings.
Once the SystemMetrics trigger alert configuration has been saved, you can then add the alert member
configurations under the Alert Metric Expire Member section.
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7. Under the Alert Metric Expire Member section, click Create New to display the configuration editor.

8. Configure the following trigger alert member settings:

Setting Description

Name Enter a name for the new SystemMetrics trigger alert member. The
configuration name cannot be edited once it has been saved.

Metric Occurs Select the systemmetrics events (average CPU usage, average memory
usage, etc.) that will trigger the action.

Comparator The metric is compared to the Value field according to the selected option:
l Ge—greater than
l Le—less than
l Eq—equal to

The action will be triggered if the specified value satisfies the selected option.

Value Specify the metric value that the Comparator uses to determine if the metric
triggers an action (for example, 2 milliseconds).

9. ClickOK to commit the trigger alert member settings.
The newly created trigger alert member is added under the Alert Metric Expire Member section.

10. ClickOK to save the SystemMetrics trigger alert configuration.

Interface Metrics

To configure an Interface Metrics trigger alert:

1. Go to Security Fabric > Automation.
2. Click the Trigger tab.
3. Click Create New to display the Create New Automation Trigger configuration page.
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4. Under the System section, click Interface Metrics to display the configuration editor.

5. Configure the following trigger alert settings:

Setting Description

Name Enter a name for the new Interface Metrics trigger alert. The configuration
name cannot be edited once it has been saved.

Description Optionally, you can add a description about this trigger alert configuration.

Instance Select the network interface on which the Interface Metrics trigger applies.

Duration Specify the metric duration in seconds. Range: 5-3600 seconds.

6. ClickOK to commit the Interface Metrics trigger settings.
Once the Interface Metrics trigger alert configuration has been saved, you can then add the alert member
configurations under the Alert Metric Expire Member section.
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7. Under the Alert Metric Expire Member section, click Create New to display the configuration editor.

8. Configure the following trigger alert member settings:

Setting Description

Name Enter a name for the new Interface Metrics trigger alert member. The
configuration name cannot be edited once it has been saved.

Metric Occurs Select the network interface events that will trigger the action.

Comparator The metric is compared to the Value field according to the selected option:
l Ge—greater than
l Le—less than
l Eq—equal to

The action will be triggered if the specified value satisfies the selected option.

Value Specify the metric value that the Comparator uses to determine if the metric
triggers an action (for example, 2 milliseconds).

9. ClickOK to commit the trigger alert member settings.
The newly created trigger alert member is added under the Alert Metric Expire Member section.

10. ClickOK to save the Interface Metrics trigger alert configuration.

Schedule

To configure a Schedule trigger alert:

1. Go to Security Fabric > Automation.
2. Click the Trigger tab.
3. Click Create New to display the Create New Automation Trigger configuration page.
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4. Under theMiscellaneous section, click Schedule to display the configuration editor.

5. Configure the following trigger alert settings:

Setting Description

Name Enter a name for the new Schedule trigger alert. The configuration name
cannot be edited once it has been saved.

Description Optionally, you can add a description about this trigger alert configuration.

Schedule Occurs Select a user-defined schedule group object or create a new schedule group.
For details, see Schedule Group on page 313.

6. ClickOK.

FortiADC Log

You can configure a FortiADC Log trigger for when a specific event log ID occurs. You can select multiple event log IDs,
and apply log field filters.

Exact information from the Event Log is required to configure the FortiADC Log trigger alert, so it is recommended that
you download the specific log files to obtain the information prior to beginning the configuration.

To configure a FortiADC Log trigger alert:

1. Go to Security Fabric > Automation.
2. Click the Trigger tab.
3. Click Create New to display the Create New Automation Trigger configuration page.
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4. Under theMiscellaneous section, click FortiADC Log to display the configuration editor.

You can view the last 4 digits of the log ID by hovering over the event entry in the Log Event list.
5. Configure the following trigger alert settings:

Setting Description

Name Enter a name for the new FortiADC Log trigger alert. The configuration name
cannot be edited once it has been saved.

Description Optionally, you can add a description about this trigger alert configuration.

Event Select the FortiADC Log event (identified through the log ID) that will trigger
the automation stitch.
The Event options correspond to the Message listed in the FortiADC event log.
Hover over an entry to view the tooltip that includes the Log Event and Log ID.
The Log ID refers to the last 4 digits of the Log ID from the event log.
The maximum is 32 log events per trigger configuration.

Field Filters Enter the Field name and the Value of the logged event that will trigger the
automation stitch.
The Field name and Value refers to the "key" and its value as it is recorded in
the log file. To successfully trigger an automation stitch using the FortiADC
Log trigger alert, the field name and value must match what is recorded in the
log file exactly.
l Field name— Enter the field name as it appears exactly in the log file.
l Value— Specify the value of the specified field name as it appears
exactly in the log file.

6. ClickOK.

Example: Create a FortiADC Log trigger alert for failed logins

In this example, you will create a FortiADC Log alert to trigger when a login fails due to incorrect password input.

1. Download the required event log file to obtain the specific information to use in the FortiADC Log trigger
configuration.
a. Go to Log & Report > Event Log.
b. Locate the "Admin login" event log.
c. Download the log file.
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2. Open the log file to obtain the required information.

date=2023-12-13 time=10:28:41 log_id=0001001000 type=event subtype=admin pri=information
vd=root msg_id=32713167 user=admin ui=172.19.162.70 action=login status=failure
reason=passwd_invalid logdesc=Admin login msg=User admin login successfully from
172.19.162.70

Copy the log id and reason fields and their values to use in later steps.
3. Go to Security Fabric > Automation, click the Trigger tab and Create New.
4. Click FortiADC Log to configure a new FortiADC Log automation trigger using the event log information collected

earlier.

a. Select the Event as Log id admin login. The last 4 digits of the "log id" from the log file should match the "Log
ID" of the selected log event entry.

b. Enter the Field name as reason and Value as passwd_invalid.
c. Click OK.

Predefined automation trigger events

Trigger Events

Security Events Bot Detected
Brute Force Detected
CORS Violate Detected
CSRF Violate Detected
Data Leak Violate Detected
DDoS HTTP Access Limit
DDoS HTTP Connection Flood
DDoS HTTP Request Flood
DDoS IP Fragmentation
DDoS SYNFLOOD attack start
DDoS SYNFLOOD attack stop
DDoS TCP Access Flood
DDoS TCP Slow Data Attack
Generic Attack Detected
Geo Violate Detected
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Trigger Events

HTML Validation Detected
JSON Violate Detected
OPENAPI Violate Detected
Protocol Constraint Detected
Reputation Violate Detected
Request Blocked
SEC Biometrics Base Detected
SEC Threshold Violate Detected
SOAP Violate Detected
SQL Injection Attack Detected
URL Pattern Violate Detected
Virtual Server Authentication Fail
Web Anti Defacement Detected
XML Violate Detected
XSS Attack Detected

HA Failover HA Master Failover
HA Peer Lost

System Events Admin user login failed and blocked IP
ARP Conflict
Bad Device Fan
Bad PSU Fan
Certification Expire
Config Create
Config Delete
Config Update
CRL Expires
Device Rebooted
Device Upgrade Completed
FW SNAT Port Exhausted
Gateway HC Down
Gateway HC Up
Gateway Inbound Bandwidth
Gateway Inbound Spillover
Gateway Outbound Bandwidth
Gateway Outbound Spillover
Gateway Total Spillover
GLB GWAvailable
GLB GWNot Available
GLB Real Server Available
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Trigger Events

GLB Real Server Not Available
GLB Virtual Server Available
GLB Virtual Server Not Available
Good Device Fan
Good PSU Fan
High CPU Temp
High CPU Usage
High Device Temp
High Disk Usage
High Memory Usage
High Power Supply
High PSU Temp
High PSU Voltage
High Voltage
Link Group HC Down
Link Group HC Up
Log Full
Logical Interface Disabled
Logical Interface Down
Logical Interface Up
Lost Log Disk
Low Power Supply
Low PSU Voltage
Low Voltage
Normal CPU Temp
Normal Device Temp
Normal PSU Temp
OCSP Response Expires
PSU Failure
Real Server Connection Limit Start
Real Server Connection Limit Stop
Real Server Connection Rate Start
Real Server Connection Rate Stop
Real Server Disabled
Real Server Enabled
Real Server HC Down
Real Server HC Up
Real Server Maintain Mode
Slow Device Fan
Slow PSU Fan
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Trigger Events

SSDMWI Near Threshold
SSDMWI Reached Threshold
SSL Certificate Revoked
User Login
User Logout
Virtual Server Connection Limit Start
Virtual Server Connection Limit Stop
Virtual Server Connection Rate Start
Virtual Server Connection Rate Stop
Virtual Server Disabled
Virtual Server Down
Virtual Server Enabled
Virtual Server IP Pool Limit
Virtual Server Maintain Mode
Virtual Server Transaction Rate Start
Virtual Server Transaction Rate Stop
Virtual Server Up

Configuring Automation Actions

On the Security Fabric > Automation > Action tab, you can view the list of available automation response actions that
have been user-defined. After defining your automation actions, you can combine them with a trigger to create an
automation stitch. For details, see Creating automation stitches on page 46

FortiADC supports six response action types:

l SNMP Trap on page 72— Sends an SNMP trap to the specified server in response to the trigger. This action is not
supported for the Schedule trigger.

l FortiGate IP Ban on page 74— Blocks all traffic from the source IP addresses flagged by the FortiGate in response
to the trigger. This action can only be used with the Period Block IP trigger.

l Email on page 75— Sends a custom email notification in response to the trigger.
l CLI Script on page 77—Runs a CLI script in response to the trigger. This action is not supported for the Period
Block IP trigger.

l Webhook on page 78— Sends data to another application using a REST callback in response to the trigger.
l Syslog on page 80—Generates a syslog in response to the trigger.
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Before you begin:

l You must have Global Administrator access. Ensure that your admin account settings hasGlobal Admin set to
Yes. For more information, see Creating administrator users on page 199.

SNMP Trap

Use this action to send SNMP traps to the specified server in response to a trigger event.

To configure an SNMP Trap response action:

1. Go to Security Fabric > Automation.
2. Click the Action tab.
3. Click Create New to display the Create New Automation Action configuration page.
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4. Under the Security Response section, click SNMP Trap to display the configuration editor.

5. Configure the following response action settings:

Setting Description

Name Enter a name for the new SNMP Trap action. The configuration name cannot be edited
once it has been saved.

Hosts Specify the IP address that will receive this message.

Version Select the SNMP version to use
l v1
l v2c
l v3

Note:
If using the System Event trigger Admin user login failed and blocked IP, it is
recommended to use SNMPv2 or SNMPv3 only. When using SNMPv1 with the Admin
user login failed and blocked IP system event trigger, the event is not recorded on the
SNMP client even when the SNMP action is triggered successfully. Whereas the SNMP
client records using SNMPv2 or SNMPv3 both properly reflect the triggered action for
Admin user login failed and blocked IP event.

Local Port Specify the source port number. Default: 162 Range: 0-65535

Remote Port Specify the destination port number. Default: 162 Range: 0-65535

Security Level The Security Level option is available if v3 is selected for Version.
The SNMP security level to use:
l Auth But no Privacy
l Auth And Privacy
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Setting Description

l No Privacy

Auth Algorithm The Auth Algorithm option is available if Auth But no Privacy or Auth And Privacy
is selected for Security Level.
The authentication algorithm to use:
l SHA1
l MD5

Auth Password The Auth Password option is available if Auth But no Privacy or Auth And Privacy
is selected for Security Level.
The password to the authentication algorithm.

Private Algorithm The Private Algorithm option is available if Auth And Privacy is selected for Security
Level.
The private algorithm to use:
l AES
l DES

Private Password The Private Password option is available if Auth And Privacy is selected for Security
Level.
The password to the private algorithm.

User Specify the User.

6. ClickOK.

FortiGate IP Ban

Use this action to block all traffic from the source addresses flagged by the FortiGate in response to the Period Block IP
trigger. See FortiGate IP Ban action for details.

To configure a FortiGate IP Ban response action:

1. Go to Security Fabric > Automation.
2. Click the Action tab.
3. Click Create New to display the Create New Automation Action configuration page.
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4. Under the Security Response section, click FortiGate IP Ban to display the configuration editor.

5. Configure the following response action settings:

Setting Description

Name Enter a name for the new FortiGate IP Ban action. The configuration name cannot be
edited once it has been saved.

Type Token

FortiGate Token Specify the FortiGate Token.
To get the token, log in to FortiGate, go to System> Administrator, create a new
REST API Administrator, then generate API key.

FortiGate URL Specify the IP address of the FortiGate URL. For example, https://10.106.155.107

6. ClickOK.

Email

Use this action to send a custom email notification in response to a trigger event.

To configure an Email response action:

1. Go to Security Fabric > Automation.
2. Click the Action tab.
3. Click Create New to display the Create New Automation Action configuration page.
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4. Under the Notifications section, click Email to display the configuration editor.

5. Configure the following settings:

Setting Description

Name Enter a name for the new Email action. The configuration name cannot be
edited once it has been saved.

From Specify the sender email address of this notification.

To Specify the recipient email address of this notification.

Email Subject Specify the email subject string.

Email Body Write the email message in the Email Body. Maximum 256 characters.
You can insert specific system data, such as parameters from logs or previous
action results by wrapping the parameter with %% tags to replace the
expression with the JSON value for that parameter.
There are 6 available Action Parameters:
l %%results%%— In automation stitches with more than one response
action, %%results%% inserts the complete result from the previous
action, such as a CLI Script action.

l %%alert_msg%%—The complete alert string will be inserted from the
event source when it happens, such as from the WAFmodule.

l %%metric_obj%%—Applicable to System trigger alerts (SLB Metrics,
SystemMetrics, and Interface Metrics), %%metric_obj%% inserts the
metric instance (port) and value that was configured in the trigger alert.

l %%block.srcip%%—The quarantined Source IP will be inserted when
the WAFmodule blocks the IP.

l %%event.srcip%%—The Source IP of the event will be inserted from the
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Setting Description

event source when it happens, such as from the WAFmodule.
l %%log_msg%%—Applicable to the FortiADC Log trigger alert, %%log_
msg%% inserts the complete log string from the log source when it
happens.

6. ClickOK.

CLI Script

Use this action to run a CLI script in response to a trigger event, such as to make appropriate configuration changes. The
scripts can be manually entered or uploaded as a file.

To configure a CLI Script response action:

1. Go to Security Fabric > Automation.
2. Click the Action tab.
3. Click Create New to display the Create New Automation Action configuration page.
4. Under theGeneral section, click CLI Script to display the configuration editor.

5. Configure the following response action settings:

Setting Description

Name Enter a name for the new CLI Script action. The configuration name cannot be
edited once it has been saved.

Script Manually enter or upload the script.
l To manually enter the script, type it into the Script field.
l To upload a script file, click Choose File and locate the file on your
management computer.

Maximum 256 characters.

6. ClickOK.
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Webhook

Use this action to send data to another application using a REST callback in response to a trigger event.

To configure a Webhook response action:

1. Go to Security Fabric > Automation.
2. Click the Action tab.
3. Click Create New to display the Create New Automation Action configuration page.
4. Under theGeneral section, clickWebhook to display the configuration editor.
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5. Configure the following response action settings:

Setting Description

Name Enter a name for the newWebhook action. The configuration name cannot be edited
once it has been saved.

Protocol Select the request protocol to use:
l HTTP
l HTTPS

Method Specify the request method:
l POST
l PUT
l GET
l PATCH
l DELETE

URL Specify the request URL. For example, 10.106.155.130:90/test

HTTP Body Specify the request body. For example, 'msg': 'abc', 'user': 'jack'
You can insert specific system data, such as parameters from logs or previous action
results by wrapping the parameter with %% tags to replace the expression with the
JSON value for that parameter.
There are 6 available Action Parameters:
l %%results%%— In automation stitches with more than one response action,
%%results%% inserts the complete result from the previous action, such as a CLI
Script action.

l %%alert_msg%%—The complete alert string will be inserted from the event
source when it happens, such as from the WAFmodule.

l %%metric_obj%%—Applicable to System trigger alerts (SLB Metrics, System
Metrics, and Interface Metrics), %%metric_obj%% inserts the metric instance
(port) and value that was configured in the trigger alert.

l %%block.srcip%%—The quarantined Source IP will be inserted when the WAF
module blocks the IP.

l %%event.srcip%%—The Source IP of the event will be inserted from the event
source when it happens, such as from the WAFmodule.

l %%log_msg%%—Applicable to the FortiADC Log trigger alert, %%log_msg%%
inserts the complete log string from the log source when it happens.

HTTP Header Specify the HTTP request header name and value.
For example, customerheader1:value1 customerheader2:value2
Ensure to only use space as the delimiter for multiple headers.

TLS Certificate The TLS Certificate option is available if the Protocol is HTTPS.
Select a TLS certificate to verify by the server to validate the HTTPS connection to the
webhook endpoint.
A valid TLS certificate is required if the HTTPS server is enabled for two-way
authentication. However, a TLS certificate is optional if the HTTPS server is not
enabled for two-way authentication.
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Setting Description

Verify Remote Host The Verify Remote Host option is available if the Protocol is HTTPS.
Enable to verify that the remote server matches the host URL using a CA certificate.
This option is disabled by default.

CA Certificate The CA Certificate option is available if the Protocol is HTTPS and Verify Remote
Host is enabled.
Select the CA certificate to use to verify the remote server. FortiADC will verify that the
IP or domain name matches in the Remote host field or the Subject alternative name
field in the certificate CN.

6. ClickOK.

Syslog

Use this action to generate a syslog message in response to a trigger event.

To configure a Syslog response action:

1. Go to Security Fabric > Automation.
2. Click the Action tab.
3. Click Create New to display the Create New Automation Action configuration page.
4. Under theGeneral section, click Syslog to display the configuration editor.

5. Configure the following response action settings:

Setting Description

Name Enter a name for the new Email action. The configuration name cannot be
edited once it has been saved.

Address Specify the IP address that will receive this message.

Port Specify the port that will receive this message. Range: 1-65535

6. ClickOK.
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Diagnose commands

To test an automation stitch, use the diagnose debug module alertd command.

For more information, see diagnose debug module in FortiADC CLI Reference.

Fabric connectors

You can use fabric connectors to integrate FortiADC with other Fortinet Security Fabric solutions:

l FortiSIEM Connector on page 81
l FortiAnalyzer Connector on page 82
l FortiSandbox Connector on page 86
l FortiADCManager Connector on page 87
l FortiGSLB Connector on page 91
l FortiClient EMS Connector on page 91

The fabric connectors define the type of connector and include information for FortiADC to communicate with and
authenticate with the products.

FortiSIEM Connector

When you create a connector for FortiSIEM, you are specifying how FortiADC can communicate with FortiSIEM for
pushing logs to FortiSIEM.

FortiADC will connect to FortiSIEM by UDP, TCP or TCP SSL depending on FortiSIEM connector setting.

Requirements:

l The FortiSIEM service is required to be exposed on External IP.

To create a FortiSIEM Connector:

1. Go to Security Fabric > Fabric Connectors.
2. Click Create New.
3. UnderOther Fortinet Products, select FortiSIEM.
4. Configure the following Syslog Server options, and then click Save.

Status Toggle on/off to enable/disable the Fabric Connector object.

Address Type the IP address of the FortiSIEM Log server.

Port Specify the port that FortiADC uses to communicate with the log server.

Proto Select the protocol used for log transfer from the following:
l UDP
l TCP
l TCP SSL

TCP Framing Select one of the following options:
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l Traditional
l Octet Counted

This field appears only if Proto is TCP or TCP SSL.

Log Level Select the severity level of the logs. All the exported logs will be attached with
the selected severity level.

CSV Enable to export the logs in .csv file.

Facility Select the source facility of the logs. We only support the local use facilities
which are not reserved and are available for general use.

Event Enable to export Event logs.

Traffic Enable to export Traffic logs.

Security Enable to export Security logs.

After the connector is created, FortiADC will push the logs to FortiSIEM server. The above configurations are also
available in Log&Report > Log Setting > Syslog Server.

FortiAnalyzer Connector

When you create a connector for FortiAnalyzer, you are specifying how FortiADC can communicate with FortiAnalyzer
for pushing logs to FortiAnalyzer. You can choose between two protocol types for sending logs to FortiAnalyzer: Syslog
or OFTP.

Using the Syslog protocol will allow FortiADC to connect to FortiAnalyzer by UDP, TCP or TCP SSL depending on the
FortiAnalyzer connector setting.

OFTP (Optimized Fabric Transfer Protocol) is used to synchronize information between FortiAnalyzer and other Fortinet
products. So, this is the recommended protocol to use for pushing logs to FortiAnalyzer.

Requirements:

l The FortiAnalyzer service is required to be exposed on External IP.

FortiADC supports integration with FortiAnalyzer versions 7.0.2 or later. As earlier
versions of FortiAnalyzer is not optimally compatible with FortiADC, unexpected
behavior may occur.

To create a FortiAnalyzer Connector:

1. Go to Security Fabric > Fabric Connectors.
2. Click Create New.
3. UnderOther Fortinet Products, click FortiAnalyzer to display the configuration editor.
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4. Configure the following Server Type settings:

Setting Description

Type Select either of the following options:
l Syslog— To send logs to FortiAnalyzer using the syslog protocol.
l FortiAnalyzer — To send logs to FortiAnalyzer using the OFTP.

Depending on your Type selection, either the Syslog Server or FortiAnalyzer configuration section will appear.
5. If the Server Type is Syslog, configure the following Syslog Server settings:

Setting Description

Status Enable/disable the Fabric Connector object.

Address Specify the IP address of the FortiAnalyzer Log server.

Port Specify the port that FortiADC uses to communicate with the log server.
This is the listening port number of the syslog server. Usually this is UDP port
514.

Proto Select the protocol used for log transfer from the following:
l UDP
l TCP
l TCP SSL

TCP Framing If Proto is TCP or TCP SSL, the TCP Framing options appear.
Select one of the following options:
l Traditional
l Octet Counted

Log Level Select the lowest severity to log from the following options:
l Emergency— The system has become unstable.
l Alert — Immediate action is required.
l Critical — Functionality is affected.
l Error — An error condition exists and functionality could be affected.
l Warning— Functionality might be affected.
l Notification— Information about normal events.
l Information—General information about system operations.
l Debug—Detailed information about the system that can be used to
troubleshoot unexpected behavior.

The exported logs will include the selected severity level and above. For
example, if you select Error, the system sends the syslog server logs with
level Error, Critical, Alert, and Emergency. If you select Alert, the system
collects logs with severity level Alert and Emergency.

CSV Enable to export the logs as a CSV file.

Facility Select the source facility of the logs. We only support the local use facilities
which are not reserved and are available for general use.

Event Enable/disable logging for events.
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Setting Description

Event Category If Event is enabled, the Event Category options appear.
Select one or more of the following event categories to include in the event
logs export:
l Configuration— Configuration changes.
l Admin— Administrator actions.
l System—System operations, warnings, and errors.
l User — Authentication results logs.
l Health Check—Health check results and client certificate validation
check results.

l SLB—Notifications, such as connection limit reached.
l LLB—Notifications, such as bandwidth thresholds reached.
l GLB—Notifications, such as the status of associated local SLB and
virtual servers.

l Firewall — Notifications for the Firewall module, such as SNAT source IP
pool is using all of its addresses.

Traffic Enable/disable logging for traffic processed by the load-balancing modules.

Traffic Category If Traffic is enabled, the Traffic Category options appear.
Select one or more of the following traffic categories to include in the traffic
logs export:
l SLB—Server Load Balancing traffic logs related to sessions and
throughput.

l GLB—Global Load Balancing traffic logs related to DNS requests.
l LLB— Link Load Balancing traffic logs related to session and throughput.

Security Enable/disable logging for traffic processed by the security modules.

Security Category If Security is enabled, the Security Category options appear.
Select one or more of the following security categories to include in the
security logs export:
l DDoS—DoS protection logs.
l IP Reputation— IP Reputation logs.
l WAF—WAF logs.
l GEO—Geo IP blocking logs.
l AV—AV logs.
l IPS— IPS logs.
l FW—Firewall logs.

6. If the Server Type is FortiAnalyzer, configure the following FortiAnalyzer settings:

Setting Description

Status Enable/disable the Fabric Connector object.

Address Specify the IP address of the FortiAnalyzer Log server.

Log Level Select the lowest severity to log from the following options:
l Emergency— The system has become unstable.
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Setting Description

l Alert — Immediate action is required.
l Critical — Functionality is affected.
l Error — An error condition exists and functionality could be affected.
l Warning— Functionality might be affected.
l Notification— Information about normal events.
l Information—General information about system operations.
l Debug—Detailed information about the system that can be used to
troubleshoot unexpected behavior.

The exported logs will include the selected severity level and above. For
example, if you select Error, the system collects logs with severity level Error,
Critical, Alert, and Emergency. If you select Alert, the system collects logs with
severity level Alert and Emergency.

Event Enable/disable logging for events.

Event Category If Event is enabled, the Event Category options appear.
Select one or more of the following event categories to include in the event
logs export:
l Configuration— Configuration changes.
l Admin— Administrator actions.
l System—System operations, warnings, and errors.
l User — Authentication results logs.
l Health Check—Health check results and client certificate validation
check results.

l SLB—Notifications, such as connection limit reached.
l LLB—Notifications, such as bandwidth thresholds reached.
l GLB—Notifications, such as the status of associated local SLB and
virtual servers.

l Firewall — Notifications for the Firewall module, such as SNAT source IP
pool is using all of its addresses.

Traffic Enable/disable logging for traffic processed by the load-balancing modules.

Traffic Category If Traffic is enabled, the Traffic Category options appear.
Select one or more of the following traffic categories to include in the traffic
logs export:
l SLB—Server Load Balancing traffic logs related to sessions and
throughput.

l GLB—Global Load Balancing traffic logs related to DNS requests.
l LLB— Link Load Balancing traffic logs related to session and throughput.

Security Enable/disable logging for traffic processed by the security modules.

Security Category If Security is enabled, the Security Category options appear.
Select one or more of the following security categories to include in the
security logs export:
l DDoS—DoS protection logs.
l IP Reputation— IP Reputation logs.
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Setting Description

l WAF—WAF logs.
l GEO—Geo IP blocking logs.
l AV—AV logs.
l IPS— IPS logs.
l FW—Firewall logs.

a. Optionally, click Test Connectivity after entering the Address to check the FortiAnalyzer OFTP connectivity.
The Connection Status appears showing the OFTP connection status.
There are three possible OFTP connection statuses:

Icon OFTP Status Description

Connected The FortiADC has successfully connected to FortiAnalyzer and
is authorized by FortiAnalyzer as a Fabric Device. FortiADC can
now send log data to FortiAnalyzer.

Disconnected The FortiADC cannot connect to FortiAnalyzer. Ensure there
are no network connectivity issues.

Need authorization The FortiADC has successfully connected to FortiAnalyzer but
is not authorized by FortiAnalyzer as a Fabric Device. This
status may indicate the authorization is either denied or
pending. If pending authorization, the status will change to
Connected once authorization is successful on the
FortiAnalyzer server.

If the status is not Connected, edit the FortiAnalyzer connector accordingly to troubleshoot the connection
issue.

7. Click Save.

After the connector is created, FortiADC will push the logs to the FortiAnalyzer server. The above configurations are also
available in Log&Report > Log Setting > Syslog Server tab or FortiAnalyzer tab.

FortiSandbox Connector

FortiADC is integrated with FortiSandbox to enhance its anti-virus capabilities. Upon detecting suspicious traffic
segments, FortiADC first conducts some basic analysis of its own and then forwards them to FortiSandbox for further
analysis. The latter will then drop or quarantine the malicious traffic segments and forward healthy traffic segments to the
back-end servers.

To enable a FortiSandbox Connector:

1. Go to Security Fabric > Fabric Connectors.
2. Double-click FortiSandbox.

FortiADC Handbook 86
Fortinet Technologies Inc.



Security Fabric

3. Configure the following Fabric Device Settings:

Settings Description

Type Select either of the following:
l FSA—FortiSandbox appliance.

Status Click the button to enable or disable FortiSandbox service.
Note: FortiSandbox is disabled by default.

Server Enter the IP address of the FortiSandbox appliance.
Note: This option applies if you want to use a on-premise FortiSandbox appliance
for service.

Email The email address of the person to be notified.

Source IP The IP address of the source interface on the FortiADC appliance.

4. Click Save.

FortiCloud Sandbox file upload limits

FortiCloud Sandbox file upload limit on page 87 shows the maximum number of files per minute that you can upload to
FortiCloud Sandbox from various FortiADC platforms.

FortiCloud Sandbox file upload limit

Platform Number of files uploaded per minute

FortiADC 60F/VM01 5

FortiADC100—400/VM02 10

FortiADC 700D/VM04 20

FortiADC 1000—2000/VM08 50

FortiADC 4000 100

FortiADC Manager Connector

Central Management allows the FortiADC to be connected to a FortiADCManager. Multiple FortiADCs can be managed
by the FortiADCManager. If you have large networks with multiple FortiADCs, with the FortiADCManager you can
simplify the configuration of these FortiADCs (for example, setting multiple FortiADCs to the same configuration), and
view all of their logs and statistics together.

The FortiADCManager is a powerful tool that gives you more effective control over your FortiADCs.

This guide will show you how to enable central management on your particular FortiADC by connecting to the FortiADC
Manager as a Fabric Connector. You will enter the IP address of your manager, then enable Central Management,
therefore allowing the FortiADCManager to manage your FortiADC.

See the FortiADCManager handbook.
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Basic configuration of two FortiADCs linked to a Manager

To enable a FortiADC Manager Connector:

1. Go to Security Fabric > Fabric Connectors.
2. Double-click FortiADC Manager.
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3. Configure the following Fabric Device Settings:

Settings Description

Type The type of the Central Management
None— Initial State of CM Agent.
FortiADCManager — The FortiADC is connected to the Manager.
Note: The Type is None by default.

Address The IP address or hostname of the FortiADCManager.
Note: The IP address should be empty by default.

Interval How often the FortiADC tries to connect to the Manager. Default 10 seconds. Range 10-
120.

Register Enable/disable registration to FortiADCManager. This will enable/disable the connection to
the FortiADCManager. This is disabled by default.

Management
Status

The connection status of the FortiADC.
l Online— FortiADC Manager successfully connects to CM Server.
l Offline— FortiADC Manager failed to connect CM Server. It can happen at the first
connection trial or if FortiADC Manager lost the connection. Note: FortiADC Manager
updates info to CM Server every minute and will make state as Offline when it does not
get response 2 times.

l Reject—Occurs when FortiADC Manager tries to connect with ‘State is not None’ and
CM Server does not have the record of this FortiADC (identified by license). The
connection will be rejected by CM Server.

4. Click Save.

Note: When register is enabled, modifying other central management settings is forbidden. Other central management
settings are grayed out. A warning message will display upon login.

When the FortiADC is set to Read-Onlymode, all configurations can only be viewed, even when the admin access
profile has Read-Write permission.
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When trying to write configurations in Read Only, the error message is shown:

The CM Agent state change log can be found in System Logs.
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FortiGSLB Connector

When you enable the FortiGSLB function, FortiADC will connect to the FortiGSLB Cloud server and sync up the
configuration to the cloud.

To enable a FortiGSLB Connector:

1. Go to Security Fabric > Fabric Connectors.
2. Double-click FortiGSLB.
3. Configure the following Fabric Device Settings:

Settings Description

Status Enable/disable the FortiGSLB function.

Interval Specify how often FortiADC should try to connect to the FortiGSLB. (Range:
10-1800; default: 15).

Cloud Server URL Specify the URL of the cloud server.

4. Click Save.

After the FortiGSLB connector is enabled, FortiADC will push information to the FortiGSLB Cloud and show the assigned
DNS server.

FortiClient EMS Connector

The FortiADC Security Fabric device can link to FortiClient Endpoint Management Server (EMS) for endpoint
connectors. Up to three EMS servers can be added to the Security Fabric. EMS settings are synchronized between all
Fabric members. Once the FortiADC is authorized as a Fabric device in FortiClient EMS, FortiClient EMS automatically
synchronizes ZTNA tags, the EMS CA certificate, and FortiClient endpoint information to the FortiADC.

The FortiClient EMS connector is an integral part of the Zero Trust Network Access (ZTNA) functionality. For more
information, see Zero Trust Network Access (ZTNA) on page 691 and How device identity and trust context is
established with FortiClient EMS on page 695.

Requirements:

l FortiClient EMS running version 7.0.3 or later
l FortiClient running 7.0.1 or later
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l FortiADC hardware, VM, or cloud platform that support FortiClient EMS.

FortiClient EMS is supported in most FortiADC platforms but not all of them. The
following lists the hardware models, cloud platforms, and VM environments that
support FortiClient EMS.
Hardware models:
l FAD-120F, FAD-220F, FAD-300F, FAD-400F, FAD-1200F, FAD-2200F,
FAD-4200F, FAD-5000F

Cloud platforms with BYOL (PAYG FortiADC does not support FortiClient EMS):
l AWS (AmazonWeb Services), Microsoft Azure, GCP (Google Cloud
Platform), OCI (Oracle Cloud Infrastructure), Alibaba Cloud

VM environments:
l VMware, Microsoft Hyper-V, KVM, Citrix Xen, Xen Project Hypervisor
Note: The most recent certificate embedded license is required. If your
license was issued prior to April 2021, please obtain a new certificate
embedded license for your VM through Fortinet Customer Service &
Support.

l Read-Write access permission for FortiADC Systems settings

To create and configure a FortiClient EMS connector:

1. Go to Security Fabric > Fabric Connectors.
2. Click Create New.
3. Under Core Network Security, click FortiClient EMS to display the configuration editor.
4. Configure the following FortiClient EMS settings:

Setting Description

Name Specify the FortiClient Enterprise Management Server (EMS) name. Valid
characters are A-Z, a-z, 0-9, _, and -. No spaces.

IP/Domain name Specify the server IPv4 address or the domain name of the FortiClient EMS
FQDN. For example: 192.0.2.1

HTTPS Port Specify the FortiClient EMS HTTPS access port number. Range: 1-65535,
default: 443

5. Click Save.
The Verify EMS server certificate dialog displays the following message:
In order for the FortiClient EMS and FortiADC to communicate, the following certificate provided by the FortiClient
EMSmust be reviewed for correctness, and accepted if deemed valid.
Do you wish to Accept the certificate as detailed below?

6. After you have verified the EMS server certificate information displayed, clickOK to accept the EMS server
certificate.
The Verify completed dialog displays the following message:
This FortiADC is not authorized on FortiClient EMS yet. Please let FortiClient EMS to authorize it.
Note: This message will only appear if the FortiADC device has not yet been authorized as a Fabric Device through
FortiClient EMS.

7. ClickOK.
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The newly created FortiClient EMS connector is added to the Security Fabric > Fabric Connectors page, under the
Core Network Security section. The FortiClient EMS connector will not be connected until the FortiADC has been
authorized as a Fabric Device in FortiClient EMS.

To authorize the FortiADC as a Fabric Device in FortiClient EMS:

1. Login to FortiClient EMS.
2. From the FortiClient EMS landing page, the Fabric Device Authorization Requests pop-up displays the Serial

Number and IP information of the FortiADC device. Click Authorize.
3. Alternatively, you can go to Administration > Fabric Devices and select the Fabric device you want to authorize.

To check and troubleshoot the FortiClient EMS connector connection:

1. Go to Security Fabric > Fabric Connectors.
2. Under the Core Network Security section, locate the FortiClient EMS connector configurations.

3. The and icons indicate whether FortiClient EMS has successfully authorized the FortiADC Fabric Device
for the corresponding FortiClient EMS connector. Hover over the FortiClient EMS connector to see the status
details. The table below lists the possible connection statuses for the FortiClient EMS connector.

Icon EMS Status Description

Connected The FortiADC has been successfully authorized as a Fabric
Device through FortiClient EMS.

Cert unauthorized FortiADC does not verify the EMS server's CA certificate. You can
edit the FortiClient EMS connector configuration and restart the
verification to accept the EMS CA certificate.

Auth failed The EMS server does not authorize the FortiADC, indicating the
request is either denied or pending authorization. If pending
authorization, the status will change to Connected once
authorization is successful on the EMS server.

Not reachable The EMS server was not reachable. Ensure the EMS server IP and
system router is properly configured.

EMS server connection failed The EMS server connection failed with unknown issue. For
example, an incorrect EMS server port may cause this issue.

No compatible The EMS server connection failed because the server is not
compatible with FortiADC.

Not sent The EMS domain name cannot resolve. Ensure proper
configuration for the DNS server setting, domain name, and
system router.
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If the status is not Connected, edit the FortiClient EMS connector accordingly to troubleshoot the connection issue.
4. Locate the newly created FortiClient EMS connector, click the FortiClient EMS connector configuration then click

Edit, or double click the configuration object to display the configuration editor.

5. Edit the configuration to troubleshoot the connection issue then click Authorize to restart the verification to accept
the EMS CA certificate.
A request is resent to the FortiClient EMS to authorize the FortiADC as a Fabric Device in FortiClient EMS. The
FortiClient EMS connector will not be connected until the FortiADC has been authorized as a Fabric Device in
FortiClient EMS.

External connectors

Cloud SDN connectors provide integration and orchestration of Fortinet products with public and private cloud solutions.
In a typical cloud environment, resources are dynamic and often provisioned and scaled on-demand. By using an SDN
connector, you can ensure that changes to cloud environment attributes are automatically updated in the Security
Fabric.
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To protect the East-West or North-South traffic in these environments, the FortiADC uses the SDN connector to sync the
dynamic addresses that these volatile environments use. You can then configure the dynamic address objects as
sources or destinations for firewall policies. When you make changes to cloud environment resources, such as moving
them to a new location or assigning different IP addresses to them, you do not need to modify the policy in FortiADC, as
the SDN connector syncs changes to the cloud address objects.

The following external connectors are available in the Security Fabric.

Public SDN:

l AmazonWeb Services (AWS) Connector on page 95
l Oracle Cloud Infrastructure (OCI) Connector on page 98

Private SDN:

l Kubernetes Connector on page 100
l Splunk Connector on page 104
l SAP Connector on page 105

Authentication:

l FortiAuthenticator (FAC) Connector

Threat Feeds:

l IP Address Connector on page 106

If VDOMs are enabled, SDN and Threat Feeds connectors are in the global settings,
and Authentication connectors are per VDOM.

Amazon Web Services (AWS) Connector

When you create an AmazonWeb Services (AWS) connector, you are authorizing FortiADC to periodically (every 30
seconds by default) get information from AWS instances and dynamically populate it in the server pool configuration.

Before you begin:

l Ensure the system time is synchronized between AWS EKS and FortiADC. You can enable NTP on FortiADC to
correct the time clock. For details, see Configuring system time on page 141.

l If you want to access AWS EKS objects through the Metadata IAM role for the FortiADC EC2 instance, you must
have permissions enabled. For details, see Accessing AWS EKS objects through Metadata IAM role on page 96.

To create an AWS Connector:

1. Go to Security Fabric > External Connectors.
2. Click Create New.
3. Under Public SDN, select Amazon Web Services (AWS) to display the configuration editor.
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4. Configure the following settings:

Setting Description

Name Type a name for the external connector object.

Status Toggle on to enable the external connector object.
Toggle off to disable the external connector object.

Update Interval (s) Specify the update interval for the connector to get AWS objects and
dynamically populate the information in the server pool configuration.

Access Key ID Specify the access key ID.

Secret Access Key Specify the secret access key.

Region Name Specify the region where your instances are deployed.

Use Metadata IAM When FortiADC is deployed on AWS, you can assign IAM role for it to access
EC2 instances and EKS objects.

5. Click Save.

After the connector is created, you can select this connector when creating a server pool. FortiADC will then get the IP
addresses of the instances from AWS and dynamically populate the objects in the server pool configuration.

You can use the IP Address Type option to get the private address or public address of the instance. This option is
supported only when the FortiADC is deployed on AWS.

Accessing AWS EKS objects through Metadata IAM role

If you want to use the Metadata IAM role for the FortiADC EC2 instance to access the AWS EKS objects, follow the steps
below to enable permission before you configure the AWS SDN connector.

Note: If you have already configured the AWS SDN connector with Metadata IAM enabled, it must be disabled and re-
enabled in order for the below steps to take effect in the new configuration.

1. Go to the AWS Dashboard and navigate to IAM > Access management > Role.
2. Create a role and grant the role with the AdministratorAccess permission policy to allow the FortiADC EC2

instance to call AWS EKS services on your behalf.
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3. Record the Role ARN information to be used later.

4. Assign the newly created IAM role to the FortiADC EC2 instance.
5. Add role-based access control (RBAC) access to the IAM role using the aws-auth ConfigMap.

a. Check the current aws-auth ConfigMap and copy the roleARN information.
The roleARNmay appear differently depending on the way the EKS cluster node group is created. In this
context, the EKS cluster node group is created with the Amazon EKS vended AWS CloudFormation templates,
which makes the NodeInstanceRole the roleARN.

kubectl describe configmap -n kube-system aws-auth

b. Download the configuration map template.

curl -o aws-auth-cm.yaml https://amazon-eks.s3.us-west-
2.amazonaws.com/cloudformation/2020-10-29/aws-auth-cm.yaml

c. Create a new aws-auth configuration by adding the IAM role created previously and the NodeInstanceRole
into aws-auth-cm.yaml.
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apiVersion: v1
kind: ConfigMap
metadata:
name: aws-auth
namespace: kube-system

data:
mapRoles: |
- rolearn: arn:aws:iam::xxxx:role/eksctl-qa-cluster-nodegroup-ng-16-

NodeInstanceRole-yyyy
username: system:node:{{EC2PrivateDNSName}}
groups:
- system:bootstrappers
- system:nodes

- rolearn: arn:aws:iam::xxxx:role/FortiADC-role
username: system:node:{{EC2PrivateDNSName}}
groups:
- system:bootstrappers
- system:nodes

d. Apply the aws-auth-cm.yaml by kubectl apply command.

kubectl apply -f aws-auth-cm.yaml

e. Use the kubectl describe command to check the aws-auth ConfigMap.

For more information on AWS IAM user and role access to the EKS cluster, refer to AWS official documentation.

Oracle Cloud Infrastructure (OCI) Connector

When you create an Oracle Cloud Infrastructure (OCI) connector, you are authorizing FortiADC to periodically (default
30s) get information from OCI instances and dynamically populate it in the server pool configuration.

To create an OCI Connector:

1. Go to Security Fabric > External Connectors.
2. Click Create New.
3. Under Public SDN, selectOracle Cloud Infrastructure (OCI) to display the configuration editor.
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4. Configure the following settings:

Setting Description

Name Type a name for the external connector object.

Status Toggle on to enable the external connector object.
Toggle off to disable the external connector object.

Update Interval (s) Specify the update interval for the connector to get OCI objects and
dynamically populates the information in the server pool configuration.

OCI region type Specify the OCI region type.

OCI region Specify the OCI region where your compute instances are located.

User ID The user's OCID.

Tenant ID The tenancy's OCID.
Refer to this article on how to get the user's OCID and tenancy's OCID:
https://docs.oracle.com/en-
us/iaas/Content/API/Concepts/apisigningkey.htm#five

Compartment ID The OCID of the Compartment in which your compute instances are deployed.

Certificate The certificate that FortiADC uses to build connections with OCI instances.
You can select an existing one or create a new one. Refer to Manage
Certificates.

OCI HA status Enable this option so that the system will use this connector to get the HA
members' information if this FortiADC is deployed in HA mode and is the
primary node.

Use Metadata IAM Enable this option to assign IAM role for FortiADC to access OCI objects.
Note: It must be enabled if the connector is used for OCI HA.

5. Click Save.

After the connector is created, you can select this connector when creating a server pool. FortiADC will then get the IP
addresses of the instances from OCI and dynamically populate the objects in the server pool configuration. This step is
not required if you have enabledOCI HA status because in this case the connector will be used by the system to get the
information of the HA members instead of the server pool members.
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You can use the IP Address Type option to get the private address or public address of the instances. This option is
supported only when FortiADC is deployed on OCI.

Kubernetes Connector

When you create a fabric connector for Kubernetes, you are specifying how FortiADC can communicate with
Kubernetes.

FortiADC will be authenticated to periodically (default 30s) get Kubernetes objects (services, nodes) and dynamically
populates and updates the related objects, including pool member and real server in its server pool configuration.

Requirements:

l The Kubernetes service is required to be exposed with NodePort type.

To obtain the IP address, port, and secret token in Kubernetes:

When configuring the Kubernetes connector in FortiADC, you must provide the IP address and port that the Kubernetes
deployment is running on.
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1. On the primary node of your Kubernetes cluster, run kubectl config view to get the IP address.
The following is an example. Take note of the IP address.

2. Run kubectl get services to get the port number. FortiADC only supports "NodePort" service type.
The following is an example:

Take note of the port number of this service, i.e. service-1236 in the above example.
3. Create a cluster role to grant the FortiADC permission to perform operations and retrieve objects.

a. Run cat > <filename>.yaml to create a yaml file specifying the cluster role.
For example, running cat > access_clusterrole.yaml will create the file "access_clusterrole.yaml".
Then, type the following to insert it in the file. In this example, the role is named as psn-reader. You can give
it other names as you desire. Remember to Type Ctrl-d at the end to save the file.
apiVersion: rbac.authorization.k8s.io/v1
kind: ClusterRole
metadata:

# "namespace" omitted since ClusterRoles are not namespaced
name: psn-reader

rules:
- apiGroups: [""]

resources: ["pods", "services", "nodes"]
verbs: ["get", "watch", "list"]

b. Run cat > <filename>.yaml to create a yaml file, then insert the following to attach the cluster role to a
service account.
In the following example, the file "cluster_role_bind.yaml" is created, and the role "psn-reader" is attached to
the service account "default" for it to read pods, node, or services in default namespace.
If you want to attach the role to a new service account, use kubectl create serviceaccount
<Service_account_name> to create one, then attach the role to it.
Remember to Type Ctrl-d at the end to save the file.
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~# cat > cluster_role_bind.yaml
apiVersion: rbac.authorization.k8s.io/v1
kind: ClusterRoleBinding
metadata:

name: read-psn-global
subjects:

- kind: ServiceAccount
name: default #name is case sensitive
namespace: default

roleRef:
kind: ClusterRole
name: psn-reader
apiGroup: rbac.authorization.k8s.io

c. Run kubectl apply -f access_clusterrole.yaml to execute the configurations in this file.
d. Run kubectl apply -f cluster_role_bind.yaml to execute the configurations in this file.

4. Get secret token.

Versions of Kubernetes before v1.22 automatically created long term credentials for
accessing the Kubernetes API. This older mechanism was based on creating token
Secrets that could then be mounted into running Pods. In more recent versions, including
Kubernetes v1.28, API credentials are obtained directly by using the TokenRequest API,
and are mounted into Pods using a projected volume. The tokens obtained using this
method have bounded lifetimes, and are automatically invalidated when the Pod they are
mounted into is deleted.
You can still manually create a service account token Secret; for example, if you need a
token that never expires. However, using the TokenRequest subresource to obtain a token
to access the API is recommended instead.

a. Run kubectl get secrets to view the secrets.
b. Run kubectl describe secrets <secret_token_name> -n <service_account_name> to view

the secret token. Take note of the token.
In the following example, the information of the secret token "default-token-x8mth" stored in "default" service
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account is displayed.

To create a Kubernetes Connector:

1. Go to Security Fabric > External Connectors.
2. Click Create New.
3. Under Private SDN, select Kubernetes. The Kubernetes screen is displayed.
4. Configure the following options, and then click Save. You will be required to provide the IP address, port, and the

secret token you have obtained in the above section: To obtain the IP address, port, and secret token in
Kubernetes:

Name Type a name for the external connector object.

Status Toggle on to enable the external connector object.
Toggle off to disable the external connector object.

Update Interval (s) Specify the update interval for the connector to get Kubernetes objects and
dynamically updates the IP addresses.

IP Type the IP address of the Kubernetes API server.

Port Specify the port that FortiADC uses to communicate with the Kubernetes API
server.

Secret Token Specify the secret token.

After the connector is created, you can select this connector when creating a server pool. FortiADC will then get the IP
addresses of the real servers from the Kubernetes deployment and dynamically populate the objects in the server pool
configuration.
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Splunk Connector

When you create a connector for Splunk, you are specifying how FortiADC can communicate with Splunk for pushing
logs to Splunk.

FortiADC will connect to Splunk by UDP, TCP or TCP SSL depending on Splunk connector setting.

Requirements:

l The Splunk service is required to be exposed on External IP.

To create a Splunk Connector:

1. Go to Security Fabric > External Connectors.
2. Click Create New.
3. Under Private SDN, select Splunk. The Splunk screen is displayed.
4. Configure the following options, and then click Save.

Status Toggle on to enable the external connector object.
Toggle off to disable the external connector object.
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Address Type the IP address of the Splunk Log server.

Port Specify the port that FortiADC uses to communicate with the log server.

Proto Select the protocol used for log transfer.

Log Level Select the severity level of the logs. All the exported logs will be attached with
the selected severity level.

CSV Enable to export the logs in .csv file.

Facility Select the source facility of the logs. We only support the local use facilities
which are not reserved and are available for general use.

Event Enable to export Event logs.

Traffic Enable to export Traffic logs.

Security Enable to export Security logs.

After the connector is created, FortiADC will push the logs to Splunk server. The above configurations are also available
in Log&Report > Log Setting > Syslog Server.

SAP Connector

When you create an SAP connector, you are authorizing FortiADC to periodically (default 30s) get information of SAP
instances and dynamically populates it in server pool configuration.

To create an SAP Connector:

1. Go to Security Fabric > External Connectors.
2. Click Create New.
3. Under Public SDN, select SAP. The SAP screen is displayed.
4. Configure the following options, and then click Save.

Name Type a name for the external connector object.

Status Toggle on to enable the external connector object.
Toggle off to disable the external connector object.

Update Interval (s) Specify the update interval for the connector to get SAP objects and
dynamically populates the information in the server pool configuration.

IP Type the IP address, FQDN, or hostname of the SAP server.

SAP DNS Suffix enter the DNS name of the SAP system is required. This option is required if
hostname is used for the SAP server.

SAP MS HTTP Port Specify the SAP MS HTTP port that FortiADC uses to communicate with the
SAP server.

SAP ICM HTTP Port Specify the ICM HTTP Port.
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SAP SID Admin Specify the SID admin account that FortiADC uses to access the resources in
this account.

SAP Password Specify the password.

After the connector is created, you can select this connector when creating a server pool. FortiADC will then get the IP
addresses of the compute instances from SAP and dynamically populates the objects in server pool configuration, as
shown in the following screenshots.

You can use the IP Address Type option to get the private address or public address of the instance.

IP Address Connector

Creating an IP Address connector allows you to dynamically import an external block list from an HTTP/HTTPS server in
the form of a plain text file. Block lists can be used to enforce special security requirements, such as long term policies to
always block access to certain websites, or short term requirements to block access to known compromised locations.
The lists are dynamically imported, so that any changes are immediately imported by FortiADC.

After you have imported your external block list through the IP Address connector, you can apply the IPs as the source or
destination address for IPv4 and IPv6 firewall policies.
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l You cannot delete an IP Address connector or modify its status if the external
resource is being used in an IPv4 or IPv6 firewall policy.

l Up to 512 external resources can be supported, however, large numbers of
external resources may affect system performance.

Requirements:

l The external block list must be accessible from an HTTP/HTTPS server.
l The import file must be in plain text and each line must contain an IP, IP Range, or Subnet in the below formats:

IP/ IP Range/ Subnet Example

IPv4 192.168.2.100

IPv4 Range 172.200.1.4/16

IPv4 Subnet 172.16.8.1-172.16.8.100

IPv6 2001:0db8::eade:27ff:fe04:9a01

IPv6 Range 2001:0db8::eade:27ff:fe04:9a01/120

IPv6 Subnet 2001:0db8::eade:27ff:fe04:aa01-2001:0db8::eade:27ff:fe04:ab01

l The maximum import file size is 1 MB (which is about 5000 line entries).

To create and configure an IP Address connector:

1. Go to Security Fabric > External Connectors.
2. Click Create New.
3. Under Threat Feeds, click IP Address to display the configuration editor.
4. Configure the following IP Address settings:

Setting Description

Name Specify the name of the IP Address connector. Valid characters are A-Z, a-z,
0-9, _, and -. No spaces.

URI of External Resource Specify the URI of the HTTP/HTTPS server where the IP address list is stored.

HTTP Basic Authentication Enable/disable HTTP Basic Authentication to require username and password
to access the IP address list.

Username The Username option is available if HTTP Basic Authentication is enable.
Specify the username to be used to access this IP address list.

Password The Password option is available if HTTP Basic Authentication is enable.
Specify the password to be used to access this IP address list.

Refresh Rate Specify the refresh rate in minutes. (Default: 5. Range: 1-43200 minutes).
FortiADC will retrieve the data from the HTTP/HTTPS server periodically
according to the refresh rate.
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Setting Description

Comments Optionally, enter comments about the IP Address connector.

Status Enable/disable the IP Address connector.

5. Click Save.
The newly created IP Address connector appears on the External Connectors page under Threat Feeds.

To view the external block list IP entries and the resource update status:

1. Go to Security Fabric > External Connectors.
2. Under Thread Feeds, double-click the IP Address Connector to display the configuration editor.
3. From the Last Update field, you can see the date of when the resource was last updated.
4. Click View Entries to display the IP address list entries.

A dialog appears displaying the entries imported for the IP Address Connector.

The imported file has been parsed line by line and marked as valid or invalid based on whether the entry meets
format requirements for IP, IP Range, or Subnet.
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FortiView

The FortiView pages display important information about your FortiADC appliance, which includes the logical topology of
real-server pools and their members within each virtual server, server load-balancing information, security, and some
other system events and alerts.

This section is organized into the following sub-menu topics:

l Logical Topology on page 109
l Server Load Balance on page 112
l Security on page 121
l System on page 133
l Global Load Balance on page 135
l Link Load Balance on page 136
l ZTNA FortiClient endpoint on page 137

Logical Topology

This page displays the logical topology of your FortiADC network structure. It shows your FortiADC appliance or
appliances identified by serial number and the real servers connected to it

Note: This page is read-only.

Server Load Balance Logical Topology

The FortiView > Logical Topology > Server Load Balance page uses the tree-view format to show the internal
configuration of each virtual server on your FortiADC appliance. Depending on the actual configuration, the diagrammay
show content touting, schedule pools, real-server pools, and real-server pool members configured on a virtual server, as
illustrated in Server Load Balance Logical topology on page 109.

Server Load Balance Logical topology
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The image above is a partial screen capture of the FortiView > Logical Topology page. It shows the internal configuration
of a virtual server named "L7_HTTP, which has the following configurations on it:

l A real-server pool named "HTTPServicePool which contains 9 members (real servers) in it.
l It is using Port 7, which is up (working).

Apart from viewing the internal configurations of virtual servers, you can also drill down into the components (except for
content routing and schedule group) for details by clicking their corresponding icons. Below highlights what you will see
when you click any of the following icons:

l Virtual server—Opens the page with details of that virtual server. See Virtual server details on page 113
l Real-server pool—Opens the page with details of the real-server pool. See Real server pool details on page 116
l Real server —Opens the page showing details of the real server. See Real-server pool member details on page 117

Link Load Balance Logical Topology

The FortiView > Logical Topology > Link Load Balance page shows the logical topology of link groups that have
been configured.

Adding link groups

To add a link group:

1. Click the Add Link Group button.
2. Make desired entries or selections as described in Configuring a link group on page 485
3. Click Save when done.

Note: While in Editor View, you can click any component in the logical topology to edit or delete it.

Filtering link groups

The Add Filters button on top of the page allows you to customize the logical topology by:
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l Availability
l Gateway Status
l Link Group Name
l Gateway Name
l Gateway IP

To add a filter:

1. Click the Add Filters button.
2. Select the filter.

You can use the same steps to apply multiple filters. Applied filters appear in front of the Add Filters button in the order
they are added. You can remove a filter by clicking the x sign on it.

Global Load Balance Logical Topology

The FortiView > Logical Topology > Global Load Balance page shows the logical topology of your global load
balance configurations.

Adding hosts

To add a host:

1. Click Add Host.
2. Make desired entries or selections as described in Configuring hosts on page 499
3. Click Save when done.

Note: While in Editor View, you click any component in the logical topology to edit or delete it.

Filtering hosts

The Add Filters button on top of the page allows you to customize the logical topology by:

l Availability
l Host
l Domain Name
l VS Pool
l Server
l Server Member
l Data Center

To add a filter:

1. Click the Add Filters button.
2. Select the desired filter from the drop-down list menu.

Note: You can use the same steps to apply multiple filters. Applied filters appear in front of the Add Filters button in the
order they are added. You can remove a filter by clicking the x sign on it.
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Server Load Balance

The FortiView > Server Load Balance sub-menu shows server load-balancing configurations on your FortiADC.

It has the following pages:

l Virtual Server
l Data Analytics
l All Sessions on page 120
l Traffic Logs

Virtual Servers

Under the FortiView Server Load Balance sub-menu, the Virtual Server page (Virtual server on page 112) is a table
that shows some key configuration and traffic information about the virtual servers that have the FortiView feature
enabled on them. You can enable FortiView on a virtual server using Server Load Balance>Virtual
Server>Add>Advanced Mode>Traffic Log>FortiView>ON. You can also show or hide all the virtual servers on or from
this page using the Enable All or Disable All button across the top of the table, regardless whether you have FortiView
enabled or not when configuring the virtual servers.

Virtual server

Virtual Server table on page 113 describes the information on the FortiView > Server Load Balance > Virtual Server
page.

FortiADC Handbook 112
Fortinet Technologies Inc.

slb_traffic_log.htm


FortiView

Column title Description

Name The name of a virtual server
Note: Clicking the name of a virtual server opens the page with detailed information
about the virtual server.

Type The type of virtual servers, which can be one of the following:
l l2 = Layer 2
l l4 = Layer 4
l l7 = Layer 7

Address The IP address of a virtual server.
Note: For Layer-2 virtual servers, this field shows 0.0.0.0.

Port The port used by a virtual server, which depends on the type of traffic the port is
handling.

Pool The name of a real-server pool configured on a virtual server.
Note: Clicking the name of a real-server pool opens the page with details of that real-
server pool.

Throughput (bits/sec) The graph shows the change in a virtual server's throughput in terms of bits per second
over the past 24 hours.
Note: The data was sampled at 60 different time points over the last 24 hours (i.e., once
every 24 minute). If you mouse over a specific point in the graph, a tool tip will pop up
showing the throughput for that time point.

Concurrent The graph shows the change in the number of concurrent connections with the virtual
server over the last 24 hours.
Note: The data was sampled at 60 different time points over the last 24 hours (i.e., once
every 24 minute). If you mouse over a specific point in the graph, a tool tip will pop up
showing the number of concurrent connections at that time point.

Connections (counts/sec) The graph shows the change in the number of connections with the virtual server over
the last 24 hours.
Note: The data was sampled at 60 different time points over the last 24 hours (i.e., once
every 24 minute). If you mouse over a specific point in the graph, a tool tip will pop up
showing the number of connections for that time point.

Health The color of the heart icon indicates the health state of a virtual server, which can be
either of the following:
l Green = healthy
l Red = Unhealthy

Virtual Server table

Virtual server details

This page shows detailed information about the virtual server you selected on the Virtual Server page under the
FortiView Server Load Balance sub-menu.

On the Virtual Server page, click the virtual server name to view its details.
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The virtual server details include the following pages:

l Analytics
l Health
l Client
l Session
l Persistence
l Statistics

Analytics

The Analytics page provides real-time analysis of data about the virtual server using colored icons, charts, and
diagrams, etc. See the following figure: 

In the upper-right corner of the page is a drop-down box. Click the down arrow to pull down the drop-down menu which
contains for setting the time frame for the graph the bottom of the page. The options are:

l 1 Hour
l 6 Hour
l 1 Day
l 1Week
l 1 Month
l 1 Year

In the lower-right corner of the page is another drop-down box which contains data options you can choose to show in
the graph. The options are:
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l End to End Timing (default)
Note: End to End Timing graphs may not deliver precise timings below the 100 ms threshold.

l Throughput
l Concurrent Connections
l Connections per Second
l Request

Health

This page uses a bar graph to show the virtual server's health status in a specific time frame, as shown in the following
figure: 

In the upper-right corner of the page is a drop-down menu, which provides the time frames that you can choose from for
the graph. The options are the same as those described in the section above.

Client

This page depicts the clients of the virtual server across the globe, as illustrated in the following figure: 

The Client page has the following sections:

l Location—This part of the page shows the top five countries in the world where most of the client traffic is coming
from. The dots on the map shows the locations of those countries. Mouse over a dot to see the name of that country
in the tool tip. The + (plus) and – (minus) signs allow you to zoom in or out on the map. The table below the map
shows percentage of client traffic from each of those countries: the green up arrows indicate that traffic is
increasing; the percentage in green indicates the percentage increase in client traffic since the last data was
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sampled; and the percentage in black indicates the percentage of traffic each of the counties accounts for in total
client traffic.

l Device—This part of the page shows the types of devices that the clients are using, the percentage increase in the
use of each of the devices since the last data was sampled, and the percentage of a type of device among all
devices that are used.
The following device types are supported: Mobile and PC.

l Browser—This part of the page shows the web browsers that the clients are using, the percentage increase in the
use of each of the browsers, and the percentage of each of the browsers among all browsers that are used.
The following web browsers are supported: IE, Firefox, Safari, Opera, Edge, and Nintendo. If the client is using a
browser that is not on the supported list, then the Browser will display as "Unknown".

l Operating System—This part of the page shows the operating systems that the clients are using, the percentage
increase in the use of each of the operating systems since the last data was sampled, and the percentage that each
operating system accounts for among all the operating systems that are used.
The following operating systems are supported: Windows, Open BSD, Linux, Mac OS, and iOS. If the client is using
an operating system that is not on the supported list, then the Operating System will display as "Unknown".

l Top URLs—This part of the page shows the top five web browsers that the clients are using, and the percentage
that each of them accounts for among all the browsers that are used.

Session

This page shows all the active sessions that the virtual server currently maintains. The table provides the same
information and tools as described in All Sessions on page 120

Persistence

This page shows all the active persistence sessions that the virtual server currently maintains. The table provides the
same information and tools as described in All Sessions on page 120

Statistics

This page shows the statistics for this particular VS, its counters. After reboot, all the counters will restart on their own. It
is limited to HTTP/HTTPS virtual servers.

Real server pool details

The real server pool details page (Real server pool details on page 116) shows detailed information about the real server
pool you selected on the Virtual Server page under the FortiView Server Load Balance sub-menu.

The top of the page shows the name of the real server pool and the virtual server to which it is assigned. Below the real
server pool name are two tabs—Members and Health. The former shows information about the members (real
servers) in the real server pool, whereas the latter shows the health state of the real server pool in general.

Member

The Member pages (see the image above) shows key information about the real servers in a real server pool, as
described in Real server pool member information on page 117.
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Column title Description

Name The name of a real server pool member (real server).
Note: Clicking the name of a real server opens the page with detailed information about
the real server.

Status Shows the status of a real server pool member, which can be either of the following:
l Enable
l Disable

Address The IP address of a real server pool member (real server).

Port The port used by a real server pool member.

Weight The weight assigned to a real server pool member.

Throughput (bits/sec) The graph shows the change in a real server's throughput in bits per second over the
specified period of time.
Note: If you mouse over a specific point in the graph, a tool tip will pop up showing the
number of bits per second that a real server pool member transmits at that time point.

Concurrent The graph shows the change in the number of concurrent connections with the real
server pool member over the specified period of time.
Note: If you mouse over a specific point in the graph, a tool tip will pop up showing the
number of concurrent connections at that time point.

Health The color of the heart icon indicates the health state of a real server pool member, which
can be either of the following:
l Green = healthy
l Red = Unhealthy

Real server pool member information

Health

This graph shows the overall health status of the real server pool.

Real-server pool member details

This page shows detailed information about the real server pool member selected on the Virtual Server page under the
FortiView Server Load Balance sub-menu. See the following figure: 

Real server pool member details
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Across the top of the page is the name of the real server pool member, preceded by the name of the virtual server and
the name of the real server pool. The page has two display options—Analytics and Health, as represented by the two
tabs below the name of the real server pool member.

Analytics

The Analytics page uses charts and diagrams to help you analyze data related to the real server pool member. The
diagram and the pie chart in the upper part of the page show the dynamic changes in server round -trip time and
application response time.

The page has two drop-down menus which allow you to set the time frame and data type displayed in the line chart at the
bottom of the page.

Data Analytics

Under the FortiView Server Load Balance sub-menu, the Data Analytics page shows, initially, the Dynamic Charts
page.

This is among three tabs:

l Dynamic Charts on page 118
l Static Charts on page 120
l Statistics on page 120

First we will speak of the Dynamic Charts page.

Dynamic Charts

In the Dynamic Charts tab, you can customize your data analytics chart by using the Add Widget button to create charts
of your own. See the table below for details.

By default, Dynamic Charts is enabled to automatically refresh with new data to add to the charts. The data is tied to the
Fast Stats log setting, in which the Traffic option is automatically enabled/disabled when Dynamic Charts is
enabled/disabled. For details, see Configuring fast stats log settings.
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To add a widget (chart):

1. Go to FortiView > Data Analytics.
The configuration page displays the Dynamic Charts tab.

2. Click the Add Widget to open the Fast Report dialog.
3. Make the entries and selections as described in Data Analytics Widget on page 119.
4. Click Save when done.

Chart/Graph Description

Name Enter a unique name for a chart.

SLB Subtype Click the down arrow and select a server load-balancing data you want to show in the
chart.
l Top Source IP—Most used source IP addresses
l Top Destination IP—Most used destination IP addresses
l Top Browser—Most used web browsers
l Top OS—Most used operating systems
l Top Device—The type of device (PC vs. Mobile) with the most traffic
l Top Domain—Most used domains
l Top URL—Most used URLs.
l Top Referrer—Referrers which forwarded most traffic
l Top Source Country—The countries where most of the traffic originated
l Top Session—Sessions with the most traffic

History Chart A "history" chart shows historical data that the system captured over a specific time
period in the past. The option is turned OFF (disabled) by default, but you can click the
button to turn it ON (enable it).
Note: If this option is turned off, the chart will be a pie chart. If it is turned on, then you
will see a bar chart for most of the data types except for Session Total and Throughput
Total which use line charts instead. Both bar charts and line charts have a time-range
selector in their upper-right corner which allows you to select one of the following:
l 10 Minutes
l 1 Hour
l 1 Day
l 1Week
l 1 Month

Time Range Click the down arrow to select one of the following time ranges:
l 10 Minutes
l 1 Hour
l 1 Day
l 1Week
l 1 Month

Note: This option becomes unavailable if History Chart is enabled.

Data Type Select either of the following:
l Bandwidth (default)
l Session

Data Analytics Widget
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Chart/Graph Description

Top X Specify a maximum value for the X axis.
Note: The default is 5, but the valid values are from 3 to 7.

Top Y Specify a maximum value for the Y axis.
Note: The default is 5, but the valid values are from 3 to 7.

Static Charts

Here, by default, there will show up two static charts. The first will measure SSL TPS, i.e. transactions per second. The
second measures Compression Throughput.

You have a time range of:

l 1 Hour
l 6 Hours
l 1 Day
l 1Week
l 1 Month
l 1 Year

Statistics

Statistics shows you the status of the whole VDOM.

All Sessions

Under the FortiView Server Load Balance sub-menu, the All Sessions page contains two tabs, which open the
Session Table and Persistence Table, respectively.

Viewing the Session or Persistence Table

The Session Table shows information about the sessions that FortiADC has established. The page shows the live
sessions only. Expired sessions are removed from the table when the page refreshes.

To view the Session or Persistence Table:

1. Go to FortiView > All Sessions.
2. Select the Session Table or Persist Table tab.

You can use the Filter Setting button (located in the upper-left corner of the page) to filter the sessions displayed on the
page.

To set the filter:
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1. Click the Filter Setting button.
2. Select between the following filters:  Trigger Time, Alert, Priority, Message.
3. Click OK when done.

You can apply multiple filters. All filters you have configured will appear under the Filter Setting button in the order they
are created. To remove a filter, click the x sign on it.

Note: The Clear button (next to Filter Setting), if clicked, clears all sessions in the table. If you click the button by mistake,
you can always re-populate the page with session data by clicking the Refresh button.

Security

The FortiView > Security sub-menu shows network security information captured by FortiADC.

It has the following pages:

l OWASP Top 10 on page 121
l Threat Map on page 123
l Data Analytics on page 124
l Security Logs on page 126
l Blocked IP on page 132

OWASP Top 10

Through the FortiView > OWASP Top 10 page, you can monitor threats by OWASP Top 10 to analyze the 10 most
critical attacks targeted to your application.

You can see the total number of threats, the types of actions FortiADC carries out in response to specific types of
attacks, and how severe attacks are.

This gives you the ability to modify your FortiADC configuration to best address specific threats your environment faces.

To view the OWASP Top 10 data on this page, you need to first enable the security
WAF log. Go to Log & Report > Log Setting to enable the corresponding log.

From FortiADC 7.1.0, the OWASP Top 10 list has been updated to the latest 2021
version. The OWASP Top 10Wizard is automatically updated to the 2021 list, and
the OWASP Top 10 2021 log data will be displayed through FortiView.
Log data from OWASP Top 10 2017 can still be accessed through the Security log.

From this window, you can see the total threat data that FortiADC has detected for each OWASP Top 10 threat:
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The summary OWASP Top 10 threats shows the total number of threats, actions, and service used according to the
threat type.

The OWASP Top 10 Threats log analysis is based on the WAF log, so the data may
not match the OWASP Top 10 Threats on the Dashboard with 100% accuracy.
The reason for this inconsistency is due to the way the data is obtained for the
Dashboard and FortiView. While the Dashboard obtains the data directly from the
FortiADC, the FortiView statistics are calculated and re-aggregated by the Log
module. Another cause for data inconsistencies is when aWAF action is predefined
as "silent-deny", which will not be sent or recorded in the WAF log when triggered.

Viewing individual OWASP Top 10 threats

There are two ways to drill down into the key elements about a specific threat:

l Double-click the threat from the OWASP Top 10 Threats Log.
l Click the Add Filter icon and select the OWASP Top 10 threat from a drop-down menu.

From here, you can view information about the source IP of the attacks, countries from which the attacks are launched,
the HTTP methods used, and the targeted URLs under the Sources, Countries, HTTP Methods, and URLs for the
specified OWASP Top 10 threat.
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Threat Map

Under the FortiView Security sub-menu, the Threat Map page depicts the security threats to your FortiADC devices in
real time. The darker part of the world map represents the part of the world at night, whereas the lighter areas are parts of
the world in daylight. The device icons represent your FortiADC appliances deployed at various locations in the world.
The shooting stars represent the live attacks on your FortiADC appliances as they occur.

The table at the bottom of the map lists the live threats as they occur, with the following information about each threat:

l Location—The country and the IP address where an attack comes come.
l Threat—The name or brief description of a threat
l Severity (score)—The level of severity of a threat, which can be high, medium, or low.
l Time—The date and time when an attack occurs.

The severity of threats are color-coded:

l High—Red
l Medium—Yellow
l Low—White.

The map and the table complement each other, showing you when the attacks occur, pinpointing where they come from,
and telling you the nature and severity of the attacks so that you can make well-informed decision as to how to react to
those threats.

You can open the Threat Map page by clicking FortiView > Security > Threat Map. Threat map on page 123 shows the
Threat Map with only one FortiADCappliance.

Threat map
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Data Analytics

Under the FortiView Security sub-menu, the Data Analytics page showsWeb application firewall information in charts
called "widgets". By default, the page is empty. You must create charts of your own using the AddWidget button.

Note: Normally, the Data Analytics page automatically refreshes itself every a few seconds so that new data can be
added to the charts. You can stop the page from refreshing by clicking the Enabled button across the top of the page.
The charts stop refreshing. as soon as the button turns to Disabled.

To add a widget (chart):

1. Click FortiView > Security > Data Analytics.
2. Click the AddWidget button to open the Fast Report dialog.
3. Make the entries and selections as described in Data Analytics widget on page 124.
4. Click Save when done,

Chart/Graph Description

Name Enter a unique name for a chart.

Attack Subtype Click the down arrow and select a server load-balancing data you want to show in the
chart.
l Top Attack Type for All
l Top Attack Type by VS for All
l Top VS for DDoS
l Top Destination Country for DDoS
l Top VS for GEO
l Top Source for GEO

Data Analytics widget
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Chart/Graph Description

l Top Destination for GEO
l Top Source Country for GEO
l Top Destination Country for GEO
l Top Action by Source for GEO
l Top Action by Source Country for GEO
l Top Category by VS for IP Reputation
l Top Source for IP Reputation
l Top Destination for IP Reputation
l Top Source Country for IP Reputation
l Top Destination Country for IP Reputation
l Top Attack Type by VS for WAF
l Top Attack Type by Source Country for WAF
l Top Attack Type by Source for WA
l Top Attack Type by Destination Country for WAF
l Top Attack Type by Destination for WAF
l Top Platform Name by Destination for AV
l Top Platform Name by Destination Country for AV
l Top Platform Name by Source for AV
l Top Platform Name by VS for AV
l Top Reference by Destination for AV
l Top Reference by Destination Country for AV
l Top Reference by Source for AV
l Top Reference by Source Country for AV
l Top Reference by VS for AV

History Chart A "history" chart shows historical data that the system captured over a specific time
period in the past. The option is turned OFF (disabled) by default, but you can click the
button to turn it ON (enable it).
Note: If this option is turned off, you will get a pie chart when you save the widget. If it is
turned on, then you will see a bar chart. Both bar charts and line charts have a time-
range selector in their upper-right corner which allows you to select one of the following:
l 10 Minutes
l 1 Hour
l 1 Day
l 1Week
l 1 Month

Time Range Click the down arrow to select one of the following time ranges:
l 10 Minutes
l 1 Hour
l 1 Day
l 1Week
l 1 Month

Note: This option becomes unavailable if History Chart is enabled.
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Chart/Graph Description

Data Type Note: For this 4.8.1 release, Count is the only option and is selected by default. No
action is needed.

Top X Specify a maximum value for the X axis.
Note: The default is 5, but the valid values are from 3 to 7.

Top Y Specify a maximum value for the Y axis.
Note: The default is 5, but the valid values are from 3 to 7.

Viewing the quarantine monitor

To view the files that have been quarantined according to the policies you set in Network Security > Anti-Virus, go to
FortiView > Security > Data Analytics > Quarantine Monitor.

Quarantined file

File Name The name of the quarantined file. Format: Checksum+Protocol.

Checksum The checksum of the file.

Size The size of the quarantined file.

First Timestamp The time at which the file was first recorded.

Last Timestamp The time at which the file was caught.

Service The protocol of the quarantine file, HTTP, HTTPS, or SMTP.

Status Infected—the file is infected. Note: no other statuses.

Duplicate Count How many times the virus was scanned out between the first timestamp and the
last timestamp.

Time to Live Lifetime of the virus in quarantine.
l 0-336 hours—Howmany hours the virus has left to live.
l Expired—The virus is expired. Note: seldom will you see this, as the expired
virus will be removed from the quarantine monitor, since it is no longer
relevant.

l Forever—The virus will never expire. A copy of the virus is kept here to give
notice to the user. Note: The virus is no longer a threat since it is blocked.

Description The virus type.

Security Logs

The FortiView > Security Logs page provides you with graphical analysis tools to view and analyze the statistical data
collected from Log & Report > Security Log. All security logs from Log & Report > Security Log can be accessed from
FortiView > Security Logs except for logs related to the Firewall module.
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There are two types of FortiView logs:

l Security Log on page 127— displays a bar graph of the security log event count against a specific time-period, from
where you can drill down to a detailed view of particular logs.

l Aggregate Log on page 130— displays a doughnut chart and bar graph that provide an aggregate view of security
logs within a selected time-frame.

Security Log

From the Security Log tab, you can generate a bar graph of the log count and time-period of your choosing. The default
selection is ALL, which generates a second bar graph of the log count of all security logs by category.

To view and filter the security log data:

1. Navigate to the settings along the top of the window.
2. Select the Security Log Category. The table below lists the available log options and their associated security

module.

Security Log Category Security Module

AV Detection Anti Virus
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Security Log Category Security Module

DDoS DNS Query Flood DoS Protection

DDoS DNS Reverse Flood

HTTP Access Limit

HTTP Connection Flood

HTTP Request Flood

IP Fragmentation Attack

TCP Access Flood

TCP Slow Data Attack

TCP SYN Flood

GEO Blocklist Geo IP Blocklist

IP Reputation IP Reputation

Intrusion Detection Intrusion Prevention System
(IPS)

Anti Defacement Web Application Firewall (WAF)

API Gateway

Bot Detection

Brute Force Login

Cookie Security

CORS Protection

Credential Stuffing Defense

CSRF Protection

Data Leak Prevention

SQL/XSS Inject Detection

HTTP Input Validation

HTTP Protocol Constraint

JSON Validation

OpenAPI Validation Detection

SOAP Validation

URL Protection

Attacks(Signature)

Web Scraping

XML Validation
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3. Select the time-period from which the selected security logs should be included to generate the graph.
You have the following options:
l 1 Hour
l 6 Hours
l 1 Day
l 1Week
l 1 Month
l 1 Year

From each graph, you can click on any data point to view the associated logs for further analysis. The log columns

displayed depends on the security log category. For additional detail, click the (Detail icon) to show the log details.
For further description of each log message, see the FortiADC Log Reference.

The following table describes the columns for each security log.

Column Description

Date Log date.

Time Log time.

Count The Count column is only available for security logs related to DoS Protection,
Geo IP Blocklist, and IP Reputation.
Rule match count.

Source Source IP address.

Destination Destination IP address.

Action Action type that was taken as a result.

Destination Destination IP address.

Service The Service column is only available for security logs related to Anti Virus and
IPS.
Specifies the service type.

Severity The Service column is only available for security logs related to Anti Virus,Geo
IP Blocklist, IPS andWAF.
Specifies the security level.

Virus Category The Virus Category column is only available for security logs related to Anti
Virus.
Specifies the virus category.

Rule Name The Rule Name column is only available for security logs related to IPS.
Specifies the security rule name.

WAF Subcategory TheWAF Subcategory column is only available for security logs related toWAF.
Specifies the Web Application Firewall subcategory.

Action Action type that was taken as a result.
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Column Description

(Detail icon) Click the (Detail icon) for the log details. For further description of each log
message, see the FortiADC Log Reference.
ForWAF related security logs, the following actions may be performed directly
from the log details:
l Add Exception— You can addWAF Exceptions directly from the WAF log.
This option appears only for WAF subcategories that support WAF
Exceptions. For details, see Configuring WAF Exception objects on page
548.

l Disable Signature— You can disable WAF signature profiles directly from
the WAF log. This option appears only for Attacks Signature WAF
subcategories. Disable Signature can only be successful if the WAF
signature profile exists, otherwise the disable will fail with the error message
"Entry not found".

l View Signature— You can view the WAF signature status and information
directly from the WAF log. This option appears only for Attacks Signature
WAF subcategories.

Aggregate Log

From the Aggregate Log tab, you can generate two graphs, a doughnut chart of the security logs by date and a
horizontal bar graph of the security logs by category. these graphs provide an aggregate view of security logs within the
time-period of your choosing.

To view and filter the aggregate log data:

1. Navigate to the settings along the top of the window.
2. Select the security logs from the following options:

l IP Reputation— Traffic logged by the IP Reputation feature.
l DDoS— Traffic logged by the DoS Protection feature.
l WAF— Traffic logged by the Web Application Firewall feature.
l GEO—Traffic logged by the Geo IP block list feature.
l AV— Traffic logged by the Anti Virus module.
l IPS— Traffic logged by the IPS feature.

3. Select the time-frame from the following options:
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l 3 Days
l 5 Days
l 7 Days

From each graph, you can click on any data point to view the associated logs for further analysis. The log columns

displayed depends on the security log category. For additional detail, click the (Detail icon) to show the log details.
For further description of each log message, see the FortiADC Log Reference.

The following table describes the columns for each security log.

Column Description

Date Log date.

Time Log time.

Count The Count column is only available for DDoS,GEO, and IP Reputation.
Rule match count.

Source Source IP address.

Destination Destination IP address.

Action Action type that was taken as a result.

Destination Destination IP address.

Service The Service column is only available for AV and IPS.
Specifies the service type.

Severity The Service column is only available for security logs related to AV,GEO, IPS
andWAF.
Specifies the security level.

Virus Category The Virus Category column is only available for security logs related to AV.
Specifies the virus category.

Rule Name The Rule Name column is only available for security logs related to IPS.
Specifies the security rule name.

WAF Subcategory TheWAF Subcategory column is only available for security logs related toWAF.
Specifies the Web Application Firewall subcategory.

Action Action type that was taken as a result.

(Detail icon) Click the (Detail icon) for the log details. For further description of each log
message, see the FortiADC Log Reference.
ForWAF security logs, the following actions may be performed directly from the
log details:
l Add Exception— You can addWAF Exceptions directly from the WAF log.
This option appears only for WAF subcategories that support WAF
Exceptions. For details, see Configuring WAF Exception objects on page
548.
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Column Description

l Disable Signature— You can disable WAF signature profiles directly from
the WAF log. This option appears only for Attacks Signature WAF
subcategories. Disable Signature can only be successful if the WAF
signature profile exists, otherwise the disable will fail with the error message
"Entry not found".

l View Signature— You can view the WAF signature status and information
directly from the WAF log. This option appears only for Attacks Signature
WAF subcategories.

Blocked IP

The FortiView > Blocked IP page displays all client IP addresses that are currently blocked by WAFmodules through
the Block or Period Block actions. Through the FortiView > Blocked IP page, you can view and release IP addresses
prior to the block expiry period.

From theWAF Blocked IP tab, you can filter through the list of WAF blocked IP addresses and release any or all of the
IP addresses that match the filter criteria.

To filter the blocked IP list:

1. Click Add Filter to display the filter editor.
2. Select either the Address or VS Name from which to filter the WAF Blocked IP list.

a. To filter by Address, enter the IP address to complete the filter equation.
b. To filter by VS Name, select the virtual server name from the drop-down menu to complete the filter equation.

3. Click Apply.

The blocked IP addresses that match the filter criteria display in the list.
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To release the blocked IP address:

You can release blocked IP addresses through any of the following options:

l Release all listed IP addresses—Click Release All.

l

Release multiple selected IP addresses— Select the IP addresses from the list and click the (Release
button).

l Release a single IP address— Locate the IP address from the list and click the (Release icon) in that row.

The following table describes the columns of the blocked IP address list:

Column Description

Address The blocked IP address.

VS Name The virtual server that has blocked the IP address.

Expire The remaining time the IP address is blocked in seconds.

Click the (Release icon) to release the IP address.

System

The FortiView > System sub-menu shows system information captured by FortiADC.

It has the following pages:

l Event Logs on page 133
l Automation on page 134

Event Logs

Under the FortiView Security sub-menu, the Event Logs page shows all system event logs that FortiADC generated.

FortiADC Handbook 133
Fortinet Technologies Inc.



FortiView

Setting log filters

1. Go to the far right and locate the System and Time figures, as highlighted in red.

2. Choose the filters.

l The logs are presented in a tabular format, with each row being a log entry. The log table shows some key
information contained in the logs.

l You can drag a blue rectangle over the graph to show the logs for a certain span of time.

Automation

Under the FortiView System sub-menu, the Automation page shows the automation alert messages that the system has
generated.

Setting alert filters

You can use the Filter Setting button in the upper-left corner of the page to filter logs displayed on the page.

To set your filter:

1. Click Filter Setting.
2. The following diagram will appear below, with an Apply button.
3. Select between the following filters: Trigger Time, Alert, Priority, Message.
4. Click OK when done.
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You can apply multiple filters to the page. All filters you have configured will appear under the Filter Setting button in the
order they are created. To remove a filter, click the x sign on it; to clear all filters, click Remove All Filters.

Viewing alerts

The alert messages are presented in a tabular format, with each row being an alert entry. The alert table shows some
basic information about each alert. You can view details of an alert by clicking the log, which will drop down with the
following information: Timestamp, Resource Name, level, Summary.

You can also remove alerts from the page by clicking the corresponding x button.

Global Load Balance

The FortiView > Global Load Balance sub-menu shows global load-balancing configurations on your FortiADC.

It has two pages:

l Host on page 135
l Data Analytics on page 136

Host

Under the FortiView Global Load Balance sub-menu, the Host page shows global load-balancing host configurations
in a tabular format. The first thing you see is the Summary. It shows you the health of all the hosts. If you want to see it in
more detail, you can Enable All Analytics.

You will see the following information about each host: 

l Name
l Host Domain
l Total Response
l Current
l Virtual Server Pool
l Response
l Health

To no longer view the Analytics, click Disable All Analytics.

Editing a host

Click the name of the host to edit it. For instructions on how to edit a global load balance host, see Configuring hosts on
page 499

Click the number next to arrow icon in Virtual Server Pool to show the virtual servers inside the pool.
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Data Analytics

Under the FortiView Global Load Balance sub-menu, the Data Analytics page shows global load-balancing
information in charts called "widgets". You can create Dynamic Charts using the AddWidget button at the top right. The
Refresh button will refresh the charts.

1. 1. After clicking Add Widget, the Analytic dialogue box will open.
2. 2. Select the Type. Based on what type you select, the type will appear as the box below it. So if you select type

Virtual Server Pool, in the second box, you will be able to select a preexisting virtual server pool, or create a new
one.

3. 3. Select the range.

Chart/Graph Description

Type Data Center, Virtual Server Pool, Server, Link

Range 1HOUR, 6HOURS, 1DAY, 1WEEK, 1MONTH, 1YEAR

Data Analytics Widget

Link Load Balance

The FortiView > Link Load Balance sub-menu shows link load-balancing configurations on your FortiADC.

It has one page:

l Gateway on page 136

Gateway

Under the FortiView Link Load Balance sub-menu, the Gateway page shows gateway configurations in a tabular
format. It provides the following information about each gateway:

l Name
l IP Address
l Availability (Up or Down)
l Inbound Bandwidth
l Outbound Bandwidth
l Health Check

Monitoring traffic

You can display traffic going through a gateway using charts by selecting the corresponding check box in the Monitor
column.

Monitoring traffic on a link
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Editing gateway configuration

You can edit the configuration of a gateway for a link group by clicking the corresponding Edit button. For instructions on
how to edit a gateway configuration, see Configuring gateway links on page 487

ZTNA FortiClient endpoint

Under the FortiView > FortiClient sub-menu, you can monitor the ZTNA page for the real-time status of the endpoints
registered to FortiClient EMS. From here, you can view the FortiClient endpoint information and status that are
synchronized to FortiADC from FortiClient EMS.

The FortiClient endpoint information is integral to the Zero Trust Network Access (ZTNA) functionality. For more
information, see Zero Trust Network Access (ZTNA) on page 691 and How device identity and trust context is
established with FortiClient EMS on page 695.

The following describes the information displayed in each column:

Column Description

Hostname The hostname of the endpoint device. This column is displayed by default.
Note: You can hover over the Hostname column to view the device details
synchronized from the FortiClient EMS.

Address The IP address of the endpoint device. This column is displayed by default.

FortiClient Version The FortiClient version installed on the endpoint device. This column is displayed
by default.

Public IP The public IP address of the endpoint device. This column is displayed by default.

Tags The ZTNA tags assigned to the endpoint device. This column is displayed by
default.
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Column Description

MAC The MAC address of the endpoint device. This column is not displayed by default
and must be added manually.

OS Type The operating system installed on the endpoint device. This column is not
displayed by default and must be added manually.

OS Version The operating system version installed on the endpoint device. This column is not
displayed by default and must be added manually.

You can add or remove columns from display by clicking the (gear icon) to open the Column Configuration editor.
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The Systemmenu contain features and configurations that allow you to manage the system.

This section is organized into the following sub-menu topics:

l Settings on page 139
l Virtual Domain on page 153
l High Availability on page 162
l Traffic Group on page 195
l Administrator on page 197
l WCCP on page 208
l SNMP on page 209
l Replacement Messages on page 214
l FortiGuard on page 215
l Debug on page 223
l Certificate on page 224

Settings

The System > Settings sub-menu includes the following topics:

l Configuring basic system settings on page 139
l Configuring system time on page 141
l Updating firmware on page 142
l Configuring an SMTPmail server on page 145
l Pushing/pulling configurations on page 145
l Backing up and restoring configuration on page 148

Configuring basic system settings

The basic system settings page includes configuration options for the following settings and features:

l Hostname
l Web UI language
l Management service ports
l DNS
l Virtual domain

Before you begin:

l You must have Read-Write permission for System settings.
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To configure basic system settings:

1. Go to System > Settings.
The configuration page displays the Basic tab.

2. Complete the configuration as described in Basic settings configuration on page 140.
3. Save the configuration.

Settings Guidelines

Hostname You can configure a hostname to facilitate systemmanagement. If you use SNMP, for example,
the SNMP system name is derived from the configured hostname.The hostname can be up to 35
characters in length. It can include US-ASCII letters, numbers, hyphens, and underscores, but
not spaces and special characters.

The System Information widget and the get system status CLI command display the full
hostname. If the hostname is longer than 16 characters, the name is truncated and ends with a
tilde ( ~ ) to indicate that additional characters exist, but are not displayed.

Language English or Simplified Chinese.

Idle Timeout Log out an idle administrator session. The default is 30 minutes.

HTTP Port Specify the port for the HTTP service. Usually, HTTP uses port 80.

Redirect to HTTPS When enabled, all HTTP connections to FortiADC will be redirected to HTTPS. HTTPS-Redirect
switch is enabled by default.

HTTPS Port Specify the port for the HTTPS service. Usually, HTTPS uses port 443.

Telnet Port Specify the port for the Telnet service. Usually, Telnet uses port 25.

SSH Port Specify the port for the SSH service. Usually, SSH uses port 22.

Primary DNS The systemmust be able to contact DNS servers to resolve IP addresses and fully qualified
domain names. Your Internet service provider (ISP) might supply IP addresses of DNS servers,
or you might want to use the IP addresses of your own DNS servers. You must provide unicast,
non-local addresses for your DNS servers. Localhost and broadcast addresses are not
accepted.

Incorrect DNS settings or unreliable DNS connectivity can cause issues with other features, such
as FortiGuard services and NTP system time.

Secondary DNS IPv4/IPv6 address of the secondary DNS server for your local network.

Virtual Domain Enables the virtual domain feature. Before you enable it, make sure you understand how the
system implements virtual domains. See Virtual Domain.

Config Sync
Enable

Enable/disable the configuration synchronization feature. This feature is related to
Pushing/pulling configurations, not HA synchronization. Disabled by default.

Pre Login Banner Enable/disable the pre-login banner feature to show login disclaimer messages. Disabled by
default.

Basic settings configuration
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Configuring system time

The system time must be accurate for many features to work, including scheduling, logging, and SSL/TLS-related
features.

We recommend that you use Network Time Protocol (NTP) to maintain the system time. As an alternative when NTP is
not available or is impractical, you can set the system time manually.

You can change the system time with the web UI or the CLI.

Before you begin:

l You must have Read-Write permission for System settings.

To configure the system time:

1. Go to System > Settings.
2. Click theMaintenance tab.
3. Complete the configuration as described in System time configuration on page 141.
4. Save your changes.

Setting Guidelines

System Time Displays the system time. You can use NTP to set the system time, or use the controls to set the
system time manually. Specify time in HH:MM:SS format.

Daylight Saving
Time

Enable if you want the system to adjust its own clock when its time zone changes between
daylight saving time (DST) and standard time.

Time Zone Select the time zone where the appliance is located.

NTP

NTP Select to use NTP.

NTP Server Specify a space-separated list of IP addresses or FQDNs for an NTP server or pool, such as
pool.ntp.org.

To find an NTP server, go to http://www.ntp.org.

Synchronizing
Interval

Specify how often the system synchronizes its time with the NTP server. The default is 60
minutes. The valid range is 1-1440.

System time configuration
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To configure NTP using the CLI:

config system time ntp
set ntpsync enable
set ntpserver {<server_fqdn> | <server_ipv4>}
set syncinterval <minutes_int>
end

To configure the system time manually:

config system time ntp
set ntpsync disable
end
config system time manual
set zone <timezone_index>
set daylight-saving-time {enable|disable}
end
execute date <MM/DD/YY> <HH:MM:SS>

Updating firmware

This topic includes the following information:

l Upgrade considerations
l Updating firmware using the web UI
l Updating firmware using the CLI

Upgrade considerations

The following considerations help you determine whether to follow a standard or non-standard upgrade procedure:

l HA—Updating firmware on an HA cluster requires some additions to the usual steps for a standalone appliance.
For details, see Updating firmware for an HA cluster.

l Re-imaging— If you are installing a firmware version that requires a different size of system partition, you might be
required to re-image the boot device. Consult the release notes. In that case, do not install the firmware using this
procedure. Instead, see Restoring firmware (“clean install”).

l Downgrades— If you are downgrading the firmware to a previous version, and the settings are not fully backwards
compatible, the systemmight remove incompatible settings or use the default values for that version of the
firmware. You may need to reconfigure some settings.

Firmware versions are tagged to indicate the maturity level of its feature
development:
l Feature (F) — New features are included in this version.
l Mature (M)— This version primarily includes bug fixes and/or vulnerability
patches, and no new or major features.

Important: Read the release notes for release-specific upgrade considerations.

Updating firmware using the web UI

Firmware can be loaded on two disk partitions: the active partition and the alternate partition. The upgrade procedure:
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l Updates the firmware on the inactive partition and then makes it the active partition.
l Copies the firmware on the active partition, upgrades it, and installs it in place of the configuration on the inactive
partition.

For example, if partition 1 is active, and you perform the upgrade procedure:

l Partition 2 is upgraded and becomes the active partition; partition 1 becomes the alternate partition.
l The configuration on partition 1 remains in place; it is copied, upgraded, and installed in place of the configuration
on partition 2.

The reason for this is to preserve the working system state in the event upgrade fails or is aborted.

Before you begin:

l Download the firmware file from the Fortinet Customer Service & Support website: https://support.fortinet.com/.
l Read the release notes for the version you plan to install.
l Back up your configuration before beginning this procedure. Reverting to an earlier firmware version could reset
settings that are not compatible with the new firmware.

l You must have super user permission (user admin) to upgrade firmware.

To boot the firmware on the alternate partition:

l Click Boot Alternate Firmware.

The system reboots, the alternate becomes the active firmware, and the active becomes the alternate firmware.

To update firmware:

1. Go to System > Settings.
2. Click theMaintenance tab.
3. Scroll to the Upgrade section.
4. Click Choose File to locate and select the file.

5. Click to upload the firmware and reboot.

The system replaces the firmware on the alternate partition and reboots. The alternate (upgraded) partition becomes the
active, and the active becomes the alternate.

When you update software, you are also updating the web UI. To ensure the web UI
displays the updated pages correctly:
l Clear your browser cache.
l Refresh the page.

In most environments, press Ctrl-F5 to force the browser to get a new copy of the
content from the web application. See the Wikipedia article on browser caching
issues for a summary of tips for many environments:
https://en.wikipedia.org/wiki/Wikipedia:Bypass_your_cache.

Updating firmware using the CLI

The CLI upgrade procedure replaces the firmware on the alternate partition and reboots. The alternate (upgraded)
partition becomes the active, and the active becomes the alternate.

Note: The CLI does not have an equivalent of the web UI Boot Alternative Firmware command.
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Before you begin:

l Read the release notes for the version you plan to install. If information in the release notes is different from this
documentation, follow the instructions in the release notes.

l You must be able to use TFTP to transfer the firmware file to the FortiADC. Download and install a TFTP server, like
tftpd (Windows, Mac OS X, or Linux), on a server on the same subnet as the FortiADC.

l Download the firmware file from the Fortinet Customer Service & Support website: https://support.fortinet.com/
l Copy the firmware image file to the root directory of the TFTP server.
l Back up your configuration before beginning this procedure.
l You must have super user permission (user admin) to upgrade firmware.

TFTP is not secure, and it does not support authentication. You should run it only on
trusted administrator-only networks, and never on computers directly connected to
the Internet. Turn off tftpd off immediately after completing this procedure.

To install firmware via the CLI:

1. Connect your management computer to the FortiADC console port using an RJ-45-to-DB-9 serial cable or a null-
modem cable.

2. Initiate a connection to the CLI and log in as the user admin.
3. Use an Ethernet cable to connect FortiADC port1 to the TFTP server directly, or connect it to the same subnet as

the TFTP server.
4. If necessary, start the TFTP server.
5. Use the following command to transfer the firmware image to the FortiADC system:

execute restore image tftp <filename> <tftp_ipv4>

The following example shows an upgrade:
FortiADC-VM # execute restore image tftp FAD_VM-v400-build0308-FORTINET.out 192.0.2.1
This operation will replace the current firmware version!
Do you want to continue? (y/n)y
Connect to tftp server 192.0.2.1 ...
Please wait...
##############################################################
Get image from tftp server OK.
Check image trailer OK.
Check image OK.
FortiADC-VM #
The following example shows a downgrade:
FortiADC-VM # execute restore image tftp FAD_VM-v400-build0307-FORTINET.out 192.0.2.1
This operation will replace the current firmware version!
Do you want to continue? (y/n)y
Connect to tftp server 192.0.2.1 ...
Please wait...
#############################################################
Get image from tftp server OK.
Check image trailer OK.
This operation will downgrade the current firmware version!
Do you want to continue? (y/n)y
FortiADC-VM #

6. To verify the upgrade, display the system version number:
FortiADC-VM # get system status
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Version: FortiADC-VM v4.2.0,build0307,150209
VM Registration: Valid: License has been successfully authenticated with registration

servers.
VM License File: License file and resources are valid.
VM Resources: 1 CPU/1 allowed, 1620 MB RAM/2048 MB allowed, 23 GB Disk/1024 GB allowed
...

If the download fails after the integrity check with the error message invalid
compressed format (err=1, but the firmware matches the integrity checksum
on the Fortinet Customer Service & Support website, try a different TFTP server.

Configuring an SMTP mail server

You can configure an SMTP email server if you want to send alerts by email.

Before you begin:

l You must have Read-Write permission for System settings.

To configure SMTP:

1. Go to System > Settings.
2. Click the Services tab.
3. Complete the configuration as described in SMTP configuration on page 145.
4. Save the configuration.

Settings Guidelines

Address IP address or FQDN of an SMTP server (such as FortiMail) or email server that the appliance
can connect to in order to send alerts and/or generated reports.

Port Listening port number of the server. Usually, SMTP is 25.

Authentication Enable if the SMTP server requires authentication.

Security STARTTLS is an extension to plain text communication protocols. It enables a plain text
connection to be upgraded to an encrypted (TLS or SSL) connection instead of using a separate
port for encrypted communication.
SMTPS is not supported by FortiADC, so if you want to build up secure connections with
FortiADC, STARTTLS can work as an substitution to SMTPS.

Username Username for authentication to the SMTP server.

Password Password for authentication to the SMTP server.

SMTP configuration

Pushing/pulling configurations

You can use the sync list configuration page to push or pull sets of configuration objects to or from a target FortiADC
appliance. The push/pull operation is a manual operation. It is not repeated automatically.
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Before you begin:

l Configuration synchronization must be enabled on the appliances. Go to System > Settings > Basic.
l You must plan for the impact the configuration push/pull has on the target deployment.
l You must have Read-Write permission for System settings.

To push or pull a configuration:

1. Go to System > Settings.
2. Click the Sync List tab.
3. Click Create New and complete the configuration as described in Table 126.

After you have saved the configuration, it is added to the configuration table.
4. To execute the push/pull operation, select the configuration from the table, select From or To, and click Sync.
5. Check the Status column in the table to see the result of the push/pull operation.
6. Log into the target appliance and check the configuration logs (Log & Report > Log Browsing > Event Log >

Configuration. Notice the log entries for each configuration change resulting from the push/pull operation.

Settings Guidelines

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces.
After you initially save the configuration, you cannot edit the name.

Server IP IP address of the remote appliance.

Password Password for the admin account on the remote appliance.

Type l System—Includes config config, config system (except config system
mailserver), config user, and config vdom commands.

l Networking—Includes config router commands.
l SLB—Includes config load-balance commands.
l Log—Includes config log commands and config system mailserver.
l LLB—Includes config link-load-balance commands.
l GLB—Includes config global-load-balance and config global-dns-
server commands.
Note: The Shared Resource type is automatically selected when GLB is selected. If any
GLB configurations reference a shared resource, that shared resource configuration must
be synced together with the GLB configuration, otherwise the GLB configuration will not
work with the missing referenced object.

l Security—Includes config security waf commands.
l Shared Resource—Includes the shared resources that are used across different
modules.
These configurations include the following commands:
config system health-check
config system health-check-script
config system schedule-group
config system address
config system address6
config system addrgrp
config system addrgrp6

Sync List configuration
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Settings Guidelines

config system isp-addr
config system service
config system servicegrp

l User—Includes config user commands.
Note: For each of the above settings, there are certain parameters that cannot be
synchronized through the Sync List feature. For details,

Table 127 highlights the commands that cannot be synced using the Sync List feature, and must be handled manually on
a per appliance basis..

Module Commands

System l system global
l system tcpdump
l system accprofile
l system admin
l system ha
l system snmp sysinfo
l system snmp community
l system snmp user
l system alert-snmp-trap
l system fortiguard
l system hsm info
l system hsm partition
l config sync-list

Networking l firewall qos-filter
l firewall qos-filter6
l router policy
l router isp
l router setting
l firewall nat-snat
l firewall vip
l router md5-ospf
l router ospf
l router bgp
l system interface
l router static

LLB l link-load-balance virtual-tunnel
l link-load-balance flow-policy

Security l firewall policy
l firewall policy6
l firewall connlimit
l firewall connlimit6

SLB l load-balance ippool

Commands that cannot be synced via the Sync List feature
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Module Commands
l load-balance virtual-server

GLB l global-load-balance setting
l global-dns-server general

Log & Report l systemmailserver

Backing up and restoring configuration

You use the backup procedure to save a copy of your system configuration. A full backup is a zip file.

The backup feature has a few basic uses:

l Saving the configuration as CLI commands that a co-worker or Fortinet support can use to help you resolve issues
with misconfiguration.

l Restoring the system to a known functional configuration.
l Creating a template configuration you can edit and then load into another system using the restore procedure.

A complete configuration backup is a zip file that includes the complete configuration files, plus any files you have
imported, including error page files, script files, and ISP address book files.

In the event that FortiADC experiences hardware failure, being able to restore the entire backup configuration minimizes
the time to reconfigure the system.

All backup files follow the same file-naming convention: hostname_date_time. For example, a backup file named
"FortiADC-VM_20171214_0830.txt" means that the backup is made of a system whose hostname is "FortiADC-
VM", the backup is made at 08:30 on December 14, 2017. It must be noted that the date and time in the backup file name
reflects the date and time in your FortiADC's system settings when the backup is performed.

Note: Configuration backups do not include data such as logs and reports.

Back up files can include sensitive information, such as HTTPS certificate private
keys. We strongly recommend that you password-encrypt your backup files and
store them in a secure location.

Before you begin:

l If you are restoring a configuration, you must know its management interface configuration in order to access the
web UI after the restore procedure is completed. Open the configuration file and make note of the IP address and
network requirements for the management interface (port1). You must also know the administrator username and
password.

l You must have Global Administrator access. Ensure that your admin account settings hasGlobal Admin set to
Yes. For more information, see Creating administrator users on page 199.

To backup or restore your system configuration:

1. From navigation bar, click System > Settings.
2. Click the Backup & Restore tab.
3. Select the desired action and storage location, as described in Backup and restore configuration on page 149.
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4. Follow the instructions in the following paragraphs to back up or restore your configuration, or schedule auto
backups.

Actions Guidelines

Mode Select one of the options:
l Back Up—Use this option to back up the current configuration. Note: The backup is saved to
a text file.

l Restore—Use this option to restore a previous configuration. The restore file must be a text
file.

l Auto Backup—Use this option to let FortiADC automatically back up its configuration as
scheduled.

Storage Select one of the storage locations:
l Local PC/Server—The local PC or server. (Note: When scheduling auto backups, this refers
to the SFTP server.)

l ADC—Your FortiADC device.

Entire
Configuration

Enable this option to include error page files, script files, and ISP address book files in the backup
file.
Note: The backup is saved to a tar file. ADC

Backup and restore configuration

Run a manual backup

You can back up your FortiADC system configuration at any time from the System>Settings>Backup & Restore page
using the following procedures.

1. Select Back Up.
2. Select a storage location for the backup file, Local PC/Server or ADC.
3. Specify a name.
4. Add a password if you want.
5. The maximum total backup file size differs by model. For more information, see Maximum total backup file size by

hardware model on page 151.
6. Click Back Up.

Note: If you've chosen to back up your configuration to the local PC or server, the backup file will appear in the lower-left
corner of the GUI. The configuration backup file can be found on the PC or server where all downloaded files are stored.
When backing up to a local PC or server, you have the option to use a password to protect the backup file. The option is
disabled by default. To use this option, you must enable it first, and then create a password for the configuration backup
you are going to do. Be sure to remember the password because it is required when you restore the configuration
backup file.

If you've chosen to back up to FortiADC device, the backup file will show up in the table on the Backup & Restore page,
where you can either download or upload the backup file using the Download or Upload icon to the far-right column of the
same row.

Restore a backup configuration

Use the following procedures to restore a backup of a previous configuration.

1. Select Restore.
2. Select the storage location where the backup file resides.
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3. To restore from the Local PC/Server, click Choose File, then upload the desired file.
4. To restore from FortiADC, select the backup from the table, and click the corresponding Restore icon, on the far

right.

Note: The time required to restore a backup file varies, depending on the size of the file and the speed of your network
connection. Your web UI session is terminated when the system restarts. To continue using the web UI, refresh the web
page and log in again.

If the restored system has a different management interface configuration than the previous configuration, you must
access the web UI using the new management interface IP address.

Schedule auto backups

FortiADC's auto backup feature allows you to conveniently set up configuration backup schedules so that it can perform
the backups for you automatically according to the schedule. Backup files can be saved on yourFortiADC or a local
device via SFTP. It must be noted that you can only store up to 10 backup files on FortiADC at any given time and that
the size of all backup files combined must not exceed the limit allowed on your hardware model, as stipulated in the table
below.

The Auto Backup configuration page also comes with an Overwrite Config check box, which (if enabled) will let the
system automatically delete backup files when the number or the size of saved backup files exceeds either limit.
Removal of backup files is done in a FIFO (first-in, first-out) fashion, starting with the oldest backup. If Overwrite Config is
not enabled, the system will generate error log messages when the backup files exceed the limits.

Schedule auto backups onto FortiADC:

1. Select Auto Backup.
2. Select ADC as the storage location where the backup files will be saved.
3. Enable the scheduled backup radio button.
4. Specify the scheduled backup frequency, and set the schedule accordingly.
5. Select the Overwrite Config radio button (recommended).
6. Click Save.

Schedule auto backups onto an SFTP sever:

To schedule auto backups onto an SFTP server, you must have a user account on the server and provide the
information required about the server, such as its IP address, port number, backup location, and your account user name
and password.

1. Select Auto Backup.
2. Select Local PC/Server (SFTP server) as the storage location where the backup files will be saved.
3. Select the Scheduled Backup radio button.
4. Specify the scheduled backup frequency, and set the schedule accordingly.
5. Enter the IP address of the SFTP server.
6. Enter the port of the SFTP server.
7. Specify the backup file path on the SFTP server, in Folder.
8. Enter your username for the SFTP server.
9. Enter your password for the SFTP server.
10. Click Save.
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Schedule auto backups from the Console

Use the following commands to set up auto backup from the Console:

config system auto-backup
set storage {sftp| disk}
set address <ip>
set port <port>
set username <name>
set password <password>
set folder <local directory>
set overwrite {enable|disable}
set schedule-backup-day {Sunday | Monday | Tuesday | Wednesday | Thursday | Friday |
Saturday}
set schedule-update-frequency {daily|weekly|every}
set schedule-update-time <hh:mm>
set backup-status {enable|disable}
end

Maximum total backup file size by hardware model

Hardware model Maximum total backup file size

FortiADC 60F 50 MB

FortiADC 100F 50 MB

FortiADC200D 50 MB

FortiADC 200F 50 MB

FortiADC 300D 100 MB

FortiADC 400D 100 MB

FortiADC 700D 100 MB

FortiADC 1000F 100 MB

FortiADC 1500D 100 MB

FortiADC 2000D 100 MB

FortiADC 2000F 200 MB

FortiADC 4000D 200 MB

FortiADC 4000F 200 MB

All FortiADC VMs 100 MB

Configuring DNS settings for non-root VDOM

For FortiADC systems with VDOM enabled, you can configure the System DNS resolver for non-root VDOMs and
override Global DNS settings to set a DNS server IP per VDOM for more flexibility.

This functionality is only available in the non-root VDOM. The root VDOM defaults to inherit the Global DNS settings.
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Note: The DNS settings per VDOM is also not available when VDOMs are in Share Network mode (ADOMmode) as all
ADOMs will share the same network namespace.

DNS settings per VDOM does not affect the following global modules which will continue to use Global DNS settings:

l Security Fabric external and fabric connectors
l URL filters
l FortiGuard
l SMTP for logs and alerts
l NTP
l Admin FortiToken Cloud
l AntiVirus cloud

Before you begin:

l You must have VDOM enabled and have access to a non-root VDOM.
l You must have a good understanding of DNS and knowledge of the remote DNS servers that can be used to
communicate with Internet domain servers.

l You must have read-write permission for system settings.

To configure DNS settings for a non-root VDOM:

1. Go to System > Settings.
The configuration page displays the DNS tab.

2. Configure the following settings:

Setting Description

DNS Override Enable to apply the DNS settings configured for this non-root VDOM instead of
inheriting from the Global DNS settings.

Primary DNS Specify the IP address for the primary DNS server.

Second DNS Specify the IP address for the secondary DNS server.

3. Click Save.

FortiADC Handbook 152
Fortinet Technologies Inc.



Virtual Domain

The System > Virtual Domain sub-menu includes the following topics:

l Virtual Domain (VDOM) and Administrative Domain (ADOM) overview on page 153
l Enabling the Virtual Domain feature and selecting the Virtual Domain Mode on page 156
l Creating a virtual domain on page 157
l Assigning administrator users and network interfaces to VDOMs on page 157
l Virtual domain policies on page 158
l Disabling a virtual domain on page 161

Virtual Domain (VDOM) and Administrative Domain (ADOM) overview

A Virtual Domain (VDOM) is a complete FortiADC instance that runs on the FortiADC platform. VDOM configuration
objects contain all of the system and feature configuration options of a full FortiADC instance and can be used to divide a
FortiADC into two or more virtual units that function independently, allowing it to support multi-tenant deployments.

The VDOM feature supports two Virtual Domain Modes that allow the VDOMs to function independently with its own
networking or as administrative domains (ADOMs) with shared networking between all ADOMs. When the VDOM is in
the Independent Network mode, you can provision an administrator account with privileges to access and manage only
their assigned VDOM. The VDOM user can then configure their VDOM as desired untethered to other VDOMs.
Alternatively, when the VDOM is in Share Network mode, it functions as an ADOM that shares the same networking
interfaces and routing between all the ADOMs. The ADOM functionality enables the administrator to constrain access
privileges to a subset of server load-balancing servers by defaulting all interface settings to the root ADOM.

The Virtual Domains feature is not enabled by default and requires an administrator with "super admin" or "global admin"
access to enable. The admin account holder (also known as the "super admin") can enable and configure all VDOMs
and provision accounts with "global admin" access that grants administrators permissions to enable and configure
VDOMs as well. The super admin and global admin have unrestricted access to all virtual domains that have been
created on the system and can provision administrator accounts to access their assigned domains.

After the Virtual Domain feature is enabled, virtual domain administrators can enter their assigned VDOM/ADOM and
see a subset of the typical menus or CLI commands appear, allowing access to only the feature configurations, logs and
reports specific to their VDOM/ADOM. Unlike super admin and global admin users, VDOM/ADOM administrators do not
have access to global settings.

Differences between super admin/global admin, and VDOM/ADOM administrators when virtual domains
are enabled:

Super admin or global admin
user

VDOM/ADOM administrators

Access to global settings
(config global)

Yes No
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Super admin or global admin
user

VDOM/ADOM administrators

Can create administrator
accounts

Yes— administrator accounts can be
assigned to access other virtual
domains on the system.

Yes— administrator accounts can only
be assigned access to the VDOM/ADOM
administrator's own virtual domain.

Can create and access all
VDOMs/ADOMs

Yes No

Basic steps:

1. Enable the Virtual Domain feature and select the Virtual Domain Mode.
2. Create a VDOM or ADOM configuration object and assign administrators to the domain.
3. If the Virtual Domain Mode is Independent Network, then assign network interfaces and administrators to the

VDOM.
Note: If the Virtual Domain Mode is Share Network (ADOMmode), all network interface settings are restricted to the
root settings.

GUI and CLI functional availability for administrators of VDOM, root ADOM, and non-root ADOM

For administrators provisioned to access only their assigned virtual domains, the GUI and CLI functions available to
them depend on their Virtual Domain Mode and whether their virtual domain is root or non-root. VDOMs configured in the
Independent Network mode function independently within its own network, allowing the VDOM administrator to have full
unrestricted access to all configurations within their own VDOM. Administrators of VDOMs in the Independent Network
mode have full unrestricted access to all configurations within their own VDOM; as these VDOMs function independently
within their own network, modifications can be made without affecting other VDOMs on the system. In contrast,
administrators of ADOMs (VDOMs in Share Network mode) do not have full access to all configurations due to all
ADOMs sharing the same network interfaces and routing as the root ADOM. As a result, administrators of non-root
ADOMs have restricted access, partial access, or completely no access to GUI and CLI functions relating to networking.

The following table lists the difference in GUI/CLI function availability between root and non-root ADOM
administrators.

Configuration Root ADOM Non-root ADOM

Network Interface Virtual Domain option is hidden
from the Interface settings. The
interface settings are
automatically defaulted to the root
ADOM.

Read-only access for Interface
settings. Data pulled from root
ADOM.

Routing Read-write access for all
configurations.

Read-only access for all
configurations. Data pulled from
root ADOM.

NAT Read-write access for all
configurations.

No access to configurations. NAT
is hidden.

QoS Read-write access for all
configurations.

No access to configurations.QoS
is hidden.
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Configuration Root ADOM Non-root ADOM

Link Load
Balance

All configurations
under Link Load
Balance

Read-write access for all
configurations.

Read-only access for all
configurations. Data pulled from
root ADOM.

Global Load
Balance

All configurations
under Global Load
Balance

Read-write access for all
configurations.

No access to all configurations.
Global Load Balance is hidden.

Network
Security

Firewall Read-write access for all
configurations.

No access to all configurations.
Firewall is hidden.

DoS Protection Networking Read-write access for all
configurations.

Partial access: IP Fragmentation
Protection and TCP SYN Flood
Protection are hidden.

FortiView Logical Topology Read-write access for all
configurations.

Partial access:Global Load
Balance is hidden, and Link Load
Balance is read-only with data
pulled from root ADOM.

Host Read-write access for all
configurations.

No access to all configurations.
Host is hidden.

Data Analytics (under
Global Load Balance)

Read-write access for all
configurations.

No access to all configurations.
Data Analytics underGlobal
Load Balance is hidden.

Gateway Read-write access for all
configurations.

Read-only access to Link Load
Balance data pulled from root
ADOM. TheMonitor option is
hidden.

Interfaces Read-write access for all
configurations.

All FortiADC interfaces are shown.
Data pulled from root ADOM.

Log & Report Log Setting Read-write access for all
configurations.

Partial access: Link Load
Balance (LLB),Global Load
Balance (GLB), and Firewall
(FW) options are hidden from the
Local Log and Fast Stats
settings.

Traffic Log Read-write access for all
configurations.

Partial access: Link Load
Balance (LLB) andGlobal Load
Balance (GLB) filter options are
hidden.

Security Log Read-write access for all
configurations.

Partial access: Firewall filter
option is hidden.
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Configuration Root ADOM Non-root ADOM

Event Log Read-write access for all
configurations.

Partial access: Link Load
Balance (LLB),Global Load
Balance (GLB), and Firewall filter
options are hidden.

Report Setting Read-write access for all
configurations.

DNS-Top-Policy-by-Count and
DNS-Top-Source-by-Count are
not supported inQuery Set.

Enabling the Virtual Domain feature and selecting the Virtual Domain Mode

By default, the Virtual Domain feature must be enabled for the Virtual Domain configuration to be visible in the GUI. Once
you enable Virtual Domain, you can select the Virtual Domain Mode to determine the VDOM networking options.

There are two virtual domain modes:

l Independent Network — each VDOM functions independently within its own network, unaffected by activity from
other VDOMs on the system.

l Share Network — VDOMs function as administrative domains (ADOMs), sharing the same network interface and
routing between all ADOMs.

Once configured, switching between the virtual domain modes is not recommended.
If you need to switch virtual domain modes, the Virtual Domain feature must first be
disabled. For details, see Disabling a virtual domain on page 161.

Before you begin:

l You must have super admin (admin administrator) or global admin permission to enable the Virtual Domain feature.

To enable the Virtual Domain and select the Virtual Domain Mode:

1. Go to System > Settings.
The configuration page displays the Basic tab.

2. Enable Virtual Domain.
The Virtual Domain Mode field appears.

3. In the Virtual Domain Mode field, select either Independent Network or Share Network.
4. Click Save.

 Super admin login with virtual domain on page 156 shows the landing page after the super admin logs into the system
when the Virtual Domain feature is enabled. From here, the super admin can create virtual domains, assign network
interfaces to virtual domains, create admin users for virtual domains, and navigate to the system and feature
configuration pages for the virtual domains, including the root (default) domain.

When a non-admin user with a delegated administrator account logs in, the landing page is the standard landing page.
Such users cannot perform the tasks related to virtual domain administration that the super admin performs.

 Super admin login with virtual domain
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Creating a virtual domain

By default, FortiADC has a predefined virtual domain named "root" that you cannot delete or modify. The super admin
and global admin users are able to add, delete, enable, and disable any non-root virtual domains on the system.

Before you begin:

l You must have super admin (admin administrator) or global admin permission to create virtual domains.

To create a virtual domain:

1. Go to System > Virtual Domain.
2. Click Create New, enter a unique name for the virtual domain.
3. Click Save.

The newly created virtual domain is listed under the Virtual Domain page.
4. Optionally, double-click or click the (edit icon) of the virtual domain to create and impose custom policies.

This function is only applicable for virtual domains in Independent Network mode. For more information, see Virtual
domain policies on page 158.
For more information about the Independent Network and Share Network virtual domain modes, see Virtual Domain
(VDOM) and Administrative Domain (ADOM) overview on page 153.

Assigning administrator users and network interfaces to VDOMs

After creating the virtual domain, you can assign administrator users to manage it. These virtual domain administrators
can access only the domain they are assigned.

For virtual domains in Independent Network mode, you need to assign network interfaces to the virtual domain. If the
Virtual Domain Mode is Share Network (ADOMmode), all network interface settings are defaulted to the root settings, so
assigning network interfaces is unnecessary.

Before you begin:

l You must have super admin (admin administrator) or global admin permission to assign administrator users and
network interfaces to virtual domains.

FortiADC Handbook 157
Fortinet Technologies Inc.



To create an administrator for a virtual domain:

1. Go to System > Administrator.
2. Click Create New to create an administrator.
3. Configure administrator settings and select the virtual domain.
4. Save the configuration.

When virtual domain administrators log into the FortiADC system, they do not see the Virtual Domain menu in the GUI.
Instead, they only see configuration settings and data for the virtual domain they have been assigned to. Furthermore,
the difference in what GUI and CLI functions are available to virtual domain administrators also depend on whether the
Virtual Domain Mode is Independent Network or Share Network. For more information, see Virtual Domain (VDOM) and
Administrative Domain (ADOM) overview on page 153.

To assign a network interface to a virtual domain:

1. Go to Networking > Interface.
2. Double-click an interface configuration or click Create New to create one.
3. Configure interface settings and select the virtual domain.
4. Save the configuration.

Virtual domain policies

For virtual domains in Independent Network mode, FortiADC allows you to create and apply custom policies or
restrictions on each virtual domain you have added. For each virtual domain, you can configure the maximum range for
its Dynamic Resources and Static Resources. Dynamic Resources are related to a virtual domain's performance, while
Static Resources are related to its configuration. The Vdom configuration dialog on page 158 also shows a virtual
domain's current configuration and workload settings, which serve as good reference points for you to fine-tune the
virtual domain. (For more information about the Independent Network and Share Network virtual domain modes, see
Virtual Domain (VDOM) and Administrative Domain (ADOM) overview on page 153.)

By default, all per-VDOM resource settings are set to have no limits. This means that any single VDOM can use all of the
FortiADC device's resources. This could deprive other VDOMs of the resources that they require, to the point that could
be unable to function. We recommend setting maximum values on the resources that are vital to you.

Custom virtual domain policies is not supported for FortiADC 5000F model.

Vdom configuration dialog
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VDOM configuration parameters

Parameter Description

Dynamic Resources

L4 CPS Shows the L4 CPS data transfer rate in kilobyte per second (kB/s) at the last page
refresh.
Note: You can set the VDOM's maximum L4 CPS data transfer rate by specifying
a desired value in the box. Valid values range from 0 to 1,000,000.

L7 CPS Shows the L7 CPS data transfer rate in kilobyte per second (kB/s) at the last page
refresh.
Note: You can set the VDOM's maximum L7 CPS data transfer rate by specifying
a desired value in the box. Valid values range from 0 to 1,000,000.
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Parameter Description

L7 RPS Shows the L7 RPS data transfer rate in kilobyte per second (kB/s) at the last page
refresh.
Note: You can set the VDOM's maximum L7 RPS data transfer rate by specifying
a desired value in the box. Valid values range from 0 to 1,000,000.

SSL CPS Shows the SSL CPS data transfer rate in kilobyte per second (kB/s) at the last
page refresh.
Note: You can set the VDOM's maximum SSL CPS data transfer rate by
specifying a desired value in the box. Valid values range from 0 to 1,000,000.

SSL Throughput Shows the SSL throughput rate in kilobyte per second (kB/s) at the last page
refresh.
Note: You can set the VDOM's maximum SSL throughput rate by specifying a
desired value in the box. Valid values range from 0 to 1,000,000.

Concurrent Session Shows the number of concurrent sessions at the last page refresh.
Note: You can set the VDOM's maximum number of concurrent sessions by
specifying a desired value in the box. Valid values range from 0 to 1,000,000.

Inbound Shows the inbound TCP data transfer rate in kilobyte per second (kB/s) at the last
page refresh.
Note: You can set the VDOM's maximum inbound TCP data transfer rate by
specifying a desired value in the box. Valid values range from 0 to 4,000,000.

Outbound Shows the outbound TCP data transfer rate in kilobyte per second (kB/s) at the
last page refresh.
Note: You can set the VDOM's maximum outbound TCP data transfer rate by
specifying a desired value in the box. Valid values range from 0 to 4,000,000.

Static Resources

Virtual Server Shows the number of virtual servers at the last page refresh.
Note: You can set the maximum number of virtual servers that can be configured
on this VDOM by specifying a desired value in the box. Valid values range from 0
to 1024.

Real Server Shows the number of real servers at the last page refresh.
Note: You can set the maximum number of real servers that can be configured on
this VDOM by specifying a desired value in the box. Valid values range from 0 to
1024.

Health Check Shows the number of health check objects at the last page refresh.
Note: You can set the maximum number of health check objects that can be
configured on this VDOM by specifying a desired value in the box. Valid values
range from 0 to 1024.

Source Pool Shows the number of source pools at the last page refresh.
Note: You can set the maximum number of source pools that can be configured
on this VDOM by specifying a desired value in the box. Valid values range from 0
to 1024.
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Parameter Description

Error Page Shows the number of error pages at the last page refresh.
Note: You can set the maximum number of error pages that can be configured on
this VDOM by specifying a desired value in the box. Valid values range from 0 to
1024.

Local User Shows the number of local users at the last page refresh.
Note: You can set the maximum number of local users that can be configured on
this VDOM by specifying a desired value in the box. Valid values range from 0 to
1024.

User Group Shows the number of user groups at the last page refresh.
Note: You can set the maximum number of user groups that can be configured on
this VDOM by specifying a desired value in the box. Valid values range from 0 to
1024.

Disabling a virtual domain

The Virtual Domain feature can be disabled through the Web UI. You may need to disable virtual domains in certain
scenarios, such as switching to a different Virtual Domain Mode.

Before you begin:

l You must have super admin (admin administrator) or global admin permission to disable the Virtual Domain
feature.

l You must have deleted all non-root virtual domains on the system, leaving only the root (default) virtual domain.

To disable the Virtual Domain feature:

1. Go to System > Settings.
The configuration page displays the Basic tab.

2. Disable Virtual Domain.
3. Click Save.

The FortiADC should refresh automatically.
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High Availability

The System > High Availability sub-menu includes the following topics:

l HA feature overview on page 162
l HA system requirements on page 166
l HA configuration synchronization on page 167
l Configuring HA settings on page 168
l Monitoring an HA cluster on page 173
l Updating firmware for an HA cluster on page 174
l Deploying an active-passive cluster on page 176
l Deploying an active-active cluster on page 179
l Deploying an active-active-VRRP cluster on page 191

HA feature overview

FortiADC appliances can be deployed as standalone units or as high availability (HA) clusters.

A cluster is composed of two nodes. A node is an instance of the appliance/system. In a cluster, one node is the primary
node and the other member of the cluster is the secondary node.

The primary node has a special role. It has a one-to-many relationship with member nodes. Both configuration updates
and software updates are initiated by the primary node and pushed to member nodes.

The system selects the primary node based on the following criteria:

l Link health (if monitor ports links are down, the node is considered down)
l Remote IP monitor health check results
l Override setting (prefers priority to uptime)
l Most available ports
l Highest uptime value
l Lowest device priority number (1 has greater priority than 2)
l Highest-sorting serial number—Serial numbers are sorted by comparing each character from left to right, where 9
and z are the greatest values. The system gives preference to higher values over lower values.

HA solutions depend on two types of communication among cluster members:

l Synchronization—During initialization, the primary node pushes its configuration (with noted exceptions) to member
nodes. After initialization has completed, the nodes synchronize their session tables.

l Heartbeats—A cluster node indicates to other nodes in the cluster that it is up and available. The absence of
heartbeat traffic indicates the node is not up and is unavailable.

There are three types of HA clusters:

l Active-Passive—Only the primary node is active, so it is the only node that receives traffic from adjacent routers.
Typically, there is one other node that is in standby mode. It assumes active status if the primary node undergoes
maintenance or otherwise becomes unavailable.

l Active-Active—All nodes receive traffic. Active-Active deployments support load balancing and failover among up to
two cluster members.
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l Active-Active-VRRP—FortiADC's Active-Active-VRRPmode uses a VRRP-like protocol, and can function in both
HA Active-Passive mode and HA Active-Active mode, depending on the number of traffic groups used in the
configuration. When only one traffic group is used, it actually functions in Active-Passive mode; when two or more
traffic groups are used, it works in Active-Active mode.

In an Active-Passive cluster, only the management IP address for the primary node is active. In an active-passive
cluster, you can log into a node only when it has primary node status and its IP address is active. To access the user
interface of an appliance in standby status (the active-passive secondary), you must use a console port connection.

In an Active-Active cluster, the IP addresses for all interfaces are unique, including the management interface. When the
appliance is in standalone mode, the physical port IP address is active; when it is in HA mode, the address assigned to it
in the HA node IP list address is active. You can log into any node using the active IP address for its management port.

In an Active-Active-VRRP cluster, FortiADC uses hbdev for members status communication. It also allows you to
configure sync+session, persistence sync, and image sync functions via hbdev and dataport, which is essentially the
same as the HA-AA/AP mode. Note that FortiADC is unable to communicate with third-party VRRP devices because it
actually doesn't use the VRRP protocol at all.

Tip: You can use the execute ha manage command to log into the console of a member node. See the CLI reference.

Basic active-passive cluster on page 163 shows an active-passive cluster in a single network path. In an active-passive
cluster, the primary node is the active node that handles all traffic. In the event that the primary node experiences
hardware failure or systemmaintenance, failover takes place. In failover, the standby node becomes the primary node
and processes the traffic that is forwarded along the network path. The new primary node sends gratuitous ARP to notify
the network to direct traffic for the virtual MAC addresses (vMAC) to its network interfaces. It takes the IP addresses of
the unresponsive node.

Basic active-passive cluster
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Redundant path active-passive cluster on page 164 shows an active-passive cluster in a redundant path. A topology like
this is a best practice because it is fully redundant, with no single point of failure. If the gateway, load balancer, or switch
were to fail, the failover path is chosen.

Redundant path active-passive cluster
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Basic active-active cluster on page 166 shows an active-active cluster. An active-active cluster supports load-balancing
and failover among up to two member nodes. The routers on either side of the cluster must be configured to use equal
cost multipath (ECMP) to distribute traffic to the FortiADC cluster nodes. All nodes actively receive and forward traffic.

The primary node has a special role. It handles all FTP and firewall traffic, and it acts as the failover node for all of the
other nodes in the cluster.

The failover mechanism is the same as an active-passive deployment, with the primary node acting as the standby node
for all other cluster members. If a member node fails, the primary node takes the IP addresses of the unresponsive node
and notifies the network via ARP to redirect traffic for that vMAC to its own network interfaces. For example, in Basic
active-active cluster on page 166, node1 is the primary node. If node2 were to fail, its traffic would failover to node1. If
node3 were to fail, its traffic would also failover to node1. If the primary node were to fail, a new primary node would be
elected, and it would function as the primary in all respects, including its role as the new standby node for failover from all
other cluster members.
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Basic active-active cluster

HA system requirements

l Appliances must have the same hardware model and same firmware version.
l Redundant network topology: if an active node fails, physical network cabling and routes must be able to redirect
traffic to the other member nodes.

l At least one physical port on both HA appliances to be used for heartbeat and data traffic between cluster members.
For active-passive failover pairs, you can connect the ports directly via a crossover cable. For active-active clusters,
you can connect the nodes via the same Layer 2 switch.

l Heartbeat and synchronization traffic between cluster nodes occur over the physical network ports that you
designate. If switches are used to connect the nodes, the interfaces must be reachable by Layer 2 multicast.

l Each appliance must be licensed. If using FortiADC-VM, the license must be paid; trial licenses will not function.

FortiADC-VM supports HA. However, if you do not want to use the native HA, you
can use your hypervisor or VM environment manager to install your virtual
appliances over a hardware cluster to improve availability. For example, VMware
clusters can use vMotion or VMware HA.
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HA configuration synchronization

Normally in an HA configuration, the primary node pushes most of its configuration to the other member nodes. This is
known as HA configuration synchronization. If automatic synchronization is enabled, synchronization occurs
automatically when an appliance joins the cluster, and it repeats every 30 seconds thereafter. If synchronization is not
enabled, you must initiate synchronization manually.

HA configuration synchronization includes:

l Core CLI-style configuration file (fadc_system.conf)
l X.509 certificates, certificate signing request files (CSR), and private keys
l Layer-7 virtual server error message files
l Layer-4 TCP connection state, Layer-4 persistence table, and Layer-7 persistence table (Source Address
Persistence table only)

l Health check status (active-passive deployments only)

For most settings, you configure only the primary node, and its settings are pushed to other members.

HA settings that are not synchronized on page 167 summarizes the configuration settings that are not synchronized. All
other settings are synchronized.

Setting Explanation

Hostname The hostnames are not synchronized to enable you to use unique names.

SNMP system
information

Each member node has its own SNMP system information so that you can maintain accurate,
separate data in SNMP collections. However, the network interfaces of a standby node are not
active, so they cannot be actively monitored with SNMP.

RAID level RAID settings are hardware-dependent and determined at boot time by looking at the drives
(for software RAID) or the controller (hardware RAID), and are not stored in the system
configuration. Therefore, they are not synchronized.

HA settings Most of the HA configuration is not synchronized in order to support HA system operations. In
particular:

l Priority and Override settings—These settings are used to elect a primary node, so they
are not synchronized to enable differentiation.

l Group ID—Nodes with the same Group ID join a cluster. The setting precedes and
determines group membership, so it is set manually.

l HAmode—Many administrators prefer to be able to switch the primary node from an HA
mode to standalone mode without the other nodes following suit, or to switch a secondary
node to standalone mode and have that setting not overwritten by periodic
synchronization, so the HA mode setting is not pushed from the primary node to the
member nodes.

l Node list and Local Node ID—These settings are for active-active mode only. They identify
a node uniquely within an active-active load balancing group, so they are not synchronized
to enable differentiation.

HA settings that are not synchronized

In addition to HA settings, the following data is not synchronized either:
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l Log messages—These describe events that happened on a specific appliance. After a fail-over, you might notice
that there is a gap in the original active appliance’s log files that corresponds to the period of its down time. Log
messages created during the time when the standby was acting as the active appliance (if you have configured local
log storage) are stored there, on the original standby appliance.

l Generated reports—Like the log messages that they are based upon, reports also describe events that happened
on that specific appliance. As such, report settings are synchronized, but report output is not.

You can view the status of cluster members from the dashboard of the primary node. You might need to log into the
system for a non-primary member node in the following situations:

l To configure settings that are not synchronized.
l To view log messages recorded about the member node itself on its own hard disk.
l To view traffic reports for traffic processed by the member node.

Configuring HA settings

Note: Currently, FortiADC only supports HA configurations for IPv4 address mode; HA is not supported on IPv6.

Before you begin:

l You must have Read-Write permission to items in the System category.

To configure HA settings:

1. Go to System > High Availability.
2. Complete the configuration as described in High availability configuration on page 168.
3. Save the configuration.

After you have saved the configuration, cluster members begin to send heartbeat traffic to each other. Members with the
same Group ID join the cluster. They send synchronization traffic through their data links.

Settings Guidelines

Cluster Mode l Standalone
l Active-Passive
l Active-Active
l Active-Active-VRRP

Basic Settings

Active-Passive

Group Name Name to identify the HA cluster if you have more than one. This setting is optional,
and does not affect HA function. The maximum length is 63 characters.

Group ID Number that identifies the HA cluster. Nodes with the same group ID join the
cluster. If you have more than one HA cluster on the same network, each cluster
must have a different group ID. The group ID is used in the virtual MAC address
that is sent in broadcast ARP messages. The valid range is 0 to 31. The default
value is 0.

High availability configuration
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Settings Guidelines

Config Priority Allows you to determine which configuration the system uses when synchronizing
the configuration between the HA nodes. It is highly recommended that you use
this option to manually set different HA configuration priority values on the nodes.
Otherwise, you'll have no control over the system's primary-secondary
configuration sync behavior. When the configuration priority values are identical
on both nodes (whether by default or by configuration), the system uses the
configuration of the appliance with the larger serial number to override that of the
appliance with the smaller serial number. When the configuration priority values
on the nodes are different, the configuration of the appliance with the lower
configuration priority will prevail.
Range of acceptable values is 0 to 255. Default is 100.

Active-Active

Group Name Name to identify the HA cluster if you have more than one. This setting is optional,
and does not affect HA function. The maximum length is 63 characters.

Group ID Number that identifies the HA cluster. Nodes with the same group ID join the
cluster. If you have more than one HA cluster on the same network, each cluster
must have a different group ID. The group ID is used in the virtual MAC address
that is sent in broadcast ARP messages. The valid range is 0 to 31. The default
value is 0.

Config Priority Allows you to determine which configuration the system uses when synchronizing
the configuration between the HA nodes. It is highly recommended that you use
this option to manually set different HA configuration priority values on the nodes.
Otherwise, you'll have no control over the system's primary-secondary
configuration sync behavior. When the configuration priority values are identical
on both nodes (whether by default or by configuration), the system uses the
configuration of the appliance with the larger serial number to override that of the
appliance with the smaller serial number. When the configuration priority values
on the nodes are different, the configuration of the appliance with the lower
configuration priority will prevail.
Range of acceptable values is 0 to 255. Default is 100.

Local Node ID A number that uniquely identifies the member within the cluster. The valid range is
from 0 to 7. This number is used in the virtual MAC address that is sent in ARP
responses.

Node List Select the node IDs for the nodes in the cluster. An active-active cluster can have
up to two members.

Active-Active-VRRP

Group Name Name to identify the HA cluster if you have more than one. This setting is optional,
and does not affect HA function. The maximum length is 63 characters.

Group ID Number that identifies the HA cluster. Nodes with the same group ID join the
cluster. If you have more than one HA cluster on the same network, each cluster
must have a different group ID. The group ID is used in the virtual MAC address
that is sent in broadcast ARP messages. The valid range is 0 to 31. The default
value is 0.

FortiADC Handbook 169
Fortinet Technologies Inc.



Settings Guidelines

Config Priority Allows you to determine which configuration the system uses when synchronizing
the configuration between the HA nodes. It is highly recommended that you use
this option to manually set different HA configuration priority values on the nodes.
Otherwise, you'll have no control over the system's primary-secondary
configuration sync behavior. When the configuration priority values are identical
on both nodes (whether by default or by configuration), the system uses the
configuration of the appliance with the larger serial number to override that of the
appliance with the smaller serial number. When the configuration priority values
on the nodes are different, the configuration of the appliance with the lower
configuration priority will prevail.
Range of acceptable values is 0 to 255. Default is 100.

Local Node ID A number that uniquely identifies the member within the cluster. The valid range is
from 0 to 7. This number is used in the virtual MAC address that is sent in ARP
responses.

Heartbeat Interface Set the network interface to be used to receive and send the HA heartbeat packet
between the HA group members. Use the same port numbers for all cluster
members.

Data Interface Set the network interface to be used for data synchronization among cluster
nodes. You can configure up to two data ports. If one data port fails, its traffic fails
over to the next data port. If all data ports fail, data synchronization traffic fails over
to the heartbeat port. If you do not configure a data port, the heartbeat port is used
for synchronization. Use the same port numbers for all cluster members. For
example, if you select port3 on the primary node, select port3 as the data port
interface on the other member nodes.

Heartbeat Type Select one of the following:
l Multicast
l Broadcast
l Unicast

Peer Address Enter the peer IP address.
This field appears only if the Heartbeat Type is Unicast.

Local Address Enter the local IP address.
This field appears only if the Heartbeat Type is Unicast.

Synchronization

Layer 7 Persistence
Synchronization

Enable to synchronize Layer 7 session data used for persistence to backend
servers.
When enabled, the Source Address Persistence table is synchronized between
HAmembers.
When not enabled, a node that receives traffic due to failover would not know that
a session had been created already, so it will be treated as a new session.
Synchronization of the persistence table is not required for cookie-based or hash-
based persistence methods to get the desired result. Client traffic will be routed to
the same backend server.
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Settings Guidelines

Synchronization of the persistence table is not possible for SSL session ID. When
the session via the first node is terminated, the client must re-establish an SSL
connection via the second node. When a client requests a new SSL connection
with an SSL server, the initial TCP connection has an SSL Session ID of 0. This
zero value tells the server that it needs to set up a new SSL session and to
generate an SSL Session ID. The server sends the new SSL Session ID in its
response to the client as part of the SSL handshake.
Note: This is not applicable to Firmware Upgrade.

Layer 4 Persistence
Synchronization

Enable to synchronize Layer 4 session data used for persistence to backend
servers.
When enabled, the Source Address Persistence table is synchronized between
HAmembers. When not enabled, a node that receives traffic because of load
balancing or failover would not know that a session had been created already, so it
will be treated as a new session.
Synchronization of the persistence table is not required for hash-based
persistence methods to get the desired result. Client traffic will be routed to the
same backend server.
Note: This is not applicable to Firmware Upgrade.

Layer 4 Connection
Synchronization

Enable to synchronize Layer 4 connection state data.
When enabled, the TCP session table is synchronized. If subsequent traffic for the
connection is distributed through a different cluster node because of failover, the
TCP sessions can resume without interruption.
When not enabled, a node that receives traffic because of failover would not know
that a session had been created already, and the client will be required to re-
initialize the connection.
Note: This is not applicable to Firmware Upgrade.

Advanced Settings

Priority Number indicating priority of the member node when electing the cluster primary
node. The smaller the number, the higher the priority. The valid range is 0 to 9.
The default is 5.
This setting is optional and does not affect the election of the configuration source.
Note: By default, unless you enable Override, uptime is more important than this
setting.

Override Enabled by default. This makes device priority (see above) a more important
factor than up time when selecting the primary node.

Heartbeat Interval Number of 100-millisecond intervals at which heartbeat packets are sent. This is
also the interval at which a node expects to receive heartbeat packets. This part of
the configuration is pushed from the primary node to member nodes. The default
is 2. The valid range is 1 to 20 (that is, between 100 and 2,000 milliseconds).
Note: Although this setting is pushed from the primary node to member nodes,
you should initially configure all nodes with the same Detection Interval to prevent
inadvertent failover from occurring before the initial synchronization.
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Lost Heartbeat Threshold Number of times a node retries the heartbeat and waits to receive HA heartbeat
packets from the other nodes before concluding the other node is down. This part
of the configuration is pushed from the primary node to member nodes. Normally,
you do not need to change this setting. Exceptions include:
l Increase the failure detection threshold if a failure is detected when none has
actually occurred. For example, in an active-passive deployment, if the
primary node is very busy during peak traffic times, it might not respond to
heartbeat packets in time, and a standby node might assume that the primary
node has failed.

l Decrease the failure detection threshold or detection interval if administrators
and HTTP clients have to wait too long before being able to connect through
the primary node, resulting in noticeable down time.

The valid range is from 1 to 60.
Note: Although this setting is pushed from the primary node to member nodes,
you should initially configure all nodes with the same HB Lost Threshold to prevent
inadvertent failover from occurring before the initial synchronization.

ARP Times Number of times that the cluster member broadcasts extra address resolution
protocol (ARP) packets when it takes on the primary role. (Even though a new NIC
has not actually been connected to the network, the member does this to notify the
network that a new physical port has become associated with the IP address and
virtual MAC of the HA cluster.) This is sometimes called “using gratuitous ARP
packets to train the network,” and can occur when the primary node is starting up,
or during a failover. Also configure ARP Packet Interval.

Normally, you do not need to change this setting. Exceptions include:

l Increase the number of times the primary node sends gratuitous ARP
packets if an active-passive cluster takes a long time to fail over or to train the
network. Sending more gratuitous ARP packets may help the failover to
happen faster.

l Decrease the number of times the primary node sends gratuitous ARP
packets if the cluster has a large number of VLAN interfaces and virtual
domains. Because gratuitous ARP packets are broadcast, sending them
might generate a large amount of network traffic. As long as the active-
passive cluster fails over successfully, you can reduce the number of times
gratuitous ARP packets are sent to reduce the amount of traffic produced by
a failover.

The valid range is 1 to 60. The default is 5.

ARP Interval Number of seconds to wait between each broadcast of ARP packets. Normally,
you do not need to change this setting. Exceptions include:
l Decrease the interval if an active-passive cluster takes a long time to fail over
or to train the network. Sending ARP packets more frequently may help the
failover to happen faster.

l Increase the interval if the cluster has a large number of VLAN interfaces and
virtual domains. Because gratuitous ARP packets are broadcast, sending
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themmight generate a large amount of network traffic. As long as the active-
passive cluster fails over successfully, you can increase the interval between
when gratuitous ARP packets are sent to reduce the rate of traffic produced
by a failover.

The valid range is from 1 to 20. The default is 6 seconds.

Remote IP Monitor Enable or disable active monitoring of remote beacon IP addresses to determine if
the network path is available.
Note: This option is disabled by default. If enabled, you must specify the Failover
Threshold and Failover Hold Time described below.

Failover Threshold Number of unreachable remote-ip-monitor-list to indicate failure. The default is 5.
The valid range is 1-64.

Failover Hold Time If failover occurs due to a remote IP monitor test, and this node's role changes (to
primary or secondary), it cannot change again until the hold time elapses. The
hold time can be used to prevent looping. The default hold time is 120 seconds.
The valid range is from 60 to 86400.

Monitoring an HA cluster

You can view the HA status from the system dashboard. Go to System > Dashboard > Main and hover over the HA
Cluster tab on the top right. Click on the See Detail button that appears.

HA Status page
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You can use also use log messages, alert emails, and SNMP to monitor HA events, such as when failover has occurred.
The system logs HA node status changes as follows:

l When HA is initialized: HA device Init
l When a member joins a group: Member (FAD2HD3A12000003) join to the HA group
l When the HA configuration is changed from standalone to an active-passive or active-active cluster mode: HA
device into secondary mode

The following figure shows FortiADC HA event objects in an SNMPmanager.

FortiADC HA event objects in an SNMPmanager

Updating firmware for an HA cluster

You can upgrade firmware on all nodes in a cluster from the primary node.

The following process occurs when you perform the HA upgrade procedure:

1. The primary node pushes the firmware image to the member nodes.
2. The primary node notifies the member nodes of the upgrade, and it takes their user traffic during the upgrade.
3. The upgrade command is run on the member nodes, the systems are rebooted, and the member nodes send the

primary node an acknowledgment that upgrade has been completed.
4. The upgrade command is run on the primary node, and it reboots. When the system is rebooting, a member node

assumes primary status, and the traffic fails over from the former primary node to the new primary node.
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After the upgrade process is completed, the system determines whether the original node becomes the primary node,
according to the HA Override setting:

l If Override is enabled, the cluster considers the Device Priority setting. Both nodes usually make a second failover
in order to resume their original roles.

l If Override is disabled, the cluster considers uptime first. The original primary node will have a smaller uptime due to
the order of reboots during the firmware upgrade. Therefore it will not resume its active role; instead, the node with
the greatest uptime will remain the new primary node. A second failover will not occur.

Reboot times vary by the appliance model, and also by differences between the original firmware version and the
firmware version you are installing.

The administrator procedure for an HA cluster is similar to the procedure for installing firmware on a standalone
appliance. To ensure minimal interruption of service to clients, use the following steps. The same procedure applies to
both active-active and active-passive clusters.

If downgrading to a previous version, do not use this procedure. The HA daemon on
a member node might detect that the primary node has older firmware, and attempt
to upgrade it to bring it into sync, undoing your downgrade.

Instead, switch out of HA, downgrade each node individually, then switch them back
into HA mode.

Before you begin:

l Download the firmware file from the Fortinet Customer Service & Support website: https://support.fortinet.com/
l Read the release notes for the version you plan to install.
l Back up your configuration before beginning this procedure. Reverting to an earlier firmware version could reset
settings that are not compatible with the new firmware.

l You must have super user permission (user admin) to upgrade firmware.
l Verify that the cluster node members are powered on and available on all of the network interfaces that you have
configured. If required ports are not available, HA port monitoring could inadvertently trigger an additional failover,
resulting in traffic interruption during the firmware update.

To upgrade the firmware for an HA cluster:

1. Log into the web UI of the primary node as the admin administrator.
2. Go to System > Settings.
3. Click theMaintenance tab.
4. Scroll to the Upgrade Firmware button.
5. Click Choose File to locate and select the file.
6. Enable the HA Cluster Upgrade.

7. Click to upload the firmware and start the upgrade process.

After the new firmware has been installed, the system reboots.
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When you update software, you are also updating the web UI. To ensure the web UI
displays the updated pages correctly:
l Clear your browser cache.
l Refresh the page.

In most environments, press Ctrl+F5 to force the browser to get a new copy of the
content from the web application. See the Wikipedia article on browser caching
issues for a summary of tips for many environments:
https://en.wikipedia.org/wiki/Wikipedia:Bypass_your_cache.

Deploying an active-passive cluster

This topic includes the following information:

l Overview
l Basic steps
l Best practice tips

Overview

In an active-passive cluster, one node is the active appliance; it processes traffic. The other node is passive; it is ready to
assume the role of the active appliance if the primary node is unavailable.

You configure the system to send heartbeat packets between the pair to monitor availability. The system continually
polls the activity of the heartbeat packets. If the active appliance becomes unresponsive, failover occurs: the standby
becomes active.  An active-passive cluster at failover—IP address transfer to the new active member on page 176
illustrates the process: (1) the standby node sends gratuitous ARP to notify adjacent routers to direct traffic for the virtual
MAC addresses (vMAC) to its network interfaces; (2) It takes the IP addresses of the unresponsive node.

 An active-passive cluster at failover—IP address transfer to the new active member

FortiADC Handbook 176
Fortinet Technologies Inc.

https://en.wikipedia.org/wiki/Wikipedia:Bypass_your_cache


When the former active appliance comes back online, it might or might not assume its former active role. The system
selects the active member based on the following criteria:
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l Link health (if monitor ports links are down, the node is considered down)
l Remote IP monitor health check results
l Override setting (prefers priority to uptime)
l Most available ports
l Highest uptime value
l Lowest device priority number (1 has greater priority than 2)
l Highest-sorting serial number—Serial numbers are sorted by comparing each character from left to right, where 9
and z are the greatest values. The system gives preference to higher values over lower values.

Basic steps

To deploy an active-passive cluster:

1. License all FortiADC appliances in the HA cluster, and register them, including FortiGuard services, with the
Fortinet Customer Service & Support website:
https://support.fortinet.com/

2. Physically link the FortiADC appliances that make up the HA cluster.
You must link at least one of their ports (for example, port4 to port4) for heartbeat and synchronization traffic
between members of the cluster. You can do either of the following:
l Connect the two appliances directly with a crossover cable.
l Link the appliances through a switch. If connected through a switch, the heartbeat interfaces must be
reachable by Layer 2 multicast.

3. Configure the secondary node:
a. Log into the secondary appliance as the admin user.
b. Complete the HA settings as described in Configuring HA settings.
Important: Set the Device Priority to a higher number than the preferred primary node; for example, set it to 2.

4. Configure the primary node:
a. Log into the primary appliance as the admin user.
b. Complete the configuration for all features, as well as the HA configuration.
Important: Set the Device Priority to a lower number than the secondary node; for example, set it to 1.

Note: After you have saved the HA configuration changes, cluster members join or rejoin the cluster. After you have
saved configuration changes on the primary node, it automatically pushes its configuration to the secondary node.

Best practice tips

The following tips are best practices:

l Be careful to maintain the heartbeat link(s). If the heartbeat is accidentally interrupted, such as when a network
cable is temporarily disconnected, the other nodes assume that the primary node has failed. In an active-passive
deployment, failover occurs. If no failure has actually occurred, both nodes can be operating as the active node
simultaneously.

l If you link HA appliances through switches, to improve fault tolerance and reliability, link the ports through two
separate switches. Also, do not connect these switches to your overall network, which could introduce a potential
attack point, and could also allow network load to cause latency in the heartbeat, which could cause an
unintentional failover.
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Deploying an active-active cluster

This topic includes the following information:

l Configuration overview
l Basic steps
l Expected behavior
l Best practice tips

Configuration overview

HA active-active deployment on page 180 shows an example of an active-active cluster. In an active-active cluster,
traffic from the upstream router can be load-balanced among up to two member nodes.

Load balancing depends on the equal cost multipath (ECMP) configuration on adjacent routers.The routers on either
side of the cluster must be configured to use ECMP to distribute traffic to the FortiADC cluster nodes. In the example,
assume that the FortiADC configuration includes virtual servers belonging to subnet 10.61.0.0./24. On Router A, you
configure equal cost routes as follows:

destination: 10.61.0.0/24 gateway: 10.61.51.1
destination: 10.61.0.0/24 gateway: 10.61.51.2
destination: 10.61.0.0/24 gateway: 10.61.51.3

Likewise, on Router B, you configure equal cost routes for server-to-client traffic:

destination: 0.0.0.0/0 gateway: 10.65.51.1
destination: 0.0.0.0/0 gateway: 10.65.51.2
destination: 0.0.0.0/0 gateway: 10.65.51.3

Active-active clusters also support failover. The primary node is the backup node for each of the other nodes in the
cluster. If a member node fails, the primary node takes its IP address and sends gratuitous ARP to adjacent routers to
direct traffic for that virtual MAC address (vMAC) to its own network interfaces.

The FortiADC configuration involves the following components:

l Primary node system and feature configuration
l Interface configuration (HA node IP list)
l HA configuration

In an active-active cluster, one of the nodes is selected as the primary node, and the others aremember nodes. In this
example, node1 is the primary node and node2 and node3 are member nodes. When the cluster is formed, the
configuration for node1 is pushed to node2 and node3.

When you configure the network interfaces for nodes in an active-active cluster, in addition to the interface primary IP
address, you configure an HA node IP list that specifies special HA IP addresses of each node in the cluster. The HA
node IP list for port2 in the example has the following values:

10.61.51.1/16 node1
10.61.51.2/16 node2
10.61.51.3/16 node3

Likewise, the HA node IP list for port3 has the following values:

10.65.51.1/16 node1
10.65.51.2/16 node2
10.65.51.3/16 node3
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Finally, you log into each node when it is in standalone mode to configure its HA settings. When you are ready to form
the cluster, change the setting to HA active-active. The system state changes when a node joins a cluster.

HA active-active deployment

Note: The example shows routers on both sides of the FortiADC cluster. Your deployment might not have a router
between the FortiADC cluster and the real server pool. In this case, if your real servers support load balancing methods
like ECMP, the expected behavior is the same as what is described here. If not, it is expected that the real servers route
reply traffic to the cluster node that sent them the client traffic.
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Basic steps

To deploy an active-active cluster:

1. License all FortiADC appliances in the HA cluster, and register them, including FortiGuard services, with the
Fortinet Customer Service & Support website: https://support.fortinet.com/.

2. Physically link the FortiADC appliances that make up the HA cluster.
You must link at least one of their ports (for example, port4 to port4) for heartbeat and synchronization traffic
between members of the cluster. You can do either of the following:
l If only two nodes, connect the two appliances directly with a crossover cable.
l If more than two nodes, link the appliances through a switch. If connected through a switch, the interfaces must
be reachable by Layer 2 multicast.

3. Configure member nodes:
a. Log into the member nodes as the admin user.
b. Complete the HA configuration as described in Configuring HA settings.
Important: Set the Device Priority to a higher number than the preferred primary node; for example, set it to 2.

4. Configure the preferred primary node:
a. Log into the primary node as the admin user.
b. Configure network interfaces so that each traffic interface has an HA node IP address list in addition to its

physical port IP address. See Configuring network interfaces.
When HA is set to standalone, the system uses the physical port IP address. When HA is set to active-active,
the system uses the HA node IP address.

c. Complete the configuration for all features, as well as the HA configuration.
Important: Set Device Priority to a lower number than the member nodes; for example, set it to 1.

Note: After you have saved the HA configuration changes, cluster members join or rejoin the cluster. After you have
saved configuration changes on the primary node, it automatically pushes its configuration to the member nodes.

Expected behavior

In active-active deployments, be sure to enable data synchronization. In particular, enable the following settings:

l Layer 4 Connection Synchronization—Sychronizes TCP connection state data.
l Layer 4 Session Synchronization—Synchronizes the source IP address table used for persistence to backend
servers.

l Layer 7 Session Synchronization—Synchronizes the source IP address table used for persistence to backend
servers.

The sections that follow describe how the cluster uses synchronized data.

Traffic to TCP virtual servers

When Layer 4 synchronization is enabled, the cluster nodes share TCP connection state and Layer 4 source IP address
data for traffic to Layer 4 virtual servers (and Layer 2 TCP and Turbo HTTP virtual servers, which are packet-based). The
node that receives the first SYN packet forwards the traffic to the real server, and, at the same time, multicasts the
session data to the other nodes in the cluster.

  TCP traffic flow when ECMP results in forwarding through same node on page 182 illustrates the sequence of the traffic
flow when client-to-server and server-to-client session traffic are routed through the same node.
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  TCP traffic flow when ECMP results in forwarding through same node

1. Router A uses ECMP to select a cluster node to which to forward a client connection request—in this case, node1.
2. The cluster node forwards the traffic to a real server and multicasts the session data to the cluster via the data port.
3. Router B uses ECMP to select a cluster node to which to forward the server response traffic—also node1.
4. The cluster node forwards the traffic to the client and multicasts the session data to the cluster.

 TCP traffic flow when synchronization has occurred on page 182 illustrates the sequence of the traffic flow when client-
to-server and server-to-client session traffic are routed through different nodes and synchronization has occurred before
the second node receives the response traffic.

 TCP traffic flow when synchronization has occurred
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1. Router A uses ECMP to select a cluster node to which to forward a client connection request—in this case, node1.
2. The cluster node forwards the traffic to a real server and multicasts the session data to the cluster via the data port.
3. Router B uses ECMP to select a cluster node to which to forward the server response traffic. In this case, it selects

node2.
4. If the session has already been synchronized between node1 and node2, node2 forwards the traffic to the client and

multicasts the session data to the cluster.

TCP traffic flow when synchronization has not yet occurred on page 183 illustrates the sequence of the traffic flow when
client-to-server and server-to-client session traffic are routed through different nodes and synchronization has not yet
occurred when the second node receives the response traffic.

TCP traffic flow when synchronization has not yet occurred

FortiADC Handbook 183
Fortinet Technologies Inc.



1. Router A uses ECMP to select a cluster node to which to forward a client connection request—in this case, node1.
2. The cluster node forwards the traffic to a real server and multicasts the session data.
3. Router B uses ECMP to select a cluster node to which to forward the server response traffic. In this case, it selects

node2.
4. Because the session has not yet been synchronized between node1 and node2, node2 multicasts the traffic to the

cluster.
5. When node1 receives traffic from node2, it forwards the traffic to the client and multicasts the session data.

Traffic to HTTP virtual servers

When Layer 7 synchronization is enabled, the cluster nodes share source IP data for traffic to HTTP virtual servers
differently when the virtual server profile Source option is enabled. When the Source option is enabled, the traffic
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FortiADC forwards to the real server has the client source IP address; when disabled, it has the FortiADC HA cluster
node IP address.

 HTTP traffic flow when the Source profile option is not enabled on page 185 illustrates the sequence of the traffic flow
when the Source option is not enabled.

 HTTP traffic flow when the Source profile option is not enabled

1. Router A uses ECMP to select a cluster node to which to forward a client connection request—in this case, node1.
2. The cluster node forwards the traffic to a real server. Because the Source option was not enabled, the source IP

address in the FortiADC-to-real-server traffic is the node1 HA cluster node IP address, and this becomes the
destination IP address for the response traffic.

3. Router B does not use ECMP; instead, it forwards the traffic to the node1 HA cluster IP address.
4. The cluster node finds the real client IP address in its session table and forwards the traffic to the client.
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 HTTP traffic flow when the Source profile option is enabled on page 186 illustrates the sequence of the traffic flow when
the Source option is enabled.

 HTTP traffic flow when the Source profile option is enabled

1. Router A uses ECMP to select a cluster node to which to forward a client connection request—in this case, node1.
2. The cluster node forwards the traffic to a real server. Because the Source option is enabled, the source IP address

in the FortiADC-to-real-server traffic is the true client IP address, and this becomes the destination IP address for
the server-to-client traffic.

3. Router B uses ECMP and might forward the traffic to any node in the cluster. In this example, it forwards the traffic to
node2.

4. Because the server-to-client response was not expected by node2, it multicasts the traffic to the cluster.
5. When node1 receives the server-to-client response data from node2, it forwards the response to the client.
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Note: In an active-active deployment, the virtual server profile Source option adds latency to the transaction. To reduce
latency, use an alternative to the Source option, such as the X-Forwarded-For option, if you have a requirement that the
original client IP be logged by the real server.

FTP traffic and traffic processed by firewall rules

In an active-active deployment, FTP traffic and firewall traffic are always forwarded through the primary node only.

FTP has both a control connection and a data connection associated with client-server communication. The two
“channels” make it difficult to support asymmetric routes in an active-active cluster.

In addition, traffic processed by the stateful firewall rules is also not load-balanced.

FTP or firewall traffic flow when ECMP selects the primary node on page 187 illustrates the sequence of the traffic flow
when ECMP results in traffic being forwarded through the primary node.

FTP or firewall traffic flow when ECMP selects the primary node
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1. Router A uses ECMP to select a cluster node to which to forward a client connection request. In this case, it selects
the primary node, node1.

2. The primary node forwards the traffic to a real server.
3. Router B uses ECMP to select a cluster node to which to forward the server response traffic—also node1.
4. The primary node forwards the traffic to the client.

FTP or firewall traffic flow when ECMP results in an asymmetric route on page 188 illustrates the sequence of the traffic
flow when ECMP results in an asymmetric route.

FTP or firewall traffic flow when ECMP results in an asymmetric route
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1. Router A uses ECMP to select a cluster node to which to forward a client connection request. In this case, it selects
the primary node, node1.

2. The cluster node forwards the traffic to a real server.
3. Router B uses ECMP to select a cluster node to which to forward the server response traffic—in this case, node2.
4. Because the server-to-client response was not expected by node2, it forwards traffic to the cluster.
5. When the primary node receives traffic from node2, it forwards it to the client.

FTP or firewall traffic flow when ECMP results in traffic sent to a non-primary node on page 189 illustrates the sequence
of the traffic flow when ECMP results in client-to-server traffic sent to a non-primary node.

FTP or firewall traffic flow when ECMP results in traffic sent to a non-primary node
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1. Router A uses ECMP to select a cluster node to which to forward a client connection request to a real server
destination IP address. In this case, it selects a member node, node3.

2. Firewall traffic is forwarded by the primary node only, so node3 multicasts the session data to the cluster.
3. The primary node forwards the traffic to a real server.
4. Router B uses ECMP to select a cluster node to which to forward the server response traffic—in this case, node2.
5. Because the server-to-client response was not expected by node2, it forwards traffic to the cluster.
6. When the primary node receives traffic from node2, it forwards it to the client.

Best practice tips

The following tips are best practices:
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l Be careful to maintain the heartbeat link(s). If the heartbeat is accidentally interrupted, such as when a network
cable is temporarily disconnected, the other nodes assume that the primary node has failed. In an active-active
deployment, a new primary node is elected among member nodes. If no failure has actually occurred, both nodes
can be operating as primary nodes simultaneously.

l If you link HA appliances through switches, to improve fault tolerance and reliability, link the ports through two
separate switches. Also, do not connect these switches to your overall network, which could introduce a potential
attack point, and could also allow network load to cause latency in the heartbeat, which could cause an
unintentional failover.

Advantages of HA Active-Active-VRRP

Compared with HA Active-Passive or Active-Active clusters, an HA Active-Active-VRRP cluster offers the following
advantages:

l The HA Active-Active mode is an device-based HA mode, in which the HA fail over will switch over the whole failed
device even in cases where only one monitor port fails.

l In FortiADC HA Active-Active-VRRPmode, you can manually assign a virtual server to a traffic group, enabling you
to do traffic load design based on virtual servers.

l In HA Active-Active-VRRPmode, FortiADC only synchronizes the session table/persistence table to the next
available device in the same traffic group using the “failover-order “ command. In cases where you have more than
two devices in the cluster, this synchronization mechanism can turn out to be more efficient than HA Active-Passive
or Active-Active mode because the session/persistence table will be synced to the whole HA group. In this sense,
FortiADC actually supports the N+M hot-backup function.

l HA Active-Active mode must work together with an external router with the ECMP route configured to distribute
traffic to different Active-Active nodes; HA Active-Active-VRRPmode does not need this external router to do ECMP
traffic distribution— Both sides can simply point their respective gateway to the VRRP floating IP.

l In HA Active-Active-VRRPmode, different devices in the same traffic group have the same HA status. Once you
have pointed both the client and the server side gateways to the floating IP in the same traffic, the
incoming/outgoing traffic will going to the same device. As a result, HA Active-Active-VRRPmode doesn't need to
multicast the traffic itself to the HA group, which should offer the best network performance and efficiency.

l In HA Active-Active mode, the AA-Primary will take over all AA-Passive nodes' traffic. If multiple AA devices have
failed, the AA-Primary will have to process much more traffic than the AA-secondary nodes, which may exhibit
some unexpected behavior under abnormal high traffic stress.

l In terms of sync session, you are unable to access the real server’s IP address from the client directly in HA Active-
Active mode, but you don’t have this limitation in HA Active-Active-VRRPmode.

Deploying an active-active-VRRP cluster

This topic includes the following information:

l Configuration overview
l Basic steps
l Best practice tips

Configuration overview

The Virtual Router Redundancy Protocol (VRRP) is designed to eliminate the single point of failure inherent in the static
default routed environment. VRRP specifies an election protocol that dynamically assigns responsibility for a virtual
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router to one of the VRRP routers on a LAN. The VRRP router controlling the IP address(es) associated with a virtual
router is called the primary, and forwards packets sent to these IP addresses. The election process provides dynamic
fail-over in the forwarding responsibility should the primary become unavailable. Any of the virtual router's IP addresses
on a LAN can then be used as the default first hop router by end-hosts. The advantage of VRRP is a higher availability
default path without requiring configuration of dynamic routing or router discovery protocols on every end-host.

A virtual router is defined by its virtual router identifier (VRID) and a set of IP addresses. A VRRP router may associate a
virtual router with its real address on an interface, and may also be configured with additional virtual router mappings and
priority that the virtual router can back up. The mapping between VRID and addresses must be coordinated among all
VRRP routers on a LAN.

FortiADC only adopts the VRRP concept, but not the exact VRRP protocol itself. For this reason, its HA Active-Active
VRRPmode cab only be called a VRRP-like HA mode

VRRP configurations can be used as a high availability (HA) solution to ensure that your network maintains connectivity
with the Internet (or with other networks) even if the default router for your network fails. Using VRRP, you can assign
VRRP routers as primary or backup routers. The primary router processes traffic, while the backup routers monitor the
primary router and start forwarding traffic the moment the primary router fails.

VRRP is described in RFC 3768.

FortiADC units can function as primary or backup Virtual Router Redundancy Protocol (VRRP) routers and can be
quickly and easily integrated into a network that has already deployed VRRP. In a VRRP configuration, when a FortiADC
unit operating as the primary unit fails, a backup unit automatically takes its place and continues processing network
traffic. In such a situation, all traffic to the failed unit transparently fails over to the backup unit that takes over the role of
the failed primary FortiADC unit. When the failed FortiADC unit is restored, it will once again take over processing traffic
for the network. See An active-active-VRRP cluster configuration using two FortiADC units on page 192.

An active-active-VRRP cluster configuration using two FortiADC units
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In an active-active-VRRP cluster, one of the nodes is selected as the primary node of a traffic group, and the rest of the
nodes are member nodes of the traffic group. Traffic from the upstream can be load-balanced among up to two member
nodes. Active-active-VRRP clusters also support failover. If the primary node fails, the traffic group work on this node will
fail over to one of the backup nodes which will send gratuitous ARP to adjacent devices to redirect traffic for its own MAC
address to all network interfaces within the traffic group.

The FortiADC VRRP configuration involves the following:

l Traffic group and their features (See Traffic Group)
l Interface and virtual server (pertinent floating IP and traffic group )
l HA

Note:It is important to note that FortiADC only supports VRRP configuration between two or more FortiADC units. It can
NOT be integrated into a VRRP group formed with any third-party VRRP devices.
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Basic steps

To deploy an active-active-VRRP cluster:

For how to deploy, refer to Deploy HA-VRRPmode in HA Deployment Guide. In the following steps, we introduce how to
configure the VRRP cluster after deployment.

1. Configure the HA active-active--VRRP cluster.
For example:
FAD 1:
config system ha

set mode active-active-vrrp
set hbdev port2
set group-id 14
set local-node-id 1

end

FAD 2:
config system ha

set mode active-active-vrrp
set hbdev port2
set group-id 14
set local-node-id 2

end

2. Configure the traffic group.
Configure the traffic group and set its parameters. The failover sequence must be configured according to the order
of node IDs. This means that if a node is dead, the next node in queue will take over handling the traffic. If you want
to decide when a node should retake the traffic over from power-down to start-up, you can enable the preempt.
If only two nodes, connect the two appliances directly with a crossover cable.
If more than two nodes, link the appliances through a switch. If connected through a switch, the interfaces must be
reachable by Layer 2 multicast.
config system traffic-group

edit "traffic-group-1"
set failover-order 1 2

next
edit "traffic-group-2"

set failover-order 2 1
set preempt enable

next
end

3. Configure applications and relate them with the traffic group
Relate applications with the traffic group in the virtual server configuration and interface + IP configuration. If no
traffic group is related, the “default” traffic group will be used.
For example (Relate a virtual server to a traffic group):
config load-balance virtual-server

edit "vs1"
set packet-forwarding-method FullNAT
set interface port1
set ip 10.128.3.4
set load-balance-profile LB_PROF_HTTP
set load-balance-method LB_METHOD_DEST_IP_HASH
set load-balance-pool rs1
set ippool-list vs1-pool vs1-pool-1
set traffic-group traffic-group-1
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next
edit "vs2"

set packet-forwarding-method FullNAT
set interface port1
set ip 10.127.3.4
set load-balance-profile LB_PROF_HTTP
set load-balance-method LB_METHOD_DEST_IP_HASH
set load-balance-pool rs2
set ippool-list vs2-pool vs2-pool-1
set traffic-group traffic-group-2

next
end

For example (Relate an interface and IP address with a traffic group):
config load-balance virtual-server

edit "port1"
set vdom root
set ip 10.128.3.1/16
set allowaccess https ping ssh snmp http telnet
set traffic-group traffic-group-1
set floating enable
set floating-ip 10.128.3.3

next
edit "port2"

set vdom root
set ip 10.127.3.1/16
set allowaccess https ping ssh snmp http telnet
set traffic-group traffic-group-2
set floating enable
set floating-ip 10.127.3.3

next
end

4. Configure working status of the HA nodes.
Configure the above two traffic groups, with the opposite failover-order, and configure two virtual servers which are
related with the two traffic groups respectively. The VS1 will work on node 1, and VS2 will work on node 2. If one HA
node fails, the other node will take over all the traffic from the failed one.

Best practice tips

The following tips are best practices:

Note: After you have saved the HA configuration changes, cluster members join or rejoin the cluster. After you have
saved configuration changes on the primary node, it automatically pushes its configuration to the member nodes.

Traffic Group

From the System > Traffic Group sub-menu, you can configure traffic groups that are used in HA Active-Active-VRRP.

A traffic group is a set of VRIDs. Each VRID keeps talking with its peers using 'hello' packets via its heartbeat interface so
that each VRID can be aware of its peers (primary or secondary) operating state and perform a VRRP fail-over in case
the primary node fails. The different VRIDs have no relationship with each other.
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In Traffic group on page 196, both VRID1 and VRID2 use Device1 as the primary. When Port2 on Device1 fails, all traffic
between the client and the server can't pass through the device

Traffic group

To solve this problem, you can create a traffic group and add both VRID1 and VRID2 as its members, and set the rule
that the whole traffic group to fail over to the success device when either VRID fails. In this case, if Device1’s Port2 fails,
the whole traffic group will fail over to Device2.

Using the VRID concept, FortiADC allows you to add objects with floating IP address, such as interface, virtual server, IP
pool, and SNAT pool, etc. to a traffic-group. With this configuration, it will trigger the whole traffic group to switch over
when a resource fails.

The traffic group is designed to work with the HA active-active-VRRPmode. Normally, the number of traffic groups
should be the same as the number of devices in an HA Active-Active-VRRPmode. In each traffic group, you should
configure a different HA node as the primary device. For example, you have HA node A and node B. It's suggested to
configure two traffic groups, where traffic group A uses node A as the primary, and node B as the secondary, while traffic
group B uses node B as the primary, and node A as the secondary. With this configuration, all the nodes are actively
processing traffic, and whichever node fails, its traffic and all related resources such as the floating IP address and virtual
server can be taken over by a new primary.

Using traffic group with the HA active-active-VRRPmode can also achieve active-passive HA deployment. FortiADC
comes with a predefined traffic group named "default". You can configure the resources such as the floating IP address
and virtual server for the default traffic group, then specify the primary node and secondary node in the traffic group, so
that when the primary node fails, the resources can be taken over by the new primary.

Please note that traffic group should be associated with a network interface. The floating IP address of the interface can
be failed over to the new primary, but the IP address of the interface does not transfer among the HA nodes in this group,
because the interface IP address is not synchronized among HA nodes in active-active-VRRPmode and it always
attaches to the physical device who owns the interface.

Create a traffic group via the command line interface

Use the following commands to create a new traffic group:

config system traffic-group
edit traffic-group-1

set preempt enable
set network-failover enable
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set failover-order 1 3 5
next

end

Note: The failover sequence must be configured according to the order of node IDs. This means that if a node is dead,
the next node in queue will take over handling the traffic. If you want to decide when a node should retake the traffic over
from power-down to start-up, you MUST enable the Preempt option.

Create a traffic group from the Web GUI

Use the following steps to configure a traffic group from FortiADC's web interface:

1. Click System > Traffic Group.
2. Click Create New to open the Traffic Group dialog.
3. Make the desired entries or selections as described in Traffic-group parameters on page 197.
4. Click Save when done.

Traffic-group parameters

Parameter Description

Traffic Group Name Specify a unique name for the traffic group.

Preempt Disabled by default. If enabled, the node will retake control of traffic from power-down to start-
up. For example, if node A was the primary and the traffic was taken over by node B during
failover. Once node A comes back, it will again take over the primary role for this traffic group.

Remote IP Monitor Disabled by default. When enabled, the system will actively monitor the remote beacon IP
addresses to determine the available network path.

Failover Order Follow the hint onscreen to set the failover sequence among the ports. The number should be
the "Local Node ID" in HA configuration.

Administrator

The System > Administrator sub-menu includes the following topics:

l Managing administrator users on page 197
l Creating administrator users on page 199
l Creating REST API administrator users on page 201
l Configuring access profiles on page 203
l Enabling password policies on page 205

Managing administrator users

This topic includes the following information:

l Administrator user overview
l REST API administrator user overview
l Create administrator users
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l Create REST API administrator users
l Configure access profiles
l Enable password policies

Administrator user overview

In its factory default configuration, FortiADC has one administrator account named admin. The user of this account has
permissions that grant read-write access to all system functions.

Unlike other administrator accounts, this default admin cannot be deleted. The admin account is similar to a root
administrator account. This account always has full permission to view and change all system configuration options,
including viewing and changing all other administrator accounts. You cannot alter the name and permissions of this
default admin account.

To prevent accidental changes to the configuration, it is best that only network administrators, and if possible, only a
single person, use the admin account.

You can use the admin account to configure more administrator accounts for other users. Accounts can be created with
different levels of access. If you require such role-based access control (RBAC) restrictions, or if you simply want to
harden security or prevent inadvertent changes to other administrators’ areas, you can do so using access profiles. For
example, you can create an account for a security auditor who must only be able to view the configuration and logs, but
not change them.

Basic steps

1. Create administrator user accounts with permissions provisioned by the profiles.
2. Configure access profiles to provision permissions to roles.
3. Enable password policies.

REST API administrator user overview

As a REST API administrator user, you can generate a generalized authorization token to access the supported
FortiADC REST APIs of other systems, such as the FNDN.

REST API administrator user accounts share much of the same features of normal administrator accounts; the primary
difference is that REST API administrators cannot login through the GUI or CLI and must use their assigned API token to
interact with FortiADC. REST API administrators can be created via GUI where they will automatically be assigned an
API token. Users can generate access tokens that do not timeout or expire once they are assigned to the REST API
administrator. These access tokens cannot be deleted, but can be regenerated. Once regenerated, the previous token
will no longer be valid. When a REST API administrator is deleted, any existing associated tokens will be revoked.

REST API administrators can send requests to FortiADC with their API token as a header field.

An example is shown below:

curl 'https://XX.XX.XX.XX/api/XXXX/' -H 'APITOKEN: ede4b6632a464a469b85abedd7b5cc91'

Basic steps

1. Create REST API administrator user accounts with permissions provisioned by the profiles.
2. Save the automatically generated API Key for use later. This is your API authorization token and is only shown

once after being generated, so ensure the API key is saved to a secure location.
3. Use the API key to access REST API resources.
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Creating administrator users

We recommend that only network administrators—and if possible, only a single person—use the admin account. You
can configure accounts that provision different scopes of access. For example, you can create an account for a security
auditor who must only be able to view the configuration and logs, but not change them.

Before you begin:

l If you want to use RADIUS, LDAP or TACACS+ authentication, you must have already have created the RADIUS
server, LDAP server or TACACS+ server configuration.

l You must have Read-Write permission for System settings.

To create an administrator user account:

1. Go to System > Administrator.
2. Click the Admin tab.
3. Click Create New > Administrator to display the configuration editor.
4. Complete the configuration as described in Administrator user configuration on page 199.
5. Click Save.

Settings Guidelines

Name Name of the administrator account, such as admin1 or admin@example.com.
Do not use spaces or special characters except the ‘at’ symbol ( @ ). The maximum length is
35 characters.
If you use LDAP, RADIUS or TACACS+, specify the LDAP, RADIUS or TACACS+ username.
This is the user name that the administrator must provide when logging in to the CLI or web
UI. The users are authenticated against the associated LDAP, RADIUS or TACACS+ server.
After you initially save the configuration, you cannot edit the name.

Global Admin Select whether or not to allow the administrator account to have Global access, which is
required to access all virtual domains, configure Automation Stitches, and create system
backup files.
l No— This is the default option. The administrator account will only have access to the
virtual domain specified in this configuration. Administrators with no Global Admin
permission cannot configure Automation Stitches or create system backup files.

l Yes— The administrator account will have access to all virtual domains. With Global
Admin access, the administrator can configure Automation Stitches and create system
backup files.

Profile Select a user-defined or predefined profile. The predefined profile named super_admin_prof
is a special access profile used by the admin account. However, selecting this access profile
will not confer all permissions of the admin account. For example, the new administrator
would not be able to reset lost administrator passwords.
Note: This option does not appear for the admin administrator account, which by definition
always uses the super_admin_prof access profile.

Administrator user configuration
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Settings Guidelines

Virtual Domain Optional. If you have enabled the virtual domain feature, select the virtual domain that this
administrator can view and manage.

Authentication Type l Local — Use the local administrator authentication server.
l RADIUS—Use a RADIUS authentication server. Select the RADIUS server
configuration.

l LDAP—Use an LDAP authentication server. Select the LDAP server configuration.
l TACACS+—Use a TACACS+ authentication server. Select the TACACS+ server
configuration.

Password The Password is available if Authentication Type is Local.
Set a strong password for all administrator accounts. The password should be at least eight
characters long, be sufficiently complex, and be changed regularly. To check the strength of
your password, you can use a utility such as Microsoft’s password strength meter.

Confirm Password The Confirm Password is available if Authentication Type is Local.
Re-enter the same password.

Two-factor
Authentication

The Two-factor Authentication is available if Authentication Type is Local.
Options:
l None
l FortiToken Cloud

l Email address—Set the email address registered with FortiToken Cloud
l Country dial code—Set country dial code of mobile phone number
l Phone number—Set mobile phone number registered with FortiToken Cloud

Note: FortiADC does not support FortiToken Cloud functionality in HA condition.

Wildcard TheWildcard option is available if Authentication Type is RADIUS, LDAP or TACACS+.
Enable the wildcard option to allow multiple remote admin accounts to match one local admin
account. This way, multiple RADIUS, LDAP or TACACS+ admin accounts can use one
FortiADC admin account.

Restrict to trusted
hosts

Enable/disable to restrict logins to trusted hosts only.

Trusted Hosts The Trusted Hosts option is available if Restrict to trusted hosts is enabled.
Source IP address and netmask from which the administrator is allowed to log in. For multiple
addresses, separate each entry with a space. You can specify up to three trusted areas. They
can be single hosts, subnets, or a mixture.
Configuring trusted hosts hardens the security of the system. In addition to knowing the
password, an administrator must connect only from the computer or subnets you specify.
Trusted host definitions apply both to the web UI and to the CLI when accessed through
Telnet, SSH, or the CLI console widget. Local console access is not affected by trusted hosts,
as the local console is by definition not remote, and does not occur through the network.
If ping is enabled, the address you specify here is also a source IP address to which the
system will respond when it receives a ping or traceroute signal.
To allow logins only from one computer, enter only its IP address and 32- or 128-bit netmask:
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Settings Guidelines

192.0.2.1/32

2001:0db8:85a3::8a2e:0370:7334/128

To allow login attempts from any IP address (not recommended), enter:
0.0.0.0/0

Caution: If you restrict trusted hosts, do so for all administrator accounts. Failure to do so
means that all accounts are still exposed to the risk of brute force login attacks. This is
because if you leave even one administrator account unrestricted (i.e. 0.0.0.0/0), the
systemmust allow login attempts on all network interfaces where remote administrative
protocols are enabled, and wait until after a login attempt has been received in order to check
that user name’s trusted hosts list.
Tip: If you allow login from the Internet, set a longer and more complex New Password, and
enable only secure administrative access protocols. We also recommend that you restrict
trusted hosts to IPs in your administrator’s geographical area.
Tip: For improved security, restrict all trusted host addresses to single IP addresses of
computer(s) from which only this administrator will log in.

Creating REST API administrator users

A REST API administrator is required to generate an authorization token prior to sending requests for supported
FortiADC REST APIs. You can create a REST API administrator account through the GUI and an authorization token,
the API key, will be automatically generated and assigned to the user.

Although users can use an API request to create a REST API administrator account,
the resulting token would not be properly assigned to the user. Without an assigned
user this authorization token would be invalid and would not be able to access the
supported FortiADC REST APIs.

Before you begin:

l You must have Read-Write permission for System settings.

To create a REST API administrator in the GUI:

1. Go to System > Administrator.
2. Select the Admin tab.
3. Click Create New > REST API Admin to display the configuration editor.
4. Configure the following settings:

Setting Description

Name Enter the login name of the REST API administrator account.
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Setting Description

The maximum length is 35 characters. Do not use spaces or special
characters except the ‘at’ symbol ( @ ). Using special characters like <, >, (, ), #,
", or ' in the administrator account name can result in a cross-site scripting
(XSS) vulnerability.
After you initially save the configuration, you cannot edit the name.

Comments Optionally, enter comments about the administrator account.

Global Admin Select either of the following global admin access options:
l No— The account can access the virtual domain specified in this
configuration only. This is the default option.

l Yes— The account can access all virtual domains.

Administrator profile The Administrator profile option appears ifGlobal Admin is No.
Select a user-defined or predefined profile to use for the new administrator.
The predefined profile named super_admin_prof is a special access profile
used by the admin account. However, selecting this access profile will not
confer all permissions of the admin account. For example, the new
administrator would not be able to reset lost administrator passwords.
Note: This option does not appear for the admin administrator account, which
by definition always uses the super_admin_prof access profile.

CORS Allow Origin Toggle Enable/disable for Cross-Origin Resource Sharing (CORS) for browsers.

CORS Allow Origin The CORS Allow Origin option appears if CORS Allow Origin Toggle is
enabled.
Specify the URL that can access the REST API.

Restricted to trusted hosts Enable/disable to use Trusted Hosts to allow specific IP addresses to log in to
the REST API.

Trusted Hosts The Trusted Hosts option appears if Restricted to trusted hosts is enabled.
Specify the trusted host IP address and and netmask allowed to log in to the
REST API. For multiple addresses, separate each entry with a space. You can
specify up to three trusted areas. They can be single hosts, subnets, or a
mixture.

5. Click Save.
The New API Key pane opens.
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The API key is the REST API authorization token that is used in REST API calls.
6. Copy the API key to a secure location.

This API key will not be displayed anywhere else after you close the pane. If this one is lost or compromised, you
can regenerate a new key by editing the REST API Admin user. Once regenerated, the previous token will no longer
be valid.

7. ClickOK.

Configuring access profiles

Access profiles provision permissions to roles. The following permissions can be assigned:

l Read (view access)
l Read-Write (view, change, and execute access)
l No access

When an administrator has only read access to a feature, the administrator can access the web UI page for that feature,
and can use the get and show CLI command for that feature, but cannot make changes to the configuration.

In larger companies where multiple administrators divide the share of work, access profiles often reflect the specific job
that each administrator does (“role”), such as account creation or log auditing. Access profiles can limit each
administrator account to their assigned role. This is sometimes called role-based access control (RBAC).

Areas of control in access profiles on page 203 lists the administrative areas that can be provisioned. If you provision
read access, the role can view the web UI menu (or issue a CLI get command). If you provision read-write access, the
role can save configuration changes (or issue a CLI set command).

For complete access to all commands and abilities, you must log in with the administrator account named admin.

Web UI Menus CLI Commands

System config system
diagnose hardware
diagnose sniffer
diagnose system
execute date
execute ping

Areas of control in access profiles
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Web UI Menus CLI Commands

execute ping-options
execute traceroute

Router config router

Server Load Balance config load-balance

Link Load Balance config link-load-balance

Global Load Balance config global-dns-server
config global-load-balance

Security config firewall
config security waf

Log & Report config log
config report
execute rebuild-db

* For each config command, there is an equivalent get/show command. The config
commands require write permission. The get/show commands require read
permission.

Before you begin:

l You must have Read-Write permission for System settings.

To configure administrator profiles:

1. Click System > Administrator.
2. Click the Access Profile tab.
3. Click Create New to display the configuration editor.
4. Complete the configuration as described in Configuring access profiles on page 203.
5. Click Save.

Settings Guidelines

Name Specify a name for the access profile configuration. Valid characters are A-Z, a-z,
0-9, _, and -. No spaces.

System Select one of the following:
l None—Do not provision access for the menu.
l Read Only—Provision ready-only access.
l Read-Write—Enable the role to make changes to the configuration.

Networking Select one of the following:
l None—Do not provision access for the menu.
l Read Only—Provision ready-only access.
l Read-Write—Enable the role to make changes to the configuration.

Access profile configuration
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Settings Guidelines

User Select one of the following:
l None—Do not provision access for the menu.
l Read Only—Provision ready-only access.
l Read-Write—Enable the role to make changes to the configuration.

Server Load Balance Select one of the following:
l None—Do not provision access for the menu.
l Read Only—Provision ready-only access.
l Read-Write—Enable the role to make changes to the configuration.

Link Load Balance Select one of the following:
l None—Do not provision access for the menu.
l Read Only—Provision ready-only access.
l Read-Write—Enable the role to make changes to the configuration.

Global Load Balance Select one of the following:
l None—Do not provision access for the menu.
l Read Only—Provision ready-only access.
l Read-Write—Enable the role to make changes to the configuration.

Security Select one of the following:
l None—Do not provision access for the menu.
l Read Only—Provision ready-only access.
l Read-Write—Enable the role to make changes to the configuration.

Log & Report Select one of the following:
l None—Do not provision access for the menu.
l Read Only—Provision ready-only access.
l Read-Write—Enable the role to make changes to the configuration.

Shared Resource For each category, set the permission:
l None—Do not provision access for the menu.
l Read Only—Provision ready-only access.
l Read-Write—Enable the role to make changes to the configuration.

The super_admin_prof access profile, a special access profile assigned to the
admin account and required by it, appears in the list of access profiles. It exists by
default and cannot be changed or deleted. The profile has permissions similar to the
UNIX root account.

Enabling password policies

A password policy is a set of rules designed to enhance computer security. A good password policy encourages users to
create strong passwords and use them properly. For your network and data security and integrity, we strongly
recommend the enforcement of strong password policies when using FortiADC.
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To enable password policy:

1. Go to System > Administrator.
2. Click the Password Policy tab.
3. Complete the configuration as described in Password policy configuration.
4. Click Save.

Settings Guidelines

Password Policy Disabled by default.

Minimum Length Specify the minimum length requirement of passwords, which can be from 8 (default) to 32
characters in length.

Must Contain Select the restrictions you want to impose on passwords:
l Upper Case Letter—If selected, passwords must contain upper-case letters.
l Lower Case Letter—If selected, passwords must contain lower-case letters.
l Number—If selected, passwords must contain numbers.
l Non-alphanumeric —If selected, passwords must contain non-alphanumeric characters.

Password policy configuration

Global Resources

From the System > Global Resources sub-menu, the global system resource usage is displayed, including current and
maximum usage per resource.

FortiADC Handbook 206
Fortinet Technologies Inc.



The Global Resources page is organized by modules, and you can click + to view the resource usage data listed under
the module. Global Resources is available in both the VDOM settings and Global settings, however, different resource
usage data is displayed. The Global Resources usage data displayed from the VDOM settings display the sum of the
usage data from each VDOM.

The Global Resources page is not supported when FortiADC is in SSLi mode.

Global Resources from VDOM settings:

Module Resource usage displayed

Network

Routing Static
Policy

Server Load Balance

Virtual Server Virtual Server
Content Rewriting
Content Routing

Real Server Pool Real Server Pool
Real Server

Link Load Balance

Link Group Link Group
Gateway

Global Load Balance

FQDN Host
Virtual Server Pool

Global Object Server
Link

Web Application Firewall WVS Task
Scan Profile
Web Anti-Defacement

DoS Protection DoS Protection Profile

User Auth Local User
OAuth Proxy

User Group User Group

Remote Server NTLM Server

SAML SAML Service Provider
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Global Resources from Global settings:

Module Resource usage displayed

Network

Interface Interface

User Auth

Remote Server LDAP Server
RADIUS Server
TACACS+ Server

WCCP

From the System > WCCP sub-menu, you can configure the WCCP (Web Cache Communication Protocol).

WCCP is a Cisco-developed content-routing protocol that provides a mechanism to redirect traffic flows in real-time.
FortiADC supports Version 2 (WCCPv2).

With WCCP, FortiADC can forward client traffic to WCCP compatible devices where additional actions will be performed
(that are not native to the FortiADC), and then, after undergoing these processes, the traffic will be sent back to the
FortiADC.

To configure a WCCP object:

1. Go to System > WCCP.
2. Click Create New to display the configuration editor.
3. Configure the following settings:

Settings Description

Service ID Name of the service group. Range 0-255.

Authentication l Disable—No password is required. Default.
l Enable—Opens up a text box. Specify the password.

Forward Method l GRE—Encapsulates the intercepted packet in an IP GRE header with a source IP
address of the WCCP server and a destination IP address of the target WCCP
client. This allows the WCCP server to be multiple Layer 3 hops away from the
WCCP client.

l L2—Rewrites the destination MAC address of the intercepted packet to equal the
MAC address of the target WCCP client. L2 forwarding requires that the WCCP
server is Layer 2 adjacent to the WCCP client.

l any—Cache server determines the method.

Return Method Defines how a cache server declines a redirected packet, and returns it to the
FortiADC (see forward-method above for option descriptions).

Assignment Method Defines which assignment method the FortiADC prefers:
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Settings Description

l HASH—A hash key based on any combination of the source and destination IP
and port of the packet.

l MASK—Amask value specified with a maximum of 7 bits and, like the hash key,
can be configured to cover both the source and destination address space.

l any—Cache server determines the method.

Group Address IP multicast address used by the cache routers. The default, 0.0.0.0, means the
FortiADC will ignore multicast WCCP traffic. Otherwise, set the address between
244.0.0.0 to 239.255.255.255.

Router ID IP address known to all cache engines, and identifies an interface on the FortiADC to
the cache engines. If all cache engines connect to the same FortiADC interface, use
the default address of 0.0.0.0. However, if the cache engines can connect to different
FortiADC interfaces, you must set router-id to a specific IP address, which must then
be added to the configuration of the cache engines that connect to that interface.

Server List IP address and netmask for up to four cache servers.

4. Click Save.
5. Enable WCCP in an interface.

a. Go to Networking > Interface. Select an interface and open the dialogue.
b. Under Mode Specifics, enableWCCP (default is disable).
c. Click Save.

6. Enable WCCP in a virtual server for monitoring.

Only Layer 7 Virtual Servers are supported.

a. Go to Server Load Balance > Virtual Server.
b. Select a virtual server. Click theMonitoring tab.
c. EnableWCCP (default is disable).
d. Click Save.

SNMP

The System > SNMP sub-menu includes the following topics:

l Configuring SNMP on page 210
l Downloading SNMP MIBs on page 211
l Configuring SNMP v1/v2 on page 212
l Configuring SNMP v3 on page 213
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Configuring SNMP

Many organizations use SNMP (simple network management protocol) to track the health of their systems. FortiADC
supports SNMP v1, v2c, and v3.

SNMP depends on network devices that maintain standard management information bases (MIBs).MIBs describe the
structure of the management data maintained on the device. Some MIB definitions are standard for all network devices,
and some are vendor and product-family specific.

The FortiADC system runs an SNMP agent to communicate with the SNMPmanager. The agent enables the system to
respond to SNMP queries for system information to the SNMPmanager.

SNMP communication on page 210 illustrates the basic communication.

SNMP communication

With SNMP v1 and v2c managers, you configure SNMP communities to connect FortiADC and the SNMPmanager. The
SNMPManager sends the community string along with all SNMP requests. If the community string is correct, the device
responds with the requested information. If the community string is incorrect, the device simply discards the request and
does not respond.

Fortinet strongly recommends that you do not add FortiADC to the community
named public. This default name is well-known, and attackers that attempt to gain
access to your network often try this name first.

With SNMPv3 managers, you configure SNMP users to connect FortiADC and the SNMPmanager. Queries and traps
include username/password authentication, along with an encryption key. FortiADC implements the user security model
described in RFC 3414.

Before you begin:

l On the SNMPmanager, you must verify that the SNMPmanager is a member of the community to which the
FortiADC system belongs, and you must compile the necessary Fortinet-proprietary management information
blocks (MIBs) and Fortinet-supported standard MIBs. For information on Fortinet MIBs, see Downloading
SNMP MIBs on page 211.

l In the FortiADC interface settings, you must enable SNMP access on the network interface through which the
SNMPmanager connects.

l You must have Read-Write permission for System settings.

To configure SNMP system information:

1. Go to System > SNMP.
2. Click the System Information tab.
3. Complete the configuration as described in SNMP settings on page 211.
4. Save the configuration.
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Settings Guidelines

SNMP Agent Disabled by default. Enable to activate the SNMP agent so that the system can d receive
SNMP queries.

Description A description or comment about the system, such as dont-reboot. The description can be up
to 35 characters long, and can contain only letters (a-z, A-Z), numbers, hyphens ( - ) and
underscores ( _ ).

Contact Contact information for the administrator or other person responsible for this system, such as a
phone number (555-5555) or name (jdoe). The contact information can be up to 35 characters
long, and can contain only letters (a-z, A-Z), numbers, hyphens ( - ) and underscores ( _ ).

Location Physical location of the appliance, such as floor2. The location can be up to 35 characters
long, and can contain only letters (a-z, A-Z), numbers, hyphens ( - ) and underscores ( _ ).

SNMP settings

Downloading SNMP MIB files

You can download the FortiADC SNMP MIB file or the Fortinet core MIB file using the links at the bottom of the page.

For more information, refer to Downloading SNMP MIBs on page 211.

Downloading SNMP MIBs

FortiADC allows you to download full FortiADC and Fortinet Core MIB (Management Information Base) files, which
provides more options for server load balance, global server load balance, link load balance, and firewall with SNMP
traps.

FortiADC 7.4.3 introduces the new SNMPMIB ifXTable with 64-bit counters to allow
users to query 10 G statistics.

To download an SNMP MIB file:

1. Go to System > SNMP.
The configuration page displays the System Information tab.

2. In the FortiADC SNMP MIB section, initiate the file download by clicking the Download FortiADC MIB File or
Download Fortinet Core MIB File.

3. Follow the instructions onscreen to complete the download.
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FortiADC MIBs

The following lists the MIBs used with FortiADC.

MIB or RFC Description

Fortinet Core MIB This Fortinet-proprietary MIB enables your SNMPmanager to query for system
information and to receive traps that are common to multiple Fortinet devices.

FortiADCMIB This Fortinet-proprietary MIB enables your SNMPmanager to query for FortiADC-
specific information and to receive FortiADC-specific traps.

RFC 1213 (MIB II) The FortiADC SNMP agent supports MIB II groups, except: There is no support
for the EGP group fromMIB II (RFC 1213, section 3.11 and 6.10). Protocol
statistics returned for MIB II groups (IP, ICMP, TCP, UDP, and so on) do not
accurately capture all FortiADC traffic activity. More accurate information can be
obtained from the information reported by the FortiADCMIB.

RFC 3635 (Ethernet-like MIB) The FortiADC SNMP agent uses any of the objects in the Ethernet-like interface
types specification (dot3StatsIndex).

Configuring SNMP v1/v2

To configure SNMP v1/v2:

1. Go to System > SNMP.
2. Click the SNMPv1/v2 tab.
3. Complete the configuration as described in SNMP settings on page 212.
4. Save the configuration.

Settings Guidelines

SNMPv1/v2

Name Name of the SNMP community to which the FortiADC system and at least one SNMPmanager
belongs, such as management.

You must configure the FortiADC system to belong to at least one SNMP community so that
community’s SNMPmanagers can query system information.

You can add up to three SNMP communities. Each community can have a different configuration
for queries and traps.

You can also add the IP addresses of up to eight SNMPmanagers to each community to which
IP addresses are permitted to query the FortiADC system.

SNMP v1 Status Select to enable the SNMP v1 configuration.

SNMP v1 Port Enter the port number on which the system listens for SNMP v1 queries from the SNMP
managers in this community. The default is 161.

SNMP v2 Status Select to enable the SNMP v2 configuration.

SNMP settings
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Settings Guidelines

SNMP v2 Port Enter the port number on which the system listens for SNMP v2 queries from the SNMP
managers in this community. The default is 161.

Host

IP Address Enter the subnet address for the SNMPmanager to be permitted to query the FortiADC system.
SNMPmanagers have read-only access. You can add up to 8 SNMPmanagers to each
community. To allow any IP address using this SNMP community name to query the FortiADC
system, enter 0.0.0.0/0. For security best practice reasons, however, this is not
recommended.

Test both traps and queries (assuming you have enabled both). Traps and queries
typically occur on different port numbers, and therefore verifying one does not
necessarily verify that the other is also functional.

To test queries, from your SNMPmanager, query the FortiADC appliance.

To test traps, cause one of the events that should trigger a trap.

Configuring SNMP v3

To configure SNMP v3:

1. Go to System > SNMP.
2. Click the SNMPv3 tab.
3. Complete the configuration as described in SNMP v3 on page 213.
4. Save the configuration.

Settings Guidelines

SNMP v3

Name User name that the SNMPManager uses to communicate with the SNMP Agent. After you
initially save the configuration, you cannot edit the name.

Status Enable/disable the configuration.

Security Level l No Auth And No Privacy—Do not require authentication or encryption.
l Auth But No Privacy—Authentication based on MD5 or SHA algorithms. Select an algorithm
and specify a password.

l Auth And Privacy—Authentication based on MD5 or SHA algorithms, and encryption based
on AES or DES algorithms. Select an Auth Algorithm and specify an Auth Password; and
select a Private Algorithm and specify a Private Password.

SNMP v3 Port Enter the port number on which the system listens for SNMP v3 queries from the SNMP
managers. The default is 161.

Host

SNMP v3
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Settings Guidelines

IP Address Enter the subnet address for the SNMPmanager to be permitted to query the FortiADC system.
SNMPmanagers have read-only access. You can add up to 8 SNMPmanagers to each
community. To allow any IP address using this SNMP community name to query the FortiADC
system, enter 0.0.0.0/0. For security best practice reasons, however, this is not
recommended.

Test both traps and queries (assuming you have enabled both). Traps and queries
typically occur on different port numbers, and therefore verifying one does not
necessarily verify that the other is also functional.

To test queries, from your SNMPmanager, query the FortiADC appliance.

To test traps, cause one of the events that should trigger a trap.

Replacement Messages

From the System > Replacement Messages sub-menu, you can configure the pre-login disclaimer message that
shows before the user reaches the login page.

The Pre-login disclaimer message configuration is not supported when FortiADC is in SSLi
mode.

To configure the pre-login disclaimer in the GUI:

1. Go to System > Replacement Messages.
2. In the Pre-login Disclaimer Message tab, edit the message.
3. Click Save.

Enable the pre-login banner

The pre-login banner needs to be enabled to show the pre-login disclaimer messages.

To enable the pre-login banner in the GUI:

1. Go to System > Settings.
2. In the Basic tab, enable Pre Login Banner.
3. Click Save.

To enable the pre-login banner in the CLI:

config system global
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set pre-login-banner enable
end

FortiGuard

The System > FortiGuard sub-menu includes the following topics:

l Connecting to FortiGuard services on page 215
l Configuring FortiGuard service settings on page 218

Connecting to FortiGuard services

After you have subscribed to FortiGuard services, configure your FortiADC to connect to the Internet so that it can reach
the world-wide Fortinet Distribution Network (FDN) in order to:

l Verify its FortiGuard service licenses
l Download up-to-date signatures, IP lists, stolen account credentials, and engine packages

FortiADC appliances can often connect using the default settings. However, due to potential differences in
routing and firewalls, you should confirm this by verifying connectivity.

You must first register the FortiADC appliance with Fortinet Customer Service &
Support (https://support.fortinet.com/) to receive service from the FDN. The
FortiADC appliance must also have a valid Fortinet Technical Support contract that
includes service subscriptions and be able to connect to the FDN. For port numbers
to use to validate the license and update connections, see Port Numbers on page
838.

Connecting your FortiADC to the FDN will enable FortiGuard to periodically update the WAF Signature Database, IP
Reputation Database, and Geo IP Database. You can go to the FortiGuard website to download the update packages
that you can upload to FortiADC, or you can schedule automatic updates. However, if you want to perform a manual
update, you must download the update file from the FortiGuard website.

To determine your FortiGuard license status

1. If your FortiADC appliance must connect to the Internet through an explicit (non-transparent) web proxy, configure
the proxy connection (see Accessing FortiGuard via a proxy on page 218).
If FortiADC is deployed in a closed network, you can also use FortiManager as a proxy and connect FortiADC with it
to validate the license. FortiManager fully supports FortiGuard security service updates and license validation for
FortiADC.

2. Go to Dashboard > Main.
3. In the Licenses widget, check the status icon for each service package.

Valid—At the last attempt, the FortiADC appliance was able to successfully contact the FDN and validate its
FortiGuard license. Continue with Scheduling automatic signature updates.
Expired—At the last attempt, the license was either expired or FortiADC was unable to determine license status
due to network connection errors with the FDN. See the following for how to verify the connection status.
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Your FortiADC appliance cannot detect the latest vulnerabilities and compliance
violations unless it is licensed and has network connectivity to download current
definitions from the FortiGuard service.

If the connection did not succeed:
l On FortiADC, verify the following settings:

l time and time zone
l DNS settings
l network interface up/down status and IP
l static routes

l On your computer, use nslookup to verify that FortiGuard domain names are resolving (license authentication
queries are sent to update.fortiguard.net):

C:\Users\cschwartz>nslookup update.fortiguard.net
Server: google-public-dns-a.google.com
Address: 8.8.8.8

Non-authoritative answer:
Name: fds1.fortinet.com
Addresses: 209.66.81.150
209.66.81.151
208.91.112.66
Aliases: update.fortiguard.net

l Check the configuration of any NAT or firewall devices that exist between the FortiADC appliance and the FDN
or FDS server override. On FortiADC, enter the execute ping and execute traceroute commands to verify that
connectivity from FortiADC to the Internet and FortiGuard is possible:

FortiADC # exec traceroute update.fortiguard.net
traceroute to update.fortiguard.net (209.66.81.150), 32 hops max, 84 byte packets
1 192.0.2.2 0 ms 0 ms 0 ms
2 209.87.254.221 <static-209-87-254-221.storm.ca> 4 ms 2 ms 3 ms
3 209.87.239.161 <core-2-g0-3.storm.ca> 2 ms 3 ms 3 ms
4 67.69.228.161 3 ms 4 ms 3 ms
5 64.230.164.17 <core2-ottawa23_POS13-1-0.net.bell.ca> 3 ms 5 ms 3 ms
6 64.230.99.250 <tcore4-ottawa23_0-4-2-0.net.bell.ca> 16 ms 17 ms 15 ms
7 64.230.79.222 <tcore3-montreal01_pos0-14-0-0.net.bell.ca> 14 ms 14 ms 15 ms
8 64.230.187.238 <newcore2-newyork83_so6-0-0_0> 63 ms 15 ms 14 ms
9 64.230.187.42 <bxX5-newyork83_POS9-0-0.net.bell.ca> 21 ms 64.230.187.93 <BX5-

NEWYORK83_POS12-0-0_core.net.bell.ca> 17 ms 16 ms
10 67.69.246.78 <Abovenet_NY.net.bell.ca> 28 ms 28 ms 28 ms
11 64.125.21.86 <xe-1-3-0.cr2.lga5.us.above.net> 29 ms 29 ms 30 ms
12 64.125.27.33 <xe-0-2-0.cr2.ord2.us.above.net> 31 ms 31 ms 33 ms
13 64.125.25.6 <xe-4-1-0.cr2.sjc2.us.above.net> 82 ms 82 ms 100 ms
14 64.125.26.202 <xe-1-1-0.er2.sjc2.us.above.net> 80 ms 79 ms 82 ms
15 209.66.64.93 <209.66.64.93.t01015-01.above.net> 80 ms 80 ms 79 ms
16 209.66.81.150 <209.66.81.150.available.above.net> 83 ms 82 ms 81 ms

License validation with FortiManager

If FortiADC is deployed in a closed network, you can validate your FortiADC-VM license through FortiManager because
it has the built-in FDS (FortiGuard Distribution Servers) feature. This requires FortiManager to have Internet connection.
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To configure FortiADC-VM to validate its license using FortiManager, before you upload the license, enter the following
command:

config system fortiguard
set override-server-status enable
set override-server-address <fortimanager_ip>:8890

end

where <fortimanager_ip> is the IP address of the FortiManager. (TCP port 8890 is the port where the built-in FDS
feature listens for requests.)

For more information on the FortiManager built-in FDS feature, see the FortiManager Administration Guide.

FortiManager fully supports FortiGuard security service updates and license
validation for FortiADC.

To verify FortiGuard update connectivity

1. If your FortiADC appliance must connect to the Internet (and therefore FDN) through an explicit (non-transparent)
web proxy, first you must configure the proxy connection. For details, see Accessing FortiGuard via a proxy.

2. Go to System > FortiGuard.
To access this part of the web UI, your administrator's account access profile must have Read andWrite
permission to items in the System category.

3. If you want your FortiADC appliance to connect to a specific FDS other than the default for its time zone, enable
Override Server address and enter the IP address and port number of an FDS in the format <FDS_ipv4>:<port_
int>, such as 10.0.0.1:443, or enter the domain name of an FDS.

4. Click Save.
5. Click Update FortiGuard service definitions.

The FortiADC appliance tests the connection to the FDN and the server you specified to override the default FDN
server. The time required varies by the speed of the FortiADC appliance’s network connection, and by the number
of timeouts that occur before the connection attempt is successful or the FortiADC appliance determines that it
cannot connect. If you have enabled logging via Log Settings > Event, test results will be indicated in Event Log.
If the connection test is successful, you would see this log message:
VM License validated

For more troubleshooting information, enter the following commands:
diagnose debug enable
diagnose debug module updated all

These commands display cause additional information in your CLI console. For example:
FortiADC # [update]: Poll timeout.
FortiADC # *ATTENTION*: license registration status changed to 'VALID',please logout and

re-login

For example, poll (license and update request) timeouts can be caused by incorrectly configured static routes and
DNS settings, links with high packet loss, and other basic connectivity issues. Unless you override the behavior with
a specific FDS address (enable and configure Override Server address), FortiADC will connect to the FDN by
communicating with the server closest according to the configured time zone. Timeouts can also be caused by
configuring an incorrect time zone.
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Accessing FortiGuard via a proxy

You can access FortiGuard via a web proxy server. Using the CLI, you can configure FortiADC to connect through an
explicit (non-transparent) web proxy server to the FortiGuard Distribution Network (FDN) for signature updates.
FortiADC connects to the proxy using the HTTP CONNECTmethod as described in RFC 2616
(http://tools.ietf.org/rfc/rfc2616.txt).

CLI Syntax

config system fortiguard
set tunneling-status enable
set tunneling-address 0.0.0.0
set tunneling-password mypassword
set tunneling-port 8080
set tunneling-username FortADC

end

For details, see the FortiADC CLI Reference: https://docs.fortinet.com/product/fortiadc/.

Configuring FortiGuard service settings

FortiGuard periodically updates the WAF Signature Database, IP Reputation Database, and Geo IP Database.

From System > FortiGuard, you can configure FortiGuard settings on your FortiADC appliance through the FortiGuard
Distribution Network (FDN).

Here, you can configure FortiADC to request for FortiGuard service updates from the FDN by Scheduling automatic
signature updates on page 220 and/or Manually initiating update requests on page 222.

Before you begin:

You must have Read andWrite permission for System settings.

Licenses

Under the Licenses section, you can check your FortiGuard license status and upgrade the license as needed.

Support Contract

Under the Support Contract section, you can review the following contract information and directly login to the Fortinet
Service & Support website.

Support Type Description

Registration Review your registration and license information. If you need to update your
registration or renew your license, click Login Now to open the login page for the
Fortinet Service & Support website.
Note: If your license is invalid, FortiGuard does not send updates to your
FortiADC. The functionality on your FortiADC unit remains intact and useful even
though it is out of date.

Hardware Shows the hardware model of your FortiADC unit.
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Support Type Description

Firmware Shows the firmware version on your FortiADC unit.

Enhanced Support Shows the status of Enhanced Support of your FortiADC unit. .

Comprehensive Support Shows the status of Comprehensive Support of your FortiADC unit.

FortiGuard services and updates

Under the FortiGuard Services section, you can review the list of your FortiGuard service entitlement and the status of
each service.

From here, you can also manually update each service by uploading the update packages individually. You can obtain
each update package from the FortiGuard website.

Alternatively, you can configure FortiADC to request for FortiGuard service updates from the FDN by doing either or both
of the following:

l Scheduling automatic signature updates on page 220
l Manually initiating update requests on page 222

Service Description

WAF Signature Shows the version of the Web Application Firewall Signature file on your FortiADC
unit. To manually update the file, click Update to display controls that enable you
to select and upload the latest WAF Signature file.

IP Reputation Shows the version of the IP Reputation file on your FortiADC unit. To manually
update the file, click Update to display controls that enable you to select and
upload the latest IP reputation file.

Credential Stuffing Defense Shows the version of the Credential Stuffing Defense file on your FortiADC unit.

Geo IP Shows the version and region of the Geo IP file on your FortiADC unit. To
manually update the file, click Update to display controls that enable you to select
and upload the latest Geo IP file.

Web Filter Shows the status of the Web Filter on your FortiADC unit.

Intrusion Prevention Shows the version of the Regular IPS Database, Extended IPS Database, and IPS
Engine on your FortiADC unit. To manually update the file, click Update to display
controls that enable you to select and upload the latest Intrusion Prevention file.

Antivirus Shows the version of the Antivirus Regular Virus Database, Extended Virus
Database, Extreme Virus Database, and AV Engine on your FortiADC unit. To
manually update the file, click Update to display controls that enable you to select
and upload the Antivirus files.

Threat Analytics Shows the license status of the AI Threat Analytics on your FortiADC unit.

Data Loss Prevention (DLP) Shows the version of the FortiGuard Data Loss Prevention (DLP) service on your
FortiADC unit. To manually update the file, click Update to display controls that
enable you to select and upload the latest DLP Signature file.

Advanced Bot Protection Shows the license status of the Advanced Bot Protection on your FortiADC unit.
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Scheduling automatic signature updates

You can configure the FortiADC appliance to periodically poll for FortiGuard service updates from the FDN, and
automatically download and apply updates if they are available. For example, you may want to schedule update
requests every night at 2 AM local time when traffic volume is light. You can also use the command config system
fortiguard to upgrade from the Anycast server. For more information, see set anycast {enable|disable} in
config system fortiguard in the FortiADC CLI Reference (https://docs.fortinet.com/product/fortiadc/).

You can manually upload update packages, or initiate an update request as an
alternative or in conjunction with scheduled updates. For additional/alternative
update methods, see Manually initiating update requests on page 222.

To configure automatic updates

1. Verify that the FortiADC appliance has a valid license and can connect to the FDN, or (if destination NAT is used, for
example) the IP address that you are using to override the default IPs for FDN servers. For details, see Connecting
to FortiGuard services on page 215 to determine your FortiGuard license status and to verify the FortiGuard update
connectivity.

2. Go to System > FortiGuard.
The page informs you if you are not registered or if registration has expired. If your registration is active, continue
scheduling updates; otherwise, click Register or Renew.

FortiADC Handbook 220
Fortinet Technologies Inc.

https://docs.fortinet.com/product/fortiadc/


3. Configure the following settings:

Setting Guideline

Scheduled Update Click the button to enable or disable the Scheduled Update feature.
Note: If enabled, you must set the frequency, date, or time of the update
schedule. See below.

Scheduled Update Frequency l Every—Schedule periodic updates. Specify the update interval to perform
the scheduled update.

l Daily—Schedule daily updates. Specify the time of the day to perform the
scheduled update.

l Weekly—Schedule weekly updates. Specify the day and time to perform
the scheduled update.

Scheduled Update Day Select the day of the week for the scheduled update.

Scheduled Update Time Specify the time (hour and minute) for the scheduled update.

Override Server Click the button to enable or disable the Override Server feature.
Note: This feature provides another option for your FortiADCto connect to
FortiGuard when it ( FortiADC) is unable to connect to FortiGuard via the default
FortiGuard server IP address.
If enabled, you must enter the Override Server Address that you have obtained
from the Fortinet Service and Support team. See below.

Override Server Address Enter the Override Server Address provided by the Fortinet Service and
Support team.

Tunneling Click the button to enable or disable tunneling.
If enabled, you must configure all the settings for the tunneling function. See
below.
Note: Tunneling, or port forwarding, is a way of transmitting private (usually
corporate) data through a public network in a disguised way— the routing
nodes in the public network are unaware that the transmission is part of a
private network.

Tunneling DNS Click the button to enable or disable DNS via web proxy tunneling for FDN.

Tunneling Address Enter the Tunneling Address that was provided to you.

Tunneling Port Enter the Tunneling Port number that was provided to you.

Tunneling Username Specify your user name for the tunneling configuration.

Tunneling Password Specify your password for the tunneling configuration.

4. Click Save.

Results of the update activity appear in Log & Report > Event log if you have enabled logging via Log Settings >
Event.

When the FortiADC appliance requests an update, the event is recorded in Log & Report > Event log.

Example log messages include:

Update result: fcni=yes fdni=yes fsci=yes IP Reputation(4.00709) Geo IP(2.00094) Regular
Virus Database(89.00510) Extended Virus Database(88.09720) Extreme Virus Database
(88.09670) AV Engine(6.00162) from 173.243.140.6:443
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Once the attack signature update is complete, FortiADC immediately begins to use them. No reboot is required.

Manually initiating update requests

If an important update has been released but there is too much time remaining until your appliance’s next scheduled
update poll, you can manually trigger the FortiADC appliance to connect to the FDN or FDS server override to request
available updates for its FortiGuard service packages.

You can manually initiate updates as an alternative or in addition to other update
methods. For details, see Scheduling automatic signature updates on page
220Scheduling automatic signature updates on page 220

To manually request updates

1. Before manually initiating an update, first verify that the FortiADC appliance has a valid license and can connect to
the FDN or override server. For details, see Connecting to FortiGuard services on page 215 to determine your
FortiGuard license status and to verify the FortiGuard update connectivity.

2. Go to System > FortiGuard.
3. Click Update FortiGuard Service Definitions.

The web UI displays a message similar to the following:
Update database successful, status refreshed.

Results of the update activity appear in Log & Report > Event log if you have enabled logging via Log Settings >
Event.

When the FortiADC appliance requests an update, the event is recorded in Log & Report > Event log.

Example log messages include:

Update result: fcni=yes fdni=yes fsci=yes IP Reputation(4.00709) Geo IP(2.00094) Regular
Virus Database(89.00510) Extended Virus Database(88.09720) Extreme Virus Database
(88.09670) AV Engine(6.00162) from 173.243.140.6:443

Once the attack signature update is complete, FortiADC immediately begins to use them. No reboot is required.

Web Filter

Under theWeb Filter section, you can configure your FortiGuard web filter settings.

Setting Guideline

Cache Status Click the button to enable or disable caching of the categorical lists of websites.
Note: FortiGuard maintains massive lists of web sites classified into categories so
that you can enforce categorical decisions in your rules, like "do not do SSL
forward proxy for sites belonging to the Personal Privacy category."

Cache TTL Specify a cache expiration value. The default is 3600. The valid range is from 10
to 86,400. When the cache expires, FortiADC initiates an update from FortiGuard.

FDS Port Specify the port to receive updates. The default is 53. An alternative is 8888.
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Debug

From the System > Debug sub-menu, you can use the Save Debug File feature to create an archive of various
configuration files, logs and other details used to help in diagnosing any issues that may arise. The file is saved locally
(maximum of 3 files) and can be downloaded to the logged-in admin PC or uploaded to an FTP server.

A key component of the system debug file is the crash log. However, downloading the entirety of the crash log may
overburden the browser memory. For this reason, the Save Debug File feature offers the option to download a text file
containing only the file names from the crash log as an alternative.

To create a system debug file:

1. Go to System > Debug.
2. Click Save Debug File.
3. Set the Enable Crash Package options:

l Enable — The debug file will contain all core files and crash files. This is the default option.
l Disable — The debug file will contain all core files and a text file containing only the file names of the crash files.

4. ClickOK.
The save debug will run, which may take several seconds. Check the Running Status for when the file is ready to
download.

5. When the file is ready, as indicated in the Running Status column, you can download it via the GUI or upload it to
an FTP server.

Column Description

Name system_debug_file_<date>_<time>

Running Status Running status indicates the final download status.
Running—The system is still collecting and compressing the debug file to generate a
download file.
Ready—The file is ready to download via the GUI or upload to FTP.

Upload Status The upload FTP status.
Running—The File is uploading. Error messages will appear in the Upload Status
column.
Ready—The Upload is completed.

6. Optionally, you may terminate a debug file save request while its Running Status is still in Running.
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Certificate

The System > Certificate sub-menu allows you to perform the following tasks relating to certificate management and
validation:

l Manage Certificates on page 224
l Verify on page 239
l OCSP on page 244

Manage Certificates

Under the System Certificate sub-menu, theManage Certificates page contains the features that allow you to perform
the following certificate management tasks:

l Generating a local certificate on page 227
l Importing a local certificate on page 229
l Creating a local certificate group on page 236
l Importing intermediate CAs on page 238
l Creating an intermediate CA group on page 238

Managing and validating certificates

This section includes the following topics:

l Overview
l Prerequisite tasks
l Manage certificates
l Validate certificates

Overview

The FortiADC system is able to process the following two types of TLS/SSL traffic:

l System administration—Administrators connect to the web UI (HTTPS connections only). When you connect to the
web UI, the system presents its own default “Factory” certificate. This certificate is used only for connections to the
web UI. It cannot be removed. Do not use this certificate for server load balancing traffic.

l Server load balancing—Clients use SSL or TLS to connect to a virtual server. When you use FortiADC as a proxy
for SSL operations normally performed on the backend real servers, you must import the X.509 v3 server
certificates and private keys that the backend servers would ordinarily use, as well as any certificate authority (CA)
or intermediate CA certificates that are used to complete the chain of trust between your clients and your servers.

The FortiADC system supports all of the TLS/SSL administration methods commonly used by HTTPS servers, including:

l Server name indication (SNI)—You can require clients to use the TLS extension to include the server hostname in
the TLS client hello message. Then, the FortiADC system can select the appropriate local server certificate to
present to the client.

l Local certificate store—A certificate store for the X.509 v3 server certificates and private keys that the backend
servers would ordinarily use.
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l Intermediate CAs store—A store for Intermediate CAs that the backend servers would ordinarily use to complete
the chain of server certificates. HTTPS transactions use intermediate CAs when the server certificate is signed by
an intermediate certificate authority (CA) rather than a root CA.

l Certificate Authorities (CAs) store—A store for CA certificates that the back-end servers would ordinarily use to
verify the CA signature in client certificates or the signature of an OCSP Responder.

l OCSP—Use Online Certificate Status Protocol (OCSP) to obtain the revocation status of certificates.
l CRL—Use a Certificate Revocation List (CRL) to obtain the revocation status of certificates.
l Certificate validation policy—You can configure certificate validation policies that use OCSP or CRL. These policies
can be associated with load balancing profiles.

l All digital certificates of RSA and ECDSA key types—whether they are local, remote, intermediate, or CA root
certificates.

l Multiple CA, CRL, and OCSP configurations.
l Client certificate forwarding.
l SNI forwarding.
l Email alert on certificate expiration, CRL expiration, and OCSP stapling expiration.

Note: The factory certificate is the default certificate for any application over SSL/TSL. It is a unique certificate that
presents the credentials of your FortiADC. Upon system start, FortiADC automatically generates a self-signed factory
certificate with its identifier (i.e., common name) which is your FortiADC's serial number. For example, if a trial license is
in use, then the common name (CN) for the factory.cer would be FADV0000000TRIAL; if the license is imported, the
factory.cer would be FADV080000072226.

Certificates and their domains

You can generate or import certificates in the global domain (i.e., FortiADC appliance) and individual VDOM domains
(i.e., virtual machines). The visibility and use of certificates or certificate groups may vary, depending where (the domain)
they are created. Below are the general guidelines regarding the availability and use of certificates or certificate groups.

l Local Certificates/intermediate Certificates—If generated or imported in a specific VDOM domain, they can be
viewed and deleted in that VDOM only, but not visible in any other VDOM or the global domain; if generated or
imported in the global domain, they can be viewed and downloaded by all VDOMS, but can be deleted only in the
global domain.

l Local Certificate Groups/Intermediate CA Groups—If added in a specific VDOM domain, they can be viewed,
edited, or referenced in that VDOM domain only, but not visible in any other VDOMs or the global domain; if added
in the global domain, they can be visible to all VDOM domains, but can be edited only in the global domain.

l CA/CRL/OCSP Signing Certificates—If imported in a specific VDOM domain, they can be viewed or deleted only
in that VDOM, but not visible in any other VDOM domain or the global domain; if imported in the global domain, they
can be viewed or downloaded in all VDOM domains, but can be deleted only in the global domain.

l Verify/CA Group/OCSP—If added in a specific VDOM domain, they can be viewed or edited or referenced to in
that VDOM domain only, but not visible in any other VDOM domain or the global domain; if added in the global
domain, they can be viewed or referenced to in all VDOMs, but can be edited only in the global domain.

Prerequisite tasks

You must download the certificates from your backend servers so that you can import them into the FortiADC system.

This example shows how to download a CA certificate from Microsoft Windows 2003.

FortiADC Handbook 225
Fortinet Technologies Inc.



To download a CA certificate from Microsoft Windows 2003 Server:

1. Go to https://<ca-server_ipv4>/certsrv/.
where <ca-server_ipv4> is the IP address of your CA server.

2. Log in as Administrator. Other accounts may not have sufficient privileges.
The Microsoft Certificate Services home page appears.  Welcome page on page 226 is an example of this page.
 Welcome page

3. Click the Download CA certificate, certificate chain, or CRL link to display the Download a CA Certificate,
Certificate Chain, or CRL page.  Download a CA Certificate, Certificate Chain, or CRL page on page 226 is an
example of this page.

4. From Encoding Method, select Base64.
5. Click Download CA certificate.

 Download a CA Certificate, Certificate Chain, or CRL page
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Generating a local certificate

In order for FortiADC to authenticate client certificates, you can either generate a certificate signing request (CSR) or
upload trusted CA certificates to FortiADC.

Many commercial certificate authorities (CAs) provide websites where you can generate your own CSR. A CSR is an
unsigned certificate file that the CA will sign. When a CSR is generated, the associated private key that the appliance will
use to sign and/or encrypt connections with clients is also generated.

If your CA does not provide this service, or if you have your own private CA such as a Linux server with OpenSSL, you
can use FortiADC to generate a CSR and private key. This CSR can then be submitted for verification and signing by the
CA.

Before you begin:

l You must have Read-Write permission for System settings.

To generate a certificate signing request:

1. Go to System > Manage Certificates.
2. Click the Local Certificate tab.
3. ClickGenerate to display the configuration editor.
4. Configure the following settings.

Setting Description

Generate Certificate Signing Request

Certification Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces.
The maximum length is 35 characters.
Note: This is the name of the CSR file, not the host name/IP contained in the
certificate’s Subject: line.

Subject Information

ID Type Select the type of identifier to use in the certificate to identify the virtual server:
l Host IP—The static public IP address of the FortiADC virtual server in the
IP Address field. If the FortiADC appliance does not have a static public
IP address, use the email or domain name options instead.
Note: Do NOT use this option if your network has a dynamic public IP
address. Your web browser will display the “Unable to verify certificate” or
similar error message when your public IP address changes.

l Domain Name—The fully qualified domain name (FQDN) of the FortiADC
virtual server, such as www.example.com. This does not require that the
IP address be static, and may be useful if, for example, your network has a
dynamic public IP address and therefore clients connect to it via dynamic
DNS. Do not include the protocol specification (http://) or any port number
or path names.

l E-Mail—The email address of the owner of the FortiADC virtual server.
Use this if the virtual server does not require either a static IP address or a
domain name.

Depending on your choice for ID Type, related options appear.
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IP Address Enter the static IP address of the FortiADC appliance, such as 10.0.0.1.The
IP address should be the one that is visible to clients. Usually, this should be its
public IP address on the Internet, or a virtual IP that you use NAT to map to the
appliance’s IP address on your private network.
This option appears only if ID Type is Host IP.

Domain Name Enter the FQDN of the FortiADC appliance, such as www.example.com. The
domain namemust resolve to the IP address of the FortiADC appliance or
backend server according to the DNS server used by clients. (If it does not, the
clients’ browsers will display a Host name mismatch or similar error
message.)
This option appears only if ID Type is Domain Name.

Email Enter the email address of the owner of the FortiADC appliance, such as
admin@example.com. This option appears only if ID Type is E-Mail.

Distinguished Information

Organization Unit Name of organizational unit (OU), such as the name of your department. This
is optional. To enter more than one OU name, click the + icon, and enter each
OU separately in each field.

Organization Legal name of your organization.

Locality (City) City or town where the FortiADC appliance is located.

State/Province State or province where the FortiADC appliance is located.

Country/Region Country where the FortiADC appliance is located.

Email E-mail address that may be used for contact purposes, such as
admin@example.com.

Key Information

Key Type Select either of the following:
l RSA
l ECDSA

Key Size/ Curve Name For RSA key, select one of the following key sizes:
l 1024 Bit
l 1536 Bit
l 2048 Bit
l 4096 Bit.

Note: Larger keys use more computing resources, but provide better security.
For ECDSA, select one of the following curve names:
l prime256v1
l secp384r1
l secp521r1

Enrollment Information

Enrollment Method l File-Based—You must manually download and submit the resulting
certificate request file to a CA for signing. Once signed, upload the local
certificate.
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Online SCEP—The FortiADC appliance automatically uses HTTP to submit
the request to the simple certificate enrollment protocol (SCEP) server of a CA,
which will validate and sign the certificate. For this selection, two options
appear. Enter the CA Server URL and the Challenge Password.

5. Click Save.
The system creates a private and public key pair. The generated request includes the public key of the FortiADC
appliance and information such as the IP address, domain name, or email address. The FortiADC appliance private
key remains confidential on the FortiADC appliance. The Status column of the new CSR entry is Pending.

6. Select the row that corresponds to the certificate request.
7. Click Download.

Standard dialogs appear with buttons to save the file at a location you select. Your web browser downloads the
certificate request (.csr) file.

8. Upload the certificate request to your CA.
After you submit the request to a CA, the CA will verify the information in the certificate, give it a serial number, an
expiration date, and sign it with the public key of the CA.

9. If you are not using a commercial CA whose root certificate is already installed by default on web browsers,
download your CA’s root certificate, and then install it on all computers that will be connecting to your FortiADC
appliance. Otherwise, those computers might not trust your new certificate.

10. After you've received the signed certificate from the CA, import the certificate into the FortiADC system.

Importing a local certificate

You can import (upload) local certificates and their private key files into the FortiADC system to allow FortiADC to
authenticate client certificates.

The following types of X.509 server certificates and private keys are supported:

l Base64-encoded
l PKCS #12 RSA-encrypted

After you have downloaded the local certificate and private key files, you can import them into the FortiADC system.

Alternatively, you can select the automated certificate type to use the ACME service to get the SSL/TLS certificates from
Let's Encrypt or other ACME providers. Certificates imported through Let's Encrypt have a ninety-day lifetime (which
may differ from other ACME providers). These certificates must be renewed prior to expiration. FortiADC supports the
TLS-ALPN-01 and DNS-01 challenge types. The TLS-ALPN-01 challenge supports automatic certificate renewal. The
DNS-01 challenge requires manual certificate renewal, however, only the DNS-01 challenge can issue certificates
containing wildcard domain names.

Before you begin:

l You must have Read-Write permission for System settings.

To import a local certificate through file upload or using the ACME protocol:

1. Go to System > Manage Certificates.
2. Click the Local Certificate tab.
3. Click Import to display the configuration editor.
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4. Select the local certificate Type from the drop-down menu.
l Certificate—Use this option only if you have a certificate and its key in separate files.
l PKCS12 Certificate—Use this option only if you have a PKCS #12 password-encrypted certificate with its key
in the same file.

l Local CSR Certificate—Use this option only if you have a CA-signed certificate that was originated from a
CSR generated in FortiADC. See Importing a local certificate on page 229.
Note: Ensure that the load-balancer (FortiADC appliance) you use to import a local certificate is the same
appliance where the CSR was generated as that is where the key matching the certificate resides. The import
operation will fail without the matching key on the same hardware system.

l Automated—Use this option if you want to use the ACME protocol to get the certificates from Let's Encrypt or
other ACME providers.

5. Configure the following settings based on the local certificate Type.

Setting Description

Certificate

Certificate Name Specify the certificate name that can be referenced by other parts of the
configuration, such as www_example_com. The maximum length is 35
characters. Do not use spaces or special characters.

Certificate File Browse for and upload the certificate file that you want to use.

Input Type Select either of the following:
l Upload
l Manual Input

Certificate File The Certificate File option appears if the Input Type is Upload.
Browse for and upload the certificate file that you want to use.

Key File The Key File option appears if the Input Type is Upload.
Browse for and upload the corresponding key file.

Certificate The Certificate File option appears if the Input Type isManual.
Paste the contents of the certificate file into the text box.

Key The Certificate File option appears if the Input Type isManual.
Paste the contents of the key file into the text box.

Password Specify the password to decrypt the file. If the file was encrypted by a
password when generated, the same password must be provided when the file
is imported to FortiADC. If the file was generated without a password, there is
no need to specify a password when importing the file to FortiADC.

PKCS12 Certificate

Certificate Name Specify the certificate name that can be referenced by other parts of the
configuration, such as www_example_com. The maximum length is 35
characters. Do not use spaces or special characters.

Certificate File Browse for and upload the certificate file that you want to use.

Password Specify the password to decrypt the file. If the file was encrypted by a
password when generated, the same password must be provided when the file
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is imported to FortiADC. If the file was generated without a password, there is
no need to specify a password when importing the file to FortiADC.

Local CSR Certificate

Certificate File Browse for and upload the certificate file that you want to use.

Automated

Certificate Name Specify the certificate name that can be referenced by other parts of the
configuration, such as www_example_com. The maximum length is 35
characters. Do not use spaces or special characters.
Note: If the Challenge Type is TLS-ALPN-01, the Certificate Namemust
match the name of the "placeholder" certificate that is linked to the HTTPS
virtual server. For details, see Fulfilling the ACME TLS-ALPN-01 challenge on
page 235.

Domain Name Specify the web server domain to be protected by the certificate.
Note: If the Challenge Type is TLS-ALPN-01, the Domain Namemust be
from the HTTPS virtual server that is linked to the "placeholder" certificate. For
details, see Fulfilling the ACME TLS-ALPN-01 challenge on page 235.

Email Enter the email address that will receive notifications regarding the status of
the certificate.
Depending on which ACME service provider you use, you may receive
notification for when the certificate request has been approved through the
Certificated Services or when the certificate is due to expire.

Key Type Select either of the following:
l RSA
l ECDSA

Note: If the Challenge Type is TLS-ALPN-01, the Key Typemust match the
key type of the "placeholder" certificate that is linked to the HTTPS virtual
server. For details, see Fulfilling the ACME TLS-ALPN-01 challenge on page
235.

Key Size The Key Size option appears if the Key Type is RSA.
Select one of the following key sizes:
l 2048 bit
l 3072 bit
l 4096 bit

Curve Name The Key Size option appears if the Key Type is ECDSA.
Select one of the following curve names:
l prime256v1
l secp384r1
l secp521r1

Password Specify the password to decrypt the file. If the file was encrypted by a
password when generated, the same password must be provided when the file
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is imported to FortiADC. If the file was generated without a password, there is
no need to specify a password when importing the file to FortiADC.

CA Group Specify the name of the CA Group. FortiADC will use the CA certificate in the
CA Group to verify the certificate sent by the ACME provider.
From the drop-down, you may select previously configured CA Group or select
Create New to create and configure a CA Group directly.

ACME Service Select either of the following:
l Let's Encrypt — use the Let's Encrypt certificate authority
(https://letsencrypt.org/) as the ACME provider.

l Other — use an ACME provider that is not Let's Encrypt, such as Buypass
AS (https://www.buypass.com/).

ACME Server URL The ACME Server URL option appears if the ACME Service isOther.
Specify the URL of the ACME server. The ACME request URL must begin with
"https://".
After you have obtained the ACME certificate from your chosen ACME service
provider, you will need to provide the ACME server URL to connect to
FortiADC. This will enable FortiADC to act as the ACME client to send the
ACME request and receive the ACME certificate/key.
Note: The ACME server URL is unique to the ACME service provider. Please
refer to the documentation from your ACME provider for further information.

Challenge Type The ACME server requires validation that you control the domain names in the
certificate using "challenges" as defined by the ACME standard. FortiADC
supports the TLS-ALPN-01 and DNS-01 challenge types.
Select either of the following challenge types:
l TLS-ALPN-01— The TLS-ALPN-01 supports automatic certificate
renewal. However, this method cannot be used to validate wildcard
domains. To use this challenge type, you will need to make preparations
to fulfill the challenge before completing the certificate import
configurations (for details, see Fulfilling the ACME TLS-ALPN-01
challenge on page 235).

l DNS-01— The DNS-01 challenge can be used to issue certificates
containing wildcard domain names. To use this challenge type, you will
need to take steps to fulfill the challenge after completing the certificate
import configurations (for details, see Fulfilling the ACME DNS-01
challenge on page 233). Certificates imported using the DNS-01
challenge need to be manually renewed.

RenewWindow The Renew Window option appears if the Challenge Type is TLS-ALPN-01.
Specify a renew window (in minutes) to automatically renew the certificate
before it expires. (Range: 0-43200 minutes). Setting the renew window to 0 will
disable the automatic certificate renewal.

ChallengeWait Time The Challenge Wait Time option appears if the Challenge Type is DNS-01.
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Specify the ACME DNS-01 challenge wait time in minutes. (Range: 1-1440
minutes).
The ACME DNS-01 challenge wait time refers to the amount of time you will
have to fulfill the DNS-01 challenge. A longer challenge wait time is
recommended to ensure enough time is allotted to perform the required Public
DNS configuration changes and for the changes to take effect.
For more information, see Fulfilling the ACME DNS-01 challenge on page 233.

6. Click Save.

Fulfilling the ACME DNS-01 challenge

The DNS-01 challenge asks you to prove that you control the DNS for your domain name by putting a specific value in a
TXT record under that domain name.

After you have saved your automated local certificate configuration, the ACME DNS challenge information is generated.
With this information, you will configure your Public DNS Service to create the TXT record.

Certificates generated by the ACME DNS-01 challenge cannot be renewed
automatically. Please manually renew the certificate before it expires.

To add the record the DNS challenge information to the Public DNS Service:

1. Obtain the ACME DNS challenge information using either of the following methods.
l After you save your automated local certificate configuration, you will be shown the challenge information.
Save this information for use later.
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l In the Local Certificate page, locate the local certificate record and click the (View icon) to see the details.

2. Login to your DNS service provider and go to your DNS Domain management page.
3. Add a record and input the challenge information into the corresponding fields.

Name _ACME-CHALLENGE is a fixed value.

Type Set the record type as TXT.

TTL Set this to the default value.

Target Paste the content from your ACME DNS-01 challenge information.

4. Save the changes.
The DNS configuration changes may take several minutes to take effect.

The ACME provider will then query the DNS system for that record to find a match. If there is a match, the ACME
certificate passes validation (certificate status will progress from Pending→OK). However, if the record is not found
within the specified challenge wait time then the certificate validation fails (certificate status is Fail).

If the certificate validation fails, then you will need to delete the record and import a new automated local certificate to try
again.

It is recommended to set a longer challenge wait time to allow enough time for the
DNS configuration changes to take effect. If the DNS configuration changes has not
taken effect at the time the ACME provider queries the DNS system for the TXT
record, then the validation will fail. Various factors may influence the speed of the
DNS (such as the DNS service provider, network speed, network traffic), so the DNS
configuration changes may take as long as 20 minutes to take effect.
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Fulfilling the ACME TLS-ALPN-01 challenge

In FortiADC, to fulfill the TLS-ALPN-01 challenge, the ACME server validates control of the domain name by connecting
to the Virtual Server at one of the addresses resolved for the domain name. This is achieved by linking a certificate to an
HTTPS virtual server to allow the ACME server resolving domain to point to its IP. Then FortiADC generates a temporary
certificate to fulfill the validation.

Before configuring an automated certificate using the TLS-ALPN-01 challenge, you must set up the following:

l A valid local certificate that functions as a placeholder
l An HTTPS virtual server to link the placeholder certificate

Once the placeholder certificate has been linked to the HTTPS virtual server, you will then use the placeholder certificate
name and the domain name from the virtual server to import the automated certificate using the TLS-ALPN-01
challenge. This certificate then replaces the placeholder certificate so that it will be linked to the HTTPS virtual server to
fulfill the TLS-ALPN-01 challenge.

To prepare the placeholder certificate and HTTPS virtual server for the ACME TLS-ALPN-01 challenge:

1. Generate or import a local certificate. This certificate must be valid (Status is OK). Ensure the Key Type of this
placeholder certificate matches the key type of the automated certificate you intend to import. In the example below,
the placeholder certificate is RSA, so the automated certificate you will be importing must also be RSA. Record the
certificate name for use in later steps. For details, see Importing a local certificate on page 229 or Importing a local
certificate on page 229.

Note: If importing a local certificate, you should only import the following certificate types: Certificate, PKCS12
Certificate and Local CSR Certificate. As the placeholder certificate must be valid, it is not recommended to use an
Automated certificate type for this purpose since this type of certificate cannot be valid until the ACME challenge is
fulfilled.

2. Create a local certificate group and add the placeholder certificate you have created previously under this certificate
group. Select the placeholder certificate from the Local Certificate drop-down and leave all other parameters as
default. Record the certificate group name for use in later steps. For details, see Creating a local certificate group on
page 236.
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3. Create a Client SSL profile and add the certificate group you have created previously as the Local Certificate
Group. Record the Client SSL profile name for use in later steps. For details, see Configuring Client SSL profiles on
page 412.

4. Create an HTTPS virtual server. Apply the Client SSL profile you have created previously. For details, see
Configuring virtual servers on page 328.
The Address of this HTTPS virtual server must be associated to a domain to ensure it can be reached by the ACME
provider. It is recommended that this domain be registered at a DNS service provider so you can set the domain to
point to a specific IP address. Record the domain for use in later steps.

5. Import the automated certificate using the TLS-ALPN-01 challenge type.
Input the information for the following settings according to the guidelines below.

Setting Guideline

Certificate Name The name must match the name of the placeholder certificate. Once this
automated certificate configuration is completed, it will replace the placeholder
certificate.

Domain Name Input the domain of the HTTPS virtual server that has been linked to the
placeholder certificate. The ACME provider will reach this domain that points
to the HTTPS virtual server IP address.

Key Type The Key Type must match the placeholder certificate.

Creating a local certificate group

Local certificate groups are used to facilitate the configuration of profiles that are associated with a virtual server.

Before you begin:

l You must have Read-Write permission for System settings.
l You must have already added the certificates to the local certificate store and intermediate CAs to the intermediate
certificate store, and created an intermediate CA group.

l Optionally, create an OCSP Stapling configuration.

To create a local certificate group:

1. Go to System > Manage Certificates.
The configuration page displays the Local Certificate Group tab.

2. Click Create New to display the configuration editor.
3. Enter the Group Name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces. The maximum length is 35

characters. After you initially save the configuration, you cannot edit the name.
4. Click Save.
5. Under theGroup Member section, click Create New to display the configuration editor.
6. Complete the configuration as described in Local certificate group configuration on page 236.
7. Click Save.

Settings Guidelines

Default Check this check box only if you want to make this local certificate the default for the group.

Local certificate group configuration
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Settings Guidelines

Note: Only one local certificate can be set as the default in a group. If one local certificate has
already been set as the default, you must disable (uncheck) it in order to set another one as the
default. By default, the first local certificate in the group becomes the default if no other local
certificate is set as the default.

Local Certificate Select a local certificate to add to the group.

OCSP Stapling Select an OCSP Stapling configuration. The local certificate in the OCSP Stapling configuration
must match the local certificate in the local certificate group member. See OCSP stapling on
page 245.

Intermediate CA
group

Select an intermediate CA group to add to the local group. (Optional)

Extra Certificate FortiADC supports dual SSL certificates, one for an RSA-based SSL certificate and the other for
an ECDSA-based SSL certificate. This option allows you to add an additional local certificate
along with an additional OCSP stapling and intermediate CA group to a local certificate group
configuration.
Note: This extra local certificate, which is optional, must be of a different format from the local
certificate you selected in the first place. In other words, if the local certificate is RSA-based, then
this extra local certificate must be ECDSA-based, or vice versa.

Extra Local
Certificate

Select an extra local certificate which is different from the local certificate.

Extra
OCSP Stapling

Select an extra OCSP stapling configuration. The extra local certificate in the extra
OCSP stapling configuration must match the extra local certificate in the extra local certificate
group member. (Optional)
Note: This option is available only when the Extra Local Certificate has already been set.

Extra Intermediate
CA Group

Select an extra intermediate CA group to add to the extra local certificate group. (Optional)
Note: This option is available only when the Extra Local Certificate is set.

Note: In general, ECDSA certificates are a good choice for both client and server because they require less time and
fewer resources to process. However, for some old web browsers that do not support ECSDA certificates, RSA is the
only choice. So, having both an RSA certificate and an ECSDA certificate in the same local certificate group
configuration allows FortiADC to take full advantage of the benefits that they offer.

You can also assign two certificates to a local certificate group from the Console, as illustrated in the following example
commands:

config system certificate local_cert_group
edit "dual"

config group_member
edit 1

set local-cert intermediate02-leafCA-leaf-Serve-RSA
set OCSP-stapling intermediate02-leafCA-leaf-Serve-RSA
set intermediate-ca-group RSA-intermediate02-leaf
set local-cert-extra intermediate02-leafCA-leaf-Serve-ECC
set OCSP-stapling-extra intermediate02-leafCA-leaf-Serve-ECC
set intermediate-ca-group-extra RSA-intermediate02-leaf

next
end

next
end
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Importing intermediate CAs

An intermediate CA store is for the intermediate CA certificates that back-end servers would normally use to complete
the chain of server certificates, if any. HTTPS transactions use intermediate CAs when the server certificate is signed by
an intermediate certificate authority (CA) rather than a root CA.

In FortiADC, a root CA can be imported as an "intermediate CA".

Before you begin:

l You must have Read-Write permission for System settings.
l You must know the URL of an SCEP server or have downloaded the certificate and key files and be able to browse
to them so that you can upload them.

To import an intermediate CA:

1. Go to System > Manage Certificates.
2. Click the Intermediate CA tab.
3. Click Import to display the configuration editor.
4. Complete the configuration as described in Intermediate CA import configuration on page 238.
5. Click Save when done.
6. Repeat Steps 3 through 5 to import as many intermediate CAs as needed.

Settings Guidelines

Certificate Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces.The maximum
length is 35 characters. After you initially save the configuration, you cannot edit the name.

Import Method l SCEP—Use Simple Certificate Enrollment Protocol. SCEP allows routers and other
intermediary network devices to obtain certificates.

l File—Upload a file.

SCEP

SCEP URL Specify the URL of the SCEP Server.

CA Identifier Enter the identifier of the CA on the SCEP server, if applicable.

File

Certificate File Browse for and upload the the certificate file on the local machine.

Key File Browse for the corresponding PEM key file that you want to upload.
Note: Both a certificate file and key file are required for the intermediate CA used in SSL
decryption by the forward proxy.

Password Password to encrypt the files in local storage.

Intermediate CA import configuration

Creating an intermediate CA group

You select an intermediate CA group configuration object in the local certificate group, so you should configure in the
group all the Intermediate CAs that would be needed by the backend servers that belong to a single virtual server.
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Before you begin:

l You must have Read-Write permission for System settings.
l You must have already added the Intermediate CAs to the Intermediate CA certificate store.

To create an Intermediate CA group:

1. Go to System > Manage Certificates.
2. Click the Intermediate CA Group tab.
3. Click Create New to display the configuration editor.
4. Complete the configuration as described in Intermediate CA group configuration on page 239.
5. Save the configuration.

Settings Guidelines

Group Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces. The maximum
length is 35 characters. After you initially save the configuration, you cannot edit the name.

Group Member

Intermediate CA Select the Intermediate CA to add to the group,

Default Check this check box only if you want to make this intermediate CA the default for the group.
Note: Only one intermediate CA can be set as the default in an intermediate CA group. If one
intermediate CA has already been set as the default, you must disable (uncheck) it in order to set
another one as the default. By default, the first intermediate CA in a group becomes the default if
no intermediate CA is set as the default,

Intermediate CA group configuration

Verify

Under the System Certificate sub-menu, the Verify page contains the features that allow you to validate client
certificates and real server certificates from within the FortiADC system:

l Validating certificates on page 239
l Importing CRLs on page 241
l Creating a CA group on page 242
l Importing CAs on page 243

Validating certificates

Certificate verification rules specify the CA certificates to use when validating client certificates, and they specify a
certificate revocation list (CRL) and/or online certificate status protocol (OCSP) server, if any, to use for certificate
revocation checking.

You select a certificate verification configuration object in the profile configuration for a virtual server or in a real-server-
SSL profile. If the client presents an invalid certificate during the authentication phase of a SSL/TLS session initiation,
the FortiADC system will not allow the connection.

For a client certificate to be valid, it must meet the following criteria:
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l Must not be expired or not yet valid
l Must not be revoked by either CRL or, if enabled, OCSP
l Must be signed by a certificate authority (CA) whose certificate you have imported into the FortiADC appliance

Before you begin:

l You must have Read-Write permission for System settings.
l You must have already created a CA, OCSP or CRL configuration.

After you have configured a certificate verification object, you can include it in a virtual server profile or a Real Server
SSL Profile, and it will be used to validate certificates presented to FortiADC.

For the same certificate object you can configure multiple CRL files.

To configure a certificate verification object:

1. Go to System > Verify.
The configuration page displays the Verify tab.

2. Click Create New to display the configuration editor.
3. Complete the configuration as described in Certificate verify configuration on page 240.
4. Click Save when done. The newly certificate verification object appears on the Verify page.
5. Click the Edit icon in the far-right column (or double-click the entry) to open the configuration editor.
6. In the Group Member panel, select the CA, OCSP, or CRL of interest.
7. Click Save when done.

Settings Guidelines

Name Enter a unique name for the certificate verification object that you are creating. Valid characters
are A-Z, a-z, 0-9, _, and -. The maximum length is 35 characters. No space is allowed.

verify-depth Note: CLI only.
The default value is 1, but you may select any value from 0 to 255.

customize-
error-ignore

Note: This option is available from the CLI only.
Enable or disable customize-error-ignore. The option is disabled by default. If it's enabled,
you are required to select the ca-ignore-errors and cert-ignore-errors, as described
below.

ca-ignore-
errors

Note: CLI only. When customize-error-ignore is enabled, the following options become
available for you to choose from:
l UNABLE_TO_GET_ISSUER_CERT
l UNABLE_TO_GET_CRL
l CERT_NOT_YET_VALID
l CERT_HAS_EXPIRED
l CRL_NOT_YET_VALID
l CRL_HAS_EXPIRED

Certificate verify configuration
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Settings Guidelines
l DEPTH_ZERO_SELF_SIGNED_CERT
l SELF_SIGNED_CERT_IN_CHAIN
l UNABLE_TO_GET_ISSUER_CERT_LOCALLY
l UNABLE_TO_VERIFY_LEAF_SIGNATURE
l CERT_CHAIN_TOO_LONG
l INVALID_CA
l INVALID_PURPOSE
l CERT_UNTRUSTED
l CERT_REJECTED

Note: If customize-error-ignore is disabled (by default), the CLI shows the following:
ca-ignore-errors: UNABLE_TO_GET_ISSUER_CERT UNABLE_TO_GET_CRL CERT_
UNTRUSTED

cert-ignore-
errors

Note: CLI only. When customize-error-ignore is enabled, the following options become
available for you to choose from:
l UNABLE_TO_GET_ISSUER_CERT
l UNABLE_TO_GET_CRL
l CERT_NOT_YET_VALID
l CERT_HAS_EXPIRED
l CRL_NOT_YET_VALID
l CRL_HAS_EXPIRED
l DEPTH_ZERO_SELF_SIGNED_CERT
l SELF_SIGNED_CERT_IN_CHAIN
l UNABLE_TO_GET_ISSUER_CERT_LOCALLY
l UNABLE_TO_VERIFY_LEAF_SIGNATURE
l CERT_CHAIN_TOO_LONG
l INVALID_CA
l INVALID_PURPOSE
l CERT_UNTRUSTED
l CERT_REJECTED

Note: If customize-error-ignore is disabled (by default), the CLI shows the following:
cert-ignore-errors: UNABLE_TO_GET_CRL

Group Member

CA Select a CA (Required).

OCSP Select an OCSP (Optional).

CRL Select a CRL (Optional).

Importing CRLs

A certificate revocation list (CRL) is a file that contains a list of revoked certificates with their serial numbers and their
revocation dates. The file also contains the name of the issuer of the CRL, the effective date, and the next update date.
By default, the shortest validity period of a CRL is one hour.

Some potential reasons for certificates to be revoked include:
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l A CA server was hacked and its certificates are no longer trustworthy.
l A single certificate was compromised and is no longer trustworthy.
l A certificates has expired and is not supposed to be used past its lifetime.

You can either upload a CRL file from your local machine or specify the URL of the CRL file

Online Certificate Status Protocol (OCSP) is an alternative to CRL. OCSP is useful
when you do not want to deploy CRL files, for example, or want to avoid the public
exposure of your PKI structure. For more information, see Adding OCSPs.

Before you begin:

l You must have Read-Write permission for System settings.
l You must know the URL of a CRL server or have the CRL files downloaded onto your local machine.

To import a CRL file:

1. Go to System > Verify.
2. Click the CRL tab.
3. Click Import to display the configuration editor.
4. Complete the configuration as described in CRL configuration on page 242.
5. Click Save when done.
6. Repeat Steps 3 through 5 to import as many CRLs as needed.

Settings Guidelines

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces. The maximum
length is 35 characters. After you initially save the configuration, you cannot edit the name.

Import Method

HTTP If selected, FortiADC will download the CRL file from an HTTP server. You must specify the
HTTP URL.

SCEP If selected, FortiADC will download the CRL file from an SCEP server. You must specify the
SCEP URL.

File If selected, you will need to browse for the CRL file on your local machine and upload it into
FortiADC.

LDAP If selected, FortiADC will download the CRL file from the LDAP server (User Authentication >
Remote Server > LDAP Server).

CRLDP If selected, FortiADC will get the address of the CRL file from the extension ("CRL Distribution
Points") stored in the client certificate.

CRL configuration

Creating a CA group

CA groups are only used to verify the signature of the OCSP Responder.

Include in the CA group all of the CAs for the pool of backend servers to be associated with a single virtual server.
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Before you begin:

l You must have Read-Write permission for System settings.
l You must have already added the CAs to the CA certificate store.

To create a CA group:

1. Go to System > Verify.
2. Click the CA Group tab.
3. Click Create New to display the configuration editor.
4. Name the CA group and click Save when done. The new CA group appears on the CA Group page.
5. Click the Edit icon in the far-right column (or double-click the CA group) to bring up the configuration editor.
6. Click Create New.
7. Complete the configuration as described in CA group configuration on page 243.
8. Click Save when done.
9. Repeat Steps 6 through 8 to add as many CAs to the group as needed.

Settings Guidelines

Group Name Specify a unique name for the CA group that you are creating. Valid characters are A-Z, a-z, 0-9,
_, and -. The maximum length is 35 characters. No space is allowed.

Group Member

CA Click the down arrow and select the desired CA from the list menu to add to the group.

CA group configuration

Importing CAs

The certificate authority (CA) store is used to authenticate the certificates of other devices. When the FortiADC system is
presented with a certificate, it examines the CA’s signature, comparing it with the copy of the CA’s certificate already
imported into the CA store. If the public key matches the private key, the client's or device’s certificate is considered
legitimate.

In web browsers, the CA store includes trusted root CAs that can be used to establish trust with servers that have
certificates signed by the issuing CAs. In an SSL forward proxy deployment, FortiADC acts as a proxy for the client, so
you might want to import client browser CAs, create a CA group, and create a certficate verification policy to verify server
certificates against this group. You can examine the CA store in common web browsers to come up with a good list of
CAs to download and then import.

The following list has links for some common web browsers:

l Apple iOS: https://support.apple.com/en-us/HT204132
l Google Chrome and Mozilla Firefox: https://wiki.mozilla.org/CA:IncludedCAs
l Microsoft Internet Explorer: https://technet.microsoft.com/en-us/library/dn265983.aspx

You must do one of the following:

l Import the certificates of the signing CA and all intermediate CAs to FortiADC’s store of CA certificates.
l In all personal certificates, include the full signing chain up to a CA that FortiADC knows in order to prove that the
clients’ certificates should be trusted.
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l If the signing CA is not known, that CA’s own certificate must likewise be signed by one or more other intermediary
CAs, until both the FortiADC appliance and the client or device can demonstrate a signing chain that ultimately
leads to a mutually trusted (shared “root”) CA that they have in common. Like a direct signature by a known CA, this
proves that the certificate can be trusted.

Before you begin:

l You must have Read-Write permission for System settings.
l You must know the URL of an SCEP server or have downloaded the certificate and key files and be able to browse
to them so that you can upload them.

To import a CA:

1. Go to System > Verify.
2. Click the CA tab.
3. Click Import to display the configuration editor.
4. Complete the configuration as described in CA import configuration on page 244.
5. Click Save when done.
6. Repeat Steps 3 through 5 to import as many CAs as needed.

Settings Guidelines

Certificate Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. The maximum length is 35
characters. No space is allowed.

Import Method l SCEP—Use Simple Certificate Enrollment Protocol. SCEP allows routers and other
intermediary network devices to obtain certificates.

l File—Upload a file.

SCEP

SCEP URL Enter the URL of the SCEP server.

CA Identifier Enter the identifier for a specific CA on the SCEP server.

File

Local PC Browse for the certificate file on the local machine and upload it to FortiADC.

CA import configuration

OCSP

Under the System Certificate sub-menu, theOCSP page contains the features that support OCSP (Online Certificate
Status Protocol) on FortiADC:

l OCSP stapling on page 245
l Adding OCSPs on page 246
l Importing OCSP signing certificates on page 250
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OCSP stapling

OCSP stapling is an improved approach to OCSP for verifying the revocation status of certificates. Rather than having
the client contact the OCSP server to validate the certificate status each time it makes a request, FortiADC can be
configured to periodically query the OCSP server and cache a time-stamped OCSP response for a set period. The
cached response is then included, or "stapled," with the TLS/SSL handshake so that the client can validate the certificate
status when it makes a request.

This method of verifying the revocation status of certificates shifts the resource cost in providing OCSP responses from
the client to the presenter of a certificate. In addition, because fewer overall queries to the OCSP responder will be made
when OCSP stapling is configured, the total resource cost in verifying the revocation status of certificates is also
reduced. FortiADC allows you to upload an OCSP response file, configure an OCSP to let FortiADC download the
OCSP response from the OCSP server, or both.

Before you begin:

l You must have Read-Write permission for System settings.
l Add a local certificate. See Generating a local certificate.
l Add a CA certificate. See Importing intermediate CAs.
l Add an OCSP configuration or have an OCSP response file. See Adding OCSPs.

To configure OCSP stapling:

1. Go to System > OCSP.
2. Click theOCSP Stapling tab.
3. Click + Import to display the configuration editor.
4. Complete the configuration as described in OCSP stapling configuration on page 245.
5. Click Save.

Settings Guidelines

Name Enter the mkey.

Local Certificate Select the local certificate to add to the OCSP stapling configuration.

Issuer Certificate Select the CA certificate to add to the OCSP stapling configuration.

OCSP Select the OCSP configuration to add to the OCSP stapling configuration. If an
OCSP configuration is not selected, import an OCSP Response from a file (see
below). You can both select an OCSP configuration and upload an
OCSP response file; in this case, FortiADC will first use the OCSP response file
and then automatically update using the OCSP configuration.

Response Update Ahead Time Available only when you select an OCSP configuration. This option is meaningful
only when the next update field in the OCSP response is present in a selected
OCSP stapling response.
Enter the time before the next scheduled update at which FortiADC will start the
download for the next update. The default value is 1 hour.

OCSP stapling configuration
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Settings Guidelines

Response Update Interval Available only when you select an OCSP configuration. Enter the next update
interval if the downloaded OCSP response is the same or FortiADC fails to
download the new OCSP response. The default value is 5 minutes.
If the next update field in the OCSP response is not present, FortiADC will attempt
to download the next update periodically according to this parameter.

OCSP Response Enable to import an OCSP response from a file. PEM and DER formats are
supported.

To configure OCSP stapling using the CLI:

config system certificate OCSP_stapling
edit <ocsp_stapling_name>

set OCSP
set OCSP-response
set issuer-certificate
set local-certificate
set response-update-ahead-time
set response-update-interval

Note: When configuring OCSP stapling in the CLI, only PEM format file types are
supported.

Adding OCSPs

FortiADC supports the validation of client digital certificates using Online Certificate Status Protocol (OCSP). In such a
configuration, FortiADC contacts the OCSP Responder (i.e., the certificate management system), which maintains the
current revocation status information of client certificates or backend server certificates, to determine the current status
of digital certificate presented to it. It can then decide whether to allow or block the TLS/SSL connections, based on the
status of the client certificates provided by the OCSP Responder.

OCSP enables you to validate certificate status by real-time online query, rather than by importing certificate revocation
list (CRL) files. Since distributing and installing CRL files can be a considerable burden in large organizations, and
because delay between the release and install of the CRL represents a vulnerability window, this can often be
preferable.

During the process of TLS/SSL handshake, FortiADC will send an OCSP status request for the client certificate or
backend server certificate to the OCSP Responder. The OCSP Responder then verifies whether the status request
contains the information required to identify the certificate and returns a signed response with the status of the inquired
certificate, which could be one of the following:

l Good = The certificate has not yet been revoked.
l Revoked = The certificate has been revoked.
l Unknown = The OCSP Responder has no information about the requested certificate, and therefore is able to
determine its status.

Note: FortiADC only accepts client certificates in"Good" status as determined by the OCSP Responder as valid.

To use OCSP queries, you must first install the certificates of trusted OCSP servers.
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Before you begin:

l You must have Read-Write permission for System settings.
l You must know the URL of an OCSP server.
l You must have downloaded the certificate and key files, and have access to them for upload.
l You must have already imported the OCSP signing certificates into FortiADC. See Importing OCSP signing
certificates on page 250 and Creating a CA group on page 242.

To add an OCSP verify object:

1. Go to System > OCSP.
2. Click theOCSP tab.
3. Click Create New to display the OCSP configuration editor.
4. Complete the configuration as described in OCSP certificate configuration on page 247.
5. Click Save when done.
6. Repeat Steps 3 through 5 to add as many OCSP verify objects as needed.

Settings Guidelines

Name Enter a unique name for the client certificate validation object that uses OCSP.
Valid characters are A-Z, a-z, 0-9, _, and -. The maximum length is 35
characters. No space is allowed.

OCSP URL Specify the URL of the OCSP Responder.

Verify Others Upon receiving the OCSP response from the OCSP server, FortiADC first
performs OCSP basic verify to validate the OCSP responder's signature.
Enable (default)—When Verify Others is enabled, you must select a OCSP
Signing Certificate (see OCSP Signing Certificates below). The OCSP basic verify
succeeds when the selected OCSP signing certificate matches the OCSP
response signature. Otherwise, the OCSP basic verify will fail and the TLS/SSL
connection will be terminated.
Disable—When Verify Others is disabled, you must select a CA chain. The OCSP
basic verify will be carried out in the following sequence:
1. The OCSP response signing certificate must be one of the certificates in the

CA group or a certificate issued by one of the certificates in the CA group.
Also, the certificates must form a chain from the OCSP signing certificate all
the way to a self-signed root CA. Otherwise, the OCSP basic verify will fail.

2. If Step 1 (above) is successful, the validation will proceed like this: If the
Issuer Criteria Check field is selected (enabled by default), then the
OCSP signing certificate can be either the issuing CA of the certificate whose
status FortiADCmust validate, or a dedicated OCSP signing certificate
issued by this issuing CA. The validation succeeds if this criterion is met.
Otherwise, the validation process will move onto Step 3 (below).

3. If the OCSP signing certificate is issued by one of the certificates in the CA
group, but is not a dedicated OCSP signing certificate, then the validation will
proceed like this: If the root CA of this OCSP signing certificate is a trusted
self-signed root CA and the "Accept Trusted Root CA" field is selected
(enabled by default), then the validation will succeed. Otherwise, the

OCSP certificate configuration
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Settings Guidelines

validation will fail.

OCSP Signing Certificates Select the client certificate of which you'd like to verify the signature of the OCSP
Responder that signs it. Note: This option is applicable only when Verify Others is
enabled. You MUST select a OCSP signing certificate which must have been
imported into FortiADC in advance. See .

CA Chain Click the down arrow and select a CA group from the list menu. Note: This
becomes available only when Verify Others is disabled. In that case, you must
select a CA chain (i.e., CA group). It's highly recommended that you have CA
groups configured in advance to use this option. See Creating a CA group.

Issuer Criteria Check Enable/Disable issuer-criteria check. Note: This option comes in hand in hand with
CA Chain, and is only available when Verify Others is disabled (see Verify Others
above). It is enabled by default, but you can uncheck it if you do not want to
validate the certificate issuer's identity.

Accept Trusted Root CA Enable/Disable accept trusted root CA. Note: This option becomes available only
when Criteria Check is enabled (see Criteria Check above). It is enabled by
default, in which case FortiADC will accept trusted root CA in the validation
process. Uncheck it if you do not want to use this feature.

Timeout Specify the amount of time in milliseconds (from 1 to 2147483647) the OCSP
responder must wait before it times out. The default is 200.

Max age Specify the maximum amount of time in seconds (from -1 to 214748364) the
OCSP responder must check. Note: Setting it to -1 disables max-age check.

Host Header Specify the host name (Optional).

Reject OCSP Response with
Missing Nextupdate

By default, this option is disabled (unselected). In that case, FortiADC accepts all
OCSP responses, including those without the nextupdate field. This may have
some potential security repercussions, especially if the max-age filed in the OCSP
response is not set.
To minimize the security risk, you can enable this option so that FortiADC will
automatically reject OCSP responses that do not have the nextupdate field.
Note: As a good practice, we recommend that, if this option is enabled, you should
set an acceptable max-age value (see above) as well so that FortiADC can also
check the max-age of the OCSP response. It must be noted that max-age check is
an extra, user-enforeced check, and that it has nothing to do with the OCSP
server's behavior. In other words, once a max-age is set, then FortiADC will
enforce the max-age check no matter whether or not the SCSP server sets the
nextupdate field in OCSP response.

Caching Enable or disable OCSP caching.
Note: Enabled by default. For a detailed discussion about the function of
OCSP caching, see OCSP caching.

Caching Thisupd Extra Maxage Specify the number of seconds before the this-update-time. The cache will be
discarded if the current timestamp is behind the this-update-time in OCSP
response.
Note: The default is -1, which means that the existing cache will always be used.
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Settings Guidelines

The smaller value will be used if the max-age and the caching-thisupd-extra-
maxage both exist. If one of them is -1, the other one will be used.

Caching Nextupd Ahead Time Specify the number of seconds before the next-update-time.The cache will be
discarded when the current timestamp is ahead of the next-update-time in OCSP
response.
Note: The default is -1, which means that the existing cache will always be used.
Setting the value to 0 means that the cache will expire after the next-update-time,
and setting it to 2147483647 makes the cache always expired so that FortiADC
always needs to get the latest result from an OCSP server.
Warning: There is a default leeway of 60 seconds. So when you set "Caching
Nextupd Ahead Time" to x, it means the cache will expire at "x" before "next-
update-time", plus 60 seconds.

Nonce Check Enable or disable nonce check.
Note: This option is enabled by default.

Tunneling Click the button to enable or disable tunneling.
If enabled, you must configure all the settings for the tunneling function. See
below.
Note: Tunneling, or port forwarding, is a way of transmitting private (usually
corporate) data through a public network in a disguised way— the routing nodes
in the public network are unaware that the transmission is part of a private
network.

Tunneling Address Enter the Tunneling Address that was provided to you.

Tunneling Port Enter the Tunneling Port number that was provided to you.

Tunneling Password Specify your password for the tunneling configuration.

Tunneling Username Specify your user name for the tunneling configuration.

Save Click the Save button to save your OCSP service configuration.

OCSP caching

OCSP caching is a technique used to speed up OCSP checking. When a client accesses FortiADC or FortiADC
accesses a real server for the first time, it (FortiADC) queries the certificate’s status using OCSP and caches the
response. In subsequent accesses, the same client or real server will get verified directly from cache, if available.

OCSP caching essentially caches the result of an OCSP verification, not the whole OCSP response. It keeps the
certificate status in the buffer for a specified period of time. OCSP verification results can be either obtained by querying
an OCSP server or from an OCSP stapling response received from backend real servers.

It must be noted that configuration of OCSP caching is done on a per-VDOM basis and in rlimit.

Each OCSP configuration has a flag to let you decide whether to enable OCSP caching or not. Each haproxy process
has one and only one OCSP cache which is shared among all OCSP servers.

If OCSP caching is enabled, FortiADC will search its cache first. If no OCSP response result is found in the cache or the
cached result has expired (expired OCSP result will be removed from cache), it will query the OCSP server for an
updated one FortiADC uses issuer and serial number hash as key, and also store some extra information (e.g., subject
name hash) as extra key. It also implements LRU (least recently used) caching policy. It forms two links: one is to search
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using key (as an eb-tree) and the other is to implement the LRU caching scheme. You can configure how much memory
to use and the maximum period of time to cache (which is useful if the next-update is missing) and cache the nextupd
ahead time.

Implementation of the LRU caching scheme means that frequently used cache would not expire because it will get
updated itself upon expiration (replacing itself with a new one) and the least recently used cache may be removed even
though it is far from expiration.

When system configuration has changed, FortiADC either restarts the process of haproxy, or performs dynamic reload.
In case of a restart, the cache is cleared. In case of dynamic reload, the cache is kept. Modification of cache memory size
will restart the haproxy process. Changing other OCSP parameters will trigger dynamic reload.

You can use the existing OCSPmax-age to control the lifespan of a cached item, or the "cache-thisupd-extra-maxage"
and the "cache-nextupd-ahead-time" to manipulate the caching behavior.

Configure OCSP caching from the Console

config system certificate ocsp
edit “ocsp”

set caching-flag enable/disable
set caching-thisupd-extra-maxage 2
set caching-nextupd-ahead-time 10

end

config system vdom
edit “root”

set OCSP-caching-maximum-memory 4M
end

Importing OCSP signing certificates

OCSP signing certificates are certificates with no private keys. For dynamic certification revocation, you must verify them
through an OCSP server. This option allows you to import remote (OCSP) certificates into FortiADC and use them to
verify the OCSP response signature.

Before you begin:

l You must have Read-Write permission for System settings.
l You must have the remote certificates downloaded onto you local machine so that you can upload it to FortiADC.

To import an OCSP-signing certificate:

1. Go to System > OCSP.
2. Click theOCSP Signing Certificates tab.
3. Click Import to display the configuration editor.
4. Complete the configuration as described in Importing an OCSP signing certificate on page 251.
5. Click Save when done.
6. Repeat Steps 3 through 5 to import as many remote certificates as needed.
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Settings Guidelines

Name Enter a unique name for the remote certificate you want to import. Valid characters are A-Z, a-z,
0-9, _, and -. The maximum length is 35 characters. No space is allowed.

OCSP Signing
Certificates

Browse for and upload the remote certificate file of interest.

Importing an OCSP signing certificate

Once an OCSP signing certificate has been uploaded into FortiADC, the name of the certificate file shows up under the
Remote tab. You can view or remove the certificate from this page using the corresponding icons in the far-right column
of the page.
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Network

Network

The Networkmenu contain features and configurations that allow you to manage your network on FortiADC.

This section is organized into the following sub-menu topics:

l Interface on page 252
l Routing on page 270
l NAT on page 290
l QoS on page 295
l Packet Capture on page 298

Interface

The Network > Interface sub-menu allows you to perform the following tasks relating to the network interface:

l Configuring network interfaces on page 255
l Configuring the management interface on page 261
l Linking VDOMs for inter-VDOM routing on page 265
l Configuring virtual overlay networks on page 263
l Transparent mode on page 270

Interface Overview

This section covers the following topics:

l Physical interface
l VLAN interface
l Aggregate interface
l Loopback interface
l Softswitch

Physical interfaces

Each physical network port (or vNIC on FortiADC-VM) has a network interface that directly corresponds to it—that is, a
“physical network interface.”

Physical ports have three uses:

l Management—The network interface named port1 is typically used as the management interface.
l HA—If you plan to deploy HA, you must reserve a physical port for HA heartbeat and synchronization traffic. Do not
configure the network interface that will be used for HA; instead, leave it unconfigured or “reserved” for HA.

l Traffic—The remaining physical ports can be used for your target traffic—these are your “traffic interfaces.”

FortiADC Handbook 252
Fortinet Technologies Inc.



Network

Traffic interfaces can be associated with logical interfaces. The system supports two types of logical interfaces: VLAN
and aggregate.  Physical and logical interfaces on page 253 illustrates how physical ports are associated with physical
and logic interfaces.

 Physical and logical interfaces

With VLANs, multiple VLAN logical interfaces are associated with a single physical port. With link aggregation, it is the
reverse: multiple physical interfaces are associated with a single aggregate logical interface.

Physical network interfaces on page 253 lists factory default IP addresses for physical network interfaces.

Network Interface* IPv4 Address/Netmask IPv6 Address/Netmask

port1 192.168.1.99/24 ::/0

port2 0.0.0.0/0 ::/0

port3 0.0.0.0/0 ::/0

port4 0.0.0.0/0 ::/0

...

Connectivity layers that will be considered when distributing frames among the aggreg-
ated physical ports:

lLayer 2
lLayer 2-3
lLayer 3-4

Physical network interfaces

VLAN interface

You can use IEEE 802.1q VLAN to reduce the size of a broadcast domain, thereby reducing the amount of broadcast
traffic received by network hosts and improving network performance.

Unlike physical LANs, VLANs do not require you to install separate hardware switches and routers to achieve this effect.
Instead, VLAN-compliant switches restrict broadcast traffic based upon whether its VLAN ID matches that of the
destination network. As such, VLAN trunks can be used to join physically distant broadcast domains as if they were
close.
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Network

The VLAN ID is part of the tag that is inserted into each Ethernet frame in order to identify traffic for a specific VLAN.
FortiADC appliances handle VLAN header addition automatically, so you do not need to adjust the maximum
transmission unit (MTU). Depending on whether the device receiving a packet operates at Layer 2 or Layer 3 of the
network, a VLAN tag might be added, removed, or rewritten before forwarding to other nodes on the network. For
example, a Layer 2 switch typically adds or removes a tag when forwarding traffic among members of the VLAN, but
does not route tagged traffic to a different VLAN ID. In contrast, a FortiADC content-based routing policy might forward
traffic between different VLAN IDs (also known as inter-VLAN routing).

Note: VLANs are not designed to be a security measure, and should not be used where untrusted devices and/or
individuals outside of your organization have access to the equipment. VLAN tags are not authenticated, and can be
ignored or modified by attackers. VLAN tags rely on the voluntary compliance of the receiving host or switch.

Aggregate interface

Link aggregation (also called NIC teaming/bonding or link bundling) forms a network interface that queues and transmits
over multiple wires (also called a port channel), instead of only a single wire (as FortiADC would normally do with a single
network interface per physical port). This multiplies the bandwidth that is available to the network interface, and therefore
is useful if FortiADC is deployed inline with your network backbone.

Link aggregation on FortiADC complies with IEEE 802.1ax and IEEE 802.3ad and distributes Ethernet frames using a
modified round-robin behavior. If a port in the aggregation fails, traffic is redistributed automatically to the remaining
ports with the only noticeable effect being a reduced bandwidth. When broadcast or multicast traffic is received on a port
in the aggregation, reverse traffic will return on the same port.

When link aggregation uses a round-robin that considers only Layer 2, Ethernet frames that belong to an HTTP request
can sometimes arrive out of order. Because network protocols at higher layers often do not gracefully handle this
(especially TCP, which may decrease network performance by requesting retransmission when the expected segment
does not arrive), FortiADC’s frame distribution algorithm is configurable. For example, if you notice that performance with
link aggregation is not as high as you expect, you could try configuring FortiADC to queue related frames consistently to
the same port by considering the IP session (Layer 3) and TCP connection (Layer 4), not simply the MAC address (Layer
2).

You must also configure the router, switch, or other link aggregation control protocol (LACP)-compatible device to which
FortiADC is connected with the same speed/duplex settings, and it must have ports that can be aggregated. In a
deployment like this, the two devices use the cables between the ports to form a trunk, not an accidental Layer 2 (link)
network loop. FortiADC uses LACP to detect the following conditions:

l Suitable links between itself and the other device, and form a single logical link.
l Individual port failure so that the aggregate interface can redistribute queuing to avoid a failed port.

Loopback interface

A loopback interface is a virtual interface. Like any other interface, a loopback interface can be assigned an address of
its own. Unlike any other interface, a loopback interface, once configured, is always up and available. Because a
loopback interface never goes down, it is often used for troubleshooting, i.e., the FortiADC appliance, in our case.

In addition, loopback interfaces are also used by BGP and OSPF protocols to determine properties specific to the
protocols for a device or network.
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Network

Softswitch

A softswitch, or software switch, is a virtual switch that is implemented at the software or firmware level rather than the
hardware level. It can be used to simplify communication between devices connected to different FortiADC interfaces.
For example, using a softswitch, you can place the FortiADC interface connected to an internal network on the same
subnet as your wireless interfaces. This allows devices on the internal network to communicate with devices on the
wireless network without any additional configuration.

A softswitch can also be useful if you require more hardware ports for the switch on a FortiADC unit. For example, if your
FortiADC has a 4-port switch, WAN1, WAN2, and DMZ interfaces, and you need one more port, you can create a
softswitch that includes the 4-port switch and the DMZ interface all on the same subnet. Such applications also apply to
wireless interfaces, virtual wireless interfaces, and physical interfaces.

Similar to a hardware switch, a softswitch functions like a single interface. It has one IP address, and all interfaces in the
softswitch are on the same subnet. Traffic between devices connected to each interface is not regulated by security
policies, and traffic passing in and out of the switch is affected by the same policy. For more information, see the
FortiADC Transparent Mode Configuration Guide.

Configuring network interfaces

You can configure the network interface by editing the configuration, however, you cannot create or delete a physical
interface configuration.

Before you begin:

l You must have Read-Write permission for System settings.

To configure a network interface:

1. Go to Network > Interface.
2. Double-click the row for a physical interface to edit its configuration or click Create New if you want to configure an

aggregate or VLAN interface.
3. Complete the configuration as described in Network interface configuration on page 255.
4. Save the configuration.

Settings Guidelines

Interface

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces. After
you initially save the configuration, you cannot edit the name.

Status The Status column is not the detected physical link status; it is the administrative
status (Up/Down) that indicates whether you permit the network interface to
receive and/or transmit packets.

Allow Access Allow inbound service traffic. Select from the following options:
l HTTP—Enables connections to the web UI. We recommend this option only
for network interfaces connected to a trusted private network, or directly to
your management computer.

Network interface configuration
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Settings Guidelines
l HTTPS—Enables secure connections to the web UI. We recommend this
option instead of HTTP.

l Ping—Enables ping and traceroute to be received on this network interface.
When it receives an ECHO_REQUEST (“ping”), FortiADC will reply with
ICMP type 0 (ECHO_RESPONSE or “pong”).

l SNMP—Enables SNMP queries to this network interface.
l SSH—Enables SSH connections to the CLI. We recommend this option
instead of Telnet.

l Telnet—Enables Telnet connections to the CLI. We recommend this option
only for network interfaces connected to a trusted private network, or directly
to your management computer.

Dedicated HA management IP Note: Starting from the v. 4.8.1 release, this option is replaced by "Management
Interface". Therefore, it is removed from the GUI though it still remains on the
Console. For more information, see Configuring the management interface on
page 261.

Virtual Domain If applicable, select the virtual domain to which the configuration applies.

Type Select from the following:
l VLAN
l Aggregate
l Loopback
l Softswitch

Note: If you are editing the configuration for a physical interface, you cannot set
the type.
If you are configuring a logical interface, you can select from the following options:
l VLAN—A logical interface you create to VLAN subinterfaces on a single
physical interface.

l Aggregate—A logical interface you create to support the aggregation of
multiple physical interfaces.

Mode l Static—Specify a static IP address. The IP address must be on the same
subnet as the network to which the interface connects. Two network
interfaces cannot have IP addresses on the same subnet (i.e. overlapping
subnets).

l PPPoE—Use PPPoE to retrieve a configuration for the IP address, gateway,
and DNS server. For example, if this interface uses a DSL connection to the
Internet, your ISP may require this option.

l DHCP—Use DHCP to automatically assign IP addresses and other
communication parameters, including subnet masks, default gateway
addresses, and DNS servers to the host.

Traffic Group Select either of the following:
l Default
l Create New

Available only if Static is selected forMode.
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Settings Guidelines

Floating Enable/Disable floating IP.
Available only if Static is selected forMode.

Floating IP Enter the floating IP.
Available only if Floating is enabled.
Note:
Ensure the Floating IP is different from the Interface IP, otherwise network issues
will occur due to the interface/port conflict.

Type Specifics

VLAN

VLAN ID VLAN ID of packets that belong to this VLAN.

If one physical network port (that is, a VLAN trunk) will handle multiple VLANs,
create multiple VLAN subinterfaces on that port, one for each VLAN ID that will be
received.

If multiple different physical network ports will handle the same VLANs, on each of
the ports, create VLAN subinterfaces that have the same VLAN IDs.

The valid range is between 1 and 4094. The value you specify must match the
VLAN ID added by the IEEE 802.1q-compliant router or switch connected to the
VLAN subinterface.

Interface Physical interface associated with the VLAN; for example, port2.

Aggregate

Member Select the physical interfaces that are included in the aggregation.

Aggregate Mode Link aggregation type:
l 802.3ad
l Balance-alb
l Balance-rr
l Balance-tlb
l Balance-xor
l Broadcast

Aggregate Algorithm Connectivity layers that will be considered when distributing frames among the
aggregated physical ports:
l Layer 2
l Layer 2-3
l Layer 3-4

Softswitch

Member Select the interfaces that are included in the softswitch.

Mode Specifics

Static
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Settings Guidelines

IPv4/Netmask Specify the IP address and CIDR-formatted subnet mask, separated by a forward
slash ( / ), such as 192.0.2.5/24. Dotted quad formatted subnet masks are not
accepted.

IPv6/Netmask Specify the IP address and CIDR-formatted subnet mask, separated by a forward
slash ( / ), such as 2001:0db8:85a3::8a2e:0370:7334/64. Dotted quad formatted
subnet masks are not accepted.

WCCP Enable/disable WCCP to redirect traffic flows in real-time.

Secondary IP Address Secondary IP addresses can be used when you deploy the system so that it
belongs to multiple logical subnets. If you assign multiple IP addresses to an
interface, you must assign them static addresses.

To add secondary IP addresses, enable the feature and save the configuration.
After you have saved it the first time, you can edit it to add secondary IP addresses
and enable inbound traffic to that address.

Trust IP Address Enable/disable the Trust IPs Access Control (TIAC) feature to restrict access to
management interfaces according to the Trust IP Address List. If the source IP is
not on the Trust IP Address List, the device will refuse the client directly.

To add IP addresses to the Trust IP Address List, enable the feature and save the
configuration. After you have saved it the first time, you can edit it to add IPs to the
list.

PPPoE

WCCP Enable/disable WCCP to redirect traffic flows in real-time.

Trust IP Address Enable/disable the Trust IPs Access Control (TIAC) feature to restrict access to
management interfaces according to the Trust IP Address List. If the source IP is
not on the Trust IP Address List, the device will refuse the client directly.

To add IP addresses to the Trust IP Address List, enable the feature and save the
configuration. After you have saved it the first time, you can edit it to add IPs to the
list.

Username PPPoE account user name.

Password PPPoE account password.

Discovery Retry Timeout Seconds the system waits before it retries to discover the PPPoE server. The
default is 5 seconds. The valid range is 1-255.

DNS Server Override Use the DNS addresses retrieved from the PPPoE server instead of the one
configured in the FortiADC system settings.

Retrieve Default Gateway Use the default gateway retrieved from the PPPoE server instead of the one
configured in the FortiADC system settings.

DHCP

WCCP Enable/disable WCCP to redirect traffic flows in real-time.
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Settings Guidelines

Trust IP Address Enable/disable the Trust IPs Access Control (TIAC) feature to restrict access to
management interfaces according to the Trust IP Address List. If the source IP is
not on the Trust IP Address List, the device will refuse the client directly.

To add IP addresses to the Trust IP Address List, enable the feature and save the
configuration. After you have saved it the first time, you can edit it to add IPs to the
list.

Retrieve Gateway Use the default gateway retrieved from the DHCP server instead of the one
configured in the FortiADC system settings.

Secondary IP List

IP Address Secondary IP addresses can be used when you deploy the system so that it
belongs to multiple logical subnets. If you assign multiple IP addresses to an
interface, you must assign them static addresses.

To add secondary IP addresses, enable the feature and save the configuration.
After you have saved it the first time, you can edit it to add secondary IP addresses
and enable inbound traffic to that address. For each address, specify an IP
address using the CIDR-formatted subnet mask, separated by a forward slash ( /
), such as 192.0.2.5/24.

Allow Access Select the services that are allowed to send inbound traffic.

Trust IP Address List

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces. After
you initially save the configuration, you cannot edit the name.

Type Select the IP address type:
l IPv4/Netmask
l IPv4 Address Range
l IPv6/Netmask
l IPv6 Address Range

IPv4/Netmask, IPv6/Netmask Specify the IP address that can access the interface.

Address Range Specify a range of IP addresses that can access the interface.

HA Node IP List

IP Address You use the HA node IP list configuration in an HA active-active deployment. On
each HA cluster node, add an HA node IP list that includes an entry for each
cluster node. When the appliance is in standalone mode, it uses the physical port
IP address; when it is in HA mode, it uses the HA node IP list address.

For each address, specify an IP address using the CIDR-formatted subnet mask,
separated by a forward slash ( / ), such as 192.0.2.5/24.

Node ID ID of the corresponding node.

Allow Access Select the services that are allowed to send inbound traffic.
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In an HA active-active deployment, if an interface uses secondary IP addresses, you
must use the CLI to enable the HA node secondary IP address list, and then
configure the list:
FADC # config system interface
FADC (interface) # edit port3
FADC (port3) # set ha-node-secondary-ip enable
FADC (port3) # config ha-node-secondary-ip-list
FADC (ha-node-second~r) # edit 1
Add new entry '1' for node 2221
FADC (1) # set ip 192.168.1.100
FADC (1) # set allowaccess https http ping snmp ssh
FADC (1) # end
FADC (port3) # end

To configure a physical interface in the CLI:

config system interface
edit <port_name>

set ip <ip&netmask>
set allowaccess {http https ping snmp ssh telnet}

end

To configure an aggregate interface in the CLI:

config system interface
edit <specified_name>

set type agg
set aggregate-mode {802.3ad | balance-alb | balance-rr | balance-tlb | balance-xor |

broadcast}
set aggregate-algorithm {layer2 | layer2_3 | layer3_4}
set member <port_name> <port_name>
set ip <ip&netmask>

end

To configure a VLAN interface in the CLI:

config system interface
edit <specified_name>

set type vlan
set vlanid <number>
set interface <port_name>
set ip <ip&netmask>

end

To enable/disable the Trust IP Address status in the CLI:

config system interface
edit <port_name>

set trust-ip <enable | disable>
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To configure the Trust IP Address List in the CLI:

config trust-ip-list
edit <name>

set type {ip-netmask | ip-range}
set ip-network <ip&netmask>
set start-ip <ip>
set end-ip <ip>

next
edit <name>

set type {ip6-netmask | ip6-range}
set ip6-network <ip6&netmask>
set start-ip6 <ip6>
set end-ip6 <ip6>

next
end

Configuring the management interface

The management interface should be used exclusively by the FortiADC administrator to manage the devices, physical or
virtual (such as configuring or debugging it). It should be an interface through which FortiADC's management traffic
(such as license authenticating) can traverse at any time without affecting normal network traffic. It is especially useful
for secondary devices in HA active-passive mode. The management interface has the highest access permissions, and
the FortiADC administrator should make sure that it is used for management traffic only, and avoid using it for normal
traffic.

You can configure the management interface from either the GUI or the CLI. This section discusses how to configure the
management interface from the GUI. For instructions on how to configure management interface using the CLI, see the
section Configuring the management interface on page 261 at the end of this section.

l As the management interface is a global configuration, it can only be configured
from the "global" system interface and used by the "global" administrator.
Therefore, the option is NOT available on any VDOM.

l This "management interface" is a virtual interface, which is different from the
default, factory-set, "physical" management interface used to set up the
appliance for the first time, as discussed in Step 2: Configure the management
interface on page 27 of the Getting Started on page 26 section of this
Handbook.

To configure the management interface:

1. From FortiADC's global interface, go to Networking > Interface to open the interface configuration page.
2. In the Management Interface section, click the edit button, the pencil, in the top right corner to enable the

management interface. The fields for management interface configuration appear on the page.
3. Make the desired selections and entries as described in Management interface configuration on page 262.
4. Click Save when done.
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Option Guidelines

Management Status Enable this option.

Management Interface Select an interface (port) from the list menu.
Note: The management interface handles all incoming and outgoing management
traffic. Note: It must be promiscuous mode to work. Promiscuous mode is required
because dedicated management interface is a virtual interface and does not share the
physical port mac address.

Management IP Enter the IP address of the management interface.
Note: Once enabled, the management network IP becomes active in all each modes
(i.e., standalone, active-passive, active-active, and VRRP). Therefore, the management
interface IP address must be unique and must NOT be used in regular functions, such
as the virtual server IP addresses, source NAT pool IP addresses, source NAT pool
trans-to IP addresses, 1-to-1 NAT external/mapped IP addresses, and all the other IP
addresses configured on the interface. Otherwise. it will conflict with the HA functions.

Management IP Allow
Access

Select the type or types of management traffic that are allows to access the
Management interface.

Management Trust IP Enable/disable the Trust IPs Access Control (TIAC) feature to restrict access to the
management interface according to the Trust IP Address List. If the source IP is not on
the Management Trust IP Address List, the device will refuse the client directly.
To add IP addresses to the Management Trust IP Address List, enable the feature and
save the configuration. After you have saved it the first time, you can edit it to add IPs to
the list.
Note: For HA configurations, the Management Trust IP Address list will not be
synchronized to peer nodes.

Management Trust IP Address List

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces. After you
initially save the configuration, you cannot edit the name.

Type Select the IP address type:
l IPv4/Netmask
l IPv4 Address Range

IPv4/Netmask Specify the IP address that can access the interface.

Address Range Specify a range of IP addresses that can access the interface.

Management interface configuration

"Dedicated HA Management IP" vs. "Management Interface"

In pre-FortiADC 4.8.1 releases, the GUI had an option in interface configuration (Networking > Interface > Add) which
allows you to set an interface as the "Dedicated HA Management IP", which functions exactly the same as the
"Management Interface" in 4.8.1. With the 4.8.1 release, that option is removed from the GUI (even though it is still
available in the Console) is replaced by the "Management Interface". If you have a dedicated HA management
IP configured on a pre-4.8.1 version of FortiADC, we highly recommend that you delete it, and then configure a
management interface instead, after you've upgraded to 4.8.1. This will help streamline your interface configuration and
make systemmanagement easier.
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All this can be done through FortiADC's Console only. The following instructions show how to delete your old "Dedicated
HA Management IP" and configure the "Management Interface" using the Console in FortiADC 4.8.1:

Step 1: Remove the "Dedicate HA Management IP"

Execute the following commands:

config system interface
edit "port1"
set dedicate-to-mgmt disable
unset ip
next
end

Step 2: Configure the "Management Interface":

Execute the following commands:

config system ha
set mgmt-status enable
set mgmt-interface port1
set mgmt-ip 10.106.129.120/24
set mgmt-ip-allowaccess https ping ssh snmp http telnet
end

Configuring virtual overlay networks

A virtual overlay network uses tunneling protocols to extend isolated network segments between servers for multi-tenant
data center networks. Overlay networking can be implemented using various networking protocols and standards.
FortiADC supports the Virtual Extensive LAN (VXLAN) and Network Virtualization using Generic Routing Encapsulation
(NVGRE) protocols.

VXLAN and NVGRE are officially documented in RFC 7348 and RFC 7637, respectively.

To configure a virtual overlay network:

1. From a virtual domain, go to Network > Interface.
2. Click theOverlay Tunnel tab.
3. Click Create New to display the configuration editor.
4. Configure the following Overlay Tunnel settings:

Setting Guideline

Name Specify a unique name for the overlay tunnel.
Specify a unique name for the overlay tunnel. Valid characters are A-Z, a-z, 0-
9, _, and -. No spaces.
After you initially save the configuration, you cannot edit the name.

Mode Select a virtual overlay networking protocol:
l VXLAN
l NVGRE

VXLAN is the default option.
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Setting Guideline

VXLAN Type The VXLAN Type option is available if theMode is VXLAN.
Select the VXLAN gateway type:
l Linux VXLAN
l Flannel VXLAN

Linux VXLAN is the default option.

Interface Specify the outing interface for VXLAN encapsulated traffic.

IP Version Select an IPv4 address type:
l IPv4 Unicast
l IPv4 Multicast

Multicast TTL TheMulticast TTL option is available if the IP Version is IPv4 Multicast.
Specify the multicast TTL. Valid values are from 0 (default) to 255, minimum
value is 1.

Destination IP Specify the destination IP address.
Note: For IPv4 unicast, you specify multiple IP addresses; for IPv4 multicast,
specify one IP address only.

Port The Port option is available if theMode is VXLAN.
Specify the VXLAN destination port (number). The default is 4789. The valid
range is 1–6553.

VNI The VNI option is available if theMode is VXLAN.
Specify the VXLAN network ID. The valid range is 1–16777215.

VSID The VSID option is available if theMode is NVGRE.
Specify the Virtual Subnet Identifier (VSID) for NVGRE.

5. Click Save.
Once the Overlay Tunnel settings are saved, the Remote Host MACMapping will be available to configure.

6. In the Remote Host MAC Mapping section, click Create New to display the configuration editor.
7. Configure the following Remote Host MACMapping settings:

Setting Guideline

Host MAC Specify the MAC address of the remote host.

VTEP Specify the IPv4 address of the virtual tunnel endpoint.

8. Click Save.
The dialog closes once the Remote Host MACMapping configuration is saved.

9. Click Save to update the Overlay Tunnel configuration.
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l Virtual overlay networking is supported on all FortiADC hardware platforms.
l For both VXLAN and NVGRE, the mapping can be configured either manually
or dynamically (the system learns from the remote VTEP).

l For VXLAN, IPv4 multicast and IPv4 unicast IP addresses can be used as the
destination IP of the VTEP.

l For NVGRE, only IPv4 unicast IP addresses can be used as the destination IP
of the VTEP.

l Once an overlay tunnel is created, an interface with the same name as the
tunnel name will be created automatically. It can be used to encapsulate or
decapsulate VXLAN or NVGRE packets.

Linking VDOMs for inter-VDOM routing

VDOM links allow VDOMs to communicate internally without using additional physical interfaces.

Inter-VDOM routing is the communication between VDOMs. VDOM links are virtual interfaces that connect VDOMs. A
VDOM link contains a pair of interfaces, each one connected to a VDOM and forming either end of the inter-VDOM
connection.

When VDOMs are configured on your FortiADC unit, configuring inter-VDOM routing and VDOM links is like creating a
VLAN interface. VDOM links can be managed in either the CLI or in the network interface list in the GUI.

Inter-VDOM routing is only available for these classic scenarios: static route, PBR,
L4 SLB, L7 SLB and NAT. It is currently not supported in IPv6 related configurations.

To create and configure a VDOM-link pair in the GUI:

1. Go to Network > Interface.
2. Scroll to the Vdom Link section.
3. Click Create New.
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4. Configure the following interface settings for each VDOM in the link:

Virtual Domain Select the VDOM to link for inter-VDOM routing.

IPv4/Netmask Specify the IP address and CIDR-formatted subnet mask, separated by a
forward slash ( / ), such as 192.0.2.5/24. Dotted quad formatted subnet masks
are not accepted.
Note: The IP address cannot be 0.0.0.0/0.

Allow Access Allow inbound service traffic. Select from the following options:
l HTTPS—Enables secure connections to the web UI. We recommend
this option instead of HTTP.

l Ping— Enables ping and traceroute to be received on this network
interface. When it receives an ECHO_REQUEST (“ping”), FortiADC will
reply with ICMP type 0 (ECHO_RESPONSE or “ping”).

l SSH—Enables SSH connections to the CLI. We recommend this option
instead of Telnet.

l SNMP—Enables SNMP queries to this network interface.
l HTTP—Enables connections to the web UI. We recommend this option
only for network interfaces connected to a trusted private network, or
directly to your management computer.

l Telnet — Enables Telnet connections to the CLI. We recommend this
option only for network interfaces connected to a trusted private network,
or directly to your management computer.

Status The Status is not the detected physical link status; it is the administrative
status (UP/Down) that indicates whether you permit the network interface to
receive and/or transmit packets.

5. Click Save.

By default, VDOM links created in the GUI are ethernet links. The link type can't be
changed after it has been created. To set a VDOM link type to point-to-point (ppp), it
needs to be created in the CLI.

To create a VDOM-link pair in the CLI:

config global
config system vdom-link

edit <vdom-link-name>
set type {ethernet|ppp}

next
end

Using this command will automatically create a VDOM-link pair in the system interface. However, by default, these
VDOM links will not be assigned an IP address or allowaccess options, so you would not be able to route traffic
between the VDOM links until these settings are configured in the system interface.

To configure the interface settings for the VDOM-link pair in the CLI:

config system interface
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edit <vdom-link-name0>
set type vdom-link
set vdom <vdom-name>
set ip <ip&netmask>
set allowaccess {http https ping snmp ssh telnet}

next
edit <vdom-link-name1>

set type vdom-link
set vdom <vdom-name>
set ip <ip&netmask>
set allowaccess {http https ping snmp ssh telnet}

next
end

To delete a VDOM link in the GUI:

1. Go to Network > Interface
2. Select a VDOM Link and click Delete.

To delete a VDOM link in the CLI:

config global
config system vdom-link

delete <vdom-link-name>
end

end

Test the configuration

When the inter-VDOM routing has been configured, test the configuration to confirm proper operation. Testing
connectivity ensures that physical networking connections and FortiADC unit interface configurations are properly
configured.

The easiest way to test connectivity is to use the ping and traceroute commands to confirm the connectivity of
different routes on the network.

Example

This example shows how to configure a FortiADC unit to use inter-VDOM routing for a static route scenario.

There are two departments of a company, Accounting and Sales, that need to connect to one FortiADC unit, and the
company uses a single ISP to connect to the Internet. To achieve this, two separate pairs of VDOM-links will need to be
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created and configured to link the traffic between VDOM 1 (Accounting) and the Management VDOM (root), and
between VDOM 2 (Sales) and the Management VDOM (root).

This example includes the following general steps. We recommend following the steps in the order below.

1) Create the VDOM-link pairs in the system interface

Create the two sets of VDOM-link pairs in the system interface: VDOM 1 to the Management VDOM (Accounting-root)
and VDOM 2 to the Management VDOM (Sales-root).

To create the Accounting to root VDOM-link pair:

config global
config system vdom-link

edit Accounting-root
set type ethernet

next
end

end

This will automatically create the pair of VDOMs named Accounting-root0 and Accounting-root1 in the system interface.
These VDOMs are created with default interface settings so they will need to be edited to enable the routing between
VDOM 1 (Accounting) and the Management VDOM (root).

To create the Sales to root VDOM-link pair:

config global
config system vdom-link

edit Sales-root
set type ethernet

next
end

end

This will automatically create the pair of VDOMs named Sales-root0 and Sales-root1 in the system interface. These
VDOMs are created with default interface settings so they will need to be edited to enable the routing between VDOM 2
(Sales) and the Management VDOM (root).

2) Configure the VDOM-link pairs in the system interface

In the system interface, edit and configure the two sets of VDOM-link pairs created through config system vdom-
link to enable the inter-VDOM routing between VDOM 1 (Accounting) and the Management VDOM (root), and VDOM
2 (Sales) and the Management VDOM (root).

To configure the interface settings for the Accounting-root VDOM-link pair:

config system interface
edit Accounting-root0

set type vdom-link
set vdom Accounting
set ip 111.111.111.2/24
set allowaccess https ping ssh

next
edit Accounting-root1

set type vdom-link
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set vdom root
set ip 111.111.111.1/24
set allowaccess https ping ssh

next
end

To configure the interface settings for the Sales-root VDOM-link pair:

config system interface
edit Sales-root0

set type vdom-link
set vdom Sales
set ip 122.122.122.2/24
set allowaccess https ping ssh

next
edit Sales-root1

set type vdom-link
set vdom root
set ip 122.122.122.1/24
set allowaccess https ping ssh

next
end

3) Configure the static routes

Configure the static route to send the traffic back to the Internal VDOM for each inter-VDOM link. For each VDOM-link
pair, specify the destination default route to point to the Internal VDOM network IP address, and specify the gateway IP
address of the next-hop router to point to the other end of the inter-VDOM link. Then set the other VDOM in the link pair
to send back the traffic by setting the gateway IP address to point back to the other VDOM in the link.

Configuring the static route for the Accounting-root VDOM-link pair

For the Accounting-root VDOM-link pair, set the destination for the Management VDOM (root) as the Internal VDOM 1
(Accounting) network, and set the gateway routing IP address to point to VDOM 1 (Accounting). Then set the gateway
routing IP address for VDOM 1 (Accounting) to point to the Management VDOM (root).

To route the Management VDOM (root):

config router static
edit 1

set destination 20.24.2.0/24
set gateway 111.111.111.2

next
end

To route the VDOM 1 (Accounting):

config router static
edit 2

set gateway 111.111.111.1
next

end
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Configuring the static route for the Sales-root VDOM-link pair

For the Sales-root VDOM-link pair, set the destination for the Management VDOM (root) as the Internal VDOM 2 (Sales)
network, and set the gateway routing IP address to point to VDOM 2 (Sales). Then set the gateway routing IP address for
VDOM 2 (Sales) to point to the Management VDOM (root).

To route the Management VDOM (root):

config router static
edit 3

set destination 20.24.3.0/24
set gateway 122.122.122.2

next
end

To route the VDOM 2 (Sales):

config router static
edit 4

set gateway 122.122.122.1
next

end

Transparent mode

In transparent mode, the FortiADC appliance (the load balancer) splits a subnet into two VLANs and bridges them
together. This allows you to insert the appliance into an existing network without modifying the IP addressing.

To support deploy FortiADC in transparent mode, you must first create a softswitch interface on the appliance. All traffic
that FortiADC does not supported can directly pass through this soft-switch interface without interruption, and FortiADC-
supported traffic, such as LLDB and DHCP, needs to be terminated.

Keep in mind that the FortiADC soft-switch does not participate in the STP node, and all STP BPDU will be forwarded by
this soft-switch interface directly.

Routing

The Network > Routing sub-menu allows you to perform the following tasks relating to network routing:

l Configuring static routes on page 271
l Configuring policy routes on page 272
l Configuring OSPF routes on page 273
l Configuring ISP routes on page 277
l Configuring BGP routes on page 280
l Configuring Bidirectional Forwarding Detection (BFD) on page 284
l Access list vs. prefix list on page 285
l Configuring an IPv4 access list on page 286
l Configuring an IPv6 access list on page 287
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l Configuring an IPv4 prefix list on page 288
l Configuring an IPv6 prefix list on page 289

Configuring static routes

Network systems maintain route tables to determine where to forward TCP/IP packets. Routes for outbound traffic are
chosen according to the following priorities:

l Link local routes—Self-traffic uses link local routes.
l LLB Link Policy route—Configured policy routes have priority over default routes.
l Policy route—Configured policy routes have priority over default routes.
l Static route / ISP route / OSPF route—Priority is based on the distance metric. By default, distance for static routes
is 10, for ISP is 20, for OSPF is 110, for EBGP is 20, and for IBGP is 200. The distance metric is configurable for
static routes and OSPF routes, but not for ISP routes.

l Default LLB Link Policy route—Default routes have lower priority than configured routes.
l Default static route / OSPF route—Default routes have lower priority than configured routes.

The system evaluates content route rules first, then policy routes, then static routes. The packets are routed to the first
route that matches. The static route table, therefore, is the one that must include a “default route” to be used when no
specific route has been determined.

Static routes specify the IP address of a next-hop router that is reachable from that network interface. Routers are aware
of which IP addresses are reachable through various network pathways, and can forward those packets along pathways
capable of reaching the packets’ ultimate destinations. The FortiADC system itself does not need to know the full route,
as long as the routers can pass along the packet.

You must configure at least one static route that points to a router, often a router that is the gateway to the Internet. You
may need to configure multiple static routes if you have multiple gateway routers, redundant ISP links, or other special
routing cases.

Before you begin:

l You must have Read-Write permission for System settings.

To configure a static route:

1. Go to Network > Routing.
The configuration page displays the Static tab.

2. Click Create New to display the configuration editor.
3. Complete the configuration as described in Static route configuration on page 271.
4. Save the configuration.

Settings Guidelines

Destination Address/mask notation to match the destination IP in the packet header.

It is a best practice to include a default route. If there is no other, more specific static route
defined for a packet’s destination IP address, a default route will match the packet, and pass it to
a gateway router so that any packet can reach its destination. If you do not define a default route,

Static route configuration
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Settings Guidelines

and if there is a gap in your routes where no route matches a packet’s destination IP address,
packets passing through the FortiADC towards those IP addresses will, in effect, be null routed.
While this can help to ensure that unintentional traffic cannot leave your FortiADC and therefore
can be a type of security measure, the result is that you must modify your routes every time that a
new valid destination is added to your network. Otherwise, it will be unreachable. A default route
ensures that this kind of locally-caused “destination unreachable” problem does not occur.
Specify 0.0.0.0/0 or ::/0 to set a default route for all packets.

Gateway Specify the IP address of the next-hop router where the FortiADC system will forward packets for
this static route. This router must know how to route packets to the destination IP addresses that
you have specified, or forward packets to another router with this information. For a direct
Internet connection, this will be the router that forwards traffic towards the Internet, and could
belong to your ISP. The gateway must be in the same subnet as the interface used to reach it.

Distance The default administrative distance is 10, which makes it preferred to OSPF routes that have a
default of 110. We recommend you do not change these settings unless your deployment has
exceptional requirements.

To configure a static route using the CLI:

config router static

edit 1

set destination <ip address/netmask>

set gateway <ip address>

set distance <value>
end

Configuring policy routes

Network systems maintain route tables to determine where to forward TCP/IP packets. Policy routes set the gateway for
traffic with a source and destination that match the policy.

Routes for outbound traffic are chosen according to the following priorities:

1. Link local routes—Self-traffic uses link local routes.
2. LLB Link Policy route—Configured policy routes have priority over default routes.
3. Policy route—Configured policy routes have priority over default routes.
4. Static route / ISP route / OSPF route—Priority is based on the distance metric. By default, distance for static routes

is 10, for ISP routes is 20, and for OSPF routes is 110. The distance metric is configurable for static routes and
OSPF routes, but not ISP routes.

5. Default LLB Link Policy route—Default routes have lower priority than configured routes.
6. Default static route / OSPF route—Default routes have lower priority than configured routes.

The system evaluates policy routes, then static routes. The packets are routed to the first route that matches. The policy
route table, therefore, does not need to include a “default route” for packets that do not match your policy because those
packets can be forwarded to the default route set in the static route table.
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Most policy route settings are optional, so a matching route may not provide enough information to forward the packet. In
that case, the FortiADC appliance may refer to the routing table in an attempt to match the information in the packet
header with a route in the routing table. For example, if the destination address is the only match criteria in the policy
route, the FortiADC appliance will look up the IP address of the next-hop router in its routing table. This situation could
occur when interfaces are dynamic (such as DHCP or PPPoE) and you do not want or are unable to specify a static IP
address of the next-hop router.

Before you begin:

l You must have Read-Write permission for System settings.

To configure a policy route:

1. Go to Network > Routing.
2. Click the Policy tab.
3. Click Create New to display the configuration editor.
4. Complete the configuration as described in Policy route configuration on page 273.
5. Save the configuration.

Settings Guidelines

Source Address/mask notation to match the source IP in the packet header. To match any value, either
leave it blank or enter 0.0.0.0/32.

Destination Address/mask notation to match the destination IP in the packet header. To match any value,
leave it blank or enter 0.0.0.0/32.

Gateway IP address of the next-hop router where the FortiADC system will forward packets for this policy
route. This router must know how to route packets to the destination subnet, or forward packets
to another router with this information.

Policy route configuration

Configuring OSPF routes

OSPF (Open Shortest Path First) is described in RFC 2328, OSPF Version 2. It is a link-state interior routing protocol.
Compared with RIP, OSPF can provide scalable network support and faster convergence times. OSPF is widely used in
large networks such as ISP backbone and enterprise networks. FortiADC supports OSPF version 2.

By supporting HA for OSPF route injection feature, the virtual server IP/IPv6 address can be injected into the OSPF
domain, and can be advertised or withdrawn according to the health state of the real server.

Before you begin:

l You must know how OSPF has been implemented in your network, and you must know the configuration details of
the implementation.

l You must have Read-Write permission for System settings.
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To configure OSPF:

1. Go to Network > Routing.
2. Click theOSPF tab.
3. Click Create New to display the configuration editor.
4. Complete the configuration as described in OSPF configuration on page 274.
5. Save the configuration.

Settings Guidelines

Router 32-bit number that sets the router-ID of the OSPF process. The router ID uses dotted decimal
notation. The router-ID must be an IP address of the router, and it must be unique within the
entire OSPF domain to the OSPF speaker.

Default Metric The default is 10.

Distance The default is 110.

Default Information
Originate

l Disable—Default.
l Enable—Originate an AS-External (type-5) LSA describing a default route into all external
routing capable areas of the specified metric and metric type.

l Always—The default is always advertised even when there is no default route present in
the routing table.

Default Information
Metric

The default is -1, which equals to the Default Metric.

Default Information
Metric Type

Select either of the following:
l 1—If selected, the metric equals to the Default Information Metric, plus the Default Metric.
l 2—(Default) If selected, the metric equals to the Default Information Metric.

Redistribute
Connected

Enable/disable to redistribute connected routes to OSPF, with the metric type and metric set if
specified. Redistributed routes are distributed into OSPF as Type-5 External LSAs into links to
areas.

Redistribute
Connected Metric

The default is -1, which equals to the Default Metric.

Redistribute
Connected Metric
Type

Select either of the following:
l 1—If selected, the metric equals to the Redistribute Connected Metric, plus the Default
Metric.

l 2—(Default) If selected, the metric equals to the Redistribute Connected Metric.

Redistribute Static Enable/disable to redistribute static routes to OSPF, with the metric type and metric set if
specified. Redistributed routes are distributed to OSPF as Type-5 External LSAs into links to
areas.

Redistribute Static
Metric

The default is -1, which equals to the Default Metric.

Redistribute Static
Metric Type

l 1—If selected, the metric equals to the Redistribute Static Metric, plus the Default Metric.
l 2—(Default) If selected, the metric equals to the Redistribute Static Metric.

Area Authentication

OSPF configuration
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Area 32-bit number that identifies the OSPF area. An OSPF area is a smaller part of the larger
OSPF network. Areas are used to limit the link-state updates that are sent out. The flooding
used for these updates would overwhelm a large network, so it is divided into these smaller
areas for manageability.

Authentication Specify an authentication type: 
l None—Also called null authentication. No authentication is used. In this case the 16-byte
Authentication field is not checked, and can be any value. However checksumming is still
used to locate errors.

l Text—A simple password is used. The password is a plain text string of characters. The
same password is used for all transactions on a network. The main use of this type of
authentication is to prevent routers from accidently joining the network. Simple password
authentication is vulnerable to many forms of attack, and is not recommended as a secure
form of authentication.

l MD5—Use OSPF cryptographic authentication. A shared secret key is used to
authenticate all router traffic on a network. The key is never sent over the network in the
clear—a packet is sent and a condensed and encrypted form of the packet is appended to
the end of the packet. A non-repeating sequence number is included in the OSPF packet
to protect against replay attacks that could try to use already sent packets to disrupt the
network. When a packet is accepted as authentic, the authentication sequence number is
set to the packet sequence number. If a replay attack is attempted, the packet sent will be
out of sequence and ignored.

Type Area type setting:
l

Network

Prefix Address/mask notation to specify the subnet.

Area Select an area configuration.

Interface

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces. After you initially
save the configuration, you cannot edit the name.

Interface Select the interface to enable OSPF for it.

Ignore MTU Enable/disable to ignore the interface MTU. Disabled by default.

Network Type l Broadcast
l Point to Point
l Point to Multipoint

Retransmit Interval Interval for retransmitting Database Description and Link State Request packets. The default is
5 seconds.

Transmit Delay Increment LSA age by this value when transmitting. The default is 1 second.

Cost Set link cost for the specified interface. The cost value is set to router-LSA's metric field and
used for SPF calculation. The default is 0.

Priority The router with the highest priority will be more eligible to become Designated Router. Setting
the value to 0 makes the router ineligible to become Designated Router. The default is 1.
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Dead Interval Number of seconds for RouterDeadInterval timer value used for Wait Timer and Inactivity
Timer. This value must be the same for all routers attached to a common network. The default
is 40 seconds.

Hello Interval Number of seconds between hello packets sent on the configured interface. This value must
be the same for all routers attached to a common network. The default is 10 seconds.

Authentication Specify an authentication type. All OSPF interfaces that want to learn routes from each other
must be configured with the same authentication type and password or MD5 key (one match is
enough). Options are: 
l None—Also called null authentication. No authentication is used. In this case the 16-byte
Authentication field is not checked, and can be any value. However checksumming is still
used to locate errors.

l Text—A simple password is used. The password is a plain text string of characters. The
same password is used for all transactions on a network. The main use of this type of
authentication is to prevent routers from accidently joining the network. Simple password
authentication is vulnerable to many forms of attack, and is not recommended as a secure
form of authentication.

l MD5—Use OSPF cryptographic authentication. A shared secret key is used to
authenticate all router traffic on a network. The key is never sent over the network in the
clear—a packet is sent and a condensed and encrypted form of the packet is appended to
the end of the packet. A non-repeating sequence number is included in the OSPF packet
to protect against replay attacks that could try to use already sent packets to disrupt the
network. When a packet is accepted as authentic, the authentication sequence number is
set to the packet sequence number. If a replay attack is attempted, the packet sent will be
out of sequence and ignored.

Text If using text authentication, specify a password string. Passwords are limited to 8 characters.

MD5 If using MD5 authentication, select an MD5 configuration name.

HA Router

Router You use the HA Router list configuration in an HA active-active deployment. On each HA
cluster node, add an HA Router configuration that includes an entry for each cluster node.
When the appliance is in standalone mode, it uses the primary OSPF Router ID; when it is in
HA mode, it uses the HA Router list ID.

Specify a 32-bit number that sets the router-ID of the OSPF process. The router ID uses dotted
decimal notation. The router-ID must be an IP address of the router, and it must be unique
within the entire OSPF domain to the OSPF speaker.

Node HA Node ID (0-7).

MD5 Key List

Name Configuration name. You select this name in the OSPF Interface configuration.
Valid characters are A-Z, a-z, 0-9, _, and -. No spaces. After you initially save the
configuration, you cannot edit the name.

Member

Key ID A number 1-255. Each member key ID must be unique to its member list.
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Key A string of up to 16 characters to be hashed with the cryptographic MD5 hash function.

Configuring ISP routes

ISP routes can be used for outbound traffic and link load balancing traffic.

Routes for outbound traffic are chosen according to the following priorities:

1. Link local routes—Self-traffic uses link local routes.
2. LLB Link Policy route—Configured policy routes have priority over default routes.
3. Policy route—Configured policy routes have priority over default routes.
4. Static route / ISP route / OSPF route—Priority is based on the distance metric. By default, distance for static routes

is 10, for ISP routes is 20, and for OSPF routes is 110. The distance metric is configurable for static routes and
OSPF routes, but not ISP routes.

5. Default LLB Link Policy route—Default routes have lower priority than configured routes.
6. Default static route / OSPF route—Default routes have lower priority than configured routes.

Before you begin:

l You must have read-write permission for system settings.

Note: Adding a new ISP route does not affect existing sessions. Deleting or editing an ISP route causes the related
sessions to be re-created.

To configure ISP Routes:

1. Go to Network > Routing.
2. Click the ISP tab.
3. Click Create New to display the configuration editor.
4. Complete the configuration as described in ISP Route configuration on page 277.
5. Save the configuration.

Settings Guidelines

Destination Select an ISP address book configuration object.

Note: Two ISP routes cannot reference the same ISP address book. The ISP routing feature
does not support multipath routing.

Gateway IP address of the gateway router that can route packets to the destination IP address that you
have specified.

ISP Route configuration

Reverse path route caching

By default, reverse path route caching is enabled. FortiADC caches a reverse path route for inbound traffic so it can
forward reply packets to the ISP link that forwarded the corresponding request packet. This is useful when your site
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receives traffic from multiple ISP links. For example, in Reverse path route caching enabled on page 278, the reverse
path pointer ensures that client traffic received from ISP1 is returned through ISP1.

Note: FortiADC does not support IPv6 traffic reverse path route caching.

Reverse path route caching enabled
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When reverse path caching is not enabled, the system forwards reply packets based on the results of routing lookup.

To enable/disable reverse path route caching, use the config router setting CLI command:

FortiADC-VM # config router setting
FortiADC-VM (setting) # get
rt-cache-strict : disable
rt-cache-reverse : enable
ip-forward : enable
ip6-forward : enable
FortiADC-VM (setting) # set rt-cache-reverse disable
FortiADC-VM (setting) # end
FortiADC-VM # get router setting
rt-cache-strict : disable
rt-cache-reverse : disable
ip-forward : enable
ip6-forward : enable

The rt-cache-strict option is disabled by default. Enable it when you want to send reply packets only via the same
interface that received the request packets. When enabled, source interface becomes part of the matching tuple that
FortiADC uses to identify sessions, so reply traffic is forwarded from the same interface that received the traffic.
(Normally each session is identified by a 5-tuple: source IP, destination IP, protocol, source port, and destination port.)

If the rt-cache-reverse option is enabled, you can use the config rt-cache-reverse-exception command
to maintain an exceptions list for source IP addresses that should be handled differently. For example, if you configure
an exception for 192.168.1.0/24, FortiADC will not maintain a pointer to the ISP for traffic from source 192.168.1.18.
Reply packets will be forwarded based on the results of routing lookup.

FortiADC-docs # config router setting
FortiADC-docs (setting) # get
rt-cache-strict : disable
rt-cache-reverse : enable
ip-forward : enable
ip6-forward : enable
icmp-redirect-send : disable
FortiADC-docs (setting) # config rt-cache-reverse-exception
FortiADC-docs (rt-cache-rever~e) # edit 1
Add new entry '1' for node 3740
FortiADC-docs (1) # set ip-netmask 192.168.1.0/24
FortiADC-docs (1) # end
FortiADC-docs (setting) # end

Configuring BGP routes

BGP stands for Border Gateway Protocol, which was first used in 1989. The current version, BGP-4, was released in
1995 and is defined in RFC 1771. That RFC has since been replaced by the more recent RFC 4271. The main benefits
of BGP-4 are classless inter-domain routing and aggregate routes. Often classified as a path-vector protocol and
sometimes as a distance-vector touting protocol, BGP exchanges routing and reachability information among
autonomous systems over the Internet.

BGPmakes routing decisions based on path, network policies and rulesets instead of the hop-count metric as RIP does,
or cost-factor metrics as OSPF does.

BGP-4+ supports IPv6. It was introduced in RFC 2858 and RFC 2545.
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BGP is the routing protocol used on the Internet. It was designed to replace the old Exterior Gateway Protocol (EGP)
which had been around since 1982, and was very limited. In doing so, BGP enabled more networks to take part in the
Internet backbone to effectively decentralize it and make the Internet more robust, and less dependent on a single ISP or
backbone network.

How BGP works

A BGP router receives information from its peer routers that have been defined as neighbors. BGP routers listen for
updates from these configured neighboring routers on TCP port 179.

A BGP router is a finite state machine with six various states for each connection. As two BGP routers discover each
other, and establish a connection they go from the idle state, through the various states until they reach the established
state. An error can cause the connection to be dropped and the state of the router to be reset to either active or idle.
These errors can be caused by: TCP port 179 not being open, a random TCP port above port 1023 not being open, the
peer address being incorrect, or the AS number being incorrect.

When BGP routers start a connection, they negotiate which (if any) optional features will be used such as multiprotocol
extensions that can include IPv6 and VPNs.

By the support HA for BGP route injection feature, the virtual server IP/IPv6 address can be injected into the BGP
domain, and can be advertised or withdrawn according to the health state of the real server.

FortiADC is designed for BGP node and for BGP route injection (distribute VS public IP to BGP
network). It’s not recommend to deploy it as a core BGP routing.

IBGP vs. EBGP

When you read about BGP, often you see EBGP or IBGPmentioned. These are both BGP routing, but BGP used in
different roles. Exterior BGP (EBGP) involves packets crossing multiple autonomous systems (ASes) where interior
BGP (IBGP) involves packets that stay within a single AS. For example the AS_PATH attribute is only useful for EBGP
where routes pass through multiple ASes.

These two modes are important because some features of BGP are only used for one of EBGP or IBGP. For example
confederations are used in EBGP, and route reflectors are only used in IBGP. Also routes learned from IBGP have
priority over EBGP learned routes.

Before you begin:

l You must know how BGP has been implemented in your network, i.e., the configuration details of the
implementation.

l You must have Read-Write permission for System settings.
l You must have configured all the required access (IPv6) lists and prefix (IPv6) lists. See Access list vs. prefix list.

To configure BGP routes:

1. Click Network > Routing.
2. Click the BGP tab.
3. Make the desired entries and/or selections as described in BGP configuration on page 282.
4. Click Save when done.
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AS Enter the AS (Autonomous System) number of the BGP router. Valid values are from 0 to
4294967295.
Note: Per RFC 6996, the first and last ASNs of the original 16-bit integers, namely 0 and 65535,
and the last ASN of the 32-bit numbers, namely 4,294,967,295, are reserved and should not be
used by operators; ASNs 64,512 to 65,534 of the original 16-bit AS range, and 4,200,000,000 to
4,294,967,294 of the 32-bit range are reserved for private use, which means that they can be
used internally but should not be announced to the global Internet.

Router ID Enter the 32-bit number that sets the router-ID of the BGP process. The router ID uses dotted
decimal notation. The router-ID must be the IP address of the router, and it must be unique within
the entire BGP domain to the BGP speaker.

Redistribute OSPF Enable/Disable (default) the redistribution of OSPF routes to the BGP process.

Redistribute
Connected

Enable/Disable (default) the redistribution of connected routes to the BGP process.

Redistribute Static Enable/Disable (default) the redistribution of static routes to the BGP process.

Redistribute IPv6
Connected

Enable/Disable (default) the redistribution of connected IPv6 routes to the BGP process.

Redistribute IPv6
Static

Enable/Disable (default) the redistribution of static IPv6 routes to the BGP process.

Always Compare
MED

Enable/Disable (default) the comparison of Multi-Exit Discriminator (MED) for paths from
neighbors in different ASs (Autonomous Systems).

Deterministic MED Enable/Disable (default) the deterministic comparison of Multi-Exit Discriminator (MED) values
among all paths received from the same AS (Autonomous System).

Bestpath Compare
Router ID

Enable/Disable (default) the BGP routing process to compare identical routes received from
different external peers during the best-path selection process and to select the route with the
lowest router ID as the best path.

Network

Type Select either of the following (IP address) types:
l IPv4
l IPv6

IPv4 Prefix If IPv4 is selected (above), specify the IPv4 prefix in the format of 0.0.0.0/0.

IPv6 Prefix If IPv6 is selected (above), specify the IPv6 prefix in the format of ::/0.

Save Be sure to click Save after you are done with configuring the network.

Neighbor

Remote AS Specify the remote AS (Autonomous System) number of the BGP neighbor you are creating.
Valid values are from 1 to 4294967295.

Type Select either of the following:
l IPv4
l IPv6

BGP configuration
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IP/IPv6 Specify the IPv4 address or IPv6 address for the BGP neighbor.

Interface Click to select the interface for the BGP neighbor.

Port Specify the port of the BGP neighbor.

Keep Alive Specify the frequency (in seconds) at which the BGP neighbor sends out keepalivemessage to
its peer.
Valid values are from 0 to 65535, with 60 seconds being the default.

Hold Time Specify the "wait time" or pause (in seconds) the BGP neighbor declares a peer dead after failing
to receive a keepalivemessage from it.
Valid values are from 0 to 65535, with 180 (seconds) being the default.
When the minimum acceptable hold time is configured on a BGP router, a remote BGP peer
session can be established only when the latter is advertising a hold time equal to, or greater
than, the minimum acceptable hold time configured on the former. If the minimum acceptable
hold time is greater than the configured hold time, then the next time the remote BGP peer tries
to establish a session with the local BGP router, it will fail and the local BGP router will notify the
remote BGP peer saying "unacceptable hold time".

Distribute List
In/Distribute IPv6
List In

Click to select an Access List or Access IPv6 List.
The BGP router will apply the selected access list to inbound advertisements to the BGP
neighbor when distributing BGP neighbor information.
Note: It is highly recommended that you have the Prefix List or the IPv6 Prefix List configured
before configuring BGP Routing.

Distribute List
Out/Distribute IPv6
List Out

Click to select an Access List or Access IPv6 List.
The BGP router will apply the selected access list to outbound advertisements to the neighbor
when distributing BGP neighbor information.
Note: It is highly recommended that you have the Access List or the Access IPv6 List configured
before configuring BGP Routing.

Prefix List In/Prefix
IPv6 List In

Click to select an Prefix List or Prefix IPv6 List.
The BGP router will apply the selected Prefix (IPv6) List to inbound advertisements to the
neighbor when distributing BGP neighbor information.
Note: It is highly recommended that you have the Prefix List or the Prefix IPv6 List configured
before configuring BGP Routing.

Prefix List
Out/Prefix IPv6 List
Out

Click to select an Prefix List or Prefix IPv6 List.
The BGP router will apply the selected Prefix (IPv6) List to outbound advertisements to the
neighbor when distributing BGP neighbor information.
Note: It is highly recommended that you have the Prefix List or the Prefix IPv6 List configured
before configuring BGP Routing.

Weight Assign a weight to a neighbor connection. Valid values are from 0 to 65535.
By default, routes learned through another BGP peer carries a weight value of 0, whereas routes
sourced by the local router carry a default weight value of 32768.
Initially, all routes learned from a neighbor will have an assigned weight. The route with the
greatest weight is chosen as the preferred route when multiple routes are available to a network.
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BFD Enable to activate Bidirectional Forwarding Detection (BFD) on the BGP session. When BFD
detects a path failure, a neighbor Down event is notified immediately to the BGP process,
triggering a BGP neighbor status change.
For details, see Configuring Bidirectional Forwarding Detection (BFD) on page 284.

Save Be sure to click Save after you are done with configuring the Neighbor.

HA Router ID List

Router ID Use the HA Router list configuration in an HA active-active deployment. On each HA cluster
node, add an HA Router configuration that includes an entry for each cluster node. When the
appliance is in standalone mode, it uses the primary BGP Router ID; when it is in HA mode, it
uses the HA Router list ID.
Specify a 32-bit number that sets the router-ID of the BGP process. The router ID uses dotted
decimal notation. The router-ID must be an IP address of the router, and it must be unique within
the entire BGP domain to the BGP speaker.

Node Specify the HA Node ID (0-7).

Save Be sure to click Save after you are done with configuring the HA Router ID List.

Note:The Access List and Prefix List features are mutually exclusive. Therefore, do NOT apply both to any neighbor in
any direction (inbound or outbound) when configuring BGP routing.

Route health injection (RHI)

Route health injection (RHI) allows for advertising routes to virtual server IP addresses based on the health status of the
corresponding service. For FortiADC deployment, routes to virtual server IP addresses can be injected into the dynamic
routing protocol like BGP, OSPF, etc. and spread through the network. The status of a virtual server depends on factors
such as the status of its real servers, the scheduled if the schedule pool is enabled. For example, if there is at least one
available real server (virtual server is healthy), the route to the virtual server IP address will be injected and spread to the
neighbors as long as the virtual server IP is added into the BGP network. Conversely, the route to the virtual server IP will
not be injected if no real server is available (virtual server is unhealthy).

Configuring Bidirectional Forwarding Detection (BFD)

You can use Bidirectional Forwarding Detection (BFD) to quickly detect Border Gateway Protocol (BGP) session failures
by enabling quicker rerouting of traffic in the event of a link or peer failure. After you configure the BFD object, you can
enable BFD in the BGP Neighbor configuration. For more information about the BGP, see Configuring BGP routes on
page 280.

The BFD protocol serves as an uncomplicated Hello mechanism designed to identify network failures. Within this
framework, Hello packets are transmitted at predetermined, regular intervals. The protocol detects a neighbor failure
when a routing device ceases to receive a reply within a specified interval. The failure detection timers employed by BFD
possess shorter time limits compared to default failure detection mechanisms for BGP, thereby delivering quicker
detection capabilities and a marked decrease in reconvergence time.

After BGP neighbors are configured to perform rapid state detection through BFD, BGP will notify the BFD process.
Based on the BGP neighbor's IP address, the BFD process establishes neighbors and starts the negotiation process.
The bidirectional detection starts once the BFD neighbor status is UP. The interval between BFD packets is configurable
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within 200 milliseconds to 30 seconds. When BFD detects a path failure, a neighbor Down event is notified immediately
to the BGP process, triggering a BGP neighbor status change.

Before you begin:

l You must know how BGP has been implemented in your network, i.e., the configuration details of the
implementation.

l You must have Read-Write permission for System settings.

To configure BFD:

1. Go to Network > Routing.
2. Click the BFD tab.
3. Click Create New to display the configuration editor.
4. Configure the following Interface settings:

Setting Description

Name Specify a unique name for the BFD configuration object. Valid characters are
A-Z, a-z, 0-9, _, and -. No space is allowed.
Note: Once saved, the name of a BFD configuration cannot be changed

Interface Specify the Interface to assign for BFD.
The BFD Interface can refer to the Link Load Balance Ingress Interface
specified in the Link Policy. Any Layer 3 interfaces that receive and send
external packets can be assigned for BFD except for Loopback interfaces.

Desired Min Transmit Interval Specify the desired minimum transmit interval for BFD liveness detection in
milliseconds. Default: 750ms, Range: 200ms-30000ms.
This refers to the interval that the FortiADC would like to use when transmitting
BFD Control packets.

Detect Multiplier Specify the detection time multiplier. Default: 3 Range: 1-20.
The negotiated transmit interval, multiplied by this value, provides the
Detection Time for the receiving system.

Required Min Receive Interval Specify the required minimum receive interval for BFD liveness detection in
milliseconds. Default: 500ms, Range: 200ms-30000ms.
This refers to the minimum interval after which the local routing device must
receive a reply from a neighbor with which it has established a BFD session.

5. Click Save.
Once you have saved the BFD object, you can enable BFD in a BGP Neighbor configuration.

Access list vs. prefix list

Access lists and prefix lists are different mechanisms that you can use to control traffic into and out of a network.
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Access lists

Access lists allow you to filter packets so that you can permit or deny them from crossing specified network interfaces.
You can control whether packets are forwarded or blocked at the routers' interfaces based on the criteria set in the
access lists.

Access lists fall into two categories: standard and extended. A standard access list (1-99) only checks the source
addresses of all IP packets, whereas an extended access list (100-199) checks both source and destination addresses,
specific UDP/TCP/IP protocols, and destination ports.

Range comparison between standard access list and extended access list on page 286 below provides a comparison
between standard access lists and extended access lists in terms of range.

Range comparison between standard access list and extended access list

Access List Type Range

Standard 1-99, 1300-1999

Extended 100-199, 2000-2699

Note: For this release, FortiADC only supports user-defined access lists. It does NOT support either standard or
extended access lists. Access lists are NOT required for BGP routing configuration. However, if you wan to include
access lists in BGP routing configuration, we highly recommend that you have them configured ahead of time.

Prefix lists

Prefix lists are used to configure filter IP routes. They are configured with the permit or deny keywords to either allow or
block the prefix based on the matching conditions. A prefix list is made up of an IP address and a bit mask. The
IP address can be a classful network, a subnet, or a single host route, whereas the bit mask can be a numeric value
ranging from 1 to 32. An implicit deny is applied to the route that matches any entry in the prefix list.

A prefix list contains one or multiple sequential entries which are evaluated sequentially, starting with the entry with the
lowest sequence number. Evaluation of a prefix against a prefix list comes to an end when a match is found and the
permit or deny statement is applied to that network.

Although extended access lists, and, to some extent, standard access lists, can be utilized to match prefix
announcements, prefix lists are considered more graceful.

Note: Prefix lists are NOT required for BGP routing configuration. However, if you want to include prefix lists in BGP
routing configuration, we highly recommend that you have them configured ahead of time.

Configuring an IPv4 access list

FortiADC units support IPv4 access lists over BGP routing. If you are configuring BGP routing using IPv4, you must
configure access lists using the IPv4 protocol.

To configure an IPv4 access list:

1. Go to Network > Routing.
2. Click the Access List tab.
3. Click Create New to display the configuration editor.
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4. Configure the following Access List settings:

Setting Guideline

Name Enter a unique name for the new access list.
The name can be up to 35 alphanumeric characters long, including . (period) ,
: (colon), _ (underscore), and - (hyphen). No space is allowed.

Description Optionally, enter a brief description of the access list.
The description can be up to 1023 alphanumeric characters long, with no
restriction on use of special characters. Space between characters is allowed.

5. Click Save.
Once the Access List configuration is saved, the Rule will be available to configure.

6. In the Rule section, click Create New to display the configuration editor.
7. Configure the following Access List Rule settings:

Setting Guideline

Action Select the action as Permit or Deny.

IPv4 Prefix Enter the IPv4 address/subnet mask in the format of 0.0.0.0./0.

8. Click Save.
The dialog closes once the Rule configuration is saved.

9. Click Save to update the Access List configuration.

Configuring an IPv6 access list

FortiADC units support IPv6 access lists over BGP routing. If you are configuring BGP routing using IPv6, you must
configure access lists using the IPv6 protocol.

To configure an IPv6 access list:

1. Go to Network > Routing.
2. Click the Access List tab.
3. Click Create New to display the configuration editor.
4. Configure the following Access IPv6 List settings:

Setting Guideline

Name Enter a unique name for the new access list.
The name can be up to 35 alphanumeric characters long, including . (period) ,
: (colon), _ (underscore), and - (hyphen). No space is allowed.

Description Optionally, enter a brief description of the access list.
The description can be up to 1023 alphanumeric characters long, with no
restriction on use of special characters. Space between characters is allowed.

5. Click Save.
Once the Access IPv6 List configuration is saved, the Rule will be available to configure.

6. In the Rule section, click Create New to display the configuration editor.
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7. Configure the following Access IPv6 List Rule settings:

Setting Guideline

Action Select the action as Permit or Deny.

IPv6 Prefix Enter the IPv6 address/subnet mask in the format of 0.0.0.0./0.

8. Click Save.
The dialog closes once the Rule configuration is saved.

9. Click Save to update the Access IPv6 List configuration.

Configuring an IPv4 prefix list

FortiADC supports IPv4 prefix lists over BGP routing. If you are configuring BGP routing using IPv4, you must configure
prefix lists using the IPv4 protocol.

To configure an IPv4 prefix list:

1. Go to Network > Routing.
2. Click the Prefix List tab.
3. Click Create New to display the configuration editor.
4. Configure the following Prefix List settings:

Setting Guideline

Name Enter a unique name for the new access list.
The name can be up to 35 alphanumeric characters long, including . (period) ,
: (colon), _ (underscore), and - (hyphen). No space is allowed.

Description Optionally, enter a brief description of the access list.
The description can be up to 1023 alphanumeric characters long, with no
restriction on use of special characters. Space between characters is allowed.

5. Click Save.
Once the Prefix List configuration is saved, the Rule will be available to configure.

6. In the Rule section, click Create New to display the configuration editor.
7. Configure the following Prefix List Rule settings:

Setting Guideline

Action Select the action as Permit or Deny.

IPv4 Prefix Enter the IPv4 address/subnet mask in the format of 0.0.0.0./0.

GE Specify theGE (greater than and equal to) values. Set to 0 or a number larger
than netmask.

LE Specify the LE (less than and equal to) values. Set to 0 or a number no smaller
than GE.

8. Click Save.
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The dialog closes once the Rule configuration is saved.
9. Click Save to update the Prefix List configuration.

Configuring an IPv6 prefix list

FortiADC supports IPv6 prefix lists over BGP routing. If you are configuring BGP routing using IPv6, you must configure
prefix lists using the IPv6 protocol.

To configure an IPv6 prefix list:

1. Go to Network > Routing.
2. Click the Prefix List tab.
3. Click Create New to display the configuration editor.
4. Configure the following Prefix IPv6 List settings:

Setting Guideline

Name Enter a unique name for the new access list.
The name can be up to 35 alphanumeric characters long, including . (period) ,
: (colon), _ (underscore), and - (hyphen). No space is allowed.

Description Optionally, enter a brief description of the access list.
The description can be up to 1023 alphanumeric characters long, with no
restriction on use of special characters. Space between characters is allowed.

5. Click Save.
Once the Prefix IPv6 List configuration is saved, the Rule will be available to configure.

6. In the Rule section, click Create New to display the configuration editor.
7. Configure the following Prefix IPv6 List Rule settings:

Setting Guideline

Action Select the action as Permit or Deny.

IPv6 Prefix Enter the IPv6 address/subnet mask in the format of 0.0.0.0./0.

GE Specify theGE (greater than and equal to) values. Set to 0 or a number larger
than netmask.

LE Specify the LE (less than and equal to) values. Set to 0 or a number no smaller
than GE.

8. Click Save.
The dialog closes once the Rule configuration is saved.

9. Click Save to update the Prefix List configuration.
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NAT

A number of network address translation (NAT) methods map packet IP address information for the packets that are
received at the ingress network interface into the IP address space you configure. Packets with the new IP address are
forwarded through the egress interface.

You can configure NAT per virtual server within the virtual server configuration.

This section describes the system-wide, policy-based NAT feature. The system-wide feature supports:

l SNAT—Translates the packet header source IP address to the configured address. See Configure source NAT.
l 1-to-1 NAT—Maps the public IP address for an interface to an IP address on a private network. See Configure 1-to-
1 NAT.

l Port forwarding—Maps an external published protocol port to the actual port. Configuration for port forwarding is
included in the configuration for 1-to-1 NAT.

Configuring source NAT

You can use source NAT (SNAT) when clients have IP addresses from private networks. This ensures you do not have
multiple sessions from different clients with source IP 192.168.1.1, for example. Or, you can map all client traffic to a
single source IP address because a source address from a private network is not meaningful to the FortiADC system or
backend servers.

 SNAT on page 290 illustrates SNAT. The SNAT rule matches the source and destination IP addresses in incoming
traffic to the ranges specified in the policy. If the client request matches, the system translates the source IP address to
an address from the SNAT pool. In this example, a client with private address 192.168.1.1 requests a resource from the
virtual server address at 192.0.2.1 (not the real server address 10.0.0.1; the real server address is not published). The
two rule conditions match, so the system translates the source IP to the next address in the SNAT pool—10.1.0.1. SNAT
rules do not affect destination addresses, so the destination address in the request packet is preserved.

The systemmaintains this NAT table and performs the inverse translation when it receives the server-to-client traffic. Be
sure to configure the backend servers to use the FortiADC address as the default gateway so that server responses are
also rewritten by the NAT module.

Note: This SNAT feature is not supported for traffic to virtual servers. Use the virtual server SNAT feature instead.

 SNAT
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Before you begin:

l You must know the IP addresses your organization has provisioned for your NAT design.
l You must have Read-Write permission for System settings.

To configure source NAT:

1. Go to Network > NAT.
The configuration page displays the Source tab.

2. Click Create New to display the configuration editor.
3. Complete the configuration as described in Source NAT configuration on page 292.
4. Save the configuration.
5. Reorder rules, as necessary.

Settings Guidelines

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces. After you initially
save the configuration, you cannot edit the name.

Source Address/mask notation to match the source IP address in the packet header. For example,
192.0.2.0/24.

Destination Address/mask notation to match the destination IP address in the packet header. For example,
10.0.2.0/24.

Egress Interface Interface that forwards traffic.

Translation Type l IP Address—Select to translate the source IP to a single specified address.
l Pool—Select to translate the source IP to the next address in a pool.
l No NAT—Select to avoid translating the source IP.

Translation to IP
Address

Note: This option applies only when the Translation Type is set to IP address.
Specify an IPv4 address. The source IP address in the packet header will be translated to this
address.

Pool Address
Range

Note: This option applies only when Translation Type is set to Pool.
Specify the first IP address in the SNAT pool.

No NAT Note: This option applies only when Translation Type is set to No-NAT

To Specify the last IP address in the SNAT pool.

Traffic Group Select a traffic group. Otherwise, the system will use the default traffic group.

Reordering

After you have saved a rule, reorder rules as necessary. The rules table is consulted from top to
bottom. The first rule that matches is applied and subsequent rules are not evaluated.

Source NAT configuration
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Configuring 1-to-1 NAT

You can use 1-to-1 NAT when you want to publish public or “external” IP addresses for FortiADC resources but want the
communication among servers on the internal network to be on a private or “internal” IP address range.

 One-to-One NAT on page 293 illustrates 1-to-1 NAT. The NAT configuration assigns both external and internal (or
“mapped”) IP addresses to Interface 1. Traffic from the external side of the connection (such as client traffic) uses the
external IP address and port. Traffic on the internal side (such as the virtual server communication with real servers)
uses the mapped IP address and port.

1-to-1 NAT is supported for traffic to virtual servers. The address translation occurs before the ADC has processed its
rules, so FortiADC server load balancing policies that match source address (such as content routing and content
rewriting rules) should be based on the mapped address space.

The systemmaintains this NAT table and performs the inverse mapping when it sends traffic from the internal side to the
external side.

 One-to-One NAT

FortiADC Handbook 293
Fortinet Technologies Inc.



Network

FortiADC Handbook 294
Fortinet Technologies Inc.



Network

Before you begin:

l You must know the IP addresses your organization has provisioned for your NAT design.
l You must have Read-Write permission for System settings.

To configure one-to-one NAT:

1. Go to Network > NAT.
2. Click the 1-to-1 NAT tab.
3. Click Create New to display the configuration editor.
4. Complete the configuration as described in 1-to-1 NAT configuration on page 295.
5. Save the configuration.
6. Reorder rules, as necessary.

Settings Guidelines

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces. After you initially
save the configuration, you cannot edit the name.

External Interface Interface that receives traffic.

External Address
Range

Specify the first address in the range. The last address is calculated after you enter the mapped
IP range.

Mapped Address
Range

Specify the first and last addresses in the range.

Port Forwarding

Port Forwarding Select to enable.

Protocol l TCP
l UDP

External Port
Range

Specify the first port number in the range. The last port number is calculated after you enter the
mapped port range.

Mapped Port
Range

Specify the first and last port numbers in the range.

Traffic Group Select a traffic group. Otherwise, the system will use the default.

Reordering

After you have saved a rule, reorder rules as necessary. The rules table is consulted from top to
bottom. The first rule that matches is applied and subsequent rules are not evaluated.

1-to-1 NAT configuration

QoS

You can use quality-of-service (QoS) policies to provision bandwidth for any traffic that matches the rule. You might
consider QoS policies for latency- or bandwidth-sensitive services, such as VoIP and ICMP.
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The FortiADC system does not provision bandwidth based on the TOS bits (also called differentiated services) in the IP
header to control packet queueing. Instead, the system provisions bandwidth based on a source/destination/service
matching tuple that you specify.

Note: The QoS policy feature is not supported for traffic to virtual servers.

Basic steps

1. Configure a QoS queue.
2. Configure a QoS filter or QoS IPv6 filter.

Configuring the QoS filter

A QoS filter is the policy that assigns traffic to the QoS queue.

Before you begin:

l You must have a good understanding and knowledge of traffic in your network that requires QoS provisioning.
l You must have created the address configuration objects and service configuration objects that define the matching
tuple for QoS rules. Use the Shared Resources menu firewall address and service object configuration editor.

l You must have created a QoS queue configuration object.
l You must have Read-Write permission for System settings.

To configure QoS filter:

1. Go to Network > QoS.
The configuration page displays theQoS Filter tab.

2. Click Create New to display the configuration editor.
3. Complete the configuration as described in QoS filter configuration on page 296.
4. Save the configuration.
5. Reorder rules, as necessary.

Settings Guidelines

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces. After you initially
save the configuration, you cannot edit the name.

Status Enable/disable the filter.

Queue Select the queue that will be used for packets that match the filter criteria.

Service Select a service object to use to form the matching tuple.

Source Select a source address object to use to form the matching tuple.

Destination Select a destination address object to use to form the matching tuple.

Ingress Interface Select the interface that receives traffic.

Egress Interface Select the interface that forwards traffic.

QoS filter configuration
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Settings Guidelines

After you have saved a rule, reorder rules as necessary. The rules table is consulted from top to
bottom. The first rule that matches is applied and subsequent rules are not evaluated.

Configuring the QoS IPv6 filter

A QoS filter is the policy that assigns traffic to the QoS queue.

Before you begin:

l You must have a good understanding and knowledge of traffic in your network that requires QoS provisioning.
l You must have created the address configuration objects and service configuration objects that define the matching
tuple for QoS rules. Use the Shared Resources menu firewall address and service object configuration editor.

l You must have created a QoS queue configuration object.
l You must have Read-Write permission for System settings.

To configure QoS filter:

1. Go to Network > QoS.
2. Click theQoS IPv6 Filter tab.
3. Click Create New to display the configuration editor.
4. Complete the configuration as described in QoS IPv6 filter configuration on page 297.
5. Save the configuration.
6. Reorder rules, as necessary.

Settings Guidelines

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces. After you initially
save the configuration, you cannot edit the name.

Status Enable/disable the filter.

Queue Select the queue that will be used for packets that match the filter criteria.

Service Select a service object to use to form the matching tuple.

Source Select a source address object to use to form the matching tuple.

Destination Select a destination address object to use to form the matching tuple.

Ingress Interface Select the interface that receives traffic.

Egress Interface Select the interface that forwards traffic.

After you have saved a rule, reorder rules as necessary. The rules table is consulted from top to
bottom. The first rule that matches is applied and subsequent rules are not evaluated.

QoS IPv6 filter configuration
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Configuring a QoS queue

You must configure a queue before you configure a filter.

Before you begin:

l You must have Read-Write permission for System settings.

To configure a QoS queue:

1. Go to Network > QoS.
2. Click theQoS Queue tab.
3. Click Create New to display the configuration editor.
4. Complete the configuration as described in QoS queue configuration on page 298
5. Save the configuration.

Settings Guidelines

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces. After you initially
save the configuration, you cannot edit the name.

Bandwidth Maximum bandwidth rate. Specify a number and a unit abbreviation. For example, specify 100K
for 100 Kbps, 10M for 10 Mbps, and 1G for 1Gbps.

QoS queue configuration

Packet Capture

From the Network > Packet Capture sub-menu, you can configure the tcpdump utility that is supported through the CLI
and web UI.

See the FortiADC CLI Reference for information on using the CLI command.

Use the following procedure to use the web UI version.

Before you begin:

l You must have a good understanding of tcpdump and filter expressions. See
http://www.tcpdump.org/manpages/pcap-filter.7.html.

l You must have Read-Write permission for System settings.

To use the web UI version of tcpdump:

1. Go to Network > Packet Capture.
2. Click Create New to open the Packet Capture editor, and specify your packet capture settings as shown in the

figure below.
3. Use the controls to start, stop, and download the packet capture. See Packet capture toolbar on page 299.

Packet capture configuration page
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Packet capture toolbar
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Shared Resources

The Shared Resourcesmenu contain features and configurations that allow you to manage resources that are used in
various configurations and policies across the FortiADC system.

This section is organized into the following sub-menu topics:

l Health Check on page 300
l Schedule Group on page 313
l Address on page 313
l Service on page 320

Health Check

The Shared Resources > Health Check sub-menu includes the following topics:

l Configuring health checks on page 300
l Monitoring health check status on page 310
l Configuring health check scripts on page 311

Configuring health checks

In server load balancing deployments, the system uses health checks to poll the members of the real server pool to test
whether an application is available. You can also configure additional health checks to poll related servers, and you can
include results for both in the health check rule. For example, you can configure an HTTP health check test and a
RADIUS health check test. In a web application that requires user authentication, the web server is deemed available
only if the web server and the related RADIUS server pass the health check.

In link load balancing deployments, the health check can poll either the ISP link group member itself or a “beacon” server
that is deployed on the other side of the ISP link. A beacon is an IP address that must be reachable in order for the link to
be deemed available. A beacon can be any IP address, such as a main office, core router, or virtual server at another
data center.

If you expect a backend server is going to be unavailable for a long period, such as
when it is undergoing hardware repair, it is experiencing extended down time, or
when you have removed it from the server farm, you can improve the performance of
the FortiADC system by setting the status of the pool member to Disabled, rather
than allowing the system to continue to attempt health checks.

Predefined health check configuration objects on page 301 describes the predefined health checks. You can get started
with these or create custom objects.
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Predefined Description

LB_HLTHCK_HTTP Sends a HEAD request to the server port 80. Expects the server to return an
HTTP 200.

LB_HLTHCK_HTTPS Sends a HEAD request to the server port 443. Expects the server to return an
HTTP 200.

LB_HLTHCK_ICMP Pings the server.

LB_HLTHCK_TCP_ECHO Sends a TCP echo to server port 7. Expects the server to respond with the
corresponding TCP echo.

Predefined health check configuration objects

You can clone a predefined configuration object to help you get started with a user-
defined configuration.

To clone a configuration object, click the clone icon that appears in the tools
column on the configuration summary page.

Before you begin:

l You must have a good understanding of TCP/IP and knowledge of the services running on your backend servers.
l You must know the IP address, port, and configuration details for the applications running on backend servers. For
some application protocol checks, you must specify user credentials.

l You must have Read-Write permission for Load Balance settings.

After you have configured a health check, you can select it in the SLB server pool, LLB link group, or GLB server
configuration.

To configure a health check:

1. Go to Shared Resources > Health Check.
The configuration page displays the Health Check tab.

2. Click Create New to display the configuration editor.
3. Enter a name for the Health Check configuration and select the Type. The Type option determines what parameters

FortiADC Handbook 301
Fortinet Technologies Inc.



Shared Resources

will need to be configured for that health check type.

4. Parameter Guideline

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces.
After you initially save the configuration, you cannot edit the name.

Type Select one of the following health check types:
l ICMP
l TCP Echo
l TCP
l HTTP
l HTTPS
l DNS
l RADIUS
l SMTP
l POP3
l IMAP4
l RADIUS Accounting
l FTP
l TCP Half Open Connection
l TCP SSL
l SNMP
l SSH
l L2 Detection
l UDP
l SIP
l SIP TCP
l SNMP Custom
l RTSP
l MySQL
l Diameter
l Script
l Oracle
l LDAP
l MSSQL
l LDAPS

5. Configure theGeneral settings that apply to all health check types.

Parameter Guideline

Destination Address Type l IPv4
l IPv6
l FQDN— destination FQDN type is only supported for LDAP and LDAPS
health check types.

Note:
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Parameter Guideline

For the LDAP or LDAPS health check types, if Verify Host Certificate is
enabled, the destination address type must match the CN in the LDAP/S
server certificate as either IP address or FQDN.
For example, if the CN in the LDAP/S server certificate is FQDN, then the
destination address in the health check configuration must be FQDN as well.

Destination Address The Destination Address option is available if Destination Address Type is
IPv4 or IPv6.
IP address to send health check traffic.
In server load balancing deployments, if you do not specify an IP address, the
real server IP address is used. You might configure IP address for a health
check if you are configuring a combination of health checks to poll related
servers.
In link load balancing deployments, if you do not specify an IP address, the
destination IP address is the address of the gateway. You can configure IP
address if you want to test connectivity to a beacon on the other side of the
gateway, or if you want to test whether service traffic is allowed to pass
through the link.

FQDN The FQDN option is available if Destination Address Type is FQDN.
Specify the destination FQDN (Fully Qualified Domain Name).

Hostname For HTTP or HTTPS health checks, you can specify the hostname (FQDN)
instead of the destination IP address. This is useful in VM environments where
multiple applications have the same IP address.

Interval Seconds between each health check. Should be more than the timeout to
prevent overlapping health checks. The default is 10.

Timeout Seconds to wait for a reply before assuming that the health check has failed.
The default is 5.

Up Retry Attempts to retry the health check to see if a down server has become
available. The default is 1.

Down Retry Attempts to retry the health check to see if an up server has become
unavailable. The default is 1.

6. Configure the Specifics settings as required.

Setting Guidelines

ICMP

No specific options Simple ping to test connectivity.

TCP Echo

No specific options Simple ping to test connectivity.

TCP / TCP Half Open Connection / UDP
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Setting Guidelines

Port Listening port number of the backend server. Usually HTTP is 80, FTP is 21, DNS is 53,
POP3 is 110, IMAP4 is 143, RADIUS is 1812, and SNMP is 161.

TCP SSL

Port Listening port number of the backend server. Usually HTTP is 80, FTP is 21, DNS is 53,
POP3 is 110, IMAP4 is 143, RADIUS is 1812, and SNMP is 161.

SSL Ciphers Default selections are recommended.

Local Cert For TCP SSL only. Click the down arrow and select a local SSL Health Check Client
certificate from the list menu. The certificate titled "Factory" is the default certificate
shipped with your FortiADC. The rest, if any, are the custom certificates that you have
created.

HTTP/HTTPS

Port Listening port number of the backend server. Usually HTTP is 80. If testing an HTTP proxy
server, specify the proxy port.

SSL Ciphers For HTTPS only. Default selections are recommended.

Local Cert For HTTPS only. See TCP / TCP Half Open Connection / TCP SSL / UDP above.

Http-version Specify the HTTP version

Additional-string Attach some string to HTTP header content

HTTP CONNECT If the real server pool members are HTTP proxy servers, specify an HTTP CONNECT
option:
l Local CONNECT—Use HTTP CONNECT to test the tunnel connection through the
proxy to the remote server. The member is deemed available if the request returns
status code 200 (OK).

l Remote CONNECT—Use HTTP CONNECT to test both the proxy server response
and remote server application availability. If you select this option, you can configure
an HTTP request within the tunnel. For example, you can configure an HTTP
GET/HEAD request to the specified URL and the expected response.

l No CONNECT—Do not use the HTTP CONNECTmethod. This option is the default.
The HTTP CONNECT option is useful to test the availability of proxy servers only.

See the FortiADC Deployment Guide for FortiCache for an example that uses this health
check.

Remote Host If you use HTTP CONNECT to test proxy servers, specify the remote server IP address.

Remote Port If you use HTTP CONNECT to test proxy servers, specify the remote server port.

Method Type HTTP method for the test traffic:
l HTTP GET—Send an HTTP GET request to the server. A response to an HTTP GET
request includes HTTP headers and HTTP body.

l HTTP HEAD—Send an HTTP HEAD request. A response to an HTTP HEAD request
includes HTTP headers only.

Send String The request URL, such as /contact.php.
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Receive String A string expected in return when the HTTP GET request is successful.

Status Code The health check sends an HTTP request to the server. Specify the HTTP status code in
the server reply that indicates a successful test. Typically, you use status code 200 (OK).
Other status codes indicate errors.

Match Type What determines a failed health check?
l Match String
l Match Status
l Match All (match both string and status)

Not applicable when using HTTP HEAD. HTTP HEAD requests test status code only.

DNS

Domain Name The FQDN, such as www.example.com, to use in the DNS A/AAAA record health check.

Address Type l IPv4
l IPv6

Host Address IP address that matches the FQDN, indicating a successful health check.

RADIUS / RADIUS Accounting

Port Listening port number of the backend server. Usually RADIUS is 1812 and RADIUS
accounting is 1813.

Username User name of an account on the backend server.

Password The corresponding password.

Password Type l User—If the backend server does not use CHAP, select this option.
l CHAP—If the backend server uses CHAP and does not require a secret key, select
this option.

Secret Key The secret set on the backend server.

NAS IP Address NAS IP address RADIUS attribute (if the RADIUS server requires this attribute to make a
connection).

SIP / SIP TCP

Port Specify the port number. Valid values range from 0 to 65535.

SIP Request Type Specify the SIP request type to be used for health checks:
l SIP Options
l SIP Register

Status Code The expected response code. If not set, response code 200 is expected. Specify 0 if any
reply should indicate the server is available.

SMTP

Port Listening port number of the backend server. Usually SMTP is 25.

Domain Name The FQDN, such as www.example.com, to use in the SMTP HELO request used for
health checks.
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If the response is OK (250), the server is considered as up. If there is error response (501)
or no response at all, the server is considered down.

POP3

Port Listening port number of the backend server. Usually POP3 is 110.

Username User name of an account on the backend server.

Password The corresponding password.

IMAP4

Port Listening port number of the backend server. Usually IMAP4 is 143.

Username User name of an account on the backend server.

Password The corresponding password.

Folder Select an email mailbox to use in the health check. If the mailbox does not exist or is not
accessible, the health check fails. The default is INBOX.

FTP

Port Listening port number of the backend server. Usually FTP is 21.

User name User name of an account on the backend server.

Password The corresponding password.

File Specify a file that exists on the backend server. Path is relative to the initial login path. If
the file does not exist or is not accessible, the health check fails.

Passive Select this option if the backend server uses passive FTP.

SNMP

Port Listening port number of the backend server. Usually SNMP is 161 or 162.

CPU Maximum normal CPU usage. If overburdened, the health check fails.

Memory Maximum normal RAM usage. If overburdened, the health check fails.

Disk Maximum normal disk usage. If the disk is too full, the health check fails.

Agent type l UCD
l Windows 2000

Community Must match the SNMP community string set on the backend server. If this does not match,
all SNMP health checks fail.

Version SNMP v1 or v2c.

CPU Weight 100

Memory Weight 100

Disk Weight 100
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SNMP Custom

Port Listening port number of the backend server. Usually SNMP is 161 or 162.

Community Must match the SNMP community string set on the backend server. If this does not match,
all SNMP health checks fail.

Version SNMP v1 or v2c.

SNMP Custom List

OID String specifying the OID to query

Value Type Abstract syntax notation (ASN) value type:
l ASN_INTEGER
l ASN_OCTET_STR
l ASN_OBJECT_ID
l ASN_COUNTER
l ASN_UINTEGER

SNMP Counter Specify the value for the evaluation. The range is 1-2147483647.

SNMP Compare l Equal
l Less
l Greater

Less is the default option.

Name Specify the SNMP custom name.

Weight Specify the SNMP custom weight.

SSH

Port Listening port number of the backend server. Usually SSH is 22.

Username Username for test login.

Password Corresponding password.

L2 Detection

No specific options Link Layer health checker. Sends ARP (IPv4) or NDP (IPv6) packets to test whether a
physically connected system is available.

RTSP

Port Specify the listening port number. Valid values range from 0 to 65535.

RTSP Method Type RTSP Options

Status Code 200

MySQL

Port Specify the listening port number of the MySQL server. Valid values range from 0 to
65535.
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Username Specify the database user name. (Optional)

Password Specify the database password, if applicable.

MySQL Server Type Select either of the following:
l Primary (Default)
l Secondary

Diameter

Origin Host Specify the FortiADC appliance that originates the Diameter message. The value is in
FQDN format and used to uniquely identify a Diameter node for duplicate connection and
routing loop detection.
Note: Some Diameter servers do not accept multiple connections from the same origin
host. If you set the origin host the same as the origin host (Identity) of the Diameter load-
balance profile and use the health check and Diameter load balance profile in the same
virtual server, the health check or the Diameter load-balance profile may run into certain
undefined problems.

Origin Realm Specify the realm of the FortiADC appliance that originates the Diameter message. The
value is in FQDN format.

Vendor ID Specify the type Unsigned32 vendor ID which contains the IANA "SMI Network
Management Private Enterprise Codes" value assigned to the vendor of a Diameter
application. The default is 12356.

Product Name Specify the type UTF8String product name which contains the vendor assigned name for
the product.

Host IPv4 Address Specify the type IPv4 address used to inform a Diameter peer of the sender's IP address
when the destination address type is IPv4. The default is blank, meaning that it is the
address of the FortiADC's outgoing interface.

Host IPv6 Address Specify the type IPv6 address used to inform a Diameter peer of the sender's IP address
when the destination address type is IPv6. The default is blank, meaning that it is the
address of the FortiADC's outgoing interface.

Auth Application ID Specify the type Unsigned32 authentication application ID used to advertise support of the
authentication and authorization portion of an application. This filed is optional; the default
is 0 (zero).

Acct Application ID Specify the type Unsigned32 accounting application ID used to advertise support of the
accounting portion of an application. This field is optional; the default is 0 (zero).

Oracle Note: Oracle DB HC only supports Hardware models in 5.1.0.

Port Listening port number of the OracleDB server.

Username Specify the database username.

Password Specify the database password.

Connect type Select one of the following:
l Service name
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l SID
l Connect string

Service name Use this to specify the service name.

SID Use this to specify the SID.

Connect String Use this to specify the connect string.

Oracle-send-string Send a string (command) to the OracleDb server.

Oracle-receive-
string

The string we accept in order to receive.

Row The row in which the send string (command) takes effect.

Column The column in which the send string (command) takes effect.

Script

Port Specify the port that the script uses

Script Specify the script which we create or which we have pre-defined

LDAP

Port Port Listening port number of the backend server. Usually LDAP is 389.

Password The corresponding password.

Attribute Attributes for the LDAP health check object.

BaseDN The distinguished name where a LDAP server will search from.

BindDN The distinguished name used to bind to a LDAP server.

Filter Criteria to use in selecting results.

MSSQL

Port Specify the listening port number of the MSSQL server. Valid values range from 0 to
65535.

Username Specify the database user name. (Optional)

Password Specify the database password, if applicable.

Database Specify the name of the MSSQL database.

MSSQL Send String Specify the MSSQL send string.

MSSQL Receive
String

Specify the MSSQL receive string.

Row The row in which the send string (command) takes effect.

Column The column in which the send string (command) takes effect.

LDAPS
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Port Port Listening port number of the backend server. The default port is 636 for LDAPS.

Password The corresponding password.

Bind DN The distinguished name where a LDAPS server will search from.

Base DN The distinguished name used to bind to a LDAPS server.

Filter Criteria to use in selecting results.

Attribute Attributes for the LDAPS health check object.

Verify Host
Certificate

Enable to verify the LDAPS server certificate. This is disabled by default.

CA The CA option is available if Verify Host Certificate is enabled.
Specify the CA certificate.

7. Click Save.
After the Health Check configuration is saved, you can select it in the SLB server pool, LLB link group, or GLB
server configuration.

In SLB deployments, a health check port configuration specifying port 0 acts as a
wildcard.The port for health check traffic is imputed from the real server pool
member.
In LLB and GLB deployments, specifying port 0 is invalid because there is no
associated configuration to impute a proper port. If your health check port
configuration specifies port 0, you will not be able to use it in an LLB or GLB
configuration.

Monitoring health check status

FortiADC enables you to monitor the health of servers in real time directly from your desktop, as described below.

Before you begin:

l You must have already created a Health Check configuration.

To configure a health check monitor:

1. Click Shared Resources > Health Check.
2. Click the Health Check Monitor tab.
3. Configure the health check monitor as described in Checking server health on page 311.
4. Click Start to perform the health check. The result will show in theMonitor Information.
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Parameter Description

IP Address Enter the IP address or FQDN of the remote server.

Health Check Select the health check configuration.

Direct Route Mode Enable/disable Direct Route Mode.

Real Server IP Specify the IP address.
Available only if Direct Route Mode is enabled.

Count Specify the count. Range is 1 - 1000 (default = 1).

Interval Specify the amount of time after the previous health check before this health
check executes, in seconds (1 - 3600, default = 5).

Timeout Specify the timeout period between health checks, in seconds (1 - 3600, default =
3).

Checking server health

Configuring health check scripts

You can upload or input scripting to run health check on FortiADC. When you set a new pool with the health check script,
health check will run this script periodically. The health check will then use the result of the script as its result.

The following should be noted when using the Health Check Script feature:

l The supported scripting type is shell script.
l Some commands, such as curl, and ping are supported.
l You should use a new root file-system to avoid the script accessing your current file-system.
l You should limit the quantity of the script and not allow too many scripts to run at the same time.

Before you begin:

l You should have knowledge of some basic concepts of shell scripting, such as variables, if/else statements, and
while loop.

To configure a health check script:

1. Go to Shared Resources > Health Check.
2. Click the Health Check Script tab.
3. Configure the health check script, as described below.

Settings Guidelines

Name Enter a unique name for the health check script.
After you initially save the configuration, you cannot edit the name.

Input Type or paste the script.

4. Click Save.
5. Go back to the Health Check tab. Create a new health check configuration and select one of the health check scripts

you created.
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Predefined Health Check Scripts

The following table describes the predefined health check scripts. You can get started with these or create custom
scripts.

Predefined script Usage

CURL_HTTP_CODE Uses curl to check the status of server

ICMP Uses ping to check the status of server

PORT_STATUS Uses nc to check status of a port on server.

Health Check Script programs and commands

The following table describes the predefined commands.

Predefined commands Usage

$NODE_IP The IP address of real server.

$NODE_PORT The port of the real server.

$UP: Sets the status of health check to UP.

$DOWN: Sets the status of health check to DOWN.

The following programs and commands can be used in the health check script:

• hostname
• ipcalc
• stty
• usleep
• busybox
• curl
• ed
• nmeter
• xargs
• tail
• basename
• dirname
• expr
• killall
• mkfif
• pwdx
• shred
• split
• traceroute6

• cat
• date
• egrep
• ifconfig
• iplink
• ln
• mktemp
• nameif
• ping6
• rm
• sleep
• true
• base64
• chmod
• dns domain
name
• fgrep
• ip

• ls
• mount
• netstat
• printenv
• rmdir
• stat
• umount
• bash
• cp
• echo
• grep
• ipaddr
• kill
• mkdir
• mpstat
• pidof
• ps
• sed
• uniq
• uptime

• link
• mknod
• mv
• ping
• pwd
• slattach
• touch
• vconfig
• adduser
• arping
• fakeidentd
• inetd
• killall5
• nbd-client
• powertop
• pmap
• pstree
• iproute
• telnet

• seq
• sort
• sum
• test
• tr
• truncate
• unix2dos
• wc
• yes
• cmp
• dos2unix
• find
• lsof
• nc
• nslookup
• pgrep
• printf

• time
• traceroute
• tty
• unlink
• whoami
• awk
• diff
• du
• flock
• md5sum
• netcat
• passwd
• pkill
• pscan
• realpath
• smemcap
• ssl_client
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Schedule Group

From the Shared Resources > Schedule Group sub-menu, you can create schedule objects to use in link load
balancing policies. A policy rule can be time-bound: one time, daily, weekly, or monthly.

Basic Steps

1. Create a schedule object.
2. Select the schedule when you configure the link policy.

Before you begin:

l You must have Read-Write permission for System settings.

To create schedule objects:

1. Go to Shared Resources > Schedule Group.
2. Click Create New to display the configuration editor.
3. Give the schedule a name, save it, and add schedule members as described in Schedule member configuration on

page 313.
4. Save the configuration.

Settings Guidelines

Name Unique group name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces.
After you initially save the configuration, you cannot edit the name.

Member

Name Unique member name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces.
After you initially save the configuration, you cannot edit the name.

Type l One Time
l Daily
l Weekly
l Monthly

Start Date YYYY/MM/DD.

End Date YYYY/MM/DD.

Start Time HH:MM.

End Time HH:MM.

Schedule member configuration

Address

The Shared Resources > Address sub-menu includes the following topics:
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l Configuring IPv4 address groups on page 314
l Creating IPv4 address objects on page 315
l Configuring IPv6 address groups on page 315
l Creating IPv6 address objects on page 316
l Managing ISP address books on page 317

Configuring IPv4 address groups

You can configure IPv4 address group objects when you have more than one IPv4 address object you want to specify in
rules that match source or destination addresses. For example, if you subscribe user 1 and user 2 to a group of links,
then you can create rules that match the user 1 OR user 2 address space and load balance the set of gateways assigned
to them.

The following policies use IPv4 address groups:

l Link load balancing policies

Basic Steps

1. Create IPv4 address objects.
2. Configure IPv4 address group objects. You can add up to 256 members in a group.
3. Select the IPv4 address groups when you configure your policies.

Before you begin:

l You must have Read-Write permission for System settings.

To configure an IPv4 address group:

1. Go to Shared Resources > Address.
The configuration page displays the Address Group tab.

2. Click Create New to display the configuration editor.
3. Complete the configuration as described in Address Group configuration on page 314.
4. Click Save.

Settings Guidelines

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces.
After you initially save the configuration, you cannot edit the name.

Member List

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces.
After you initially save the configuration, you cannot edit the name.

Address Select an address object.

Address Group configuration
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Creating IPv4 address objects

You can create IPv4 address objects to specify matching source and destination addresses in policies.

The following policies use IPv4 address objects:

l Firewall policies
l QoS policies
l Connection limit policies
l Link load balancing policies

Note: For link load balancing, you can also add address objects to address groups, which can then be used in link load
balance policies.

Basic Steps

1. Create IPv4 address objects.
2. Select them when you configure address groups or policies.

Before you begin:

l You must have Read-Write permission for System settings.

To create an IPv4 address object:

1. Go to Shared Resources > Address.
2. Click the Address tab.
3. Click Create New to display the configuration editor.
4. Complete the configuration as described in Address object configuration on page 315.
5. Click Save.

Settings Guidelines

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces.
After you initially save the configuration, you cannot edit the name.

Type l IPv4/Netmask
l Address Range

IPv4/Netmask Specify a subnet using the IPv4 address/mask notation.

Address Range Specify the start and end of an address range.

Address object configuration

Configuring IPv6 address groups

You can configure IPv6 address group objects when you have more than one IPv6 address object you want to specify in
rules that match source or destination addresses. For example, if you subscribe user 1 and user 2 to a group of links,
then you can create rules that match the user 1 OR user 2 address space and load balance the set of gateways assigned
to them.
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The following policies use IPv6 address groups:

l Link load balancing policies

Basic Steps

1. Create IPv6 address objects.
2. Configure IPv6 address group objects. You can add up to 256 members in a group.
3. Select the IPv6 address groups when you configure your policies.

Before you begin:

l You must have Read-Write permission for System settings.

To configure an address group:

1. Go to Shared Resources > Address.
2. Click the IPv6 Address Group tab.
3. Click Add to display the configuration editor.
4. Complete the configuration as described in Address Group configuration on page 316.
5. Click Save.

Settings Guidelines

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces.
After you initially save the configuration, you cannot edit the name.

Member List

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces.
After you initially save the configuration, you cannot edit the name.

Address Select an address object.

Address Group configuration

Creating IPv6 address objects

You can create IPv6 address objects to specify matching source and destination addresses in policies.

The following policies use IPv6 address objects:

l Firewall policies
l QoS policies
l Connection limit policies
l Link load balancing policies

Note: For link load balancing, you can also add address objects to address groups, which can then be used in link load
balance policies.
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Basic Steps

1. Create IPv6 address objects.
2. Select them when you configure address groups or policies.

Before you begin:

l You must have Read-Write permission for System settings.

To create an IPv6 address object:

1. Go to Shared Resources > Address.
2. Click the IPv6 Address tab.
3. Click Create New to display the configuration editor.
4. Complete the configuration as described in IPv6 Address object configuration on page 317.
5. Click Save.

Settings Guidelines

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces.
After you initially save the configuration, you cannot edit the name.

Type l IPv6/Netmask
l Address Range

IPv6/Netmask Specify a subnet using the IPv6 address/mask notation.

Address Range Specify the start and end of an address range.

IPv6 Address object configuration

Managing ISP address books

ISP address books contain IP subnet addresses and associated province location settings for ISP links.

The following policies use the ISP address book objects:

l ISP routes
l LLB proximity routes
l LLB policies
l GLB data center configuration

The province setting is used in GLB deployments in China to enable location awareness that is province-specific. For
example, a user can be directed to a data center in specific location inside the country, such as Beijing or Guangdong,
rather than simply China.

ISP address book types on page 318 shows the three types of address book entries:

l Predefined—Addresses and associated province location settings for China Mobile, China Telecom, and China
Unicom. The IP subnet addresses in the predefined address books are not exposed in the user interface. The
predefined package is provided to make it easier for you to configure a route when all you know and all you need to
know is the name of the ISP that hosts the link.
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l Restored—Addresses imported from a text file. The IP subnet addresses in the restored address books are not
exposed in the user interface. “Restored” addresses can help you rapidly build an ISP address book configuration.

l User-defined—In the ISP address configuration, you can modify the predefined and restored address books by
specifying subnets to add or exclude from them. This gives you flexibility in case you encounter address conflicts or
the ISP instructs you to add a subnet address manually.

You can also create new user-defined entries for other ISPs.

Note: In systems with multiple VDOMs, these commands apply to the current VDOM only. In other words, if you
configure an exclusion, it is applicable to the current VDOM only; it does not change the predefined address book.

You can use the Inquire utility to see whether an IP address belongs to any of the address books. If an address can be
found in more than one address book, the results are returned in the following priority:

1. User-defined
2. Restored
3. Predefined

ISP address book types

The text file for the Restored entries has the following format:

#this is a comment line
ISP name:ABC
Province:Beijing
1.1.1.0/24
Province:Unknown
2.2.0.0 255.255.0.0
#this is a comment line too
3.3.3.3/32
ISP name:DEF
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Province:Shanghai
4.4.4.0 255.255.255.0
5.5.0.0/16

You use the Restore utility to import the file and the Back Up utility to export it. This operation will back up the current
restored ISP address books, however, it does not back up the predefined addresses or user-configured entries.

You use the Clean utility to erase entries that were imported from the text file. This operation will erase the current
restored ISP address books, however, it does not affect the predefined addresses or user-configured entries. If a
restored entry has user-configured elements (for example, an exclude list), the clean operation clears the addresses but
preserves the configuration and converts it to a user-defined type.

Basic Steps

1. Create ISP address objects.
2. Select them when you configure your policies.

Before you begin:

l You must have Read-Write permission for System settings.

Create an ISP address book object

To create an ISP address book object:

1. Click Shared Resource > Address.
2. Click the ISP Address tab.
3. Click Create New. The ISP Address dialog opens.
4. Complete the configuration as described in ISP address object configuration on page 319.
5. Click Save.

Settings Guidelines

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces.
After you initially save the configuration, you cannot edit the name.

Address Address/mask notation specifying a subnet to add it to the address book entry.

Excluded Address Address/mask notation specifying a subnet to be excluded from the address book entry.
Create exclusions to predefined and restored address books only.
Note: This field applies to predefined and restored address books only; it is not
applicable or available for user-defined address books.

ISP address object configuration
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Settings Guidelines

Province Select the associated province location. The configuration supports the following
selections:

Anhui
Beijing
Chongqing
Fujian
Gansu
Guangdong
Guangxi
Guizhou
Hainan
Hebei
Heilongjiang

Henan
Hubei
Hunan
Jiangsu
Jiangxi
Jilin Liaoning
Neimenggu
Ningxia
Qinghai
Shandong
Shanghai

Shanxi (Taiyuan)
Shanxi (Xian)
Sichuan
Tianjin
Xianggang
Xinjiang
Xizang
Yunnan
Zhejiang
Unknown

Service

The Shared Resources > Service sub-menu includes the following topics:

l Creating service groups on page 320
l Creating service objects on page 321

Creating service groups

You can configure service group objects when you have more than one service you want to specify in a rule that matches
services. You can group all Web services and group all mail services, for example, if you want to have rules that treat
those as groups.

The following policies use service groups:

l Link load balancing policies

Basic Steps

1. Create service objects.
2. Configure service group objects. You can add up to 256 members in a group.
3. Select the service groups when you configure your policies.

Before you begin:

l You must have Read-Write permission for System settings.
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To configure a service group:

1. Go to Shared Resources > Service.
The configuration page displays the Service Group tab.

2. Click Create New to display the configuration editor.
3. Complete the configuration as described in Service Group configuration on page 321.
4. Save the configuration.

Settings Guidelines

Name Specify a unique name for the service group configuration. Valid characters are A-Z, a-z, 0-9, _,
and -. No spaces.
After you initially save the configuration, you cannot edit the name.

Member List

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces.
After you initially save the configuration, you cannot edit the name.

Service Select a service object.

Service Group configuration

Creating service objects

FortiADC provides more than two dozen predefined services, as shown on the Shared Resources > Service > Service
page. In addition, it allows you to create your service objects.

Service objects are an important part of the following policy configurations:

l Firewall policies
l QoS policies
l Connection limit policies
l Link load balancing policies

Note: For link load-balancing, you can also add service objects to service groups; then use service groups in LLB
policies.

Basic Steps

1. Create service objects.
2. Select them when you configure service groups or policies.

Before you begin:

l You must have Read-Write permission for System settings.

To create a service object:

1. Go to Shared Resources > Service.
2. Select the Service tab.
3. Click Create New to display the configuration editor.
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4. Complete the configuration as described in Service object configuration on page 322.
5. Save the configuration.

Settings Guidelines

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces.
Note: Once created, the name cannot be changed.

Protocol Type Select one of the following:
l ip (default)
l icmp
l tcp
l udp
l tcp-and-udp
l sctp

Protocol 1
Note: This applies only when Protocol Type is to set to IP. In that case, it displays the protocol
number without port.

Specify Source Port This option becomes available when TCP, UDP, SCTP, or TCP-AND-UDP is selected as the
protocol type. When selected, you also need to specify the Minimum Source Port and
Maximum Source Port below.

Minimum Source
Port

1

Maximum Source
Port

65535

Minimum Destination
Port

1

Maximum
Destination Port

-65535

Service object configuration
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Server Load Balance

As an advanced application delivery controller (ADC), FortiADC supports load balancing for your application servers to
enhance application availability and performance. After you have deployed the FortiADC, the traffic can be routed to the
FortiADC virtual server and distributed among the destination real servers. To optimize server response times and
server capacity, FortiADC can assign traffic based on various load-balancing algorithms and health checks to ensure
application availability.

FortiADC's Server Load Balance functionality is supported by the following core modules that work in tandem to load-
balance your application servers:

l Virtual Server on page 328— The Virtual Server module contains configurations to define the application delivery
control, wherein three classes are supported: Layer 7, Layer 4, and Layer 2.

l Application Resources on page 374— The Application Resources module contains configurations to define the
protocols and load-balancing methods that will be used to distribute traffic.

l Application Optimization on page 439— The Application Optimization module contains tools to further optimize
application response times and server capacity, such as defining compression and caching rules.

l Real Server Pool on page 448— The Real Server Pool module contains configurations to define the destination
real servers to direct the traffic.

Additional functionality such as HTTP scripting and SSL Forward Proxy is offered for advanced customization of your
load-balancing needs.

l Scripting on page 464— Lua scripting is supported for HTTP/HTTPS applications to perform actions that are not
supported by the current built-in feature set.

l SSL-FP Resources on page 474— FortiADC offers resources to support SSL Forward Proxy functionality, such as
SSL decryption exceptions using L2 Exception Lists andWeb Filtering, and Certificate Caching to enhance
performance.

 Basic network topology on page 323 illustrates an example of a basic load balancing deployment. The FortiADC
appliance is deployed in front of a server farm, where the network interfaces are connected to three subnets: 1) a subnet
for management traffic; 2) a subnet that hosts the real servers A, B, and C; and 3) a different subnet that hosts the real
servers D, e, and F. In this topology, the FortiADC system performs health checks on the real servers and distributes
traffic to them according to the system logic and user-defined settings.

 Basic network topology
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Optionally, you can further improve application security and performance by offloading system processes from the
server and having them handled transparently by the ADC. Server tasks that can be handled by the FortiADC appliance
include SSL encryption/decryption, WAF protection, Gzip compression, and routing processes, such as NAT.
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The  FortiADC processing for application using HTTP on page 325 illustrates the order in which the FortiADC features
process Client-to-Server and Server-to-Client traffic in an HTTP application server.

FortiADC processing for application using HTTP
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In the Client-to-Server direction:

1. If the SNI or SSL decryption is applicable, the system acts on those exchanges.
2. The security module rules filter the traffic. If the traffic is not dropped, it will continue to the virtual server module.
3. The virtual server security features are applied. If the traffic is not dropped, it will continue for further processing until

it is forwarded to the server.
a. If a caching rule applies, the FortiADC cache serves the content and the request will not be forwarded to a

backend server.
b. If the system selects a destination server based on a persistence rule, content route, or script, then the load-

balancing rules will not be applied.
c. After selecting a server, the system performs any rewriting and re-encryption actions that are applicable, and

then forwards the packets to the server.

In the Server-to-Client direction:

1. The server traffic reaches the virtual server where the WAF HTTP response, rewriting, persistence, and caching
rules are applied.

2. If applicable, the FortiADC compresses and encrypts the server response traffic and forwards the packets to the
client.

Server load balancing configuration overview

The FortiADC server load-balancing configuration framework is designed to be modular to support the granularity of the
FortiADC application delivery control rules. This allows you to tailor configurations based on traffic type by specifying
different options and rules for each type.

FortiADC provides a wide range of configuration options that allow you to customize your server load-balancing to your
desired use-case. Many predefined options and configurations are also available to help you get started on load-
balancing your application server. Be aware that some configurations and options are minimally required to run server
load-balancing.

The steps below describes the basic configuration workflow for server load-balancing:

1. Configure health check rules and real server SSL profiles. For details, see Configuring health checks on page 300
and Configuring real server SSL profiles on page 457.
This step is optional if you intend to use predefined health check rules and predefined real server SSL profiles.
However, if you do intend to use custom health check rules and real server SSL profiles, ensure to configure them
before you configure the pools of real servers.

2. Configure real server pools. For details, see Using real server pools on page 448.
This step is required. Server pools are the backend servers you want to load balance and specify the health checks
used to determine server availability.

3. Configure persistence rules, optional features and policies, profile components, and load balancing methods. These
configurations are all contained under the Application Resources module. For details, see Application Resources on
page 374.
This step is optional if you intend to use predefined persistence rules, profiles, and methods.

4. Configure the virtual server. For details, see Configuring virtual servers on page 328.
This step is required. In your virtual server configuration, you define the load-balancing rules by specifying the class
of application delivery control (Layer 7, Layer 4, or Layer 2), and the persistence rules, profiles, and load-balancing

FortiADC Handbook 327
Fortinet Technologies Inc.



Server Load Balance

methods to use to assign traffic. You can reference predefined or custom defined objects configured in previous
steps.

Example workflow

For a members-only HTTPS web server farm, you may have a workflow similar to the following:

1. Configure security module firewall rules that allow only HTTPS traffic from untrusted subnets to the virtual server.
2. Import server SSL certificates, configure a local certificate group, and a certificate verification policy.
3. Configure HTTPS health checks to test the availability of the web servers.
4. Configure the server pools, referencing the health check configuration object.
5. Configure authentication:

l Create a RADIUS or LDAP server configuration.
l Create user groups.
l Create an authentication policy.

6. Configure an HTTPS profile, referencing the certificate group and certificate verification policy and setting SSL
version and cipher requirements.

7. Configure an application profile and client SSL profile if needed.
8. Configure the virtual server, using a combination of predefined and user-defined configuration objects:

l Predefined: WAF policy, Persistence, Method
l User-defined: Authentication Policy, Profile

Virtual Server

The Server Load Balance > Virtual Server sub-menu allows you to perform the following tasks relating to virtual
server:

l Configuring virtual servers on page 328
l Using content rewriting rules on page 339
l Configuring content routes on page 353
l Using source pools on page 357
l Using schedule pools on page 370
l Using clone pools on page 371

Configuring virtual servers

The virtual server configuration supports three classes of application delivery control:

l Layer 7—Persistence, load balancing, and routing are based on Layer-7 objects, such as HTTP headers, cookies,
and so on.

l Layer 4—Persistence, load balancing, and network address translation are based on Layer-4 objects, such as
source and destination IP addresses.

l Layer 2—This feature is useful when the request’s destination IP is unknown and you need to load-balance
connections among multiple next-hop gateways.
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Before you begin:

l You must have a deep understanding of the backend servers and your load-balancing objectives.
l You must have configured a real server pool and other configuration objects that you can incorporate into the virtual
server configuration, such as persistence rules, user-defined profiles, content routes and rewriting rules, error
messages, authentication policies, and source IP address pools if you are deploying NAT.

l You must have Read-Write permission for load-balance configurations.

Unlike virtual IPs on FortiGate or virtual servers on FortiWeb, virtual servers on
FortiADC are activated as soon as you have configured them and set their status to
Enable. You do not need to apply them by selecting them in a policy.

Two Options for virtual server configuration

FortiADC provides two options for configuring virtual servers—Basic Mode and Advanced Mode.

In Basic Mode, you are required to specify only the basic parameters needed to configure a virtual server. FortiADC
automatically configures those advanced parameters using the default values when you click the Save button. The Basic
Mode is for less experienced users who may not have the skills required to configure the advanced features on their
own.

The Advanced Mode, on the other hand, is ideal for experienced or "power" users who are knowledgeable and
comfortable enough to configure all the advanced features, in addition to the basic ones, on their own.

All virtual servers you have added, whether they are configured through Basic Mode or Advanced Mode, end up on the
Load Balance > Virtual Server page. You can view the configuration details of a virtual server by clicking the entry.

Basic virtual server configuration

This option is used mostly for beginners who have less experience with FortiADC.

To configure a virtual server using Basic Mode:

1. Go to Server Load Balance > Virtual Server.
The configuration page displays the Virtual Server tab.

2. Click Create New > Basic Mode to open the Basic Mode configuration editor.
3. Complete the configuration as described in Virtual server configuration Basic Mode on page 329.
4. Click Save.

Settings Guidelines

Name Specify a unique name for the virtual server configuration object. Valid characters are A-Z, a-
z, 0-9, _, and -. No space is allowed. This name appears in reports and in logs as the SLB
“policy”.
Note: Once saved, the name of a virtual server configuration cannot be changed

Application Select an application from the list menu:
l Microsoft SharePoint Application
l Microsoft Exchange Server Application

Virtual server configuration Basic Mode
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Settings Guidelines

l IIS
l Apache
l Windows Remote Desktop
l HTTPS H2
l HTTPS H2C
l HTTP(S)
l TCPS
l HTTP Turbo
l RADIUS
l DNS
l SIP
l TCP
l UDP
l FTP
l IP
l RTSP
l RTMP
l SMTP
l DIAMETER
l ISO8583
l L7 TCP
l L7 UDP

Address Specify the IP address provisioned for the virtual server.

Port Accept the default port number (80) or specify a port , ports, or a range of ports of your
preference.
Note: The virtual server will use the specified port or ports to listen for client requests. You
can specify up to eight ports or port ranges separated by space. Valid values are from 0 to
65535. Port 0 applies to Layer-4 virtual servers only,

Interface Select a network interface from the list menu, or specify a new one.

Real Server Pool Select a real server pool (if you have one already configured) or create a new one.

SSL Applicable to HTTP(S) applications only.
Note: SSL is disabled by default, you must check the check box to enable it. Once SSL is
enabled, you must select an profile from the Client SSL Profile drop-down menu below.

Client SSL Profile Note: This setting applies to HTTPS, TCPS, HTTP2 H2, and SMTP applications only. In the
case of HTTPS, it becomes available only when SSL is enabled.
Select a client SSL profile from the drop-down menu.

Protocol Note: This setting becomes available only when Application is set to IP.
Enter up to eight numeric values or value ranges corresponding to the protocols you'd like to
use, separated by space.

Domain Name Note: This field becomes available only when Application is set to SMTP.
Specify the FQDN.
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Advanced virtual server configuration

This option is used mostly by advanced users of FortiADC.

To configure a virtual server using the Advanced Mode:

1. Go to Server Load Balance > Virtual Server.
The configuration page displays the Virtual Server tab.

2. Click Create New > Advanced Mode to display the Advanced Mode configuration editor.
The settings for Advanced Mode are separated into tabs to configure specific virtual server functionality.
l Basic
l General
l Security
l SSL Traffic Mirror (only available for Layer 7 HTTPS and TCPS server load-balancing profiles)
l Application Optimization (only available for Layer 7 HTTP and HTTPS server load-balancing profiles)
l Monitoring

3. Configure and save the settings in the Basic tab.

Setting Description

Name Enter a unique name for the virtual server. Valid characters are A-Z, a-z, 0-9,
_, and -. No space is allowed. This name appears in reports and in logs as the
SLB “policy”.
Note:Once you have saved the configuration, you cannot edit the virtual
server name.

Type l Layer 7— Persistence, load balancing, and routing are based on Layer-7
objects, such as HTTP headers, cookies, and so on.

l Layer 4— Persistence, load balancing, and network address translation
are based on Layer-4 objects, such as source and destination IP
addresses.

l Layer 2— This feature is useful when the request’s destination IP is
unknown and you need to load-balance connections among multiple next-
hop gateways.

Depending on your Type selection, the Layer 7, Layer 4, or Layer 2 Specifics
configuration section will appear.

Status l Enable — The virtual server can receive new sessions.
l Disable — The server does not receive new sessions and closes any
current sessions as soon as possible.

l Maintain — The server does not receive new sessions, but maintains its
current connections.

Address Type l IPv4
l IPv6

Note: IPv6 is not supported for FTP, HTTP Turbo, RDP, or SIP profiles.

Comment A string used to describe the purpose of the configuration
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a. If the Type is Layer 7, configure the following Layer 7 Specifics settings:

Setting Description

Schedule Pool Enable/disable the Schedule Pool. This is disabled by default.
Note: If Schedule Pool is enabled, Content Routing becomes unavailable.

Schedule Pool List The Schedule Pool List option appears if Schedule Pool is enabled.
Select the schedule pool(s) and arrange them in a desired order.

Content Routing Enable/disable the Content Routing. This is disabled by default.
Note:
l When content routing is enabled, FortiADC will route packets to
backend servers based on IP address (Layer-4 content) or HTTP
header (Layer-7 content).

l Content-routing rules override static or policy routes.
l This option does NOT apply to SIP profiles.

Content Routing List The Content Routing List option appears if Content Routing is enabled.
Select the content-routing rules and arrange them in a desired order.
Note:
You can select multiple content routing rules in virtual server configuration.
Rules that you add are checked from top to bottom. The first rule to match
is applied. If the traffic does not match any of the content-routing rule
conditions specified in the virtual server configuration, the system will show
some unexpected behaviors. Therefore, it is important that you create a
“catch-all” rule that has no match conditions. In the virtual server
configuration, this rule should be ordered last so it can be used to forward
traffic to a default pool.
See Configuring content routes.

Content Rewriting Enable/disable the Content Rewriting. This is disabled by default.
Note:
l This option applies to Layer-7 only.
l This option does NOT apply to SIP profiles.

Content Rewriting List The Content Rewriting List option appears if Content Rewriting is
enabled.
Select the content rewriting rules and arrange them in a desired order.
Note: You can select multiple content rewriting rules in the virtual server
configuration. Rules that you add are consulted from top to bottom. The
first rule to match is applied. If the traffic does not match any of the content
rewriting rule conditions, the header is not rewritten.
See Using content rewriting rules.

NAT Source Pool List Select one or more source pool configuration objects and arrange them in
a desired order. See Using source pools.
Note:
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Setting Description

By default, the same IP pool cannot be set up in different virtual servers.
However, you can enable IP address sharing through the CLI to allow the
source pool to be set up in different virtual servers.
To enable IP address sharing:
config system global

set share-ip-address enable
end

Transaction Rate Limit Note: This setting applies to Layer-7 virtual servers only. It is not supported
for HTTP Turbo profiles.
Set a limit to the number of HTTP requests per second that the virtual
server can process. Valid values are from 0 to 1,048,567. The default is 0
(disabled).
The system counts each client HTTP request against the limit. When the
HTTP request rate exceeds the limit, the virtual server sends an HTTP 503
error response to the client.

b. If the Type is Layer 4, configure the following Layer 4 Specifics settings:

Setting Description

Schedule Pool Enable/disable the Schedule Pool. This is disabled by default.
Note: If Schedule Pool is enabled, Content Routing becomes unavailable.

Schedule Pool List The Schedule Pool List option appears if Schedule Pool is enabled.
Select the schedule pool(s) and arrange them in a desired order.

Content Routing Enable/disable the Content Routing. This is disabled by default.
Note:
l When content routing is enabled, FortiADC will route packets to
backend servers based on IP address (Layer-4 content) or HTTP
header (Layer-7 content).

l Content-routing rules override static or policy routes.
l This option does NOT apply to SIP profiles.

Content Routing List The Content Routing List option appears if Content Routing is enabled.
Select the content-routing rules and arrange them in a desired order.
Note:
You can select multiple content routing rules in virtual server configuration.
Rules that you add are checked from top to bottom. The first rule to match
is applied. If the traffic does not match any of the content-routing rule
conditions specified in the virtual server configuration, the system will show
some unexpected behaviors. Therefore, it is important that you create a
“catch-all” rule that has no match conditions. In the virtual server
configuration, this rule should be ordered last so it can be used to forward
traffic to a default pool.
See Configuring content routes.

Packet Forwarding Method Note: This setting applies to Layer-4 virtual servers only.
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Setting Description

Select one of the following packet forwarding methods:
l Direct Routing— Forwards the source and destination IP addresses
with no changes.
Note: For FTP profiles, when Direct Routing is selected, you must also
configure a persistence method.

l DNAT—Replaces the destination IP address with the IP address of
the backend server selected by the load balancer.

The destination IP address of the initial request is the IP address of the
virtual server. Be sure to configure FortiADC as the default gateway on the
backend server so that the reply goes through FortiADC and can also be
translated.
l Full NAT—Replaces both the destination and source IP addresses.
IPv4 to IPv4 or IPv6 to IPv6 translation.

l Tunneling— (For Layer-4 IPv4 virtual servers) Allows FortiADC to
send client requests to real servers through Layer-4 IP tunnels. See
Layer-4 Virtual server IP tunneling on page 1.

l NAT46— (If Address Tpye is IPv4) Replaces both the destination and
source IP addresses, translating IPv4 addresses to IPv6 addresses.

l NAT64— (If Address Type is IPv6) Replaces both the destination and
source IP addresses, translating IPv6 addresses to IPv4 addresses.

For Full NAT, NAT46, and NAT64, the source IP address is replaced by an
IP address from the pool you specify. The destination IP address is
replaced with the IP address of the backend server selected by the load
balancer

NAT Source Pool List If you are configuring a Layer 4 virtual server and enable Full NAT or
NAT46, select one or more source pool configuration objects. See Using
source pools.
Note:
By default, the same IP pool cannot be set up in different virtual servers.
However, you can enable IP address sharing through the CLI to allow the
source pool to be set up in different virtual servers.
To enable IP address sharing:
config system global

set share-ip-address enable
end

c. If the Type is Layer 2, configure the following Layer 2 Specifics settings:

Setting Description

Schedule Pool Enable/disable the Schedule Pool. This is disabled by default.
Note: If Schedule Pool is enabled, Content Routing becomes unavailable.

Schedule Pool List The Schedule Pool List option appears if Schedule Pool is enabled.
Select the schedule pool(s) and arrange them in a desired order.

Content Routing Enable/disable the Content Routing. This is disabled by default.
Note:
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Setting Description

l When content routing is enabled, FortiADC will route packets to
backend servers based on IP address (Layer-4 content) or HTTP
header (Layer-7 content).

l Content-routing rules override static or policy routes.
l This option does NOT apply to SIP profiles.

Content Routing List The Content Routing List option appears if Content Routing is enabled.
Select the content-routing rules and arrange them in a desired order.
Note:
You can select multiple content routing rules in virtual server configuration.
Rules that you add are checked from top to bottom. The first rule to match
is applied. If the traffic does not match any of the content-routing rule
conditions specified in the virtual server configuration, the system will show
some unexpected behaviors. Therefore, it is important that you create a
“catch-all” rule that has no match conditions. In the virtual server
configuration, this rule should be ordered last so it can be used to forward
traffic to a default pool.
See Configuring content routes.

4. Configure and save the settings in theGeneral tab.

Setting Description

Configuration

Address Enter the IP address provisioned for the virtual server.
Note:
You do not specify an IP address for a Layer 2 virtual server. A Layer 2 virtual
server is not aware of IP addresses. Instead of routing data for a specific
destination, this type of server simply forwards data from the specified network
interface and port.

Port Accept the default port or specify a port, ports, or port ranges of your
preference.
Note: The virtual server will use the specified port or ports to listen for client
requests. You can specify up to eight ports or port ranges separated by space.
Valid values are from 0 to 65535. Port 0 applies to Layer-4 virtual servers only,
The port range option is useful in deployments where it is desirable to have a
virtual IP address with a large number of virtual ports, such as data centers or
web hosting companies that use port number to identify their specific
customers.
Statistics and configurations are applied to the virtual port range as a whole
and not to the individual ports within the specified port range.
Note: If a Layer 2 virtual server is assigned a network interface that uses port
80 or 443, ensure that the HTTPS and HTTP administrative access options
are not enabled for the interface. Setting a port range is not supported for FTP,
HTTP Turbo, RADIUS, or Layer 2 TCP profiles.
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Setting Description

Connection Limit Set a limit to the number of concurrent connections. The default is 0 (disabled).
Valid values are from 1 to 100,000,000.
You can apply a connection limit per real server and per virtual server. Both
limits are enforced. Attempted connections that are dropped by security rules
are not counted.
Note: This feature is NOT supported for FTP or SIP profiles.

Connection Rate Limit This option is available if Layer 4 is selected as the Type in the Basic settings.
With Layer 4 profiles you can limit the number of new connections per second.
The default is 0 (disabled). Valid values are from 1 to 86,400.
You can apply a connection rate limit per real server and per virtual server.
Both limits are enforced. Attempted connections that are dropped by security
rules are not counted.
Note: Not supported for FTP profiles.

Interface Network interface that receives client traffic for this virtual server.

Resources

Profile Select a predefined or user-defined profile configuration object. See
Configuring Application profiles.
Note: Only TCP, UDP and IP profiles are available for Layer 2 VS Type with
IPv6 Address.

Client SSL Profile Note: This setting applies to HTTPS, TCPS, HTTP2 H2, SMTP, and FTPS
applications only. In the case of HTTPS, it becomes available only when SSL
is enabled.
Select a client SSL profile from the drop-down menu.
Note: If a ZTNA Profile is referenced in the VS, ensure the client SSL profile
has enabled client certificate verification for the corresponding EMS CA
certificate object. See Configuring Client SSL profiles on page 412.

Persistence Select a predefined or user-defined persistence configuration object. See
Configuring persistence rules.
Note: The persistence rule withMatch Across Virtual Servers enabled
works only with L4 virtual servers or the L7 virtual server whose profile is LB_
PROF_RADIUS.

Method Select a predefined or user-defined method configuration object. See
Configuring load-balancing (LB) methods on page 423.

Real Server Pool Select a real server pool configuration object. See Configuring real server
pools.
Note: For Layer 2 VS Type, the available real server pools are dependent on
the Address (IPv4 or IPv6) selected in Basic settings.

Clone Pool Select a configuration object. See Configuring a clone pool on page 372.
Note: This option is not available if the VS Type is Layer 2 and Address is
IPv6.
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Setting Description

Auth Policy This option is available if Layer 7 is selected as the Type in the Basic settings.
Select an authentication policy configuration object. HTTP/HTTPS only.
See Authentication Policy.

Scripting This option is available only if Scripting is enabled AND if Layer 7 is selected
as the Type in the Basic settings.
Select the scripting object(s) and arrange them in a desired order.
Note:
FortiADC allows you to combine multiple individual scripts into one combined
script so that you can execute them all at once. In that situation, you can set
the order in which the scripts are executed by assigning the scripts with
different priorities. For more information, see Support for multiple scripts.

AD FS Published Service This option is available if Layer 7 is selected as the Type in the Basic settings.
Select an AD FS configuration object. HTTPS only.
See AD FS Proxy on page 750.

L2 Exception List This option is available if Layer 2 is selected as the Type in the Basic settings
AND an HTTP/HTTPS server load-balancing profile is selected.
Select an exception configuration object. See Configuring an L2 Exception
List.

HTTP Redirect to HTTPS This option becomes available when an HTTPS server load-balancing profile
is selected.
Enable/disable HTTP redirect to HTTPS. This option is disabled by default.
If enabled, it opens HTTP service on an HTTPS virtual server which
redirects traffic to an HTTP virtual server.

Redirect Service Port This option becomes available when HTTP Redirect to HTTPS is enabled.
You can either accept the default port (80), or specify up to eight ports or
ranges of ports of your preference.

Error Page (This section is only available for Layer 7 virtual servers)

Error Page Select an error page configuration object. See Configuring error pages.
Note: Not supported for SIP profiles.

Error Message If you do not use an error page, you can enter an error message to be returned
to clients in the event no server is available. Maximum 1023 bytes.
Note: Not supported for SIP profiles.

FortiGSLB (This section is not available for Layer 2 virtual servers)

Public IP Type Set the Public IP type for the virtual server as either IPv4 or IPv6.

Public IPv4/IPv6 Enter the virtual server public IP address.

One Click GSLB Server Enable/disable the FortiGSLB One Click GSLB server.

Host Name The Host Name option is available ifOne Click GSLB Server is enabled.
Enter the hostname part of the FQDN, such as www.
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Setting Description

Note: You can specify the@ symbol to denote the zone root. The value
substitute for @ is the preceding $ORIGIN directive.

Domain Name The Domain Name option is available ifOne Click GSLB Server is enabled.
The domain name must end with a period. For example, example.com.

5. Configure and save the settings in the Security tab. The security settings available are dependent on the virtual
server type selected in Basic settings and the server load-balancing profile inGeneral settings.

Setting Description

WAF Profile Select a WAF profile configuration object or create a new one.
See Configuring a WAF Profile.

AV Profile Select an existing AV profile from the drop-down menu or create a new one.
AV profile can support HTTP/HTTPS/SMTP.
See Creating an AV profile on page 679.

DoS Protection Profile Select a DoS protection profile configuration object or create a new one.
See DoS Protection Profile on page 704.

Captcha Profile Select a Captcha configuration object.
See Configuring Captcha on page 438.

ZTNA Profile Note: This setting applies to Layer 7 HTTPS and TCPS applications only.
Select a ZTNA Profile object.
See Configuring a ZTNA Profile on page 702

6. Configure and save the settings in the SSL Traffic Mirror tab.
Note: The SSL Traffic Mirror settings are only accessible if Layer 7 is selected as the Type in the Basic settings AND
an HTTPS or TCPS server load-balancing profile is selected in General settings.

Setting Description

SSL Traffic Mirror Enable/disable SSL Traffic Mirror.

Mirror To TheMirror To field appears when SSL Traffic Mirror is enabled.
Select the ports from the list of Available Items.

7. Configure and save the settings in the Application Optimization tab.
Note: The Application Optimization settings are only accessible if Layer 7 is selected as the Type in the Basic
settings AND an HTTP or HTTPS server load-balancing profile is selected in General settings.

Setting Description

Page Speed Select a page speed optimization profile.

8. Configure and save the settings in theMonitoring tab.

Setting Description

Traffic Log Enable/disable to record traffic logs for this virtual server.
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Setting Description

Note: Local logging is constrained by available disk space. We recommend
that if you enable traffic logs, you monitor your disk space closely. We also
recommend that you use local logging during evaluation and verification of
your initial deployment, and then configure remote logging to send logs to a log
management repository.

FortiView Enable/disable to view this virtual server from FortiView.

WCCP TheWCCP option is only available for Layer 7 virtual servers.
Enable/disable Web Cache Communications Protocol.

Using content rewriting rules

This section includes the following topics:

l Overview
l Configuring content rewriting rules
l Example: Redirecting HTTP to HTTPS
l Example: Rewriting the HTTP response when using content routing
l Example: Rewriting the HTTP request and response to mask application details
l Example: Rewriting the HTTP request to harmonize port numbers

Overview

You might rewrite the HTTP request/response and HTTP headers for various reasons, including the following:0

l Redirect HTTP to HTTPS
l External-to-internal URL translation
l Other security reasons

HTTP header rewriting on page 339 summarizes the HTTP header fields that can be rewritten.

Direction HTTP Header

HTTP Request l Host
l Referer

HTTP Redirect Location

HTTP Response Location

HTTP header rewriting

The first line of an HTTP request includes the HTTP method, relative URL, and HTTP version. The next lines are
headers that communicate additional information. The following example shows the HTTP request for the URL
http://www.example.com/index.html:

GET /index.html HTTP/1.1

Host: www.example.com

Referer: http://www.google.com
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The following is an example of an HTTP redirect including the HTTP Location header:

HTTP/1.1 302 Found

Location: http://www.iana.org/domains/example/

You can use literal strings or regular expressions to match traffic to rules. To match a request URL such as
http://www.example.com/index, you create two match conditions: one for the Host header www.example.com and
another for the relative URL that is in the GET line: /index.html.

For HTTP redirect rules, you can specify the rewritten location as a literal string or as a regular expression. For all other
types or rules, you must specify the complete URL as a literal string.

Configuring content rewriting rules

Before you begin:

l You must have a good understanding of HTTP header fields.
l You must have a good understanding of Perl-compatible regular expressions (PCRE) if you want to use them in rule
matching or rewriting.

l You must have Read-Write permission for Load Balance settings.

After you have configured a content rewriting rule, you can select it in the virtual server configuration.

Note: You can select multiple content rewriting rules in the virtual server configuration. Rules you add to that
configuration are consulted from top to bottom. The first to match is applied. If the traffic does not match any of the
content rewriting rule conditions, the header is not rewritten.

To configure a content rewriting rule:

1. Go to Server Load Balance > Virtual Server.
2. Click the Content Rewriting tab.
3. Click Create New to display the configuration editor.
4. Complete the configuration as described in Content rewriting rule guidelines on page 340.
5. Save the configuration.

Settings Guidelines

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces. You reference
this name in the virtual server configuration.
Note: After you initially save the configuration, you cannot edit the name.

Comments A string to describe the purpose of the configuration, to help you and other administrators
more easily identify its use.

Action Type Select whether to rewrite the HTTP request or HTTP response.

HTTP Request Rewrite Actions

Rewrite HTTP
Header

Host—Rewrites the Host header by replacing the hostname with the string you specify. For
Host rules, specify a replacement domain and/or port.

Content rewriting rule guidelines
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Settings Guidelines

URL—Rewrites the request URL and Host header using the string you specify. For URL rules,
specify a URL in one of the following formats:
l Absolute URL— https://example.com/content/index.html
l Relative URL— content/index.html

If you specify a relative URL, the host header is not rewritten.
Referer—Rewrites the Referer header with the URL you specify. For Referer rules, you must
specify an absolute URL.
Note: The rewrite string is a literal string. Regular expression syntax is not supported.

Redirect Sends a redirect with the URL you specify in the HTTP Location header field.
For Redirect rules, you must specify an absolute URL. For example:
https://example.com/content/index.html

Note: The rewrite string can be a literal string or a regular expression.

Send 403 Forbidden Sends a 403 Forbidden response instead of forwarding the request.

Add HTTP Header Adds user-defined HTTP header in content-rewriting rules in HTTP request.
Header Name—Specify the HTTP header name
Header Value—Specify the HTTP header value
Note:
l The HTTP header name and value must conform to RFC 2616.
l The HTTP header and value must conform to PCRE regular expression.
l This feature works with HTTP and HTTPS server load-balance profiles only.

Delete HTTP Header Deletes user-defined HTTP header in content-rewriting rules in HTTP request.
Header Name—See above.
Header Value—See above
Note: See above.

HTTP Response Rewrite Actions

Rewrite HTTP
Location

Rewrites the Location header field in the server response.
For Location rules, you must specify an absolute URL. For example:
https://example.com/content/index.html

Note: The rewrite string is a literal string. Regular expression syntax is not supported.

Add HTTP Header Adds user-defined HTTP header in content-rewriting rules in HTTP response.
Note: Refer to HTTP Request Rewrite Actions > Add HTTP Header above.

Delete HTTP Header Deletes user-defined HTTP header in content-rewriting rules in HTTP response.
Note: Refer to HTTP Request Rewrite Actions > Delete HTTP Header above.

Match Condition

Object Select content matching conditions based on the following parameters:
l HTTP Host Header
l HTTP Location Header
l HTTP Referer Header
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Settings Guidelines

l HTTP Request URL
l Source IP Address

Note: When you add multiple conditions, FortiADC joins them with an AND operator. For
example, if you specify both a HTTP Host Header and HTTP Request URL to match, the rule
is a match only for traffic that meets both conditions.

Type l String
l Regular Expression

Content Specify the string or PCRE syntax to match the header or IP address.

Reverse Rule matches if traffic does not match the expression.

Example: Redirecting HTTP to HTTPS

You can use the content rewriting feature to send redirects. One common case to use redirects is when the requested
resource requires a secure connection, but you accidentally type an HTTP URL instead of an HTTPS URL in the web
browser.

For HTTP redirect rules, you can specify the rewritten location as a literal string or regular expression.

Redirecting HTTP to HTTPS (literal string) on page 342 shows a redirect rule that matches a literal string and rewrites a
literal string. In the match condition table, the rule is set to match traffic that has the Host header domain example.com
and the relative URL /resource/index.html in the HTTP request URL. The redirect action sends a secure URL in
the Location header: https://example.com/resource/index.html.

Redirecting HTTP to HTTPS (literal string)

Regular expressions are a powerful way of denoting all possible forms of a string. They are very useful when trying to
match text that comes in many variations but follows a definite pattern, such as dynamic URLs or web page content.
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Redirecting HTTP to HTTPS (regular expression) on page 343 shows a redirect rule that uses PCRE capture and back
reference syntax to create a more general rule than the previous example. This rule sends a redirect for all connections
to the same URL but over HTTP. In the match condition table, the first regular expression is (.*). This expression
matches any HTTP Host header and stores it as capture 0. The second regular expression is ^/(.*)$. This expression
matches the path in the Request URL (the content after the /) and stores it as capture 1. The regular expression for the
redirect action uses the back reference syntax https://$0/$1.

Redirecting HTTP to HTTPS (regular expression)

Common PCRE syntax elements on page 343 describes commonly used PCRE syntax elements.

PCRE examples submitted to the FortiGate Cookbook on page 346 gives examples of useful and relevant expressions
that were originally submitted to the FortiGate Cookbook. For a deeper dive, consult a PCRE reference.

Regular expressions can involve very computationally intensive evaluations. For
best performance, you should only use regular expressions where necessary, and
build them with care.

Pattern Usage Example

() Creates a capture group or sub-pattern for
back-reference or to denote order of
operations.

Text: /url/app/app/mapp
Regular expression: (/app)*
Matches: /app/app
Text: /url?paramA=valueA&paramB=valueB
Regular expression: (param)A=
(value)A&\0B\1B

Common PCRE syntax elements
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Pattern Usage Example

Matches: paramA=valueA&paramB=valueB

$0, $1, $2, ... Only $0, $1,..., $9 are supported.
A back-reference is a regular expression
token such as $0 or $1 that refers to whatever
part of the text was matched by the capture
group in that position within the regular
expression.
Back-references are used whenever you
want the output/interpretation to resemble the
original match: they insert a substring of the
original matching text. Like other regular
expression features, back-references help to
ensure that you do not have to maintain a
large, cumbersome list of all possible URLs.
To invoke a substring, use $n (0 <= n <= 9),
where n is the order of appearance of capture
group in the regular expression, from left to
right, from outside to inside, then from top to
bottom.

Let’s say the regular expressions in a
condition table have the following capture
groups:
(a)(b)(c(d))(e)
This syntax results in back-reference
variables with the following values:
$0—a
$1—b
$2—cd
$3—d
$4—e

\ Escape character.
Except, if it is followed by an alphanumeric
character, the alphanumeric character is not
matched literally as usual. Instead, it is
interpreted as a regular expression token.
For example, \w matches a word, as defined
by the locale.
Except, if it is followed by regular expression
special character:
*.|^$?+\(){}[]\
When this is the case, the \ escapes
interpretation as a regular expression token,
and instead treats the character as a normal
letter.
For example, \\ matches the \ character.

Text: /url?parameter=value
Regular expression: \?param
Matches: ?param

. Matches any single character except \r or \n.
Note: If the character is written by combining
two Unicode code points, such as à where
the core letter is encoded separately from the
accent mark, this will notmatch the entire
character: it will only match one of the code
points.

Text:My cat catches things.
Regular expression: c.t
Matches: cat cat
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Pattern Usage Example

+ Repeatedly matches the previous character
or capture group, 1 or more times, as many
times as possible (also called “greedy”
matching) unless followed by a question
mark ( ? ), which makes it optional.
Does not match if there is not at least 1
instance.

Text: www.example.com
Regular expression: w+
Matches: www
Would also match “w”, “ww”, “wwww”, or any
number of uninterrupted repetitions of the
character “w”.

* Repeatedly matches the previous character
or capture group, 0 or more times. Depending
on its combination with other special
characters, this token could be either:
* —Match asmany times as possible (also
called “greedy” matching).
*? —Match as few times as possible (also
called “lazy” matching).

Text: www.example.com
Regular expression: .*
Matches: www.example.com
All of any text, except line endings (\r and
\n).
Text: www.example.com
Regular expression: (w)*?
Matches: www
Would also match common typos where the
“w” was repeated too few or too many times,
such as “ww” in w.example.com or “wwww” in
wwww.example.com. It would still match,
however, if no amount of “w” existed.

? Makes the preceding character or capture
group optional (also called “lazy” matching).
This character has a different significance
when followed by =.

Text: www.example.com
Regular expression: (www\.)?example.com
Matches: www.example.com
Would also match example.com.

?= Looks ahead to see if the next character or
capture group matches and evaluate the
match based upon them, but does not include
those next characters in the returned match
string (if any).
This can be useful for back-references where
you do not want to include permutations of
the final few characters, such as matching
“cat” when it is part of “cats” but not when it is
part of “catch”.

Text: /url?parameter=valuepack
Regular expression: p(?=arameter)
Matches: p, but only in “parameter, not in
“pack”, which does not end with “arameter”.

^ Matches either:
the position of the beginning of a line (or, in
multiline mode, the first line), not the first
character itself
the inverse of a character, but only if ^ is the
first character in a character class, such as
[^A]

Text: /url?parameter=value
Regular expression: ^/url
Matches: /url, but only if it is at the beginning
of the path string. It will notmatch “/url” in
subdirectories.
Text: /url?parameter=value
Regular expression: [^u]
Matches: /rl?parameter=value
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Pattern Usage Example

This is useful if you want to match a word, but
only when it occurs at the start of the line, or
when you want to match anything that is not a
specific character.

$ Matches the position of the end of a line (or,
in multiline mode, the entire string), not the
last character itself.

[] Defines a set of characters or capture groups
that are acceptable matches.
To define a set via a whole range instead of
listing every possible match, separate the
first and last character in the range with a
hyphen.
Note: Character ranges are matched
according to their numerical code point in the
encoding. For example, [@-B]matches any
UTF-8 code points from 40 to 42 inclusive:
@AB

Text: /url?parameter=value1
Regular expression: [012]
Matches: 1
Would also match 0 or 2.
Text: /url?parameter=valueB
Regular expression: [A-C]
Matches: B
Would also match “A” or “C”. It would not
match “b”.

{} Quantifies the number of times the previous
character or capture group may be repeated
continuously.
To define a varying number repetitions,
delimit it with a comma.

Text: 1234567890
Regular expression: \d{3}
Matches: 123
Text: www.example.com
Regular expression: w{1,4}
Matches: www
If the string were a typo such as “ww ” or
“wwww”, it would also match that.

(?i) Turns on case-insensitive matching for
subsequent evaluation, until it is turned off or
the evaluation completes.

Text: /url?Parameter=value
Regular expression: (?i)param
Matches: Param
Would also match pArAM etc.

| Matches either the character/capture group
before or after the pipe ( | ).

Text: Host: www.example.com
Regular expression: (\r\n)|\n|\r
Matches: The line ending, regardless of
platform.

Regular Expression Usage

[a-zA-Z0-9] Any alphanumeric character. ASCII only; e.g. does not match é or É.

[#\?](.*) All parameters that follow a question mark or hash mark in the URL.

PCRE examples submitted to the FortiGate Cookbook
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Regular Expression Usage

e.g. #pageView or ?param1=valueA&param2=valueB...;
In this expression, the capture group does not include the question
mark or hash mark itself.

\b10\.1\.1\.1\b A specific IPv4 address.

\b(25[0-5]|2[0-4][0-9]|[01]?[0-9][0-9]?)
\.(25[0-5]|2[0-4][0-9]|[01]?[0-9][0-9]?)
\.(25[0-5]|2[0-4][0-9]|[01]?[0-9][0-9]?)
\.(25[0-5]|2[0-4][0-9]|[01]?[0-9][0-9]?)
\b

Any IPv4 address.

(?i)\b.*\.(a(c|d|e(ro)?|f|g|i|m|n|o|q|r|s
(ia)?|t|y|w|x|z)
|b(a|b|d|e|f|g|h|i(z)?|j|m|n|o|r|s|t|v|w|y|z)
|c(a(t)?|c|d|f|g|h|i|k|l|m|n|o((m)?
(op)?)|r|s|u|v|x|y|z)
|d(e|j|k|m|o|z)
|e(c|du|e|g|h|r|s|t|u)
|f(i|j|k|m|o|r)
|g(a|b|d|e|f|g|h|i|l|m|n|ov|p|q|r|s|t|u|w|y)
|h(k|m|n|r|t|u)
|i(d|e|l|m|n(fo)?(t)?|o|q|r|s|t)
|j(e|m|o(bs)?|p)
|k(e|g|h|i|m|n|p|r|w|y|z)
|l(a|b|c|i|k|r|s|t|u|vy)
|m(a|c|d|e|g|h|il|k|l|m|n|o(bi)?|p|q|r|s|t|u
(seum)?|v|w|x|y|z)
|n(a(me)?|c|e(t)?|f|g|i|l|o|p|r|u|z)
|o(m|rg)
|p(a|e|f|g|h|k|l|m|n|r(o)?|s|t|w|y)
|qa
|r(e|o|s|u|w)
|s(a|b|c|d|e|g|h|i|j|k|l|m|n|o|r|s|t|u|v|y|z)
|t(c|d|el|f|g|h|j|k|l|m|n|o|p|r(avel)?|t|v|w|z)
|u(a|g|k|s|y|z)
|v(a|c|e|g|i|n|u)
|w(f|s)
|xxx
|y(e|t|u)
|z(a|m|w))\b

Any domain name.

(?i)\bwww\.example\.com\b A specific domain name.

(?i)\b(.*)\.example\.com\b Any sub-domain name of example.com.

Example: Rewriting the HTTP response when using content routing

It is standard for web servers to have external and internal domain names. You can use content-based routing to forward
HTTP requests to example.com to a server pool that includes server1.example.com, server2.example.com, and
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server3.example.com. When you use content routing like this, you should also rewrite the Location header in the HTTP
response so that the client receives HTTP with example.com in the header and not the internal domain
server1.example.com.

Rewriting the HTTP response when masking internal server names on page 348 shows an HTTP response rule that
matches a regular expression and rewrites a literal string. In the match condition table, the rule is set to match the regular
expression server.*\.example\.com in the HTTP Location header in the response. The rewrite action specifies the
absolute URL http://www.example.com.

Rewriting the HTTP response when masking internal server names

Example: Rewriting the HTTP request and response to mask application details

Another use case for external-to-internal URL translation involves masking pathnames that give attackers information
about your web applications. For example, the unmasked URL for a blog might be
http://www.example.com/wordpress/?feed=rss2, which exposes that the blog is a wordpress application. In this case,
you want to publish an external URL that does not have clues of the underlying technology. For example, in your web
pages, you create links to http://www.example.com/blog instead of the backend URL.

On FortiADC, you create two rules: one to rewrite the HTTP request to the backend server and another to rewrite the
HTTP response in the return traffic.

Rewriting the HTTP request when you mask backend application details on page 349 shows an HTTP request rule. In
the match condition table, the rule is set to match traffic that has the Host header domain example.com and the
relative URL /blog in the HTTP request URL. The rule action rewrites the request URL to the internal URL
http://www.example.com/wordpress/?feed=rss2.
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Rewriting the HTTP request when you mask backend application details

Rewriting the HTTP response when you mask backend application details on page 349 shows the rule for the return
traffic. In the match condition table, the rule is set to match traffic that has the string
http://www.example.com/wordpress/?feed=rss2 in the Location header of the HTTP response. The action
replaces that URL with the public URL http://www.example.org.

Rewriting the HTTP response when you mask backend application details

Example: Rewriting the HTTP request to harmonize port numbers

The HTTP Host header contains the domain name and port. You might want to create a rule to rewrite the port so you
can harmonize port numbers that are correlated with your application service. For example, suppose you want to avoid
parsing reports on your backend servers that show requests to many HTTP service ports. When you review your
aggregated reports, you have records for port 80, port 8080, and so on. You would rather have all HTTP requests served
on port 80 and accounted for on port 80. To support this plan, you can rewrite the HTTP request headers so that all the
Host header in all HTTP requests shows port 80.
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Rewriting the HTTP request port number on page 350 shows an HTTP request rule that uses a regular expression to
match HTTP Host headers for www.example.com with any port number and change it to port 80.

Rewriting the HTTP request port number

HSTS and HPKP support

Starting from its 4.8.1 release, FortiADC supports HSTS and HPKP to offer enhanced web security to its users.

HSTS

HSTS, or HTTP Strict Transport Security, is a web security mechanism used to guard websites against
malicious attacks, such as protocol downgrading and cookie hijacking. Once implemented, HSTS enables the web
server to force web browsers to use secure HTTPS connections when interacting with it, and prohibit the use of insecure
HTTP connections.

An HSTS-enabled web application server communicates its HSTS policy to web browsers via an HTTPS header field
called "Strict-Transport-Security". The policy dictates that web browsers should only connect to the server via a secure
connection during the period of time (i.e., max-age) specified in the policy. Based on the HSTS policy, compliant web
browsers either automatically convert insecure (i.e., HTTP) connections to secure (i.e., HTTPS) ones or show an error
message and bar the user from accessing the server if it cannot ensure the security of the connection.

HSTS is used to address SSL/TSL-stripping attacks and prevent hackers from stealing your cookie-based web login
credentials.

HSTS syntax:

l Strict-Transport-Security: max-age=<expire-time> [; includeSubDomains][; preload]
l Preload validation and registration:
l https://www.chromium.org/hsts

l https://hstspreload.org
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HPKP

HPKP, or HTTP Public Key Pinning, is a web security mechanism used to prevent HTTPS websites from impersonation
via mis-issued or fraudulent security certificates.

The first time a client browser accesses an HTTPS web application server, the server sends to the client a set of public
keys, which are the only ones that should be trusted for connections to the domain. This list of "pinned" public key
hashes are used for subsequent connections between the client and the server, and are valid only for the period of time
that is specified in the HPKP policy.

HPKP syntax

l Public-Key-Pins: pin-sha256="<pin-value>"; pin-sha256=“<backup-pin-value>”; max-
age=expireTime [; includeSubDomains][; report-uri="reportURI"]

l Public-Key-Pins-Report-Only: pin-sha256="<pin-value>"; pin-sha256=“<backup-pin-value>”;
max-age=<expire-time> [; includeSubDomains][; report-uri="<uri>“]

HPKP note and validation

l Note a host as the known pinned host:
l Identified only by its domain name, but never IP
l Three conditions:

l PKP received over an error-free TLS, including possible HPKP validation
l At least one intersection
l The host must set a backup pin.

l Pin Validation:
l Ignore superfluous certificates
l Check intersection, at least one
l Can be disabled for some hosts according to local policy

Good HPKP practices

l If used incorrectly, HPKP could lock out users for a long period of time. Using backup certificates and/or pinning the
CA certificate is recommended.

l Use small value for max-age.
l When a certificate expires, generate a new certificate using the old key if pinning is done on the server certificate.

HPKP calculation

Use the following OpenSSL commands to calculate HPKP fingerprints:

l openssl rsa -in my-rsa-key-file.key -outform der -pubout | openssl dgst -sha256 -
binary | openssl enc -base64

l openssl ec -in my-ecc-key-file.key -outform der -pubout | openssl dgst -sha256 -
binary | openssl enc -base64

l openssl req -in my-signing-request.csr -pubkey -noout | openssl pkey -pubin -
outform der | openssl dgst -sha256 -binary | openssl enc -base64
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l openssl x509 -in my-certificate.crt -pubkey -noout | openssl pkey -pubin -outform
der | openssl dgst -sha256 -binary | openssl enc -base64

l openssl s_client -servername www.example.com -connect www.example.com:443 | openssl
x509 -pubkey -noout | openssl pkey -pubin -outform der | openssl dgst -sha256 -
binary | openssl enc -base64

Implementation of HSTS/HPKP

Support for HSTS and HPKP can be implemented for both SSL offloading and forward proxy.

SSL offloading

On the Server Load Balance>Virtual Server>Content Rewriting page, do the following:

1. (Optional) Add a content rewriting rule to delete the HSTS or HPKP header received from the real server. Skip this
step if the real server did not send any HSTS or HPKP header. See Delete HTTP header (optional) on page 352.

2. Add one content rewriting to add an HSTS or HPKP header, customize the max-age and other optional fields. See
Add HTTP header on page 353.

Delete HTTP header (optional)
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Add HTTP header

Forward proxy

On the Server Load Balance>Virtual Server>Content Rewriting page, do the following:

1. (Optional) Add a content rewriting rule to delete the HSTS or HPKP header received from the real server. Skip this
step if the real server did not send any HSTS or HPKP header.

2. Do nothing to HSTS header (let it pass through).

Configuring content routes

You can use the content routes configuration to select the backend server pool based on matches to TCP/IP or HTTP
header values.

Layer 7 content route rules are based on literal or regular expression matches to the following header values:

l HTTP Host
l HTTP Referer
l HTTP Request URL
l SNI
l Source IP address

You might want to use Layer 7 content routes to simplify front-end coding of your web pages or to obfuscate the precise
server names from clients. For example, you can publish links to a simple URL named example.com and use content
route rules to direct traffic for requests to example.com to a server pool that includes server1.example.com,
server2.example.com, and server3.example.com.

Layer 4 content route rules are based on literal or regular expression matches to the following header values:

l Source IP address

Before you begin:

l You must have a good understanding of HTTP header fields.
l You must have a good understanding of Perl-compatible regular expressions (PCRE) if you want to use them in rule
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matching.
l You must have Read-Write permission for Load Balance settings.

After you have configured a content routing rule, you can select it in the virtual server configuration.

Note: You can select multiple content routing rules in the virtual server configuration. Rules you add to that configuration
are consulted from top to bottom. The first rule to match is applied. If the traffic does not match any of the content routing
rule conditions specified in the virtual server configuration, the system behaves unexpectedly. Therefore, it is important
that you create a “catch all” rule that has no match conditions. In the virtual server configuration, this rule should be
ordered last so it can be used to forward traffic to a default pool.

To configure a content route rule:

1. Go to Server Load Balance > Virtual Server.
2. Click the Content Routing tab.
3. Click Create New to display the configuration editor.
4. Enter a name for the Content Routing configuration and select the Type:

Setting Description

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces.
You reference this name in the virtual server configuration.
Note: After you initially save the configuration, you cannot edit the name.

Type l Layer 4
l Layer 7

The content routing settings applicable to the selected Type displays.
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5. If the Type is Layer 7, configure the following settings.
a. Configure the General settings:

Setting Description

Schedule Pool Enable to select a schedule pool for content routing. This is disabled by
default.

Schedule Pool List The Schedule Pool List option is available if Schedule Pool is enabled.
Select the schedule pool objects.

Real Server Pool The Real Server Pool option is available if Schedule Pool is disabled.
Select the real server pool configuration.

Persistence The Persistence option is configurable if Inherit (Persistence) is
disabled.
Select a session persistence type if not inheriting persistence from the
virtual server.

Inherit (Persistence) Enable to use the persistence object specified in the virtual server
configuration. This is enabled by default.

Method TheMethod option is configurable if Inherit (Method) is disabled.
Select a load balancing method type if not inheriting method from the
virtual server.

Inherit (Method) Enable to use the method specified in the virtual server configuration.

b. Click Save to commit the General settings to the Content Routing configuration.
Once the configuration is saved, the Match Condition (Empty Match Condition will match anything) section
becomes configurable.

c. Under the Match Condition (Empty Match Condition will match anything) section, click Create New to display
the configuration editor.
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d. Configure the Match Condition (Empty Match Condition will match anything) settings:

Setting Description

Object Select content matching conditions based on the following parameters:
l HTTP Host Header
l HTTP Referer Header
l HTTP Request URL
l Source IP Address
l SNI

Note: When you add multiple conditions, FortiADC joins them with an AND
operator. For example, if you specify both a HTTP Host Header and HTTP
Request URL to match, the rule is a match only for traffic that meets both
conditions.

Type The Type option is not available ifObject is Source IP Address.
l String
l Regular Expression

Content Specify the string or PCRE syntax to match the header or IP address.
Note: An empty match condition matches any HTTP request.

Negative Enable to rule matches if traffic does not match the expression. This is
disabled by default.

Ignore Case The Ignore Case option is not available ifObject is Source IP Address.
Enable to allow users to let the match be case sensitive. This is enabled by
default.

e. Click Save to commit the Match Condition configuration and exit from the editor.
6. If the Type is Layer 4, configure the following settings.

a. Configure the Specifics settings:

Setting Description

Source (IPv4) Address/mask notation to match the source IPv4 address in the packet
header.

Source (IPv6) Address/mask notation to match the source IPv6 address in the packet
header.

b. Configure the General settings:

Setting Description

Schedule Pool Enable to select a schedule pool for content routing. This is disabled by
default.

Schedule Pool List The Schedule Pool List option is available if Schedule Pool is enabled.
Select the schedule pool objects.

Real Server Pool The Real Server Pool option is available if Schedule Pool is disabled.
Select the real server pool configuration.
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Setting Description

Persistence The Persistence option is configurable if Inherit (Persistence) is
disabled.
Select a session persistence type if not inheriting persistence from the
virtual server.

Inherit (Persistence) Enable to use the persistence object specified in the virtual server
configuration. This is enabled by default.

Method TheMethod option is configurable if Inherit (Method) is disabled.
Select a load balancing method type if not inheriting method from the
virtual server.

Inherit (Method) Enable to use the method specified in the virtual server configuration.

Packet Forward Method Select the packet forwarding method:
l Inherit
l Full NAT

Source Pool List The Source Pool List option is available if Packet Forward Method is
Full NAT.
Select the source pool objects for packet forwarding.

7. Save the configuration.
Once saved, the new Content Routing configuration will be listed in the Content Routing page.

Using source pools

This topic includes a procedure for configuring the source IP address pools used in NAT, and examples of NAT
deployments. It includes the following sections:

l Configuring source pools
l Example: DNAT
l Example: full NAT
l Example: NAT46 (Layer 4 virtual servers)
l Example: NAT64 (Layer 4 virtual servers)
l Example: NAT46 (Layer 7 virtual servers)
l Example: NAT64 (Layer 7 virtual servers)

Configuring source pools

You use the Source Pool page to create configuration objects for source IP addresses used for NAT in Layer 4 virtual
server configurations.

In a Layer 4 virtual server configuration, you select a “packet forwarding method” that includes the following network
address translation (NAT) options:

l Direct Routing—Does not rewrite source or destination IP addresses.
l DNAT—Rewrites the destination IP address for packets before it forwards them.
l Full NAT—Rewrites both the source and destination IP addresses. Use for standard NAT, when client and server IP
addresses are all IPv4 or all IPv6.
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l NAT46—Rewrites both the source and destination IP addresses. Use for NAT 46, when client IP addresses are
IPv4 and server IP addresses are IPv6.

l NAT64—Rewrites both the source and destination IP addresses. Use for NAT 64, when client IP addresses are
IPv6 and server IP addresses are IPv4.

In a Layer 7 virtual server configuration, you do not select a packet forwarding option. Layer 7 virtual servers use NAT46
and NAT64 to support those traffic flows, but they do not use the Source Pool configuration.

See the examples that follow the procedure for illustrated usage.

Before you begin:

l You must have a good understanding of NAT. You must know the address ranges your network has provisioned for
NAT.

l Be sure to configure the backend servers to use the FortiADC address as the default gateway so that server
responses are also rewritten by the NAT module.

l You must have Read-Write permission for Load Balance settings.

After you have configured a source pool IP address range configuration object, you can select it in the virtual server
configuration. You can assign a virtual server multiple source pools (with the same or different source pool interface
associated with it).

There are no validation checks for duplicate addresses in the NAT source pool for
HA synchronization, SNAT, 1-to-1 NAT, and VIP, as the ha-mgmt-ip is not
synchronized between the HA nodes. For these configurations, ensure the starting
and ending IPs in the address range of the NAT source pool are not duplicates.

To configure a source pool:

1. Go to Server Load Balance > Virtual Server.
2. Click the NAT Source Pool tab.
3. Click Create New to display the configuration editor.
4. Complete the configuration as described in Source pool configuration on page 358.
5. Save the configuration.

Settings Guidelines

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces. You reference
this name in the virtual server configuration.
Note: After you initially save the configuration, you cannot edit the name.

Interface Interface to receive responses from the backend server. The interface used for the initial client
traffic is determined by the virtual server configuration.

Address Type l IPv4
l IPv6

Address Range The first address in the address pool.

To The last address in the address pool.

Source pool configuration
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Settings Guidelines

Node Member

Name Create a node member list to be used in an HA active-active deployment. In an active-active
deployment, node interfaces are configured with a list of IP addresses for all nodes in the
cluster. You use this configuration to provision SNAT addresses for each of the nodes.
Name is a configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces. You
reference this name in the virtual server configuration.
Note: After you initially save the configuration, you cannot edit the name.

Pool Type IPv4 or IPv6.

Minimum IP The first address in the address pool.

Maximum IP The last address in the address pool.

Interface Interface to receive responses from the backend server. The interface used for the initial client
traffic is determined by the virtual server configuration.

HA Node Number Specify the HA cluster node ID.

Example: DNAT

 Destination NAT on page 359 illustrates destination NAT (DNAT). The NAT module rewrites only the destination IP
address. Therefore, if you configure destination NAT, you do not need to configure a source pool. In this DNAT example,
the destination IP address in the packets it receives from the client request is the IP address of the virtual server—
192.168.1.101. The NAT module translates this address to the address of the real server selected by the load
balancer—in this example, 192.168.2.1. The systemmaintains this NAT table and performs the inverse translation when
it receives the server-to-client traffic.

 Destination NAT
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Example: full NAT

 Full NAT on page 361 illustrates full NAT. The source IP / destination IP pair in the packets received is SRC 192.168.1.1
/ DST 192.168.1.101. The NAT module translates the source IP address to the next available address in the source
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pool—in this example, 192.168.2.101. It translates the destination IP address to the address of the real server selected
by the load balancer—in this example, 192.168.2.1.

The systemmaintains this NAT table and performs the inverse translation when it receives the server-to-client traffic.

 Full NAT
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Example: NAT46 (Layer 4 virtual servers)

 NAT46 (Layer 4 virtual servers) on page 362 illustrates full NAT with NAT46. The IPv6 client connects to the virtual
server IPv4 address. The source IP / destination IP pair in the packets received is SRC 192.168.1.1 / DST
192.168.1.101. The NAT module translates the source IP address to the next available IPv6 address in the source
pool—in this example, 2002::2:1001. It translates the destination IP address to the IPv6 address of the real server
selected by the load balancer—in this example, 2002::2:1.

The systemmaintains this NAT table and performs the inverse translation when it receives the server-to-client traffic.

 NAT46 (Layer 4 virtual servers)
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Features Notes

Profile Not Supported: FTP

ICMP ICMP traffic is dropped.

Limitations: NAT46 (Layer 4 virtual servers)

Example: NAT64 (Layer 4 virtual servers)

 NAT64 (Layer 4 virtual servers) on page 364 illustrates full NAT with NAT64. The IPv6 client connects to the virtual
server IPv6 address. The source IP / destination IP pair in the packets received is SRC 2001::1:1 / DST 2001::1:101. The
NAT module translates the source IP address to the next available IPv4 address in the source pool—in this example,
192.168.2.101. It translates the destination IP address to the IPv4 address of the real server selected by the load
balancer—in this example, 192.168.2.1.

The systemmaintains this NAT table and performs the inverse translation when it receives the server-to-client traffic.

 NAT64 (Layer 4 virtual servers)
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Features Notes

Profiles Not Supported: FTP

ICMP ICMP traffic is dropped.

Security Not Supported: IP Reputation, DoS protection, Security logs and reports

Limitations: NAT64 (Layer 4 virtual servers)

Example: NAT46 (Layer 7 virtual servers)

 NAT46 (Layer 7 virtual servers) on page 366 illustrates full NAT with NAT46. The IPv4 client connects to the virtual
server IPv4 address. The source IP / destination IP pair in the packets received is SRC 192.168.1.1 / DST
192.168.1.101. The NAT module translates the source IP address to the IPv6 address of the egress interface that has
IPv6 connectivity with the real server—in this example, 2002::2:1001. It translates the destination IP address to the IPv6
address of the real server selected by the load balancer—in this example, 2002::2:1.

The systemmaintains this NAT table and performs the inverse translation when it receives the server-to-client traffic.

 NAT46 (Layer 7 virtual servers)
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Feature Note

Profiles Not Supported: RADIUS, HTTP Turbo

Profile options Not supported: Source Address (Using the original source IP address for the connection
to the real server is contrary to the purpose of NAT.)

Virtual server options Not supported: Connection Rate Limit

Real server pool options Not supported: Connection Rate Limit

Limitations: NAT46 (Layer 7 virtual servers)

Example: NAT64 (Layer 7 virtual servers)

 NAT64 (Layer 7 virtual servers) on page 368 illustrates full NAT with NAT64. The IPv6 client connects to the virtual
server IPv6 address. The source IP / destination IP pair in the packets received is SRC 2001::1:1 / DST 2001::1:101. The
NAT module translates the source IP address to the IPv4 address of the egress interface that has IPv4 connectivity with
the real server—in this example, 192.168.2.101. It translates the destination IP address to the IPv4 address of the real
server selected by the load balancer—in this example, 192.168.2.1.

The systemmaintains this NAT table and performs the inverse translation when it receives the server-to-client traffic.

 NAT64 (Layer 7 virtual servers)
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Feature Note

Profiles Not Supported: RADIUS, HTTP Turbo

Profile options Not supported: Source Address (Using the original source IP address for the connection
to the real server is contrary to the purpose of NAT.)

Virtual server options Not supported: Connection Rate Limit

Real server pool options Not supported: Connection Rate Limit

Security Not Supported: IP Reputation, DoS protection, Security logs and reports

Limitations: NAT64 (Layer 7 virtual servers)

Using schedule pools

A schedule pool is a list of configuration objects, each of which is tied to a specific real-server pool and schedule group.
Used together with real-server pools, schedule groups, and content routing rules, schedule pools make it much easier
for you to streamline the operation and management of your real servers. You set or change the working schedules of
your real servers with ease.

The schedule pool feature takes the following two factors are taken into consideration:

First, there can be multiple pools in a virtual server or a content routing configuration. This does not mean to introduce a
traffic distributing hierarchy to load-balance across the pools because all the pools of different schedule pools in a virtual
server obey the same rule of traffic distribution. So the basic schema is not changed. The way it works is the same as a
single pool does. We have the following specific confines:

l The same real server pool is not allowed to be used in different schedule pools which are configured in the same
virtual server.

l The same real server is not allowed to be used in different real-server pools that are used by schedule pools
configured in the same virtual server.

l When multiple schedule pools are active, all the real-server pools within them (schedule pools) are active, and
traffic can be transmitted to all the real servers in the real-server pools as scheduled. In that case, all the real
servers are placed in different pools for scheduling.

l The backup real servers are backed up for all the current active real servers from multiple schedule pools of a virtual
server.

Second, a schedule pool can be scheduled inactive. The schedule daemon tracks the states of all the schedules. When
a schedule's state changes, the schedule daemon updates the new state to all the related daemons. As soon as the
state of a schedule pool goes active, the system will start to transmit traffic to members of the corresponding pool unless
there are some other mechanisms keeping the schedule pool or some members of the pool in “not work” state, as in the
case of health check failure or backup members of the pool. Once a schedule turns inactive, the system will stop
transmitting traffic to all the members of the corresponding pool. Some or all members of the pool may be in “not work”
state for various reasons when a schedule's state changes to inactive. Anyway, when members of a pool turn inactive,
the system will react in the same way as it does when they fail their health check— immediately removes the
connections involved and cuts off traffic to those connections at the same time.

The schedule-based pool can be applied to all kinds of virtual servers and all kinds of content routing configurations. It
should also work well with all packet-forwarding methods, and can handle all the protocols that FortiADC now supports.
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How to use the "schedule pool" feature

The following are the basic steps you should follow to take advantage of the schedule pool feature:

1. Configure schedule groups (Shared Resources > Schedule Group).
2. Configure real servers (Server Load Balance > Real Server).
3. Configure real-server pools (Server Load Balance > Real Server Pool).
4. Configure schedule pools (Server Load Balance > Schedule Pool).
5.  Configure content routing rules (Server Load Balance > Content Routing). (Optional)
6. Configure virtual servers (Server Load Balance > Virtual Server)

Configuring schedule pools

The following instructions assume that you have properly configured schedule groups, real servers, and real server
pools, as mentioned in the preceding paragraph.

To configure schedule pools:

1. Go to Server Load Balance > Virtual Server.
2. Click the Schedule Pool tab.
3. Click Create New to open the Schedule Pool dialog box.
4. Specify a unique name for the schedule pool.
5. Select a real server pool.
6. Select a schedule group.
7. Click Save when done.
8. Repeat Steps 2 through 7 to create as many schedule pools as needed.

Using clone pools

A clone pool is a set of destinations, of monitor servers.

The FortiADC is tasked with protecting the real-server pools. Before allowing traffic to reach the servers, it will duplicate
the traffic, sending a copy towards the clone pool, which holds onto it.

As such, the clone pool is assigned to a virtual server. In the clone pool is a farm of monitor servers; some of these
monitor servers can be IDS servers - intrusion detection system (IDS) - which will analyze traffic to identify suspicious
patterns. The IDS server does not perform fire wall functions, like blocking the traffic. However, the IDS server will send
out, say, an email, indicating that the server

Important: A clone pool receives all of the same traffic that the server pool receives.

To configure a clone pool, you first create a pool of IDS or sniffer devices and then assign the pool as a clone pool to a
virtual server. The clone pool feature is the recommended method for copying production traffic to IDS systems or sniffer
devices. Note that when you create the clone pool, the service port that you assign to each node is irrelevant; you can
choose any service port. Also, when you add a clone pool to a virtual server, the system copies only new connections;
existing connections are not copied.

You can configure a virtual server to copy client-side traffic, server-side traffic, or both:

l A client-side clone pool causes the virtual server to replicate client-side traffic (prior to address translation) to the
specified clone pool.
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l A server-side clone pool causes the virtual server to replicate server-side traffic (after address translation) to the
specified clone pool.

Clone pool topology on page 372 illustrates how clone pools work.

Clone pool topology

The following steps show the process in which FortiADC clones packets and sends them to the monitor servers:

1. Duplicates the packet data structure.
2. Looks up the route table by monitor server IP to find out the next-hop IP address and output device, if necessary.
3. Looks up the neighbors by the next-hop IP address, if necessary.
4. Updates packet headers with specified values or results of route and ARP look-up.
5. Sends the packets out to the monitor servers.

Configuring a clone pool

Before starting to create clone pools, keep the following in mind:

l Only one clone pool can be configured for the virtual server.
l The clone pool can have at most four members. The traffic will be duplicated and sent to each of the members.
l Only IPv4 addresses are supported.
l There are four modes by which you may update and send the packets.
l When the clone pool is added to the virtual server, the traffic (of old sessions and new) is duplicated and sent to the
monitor servers in the clone pool.
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l The following is true:
l If the virtual server is of the type L7, then the profiles TURBOHTTP, HTTP, HTTPS, TCPS, RDP, are
supported.

l If the virtual server is of the type L2, then the profiles TCP, UDP, IP, HTTP, HTTPS, TCPS, are supported.
l If the virtual server is of the type L4, then the profiles TCP, UDP, FTP, are supported.

l Traffic of both client and server sides may be cloned. For the client-side, traffic is replicated BEFORE the packet's
address undergoes Network Address Translation (NAT) such that it may reach the clone members. For the server-
side, however, NAT has already happened; the packet has already gone through the virtual server. Thus the traffic
is replicated AFTER the packet address has been translated.

To configure a clone pool:

The following instructions assume that you have properly configured schedule groups, real servers, and real server
pools.

1. Go to Server Load Balance > Virtual Server.
2. Click the Clone Pool tab.
3. Click Create New to display the configuration editor.
4. Return to Clone Pool tab and select your clone pool, and click edit.
5. Click Create New to create a member inside your clone pool. Create as many members as four.
6. Refer to the table below for entries and/or selections required for creating a clone pool.

Parameters for clone pool configuration

Entry/Selection Description

Clone Pool

Name Specify a unique clone pool name

Pool Member

Name Specify a unique pool member name.
Note: A pool member is a clone server. So this name is essentially the
name you give to the clone server.

Interface Select the interface (port) FortiADC uses to send out packets to the clone
server.

Mode The headers of duplicated packets need to be updated when sent to
monitor servers. There are several modes in which this occurs. Select one
of the following:
l Mirror Interface—This mode does not change the packet header at all.
It is most commonly used; with it, the monitor does not look at the
content of the packet, neither does it receive the payload, it merely
looks at how much data is being passed, and counts the bytes of the
data. The original Layer 2 Destination Address (DA) or Source
Address (SA) and Layer 3 IP Addresses are left intact. In this mode
the FortiADC simply sends the packets "as is" out from the specified
interface.

l Mirror Destination MAC Address Update—This mode uses Layer 2

[caption]
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Entry/Selection Description

forwarding. With the incoming packet, the ADC replaces the
destination MAC address with the specified destination MAC address.
It is preferred when connecting the ADC to end devices like the IDS.

l Mirror Source MAC Update—This mode replaces the source MAC
address in the incoming packet with the specified MAC address on the
FortiADC device. This option is recommended where not changing the
source MAC address could cause a loop.

l Mirror Source Destination MAC Update—This mode replaces both the
source and destination MAC addresses at Layer 2, but does not
change the Layer-3 IP addressing information.

l Mirror IP Update—This mode replaces the incoming packet’s IP
address with the specified IP address and then forwards the
duplicated packet to those servers. This mode may also change the
Layer 4 source and destination ports. If the virtual server port isn't set
to wildcard port 0 while the port IS specified, the Layer 4 destination
port on the duplicated packets will be changed to the specified value.
This option is recommended for scenarios in which monitor servers
are not directly connected to the ACOS device.

Application Resources

The Server Load Balance > Application Resources sub-menu allows you to perform the following tasks relating to
the application resources for server load balancing:

l Configuring Application profiles on page 374
l Configuring Client SSL profiles on page 412
l Configuring HTTP2 profiles on page 418
l Configuring HTTP3 profiles on page 419
l Configuring load-balancing (LB) methods on page 423
l Configuring persistence rules on page 424
l Configuring error pages on page 432
l Configuring decompression rules on page 434
l Configuring Captcha on page 438

Configuring Application profiles

An application profile is a configuration object that defines how you want the FortiADC virtual server to handle traffic for
specific protocols.

The Application Profile Usage table describes the usage by application profile type, including the compatible virtual
server types, load-balancing methods, persistence methods, and content routing types.

Application Profile Usage
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Profile Usage VS
Type

LB Methods Persistence

FTP Use with FTP servers. Layer 7,
Layer 4

Layer 7: Round Robin, Least
Connections
Layer 4: Same as Layer 7,
plus Fastest Response,
Dynamic Load

Layer 7: Source Address,
Source Address Hash
Layer 4: Same as Layer 7,
plus Source Address-Port
Hash

HTTP Use for standard, unsecured
web server traffic.

Layer 7,
Layer 2

Layer 7: Round Robin, Least
Connections, URI Hash, Full
URI Hash, Host Hash, Host
Domain Hash, Dynamic
Load
Layer 2: Same as Layer 7,
plus Destination IP Hash

Source Address, Source
Address Hash, Source
Address-Port Hash, HTTP
Header Hash, HTTP
Request Hash, Cookie
Hash, Persistent Cookie,
Insert Cookie, Embedded
Cookie, Rewrite Cookie,
Passive Cookie

HTTPS Use for secured web server
traffic when offloading
TLS/SSL from the backend
servers. You must import the
backend server certificates
into FortiADC and select
them in the HTTPS profile.

Layer 7,
Layer 2

Same as HTTP Same as HTTP, plus SSL
Session ID

TURBO
HTTP

Use for unsecured HTTP
traffic that does not require
advanced features like
caching, compression,
content rewriting, rate
limiting, Geo IP blocking, or
source NAT. The profile can
be used with content routes
and destination NAT, but the
HTTP request must be in the
first data packet.
This profile enables packet-
based forwarding that
reduces network latency and
system CPU usage.
However, packet-based
forwarding for HTTP is
advisable only when you do
not anticipate dropped
packets or out-of-order
packets.

Layer 7 Round Robin, Least
Connections, Fastest
Response

Source Address
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Profile Usage VS
Type

LB Methods Persistence

RADIUS Use with RADIUS servers. Layer 7 Round Robin RADIUS attribute

RDP Use with Windows Terminal
Service(remote desktop
protocol).

Layer 7 Round Robin, Least
Connections

Source Address, Source
Address Hash, Source
Address-Port Hash, RDP
Cookie

SIP Use with applications that
use session initiation
protocol (SIP), such as VoIP,
instant messaging, and
video.

Layer 7 Round Robin, URI Hash,
Full URI Hash

Source Address, Source
Address Hash, Source
Address-Port Hash, SIP
Call ID

TCP Use for other TCP protocols. Layer 4,
Layer 2

Layer 4: Round Robin, Least
Connections, Fastest
Response, Dynamic Load
Layer 2: Round Robin, Least
Connections, Fastest
Response, Destination IP
Hash, Dynamic Load

Source Address, Source
Address Hash, Source
Address-Port Hash

TCPS Use for secured TCP when
offloading TLS/SSL from the
backend servers. Like the
HTTPS profile, you must
import the backend server
certificates into FortiADC
and select them in the TCPS
profile.

Layer 7,
Layer 2

Layer 7: Round Robin, Least
Connections, Dynamic Load
Layer 2: Round Robin, Least
Connections, Destination IP
Hash, Dynamic Load

Source Address, Source
Address Hash, Source
Address-Port Hash, SSL
Session ID

UDP Use with UDP servers. Layer 4,
Layer 2

Layer 4: Round Robin, Least
Connections, Fastest
Response, Dynamic Load
Layer 2: Same as Layer 4,
plus Destination IP Hash

Source Address, Source
Address Hash, Source
Address-Port Hash

IP Combines with Layer 2
TCP/UDP/HTTP virtual
server to balance the rest of
the IP packets passed
through FortiADC. When
running the IP protocol 0 VS,
the traffic always tries to
match none protocol 0 VS
first.

Layer 2 Round Robin, Dynamic
Load

Source Address, Source
Address Hash, Source
Address-Port Hash

DNS Use with DNS servers. Layer 7 Round Robin, Least
Connections

Not supported yet.
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Profile Usage VS
Type

LB Methods Persistence

SMTP Use with SMTP servers. Layer 7 Round Robin, Least
Connections

Source Address, Source
Address Hash

RTMP A TCP-based protocol used
for streaming audio, video,
and data over the Internet

Layer 7 Round Robin, Least
Connection

Source Address, Source
Address Hash

ISO8583 Use with ISO8583 servers Layer 7 Round Robin N/A

RTSP A network control protocol
used for establishing and
controlling media sessions
between end points

Layer 7 Round Robin, Least
Connection

Source Address, Source
Address Hash

MySQL MySQL network protocol
stack (i.e., MySQL-Proxy)
which parses and builds
MySQL protocol packets

Layer 7 Round Robin, Least
Connection

N/A

DIAMETER A successor to RADIUS,
DIAMETER is the next-
generation Authentication,
Authorization and
Accounting (AAA) protocol
widely used in IMS and LTE.

Layer 7 Round Robin Source Address.
DIAMETER Session ID
(default)

MSSQL MSSQL network protocol
stack, which parses and
builds MSSQL protocol
packets

Layer 7 Least connection N/A

EXPLICIT_
HTTP

A simple explicit/forward
HTTP proxy mode.
In this mode, you don’t need
to add backend real server
pool. The destination IP
address of the downstream
is specified by the URL or
Host field of the client
request.

Layer 7 N/A N/A

L7 TCP Use for other TCP protocols. Layer 7 Layer 7: Round Robin, Least
Connections

Source Address, Source
Address Hash

L7 UDP Use with UDP servers. Layer 7 Layer 7: Round Robin, Least
Connections

Source Address, Source
Address Hash

The Predefined Profiles table lists the default values of each predefined profile. All values in the predefined profiles are
view-only, and cannot be modified. You can select predefined profiles in the virtual server configuration, or you can
create user-defined profiles to include configuration objects such as certificates, caching settings, compression options,
and IP reputation.
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Predefined Profiles

Profile Defaults

LB_PROF_DIAMETER Origin Host—Blank
Origin Realm—Blank
Vendor ID—0
Product Name—Blank
Idle Timeout—300 (seconds) (Note: This refers to the built-in session
ID persistence timeout.)
Server Close Propagation—OFF (Note: This means that the
connection on the client side stays open when the server closes any
connection on its side.)
Client SSL—Off

LB_PROF_TCP Timeout TCP Session—100
Timeout TCP Session after FIN—100
IP Reputation—Disabled
Geo IP block list—None
Geo IP Allowlist—None

LB_PROF_UDP Timeout UDP Session—100
IP Reputation—Disabled
Stateless—Disabled
Geo IP block list—None
Geo IP Allowlist—None

LB_PROF_HTTP Client Timeout—50
Server Timeout—50
Connect Timeout—5
Queue Timeout—5
HTTP Request Timeout—50
HTTP Keepalive Timeout—50
Client Address—Disabled
X-Forwarded-For—Disabled
X-Forwarded-For Header—Blank
IP Reputation—Disabled
HTTP Mode—Keep Alive
Compression—None.
Decompression—None
Caching—None
Geo IP Block List—None
Geo IP Allowlist—None
Geo IP Redirect URL—http://
HTTP Send Timeout—5
HTTP2—None
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Profile Defaults

LB_PROF_HTTP_SERVERCLOSE Client Timeout—50
Server Timeout—50
Connect Timeout—5
Queue Timeout—5
HTTP Request Timeout—50
HTTP Keepalive Timeout—50
Buffer Pool—Enabled
Client Address—Disabled
X-Forwarded-For—Disabled
X-Forwarded-For Header—None
IP Reputation—Disabled
HTTP Mode—Server Close
Customized SSL Ciphers Flag—Disabled
Compression—None
Decompression—None
Caching—None
Geo IP Block List—None
Geo IP Allowlist—None
Geo IP Redirect URL—http://
HTTP Send Timeout—0
HTTP2—None

LB_PROF_TURBOHTTP Timeout TCP Session—100
Timeout TCP Session after FIN—100
IP Reputation—Disabled
Geo IP Block List—None
Geo IP Allowlist—None

LB_PROF_FTP Timeout TCP Session—100
Timeout TCP Session after FIN—100
IP Reputation—Disabled
Geo IP Block List—None
Geo IP Allowlist—None
Client Address—Off
Security Mode—None

LB_PROF_RADIUS Client Address—Off
Source Port—Off
Dynamic Auth—Disable
RADIUS Session—300
Geo IP Block List—None
Geo IP Allowlist—None
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LB_PROF_SIP SIP Max Size—65535
Server Keepalive Timeout—30
Server Keepalive—Enabled
Client Keepalive—Disabled
Client Protocol—UDP
Server Protocol—None
Failed Client Type—Drop
Failed Server Type—Drop
Insert Client IP—Disabled
Geo IP Block List—None
Geo IP Allowlist—None
Client Address—Off
Media Address—0.0.0.0

LB_PROF_RDP Client Timeout—50
Server Timeout—50
Connect Timeout—5
Queue Timeout—5
Source Address—Disabled
IP Reputation—Disabled
Geo IP Block List—None
Geo IP Allowlist—None

LB_PROF_IP IP Reputation—Disabled
Geo IP Block List—None
Geo IP Allowlist—None
Timeout IP Session—100

LB_PROF_DNS Client Address—Off
DNS Cache Flag—Enabled
DNS Cache Ageout Time—3600
DNS Cache Size—10
DNS Cache Entry Size—512
DNS Cache Response Type—All Records
DNSMalform Query Action—Drop
DNAMax Query Length—512
DNS Authentication Flag—Disabled

LB_PROF_TCPS Client Timeout—50
Server Timeout—50
Connect Timeout—5
Queue Timeout—5
Client Address—Disabled
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IP Reputation—Disabled
Geo IP block list—None

LB_PROF_HTTPS Client Timeout—50
Server Timeout—50
Connect Timeout—5
Queue Timeout—5
HTTP Request Timeout—50
HTTP Keepalive Timeout—50
Client Address—Disabled
X-Forwarded-For—Disabled
X-Forwarded-For Header—None
IP Reputation—Disabled
HTTP Mode—Keep Alive
SSL Proxy Mode—Disabled
Compression—None
Decompression—None
Caching—None
Geo IP Block List—None
Geo IP Allowlist—None
Geo IP Redirect URL—http://
HTTP Send Timeout—0
HTTP2—None

LB_PROF_HTTPS_SERVERCLOSE Client Timeout—50
Server Timeout—50
Connect Timeout—5
Queue Timeout—5
HTTP Request Timeout—50
HTTP Keepalive Timeout—50
Client Address—Disabled
X-Forwarded-For—Disabled
X-Forwarded-For Header—None
IP Reputation—Disabled
HTTP Mode—Server Close
Compression—None
Decompression—None
Caching—None
Geo IP Block List—None
Geo IP Allowlist—None
Geo IP Redirect URL—http://
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HTTP Send Timeout—0
HTTP2—None

LB_PROF_SMTP Starttls Active Mode—require
Forbidden Command—expn, turn, vrfy
Local Certificate Group—LOCAL_CERT_GROUP
Client Address—Disable
Forbidden Command Status—Enable
Domain Name—default.com
Geo IP Block List—None
Geo IP Allowlist—None

LB_PROF_RTSP Max Header Size—Default is 4096. Valid values range from 2048 to
65536.
Client Address—Disabled by default. When enabled, FortiADC will
use the client address to connect to the server pool.

LB_PROF_RTMP Client Address—Disabled by default. When enabled, FortiADC will
use the client address to connect to the server pool.

LB_PROF_HTTP2_H2 Client Timeout—50
Server Timeout—50
Connect Timeout—5
Queue Timeout—5
HTTP Send Timeout—0
HTTP Request Timeout—50
HTTP Keepalive Timeout—50
Client Address—Disabled
X-Forwarded-For—Disabled
IP Reputation—Disabled
HTTP Mode—Keep Alive
Compression—None
Decompression—None
HTTP2—LB_HTTP2_PROFILE_DEFAULT
Caching—None
Geo IP Block List—None
Geo IP Allow list—None
Geo IP Redirect URL—http://
Tune Buffer Size—17418
Max HTTP Headers—200
Response Half Closed Connection—Disabled

LB_PROF_HTTP2_H2C Client Timeout—50
Server Timeout—50
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Connect Timeout—5
Queue Timeout—5
HTTP Send Timeout—0
HTTP Request Timeout—50
HTTP Keepalive Timeout—50
Client Address—Disabled
X-Forwarded-For—Disabled
IP Reputation—Disabled
HTTP Mode—Keep Alive
Compression—None
Decompression—None
HTTP2—LB_HTTP2_PROFILE_DEFAULT
Caching—None
Geo IP Block List—None
Geo IP Allowlist—None
Geo IP Redirect URL—http://
Tune Buffer Size—17418
Max HTTP Headers—200
Response Half Closed Connection—Disabled

LB_PROF_HTTP3 Client Timeout—50
Server Timeout—50
Connect Timeout—5
Queue Timeout—5
HTTP Request Timeout—50
HTTP Keepalive Timeout—50
X-Forwarded-For—Disabled
HTTP Mode—Keep Alive
HTTP3—LB_HTTP3_PROFILE_DEFAULT
Tune Buffer Size—32768
Max HTTP Headers—200

LB_PROF_ISO8583 Timeout TCP Session—100
Message Encode Type—ASCII
Length Indicator Type—binary
Length Indicator Shift—0
Length Indicator Size—2
Optional Header Length—2
Optional Trailer Hex—None
Geo IP Block List—None
Geo IP Allowlist—None
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LB_PROF_EXPLICIT_HTTP Client Timeout—50
Server Timeout—50
Connect Timeout—50
Queue Timeout—50
HTTP Send Timeout—0
HTTP Request Timeout—50
HTTP Keepalive Timeout—50
Client Address—Disabled
X-Forwarded-For—Disabled
X-Forwarded-For Header—None
IP Reputation—Disabled
HTTP Mode—Keep Alive
Decompression—None
Geo IP Block List—None
Geo IP Allowlist—None
Geo IP Redirect URL—http://
Tune Buffer Size—8030
Max HTTP Headers—100
Response Half Closed Connection—Disabled

LB_PROF_L7_TCP Timeout TCP Session—100
IP Reputation—Disabled
Geo IP Block List—None
Geo IP Allowlist—None

LB_PROF_L7_UDP Timeout UDP Session—100
IP Reputation—Disabled
Geo IP Block List—None
Geo IP Allowlist—None

Before you begin:

l You must have already created configuration objects for certificates, caching, and compression if you want the
profile to use them.

l You must have Read-Write permission for Load Balance settings.

To configure custom profiles:

1. Go to Server Load Balance > Application Resources. Click the Application Profile tab.
2. Click Create New to display the configuration editor.
3. Give the profile a name, select a protocol type; then complete the configuration as described in Profile configuration

guidelines on page 385.
4. Save the configuration.
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You can clone a predefined configuration object to help you get started with a user-defined
configuration.

To clone a configuration object, click the clone icon that appears in the tools column on
the configuration summary page.

Type Profile Configuration Guidelines

TCP

Timeout TCP Session Client-side timeout for connections where the client has not sent a FIN signal, but the
connection has been idle. The default is 100 seconds. The valid range is 1 to 86,400.

Timeout TCP Session after
FIN

Client-side connection timeout. The default is 100 seconds. The valid range is 1 to
86,400.

Timeout Send RST Enable to send TCP RST to the client and real server when the TCP session expires.
This is disabled by default.
Note: This function is supported for both IPv4 and IPv6 in L4 and L2 virtual servers.
For L4 virtual servers, Timeout Sent RST is supported for
DNAT/FullNAT/NAT46/NAT64 packet forwarding methods.

IP Reputation Enable to apply the FortiGuard IP reputation service. See Managing IP Reputation
policy settings.

Geo IP Block List Select a Geo IP block list configuration object. See Using the Geo IP block list.

Geo IP Allowlist Select an allowlist configuration object. See Using the Geo IP allowlist.

IP

IP Reputation Enable to apply FortiGuard IP reputation service. IP reputation. See Managing IP
Reputation policy settings.

Geo IP Block List Select a Geo IP block list configuration object. See Using the Geo IP block list.

Geo IP Allowlist Select an allowlist configuration object. See Using the Geo IP allowlist.

Timeout IP Session Client-side session timeout. The default is 100 seconds. The valid range is 1 to
86,400.

DNS

Client Address Enable/disable to use the original client IP address as the source address when
connecting to the real server.

DNS Cache Flag Enable/disable the cache for the DNS virtual server.

DNS Cache Ageout Time Specify the cache age-out time (in seconds). The default is 3,600. The valid range is
0 to 65,535.

Profile configuration guidelines
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DNS Cache Size Specify the maximum cache size (in Megabytes). The default is 10. The valid range
is 1 to 100.

DNS Cache Entry Size Specify the maximum cache entry size. The default is 512. The valid range is 256 to
4,096.

DNS Cache Response Type Select either of the following cache response types:
l All Record
l Round Robin

DNS Malform Query Action Select either of the following reactions for the malformed requests:
l Drop
l Forward

DNSMax Query Length Specify the maximum query length. The default is 512. The valid range is 256 to
4,096.

DNS Authentication Flag Enable/disable to authenticate client by redirecting UDP query to TCP.

Special Note With the 4.8.1 release. FortiADC supports DNS zone transfer, i.e., DNS traffic over
TCP from servers and server-oriented requests from inside the server cluster.

UDP

Stateless Enable to apply UDP stateless function.

Timeout UDP Session Client-side session timeout. The default is 100 seconds. The valid range is 1 to
86,400.

IP Reputation Enable to apply the FortiGuard IP reputation service. See Managing IP Reputation
policy settings.

Geo IP Block List Select a Geo IP block list configuration object. See Using the Geo IP block list.

Geo IP Allowlist Select an allowlist configuration object. See Using the Geo IP allowlist.

HTTP

Client Timeout This timeout is counted as the amount of time when the client did not send a
complete request HTTP header to the FortiADC after the client connected to the
FortiADC. If this timeout expires, FortiADC will send a 408 message to client and
close the connection to the client.

Server Timeout This timeout is counted as the amount of time when the server did not send a
complete response HTTP header to the FortiADC after the FortiADC sent a request
to server. If this timeout expires, FortiADC will close the server side connection and
send a 503 message to the client and close the connection to the client.

Connect Timeout This timeout is counted as the amount of time during which FortiADC tried to connect
to the server with TCP SYN. After this timeout, if TCP connection is not established,
FortiADC will drop this current connection to server and respond with a 503 message
to client side and close the connection to the client.
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Queue Timeout This timeout is counted as the amount of time during which the request is queued in
the dispatched queue. When the request cannot be dispatched to a server by a load
balance method (for example, the server's connection limited is reached), it will be
put into a queue. If this timeout expires, the request in the queue will be dropped and
FortiADC will respond with a 503 message to client side and close the connection to
the client.

HTTP Send Timeout This timeout is counted as the amount of time it took FortiADC to send a response
body data (not including the header); the time is counted starting from when the body
is transferred. If this timeout expires, FortiADC will close the connection of both side.

HTTP Request Timeout This timeout is counted as the amount of time the client did not send a complete
request (including both HTTP header and request body) to FortiADC after the client
connected to FortiADC. If this timeout expires, FortiADC will send a 408 message to
client and close the connection to the client.

HTTP Keepalive Timeout This timeout is counted as the time FortiADC can wait for a new request after the
previous transaction is completed. This is an idle timeout if the client does not send
anything in this period. If this timeout expires, FortiADC will close the connection to
the client.

Client Address Use the original client IP address as the source address when connecting to the real
server.

X-Forwarded-For Append the client IP address found in IP layer packets to the HTTP header that you
have specified in the X-Forwarded-For Header setting. If there is no existing X-
Forwarded-For header, the system creates it.
If you only enable http-x-forwarded-for and do not configure http-x-forwarded-for-
header, the default is to add such a header: X-Forwarded-For: <client's ip>

X-Forwarded-For Header Specify the HTTP header to which to write the client IP address. Typically, this is the
X-Forwarded-For header, but it is customizable because you might support traffic
that uses different headers for this. Examples: Forwarded-For, Real-IP, or True-IP.
If http-x-forwarded-for-header <string> is configured, the added header is: <string>:
<client's ip>,

IP Reputation Enable to apply the FortiGuard IP reputation service. See Managing IP Reputation
policy settings.

IP Reputation Redirect URL Type a URL including the FQDN/IP and path, if any, to which a client will be
redirected if the request violates the IP reputation policy.

HTTP Mode l Server Close—Close the connection to the real server after each HTTP
transaction.

l Once Only— An HTTP transaction can consist of multiple HTTP requests
(separate requests for an HTML page and the images contained therein, for
example). To improve performance, the "once only" flag instructs the FortiADC
to evaluate only the first set of headers in a connection. Subsequent requests
belonging to the connection are not load balanced, but sent to the same server
as the first request.
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l Keep Alive—Do not close the connection to the real server after each HTTP
transaction. Instead, keep the connection between FortiADC and the real server
open until the client-side connection is closed. This option is required for
applications like Microsoft SharePoint.

Compression Select a compression configuration object. See Configuring compression rules.

Decompression Select a decompression configuration object. See Configuring decompression rules
on page 434.

HTTP2 Select an HTTP2 Profile configuration object. See Configuring HTTP2 profiles on
page 418.

Caching Select a caching configuration object. See Using caching features.

Geo IP Blocklist Select a Geo IP block list configuration object. See Using the Geo IP block list.

Geo IP Allowlist Select an allowlist configuration object. See Using the Geo IP allowlist.

Geo IP Redirect URL For HTTP, if you have configured a Geo IP redirect action, specify a redirect URL.

Tune Buffer Size Adjust the value of the HTTP/HTTPS VS's connection buffer size.
l For every session, there are two connection buffers.
l The default size is 8030, it is not recommended that you edit it. It's hidden in the
Advance tab, and when you edit it you will get a warning message.

l Tuning this option is dangerous because it may lead to concurrent session
number reduction or other unpredictable problems.

Max HTTP Headers Adjust the max header number that HTTP/HTTPS VS can process for every request
or response. If a request or response has a header over this limit, it will be dropped,
and return error message 400.
l The default value is 100, it's not recommended that you edit it. It is hidden in the
Advance tab, and when you edit it you will get a warning message.

l Tuning this option is dangerous and may lead to concurrent session number
reduction or other unpredictable problems.

Response Half Closed
Connection

Enable to continue to serve half-closed connections.

FTP

Timeout TCP Session Client-side timeout for connections where the client has not sent a FIN signal, but the
connection has been idle. The default is 100 seconds. The valid range is 1 to 86,400.

Timeout TCP Session after
FIN

Client-side connection timeout. The default is 100 seconds. The valid range is 1 to
86,400.

Client Address Use the original client IP address as the source address when connecting to the real
server.

IP Reputation Enable to apply the FortiGuard IP reputation service. See Managing IP Reputation
policy settings.
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Geo IP Block List Select a Geo IP block list configuration object. See Using the Geo IP block list.

Geo IP Allowlist Select an allowlist configuration object. See Using the Geo IP allowlist.

Security Mode Select either of the following:
l None
l Explicit
l Implicit

RADIUS

Client Address Use the original client IP address as the source address when connecting to the real
server.

Source Port Use the original client port as the source port when connecting to the real server.

Timeout RADIUS Session The default is 300 seconds. The valid range is 1 to 3,600.

Dynamic Auth Enable or disable Dynamic Authorization for RADIUS Change of Authorization(CoA)

Dynamic Auth Port Configures the UDP port for CoA requests. The default is 3799.

Geo IP Block List Select a Geo IP block list configuration object. See Using the Geo IP block list.

Geo IP Allowlist Select an allowlist configuration object. See Using the Geo IP allowlist.

RDP

Client Timeout Client-side TCP connection timeout. The default is 50 seconds. The valid range is 1
to 3,600.

Server Timeout Server-side IP session timeout. The default is 50 seconds. The valid range is 1 to
3,600.

Connect Timeout Multiplexed server-side TCP connection timeout. Usually less than the client-side
timeout. The default is 5 seconds. The valid range is 1 to 3,600.

Queue Timeout Specifies how long connection requests to a backend server remain in a queue if the
server has reached its maximum number of connections. If the timeout period
expires before the client can connect, FortiADC drops the connection and sends a
503 error to the client. The default is 5 seconds. The valid range is 1 to 3,600.

Client Address Use the original client IP address as the source address in the connection to the real
server.

IP Reputation Enable to apply the FortiGuard IP reputation service. See Managing IP Reputation
policy settings.

Geo IP Block List Select a Geo IP block list configuration object. See Using the Geo IP block list.

Geo IP Allowlist Select an allowlist configuration object. See Using the Geo IP allowlist.

TCPS

Client Timeout Client-side TCP connection timeout. The default is 50 seconds. The valid range is 1
to 3,600.
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Server Timeout Server-side IP session timeout. The default is 50 seconds. The valid range is 1 to
3,600.

Connect Timeout Multiplexed server-side TCP connection timeout. Usually less than the client-side
timeout. The default is 5 seconds. The valid range is 1 to 3,600.

Queue Timeout Specifies how long connection requests to a backend server remain in a queue if the
server has reached its maximum number of connections. If the timeout period
expires before the client can connect, the system drops the connection and sends a
503 error to the client. The default is 5 seconds. The valid range is 1 to 3,600.

Client Address Use the original client IP address as the source address in the connection to the real
server.

IP Reputation Enable to apply the FortiGuard IP reputation service. See Managing IP Reputation
policy settings.

Geo IP Block List Select a Geo IP block list configuration object. See Using the Geo IP block list.

Geo IP Allowlist Select an allowlist configuration object. See Using the Geo IP allowlist.

HTTPS

Client Timeout This timeout is counted as the amount of time when the client did not send a
complete request HTTP header to the FortiADC after the client connected to the
FortiADC. If this timeout expires, FortiADC will send a 408 message to client and
close the connection to the client.

Server Timeout This timeout is counted as the amount of time when the server did not send a
complete response HTTP header to the FortiADC after the FortiADC sent a request
to server. If this timeout expires, FortiADC will close the server side connection and
send a 503 message to the client and close the connection to the client.

Connect Timeout This timeout is counted as the amount of time during which FortiADC tried to connect
to the server with TCP SYN. After this timeout, if TCP connection is not established,
FortiADC will drop this current connection to server and respond with a 503 message
to client side and close the connection to the client.

Queue Timeout This timeout is counted as the amount of time during which the request is queued in
the dispatched queue. When the request cannot be dispatched to a server by a load
balance method (for example, the server's connection limited is reached), it will be
put into a queue. If this timeout expires, the request in the queue will be dropped and
FortiADC will respond with a 503 message to client side and close the connection to
the client.

HTTP Send Timeout This timeout is counted as the amount of time it took FortiADC to send a response
body data (not including the header); the time is counted starting from when the body
is transferred. If this timeout expires, FortiADC will close the connection of both side.
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HTTP Request Timeout This timeout is counted as the amount of time the client did not send a complete
request (including both HTTP header and request body) to FortiADC after the client
connected to FortiADC. If this timeout expires, FortiADC will send a 408 message to
client and close the connection to the client.

HTTP Keepalive Timeout This timeout is counted as the time FortiADC can wait for a new request after the
previous transaction is completed. This is an idle timeout if the client does not send
anything in this period. If this timeout expires, FortiADC will close the connection to
the client.

Client Address Use the original client IP address as the source address when connecting to the real
server.

X-Forwarded-For Append the client IP address found in IP layer packets to the HTTP header that you
have specified in the X-Forwarded-For Header setting. If there is no existing X-
Forwarded-For header, the system creates it.
If you only enable http-x-forwarded-for and do not configure http-x-forwarded-for-
header, the default is to add such a header: X-Forwarded-For: <client's ip>

X-Forwarded-For Header Specify the HTTP header to which to write the client IP address. Typically, this is the
X-Forwarded-For header, but it is customizable because you might support traffic
that uses different headers for this. Examples: Forwarded-For, Real-IP, or True-IP.
If http-x-forwarded-for-header <string> is configured, the added header is: <string>:
<client's ip>,

IP Reputation Enable to apply the FortiGuard IP reputation service. See Managing IP Reputation
policy settings.

IP Reputation Redirect URL Type a URL including the FQDN/IP and path, if any, to which a client will be
redirected if the request violates the IP reputation policy.

HTTP Mode l Server Close—Close the connection to the real server after each HTTP
transaction.

l Once Only— An HTTP transaction can consist of multiple HTTP requests
(separate requests for an HTML page and the images contained therein, for
example). To improve performance, the "once only" flag instructs the FortiADC
to evaluate only the first set of headers in a connection. Subsequent requests
belonging to the connection are not load balanced, but sent to the same server
as the first request.

l Keep Alive—Do not close the connection to the real server after each HTTP
transaction. Instead, keep the connection between FortiADC and the real server
open until the client-side connection is closed. This option is required for
applications like Microsoft SharePoint.

Compression Select a compression configuration object. See Configuring compression rules.

Decompression Select a decompression configuration object. See Configuring decompression rules
on page 434.
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HTTP2 Select an HTTP2 Profile configuration object. See Configuring HTTP2 profiles on
page 418.

HTTP3 Select an HTTP3 Profile configuration object. See Configuring HTTP3 profiles on
page 419.

Caching Select a caching configuration object. See Using caching features.

Geo IP Blocklist Select a Geo IP block list configuration object. See Using the Geo IP block list.

Geo IP Allowlist Select an allowlist configuration object. See Using the Geo IP allowlist.

Geo IP Redirect URL For HTTP, if you have configured a Geo IP redirect action, specify a redirect URL.

Tune Buffer Size Adjust the value of the HTTP/HTTPS VS's connection buffer size.
l For every session, there are two connection buffers.
l The default size is 8030, it is not recommended that you edit it. It's hidden in the
Advance tab, and when you edit it you will get a warning message.

l Tuning this option is dangerous because it may lead to concurrent session
number reduction or other unpredictable problems.

Max HTTP Headers Adjust the max header number that HTTP/HTTPS VS can process for every request
or response. If a request or response has a header over this limit, it will be dropped,
and return error message 400.
l The default value is 100, it's not recommended that you edit it. It is hidden in the
Advance tab, and when you edit it you will get a warning message.

l Tuning this option is dangerous and may lead to concurrent session number
reduction or other unpredictable problems.

Response Half Closed
Connection

Enable to continue to serve half-closed connections.

HTTP TURBO

Timeout TCP Session Client-side timeout for connections where the client has not sent a FIN signal, but the
connection has been idle. The default is 100 seconds. The valid range is 1 to 86,400.

Timeout TCP Session after
FIN

Client-side connection timeout. The default is 100 seconds. The valid range is from 1
to 86,400.

IP Reputation Enable to apply the FortiGuard IP reputation service.

Geo IP Block List Select a Geo IP block list configuration object. See Using the Geo IP block list.

Geo IP Allowlist Select an allowlist configuration object. See Using the Geo IP allowlist.

SIP

SIP Max Size Maximummessage size. The default is 65535 bytes. The valid range is from 1 to
65,535.

Server Keepalive Timeout Maximum wait for a new server-side request to appear. The default is 30 seconds.
The valid range is 5-300.
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Server Keepalive Enable/disable a keepalive period for new server-side requests. Supports CRLF
ping-pong for TCP connections. Enabled by default.

Client Keepalive Enable/disable a keepalive period for new client-side requests. Supports CRLF ping-
pong for TCP connections. Disabled by default.

Client Protocol Client-side transport protocol:
l TCP
l UDP (default)

Server Protocol Server-side transport protocol.
l TCP
l UDP

Default is "unset", so the client-side protocol determines the server-side protocol.

Failed Client Type Action when the SIP client cannot be reached:
l Drop—Drop the connection.
l Send—Drop the connection and send a message, for example, a status code
and error message.

Failed Server Type Action when the SIP server cannot be reached:
l Drop—Drop the connection.
l Send—Drop the connection and send a message, for example, a status code
and error message.

Insert Client IP Enable/disable option to insert the client source IP address into the X-Forwarded-For
header of the SIP request.

Client Address Use the original client IP address as the source address in the connection to the real
server.

Media Address Change the media address of SIP payload to specified address. 0.0.0.0 is default.

Client-Request-Header-Insert (maximum 4 members)

Type l Insert If Not Exist—Insert before the first header only if the header is not already
present.

l Insert Always—Insert before the first header even if the header is already
present.

l Append If Not Exist—Append only if the header is not present.
l Append Always—Append after the last header.

HeaderName:Value The header:value pair to be inserted.

Client-Request-Header-Erase (maximum 4 members)

Type l All—Parse all headers for a match.
l First—Parse the first header for a match.

HeaderName Header to be erased.

Client-Response-Header-Insert (maximum 4 members)
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Type l Insert If Not Exist—Insert before the first header only if the header is not already
present.

l Insert Always—Insert before the first header even if the header is already
present.

l Append If Not Exist—Append only if the header is not present.
l Append Always—Append after the last header.

HeaderName:Value The header:value pair to be inserted.

Client-Response-Header-Erase (maximum 4 members)

Type l All—Parse all headers for a match.
l First—Parse the first header for a match.

HeaderName Header to be erased.

Server-Request-Header-Insert (maximum 4 members)

Type l Insert If Not Exist—Insert before the first header only if the header is not already
present.

l Insert Always—Insert before the first header even if the header is already
present.

l Append If Not Exist—Append only if the header is not present.
l Append Always—Append after the last header.

HeaderName:Value The header:value pair to be inserted.

Server-Request-Header-Erase (maximum 4 members)

Type l All—Parse all headers for a match.
l First—Parse the first header for a match.

HeaderName Header to be erased.

Server-Response-Header-Insert (maximum 4 members)

Type l Insert If Not Exist—Insert before the first header only if the header is not already
present.

l Insert Always—Insert before the first header even if the header is already
present.

l Append If Not Exist—Append only if the header is not present.
l Append Always—Append after the last header.

HeaderName:Value The header:value pair to be inserted.

Server-Response-Header-Erase (maximum 4 members)

Type l All—Parse all headers for a match.
l First—Parse the first header for a match.

HeaderName Header to be erased.

SMTP
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Client Address Use the original client IP address as the source address in the connection to the real
server.
Note: When using the NAT Source Pool for SMTP VS, ensure the SMTP application
profile is disabled for Client Address. When the SMTP is enabled for Client Address,
it will use the original client IP address as the source address when connecting to the
real server, which cannot be done when the NAT source pool is used at the same
time.

Starttls Active Mode Select one of the following:
l Allow—The client can either use or not use the STARTTLS command.
l Require—The STARTTLS command must be used to encrypt the connection
first.

l None—The STARTTLS command is NOT supported.

Forbidden Command Status Enable/disable to forbid the command(s) selected in Forbidden Command.

Forbidden Command Select any, all, or none of the commands (i.e., expn, turn, vrfy).
If selected, the command or commands will be rejected by FortiADC; otherwise, the
command or commands will be accepted and forwarded to the back end.

Geo IP Block List Select a Geo IP block list configuration object. See Using the Geo IP block list.

Geo IP Allowlist Select an allowlist configuration object. See Using the Geo IP allowlist.

Domain Name Specify the domain name.

RTSP

Client Address Use the original client IP address as the source address in the connection to the real
server.

Max Header Size Specify the maximum size of the RTSP header.

RTMP

Client Address Use the original client IP address as the source address in the connection to the real
server.

MySQL Note: The system does not provide default MyQSL profiles as it does with the other
protocols.

MySQL Mode Select either of the following MySQL modes:
l Single Primary— The profile will use the single-primary mode. You will then
need to specify and configure the primary server and secondary servers.

l Sharding— The profile will use the sharding mode to load-balance MySQL
traffic.

Diameter FortiADC comes with a default load-balancing profile titled "LB_PROF_DIAMETER".
If it is selected, FortiADC will not change Diameter packets except the host
IP address AVP, which means that FortiADC functions as a relay agent.
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Type Profile Configuration Guidelines

Origin Host Leave blank. If defined, FortiADC will change the Origin-Host AVP of the Diameter
packet.

Origin Realm Leave blank. If defined, FortiADC will change the Origin-Realm AVP of the Diameter
packet.

Vendor ID Leave blank. If defined, FortiADC will change the Vendor-ID AVP of the Diameter
packet.

Product Name Leave blank. If defined, FortiADC will change the Product-Name AVP of the
Diameter packet.

Idle Timeout 300 (seconds) by default. Valid values range from 1 to 86,400.

Server Close Propagation OFF by default, which means that the connection on the client side stays open when
the server closes the connection on its side.

Client SSL Select a client SSL profile configuration. See Configuring Client SSL profiles on page
412.

ISO8583

Timeout TCP Session Client-side timeout for connections where the client has not sent a FIN signal, but the
connection has been idle. The default is 100 seconds. The valid range is 1 to 86,400
seconds.

Message Encode Type Specify the encode type for protocol message, default ASCII.

Length Indicator Type Specify the encode type of length indicator, default binary.

Length Indicator Shift Specify bytes to shift from the beginning of payload to read length value, range 0-32.

Length Indicator Size Specify total bytes reading to calculate length, range 0-8.

Optional Header Length Specify length of optional header before MTI, including the length-indicator, range 0-
32.

Optional Trailer Hex Specify hex string of optional trailer, maximum length 16, i.e. 8 bytes in binary

Geo IP Block List Select a Geo IP block list configuration object. See Using the Geo IP block list.

Geo IP Allowlist Select an allowlist configuration object. See Using the Geo IP allowlist.

MSSQL

Client Timeout This timeout is counted as the amount of time when the client did not send a
complete request HTTP header to the FortiADC after the client connected to the
FortiADC. If this timeout expires, FortiADC will send a 408 message to client and
close the connection to the client. The default is 50 seconds. The valid range is 1 to
86,400 seconds.

Server Age Specify the maximum inactivity time for MS SQL server on the server side.

Server Max Size Specify the maximum connections that can connect to the MS SQL server on the
server side.
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Type Profile Configuration Guidelines

Geo IP Block List Select a Geo IP block list configuration object. See Using the Geo IP block list.

Geo IP Allowlist Select an allowlist configuration object. See Using the Geo IP allowlist.

EXPLICIT_HTTP

Client Timeout This timeout is counted as the amount of time when the client did not send a
complete request HTTP header to the FortiADC after the client connected to the
FortiADC. If this timeout expires, FortiADC will send a 408 message to client and
close the connection to the client.

Server Timeout This timeout is counted as the amount of time when the server did not send a
complete response HTTP header to the FortiADC after the FortiADC sent a request
to server. If this timeout expires, FortiADC will close the server side connection and
send a 503 message to the client and close the connection to the client.

Connect Timeout This timeout is counted as the amount of time during which FortiADC tried to connect
to the server with TCP SYN. After this timeout, if TCP connection is not established,
FortiADC will drop this current connection to server and respond with a 503 message
to client side and close the connection to the client.

Queue Timeout This timeout is counted as the amount of time during which the request is queued in
the dispatched queue. When the request cannot be dispatched to a server by a load
balance method (for example, the server's connection limited is reached), it will be
put into a queue. If this timeout expires, the request in the queue will be dropped and
FortiADC will respond with a 503 message to client side and close the connection to
the client.

HTTP Send Timeout This timeout is counted as the amount of time it took FortiADC to send a response
body data (not including the header); the time is counted starting from when the body
is transferred. If this timeout expires, FortiADC will close the connection of both side.

HTTP Request Timeout This timeout is counted as the amount of time the client did not send a complete
request (including both HTTP header and request body) to FortiADC after the client
connected to FortiADC. If this timeout expires, FortiADC will send a 408 message to
client and close the connection to the client.

HTTP Keepalive Timeout This timeout is counted as the time FortiADC can wait for a new request after the
previous transaction is completed. This is an idle timeout if the client does not send
anything in this period. If this timeout expires, FortiADC will close the connection to
the client.

Client Address Use the original client IP address as the source address when connecting to the real
server.

X-Forwarded-For Enable this option to append the client IP address found in IP layer packets to the
HTTP header, for example, X-forwarded-for: 192.168.161.100.
The default header name is X-forwarded-for. If you prefer a different name, use
X-Forwarded-For Header to define a custom name.

X-Forwarded-For Header Specify a custom name for the HTTP header which carries the client IP address. Do
not include the 'X-' prefix. Examples: Forwarded-For, Real-IP, or True-IP.
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Type Profile Configuration Guidelines

IP Reputation Enable to apply the FortiGuard IP reputation service. See Managing IP Reputation
policy settings.

IP Reputation Redirect URL Type a URL including the FQDN/IP and path, if any, to which a client will be
redirected if the request violates the IP reputation policy.

Decompression Select a compression configuration object. See Configuring compression rules.

Geo IP Block List Select a Geo IP block list configuration object. See Using the Geo IP block list.

Geo IP Allowlist Select an allowlist configuration object. See Using the Geo IP allowlist.

Geo IP Redirect URL For HTTP, if you have configured a Geo IP redirect action, specify a redirect URL.

Tune Buffer Size Adjust the value of the HTTP/HTTPS VS's connection buffer size.
l For every session, there are two connection buffers.
l The default size is 8030, it is not recommended that you edit it. It's hidden in the
Advance tab, and when you edit it you will get a warning message.

l Tuning this option is dangerous because it may lead to concurrent session
number reduction or other unpredictable problems.

Max HTTP Headers Adjust the max header number that HTTP/HTTPS VS can process for every request
or response. If a request or response has a header over this limit, it will be dropped,
and error message 400 will be returned.
l The default value is 100, it's not recommended that you edit it. It is hidden in the
Advance tab, and when you edit it you will get a warning message.

l Tuning this option is dangerous and may lead to concurrent session number
reduction or other unpredictable problems.

Response Half Closed
Connection

Enable to continue to serve half-closed connections.

L7 TCP

Timeout TCP Session Client-side timeout for connections where the client has not sent a FIN signal, but the
connection has been idle. The default is 100 seconds. The valid range is 1 to 86,400.

IP Reputation Enable to apply the FortiGuard IP reputation service. See Managing IP Reputation
policy settings.

Geo IP Block List Select a Geo IP block list configuration object. See Using the Geo IP block list.

Geo IP Allowlist Select an allowlist configuration object. See Using the Geo IP allowlist.

L7 UDP

Timeout UDP Session Client-side session timeout. The default is 100 seconds. The valid range is 1 to
86,400 seconds.

IP Reputation Enable to apply the FortiGuard IP reputation service. See Managing IP Reputation
policy settings.

Geo IP Block List Select a Geo IP block list configuration object. See Using the Geo IP block list.

Geo IP Allowlist Select an allowlist configuration object. See Using the Geo IP allowlist.
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See also:

l Configuring MySQL profiles on page 399
l Configuring MSSQL profiles on page 406
l WebSocket load-balancing on page 409
l TCPmultiplexing on page 410

Configuring MySQL profiles

FortiADC (Version 4.7.0 and later) supports MySQL server load-balancing.

MySQL application profiles are user-specific and must be configured only by the user on a case by case basis. For this
reason, FortiADC does not provide any default predefined MySQL application profiles that you can use out of the box. So
you must configure your own MySQL load-balancing application profiles to take advantage of this feature.

FortiADC supports two MySQL database load-balancing modes: single primary and data sharding.

Single-primary mode

The single-primary mode is a database server configuration in which a single primary MySQL server is responsible for all
write operations (i.e., create, update, or delete requests), and one or more secondary servers handle all read-only
operations. The primary server replicates data to the secondary servers in a close to real-time fashion. This mode can
improve database performance to a certain extent by offloading read-intensive operations to secondary servers. It is
ideal for load-balancing database traffic that involves more read operations.

Single-primary mode on page 399 illustrates the network topology of database server load-balancing in single-primary
mode.

Single-primary mode
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By default, FortiADC passes all write requests to the primary server and all read requests (such as select) to the
secondary servers. So once you have created a MySQL server load-balancing profile, FortiADC will automatically apply
this default mode when load-balancing MySQL traffic on the network. However, if you do not like the default behavior,
you can change it by setting up your own MySQL server load-balancing rules when configuring your MySQL application
profile. For more information, see Configuring MySQL rules on page 404.
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Sharding mode

Database sharding is a "shared-nothing" database partitioning technique that breaks down a large database involving a
number of database servers into small database chunks and spread them across a number of distributed servers. It's a
highly scalable approach to improving the throughput and performance of large enterprise business applications that are
transaction-extensive and database-centric because it provides scalability across independent servers, each having its
own CPU, memory, and disks.

Sharding mode on page 401 illustrates MySQL server load-balancing in data-sharding mode.

Sharding mode
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In sharding mode, FortiADC stores global data on the primary Global—it sends all requests that do not belong to any
group to global servers. Using the keys that you have specified, it sends part of the requests to Group) and some to
Group 1. It supports split read/write in every group.

It must be noted that Data Manipulation Language (DDL) is not supported in sharding mode.
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Creating a MySQL profile

Creating a MySQL profile involves the following steps:

1. Create a MySQL configuration object.
2. Specify the existing user name and password of the MySQL database to be used by the MySQL profile

configuration object.
3. Configure MySQL Rule (for single-primary mode, optional) or MySQL Sharding (for database sharding mode).

Note: You can create MySQL profiles from either the GUI or the CLI. The following paragraphs discuss how to configure
a MySQL profile using the GUI. For instructions on how to create MySQL profiles from the CLI, refer to the
CLI Reference.

Before you begin:

l You must have already created MySQL database objects to be used the MySQL profile.
l You must have read-write permission for load-balance settings.

Creating a MySQL configuration object

1. Go to Server Load Balance > Application Resources.
2. Select the Application Profile tab if it is not already selected.
3. Click Create New to open the Application Profile configuration editor.
4. In the Name field, enter a unique profile name.
5. In the Type field, click the down arrow and selectMySQL from the drop-down menu.
6. ForMySQL Mode, select Single primary or Sharding. Refer to MySQL profile configuration guidelines on page

405.
7. Click Save. Your newly created MySQL profile configuration object is automatically appended to the bottom of the

Server Load Balancing > Application Resources > Application Profile page.
8. Click the newly created MySQL profile to open it. See MySQL application profile configuration on page 403.

MySQL application profile configuration
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Note: The image above shows a sample MySQL profile configuration object named "1". Once a MySQL profile is
created, you need to specify the MySQL database user account, and create MySQL Rule or Sharding depending on
which MySQL mode you choose to use. The following paragraphs discuss the procedures for each of those tasks.

Specifying the MySQL user account

Once a MySQL profile is created, you must specify a MySQL user account to be used with the profile by entering the
user name and password of that account.

It's important to note that you are asked to provide the user name and password of an existing MySQL account. So do
not try to create a new user account here.

To specify a MySQL user account:

1. In the MySQL User Password pane (see the illustration above), click Create New. The Edit MySQL User Password
dialog opens.

2. Enter the user name and password of the MySQL database account.
3. Click Save.

Configuring MySQL rules

When configuring a MySQL rule, you first need to decide whether you want FortiADC to send requests to the primary
database server or the secondary database server(s). Then you can set a few conditions (rules) to tell FortiADC how to
send the requests . It must be noted that all the conditions are of an "OR" relationship.

To configure a MySQL rule:

1. In the MySQL Rule pane, click Create New. The Application Profile > Edit MySQL Rule dialog opens.
2. Make the desired entries or selections as described in MySQL profile configuration guidelines on page 405.
3. Click Save.

Configuring sharding

FortiADC supports two types of database-sharding: by range or by hash. In the former case, FortiADC distributes the
data to different groups according to the key range. In the latter case, it first hashes the keys and then automatically
distributes the data to different groups.

To configure MySQL sharding:

1. In the MySQL Sharding pane, click Create New. The Application Profile > Edit MySQL Sharding dialog opens.
2. Make the desired entries or selections as described in MySQL profile configuration guidelines on page 405.
3. Click Save.

Note:When configuring pool members in the CLI to match the real server pool members on the GUI, you can use the
set mysql-group-id command to set the groups that match the pool members:

config load-balance pool
edit "sharding"
set real-server-ssl-profile NONE
config pool_member
edit 1
set pool_member_service_port 3306
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set pool_member_cookie rs
set real-server primary
next
edit 2
set pool_member_service_port 3306
set pool_member_cookie rs2
set real-server primary2
set mysql-group-id 1
next
edit 3
set pool_member_service_port 3306
set pool_member_cookie rs3
set real-server secondary
set mysql-read-only enable
next
edit 4
set pool_member_service_port 3306
set pool_member_cookie rs4
set real-server secondary2
set mysql-read-only enable
set mysql-group-id 1
next
end
next
end

You can clone a predefined configuration object to help you get started with a user-defined
configuration.

To clone a configuration object, click the clone icon that appears in the tools column on
the configuration summary page.

Parameter Description

Application Profile

Name A unique name for the MySQL profile you are creating.

Type MySQL

MySQL Mode Select either of the following:
Single primary—If selected, FortiADC will configure the MySQL profile in single-
primary mode. See Single-primary mode.
Sharding—If selected, FortiADC will configure the MySQL profile in database-
sharding mode. See Sharding mode.

MySQL User Password

User Name The user name of the MySQL database.

MySQL profile configuration guidelines
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Parameter Description

Password The password for the MySQL user name you've entered above.

MySQL Rule

Type Select either of the following:
l Primary—If selected, FortiADC will send all data specified in the MySQL rule to
the primary MySQL database server.

l Secondary—If selected, FortiADC will send all data specified in the MySQL rule
to the secondary MySQL database server.

Database List A list of up to eight MySQL database names separated by space

User List A list of up to eight user names separated by space

Table List A list of up to eight MySQL Database tables separated by space

Client IP List A list of up to eight FortiADC client IP addresses separated by space

SQL List A list of up to eight MySQL statements separated by space

Sharding

Type Select either of the following:
l Range—If selected, FortiADC will send data in the data tables to different groups
based on the specified range of the keys.

l Hash—If selected, FortiADC will perform hash calculations and then
automatically send data to different groups.

Database The database name

Table The table name

Key The column name

Group List A list of up to eight group IDs
Note: The group IDs must match the real server pool members.

Configuring MSSQL profiles

FortiADC (6.0.0 and later) supports MSSQL server load-balancing.

MSSQL application profiles are user-specific and must be configured only by the user on a case-by-case basis. For this
reason, FortiADC does not provide any default predefined MSSQL application profiles that you can use out of the box.
You must configure your own MSSQL load-balancing application profiles to take advantage of this feature.

Single-primary mode

The single-primary mode is a database server configuration in which a single primary MSSQL server is responsible for
all write operations (i.e., create, update, or delete requests), and one or more secondary servers handle all read-only
operations. The secondary server replicates data to the secondary servers in a close to real-time fashion. This mode can
improve database performance to a certain extent by offloading read-intensive operations to secondary servers. It is
ideal for load-balancing database traffic that involves more read operations.
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By default, FortiADC passes all write requests to the primary server and all read requests (such as select) to the
secondary servers. Once you have created a MSSQL server load-balancing profile, FortiADC will automatically apply
this default mode when load-balancing MSSQL traffic on the network.

Creating a MSSQL profile

Creating a MSSQL profile involves the following steps:
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1. Create a MSSQL configuration object.
2. Specify the existing user name and password of the MSSQL database to be used by the MSSQL profile

configuration object.

Note: You can create MSSQL profiles from either the GUI or the CLI. The following paragraphs discuss how to configure
a MSSQL profile using the GUI. For instructions on how to create MSSQL profiles from the CLI, refer to the CLI
Reference.

Before you begin:

l You must have already created MSSQL database objects to be used the MSSQL profile.
l You must have read-write permission for load-balance settings.

Creating a MSSQL configuration object

1. Go to Server Load Balance > Application Resources.
2. Select the Application Profile tab if it is not already selected.
3. Click Create New to open the Application Profile configuration editor.
4. In the Name field, enter a unique profile name.
5. In the Type field, click the down arrow and select MSSQL from the drop-down menu.
6. Click Save. Your newly created MSSQL profile configuration object is automatically appended to the bottom of the

Server Load Balancing > Application Resources > Application Profile page.
7. Click the newly created MSSQL profile to open it to see the MSSQL application profile configuration.

Specifying the MSSQL user account

Once a MSSQL profile is created, you must specify a MSSQL user account to be used with the profile by entering the
user name and password of that account.

Note that you are asked to provide the user name and password of an existing MSSQL account, so do not try to create a
new user account here.

To specify a MSSQL user account:

1. In theMSSQL User Password pane, click Create New. The Edit MSSQL User Password dialog opens.
2. Enter the user name and password of the MSSQL database account,
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3. Click Save.

Parameter Description

Application Profile

Name A unique name for the MSSQL profile you are creating.

Type MSSQL

MSSQL Account

User Name The user name of the MSSQL database.

Password The password for the MSSQL user name you've entered above.

Specifics

Client Timeout Client connection timeout

Server Age Server connection timeout

Server Max Size The maximum size of server connection

WebSocket load-balancing

TheWebSocket protocol provides full duplex communication between client and server over a single TCP connection.
The initial handshake occurs over the HTTP protocol, while subsequent WebSocket message frames layer over the TCP
protocol, as illustrated in WebSocket load-balancing on page 409.

WebSocket load-balancing

You can configure FortiADC in such as way that it is able to load-balance Layer-7 virtual servers with HTTP or
HTTPS profiles to the WebSocket protocol without any change to the default configuration. During the setup phase, the
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virtual server works in HTTP mode, processing Layer-7 information. It automatically detects the connection and upgrade
exchange, and is able to switch to tunnel mode when the upgrade negotiation succeeds. When the WebSocket is
established, and the virtual server fails over to tunnel mode in which no data is analyzed anymore (and anyway,
WebSocket does not communicate in HTTP). SeeWebSocket with FortiADC on page 410.

WebSocket with FortiADC

If you want to configure your FortiADC appliance to perform HTTP inspection andWebSocket traffic load-balancing, you
must use a Layer-7 virtual server with an HTTP profile. If WebSocket traffic is over the transport layer security protocol,
you must use a Layer-7 virtual server with an HTTPS profile and choose an appropriate server SSL profile in the real-
server pool.

If you only want WebSocket load-balancing, use a Layer-4 or Layer-7 virtual server with a TCP profile.

For more information, see https://en.wikipedia.org/wiki/WebSocket and http://tools.ietf.org/html/rfc6455.

TCP multiplexing

The TCPmultiplexing option enables Layer 7 load balancing virtual servers to “reuse” existing TCP connections
between FortiADC and backend real servers. Using this connection pool can reduce TCP overhead and improve web
server and application performance. See Client requests handled using connections from the connection pool on page
410.

Client requests handled using connections from the connection pool
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Note: The feature is not supported for profiles with the Source Address option enabled.

You can enable and configure this option using the CLI only.

To configure a connection pool and assign it to a virtual server:

Use the following command to configure the connection pool:

config load-balance connection-pool

edit <name>
set age <integer>
set reuse <integer>
set size <integer>
set timeout <integer>
next

end

Settings Guidelines

age Maximum duration of a connection in seconds. The recommended value is 3000.

reuse Maximum number of times that the virtual server can reuse the connection. The recommended value is
2000.

size Maximum number of connections in the connection pool. The recommended value is 0, which specifies
that there is no limit on the connection size.

timeout Maximum number of seconds a connection can be idle before the system deletes it. The recommended
value is 30.

To assign the connection pool configuration to a virtual server, enter the following command:

config load-balance virtual-server
edit <virtual-server_name>
set type l7-load-balance
set connection-pool <pool_name>
end

where:

<pool_name> is the name of the connection pool.
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Configuring Client SSL profiles

A Client SSL profile is used to manage the SSL session between the client and the proxy. It allows FortiADC to accept
and terminate client requests sent via the SSL protocol. The Client SSL Profile page provides the settings for configuring
client-side SSL connections, and displays all the client SSL profiles that have been configured on the system.

Before you begin:

l You must have already created configuration objects for certificates, certificate caching, and certificate verify if you
want to include them in the profile.

l You must have Read-Write permission for Load Balance settings.

To configure custom profiles:

1. Go to Server Load Balance > Application Resources.
2. Click the Client SSL Profile tab.
3. Click Create New to display the configuration editor.
4. Complete the configuration as described in Client SSL profile configuration guidelines on page 412.
5. Save the configuration.

You can clone a predefined client SSL profile to help you get started with a user-defined
configuration.

To clone a configuration object, click the clone icon that appears in the tools column on
the configuration summary page.

Type Profile Configuration Guidelines

Name Specify a unique name for the client SSL profile.

Customized SSL Ciphers Flag Enable or disable the use of user-specified cipher suites. If enabled, you must
specify a colon-separated, ordered list of a customized SSL cipher suites. See
below.

Customized SSL Ciphers Available only when the Customized SSL Cipher Flag is enabled (see above).
Specify a colon-separated, ordered list of a customized SSL cipher suites.
Note: FortiADC will use the default SSL cipher suite if the field is left empty.

SSL Ciphers Ciphers are listed from strongest to weakest:
l ECDHE-ECDSA-AES256-GCM-SHA384
l ECDHE-ECDSA-AES256-SHA384
l ECDHE-ECDSA-CAMELLIA256-SHA384
l *ECDHE-ECDSA-AES256-SHA
l ECDHE-ECDSA-AES128-GCM-SHA256
l *ECDHE-ECDSA-AES128-SHA256
l ECDHE-ECDSA-CAMELLIA128-SHA256
l *ECDHE-ECDSA-AES128-SHA

Client SSL profile configuration guidelines
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Type Profile Configuration Guidelines

l ECDHE-ECDSA-DES-CBC3-SHA
l ECDHE-ECDSA-RC4-SHA
l ECDHE-RSA-AES256-GCM-SHA384
l ECDHE-RSA-AES256-SHA384
l ECDHE-RSA-CAMELLIA256-SHA384
l *ECDHE-RSA-AES256-SHA
l DHE-RSA-AES256-GCM-SHA384
l *DHE-RSA-AES256-SHA256
l DHE-RSA-CAMELLIA256-SHA256
l *DHE-RSA-AES256-SHA
l DHE-RSA-CAMELLIA256-SHA
l AES256-GCM-SHA384
l *AES256-SHA256
l *AES256-SHA
l ECDHE-RSA-AES128-GCM-SHA256
l *ECDHE-RSA-AES128-SHA256
l ECDHE-RSA-CAMELLIA128-SHA256
l DHE-RSA-AES128-GCM-SHA256
l *DHE-RSA-AES128-SHA256
l DHE-RSA-CAMELLIA128-SHA256
l *DHE-RSA-AES128-SHA
l AES128-GCM-SHA256
l *AES128-SHA256
l *AES128-SHA
l ECDHE-RSA-RC4-SHA
l RC4-SHA
l RC4-MD5
l EDH-RSA-DES-CBC3-SHA
l DES-CBC3-SHA
l eNULL

*These ciphers are fully supported by hardware SSL (in 400F, 1200F, 2200F,
4200F and 5000F).
Note: We recommend retaining the default list. If necessary, you can deselect the
SSL ciphers that you do not want to support.

TLSv1.3 Cipher Suite List TLSv1.3 ciphers are listed as following:
l TLS_AES_256_GCM_SHA384
l TLS_AES_128_GCM_SHA256
l TLS_CHACHA20_POLY1305_SHA256
l TLS_AES_128_CCM_SHA256
l TLS_AES_128_CCM_8_SHA256

Note: This option only available if the TLSv1.3 is checked.

Allowed SSL Versions You have the following options:
l SSLv3
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Type Profile Configuration Guidelines

l TLSv1.0
l TLSv1.1
l TLSv1.2
l TLSv1.3

We recommend retaining the default list. If necessary, you can deselect SSL
versions you do not want to support.
Note:
l FortiADC does not support session reuse for SSLv2 at the client side.
Instead, a new SSL session is started. Please make sure that the
SSL versions are continuous. IF not, an error message should be returned.

l RFC 7919 Comply cannot support SSLv3 and TLS 1.3. If RFC 7919 Comply
is enabled and SSLv3 or TLSv1.3 is selected in Allowed SSL Versions, an
error message will display.

Client Certificate Verify Select the client certificate verify configuration object.
Note: For VS configurations that reference a ZTNA Profile, ensure the
corresponding EMS CA certificate is selected for the corresponding Client SSL
profile.

Client Certificate Verify Mode The Client Certificate Verify Mode option is available if the Client Certificate
Verify is selected.
Select one of the following:
l Required (default)
l Optional

SSL Session Cache Flag Allows to the same SSL client attempts to reconnect to this SSL server and
requests a resumption of a previous SSL session.
Note: This feature doesn’t support TLSv1.3

Use TLS Tickets Allows resuming TLS sessions by storing key material encrypted on the clients.
Note: This feature doesn’t support TLSv1.3

Client Certificate Forward The Client Certificate Forward option is available if the Client Certificate
Verify is selected.
Disabled by default. When enabled, you must specify the client certificate forward
header.

Client Certificate Forward
Header

The Client Certificate Forward Header option is available if the Client
Certificate Verify is selected and Client Certificate Forward is enabled.
Specify the client certificate forward header.

Forward Proxy By default, (SSL) Forward Proxy is disabled. When enabled, you'll have to
configure additional settings noted below.
Note: RFC 7919 Comply is not supported for Forward Proxy. If RFC 7919 Comply
is enabled and Forward Proxy is enabled, the RFC 7919 Comply feature will not
apply to Forward Proxy functionality.
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Client SNI Required Require clients to use the TLS server name indication (SNI) extension to include
the server hostname in the TLS client hello message. Then, the FortiADC system
can select the appropriate local server certificate to present to the client.

Local Certificate Group Select a local certificate group that includes the certificates this virtual server
presents to SSL/TLS clients. This should be the backend servers' certificate, NOT
the appliance's GUI web server certificate. See Manage Certificates.

Reject OCSP Stapling with
Missing Nextupdate

This flag is meaningful only when you have configured OCSP stapling in Local
Certificate Group.
By default, this option is disabled (unselected). In that case, FortiADC accepts all
OCSP responses, including those in which the next update field is not set. If
enabled, and the next update field is not set in an OCSP stapling response,
FortiADC will not load this OCSP stapling response or present it to clients during
the SSL/TLS handshake.

Renegotiation Enable or disable SSL renegotiation from the client side.
Note:
l The feature is disabled by default.
l When enabled, you must configure the options below.

Renegotiation Interval Specify the minimum interval between two successive client-initiated
SSL renegotiation requests. The unit of measurement can be second, minute, or
hour, e.g., 100s, 20m, or 1h.
Note:
l The default is -1, which disables the function.
l 0 means ‘Indefinite’.
l FortiADC will terminate the connection once the threshold is exceeded.

SSL DH Parameter Size Specify the pubkey length in Diffie Hellman. Default is 1024.
Note: The SSL DH Parameter Size option is not available when RFC 7919
Comply is enabled.

SSL Renegotiate Period Specify the period in second (default), minute, or hour at which FortiADC will
initiate SSL renegotiation.
Note: The default is 0, which disables the function.

SSL Renegotiate Size Specify the amount (MB) of application data that must have been transmitted over
the SSL connection whenFortiADC initiates SSL renegotiation.
Note: The default is 0, which disables the function.

Secure Renegotiation Select one of the following:
l Request—FortiADC requests secure renegotiation of SSL connections.
l Require—(Default) Specifies thatFortiADC requires secure renegotiation of
SSL connections. In this mode, FortiADC permits initial SSL handshakes
from clients, but terminates renegotiation requests from clients that do not
support secure renegotiation.

l Require Strict—FortiADC requires strict secure renegotiation of SSL
connections. In this mode, FortiADC denies initial SSL handshakes from
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clients that do not support secure renegotiation.

RFC 7919 Comply Enable/disable parameters to comply with RFC 7919.
Note:
l RFC 7919 Comply is not supported for Forward Proxy. If RFC 7919 Comply
is enabled and Forward Proxy is enabled, the RFC 7919 Comply feature will
not apply to Forward Proxy functionality.

l RFC 7919 Comply cannot support SSLv3 and TLS 1.3. If RFC 7919 Comply
is enabled and SSLv3 or TLSv1.3 is selected in Allowed SSL Versions, an
error message will display.

l When RFC 7919 Comply is enabled the SSL DH Parameter Size option
becomes unavailable.

Supported Groups The Supported Groups option is available if RFC 7919 Comply is enabled.
Specify the supported group objects from the following:
l secp256r1
l secp384r1
l secp521r1
l x25519
l x448
l ffdhe2048
l ffdhe3072
l ffdhe4096
l ffdhe6144
l ffdhe8192

At least one item from the FFDHE group must be selected.
Note:
The RFC 7919 Comply feature requires certain cipher selections to correspond
with the Supported Group selection.
l If a FFDHE group is selected (for example, ffdhe2048), then at least one
cipher must be DHE-RSA (for example, DHE-RSA-AES256-SHA256).

l If the Supported Group includes groups other than FFDHE (such as a SECP
group, secp256r1), then at least one cipher must be ECDHE (for example,
ECDHE-ECDSA-AES256-GCM-SHA384).

l If a ECDHE cipher is selected (for example, ECDHE-ECDSA-AES256-GCM-
SHA384), then the Supported Group must include at least one group that is
not FFDHE (such as a SECP group, secp256r1).

Dynamic record sizing Allows ADC to dynamically adjust the size of TLS records based on the state of
the connection, in order to prevent bottlenecks caused by the buffering of TLS
record fragments.
Note: The feature is disabled by default.

Forward Proxy Certificate
Caching

The Forward Proxy Certificate Caching option is available if Forward Proxy is
enabled.
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Select a Forward Proxy Certificate Caching rule.

Forward Proxy Local Signing CA The Forward Proxy Local Signing CA option is available if Forward Proxy is
enabled.
Select a Forward Proxy Local Signing CA.

Forward Proxy Intermediate CA
Group

The Forward Proxy Intermediate CA Group option is available if Forward
Proxy is enabled.
Select a Forward Proxy Intermediate CA Group.

Forward Proxy Resign Cert by
SNI

The Forward Proxy Resign Cert by SNI option is available if Forward Proxy is
enabled.
Enabled by default, the Forward Proxy Resign Cert by SNI option allows SSL
Forward Proxy to return re-signed local certificates with modified CN (or SAN)
matching the ClientHello Server Server Name Indication (SNI). This allows the
proxy to act automatically when the SNI is detected in the ClientHello message to
return a re-signed local certificate to the client. The Common Name (CN) and/or
Subject Alternative Name (SAN) of this certificate will be adeptly modified to align
with the SNI, ensuring a seamless and trustworthy SSL handshake process.
Note: This function is supported HTTP/S virtual servers and real server pools with
HTTP/S topology.

Backend SSL SNI Forward The Backend SSL SNI Forward option is available if Forward Proxy is
enabled.
Disabled by default. Enable it to let FortiADC forward Server Name Indication
(SNI) from the client to the back end.

Backend Customized SSL
Ciphers Flag

The Backend Customized SSL Ciphers Flag option is available if Forward
Proxy is enabled.
Enabled by default. In this case, you must specify the backend customized SS
ciphers. See below.

Backend Customized SSL
Ciphers

The Backend Customized SSL Ciphers option is available if Forward Proxy
and Backend Customized SSL Ciphers Flag are enabled.
Specify the customized SSL ciphers to be supported at the back end.

Backend SSL Cipher Suite List The Backend SSL Cipher Suite List option is available if Forward Proxy is
enabled and Backend Customized SSL Ciphers Flag is disabled.
Select the cipher from the list to be supported at the back end.

Backend TLSv1.3 Cipher Suite
List

The Backend TLSv1.3 Cipher Suite List option is available if Forward Proxy is
enabled and Backend Allowed SSL Versions selected TLSv1.3.
TLSv1.3 ciphers are listed as following:
TLS_AES_256_GCM_SHA384
TLS_AES_128_GCM_SHA256
TLS_CHACHA20_POLY1305_SHA256
TLS_AES_128_CCM_SHA256
TLS_AES_128_CCM_8_SHA256
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Note: This option only available if the backendTLSv1.3 is checked.

Backend Allowed SSL Versions The Backend Allowed SSL Versions option is available if Forward Proxy is
enabled.
We recommend retaining the default list. If necessary, you can deselect SSL
versions you do not want to support.
Note: FortiADC does not support session reuse for SSLv2 at the client side.
Instead, a new SSL session is started.

Backend SSL OCSP Stapling
Support

The Backend SSL OCSP Stapling Support option is available if Forward
Proxy is enabled.
Disabled by default. Enable it to let FortiADC support OCSP stapling at the
backend.

Configuring HTTP2 profiles

You can now create application profiles that support HTTP2. To do so, you must first create an HTTP2 Profile, then use
that profile when creating a new application profile.

To configure HTTP2 profiles:

1. Go to Server Load Balance > Application Resources.
2. Click the HTTP2 Profile tab.
3. Click Create New to display the configuration editor.
4. Complete the configuration as described in HTTP2 profile configuration guidelines on page 418.
5. Save the configuration.

Type Profile Configuration Guidelines

Name Specify a unique name for the HTTP2 profile.

Priority Mode Set to Best Effort. Not configurable.

Upgrade Mode Set to Upgradeable. Not configurable.

Max Concurrent Stream Specify the maximum number of concurrent streams available at one time. The
default number is 5.

Max Receive Window Specify the maximum number of bytes that can be received without sending an
acknowledgment response. The default is 65535 bytes.

Max Frame Size Specify the max size of the data frames, in bytes that the HTTP2 protocol sends to
the client. Setting a large frame size improves network utilization, but it can also
affect concurrency. The default is 16384 bytes.

Header Table Size Specify the size of the header table, in KB. A larger table size allows for better
HTTP header compression, but it requires more memory. The default is 4096.

HTTP2 profile configuration guidelines
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Header List Limitation Specify the size of the name value length , in bytes, that the HTTP2 protocol
sends in a single header frame. The default is 65536.

SSL Constraint Enable or disable SSL constraint. If enabled, the following conditions must be
met:
l The TLS implementation supports Server Name Indication.
l The TLS implementation disables compression.
l The TLS implementation disables renegotiation.
l Renegotiation takes place before the connection preface is sent.
l HTTP/2 uses cipher suites with ephemeral key exchange.
l Ephemeral key exchange has a size of at least 2048 bits (for DHE) or a
security level of at least 128 bits (for ECDHE).

l Clients accept DHE no smaller than 4096 bits.
l Stream or block ciphers are not used with HTTP.

Configuring HTTP3 profiles

HTTP/3 Protocol Overview

HTTP/3 is the latest version of the HTTP protocol and unlike previous versions which relied on TCP to handle streams in
the HTTP layer, HTTP/3 uses QUIC (Quick UDP Internet Connections), a multiplexed transport protocol built on UDP.
The HTTP/3 protocol has a lower latency as a result of using QUIC, allowing it to have a quicker handshake for
establishing a secure session compared to HTTP/2 which achieves this using TCP and TLS.

In version 7.4.0, FortiADC is introducing HTTP/3 support as an experimental feature
with limited HTTP/3 functionality, so it is not recommended to be used in production
environments. For details, see HTTP/3 supported functionality and limitations on
page 422.
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Advantages of HTTP/3 using QUIC

As a result of using QUIC, HTTP/3 is designed to improve the speed, reliability, and security of data transfer over the
internet.

Faster connection setup (lower latency)

The HTTP/3 protocol has a lower latency as a result of using QUIC, allowing it to have a quicker handshake for
establishing a secure session compared to HTTP/2 which achieves this using TCP and TLS.

Customizable congestion control

QUIC allows implementers to customize the congestion control algorithm used within the protocol.

Enhanced security

QUIC encrypts almost all of its packet header fields by default default (via TLS).

Connection migration

QUIC identifies connections based on the ConnectionID (CID) instead of Connection table, which allows migration
between different network interfaces or IP addresses without disconnecting.
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Less head-of-line (HoL) blocking

In TCP, if a packet is lost or delayed, it can cause subsequent packets to be blocked. QUIC mitigates this issue by using
multiple independent byte streams so that the loss or delay of a single packet does not impact the delivery of other
packets.

FortiADC HTTP/3 support

You can now configure an HTTP3 Profile that can then be referenced in HTTPS application profiles. Once referenced,
the HTTPS profile becomes a HTTP/3 load balance profile and the virtual server that references the profile becomes a
HTTP/3 VS. This HTTP/3 VS can only operate under L7-HTTPS VS.

HTTP/3 VS listens to the TCP port and the corresponding UDP port at the same time.

FortiADC does not support server side HTTP/3, instead support is provided for client
HTTP/3 to the ADC and then converted to HTTP/1 (conversion to HTTP/2 is not
supported).

A predefined profile is available to be referenced in HTTPS application profiles. All values in the predefined profile is
view-only and cannot be modified.

Profile Description

LB_HTTP3_PROFILE_
DEFAULT

QUIC Congestion Algorithm—Cubic
Max Streams— 5
Max Idle Timeout — 50
Connection TX Buffers — 30

To configure an HTTP3 Profile:

1. Go to Server Load Balance > Application Resources.
2. Click the HTTP3 Profile tab.
3. Click Create New to display the configuration editor.
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4. Configure the following settings:

Setting Description

Name Specify a unique name for the HTTP3 profile. Valid characters are A-Z, a-z,
0-9, _, and -. No spaces. After you initially save the configuration, you
cannot edit the name.

QUIC Congestion Algorithm FortiADC supports Cubic and New Reno loss-based congestion control for
QUIC, where the congestion control responds to packet loss events.
Select the QUIC congestion algorithm to use:
l Cubic
l New Reno

Cubic is the default congestion control algorithm.

Max Streams Specify the maximum allowable number of HTTP/3 QUIC streams. The default
value is 5, and the range is 1-200.

Max Idle Timeout Specify the HTTP/3 QUIC connection idle timeout in seconds.
When no data is transmitted over the HTTP/3 connection after the specified
time has elapsed, the HTTP/3 connection will timeout. The HTTP/3 connection
is tracked using a unique connection-ID instead of a UDP session.
The default value is 50 seconds, and the range is 1-86400 seconds.

Connection TX Buffers Specify the number of buffers to send on the HTTP/3 QUIC connection.
This parameter significantly affects the performance of the HTTP/3 response
direction. The higher the number of buffers are sent, the higher the
performance will be. However, the memory usage increases.
The default value is 30, and the range is 5-100.

5. Click Save.

Once the HTTP3 Profile configuration is saved, it can be referenced in an HTTPS Application Profile configuration.

HTTP/3 supported functionality and limitations

HTTP/3 support is currently an experimental feature with limited HTTP/3 functionality, so it is not recommended to be
used in production environments.

Key limitations:

l HTTP/3 only operates under L7-HTTPS VS.
l HTTP/3 VS does not support dynamic configuration.
l HTTP/3 VS does not support session and persistence table display.
l HTTP/3 VS does not support HTTP detailed information statistics.
l HTTP/3 is only supported on VS, and the backend (RS) only supports HTTP/1.1.

The current iteration of the HTTP/3 feature is supported in limited or conditional capacity. The following lists the
configurations that currently support HTTP/3 functionality and in what capacity.
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Configuration Supported HTTP/3 functionality

Application Profile Profile type must be HTTPS to reference HTTP3 profiles.

Virtual Server l VS type must be Layer 7 to reference HTTP3 profiles.
l Number of ports must be set to one port only, multiple ports is not supported.

LB Method Supported load balancing methods:
l Round Robin
l Least Connection
l URI Hash
l Full URI Hash
l Host Hash
l Host Domain Hash
l Dynamic Load

Persistence Supported persistence types:
l Source Address Hash
l Source Address-port Hash
l HTTP Header Hash
l HTTP Request Hash
l Cookie Hash
l Persistent Cookie
l Insert Cookie
l Rewrite Cookie
l Embedded Cookie
l SSL Session ID

Client SSL Profile Allowed SSL Versions— SSLv3, TLSv1.0, TLSv1.1, TLSv1.2 and TLSv1.3

Real Server SSL Profile Allowed SSL Versions— SSLv3, TLSv1.0, TLSv1.1, TLSv1.2 and TLSv1.3

Configuring load-balancing (LB) methods

The system includes predefined configuration objects for all supported load balancing methods, and there is no need to
create additional configuration objects. You may choose to do so, however, for various reasons, for example, to use a
naming convention that makes the purpose of the configuration clear to other administrators.

Predefined LB methods on page 423 describes the predefined methods.

Predefined Description

LB_METHOD_ROUND_ROBIN Selects the next server in the series: server 1, then server 2, then server
3, and so on.

LB_METHOD_LEAST_CONNECTION Selects the server with the least connections.

Predefined LB methods
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Predefined Description

LB_METHOD_FASTEST_RESPONSE Selects the server with the fastest response to health check tests.

LB_METHOD_URI Selects the server based on a hash of the URI found in the HTTP header,
excluding hostname.

LB_METHOD_FULL_URI Selects the server based on a hash of the full URI string found in the
HTTP header. The full URI string includes the hostname and path.

LB_METHOD_HOST Selects the server based on a hash of the hostname in the HTTP Request
header Host field.

LB_METHOD_HOST_DOMAIN Selects the server based on a hash of the domain name in the HTTP
Request header Host field.

LB_METHOD_DEST_IP_HASH Selects the next hop based on a hash of the destination IP address. This
method can be used with the Layer 2 virtual server.

LB_METHOD_DYNAMIC_LOAD Selects the server with the highest weight assigned to it based on its
SNMP health check.
Note: Dynamic load-balancing is a load-balancing method in which
FortiADC (the load-balancer) actively polls server pool members, and
then assigns a weighted value to each member based on a set of default
or user-defined thresholds. The value ranges from 1 to 256, and
determines the amount of traffic FortiADC directs to a member. The
greater the value that FortiADC assigns to a member, the more client
requests it (the member) receives.
Dynamic load-balancing relies on the status of SNMP health check to
calculate the load on each real server. The health check covers a real
server's CPU, memory, and disk usage. When a real server has
exceeded its health check thresholds, it will be marked as "down". If that
happens, FortiADC will stop sending client requests to that server.

Before you begin:

l You must have Read-Write permission for Load Balance settings.

To configure a load-balancing method configuration object:

1. Go to Server Load Balance > Virtual Server > Application Resources.
2. Click the LB Method tab.
3. Click Create New to display the configuration editor.
4. Give configuration object a name and select the load-balancing type.
5. Save the configuration.

Configuring persistence rules

Persistence rules identify traffic that should not be load balanced, but instead forwarded to the same backend server that
has seen requests from that source before. Typically, you configure persistence rules to support server transactions that
depend on an established client-server session, like e-commerce transactions or SIP voice calls.
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The systemmaintains persistence session tables to map client traffic to backend servers based on the session attribute
specified by the persistence rule.

The persistence table is evaluated before load balancing rules. If the packets received by FortiADCmatch an entry in the
persistence session table, the packets are forwarded to the server that established the connection, and load balancing
rules are not applicable.

Most persistence rule types have a timeout. When the time that has elapsed since the system last received a request
from the client IP address is greater than the timeout, the system does not use the mapping table to forward the request.
Instead, it again selects the server using the method specified in the virtual server configuration. Hash-based rule types
have a timeout built into the hash algorithm. For other types, you can specify the timeout.

Predefined persistence rules on page 425 describes the predefined persistence rules. You can get started with these
commonly used persistence methods or create custom objects.

Predefined Description

LB_PERSIS_SRC_ADDR Persistence based on source IP address or subnet.

LB_PERSIS_HASH_SRC_ADDR Persistence based on a hash of source IP address.

LB_PERSIS_HASH_SRC_
ADDR_PORT

Persistence based on a hash that includes source IP address and
port.

LB_PERSIS_HASH_COOKIE Persistence is based on a hash of a cookie provided by client
request.

LB_PERSIS_RDP_COOKIE Persistence based on RDP cookie sent by RDP clients in the initial
connection request.

LB_PERSIS_SSL_SESS_ID Persistence based on the SSL session ID.

LB_PERSIS_SIP_CALL_ID Persistence based on the SIP call ID.

LB_PERSIS_PASSIVE_COOKIE Persistence based on a passive cookie generated by the server.
FortiADC does not generate or manage the cookie, but only
observes it in the HTTP stream, thus the name "passive cookie".
Also known as "server cookie".

Predefined persistence rules

Before you begin:

l You must have a good understanding and knowledge of the applications that require persistent sessions and the
methods that can be used to identify application sessions.

l You must have Read-Write permission for Load Balance settings.

After you have configured a persistence rule, you can select it in the virtual server configuration.

To configure a persistence rule:

1. Go to Server Load Balance > Application Resources.
2. Click the Persistence tab.
3. Click Create New to display the configuration editor.
4. Give the rule a name, select the type, and specify rule settings as described in Persistence rule guidelines on page
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426.
5. Save the configuration.

You can clone a predefined configuration object to help you get started with a user-
defined configuration.

To clone a configuration object, click the clone icon that appears in the tools
column on the configuration summary page.

Settings Guidelines

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces. You reference
this name in the virtual server configuration.

Note: After you initially save the configuration, you cannot edit the name.

Type Select a persistence type.

Source Address

Source Address Persistence is based on source IP address.

Timeout Timeout for an inactive persistence session table entry. The default is 300 seconds. The valid
range is 1-86,400.

Subnet Mask Bits
(IPv4)

Number of bits in a subnet mask to specify a network segment that should follow the
persistence rule. For example, if IPv4 maskbits is set to 24, and the backend server A
responds to a client with the source IP 192.168.1.100, server A also responds to all clients
from subnet 192.168.1.0/24.

Subnet Mask Bits
(IPv6)

Number of bits in a subnet mask to specify a network segment that should follow the
persistence rule.

Match Across Virtual
Servers

OFF (disabled) by default. Click the button to enable it.
If enabled, clients will continue to access the same backend server through different virtual
servers for the duration of a session.
Note: The persistence rule withMatch Across Virtual Servers enabled works only with L4
virtual servers or the L7 virtual server whose Profile is LB_PROF_RADIUS.

NAT Source Pool
Persistence

OFF (disabled) by default. Click the button to enable it.
If enabled, the IP selected from the IP pool will persist for the session.
Note: NAT Source Pool Persistence only works with L4 virtual servers.

Passive Cookie

Session Keyword
Type

Persistence is based on the cookie which generated from the server, including six options:

Persistence rule guidelines
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auto/PHPSESSID/JESSIONID/CFID+CFTOKEN/ASP.NET_SessionId/custom. When type
is auto, PHPSESSID/JESSIONID/CFID+CFTOKEN/ASP.NET_SessionId can be all
checked. When type is custom, user could define the cookie’s keyword at will.

Keyword Backend server cookie name.

Timeout Timeout for an inactive persistence session table entry. The default is 300 seconds. The valid
range is 1-86,400.

Match across servers Enable so clients continue to access the same backend server through different virtual
servers for the duration of a session.
For example, a client session with a vSphere 6.0 Platform Services Controller (PSC) has
connections on the following ports: 443, 389, 636, 2012, 2014, 2020. A FortiADC deployment
to load balance a cluster of vSphere PSCs includes Layer 4 virtual server configurations for
each of these ports. To ensure a client’s connections for a session go to the same backend
real server:
1. Create a persistence object based on Source Address affinity and select the Match

Across Servers option.
2. Select this persistence object in each of the Layer 4 virtual servers configured to load

balance the vSphere PSC pool.
3. Select the same real server pool object in each of the Layer 4 virtual servers configured

to load balance the vSphere PSC pool.
When these options are enabled, FortiADC dispatches the intial connection to a real server
destination (for example, RS1) based on the virtual server’s load balancing method, and the
persistence object is noted in the connection table. Subsequent connection attempts with the
same source IP address to any FortiADC virtual server that has this persistence object and
real server pool are dispatched to RS1, as long as the session is active.
Note: In the Layer 4 virtual server configuration, you specify a packet forwarding method.
You can use Source Address persistence with Match Across Servers with any combination of
Direct Routing, DNAT, and Full NAT packet forwarding methods. However, with NAT46 and
NAT64 packet forwarding methods, the source address type is different from the real server
address type. To use Match Across Servers with NAT46 or NAT64, all virtual servers for the
application must be configured with the same packet forwarding method: all NAT46 or all
NAT64.

Source Address Hash

Source Address Hash Persistence is based on a hash of the IP address of the client making an initial request.

Source Address-Port Hash

Source Address-Port
Hash

Persistence is based on a hash of the IP address and port of an initial client request.

HTTP Header Hash

HTTP Header Hash Persistence is based on a hash of the specified header value found in an initial client request.

Keyword A value found in an HTTP header.

HTTP Request Hash
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HTTP Request Hash Persistence is based on a hash of the specified URL parameter in an initial client request.

Keyword A URL parameter.

Cookie Hash

Cookie Hash Persistence is based on a hash of the cookie provided by client request.

Keyword Specifies the cookie name.
If the specified cookie keyword is a valid cookie name from which the cookie value can be
extracted, it will be used to calculate the hash. Without the keyword, the hash will be
calculated using the whole cookie. Otherwise, the default round robin method will be used.

Persistent Cookie

Persistent Cookie Persistence is based on the cookie provided in the backend server response. It forwards
subsequent requests with this cookie to the original backend server.

Keyword Backend server cookie name.

Timeout Timeout for an inactive persistence session table entry. The default is 300 seconds. The valid
range is 0-86,400.
If the timeout is set to 0 seconds, the persistence cookie will function as a session cookie,
expiring at the end of the session.
Typically, when the timeout value is set to 1 or more seconds, a timestamp is applied to the
cookie to track the timeout. When the timeout is set to 0, the cookie will not have a timestamp
and instead will expire along with the session.

Httponly Enable/disable to add the "HTTPOnly" flag to cookies. The HttpOnly attribute limits the scope
of the cookie to HTTP requests. In particular, the attribute instructs the user agent to omit the
cookie when providing access to cookies via "non-HTTP" APIs (such as a web browser API
that exposes cookies to scripts).
If the cookie attribute does not match or is not applicable, the user agent will ignore the
cookie and will not enforce persistence.

Secure Enable/disable to add the Secure flag to cookies. The Secure attribute limits the scope of the
cookie to "secure" channels (where "secure" is defined by the user agent). When a cookie
has the Secure attribute, the user agent will include the cookie in an HTTP request only if the
request is transmitted over a secure channel (typically HTTP over Transport Layer Security
(TLS)).
If the cookie attribute does not match or is not applicable, the user agent will ignore the
cookie and will not enforce persistence.

Samesite Add a SameSite attribute to prevent the browser from sending cookies along with cross-site
requests, to mitigate the risk of cross-origin information leakage. It provides Strict, Lax, and
None values for this attribute:
l Nothing— Do not add Samesite attribute to cookies.
The default value is Nothing.

l None— set the value as none if a cookie is required to be sent by cross origin.
Note: If Secure is enabled, then Samesite should be set to None.

l Lax— any request from the third parties will not carry such cookies except for GET
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requests that navigate to the destination URL.
l Strict — any request from the third parties will not carry such cookies

If the cookie attribute does not match or is not applicable, the user agent will ignore the
cookie and will not enforce persistence.

Custom Attribute Enable to specify custom attributes.
When Custom Attribute is enabled, the following options become unavailable: Domain,
Httponly, Secure, and Samesite.

Custom Attribute
Value

The Custom Attribute Value option appears if Custom Attribute is enabled.
Specify the full cookie attributes, including any of the standard attributes and any of the
custom attributes.
If the cookie attribute does not match or is not applicable, the user agent will ignore the
cookie and will not enforce persistence.

Insert Cookie

Insert Cookie Persistence is based on a cookie inserted by the FortiADC system.
The system inserts a cookie whose name is the value specified by Keyword and whose value
is the real server pool member Cookie value and expiration date (if the client does not already
have a cookie).
For example, if the value of Keyword is sessid and the real server pool member Cookie
value is rs1, FortiADC sends the cookie sessid=rs1|U6iFN to the client, where U6iFN is
the expiration date as a base64 encoded string.

Keyword Specifies the backend server cookie name.

Timeout Timeout for an inactive persistence session table entry. The default is 300 seconds. The valid
range is 0-86,400.
If the timeout is set to 0 seconds, the insert cookie will function as a session cookie, expiring
at the end of the session.
Typically, when the timeout value is set to 1 or more seconds, a timestamp is applied to the
cookie to track the timeout. When the timeout is set to 0, the cookie will not have a timestamp
and instead will expire along with the session.

Domain Specifies the domain attribute of the cookie.
If the cookie attribute does not match or is not applicable, the user agent will ignore the
cookie and will not enforce persistence.

Httponly Enable/disable to add the "HTTPOnly" flag to cookies. The HttpOnly attribute limits the scope
of the cookie to HTTP requests. In particular, the attribute instructs the user agent to omit the
cookie when providing access to cookies via "non-HTTP" APIs (such as a web browser API
that exposes cookies to scripts).
If the cookie attribute does not match or is not applicable, the user agent will ignore the
cookie and will not enforce persistence.
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Secure Enable/disable to add the Secure flag to cookies. The Secure attribute limits the scope of the
cookie to "secure" channels (where "secure" is defined by the user agent). When a cookie
has the Secure attribute, the user agent will include the cookie in an HTTP request only if the
request is transmitted over a secure channel (typically HTTP over Transport Layer Security
(TLS)).
If the cookie attribute does not match or is not applicable, the user agent will ignore the
cookie and will not enforce persistence.

Samesite Add a SameSite attribute to prevent the browser from sending cookies along with cross-site
requests, to mitigate the risk of cross-origin information leakage. It provides Strict, Lax, and
None values for this attribute:
l Nothing— Do not add Samesite attribute to cookies.
The default value is Nothing.

l None— set the value as none if a cookie is required to be sent by cross origin.
Note: If Secure is enabled, then Samesite should be set to None.

l Lax— any request from the third parties will not carry such cookies except for GET
requests that navigate to the destination URL.

l Strict — any request from the third parties will not carry such cookies
If the cookie attribute does not match or is not applicable, the user agent will ignore the
cookie and will not enforce persistence.

Custom Attribute Enable to specify custom attributes.
When Custom Attribute is enabled, the following options become unavailable: Domain,
Httponly, Secure, and Samesite.

Custom Attribute
Value

The Custom Attribute Value option appears if Custom Attribute is enabled.
Specify the full cookie attributes, including any of the standard attributes and any of the
custom attributes.
If the cookie attribute does not match or is not applicable, the user agent will ignore the
cookie and will not enforce persistence.

Rewrite cookie

Rewrite Cookie Persistence is based on the cookie provided in the backend server response, but the system
rewrites the cookie.

The system checks the HTTP response for a Set-Cookie: value that matches the value
specified by Keyword. It replaces the keyword value with the real server pool member Cookie
value.

For example, the value of Keyword in the persistence configuration is sessid. The real
server pool member Cookie value is rs1. After an initial client request, the response from
the server contains Set-Cookie: sessid=666, which FortiADC changes to Set-
Cookie: sessid=rs1. FortiADC uses this rewritten value to forward subsequent requests
to the same backend server as the original request.

Keyword Specifies a Set-Cookie: value to match.

FortiADC Handbook 430
Fortinet Technologies Inc.



Server Load Balance

Settings Guidelines

Embedded Cookie

Embedded Cookie Persistence is based on the cookie provided in the backend server response.
Like Rewrite Cookie, the system checks the HTTP response for a Set-Cookie: value
that matches the value specified by Keyword in the persistence configuration. However, it
preserves the original value and adds the real server pool member Cookie value and a ~
(tilde) as a prefix.
For example, the value of Keyword is sessid. The real server pool member Cookie value is
rs1. After an initial client request, the response from the server contains Set-Cookie:
sessid=666, which the system changes to Set-Cookie: sessid=rs1~666. It uses this
rewritten value to forward subsequent requests to the same backend server as the original
request.

Keyword Specifies a Set-Cookie: value to match.

RADIUS Attribute

Type Select RADIUS Attribute.

Timeout Specify the timeout for an inactive persistence session table entry. The default is 300
seconds, and valid values range from 1 to 86,400.

Match Across Virtual
Servers

OFF (disabled) by default. Click the button to enable it.
If enabled, clients will continue to access the same backend server through different virtual
servers for the duration of a session.
Note: The persistence rule withMatch Across Virtual Servers enabled works only with L4
virtual servers or the L7 virtual server whose Profile is LB_PROF_RADIUS.

Override Connection
Limit

OFF (disabled) by default, which means that when the connection limit is reached, new
connections will still be persistently forwarded to the real server.
If enabled, new connections will be forwarded to another node (load-balancing) until all
nodes are full.

RADIUS Attribute
Relation

RADIUS persistence rule supports multiple RADIUS settings, which can be either of the
following relations:
l AND (Default) — The persistence condition is true if all RADIUS attributes are found.
l OR—The persistence condition is true if any of the attributes is found.

RADIUS Attribute After you have saved the RADIUS-type persistence configuration object, you can open the
Persistence configuration editor and add up to four (4) RADIUS attributes to it.
Note: If you choose to use the 26-Vendor-Specific attribute, you need to specify the Vendor
ID and Vendor Type.

RDP Cookie

RDP Cookie Persistence based on RDP cookie sent by RDP clients in the initial connection request.

SSL Session ID

SSL Session ID Persistence is based on SSL session ID.
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Timeout Timeout for an inactive persistence session table entry. The default is 300 seconds. The valid
range is 1-86,400.

SIP Call ID

SIP Call ID Persistence is based on SIP Call ID. For SIP services, you can establish persistence using
Source Address, Source Address Hash, or SIP caller ID.

Timeout Timeout for an inactive persistence session table entry. The default is 300 seconds. The valid
range is 1-86,400.

ISO8583 Bitmap

Timeout Timeout for an inactive persistence session table entry. The default is 300 seconds. The valid
range is 1-86,400.

ISO8583 Bitmap
Relation

Relation among the bitmap type, be AND/OR. Default is OR.

Keyvalue Relation Relation of keyvalue, be AND/OR. Default is AND.

Type Persistence is based on bitmap. Support 30 bitmap type.

Configuring error pages

When backend real servers are unavailable or another status code for other module (ex: WAF/DoS/Auth), FortiADC can
respond to clients attempting HTTP/HTTPS connections with a customized HTML error page. From the Application
Resources > Error Page, you can create a customized error page by uploading an HTML error page file. You can then
edit and preview the HTML file from the GUI. Once the HTML error page has been created, you can select it in virtual
server configurations.

To aid you in customizing your HTML error page, FortiADC provides all default error page files that can be downloaded
from the predefined profile LB_ERROR_PAGE_DEFAULT. You may use any of these default error page files as a
template for customization.

The current error page file package only requests index.html to replace 503 error message when there are no servers in
the pool. We also extend the support to these files listed below:

File Name MUST Guidelines

Index.html Yes This page will replace 503 error message page.

200.html No This page will replace 200 error message page.

202.html No This page will replace 202 error message page.

205.html No This page will replace 205 error message page.

400.html No This page will replace 400 error message page.

401.html No This page will replace 401 error message page.

403.html No This page will replace 403 error message page.
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404.html No This page will replace 404 error message page.

405.html No This page will replace 405 error message page.

406.html No This page will replace 406 error message page.

408.html No This page will replace 408 error message page.

410.html No This page will replace 410 error message page.

413.html No This page will replace 413 error message page.

500.html No This page will replace 500 error message page.

501.html No This page will replace 501 error message page.

502.html No This page will replace 502 error message page.

504.html No This page will replace 504 error message page.

waf_deny.html No This page will replace all response to a WAF deny action. The error
page will show the Message ID, Signature ID, and Client IP of the
attack in the message as recorded in the attack log.
The error page file does not include the related response-code.html.

default.html No This page will replace all other error page doesn’t include in the
package (excluding 503).

Alternatively, you do not have to create an HTML error page if you want to simply send a basic text error message when
backend servers are unavailable. Instead, you can enter an error message in a text box from within the virtual server
configuration. See Error Message on page 337.

Before you begin:

l You must have Read-Write permission for Server Load Balance settings.
l Copy the error message file to a location you can reach from your browser; the error page file must be named
index.html and contained in a tar, tar.gz, or zip file. The maximum file size is 1 MB.

To upload an error message file:

1. Go to Server Load Balance > Application Resources.
2. Click the Error Page tab.
3. Click Create New to display the configuration editor.
4. Enter the name of the error page. You will use this name to select the error page in virtual server configurations. No

spaces.
5. Click Choose File and browse and select the error message tar, tar.gz, or zip file. The maximum file size is 1MB.
6. Enter the Virtual Path of the error page. This virtual path will conflict with the custom authentication form base

page's virtual path and also with SAML's server URL configuration and Captcha path.
7. Click Save.

The newly created error page will be listed in the Error Page tab.
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To modify an error page:

1. Go to Server Load Balance > Application Resources.
2. Click the Error Page tab.
3. Double-click the error page or select the (edit) icon in the row of the error page that you want to modify.

The Error Page configuration editor displays.
4. From the configuration editor, you can make the following modifications:

l Upload a new error message file.
l If the uploaded file is a zip file, edit the file directly through the text editor. The GUI text editor supports HTML,
CSS, and JS file types.

5. Optionally, click Preview to test and view your HTML error page.
Note: The preview function only supports HTML files and cannot execute any JavaScript contained in the HTML.

6. Click Save.

Note: While it is possible to modify the error message file, once an error page is created, you cannot modify its name.

Configuring decompression rules

If the HTTP/HTTPS request body is compressed, FortiADC cannot pass it to the other functional modules which perform
inspection or modification.

To allow FortiADC to pass compressed HTTP/HTTPS client requests to other modules for inspection or modification
before forwarding it to the back-end server, you must create a FortiADC decompression policy.

You can configure FortiADC to temporarily decompress the body of a request based on its file type, which can be
specified by the HTTP/HTTPS Content-Type: header. The appliance can then inspect or modify the traffic. If no
inspection or modification is needed, it will allow the compressed version of the request to pass to the back-end server.

FortiADC supports HTTP/HTTPS request decompression in either gzip or deflate format. Upon receiving a compressed
HTTP/HTTPS request body, FortiADC first extracts the HTTP/HTTPS request body to a temporary buffer and then
sends the buffer to the other modules.

Note that, for the current release, decompression only works for Web Application Firewall (WAF) and Scripting functions.

FortiADC supports decompression of the following content-type files:

l application/javascript
l application/soap+xml
l application/x-javascript
l application/xml
l text/css
l text/html
l text/javascript
l text/plain
l text/xml
l custom

Before you begin:

l You must have a good understanding of HTTP decompression and knowledge of the content types served from the
backend real servers.
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l You must have Read-Write permission for Load Balance settings.

Decompression is not enabled by default. After you have configured a decompression rule, you can select it in the profile
configuration. To enable decompression, select the profile when you configure the virtual server.

To configure a decompression rule:

1. Click Server Load Balance > Application Resources.
2. Click the Decompression tab.
3. Click Create New to display the configuration editor.
4. Complete the configuration as described in Decompression configuration on page 435.
5. Save the configuration.

Settings Guidelines

Name Specify a unique name for the decompression rule. Configuration name. Valid characters are
A-Z, a-z, 0-9, _, and -. No spaces. You reference this name in the profile configuration.
Note: After you initially save the configuration, you cannot edit the name.

URI List Type l Include— Select this option to create a decompression inclusion rule. HTPP/HTTPS 
responses that match the URIs and content types specified in this rule will be
decompressed by FortiADC before being passed to the client.

l Exclude—Select this option to create a decompression exclusion rule.
HTPP/HTTPS responses that match the URIs and content types specified in this rule will
not be decompressed by FortiADC before being passed to the client.

URI List Click Add and specify URIs to build the list.

Content Types Click Add and select from the following content types to build the list:
l application/javascript
l application/soap+xml
l application/x-javascript
l application/xml
l text/css
l text/html
l text/javascript
l text/plain
l text/xml
l custom

Note: The "custom" option allows you to specify almost any content/media type, including
image files in .JPG, .PNG, and .BMP formats. The default is */*, which means any
content/media type.

Decompression configuration
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You can use the CLI to configure decompression rules:
config load-balance decompression
edit <name>
set cpu-limit {enable | disable}
set max-cpu-usage [1-100]
set uri-list-type {include | exclude}
config uri_list
edit <ID>
set uri <refex_pattern>
next
end
config content-types
edit <ID>
set content-type <types>
{
application/javascript
application/soap+xml
application/x-javascript
application/xml
custom <plain-string>
text/css
text/html
text/javascript
text/plain
text/xml
}
next
end

You can use the CLI to select a decompression rule in a server load balance profile
(HTTP):
config load-balance profile
edit <name>
...
set decompression <decompression name>
...
next
end

Using decompression with script data body manipulation

Script data body manipulation can work in tandem with compression or decompression rules in a rather transparent way.
When a decompression rule is configured and used with scripting, FortiADC will decompress HTTP data first, then apply
script data body manipulation, and then re-compress the data before sending it to clients.

So, if HTTP data is compressed before being sent out from the real server, you must create a decompression rule if you
want to access the original data and use it in a script. This can be done either via the GUI or the Console. The following
paragraphs show you the basic steps for configuring decompression rules to work with script data body manipulation.
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From the GUI

Step 1: Creating a decompression rule

1. Click Server Load Balance > Application Resources > Decompression.
2. Click Create New to open the Decompression configuration dialog.
3. For Name, specify a unique name for the decompression rule.
4. For URI Rule Type, select Include or Exclude.
5. Click Save. The dialog closes and the decompression rule appears in the Decompression table.
6. Double-click the decompression rule (or click the corresponding Edit button) to open it.
7. In the URI Rule section, make the desired configuration. (Optional)
8. In the Content Types sections, make the desired configuration. (Optional)
9. Click Save.
10. Repeat the above steps to create as many decompression rules as needed.

Step 2: Configuring a load balance profile

1. Click Server Load Balance > Application Resources > Application Profile.
2. Click Create New to open the Application Profile configuration dialog.
3. For Type, click the down arrow and select HTTP or HTTPS from the list menu.
4. For Decompression, click the down arrow and select a decompression rule from the list menu.
5. Complete all the other fields required for load-balancing profile configuration.
6. Click Save.

Step 3: Enabling scripting in virtual server configuration

1. Click Server Load Balance > Virtual Server > Virtual Server.
2. Click Add > Advanced Mode.
3. For Type (under the Basic section), be sure to select Layer 7.
4. For Profile (under the General section), be sure to select an HTTP or HTTPS profile associated with the

decompression rules that you have configured.
5. For Scripting, be sure to turn it on (enable it), and then select the desired script or scripts.
6. Complete all the other fields required for virtual server configuration.
7. Click Save.

From the Console

Use the following example commands as a reference when configuring decompression and script data body
manipulation from the Console.

Step 1: Creating a decompression rule

config load-balance decompression
edit "decompress"
set uri-list-type include
config uri_list
edit 1
set uri /
next
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end
config content_types
edit 1
set content-type text/html
next
end
next
end

Step 2: Configuring a load balance profile

config load-balance profile
edit "http"
set type http
set decompression decompress
next
end

Step 3: Enabling scripting in virtual server configuration

config load-balance virtual-server
edit "vs"
set load-balance-profile http
set scripting-flag enable
set scripting-list data
next
end

Configuring Captcha

FortiADC allows administrators to validate incoming users with CAPTCHAs to determine whether a client is a regular
user or an attacker. FortiADC can configure the WAF/DoS Policy to issue CAPTCHAs only to clients who meet the attack
rules.

Select a FortiADC default captcha profile from within the virtual server configuration or upload a customized captcha
page if you want to use your own captcha verification page for when anWAF/DoS attack detected.

Before you begin:

l You must have Read-Write permission for Server Load Balance settings.
l Copy the captcha file to a location you can reach from your browser; the captcha file must be named
l index.html it must include a tag called “%%FORTIADC_CAPTCHA_IFRAME%%” and be compressed as tar, tar.gz,
or zip file. The maximum file size is 1 MB.

To upload a Captcha page file:

1. Go to Server Load Balance > Application Resources.
2. Click the Captcha tab.
3. Click Create New to display the configuration editor.
4. Enter the name of the captcha. You will use this name to select the captcha profile in virtual server

configurations. No spaces.
5. Toggle the Customized Captcha Page and then click Choose File and browse and select the captcha page tar,
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tar.gz, or zip file. The maximum file size is 1MB.
6. Save the configuration.

Parameter Description

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No
spaces are allowed. Maximum length 63. Note: After you initially save the
configuration, you cannot edit the name.

Virtual Path Virtual path of captcha function. This path is running on VS, so it will conflict with
other configurations like errorpage’s vpath and custom auth page. String type, not
empty, maximum length 63, the default value is “/fortiadc_captcha/”

Max Attempts Maximum attempts for Captcha verification. Integer type, range 1-100, default 5.
The client will be blocked upon exceeding max attempts.

Max Picture Changes The maximum number of times you can change another picture. Integer type,
range 1- 100, default 5. Exceed change times change picture action won’t
success.

Picture Difficulty There are two difficulty level here can be selected, hard and easy. hard level
picture may fight AI picture recognition, but may cause difficulty in human
identification. Default value is hard.

Max Block Period Once client is blocked, how long it will be blocked. Integer type, range 10-
2592000, default 86400. Exceed this time client will be reset to untracked state.

Max Verify Period The longest verification time from captcha verify action start. Unit second, range
20- 86400, default 1200. Exceed this time the client will be blocked.

Customized Captcha Page Switch for customize captcha page, default disable. If disable, the custom captcha
package file option won’t valid.

File File package for customize captcha page. Click ‘Choose File’ to upload.
The file package must include index.html file, and in the index page, it must
include a tag called “%%FORTIADC_CAPTCHA_IFRAME%%”, that we will insert
the verify page box on it.
Note: This option is only available when the ‘Customized Captcha Page’ is
enabled.

Captcha Configuration

Application Optimization

The Server Load Balance > Application Optimization sub-menu allows you to perform the following tasks relating to
the optimizing applications for server load balancing:

l Creating a Page Speed configuration on page 440
l Creating Page Speed profiles on page 441
l Configuring compression rules on page 443
l Using caching features on page 445
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Creating a Page Speed configuration

A Page Speed configuration sets the rule(s) that FortiADC follows when rendering web pages. Creating a Page Speed
configuration object involves the following:

l Specify the inode/file cache limits
l Choose a Page Speed profile (Must be configured in advance)
l Set page control
l Set resource control

To create a Page Speed configuration object:

1. Click Server Load Balance > Application Optimization.
The configuration page displays the Page Speed tab.

2. Click Create New to display the configuration editor.
3. Make the entries or selections as described in PageSpeed configuration on page 440.
4. Click Save when done.

Parameter Description

PageSpeed

Name Enter a name for the PageSpeed configuration object that you are creating.

File Cache Inode Limit Specify the maximum number of inodes that can be cached on FortiADC for this virtual
server. The default is 10,000. Valid values range from 1 to 100,000.
Note: An inode is a data structure with information about files or directories on a
filesystem on Linux or other Unix-type operating systems. It's generated when a
filesystem is created. Within a filesystem, every file and directory has a corresponding
inode identified by an inode number. Each inode contains the attributes and disk block
location(s) of the file's or directory's data, which may include metadata (e.g., access
mode, times of last change, modification) and user, ownership, and permission data.
A filesystem has a set number of inodes, which indicates the maximum number of files
or directories it can hold. A FortiADC appliance can support up to 100,000 inodes.
Every time you open a file, the kernel of the server reads the file's inode. The more files
and directories you have, the more inodes the server uses. And the more inodes the
server uses, the more system resources it consumes. So it is always a good practice to
try to limit the number of inodes a host has on a shared server. This will prevent it from
using all system resources.
To ensure efficient use of its resources, FortiADC cleans its cache every 10 minutes. It
cleans the cache only when either of the following conditions is met:
l The virtual server has reached its set inode cache limit.
l The virtual server has reached its file size cache limit.

When performing cache clean-up, FortiADC will use the "first-in first-out" (FIFO)
principle to remove the oldest cached inodes or files until the cached data is reduced to
less than 75% of its set inode- or file-cache limit(s).

File Cache
Size Limit

Specify the maximum file size that can be cached on FortiADC for this virtual server. The
default is 128. Value values range from 1 to 512 (MB).

PageSpeed configuration
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Parameter Description

PageSpeed Profile Select a PageSpeed profile from the list menu.
Note: You must have PageSpeed profiles created before you start to create a
PageSpeed rule. For instructions on how to create a PageSpeed profile, refer to
Creating Page Speed profiles on page 441

Page Control

Type Select either of the following page control types:
l Include— If selected, FortiADC will process Web pages associated with the
URI specified below.

l Exclude— If selected, FortiADC will skip Web pages associated with the
URI specified below.

URI Pattern Specify the full URI in regular expression. For example,
(http(s)://)*example.com/*/htmls/*.html

Note: In the HTTP response body, HTML sometimes is linked to a certain resource URL.
If the resource contains a domain name, then FortiADC will do the fetch according to the
fetch-domain setting or the rewrite-domain setting.
Wildcards include * (asterisk) which matches any 0 (zero) or more characters, and ?
(question mark) which matches exactly one character. Unlike Unix shells, the / directory
separator is not special, and can be matched by either * or ?. The resources are always
expanded into their absolute form before expanding.
A wildcard will be matched against the full URL, including any query parameters. For
example, you can use "*.jsp*" to match
http://example.com/index.jsp?test=xyz.

Resource Control

Origin Domain Patten Specify the original domain pattern in regular expression in alphanumeric characters.
For example, (http(s)://)*.example.com
Note: Valid characters are 0– 9, a–z, A–Z, . (period), : (colon), hyphen (-) and / (forward
slash). The FortiADC 4.8.0 release only supports HTTP or HTTPS.
To improve web page performance, PageSpeed will examine and modify the content of
the resources referenced on web pages. It does that by fetching those resources using
HTTP, according to the URL reference specified on an HTML page.

Rewrite Domain Specify the fetch domain string. For example, http://www.example.com
Valid characters are 0– 9, a–z, A–Z, . (period), : (colon), hyphen (-) and / (forward slash).
The FortiADC 4.8.0 release only supports HTTP or HTTPS.

Fetch Domain Specify the rewrite domain string. For example, http://www.example.com
Valid characters are 0– 9, a–z, A–Z, . (period), : (colon), hyphen (-) and / (forward slash).
The FortiADC 4.8.0 release only supports HTTP or HTTPS.

Creating Page Speed profiles

Page Speed provides a technology solution to speed up web application response and optimize web pages and
resources in real time.
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As a module on FortiADC device, Page Speed is simple to deploy and does not require any integration into Web
application servers or any client installation on end-user devices. With the Page Speed feature, you can select the
approach(es) to make your web site faster and more user-friendly.

A Page Speed profile specifies the option(s) for optimizing the delivery of web applications. To take full advantage of the
benefits that Page Speed offers, you must first create your own Page Speed profiles and then select the application
optimization option(s) to add to them. Once you have your own Page Speed profiles created, you can simply select them
to include in any Page Speed configurations you create.

FortiADC offers options for optimizing the delivery of the following web content:

l HTML
l CSS
l Image

To create a Page Speed profile:

1. Go to Server Load Balance > Application Optimization.
2. Click the Page Speed Profile tab.
3. Make the entries or selections as described in Application optimization parameters on page 442.
4. Click Save when done.

Parameter Description

HTML Disable (default) or enable HTML optimization. If enabled, you must also select a
specific option(s) below.
Note: FortiADC supports optimization of compressed HTML files.

Move CSS to Head If selected, FortiADC will move CSS elements above script tags.
Note: This ensures that the CSS styes are parsed in the head of the HTML page
before any body elements are introduced,. In so doing, it can effectively reduce the
number of times web browsers have to re-flow HTML documents.

CSS Disable (default)/enable CSS optimization.
Note: If enabled, you must also select the specific option(s) below.

Combine CSS If selected, FortiADC will combine multiple CSS elements into one.
Note: This option replaces multiple CSS files with a combined CSS file that contains
the contents of all individual CSS files. As a result, it can reduce the number of
HTTP/HTTPS requests web browsers make during page refresh. This is particularly
beneficial to older browsers that can handle only up to two connections per domain.
Not only can this reduce the overhead for HTTP/HTTPS headers and
communications warm-up, but also work well with TCP/IP slow-start because it
increases the effective payload bit rate through a browser's network connection.

Maxi Combine CSS Byte Specify the maximum number of CSS bytes that can be combined. The default is
4,096.
Note: Valid values range from 1 to 10,240.

Image Disable (default)/enable image optimization.
Note: If enabled, you must also select the specific option(s) below.

Application optimization parameters
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Parameter Description

Resize Image Disabled by default. If enabled, this will reduce the dimension of an image to the
"width=" and "height=" attributes defined in the <img> tag or in the inline
"style=attibute".

Note:
l The option will remove color profile and metadata.
l The re-sized image may also be re-compressed or converted to a new format and
quality based on user configuration.

l This option applies to .jpg, .png, and .webp images only.

JPEG Sampling Disabled by default.When enabled, it will apply 4:2:0 chroma subsampling to .jpg
images, in which hue and saturation have only 25% as many samples as brightness.
Because the human eye is less sensitive to hue and saturation than to brightness, this
subsampling technique can greatly reduce image size with no noticeable effect on
perception

Configuring compression rules

To offload compression from your back-end servers, you can configure FortiADC to perform HTTP/HTTPS compression
on behalf of the server.

The following content types can be compressed:

l application/javascript
l application/soap+xml
l application/x-javascript
l application/xml
l text/css
l text/html
l text/javascript
l text/plain
l text/xml
l custom

Not all HTTP.HTTPS responses should be compressed. Compression offers the greatest performance improvements
when applied to URIs whose media types include repetitive text such as tagged HTML and JavaScript. Files that already
contain efficient compression such as GIF images usually should not be compressed, as the CPU usage and time spent
compressing them will result in an increased delay rather than network throughput improvement. Plain text files where
no words are repeated, such as configurations with unique URLs or IPs, also may not be appropriate for compression.

You can offload HTTP/HTTPS response compression to FortiADC to save resources on your back-end servers, and
allow FortiADC to decompress compressed HTTP/HTTPS client requests for WAF inspection before passing them to
your back-end servers.

FortiADC supports HTTP/HTTPS response compression in either gzip or deflate format.

Before you begin:

l You must have a good understanding of HTTP/HTTPS compression and knowledge of the content types served
from the back-end real servers.
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l You must have Read-Write permission for Load Balance settings.

Compression is not enabled by default. After you have configured a compression inclusion rule, you can select it in the
profile configuration. To enable compression, select the profile when you configure the virtual server.

To configure a compression rule:

1. Click Server Load Balance > Application Optimization.
2. Click the Compression tab.
3. Click Add to display the configuration editor.
4. Complete the configuration as described in Compression configuration on page 444.
5. Save the configuration.

Settings Guidelines

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces. You reference
this name in the profile configuration.
Note: After you initially save the configuration, you cannot edit the name.

URI List Type l Include— Select this option to create a compression inclusion rule. HTPP/HTTPS 
responses that match the URIs and content types specified in this rule will be
compressed by FortiADC before being passed to the client.

l Exclude—Select this option to create a compression exclusion rule. HTPP/
HTTPS responses that match the URIs and content types specified in this rule will not be
compressed by FortiADC before being passed to the client.

URI Rule Click Add and specify the URI to create the rule. Note: You must use a regular expression,
e.g., https://example.com/tmp/test.txt.

Content Types Click Add and select from the following content types to build the list:
l application/javascript
l application/soap+xml
l application/x-javascript
l application/xml
l text/css
l text/html
l text/javascript
l text/plain
l text/xml
l custom

Note: The "custom" option allows you to specify almost any content/media type, including
image files in .JPG, .PNG, and .BMP formats. The default is */*, which means any
content/media type.

Compression configuration
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You can use the CLI to configure advanced options:
config load-balance compression
edit 1
set cpu-limit {enable | disable}
set max-cpu-usage <percent> -- max cpu usage for compression
set min-content-length <bytes> -- min bytes for compression
end

Using caching features

The system RAM cache can store HTTP content and serve subsequent HTTP requests for that content without
forwarding the requests to the backend servers, thereby reducing the load on the backend servers.

You can configure basic static caching or dynamic caching rules.

Static caching

 Static caching feature on page 445 illustrates the static caching feature.

 Static caching feature

Before content is cached After content has been cached

1. FortiADC receives the request from Client A and
checks to see if it has a cached copy of the content.

2. If it does not, it forwards the request to a backend
server.

3. The server sends content in response, and FortiADC
caches the content.

4. FortiADC sends it to the client.

1. FortiADC receives the request from Client B and
checks to see if it has a cached copy of the content.

2. It does, so it responds by sending the content to the
client. The backend server is not contacted.
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In general, the RAM cache conforms with the cache requirements described in sections 13 and 14 in RFC 2616.

If caching is enabled for the profile that is applied to traffic processing, the system evaluates HTTP responses to
determine whether or not to cache the content. HTTP responses with status codes 200, 203, 300, 301, 400 can be
cached.

The following content is not cached:

l A response for a request that uses any method other than GET.
l A response for a request of which URI is contained in URI Exclude List or Dynamic Request URI Invalid list.
l A response for a request that contains any of the following headers: If-Match, If-Unmodified-Since, Authorization,
Proxy-Authorization.

l A response that contains any of the following headers: Pragma, Vary, Set-Cookie, and Set-Cookie2.
l A response that does not include the Content-Length header. The Content-Length header must be 0.
l A response that does not contain the following headers: Cache-Control, Expires.
l A response with a Cache-Control header that does not have any of the following values: public, max-age, s-
maxage.

l A response with a Cache-Control header that has one of the following values: no-cache, no-store, private.

In addition, content is not cached if the user-configured RAM cache thresholds described below are exceeded.

Dynamic caching

Dynamic caching is subject to rules you configure. In the Dynamic Caching Rules List, content that matches "caching
invalid" URIs is never cached; otherwise, content that matches the Dynamic Cache Rule List of URIs is cached for the
period you specify.

Dynamic caching is useful for dynamic web app experiences, such as online stores. For example, suppose a site uses a
shopping cart. The URL to list items in the shopping cart is as follows:

http://customshop.com/cart/list

The URLs to add or delete items in the cart is as follows:

http://customshop.com/cart/add

http://customshop.com/cart/delete

In this case, you never want to cache the added or deleted pages because the old content will be "invalidated" by the
changes you make. You may want, however, to cache the list page, but only for the period of time that you specify. The
dynamic "invalid" rules makes it possible for you to never cache added and deleted pages, whereas the Dynamic Cache
Rule List allows you to cache the list page for a specified period of time.

Another case where dynamic caching is useful is when content on a page is dynamic. For example, suppose an online
ticket vendor has the following URL that shows how many tickets remain available for an
event: http://customshop.com/tickets/get_remains. The number of tickets available is updated by a backend database.
In this case, you might want to invalidate caching the URL or give it a small age out time.

Configuring caching rules

Before you begin:

l You must have a good understanding of caching and knowledge about the size of content objects clients access on
the backend servers.
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l You must have deep and detailed knowledge of your website URIs if you want to create dynamic caching rules.
l You must have Read-Write permission for Load Balance settings.

Caching is not enabled by default. After you have configured caching, you can select it in the profile configuration. To
enable caching, select the profile when you configure the virtual server.

To configure caching:

1. Click Server Load Balance > Application Optimization.
2. Click the Caching tab.
3. Click Create New to display the Caching configuration editor.
4. Complete the configuration as described in Caching configuration on page 447.
5. Save the configuration.

Settings Guidelines

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces. You reference
this name in the profile configuration.
Note: After you initially save the configuration, you cannot edit the name.

MaximumObject
Size

The default is 1 MB. The valid range is 1 byte to 10 MB.

Maximum Cache
Size

The default is 100 MB. The valid range is 1 byte to 500 MB.

Maximum Entries The default is 10,000. The valid range is 1 to 262,144.

Maximum Age The default is 43,200 seconds. The valid range is 60 to 86,400.
The backend real server response header also includes a maximum age value. The FortiADC
system enforces whichever value is smaller.

URI Exclude List

URI Specify URIs to build the list. You can use regular expressions.
This list has precedence over the Dynamic Cache Rule List. In other words, if a URI matches
this list, it is ineligible for caching, even if it also matches the Dynamic Cache Rule list.

Dynamic Cache Rule List

ID Enter a unique ID. Valid values range from 1 to 1023.

Age Timeout for the dynamic cache entry. The default is 60 seconds. The valid range is 1-86,400.
This age applies instead of any age value in the backend server response header.

URI Pattern to match the URIs that have content you want cached and served by FortiADC.
Be careful with matching patterns and the order rules in the list. Rules are consulted from
lowest rule ID to highest. The first rule that matches is applied.

Invalid URI Pattern to match URIs that trigger cache invalidation.

Caching configuration
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Settings Guidelines

Be careful with matching patterns and the order rules in the list. Rules are consulted from
lowest rule ID to highest. The first rule that matches is applied.
This list has precence over the Dynamic Cache URI list. In other words, if a URI matches this
list, it is ineligible for caching, even if it also matches the Dynamic Cache URI list.

Real Server Pool

The Server Load Balance > Real Server Pool sub-menu allows you to perform the following tasks relating to the real
server pool for server load balancing:

l Using real server pools on page 448
l Configuring real servers on page 454
l Configuring real server SSL profiles on page 457

Using real server pools

This section includes the following topics:

l Configuring real server pools
l Example: Using port ranges and the port 0 configuration

Configuring real server pools

Server pools are groups of real servers that host the applications that you load balance.

To configure a server pool:

1. Create a server pool object.
2. Add members.

Before you begin:

l You must have a good understanding and knowledge of the backend server boot behavior, for example, how many
seconds it takes to “warm up” after a restart before it can process traffic.

l You must know the IP address and port of the applications.
l If you want to select user-defined health checks, you must create them before creating the pool configuration. See
Configuring health checks.

l If you want to select user-defined real server SSL profiles, you must create them before creating the pool
configuration. See Configuring real server SSL profiles.

l You must have Read-Write permission for Load Balance settings.

After you have configured a real server pool, you can select it in the virtual server configuration.
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To configure a real server pool:

1. Go to Server Load Balance > Real Server Pool.
The configuration page displays the Real Server Pool tab.

2. Click Create New to display the configuration editor.
3. Configure the following settings for the Real Server Pool:

Settings Guidelines

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces. You
reference this name in the virtual server configuration.

Note: After you initially save the configuration, you cannot edit the name.

Address Type l IPv4
l IPv6

Type Select the server type:
l Static
l Dynamic

SDN Connector The SDN Connector option is available if Type is Dynamic.
Select an existing SDN connector configuration.

Service The Service option is available if Type is Dynamic.
Specify the service for the SDN connector.

IP Address Type The IP Address Type option is available if Type is Dynamic and when FortiADC is
deployed on public cloud platforms.
Select whether the SDN connector should get the private address or public address of the
instances.
FortiADC will get the IP addresses of the real servers from the FortiADC instance
deployed on the public cloud platform, and dynamically populate the objects in the server
pool configuration. The resulting real server pool configurations will have the server type
Dynamic Auto.

Health Check Enable health checking for the pool. You can override this for individual servers in the
pool.

Health Check
Relationship

The Health Check Relationship option is available if Health Check is enabled.
l AND—All of the selected health checks must pass for the server to the considered
available.

l OR—One of the selected health checks must pass for the server to be considered
available.

4. Click Save to save the real server pool parent configuration.
TheMember section becomes available to add real server pool member configurations.
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5. Under theMember section, click Create to display the configuration editor.
6. Configure the following settings for the real server poolMember:

Settings Guidelines

Status l Enable—The server can receive new sessions.
l Disable—The server does not receive new sessions and closes any current sessions
as soon as possible.

l Maintain—The server does not receive new sessions but maintains any current
connections.

Real Server Click the down arrow and select a real server configuration object from the list menu.
Note: The name of the selected real server pool member will appear in logs and reports.

Port Enter the backend server's listening port (number), as described below:
l HTTP—80,
l HTTPS—443
l FTP—21
l SMTP—25
l DNS—53
l POP3—110
l IMAP4—143
l RADIUS—1812
l SNMP—161

Tip: The system uses Port 0 as a “wildcard” port. When configured to use Port 0, the
system uses the destination port from the client request. For example, if you specify 0, and
the destination port in the client request is 50000, the traffic will be forwarded to Port
50000.

Weight Assigns relative preference among members—higher values are more preferred and are
assigned connections more frequently. The default is 1. The valid range is 1 to 256.
All load balancing methods consider weight. Servers are dispatched requests proportional
to their weight, relative to the sum of all weights.
The following example shows the effect of weight on Round Robin:
l Sever A, Weight 2; Server B, Weight 1: Requests are sent AABAAB.
l Sever A, Weight 3; Server B, Weight 2: Requests are sent AABAB.

For other methods, weight functions as a tie-breaker. For example, with the Least
Connection algorithm, requests are sent to the server with the least connections. If the
number of connections is equal, the request is sent to the server with the greater weight.
For example:
l Server A, Weight 1, 1 connection
l Server B, Weight 2, 1 connection
l The next request is sent to Server B.

Recover Seconds to postpone forwarding traffic after downtime, when a health check indicates that
this server has become available again. The default is 0 (disabled). The valid range is 1 to
86,400 seconds. After the recovery period elapses, the FortiADC assigns connections at
the warm rate.
Examples of when the server experiences a recovery and warm-up period:
l A server is coming back online after the health check monitor detected it was down.
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Settings Guidelines

l A network service is brought up before other daemons have finished initializing and
therefore the server is using more CPU and memory resources than when startup is
complete.

To avoid connection problems, specify the separate warm-up rate, recovery rate, or both.
Tip: During scheduled maintenance, you can also manually apply these limits by setting
Status to Maintenance instead of Enable.
Note: Not applicable for SIP servers.

Warm Up If the server cannot initially handle full connection load when it begins to respond to health
checks (for example, if it begins to respond when startup is not fully complete), indicate
how long to forward traffic at a lesser rate. The default is 0 (disabled). The valid range is 1
to 86,400 seconds.
Note: Not applicable for SIP servers.

Warm Rate Maximum connection rate while the server is starting up. The default is 10 connections per
second. The valid range is 1 to 86,400 connections per second.
The warm up calibration is useful with servers that have the network service brought up
before other daemons have finished initializing. As the servers are brought online, CPU
and memory are more utilized than they are during normal operation. For these servers,
you define separate rates based on warm-up and recovery behavior. For example, if
Warm Up is 5 andWarm Rate is 2, the number of allowed new connections increases at
the following rate:
l 1st second—Total of 2 new connections allowed (0+2).
l 2nd second—2 new connections added for a total of 4 new connections allowed
(2+2).

l 3rd second—2 new connections added for a total of 6 new connections allowed
(4+2).

l 4th second—2 new connections added for a total of 8 new connections allowed
(6+2).

l 5th second—2 new connections added for a total of 10 new connections allowed
(8+2).

Note: Not applicable for SIP servers.

Connection Limit Maximum number of concurrent connections to the backend server. The default is 0
(disabled). The valid range is 1 to 1,048,576 concurrent connections.
Note: Connection Limit is not supported for FTP or SIP servers.

Connection Rate
Limit

Limit the number of new connections per second to this server. The default is 0 (disabled).
The valid range is 1 to 86,400 connections per second.

In Layer 4 deployments, you can apply a connection rate limit per real server and per
virtual server. Both limits are enforced.

Note: The connection rate limit applies only when the real servers belong to a Layer 4
virtual server. If you add a real server pool with this setting configured to a Layer 7 virtual
server, for example, the setting is ignored.

Note: Connection Rate Limit is not supported for FTP or SIP servers.
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Settings Guidelines

Cookie Specify the cookie name to be used when cookie-based Layer 7 session persistence is
enabled. The cookie is used to create a FortiADC session ID, which enables the system to
forward subsequent related requests to the same backend server.
If you do not specify a cookie name, it is set to the pool member server name string.
Note: This option is NOT applicable for SIP servers.

MySQL Group ID Specify the MySQL group ID.

MySQL Read Only Disabled by default. Select the button to enable it.

Backup Designate this as a backup server to which FortiADC will direct traffic when the other
servers in the pool are down. The backup server receives connections when all the other
pool members fail the health check or you have manually disabled them.
Note: Not applicable for SIP servers.

Health Check Inherit When enabled, FortiADC will use the pool's health check settings. If disabled, you must
select a health check to use with this individual backend server. See below.

Health Check Select this option to specify a health check configuration object for this server.
Note: This option becomes available only when

Health Check
Relationship

l AND—All of the selected health checks must pass for the server to the considered
available.

l OR—One of the selected health checks must pass for the server to be considered
available.

Health Check List Select one or more health check configuration objects. Shift-click to select multiple objects
at the same time.

RS Profile Inherit Enable to inherit the real server SSL profile from the pool configuration. Disable to specify
the real server profile in this member configuration. See below.

RS Profile If RS Profile Inherit (above) is disabled, you must specify a real server SSL profile. A real
server SSL profile determines the settings for communication between FortiADC and
backend real server.
Note: This option becomes available only when RS Profile Inherit is disabled.

Proxy Protocol This is a protocol of application layer, which is located upper layer of HTTP and SSL, and
it contains a head to description the real IP address of client. There two major version of
this protocol v1 and v2.
Support none, v1, v2. None will disable this function and it’s the default value, v1 and v2 is
different version of this protocol, the v1 version is human readable.
You need co-deployment with FortiWeb, and because X-Forword-For option isn’t valid for
them they demand use proxy protocol to deliver the real client’s IP address to them.
Only support : HTTP/HTTPS/TCPS/RDP, Either L7 and L2 VS of these type can support
it.

Modify Host Enable to allow FortiADC to modify the HTTP header according to the "host" field of the
real server. This is disabled by default.

Host The Host option is available ifModify Host is enabled.
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Settings Guidelines

Specify the host as a string. This field cannot be left empty. The input validation regex is
([0-9A-Za-z+/?%$#&\=.:_-]|\[|])+$, maximum of 255 characters. The default
value is host.

7. Click Save.
The newly created real server pool member is listed under theMember section.
Optionally, you can configure the column settings to view and sort the real server pool members, such as adding the
FQDN column that is not included in the default view.
Note: Real Server Pool members that are generated from the auto populate function cannot be cloned or edited.

When cloning a Real Server Pool that has auto-populated pool members, the cloned
configuration will initially appear without the auto-populated pool members. However, the
auto-populated pool members will appear again once the cloning operation is complete.

Example: Using port ranges and the port 0 configuration

In some deployments, it is advantageous to support listening port ranges for client requests. For example, data centers
or web hosting companies sometimes use port numbers to identify their customers. Client A sends requests to port
50000, client B to port 50001, client C to port 50002, and so on.

To support this scenario:

1. On the real servers, configure the listening ports and port ranges according to your requirements.
2. On the FortiADC, when you configure the real server pool member, specify port 0 for the port. The system handles

port 0 as a “wildcard” port. When configured to use port 0, the system uses the destination port from the client
request. For example, if you specify 0, and the destination port in the client request is 50000, the traffic is forwarded
to port 50000.

3. When you configure the virtual server, specify a listening port and port range. The port range is like an offset. If the
specified port is 50000 and the port range is 10, the virtual server listens on ports 50000-50009.

Key FortiADC configuration elements
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Note: Ports shown on the Dashboard > Virtual Server > Real Server page are for the configured port, so in this case, port
0. The ports shown in traffic logs are the actual destination port, so in this case, port 50000.

Note: The real-server port must be 0 or the same as the virtual server port for Layer-4 virtual servers in tunnel mode.

Configuring real servers

Real servers are physical servers that are used to form real server pools. These dedicated servers provide clients with
services such as HTTP or XML content, streaming audio or video, TFTP/FTP uploads and downloads, etc. You can start
configuring a real server by giving it a unique configuration name, setting its status, and specifying its IP address.

After you have created your real server configuration objects, you can select them as members to form real server pools.
At that stage, further configurations are needed as discussed in Using real server pools on page 448.

To configure a real server configuration object:

1. Go to Server Load Balance > Real Server Pool.
2. Click the Real Server tab.
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3. Click Create New to display the configuration editor.
4. Configure the following settings:

Settings Guidelines

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces. You
reference this name in the virtual server configuration.
Note: After you initially save the configuration, you cannot edit the name.

Server Type Select the real server type:
l Static
l Dynamic Manual
l Dynamic Auto*

*Note: The Dynamic Auto server type is not a selectable option. The Dynamic Auto
server type is used to mark real servers that have been dynamically populated using
the IP addresses from the FortiADC instances deployed on public cloud platforms.

Status Select one of the options:
l Enable — The server can receive new sessions.
l Disable — The server does not receive new sessions and closes any current
sessions as soon as possible.

l Maintain — The server does not receive new sessions but maintains any
current connections.

Type The Type option is available if the Server Type is Static.
Select the static server type to use for DNS resolution:
l IP — Use the specified IPv4 Address or IPv6 Address.
l FQDN—Use the specified FQDN of the Real Server for DNS resolution. The
address will be resolved by the DNS query. Only one IPv4 or IPv6 address will
be used to form the real server.

l FQDN Populate More— Use the specified FQDN of the Real Server for DNS
resolution. The address will be resolved by the DNS query. Multiple IPv4 or
IPv6 addresses will be used to form the real server. A maximum of 16 IPv4 or
IPv6 addresses is supported for one domain.
If the DNS query gets more than 1 IP or IPv6 address for the Real Server
FQDN, then the system will automatically generate real servers based on the
specified FQDN.
Only select the FQDN Populate More option when creating a new Real Server
configuration. If an existing real server configuration set to IP or FQDN type is
changed to FQDN Populate More, the auto-population function will fail to
populate pool members.

Address The Address option is available if the Server Type is Static and the Type is IP.
For IPv4 real server, enter the real server's IP address in IPv4 address format.

Address6 The Address6 option is available if the Server Type is Static and the Type is IP.
For IPv6 real server, enter the real server's IP address in IPv6 address format.

FQDN The FQDN option is available if the Server Type is Static and the Type is FQDN or
FQDN Populate More.
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Settings Guidelines

Specify a fully qualified domain name, such as "www.example.com". This is
required.

Auto Populate The Auto Populate field appears if the Server Type is Static and the Type is
FQDN Populate More.
Auto Populate is a read-only status that indicates whether or not a real server was
auto-generated through FQDN Populate More.
l Disabled— By default, Auto Populate is disabled. This indicates that the
current real server configuration is not auto-generated.

l Enabled— This indicates that the current real server configuration was
automatically generated by the system based on the "parent" real server's
FQDN. If the DNS query gets more than 1 IP or IPv6 address for the Real
Server FQDN of the
parent" real server, then the system will automatically populate real servers
based on the specified FQDN, with the "child" real server name based on the
"parent" real server name as specified in the Auto Populate From field (read-
only). The auto-generated real servers will be read-only and cannot be cloned
or edited.

SDN Connector The SDN Connector is available if the Server Type is Dynamic Manual.
Specify a previously configured SDN Connector. For details, see External
connectors.

Instance The Instance is available if the Server Type is Dynamic Manual.
Specify the instance of your SDN Connector.

5. Click Save.
The new real server configuration appears on the Real Server page.
For real servers with the type FQDN Populate More, real servers will automatically generate if there are more than
1 IP/IPv6 addresses associated with the specified FQDN. The auto-generated real servers will be read-only and
cannot be cloned or edited.
Auto-generated real servers will be named after the "parent" real server and a combination of sequential numbers
and random numbers, in the following format:
Real Server Name_\d\d_random number
For example:
If the parent Real Server Name is "xxx", then the name of the auto-generated real server can be "xxx_01_
69104274032".

The Auto Populate and Auto Populate From fields are read-only information to indicate the origin of the auto-
generated real server.
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The FQDN Populate More real server type is only applicable to newly created real server
configurations. Do not edit an existing real server configuration set to IP or FQDN type to
FQDN Populate More as the auto-population will not function and pool members will not auto-
populate.

Configuring real server SSL profiles

A real server SSL profile determines settings used in network communication on the FortiADC-server segment, in
contrast to a virtual server profile, which determines the settings used in network communication on the client-FortiADC
segment.

SSL profiles on page 457 illustrates the basic idea of client-side and server-side profiles.

SSL profiles
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Predefined real server profiles on page 459 provides a summary of the predefined profiles. You can select predefined
profiles in the real server pool configuration, or you can create user-defined profiles.
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Profile Defaults

LB_RS_SSL_PROF_DEFAULT l Allow version: SSLv3, TLSv1.0, TLSv1.1, TLSv1.2, TLSv1.3
l Cipher suite list: custom

LB_RS_SSL_PROF_ECDSA l Allow version: SSLv3, TLSv1.0, TLSv1.1, and TLSv1.2
l Cipher suite list: ECDHE-ECDSA-AES256-GCM-SHA384,
ECDHE-ECDSA-AES256-SHA384, ECDHE-ECDSA-AES256-
SHA, ECDHE-ECDSA-AES128-GCM-SHA256,ECDHE-
ECDSA-AES128-SHA256,ECDHE-ECDSA-AES128-
SHA,ECDHE-ECDSA-RC4-SHA,ECDHE-ECDSA-DES-
CBC3-SHA,

LB_RS_SSL_PROF_ECDSA_
SSLV3

l Allow version: SSLv3
l Cipher suite list: ECDHE-ECDSA-AES256-SHA, ECDHE-
ECDSA-AES128-SHA,ECDHE-ECDSA-RC4-SHA,ECDHE-
ECDSA-DES-CBC3-SHA,

LB_RS_SSL_PROF_ECDSA_
TLS12

l Allow version: TLSv1.2
l Cipher suite list: ECDHE-ECDSA-AES256-GCM-SHA384,
ECDHE-ECDSA-AES256-SHA384, ECDHE-ECDSA-AES128-
GCM-SHA256,ECDHE-ECDSA-AES128-SHA256,

LB_RS_SSL_PROF_ENULL l Allow version: SSLv3, TLSv1.0, TLSv1.1, and TLSv1.2
l Cipher suite list:  eNull

Recommended for Microsoft Direct Access servers where the
application data is already encrypted and no more encryption is
needed.

LB_RS_SSL_PROF_HIGH l Allow version TLSv1.2
l Cipher suite list:  ECDHE-RSA-AES256-GCM-SHA384
ECDHE-RSA-AES256-SHA384 ECDHE-RSA-AES256-SHA
DHE-RSA-AES256-GCM-SHA384 DHE-RSA-AES256-
SHA256 AES256-GCM-SHA384 AES256-SHA256,

LB_RS_SSL_PROF_LOW_
SSLV3

l Allow version SSLv3
l Cipher suite list:  DHE-RSA-AES128-GCM-SHA256 DHE-
RSA-AES128-SHA256 DHE-RSA-AES128-SHA AES128-
GCM-SHA256 AES128-SHA256 AES128-SHA ECDHE-RSA-
RC4-SHA RC4-MD5 ECDHE-RSA-DES-CBC3-SHA EDH-
RSA-DES-CBC3-SHA DES-CBC3-SHA EDH-RSA-DES-CBC-
SHA DES-CBC-SHA

LB_RS_SSL_PROF_MEDIUM l Allow version: TLSv1.0, TLSv1.1, and TLSv1.2
l Cipher suite list:  ECDHE-RSA-AES128-GCM-SHA256
ECDHE-RSA-AES128-SHA256 ECDHE-RSA-AES128-SHA
DHE-RSA-AES128-GCM-SHA256 DHE-RSA-AES128-
SHA256 DHE-RSA-AES128-SHA AES128-GCM-SHA256
AES128-SHA256 AES128-SHA RC4-SHA EDH-RSA-DES-
CBC3-SHA DES-CBC3-SHA

Predefined real server profiles
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Profile Defaults

NONE l SSL is disabled.

Before you begin:

l You must have Read-Write permission for Load Balance settings.

To configure custom real server profiles:

1. Go to Server Load Balance > Real Server Pool.
2. Click the Server SSL tab.
3. Click Create New to display the configuration editor.
4. Complete the configuration as described in Real Server SSL Profile configuration guidelines on page 460.
5. Save the configuration.

You can clone a predefined configuration object to help you get started with a user-defined
configuration.

To clone a configuration object, click the clone icon that appears in the tools column on
the configuration summary page.

Settings Guidelines

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces. You
reference this name in the real server pool configuration.

Note: After you initially save the configuration, you cannot edit the name.

SSL Enable/disable SSL for the connection between the FortiADC and the real server.

Note: The following fields become available only when SSL is enabled. See above.

Customized SSL Ciphers
Flag

Enable/disable use of user-specified cipher suites. When enabled, you must select a
Customized SSL Cipher. See below.

Customized SSL Ciphers If the customize cipher flag is enabled, specify a colon-separated, ordered list of cipher
suites.
An empty string is allowed. If empty, the default cipher suite list is used.
The names you enter are validated against the form of the cipher suite short names
published on the OpenSSL website:
https://www.openssl.org/docs/manprimary/apps/ciphers.html

SSL Cipher Suite List Ciphers are listed from strongest to weakest:
l ECDHE-ECDSA-AES256-GCM-SHA384
l ECDHE-ECDSA-AES256-SHA384
l ECDHE-ECDSA-CAMELLIA256-SHA384

Real Server SSL Profile configuration guidelines
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l *ECDHE-ECDSA-AES256-SHA
l ECDHE-ECDSA-AES128-GCM-SHA256
l *ECDHE-ECDSA-AES128-SHA256
l ECDHE-ECDSA-CAMELLIA128-SHA256
l *ECDHE-ECDSA-AES128-SHA
l ECDHE-ECDSA-DES-CBC3-SHA
l ECDHE-ECDSA-RC4-SHA
l ECDHE-RSA-AES256-GCM-SHA384
l ECDHE-RSA-AES256-SHA384
l ECDHE-RSA-CAMELLIA256-SHA384
l *ECDHE-RSA-AES256-SHA
l DHE-RSA-AES256-GCM-SHA384
l *DHE-RSA-AES256-SHA256
l DHE-RSA-CAMELLIA256-SHA256
l *DHE-RSA-AES256-SHA
l DHE-RSA-CAMELLIA256-SHA
l AES256-GCM-SHA384
l *AES256-SHA256
l *AES256-SHA
l ECDHE-RSA-AES128-GCM-SHA256
l *ECDHE-RSA-AES128-SHA256
l ECDHE-RSA-CAMELLIA128-SHA256
l *ECDHE-RSA-AES128-SHA
l DHE-RSA-AES128-GCM-SHA256
l *DHE-RSA-AES128-SHA256
l DHE-RSA-CAMELLIA128-SHA256
l *DHE-RSA-AES128-SHA
l AES128-GCM-SHA256
l *AES128-SHA256
l *AES128-SHA
l ECDHE-RSA-RC4-SHA
l RC4-SHA
l RC4-MD5
l ECDHE-RSA-DES-CBC3-SHA
l EDH-RSA-DES-CBC3-SHA
l DES-CBC3-SHA
l EDH-RSA-DES-CBC-SHA
l DES-CBC-SHA
l eNULL

*These ciphers are fully supported by hardware SSL (in 400F, 1200F, 2200F, 4200F
and 5000F).
Note: We recommend retaining the default list. If necessary, you can deselect the SSL
ciphers that you do not want to support.
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TLSv1.3 Cipher Suite List TLSv1.3 ciphers are listed as following:
l TLS_AES_256_GCM_SHA384
l TLS_AES_128_GCM_SHA256
l TLS_CHACHA20_POLY1305_SHA256
l TLS_AES_128_CCM_SHA256
l TLS_AES_128_CCM_8_SHA256

Note: This option only available if the TLSv1.3 is checked.

Allowed SSL Versions You have the following options:
l SSLv3
l TLSv1.0
l TLSv1.1
l TLSv1.2
l TLSv1.3

Note:
l Please make sure that the SSL version is continuous. If not, an error message
should be returned.

l RFC 7919 Comply cannot support SSLv3 and TLS 1.3. If RFC 7919 Comply is
enabled and SSLv3 or TLSv1.3 is selected in Allowed SSL Versions, an error
message will display.

Certificate Verify Specify a Certificate Verify configuration object to validate server certificates. This
Certificate Verify object must include a CA group and may include OCSP and CRL
checks.

Local Certificate Select a local certificate object. This should be the backend servers' certificate, NOT the
appliance's GUI web server certificate. See Manage Certificates.

SNI Forward Flag Enable/disable forwarding the client SNI value to the server. The SNI value will be
forwarded to the real server only when the client-side ClientHello message contains a
valid SNI value; otherwise, nothing is forwarded.

Session Reuse Flag Enable/disable SSL session reuse.

Session Reuse Limit The default is 0 (disabled). The valid range is 0-1048576.

TLS Ticket Flag Enable/disable TLS ticket-based session reuse.

Renegotiation This option controls how FortiADC responds to mid-stream SSL reconnection requests
either initiated by real servers or forced by FortiADC.
Note:
l This option is enabled by default.
l When disabled, you must select an option for Renegotiation-Deny-Action.

Renegotiation Period Specify the interval from the initial connect time that FortiADC renegotiates an SSL
session. The unit of measurement can be second (default), minute, or hour, e.g., 100s,
20m, or 1h.
Note:
l The default is 0, which disables the function.
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l If a custom value is set, FortiADC will renegotiate the SSL session accordingly. For
example, if you set the renegotiate period to 3600s (or 3600, 60m, or 1h), FortiADC
will renegotiate the SSL session at least once an hour.

Renegotiate Size Specify the amount (in MB) of application data that must have been transmitted over the
secure connection before FortiADC initiates the renegotiation of an SSL session.
Note: The default is 0, which disables the function.

Secure Renegotiation Select one of the following options:
l Request—FortiADC requests secure renegotiation of SSL connections.
l Require—FortiADC requires secure renegotiation of SSL connections. In this
mode, FortiADC allows initial SSL handshakes from real servers, but terminates
renegotiation from real servers that do not support secure renegotiation.

l Require Strict—FortiADC requires strict secure renegotiation of SSL connections.
In this mode, FortiADC denies initial SSL handshakes from real servers that do not
support secure renegotiation.

Renegotiation-Deny-Action This option becomes available when Renegotiation is disabled on the server side. In
that case, you must select an action that FortiADC will take when denying an SSL
renegotiation request:
l Ignore (default)—Ignores SSL renegotiation requests.
l Terminate— Terminates SSL connections.

RFC 7919 Comply Enable/disable parameters to comply with RFC 7919.
Note: RFC 7919 Comply cannot support SSLv3 and TLS 1.3. If RFC 7919 Comply is
enabled and SSLv3 or TLSv1.3 is selected in Allowed SSL Versions, an error
message will display.

Supported Groups The Supported Groups option is available if RFC 7919 Comply is enabled.
Specify the supported group objects from the following:
l secp256r1
l secp384r1
l secp521r1
l x25519
l x448
l ffdhe2048
l ffdhe3072
l ffdhe4096
l ffdhe6144
l ffdhe8192

At least one item from the FFDHE group must be selected.
Note:
The RFC 7919 Comply feature requires certain cipher selections to correspond with the
Supported Group selection.
l If a FFDHE group is selected (for example, ffdhe2048), then at least one cipher
must be DHE-RSA (for example, DHE-RSA-AES256-SHA256).
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l If the Supported Group includes groups other than FFDHE (such as a SECP group,
secp256r1), then at least one cipher must be ECDHE (for example, ECDHE-
ECDSA-AES256-GCM-SHA384).

l If a ECDHE cipher is selected (for example, ECDHE-ECDSA-AES256-GCM-
SHA384), then the Supported Group must include at least one group that is not
FFDHE (such as a SECP group, secp256r1).

Scripting

The Server Load Balance > Scripting sub-menu allows you to perform the following tasks relating to using scripts for
server load balancing:

l Using HTTP scripting on page 464

Using HTTP scripting

Enable scripting for Layer 2 and Layer 7 HTTP/HTTPS virtual servers to perform actions that are not supported by the
current built-in feature set. You can import HTTP scripts from the GUI, Server Load Balance > Scripting > HTTP tab.
To get you started, FortiADC provides system predefined HTTP scripts that can be cloned for customization. The HTTP
scripts are event-triggered, allowing you to manipulate HTTP requests and responses, redirection, and dynamically
change backend routing. This functionality can be combined with other HTTP related functions such as WAF, SSL, and
Authentication.

FortiADC HTTP scripts are based on Lua 5.3.

FortiADC does not support all Lua functions. For the full list of supported functions, see Scripts
on page 840. The Appendix C: Scripts page also provides the supported list of events and
predefined commands.
Please note that Scriping is an as is feature and does not come with any functionality or
performance guarantees.

This section includes the following:

l Create a script object on page 465
l Import a script on page 465
l Export a script on page 465
l Delete a script on page 465
l Predefined HTTP scripts on page 465
l Multi-script support on page 471
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Create a script object

To create a script configuration object:

1. Go to Server Load Balance > Scripting.
2. Click the HTTP tab.
3. Click Create New to display the configuration editor.
4. Complete the configuration as described in Script configuration on page 465.
5. Save the configuration.

Settings Guidelines

Name Unique group name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces.
After you initially save the configuration, you cannot edit the name.

Input Type or paste the script.
Note: If you want the script to be part of a big multiple script and have it executed in a certain
order, be sure to set its priority. For more information, see Support for multiple scripts.

Script configuration

Import a script

To import a script:

1. Click Import
2. Click Choose File to browse for the script file.
3. Click Save.

Export a script

To export a script:

1. Select the script of interest.
2. Click Export.

Delete a script

To delete a script:

1. Select the script of interest.
2. Click Delete.

Predefined HTTP scripts

You can view and use predefined HTTP scripts by going to Server Load Balance > Scripting > HTTP.
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Scripts and predefined commands on page 466 highlights the functions of these scripts and commands and shows how
to use them.

Scripts and predefined commands

Note:

l UTILITY_FUNCTIONS_DEMO and CLASS_SEARCH_n_MATCH provide various utility commands.
l MULTIPLE_SCRIPT_CONTROL_DEMO_1 and MULTIPLE_SCRIPT_CONTROL_DEMO_2 show how to use
multiple-script support.

l HTTP_DATA_FIND_REMOVE_REPLACE_DEMO and HTTP_DATA_FETCH_SET_DEMO show how to
manipulate HTTP data.

l SPECIAL_CHARACTERS_HANDLING_DEMO shows how to handle certain special characters.
l INSERT_RANDOM_MESSAGE_ID_DEMO shows how to generate randommessage IDs.
l OPTIONAL_CLIENT_AUTHENTICATION shows how to perform optional client authentication based on a request
URL.

l COMPARE_IP_ADDR_2_ADDR_GROUP_DEMO shows how to perform IP address match.
l USE_REQUEST_HEADERS_in_OTHER_EVENTS shows how to share information across events.
l Many more predefined scripts are provided for load balance content routing, HTTP redirection, and HTTP content
rewriting.

The following table lists the FortiADC predefined scripts available for users to apply and customize.
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Predefined script Usage

AES_DIGEST_SIGN_2F_COMMANDS Demonstrate how to use AES to encryption/decryption data
and some tools to generate the digest.

AUTH_COOKIE_BAKE Allows you to retrieve the baked cookie and edit the cookie
content.

AUTH_EVENTS_n_COMMANDS Used to get the information from authentication process.

CLASS_SEARCH_n_MATCH Demonstrates how to use the class_match and class_
search utility function.

COMPARE_IP_ADDR_2_ADDR_
GROUP_DEMO

Compares an IP address to an address group to determine if
the IP address is included in the specified IP group. For
example ,192.168.1.2 is included in 192.168.1.0/24.
Note: Do NOT use this script "as is". Instead, copy it and
customize the IP address and the IP address group.

CONTENT_ROUTING_by_URI Routes to a pool member based on URI string matches. You
should not use this script as is. Instead, copy it and customize
the URI string matches and pool member names.

CONTENT_ROUTING_by_X_
FORWARDED_FOR

Routes to a pool member based on IP address in the X-
Forwarded-For header. You should not use this script as is.
Instead, copy it and customize the X-Fowarded-For header
values and pool member names.

COOKIE_COMMANDS Demonstrate the cookie command to get the whole cookie in a
table and how to remove/insert/set the cookie attribute.

COOKIE_COMMANDS_USAGE Demonstrate the sub-function to handle the cookie attribute
"SameSite" and others.

COOKIE_CRYPTO_COMMANDS Used to perform cookie encryption/decryption on behalf of the
real server.

CUSTOMIZE_AUTH_KEY Demonstrate how to customize the crypto key for
authentication cookie.

GENERAL_REDIRECT_DEMO Redirects requests to a URL with user-defined code and
cookie.
Note: Do NOT use this script "as is". Instead, copy and
customize the code, URL, and cookie.

GEOIP_UTILITY Used to fetch the GEO information country and possible
province name of an IP address.

HTTP_2_HTTPS_REDIRECTION Redirects requests to the HTTPS site. You can use this script
without changes.

HTTP_2_HTTPS_REDIRECTION_
FULL_URL

Redirects requests to the specified HTTPS URL.
Note: This script can be used directly, without making any
change.

FortiADC Handbook 467
Fortinet Technologies Inc.



Server Load Balance

Predefined script Usage

HTTP_DATA_FETCH_SET_DEMO Collects data in HTTP request body or HTTP response body.
In HTTP_REQUEST or HTTP_RESPONSE, you could collect
specified size data with “size” in collect().In HTTP_
DATA_REQUEST or HTTP_DATA_RESPONSE. You could print
the data use “content”, calculate data length with
“size”, and rewrite the data with “set”.
Note: Do NOT use this script "as is". Instead, copy it and
manipulate the collected data.

HTTP_DATA_FIND_REMOVE_
REPLACE_DEMO

Finds a specified string, removes a specified string, or
replaces a specified string to new content in HTTP data.
Note: Do NOT use this script "as is". Instead, copy it and
manipulate the collected data.

INSERT_RANDOM_MESSAGE_ID_
DEMO

Inserts a 32-bit hex string into the HTTP header with a
parameter “Message-ID”.
Note: You can use the script directly, without making any
change.

IP_COMMANDS Used to get various types IP Address and port number
between client and server side.

MANAGEMENT_COMMANDS Allow you to disable/enable rest of the events from executing.

MULTIPLE_SCRIPT_CONTROL_
DEMO_1

Uses demo_1 and demo_2 script to show howmultiple scripts
work. Demo_1 with priority 12 has a higher priority.
Note: You could enable or disable other events. Do NOT use
this script "as is". Instead, copy it and customize the operation.

MULTIPLE_SCRIPT_CONTROL_
DEMO_2

Uses demo_1 and demo_2 script to show how multiple
scripts work. Demo_2 with priority 24 has a lower priority.
Note: You could enable or disable other events. Do NOT use
this script "as is". Instead, copy it and customize the operation.

OPTIONAL_CLIENT_
AUTHENTICATION

Performs optional client authentication.
Note: Before using this script, you must have the following four
parameters configured in the client-ssl-profile:
l client-certificate-verify—Set to the verify you'd like to use
to verify the client certificate.

l client-certificate-verify-option—Set to optional
l ssl-session-cache-flag—Disable.
l use-tls-tickets—Disable.

PERSIST_COMMANDS Demonstrates how to use persist commands and event. Event
PERSISTENCE is triggered when FADC receive the HTTP
REQ and ready to dispatch to real server.
You can set the entry in PERSISTENCE, then look up it in
POST_PERSIST.
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FADC will dispatch to dedicate server according to your entry
set in PERSISTENCE if this session haven't assign real server
before.

RAM_CACHING_COMMANDS Demonstrate how to use script to do RAM caching.
FADC script allows user to control RAM caching behaviors
and check the caching status.
Note: make sure RAM caching configuration is selected in
HTTP or HTTPS profile.

RAM_CACHING_DYNAMIC Demonstrate how to use script to do dynamic RAM caching.
Note: Dynamic caching is identified by a configured ID. Make
sure RAM caching configuration is selected in HTTP or
HTTPS profile.

RAM_CACHING_GROUPING Demonstrate how to create multiple variations based on client
IP address. The sort of grouping applies to both regular
caching and dynamic caching.
Note: make sure RAM caching configuration is selected in
HTTP or HTTPS profile.

REDIRECTION_by_STATUS_CODE Redirects requests based on the status code of server HTTP
response (for example, a redirect to the mobile version of a
site). Do NOT use this script "as is". Instead, copy it and
customize the condition in the server HTTP response status
code and the URL values.

REDIRECTION_by_USER_AGENT Redirects requests based on User Agent (for example, a
redirect to the mobile version of a site). You should not use this
script as is. Instead, copy it and customize the User Agent and
URL values.

REWRITE_HOST_n_PATH Rewrites the host and path in the HTTP request, for example,
if the site is reorganized. You should not use this script as is.
Instead, copy it and customize the "old" and "new" hostnames
and paths.

REWRITE_HTTP_2_HTTPS_in_
LOCATION

Rewrites HTTP location to HTTPS, for example, rewrite
“Location:http://www.example.com” to
“Location:https://www.example.com”.

Note: You can use the script directly, without making any
change.

REWRITE_HTTP_2_HTTPS_in_
REFERER

Rewrites HTTP referer to HTTPS, for example, rewrite
“Referer: http://www.example.com” to
“Referer: https://www.example.com”.

Note: You can use the script directly, without making any
change.
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REWRITE_HTTPS_2_HTTP_in_
LOCATION

Rewrites HTTPS location to HTTP, for example, rewrite
“Location:https://www.example.com” to
“Location:http://www.example.com”.

Note: You can use the script directly, without making any
change.

REWRITE_HTTPS_2_HTTP_in_
REFERER

Rewrites HTTPS referer to HTTP, for example, rewrite
“Referer: https://www.example.com” to
“Referer: http://www.example.com”.

Note: You can use the script directly, without making any
change.

SNAT_COMMANDS Allows you to overwrite client source address to a specific IP
for certain clients, also support IPv4toIPv6 or IPv6toIPv4 type.
Note: Make sure the flag SOURCE ADDRESS is selected in
the HTTP or HTTPS type of profile.

SOCKOPT_COMMAND_USAGE Allows user to customize the TCP_send buffer and TCP_
receive buffer size.

SPECIAL_CHARACTERS_
HANDLING_DEMO

Shows how to use those "magic characters" which have
special meanings when used in a certain pattern. The magic
characters are ( ) . % + - * ? [ ] ^ $

SSL_EVENTS_n_COMMANDS Demonstrate how to fetch the SSL certificate information and
some of the SSL connection parameters between server and
client side.

TCP_EVENTS_n_COMMANDS Demonstrate how to reject a TCP connection from a client in
TCP_ACCEPTED event.

TWO_STEP_VERIFICATION Demonstrate how to perform 2-Step Verification using
FortiToken. One needs have authentication policy configured
and selected in a virtual-server.

TWO_STEP_VERIFICATION_2_NEW Demonstrate how to perform 2-Step Verification using
FortiToken for the second authentication group.

TWO_STEP_VERIFICATION_2_SAME Demonstrate how to perform 2-Step Verification for the
second authentication group using the same token group.

TWO_STEP_VERIFICATION_
CHANGE_KEY

Demonstrate how to change the AES key and its size for
stored token group.

URL_UTILITY_COMMANDS Demonstrate how to use those url tools to
encode/decode/parser/compare.

USE_REQUEST_HEADERS_in_
OTHER_EVENTS

Stores a request header value in an event and uses it in other
events. For example, you can store a URL in a request event,
and use it in a response event.
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Note: Do NOT use this script "as is". Instead, copy it and
customize the content you want to store, use collect() in
HTTP_REQUEST to trigger HTTP_DATA_REQUEST,or use
collect() in HTTP_ RESPONSE to trigger HTTP_DATA_
RESPONSE.

UTILITY_FUNCTIONS_DEMO Demonstrates how to use the basic string operations and
random number/alphabet, time, MD5, SHA1, SHA2, BASE64,
BASE32, table to string conversion, network to host
conversion utility function

Commands

AUTH_EVENTS_n_COMMANDS Lists the auth event and commands

COOKIE_COMMANDS Lists the two cookie commands and shows how to use them.

IP_COMMANDS Lists the IP commands and shows how to use them.

MANAGEMENT_COMMANDS Lists the management commands and shows how to use
them.

PERSIST_COMMANDS Lists the persist event and commands

RAM_CACHING_COMMANDS Lists the RAM caching event and commands

SSL_EVENTS_n_COMMANDS Lists the SSL events and commands.

TCP_EVENTS_n_COMMANDS Lists the TCP events and commands.

Multi-script support

Linking multiple scripts to the same virtual server

FortiADC supports the use of a single script file containing multiple scripts and applies them to a single virtual server in
one execution. Different scripts can contain the same event. You can specify the priority for each event in each script file
to control the sequence in which multiple scripts are executed or let the system to execute the individual scripts in the
order they are presented in the multi-script file.

For the current release, you can add up to 16 individual scripts to create a big multi-script file.

If you'd like to, you can disable the processing of the rest of the scripts (e.g., you can disable the processing of the
remaining scripts in the list in a script), and even totally disable the processing of a certain event (e.g., you can disable
processing the HTTP RESPONSE event in a HTTP REQUEST script). FortiADC also supports multiple calls of
HTTP:redirect(), HTTP:redirect_with_cookie(), LB:routing(), and HTTP:close() functions such that the final one prevails.

In practice, rather than building one big complicated script containing all the required logic, it might be more useful to
break it down into smaller functional pieces in the form of individual scripts. This is because executing multiple scripts at
the same time is more efficient than running them separately, one at a time. Also, breaking down a giant script into
multiple small individual scripts makes it more flexible to apply scripts to different virtual servers because some virtual
servers may use some of the scripts while others may use them all. With the small individual scripts at hand, you can

FortiADC Handbook 471
Fortinet Technologies Inc.



Server Load Balance

simply pick and choose only the scripts you need to assemble a big multi-script file with a set priority for each script and
apply them all at once to a virtual server.

Apply multiple scripts on page 472 shows how to link multiple scripts to a single virtual server from the GUI.

Apply multiple scripts

Setting script priority

Priority in a multi-script is optional, but is highly recommended. When executing a big multiple-script file, care must be
taken to avoid conflicting commands among the scripts. You can set the priority for each script using the script editor on
FortiADC's GUI. Valid values range from 1 to 1,000, with 500 being the default. The smaller the value, the higher the
priority. Below is an example script with a set priority:

when HTTP_REQUEST priority 100 {
LB:routing(“cr1”)
}
To display the priority info in the GUI, you can define one and only one event in each

script file, as shown below:
Script 1:
when HTTP_REQUEST priority 500 {
LB:routing(“cr1”)
}
Script 2:
when HTTP_RESPONSE priority 500 {
HTTP:close()
}
Script 3:
when HTTP_REQUEST priority 400 {
LB:routing(“cr2”)
}
Script 4:
when HTTP_RESPONSE priority 600 {
HTTP:close()
}

Individual script files are loaded separately into the Lua stack. A numeric value (starting from 1) is appended to each
event (e.g., for HTTP_REQUEST event, there are functions HTTP_REQUST1, HTTP_REQUEST2, and so on so forth).

To support multiple scripts, FortiADC:

l Supports multiple calls of redirect/routing/close function, making them re-entrant so that the final one prevails. For
that purpose, the system checks the behavior of multiple calls across redirect(), close(), and routing
(). If redirect() comes first, followed by close(), then close() prevails. If close() comes first, followed
by redirect(), then redirect() prevails. If you want to close(), you must disable the event after close().
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l Allows enabling or disabling events. There are times when you may want to disable the processing of the remaining
scripts while a multi-script file is being executed, or want to disable processing the response completely. The
mechanism serves that purpose.

l Allows enabling or disabling automatic event-enabling behavior. In the HTTP keep-alive mode, the system by
default re-enables HTTP REQUEST and HTTP RESPONSE processing for the next transaction (even if they are
disabled in the current transaction using the above enable or disable event mechanism). Now you can disable or
enable this automatic enabling behavior.

Script priority on page 473 shows a sample multi-script with priority information.

Script priority

Compiling principles

l All individual scripts should be pre-compiled when they are linked to a virtual server, where they can be combined
into one big multi-script.

l For the same event, combine the commands in different scripts according to their priorities and orders.
l For commands of different priorities, FortiADC processes the high-priority commands first, and then the low-priority
ones; for commands of the same priority, it processes them in the order they appear in the combined script.

l And if you are using multiple scripts with overlapping events for bidirectional traffic, you must ensure that the
response traffic traverses the overlapping events in the expected order. By default, the scripts applied to the same
virtual server will run in the order in which they are applied, regardless of the direction of traffic flow.

l For a specified event, you must make sure to avoid the conflict commands in different scripts. For example, if you
have multiple scripts applied to the same virtual server and the scripts contain both request and response logic, the
default execution order is like this:
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but NOT like this:

As shown above, FortiADC cannot control the order in which events in the scripts are executed. The only way to enforce
the execution order for response traffic is to use the event priority command, as we have discussed above. When setting
the priorities, pay special attention to both request and response flows.

Special notes

When using the multi-script feature, keep the following in mind:

l The multi-script feature is supported on all FortiADC hardware platforms.
l Currently, the feature can be applied to layer-2 and Layer-7 virtual servers on HTTP/HTTPS protocol only.
l Scripts are VDOM-specific, and cannot be shared among different VDOMs.
l Session tables set up using scripts must be synced through high-availability (HA) configuration.
l Each multi-script script can contain up to 256 individual scripts, each being no more than 32 kilobytes.

SSL-FP Resources

The Server Load Balance > SSL-FP Resources sub-menu allows you to perform the following tasks relating to SSL
forward proxy for server load balancing:

l Configuring an L2 exception list on page 474
l Creating a Web Filter Profile configuration on page 476
l Viewing Web Filter categories on page 477
l Configuring certificate caching on page 477

Configuring an L2 exception list

In some jurisdictions, SSL interception and decryption is disfavored for some types of websites or disallowed entirely.
You use the L2 Exception List configuration to define such destinations. You can leverage FortiGuard web filter
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categories, and you can configure a list of additional destinations.

Before you begin:

l You must have created a Web Filter Profile configuration that includes the web categories to exclude from SSL
decryption.

l You must have hostname or IP address details on additional destinations you want to exclude from SSL decryption.
l You must have Read-Write permission for Load Balance settings.

After you have created an L2 exception list configuration object, you can select it in a Layer 2 virtual server configuration.

To configure an exception list:

1. Go to Server Load Balance > SSL-FP Resources.
2. Click the L2 Exception List tab.
3. Click Create New to display the L2 Exception List configuration editor.
4. Configure the following L2 Exception List settings:

Settings Guidelines

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces. You
reference this name in the profile configuration.
Note: After you initially save the configuration, you cannot edit the name.

Description A string to describe the purpose of the configuration, to help you and other administrators
more easily identify its use.

Web Filter Profile Select a Web Filter Profile configuration.

5. Click Save.
The Member section becomes available to configure.

6. In theMember section, click Create New to display the Member configuration editor.
7. Configure the following Member settings:

Settings Guidelines

Type How you want to define the exception:
l Host
l IP/Netmask

Host Pattern The Host Pattern option is available if the Type is Host.
Specify a wildcard pattern, such as *.example.com.

IP/Netmask The IP/Netmask option is available if the Type is IP/Netmask.
Specify the IP address and CIDR-formatted subnet mask, separated by a forward slash,
such as 192.0.2.0/24.
Note:
l Dotted quad formatted subnet masks are not accepted.
l IPv6 addresses are not supported.

IP/Netmask Role The IP/Netmask option is available if the Type is IP/Netmask.
Specify the role of the IP/Netmask:
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Settings Guidelines

l Destination— The IP/Netmask is set as the Destination IP, and the L2 SSL Forward
Proxy VS will be bypassed based on this Destination IP.

l Source— The IP/Netmask is set as the Source IP, and the L2 SSL Forward Proxy VS
will be bypassed based on this Source IP.

Comments Optionally, enter a comment to describe this L2 Exception List Member.

8. Click Save.
The L2 Exception List Member configuration is saved and added to the Member section.

9. Click Save to commit the changes made for the Member configuration.

Creating a Web Filter Profile configuration

You use the web filter profile configuration to create groups of FortiGuard categories that you want to include in the SSL
forward proxy "L2 Exception List" configuration. The web filter profile should include categories that should not be
processed by the outbound L2 SSL forward proxy feature. To address privacy concerns, you can include categories
such as "Personal Privacy", "Finance and Banking", "Health andWellness", and Medicine.

Before you begin:

l Learn about FortiGuard web filter categories. Go to http://fortiguard.com/webfilter.
l You must have Read-Write permission for Load Balance settings.

After you have created a web filter profile configuration object, you can select it in a L2 exception list configuration.

To create a web filter profile configuration:

1. Go to Server Load Balance > SSL-FP Resources.
2. Click theWeb Filter Profile tab.
3. Click Create New to display the configuration editor.
4. Complete the configuration as described in Web Filter Profile configuration on page 476.
5. Save the configuration.

Settings Guidelines

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces. You reference
this name in the profile configuration.
Note: After you initially save the configuration, you cannot edit the name.

Description A string to describe the purpose of the configuration, to help you and other administrators
more easily identify its use.

Category-Members

Category Select a category or subcategory from the predefined list.

Web Filter Profile configuration
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Viewing Web Filter categories

TheWeb Category tab displays the web filter categories imported from FortiGuard. You specify web categories when
you create web filter groups.

For information on FortiGuard web categories, go to the FortiGuard website:

http://fortiguard.com/webfilter

Before you begin:

l You must have read permission for load balancing settings.

To display web categories:

1. Go to Server Load Balance > SSL-FP Resources.
2. Click theWeb Category tab.

To manage how long the URL lists from FortiGuard are cached:

1. Go to System > FortiGuard.
2. Under Web Filter Configure, adjust caching settings as desired.

Configuring certificate caching

Certificate caching allows the system to cache the certificates presented to it for later use. Once cached, the certificates
can be readily retrievable from the cache so that the system does not have to reload them when clients requesting
service. In so doing, system performance can be greatly improved.

To configuring a certificate caching object

1. Click Server Load Balance > SSL-FP Resources.
2. Click the Certificate Caching tab.
3. Click Create New to open the certificate caching editor.
4. Make the desired entries as described in Certificate caching configuration guidelines on page 477.
5. Click Save.

Settings Guidelines

Name Enter a unique name for the certificate caching rule.

Maximum Certificate
Cache Size

Specify the maximum size of the certificate caching object. The default is 100 M.

Maximum entries Specify the maximum number of real servers whose certificates (RSA + ECDSA) are to be
cached. The default is 100,000.

Certificate caching configuration guidelines
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Link Load Balance

The Link Load Balancemenu contain features and configurations that allow you to link load balance.

This section is organized into the following sub-menu topics:

l Link Policy on page 483
l Link Group on page 484
l Virtual Tunnel on page 491

Link load balancing basics

The link load balancing (LLB) features are designed to manage traffic over multiple internet service provider (ISP) or
wide area network (WAN) links. This enables you to subscribe to or provision multiple links, resulting in reduced risk of
outages, additional bandwidth for peak events, and potential cost savings if your ISP uses billing tiers based on
bandwidth rate or peak/off-peak hours.

In most cases, you configure link load balancing for outgoing traffic. Outbound traffic might be user or server traffic that is
routed from your local network through your ISP transit links, leased lines, or other WAN links to destinations on the
Internet or WAN. You configure link policies that select the gateway for outbound traffic.

When the FortiADC system receives outbound traffic that matches a source/destination/service tuple that you configure,
it forwards it to an outbound gateway link according to system logic and policy rules that you specify.

The LLB feature supports load balancing among link groups or among virtual tunnel groups.

Using link groups

The link group option is useful for ISP links. It enables you to configure multiple ISP links that are possible routes for the
traffic. The LLB picks the best route based on health checks, LLB algorithms, bandwidth rate thresholds, and other
factors you specify, including a schedule.

 LLB link groups on page 478 shows an example topology when FortiADC is deployed to support link groups.

 LLB link groups
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Using virtual tunnels

A virtual tunnel is a good choice when you want to load balance traffic from applications that embed the source address
in the packet payload, like VPN and VoIP traffic. Such traffic can be difficult to load balance using traditional LLB
methods. Virtual tunnels enable reliable, site-to-site connectivity using Generic Routing Encapsulation (GRE). The local
FortiADC appliance encapsulates traffic so that it can be routed according to your link policy rules. The link policy rules
use LLB techniques to identify the best available route among a group of links. If one of the links breaks down, the traffic
can be rerouted through another link in the tunnel group. When traffic egresses the remote FortiADC appliance, it is
decapsulated and the original source and destination IP addresses are restored.

 WAN connectivity over single leased lines on page 480 shows an example of a deployment that does not use LLB. It
uses dedicated leased lines for its WAN links, which are reliable, but expensive.

 WAN connectivity over single leased lines

 LLB virtual tunnels on page 480 shows the same network deployed with FortiADC appliances. The LLB link policy load
balances traffic among more affordable ADSL links.

 LLB virtual tunnels
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Depending on your business, you might use the link group option, the virtual tunnel option, or both.

The FortiADC system evaluates traffic to determine the routing rules to apply. With
regard to link load balancing, the system evaluates rules in the following order and
applies the first match:
1. LLB link policy
2. Policy route
3. Static/Dynamic route
4. LLB default link group

Link load balancing configuration overview

The system has a configuration framework that enables granular link load balancing rules.

 LLB configuration summary on page 481 shows the configuration objects used in the LLB configuration and the order in
which you create them. A link policy specifies the source/destination/service matches to which the policy applies. You
apply a link policy to a link group or a virtual tunnel.

 LLB configuration summary
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The granular configuration of the gateway configuration includes health checks and bandwidth thresholds. The granular
configuration of link groups includes load balancing methods, persistence rules, and proximity routes.

The granular configuration of virtual tunnels includes load balancing methods. In the virtual tunnel configuration, you can
enable health check tests, but you do not use health check configuration objects.

Basic steps

1. Add address, address group, service, service group, and schedule group configuration objects that can be used to
match traffic to link policy rules. This step is recommended. If your policy does not use match criteria, it will not have
granularity.

2. Configure optional features. If you want to use health check rules, configure them before you configure the gateway
links. If you want to use persistence rules or proximity routes, configure them before you configure a link group.

3. Configure gateway links.
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4. Configure link groups or virtual tunnels.
5. Configure the link policy. When you configure a link policy, you set the source/destination/service matching tuple for

your link groups or virtual tunnels.

Link Policy

From the Link Load Balance > Link Policy sub-menu, you can configure link policies to match traffic to rules that use a
link group or virtual tunnel.

The link policy uses a matching tuple: source, destination, service, and schedule. The policy match is a Boolean AND—
All must match for the rule to be applied.

The elements of the tuple support specification by group objects. This is a Boolean OR—If source IP address belongs to
member 1 ORmember 2, then source matches.

The logical combinations enable you to subscribe multiple address spaces or services to a group of links, and create
load balancing rules on that group basis.

The policy table is consulted from top to bottom. The first rule to match is applied.

The FortiADC system evaluates traffic to determine the routing rules to apply. With
regard to link load balancing, the system evaluates rules in the following order and
applies the first match:
1. LLB link policy
2. Policy route
3. Static/Dynamic route
4. LLB default link group

Before you begin:

l You must have configured any address, service, and schedule objects that you want to use as match criteria for
your policy.

l You must have configured a link group or virtual tunnel group.
l You must have Read-Write permission for Link Load Balance settings.

To configure a link policy:

1. Go to Link Load Balance > Link Policy.
2. Click Create New to display the configuration editor.
3. Complete the configuration as described in Link policy configuration on page 484.
4. Save the configuration.
5. Reorder rules, as necessary.
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Option Guidelines

Default Link Group Select a link group configuration object that is used as the default when traffic does not
match policy rules.

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces.
After you initially save the configuration, you cannot edit the name.

Ingress Interface Select the network interface to which the policy applies.

Source Type Whether to use address, address group, or ISP address objects for this rule.

Source, Source ISP, or
Source Group

Select an address object to match source addresses. If you do not specify a source
address, the rule matches any source address. See Configuring IPv4 address groups.

Destination Type Whether to use address, address group, or ISP address objects for this rule.

Destination, Destination
ISP, or Destination Group

Select an address object to match destination addresses. If you do not specify a
destination address, the rule matches any destination. See Configuring IPv4 address
groups.

Service Type Whether to use service or service group objects for this rule.

Service or Service Group Select a service object to match destination services. If you do not specify a service, the
rule matches any service. See Creating service groups.

Schedule Select the schedule object that determines the times the system uses the logic of this
configuration. The link policy is active when the current time falls in a time period
specified by one or more schedules in the schedule group. If you do not specify a
schedule, the rule applies at all times. See Schedule Group.

Group Type l Link Group—Policy applies to a link group. Select the option, then the link group.
See Configuring a link group.

l Virtual Tunnel—Policy applies to a virtual tunnel. Select the option, then the virtual
tunnel. See Virtual Tunnel.

Link Group Select a link group.

Reordering

After you have saved a rule, reorder rules as necessary. The rules table is consulted
from top to bottom. The first rule that matches is applied and subsequent rules are not
evaluated.

Hit Counts Hit Counts: For monitor only. The value indicates the link policy hit times.

Link policy configuration

Link Group

The Link Load Balance > Link Group sub-menu allows you to perform the following tasks relating to grouping links for
link load balancing:

l Configuring a link group on page 485
l Configuring gateway links on page 487
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l Configuring LLB persistence rules on page 488
l Configuring proximity route settings on page 490

Configuring a link group

Link groups include ISP gateways your company uses for outbound traffic. Grouping links reduces the risk of outages
and provisions additional bandwidth to relieve potential traffic congestion. See Using link groups.

The link group configuration specifies the load balancing algorithm and the gateway routers in the load balancing pool.
You can enable LLB options, such as persistence rules and proximity routes.

Before you begin:

l You must have configured gateway links and persistence rules and before you can select them in the link group
configuration.

l You must have Read-Write permission for Link Load Balance settings.

After you have configured a link group configuration object, you can select it in the link policy configuration.

To configure a link group:

1. Go to Link Load Balance > Link Group.
The configuration page displays the Link Group tab.

2. Click Create New to display the configuration editor.
3. Complete the configuration and add members as described in Link group configuration on page 485.
4. Save the configuration.

Settings Guidelines

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces. You reference
this name in the LLB policy configuration.
Note: After you initially save the configuration, you cannot edit the name.

Address Type IPv4
Note: IPv4 is selected by default, and cannot be changed.

Route Method l Weighted Round Robin—Dispatches new connections to link members using a weighted
round-robin method.

l Least Connections—Dispatches new connections to the link member with the lowest
number of connections.

l Least New Connections per Second—Dispatches new connections to the link member
that has the lowest rate of new connections per second.

l Least Throughput Outbound—Dispatches new connections to the link member with the
least outbound traffic.

l Least Throughput Inbound—Dispatches new connections to the link member with the
least inbound traffic.

l Least Throughput Total—Dispatches new connections to the link member with the least
total traffic (that is, inbound plus outbound).

Link group configuration
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Settings Guidelines

l Spillover Throughput Outbound—Dispatches new connections according to the spillover
list based on outbound traffic.

l Spillover Throughput Inbound—Spillover list based on inbound traffic.
l Spillover Throughput Total—Spillover list based on total traffic (that is, inbound plus
outbound).

l Source Address Hash—Selects the gateway link based on a hash of the source IP
address.

Persistence Select a persistence configuration. Optional.

Proximity Route l Enable—The system uses the proximity route logic and configuration when determining
routes.

l Disable—The system does not use the proximity route configuration.

Add member

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces.
After you initially save the configuration, you cannot edit the name.

Gateway Select a gateway configuration object. See Configuring gateway links.

Weight Assigns relative preference among members—higher values are more preferred and are
assigned connections more frequently. The default is 1. The valid range is 1 to 255.
All load balancing methods consider weight, except spillover, which uses its own priority
configuration. Servers are dispatched requests proportional to their weight, relative to the sum
of all weights.
The following example shows the effect of weight on WRR:
l Sever A, Weight 2; Server B, Weight 1: Requests are sent AABAAB.
l Sever A, Weight 3; Server B, Weight 2: Requests are sent AABAB.

For other methods, weight functions as a tie-breaker. For example, with the Least Connection
algorithm, requests are sent to the server with the least connections. If the number of
connections is equal, the request is sent to the server with the greater weight. For example:
l Server A, Weight 1, 1 connection
l Server B, Weight 2, 1 connection

The next request is sent to Server B.

Spillover Priority Assigns a priority to the link when using a spillover load balancing method. Higher values
have greater priority. When a spillover method is enabled, the system dispatches new
connections to the link that has the greatest spillover priority until its threshold is exceeded;
then it dispatches new connections to the link with the next greatest priority until its threshold
is exceeded, and so on.
If multiple links in a link group have the same spillover priority, the system dispatches new
connections among those links according to round robin.
The default is 0. The valid range is 0-9.

Status l Enable—The member is considered available for new traffic.
l Disable—The member is considered unavailable for new traffic.

Backup Enable to designate the link as a backup member of the group. All backup members are
inactive until all main members are down.
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Configuring gateway links

The gateway link configuration enables you to specify health checks, bandwidth rate thresholds, and spillover threshold
behavior for the gateway links you add to link groups.

Before you begin:

l You must know the IP addresses of the ISP gateway links used in the network segment where the FortiADC
appliance is deployed.

l You must have added health check configuration objects that you want to use to check the gateway links.
l You must have Read-Write permission for Link Load Balance settings.

After you have configured a gateway link configuration object, you can select it in the link group configuration.

To configure a gateway link:

1. Go to Link Load Balance > Link Group.
2. Click theGateway tab.
3. Click Create New to display the configuration editor.
4. Complete the configuration as described in LLB gateway configuration on page 487.
5. Save the configuration.

Settings Guidelines

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces. You reference
this name in the link group configuration.
Note: After you initially save the configuration, you cannot edit the name.

Address IP address of the gateway link.

Health Check Enable health checks.

Health Check
Relationship

l AND—All of the selected health checks must pass for the link to the considered available.
l OR—One of the selected health checks must pass for the link to be considered available.

Health Check List Select one or more health check configuration objects.

Inbound Bandwidth Maximum bandwidth rate for inbound traffic through this gateway link.

Outbound Bandwidth Maximum bandwidth rate for outbound traffic to this gateway link. If traffic exceeds this
threshold, the FortiADC system considers the gateway to be full and does not dispatch new
connections to it.
The default is 2,000,000 Kbps. The valid range is 1 to 2,147,483,647.
We recommend you tune bandwidth thresholds strategically, using the bandwidth rate and
price structure agreement you have with your ISP to your advantage.

Inbound Spillover
Threshold

Maximum inbound bandwidth rate for a link in a spillover load balancing pool.

Outbound Spillover
Threshold

Maximum outbound bandwidth rate for a link in a spillover load balancing pool.

LLB gateway configuration
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Settings Guidelines

If you enable spillover load balancing in the link group configuration, the systemmaintains a
spillover list. It dispatches new connections to the link with the greatest priority until its
spillover threshold is exceeded; then dispatches new connections to the link with the next
greatest priority until its threshold is exceeded, and so on.
The default is 2,000,000 Kbps. The valid range is 1 to 2,147,483,647.

Total Spillover
Threshold

Maximum total bandwidth rate (inbound plus outbound) for a link in a spillover load balancing
pool.

Configuring LLB persistence rules

Persistence rules identify traffic that should be ignored by load balancing rules and instead be forwarded to the same
gateway each time the traffic traverses the FortiADC appliance.

You should use persistence rules with applications that use a secure connection. Such applications drop connections
when the server detects a change in a client’s source IP address.

Persistence rules used in link load balancing on page 488 describes the types of persistence rules you can configure.

Persistence Description

Source-Destination Pair Packets with the same source IP address and destination IP address take same
outgoing gateway.

Source-Destination Address Packets with a source IP address and destination IP address that belong to the
same subnet take the same outgoing gateway.

Source Address Packets with a source IP address that belongs to the same subnet take the same
outgoing gateway.
Source address based persistence consumes a significant amount of memory, as
calculated using the following formula per VS:
(max persistence entry size) x (size per entry of the table) x (content routing or
pool count)
For example:
If the max persistence entry size is 262144 (default), the per entry of the table is
44 bytes, and there is no content routing.
262144 x 44 = 11534336 bytes (which is ≈11MB)

Destination Address Packets with a destination IP address that belongs to the same subnet take same
outgoing gateway.

Persistence rules used in link load balancing

Before you begin:

l You must have an awareness of the types of outbound traffic from your network. Persistence rules are useful for
traffic that requires an established session, such as secure connections (HTTPS and SSH, for example).

l You must have knowledge of the source and/or destination subnets to which the persistence rules should apply.
l You must have Read-Write permission for Link Load Balance settings.
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You can use persistence rules in link groups but not virtual tunnels.

To configure a persistence rule:

1. Go to Link Load Balance > Link Group.
2. Click the Persistence tab.
3. Click Create New to display the configuration editor.
4. Complete the configuration as described in Persistence rule configuration on page 489.
5. Save the configuration.

Type Guidelines

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces. You
reference this name in the link group configuration.
Note: After you initially save the configuration, you cannot edit the name.

Type Select one of the persistence types, as described below.

Source-Destination Pair

Timeout The default is 300 seconds.

Source-Destination Address

Timeout The default is 300 seconds.

Source IPv4 Netmask Bits Number of bits in a subnet mask to specify a network segment that should following the
persistence rule.

Destination IPv4 Netmask
Bits

Number of bits in a subnet mask to specify a network segment that should following the
persistence rule.
For example, if you set this to 24, and the system chooses a particular gateway router
for destination IP 192.168.1.100, the system will select that same gateway for traffic to
all destination IPs in subnet 192.168.1.0/24.

Source Address

Timeout The default is 300 seconds.

Source IPv4 Netmask Bits Number of bits in a subnet mask to specify a network segment that should following the
persistence rule. The default is 32, but you can set it to any value between 1 and 32.
For example, if you set this to 24, and the system chooses a particular gateway router
for client IP 192.168.1.100, the system will select that same gateway for subsequent
client requests when the subsequent client belongs to subnet 192.168.1.0/24.

Destination Address

Timeout The default is 300 seconds.

Destination IPv4 Netmask
Bits

Number of bits in a subnet mask to specify a network segment that should following the
persistence rule.

Persistence rule configuration
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Configuring proximity route settings

The proximity route feature enables you to associate link groups with efficient routes. Proximity routes can improve user
experience over the WAN because traffic is routed over fast routes.

You can use either or both of these methods:

l Static Table—You specify the gateways to use for traffic on destination networks.
l Dynamic Detection—The system polls the network for efficient routes. The algorithm selects a gateway based on
latency.

If you configure both, the system checks the static table first for a matching route and, if any, uses it. If there is no
matching static route, the system uses dynamic detection.

Before you begin:

l You must have knowledge of IP addresses used in outbound network routes to configure a static route.
l You must have Read-Write permission for Link Load Balance settings.

To configure a proximity route:

1. Go to Link Load Balance > Link Group.
2. Click the Proximity Route tab.
3. Complete the configuration as described in Proximity route rule configuration on page 490.
4. Save the configuration.

Type Guidelines

Mode l Static Table First—Consult the static table first. If no match, use dynamic detection.
l Static Table Only—Use the static table; do not use dynamic detection.
l Dynamic Detect Only—Use dynamic detection; do not use the static table.
l Disable—Do not use the proximity route configuration.

Static Table

Type l ISP—Use an ISP address object.
l Subnet—Specify an IP netmask manually.

Routes that are specified manually have priority over ISP address object entries.

ISP Name If you use the ISP configuration type, select an ISP address book configuration object.
If an address exists in multiple ISP address books, the route entries have priority as follows:
1. User-defined entries.
2. Entries from an address book that has been imported.
3. Entries from the predefined address book (default for the firmware image).

IP Subnet If you use the Subnet configuration type, specify a destination IP address and netmask.

Gateway Select a gateway configuration object. The gateway must be able to route packets to the
destination IP address that you have specified.

Dynamic Detect

Proximity route rule configuration
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Type Guidelines

Protocol l ICMP—Use ICMP to detect routes. Calculate proximity by the smaller RTT.
l ICMP and TCP—Some hosts do not respond to ICMP requests. Specify this option to
use both ICMP and TCP to detect routes and RTT. For TCP detection, port 7 (TCP echo)
is used. A connection refused or connection reset by the destination is treated as
successful detection.

Aging Period The default is 86,400 seconds (24 hours).

Retry Number The default is 3.

Retry Interval The default is 3.

Virtual Tunnel

From the Link Load Balance > Virtual Tunnel sub-menu, you can configure virtual tunnels that allow reliable, site-to-
site connectivity using Generic Routing Encapsulation (GRE) to tunnel traffic between pairs of FortiADC appliances.

The virtual tunnel group configuration sets the list of tunnel members, as well as load balancing options like algorithm
and weight.

When you add members to a virtual tunnel configuration, you specify a local and remote IP address. These addresses
are IP addresses assigned to a network interface on the local and remote FortiADC appliance.

Before you begin:

l You must have Read-Write permission for Link Load Balance settings.

After you have configured a virtual tunnel configuration object, you can select it in the link policy configuration.

To configure a virtual tunnel:

1. Go to Link Load Balance > Virtual Tunnel.
2. Click Create New to display the configuration editor.
3. Complete the configuration and add members as described in Virtual tunnel configuration on page 491.
4. Save the configuration.

Settings Guidelines

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces. You reference
this name in the LLB policy configuration.
Note: After you initially save the configuration, you cannot edit the name.

Method l Weighted Round Robin—Dispatches packets to VT members using a weighted round-
robin method.

l Source-Destination Hash—Dispatches packets by source-destination IP address tuple.

Add member

Virtual tunnel configuration
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Settings Guidelines

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces.
After you initially save the configuration, you cannot edit the name.

Tunnel Local
Address

IP address for the network interface this system uses to form a VPN tunnel with the remote
system.

Tunnel Remote
Address

IP address that the remote FortiADC system uses to form a VPN tunnel with this system.

Health Check l Enable—Send probes to test whether the link is available.
l Disable—Do not send probes to test the health of the link.

Weight Assigns relative preference among members—higher values are more preferred and are
assigned connections more frequently.

Status l Enable—The member is considered available for new traffic.
l Disable—The member is considered unavailable for new traffic.

Backup Enable to designate the tunnel as a backup member of the group. All backup members are
inactive until all main members are down.
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Global Load Balance

TheGlobal Load Balancemenu contain features and configurations that allow you to global load balance.

This section is organized into the following sub-menu topics:

l GLBWizard on page 497
l FQDN on page 499
l Zone Tools on page 505
l Global Object on page 530

Global load balancing basics

The global load balancing (GLB) feature is a DNS-based solution that enables you to deploy redundant resources
around the globe that you can leverage to keep your business online when a local area deployment experiences
unexpected spikes or downtime. The FortiADC system implements a hardened BIND 9 DNS server that can be deployed
as the authoritative name server for the DNS zones that you configure. Zone resource records are generated
dynamically based on the global load balancing framework. The DNS response to a client request is an ordered lists of
answers that includes all available virtual servers. A client that receives DNS response with a list of answers tries the first
and only proceeds to the next answers if the first answer is unreachable. The response list is based on the following
priorities:

1. Virtual server health—Availability is determined by real-time connectivity checking. When the DNS server receives
a client request, it checks connectivity for all possible matches and excludes unavailable servers from the response
list.

2. Persistence—You can enable persistence for applications that have transactions across multiple hosts. A match to
the persistence table has priority over proximity algorithms.

3. Geographic proximity—Proximity is determined by matching the source IP address to either the FortiGuard Geo IP
database or the FortiADC predefined ISP address book.

4. Dynamic proximity—Proximity is determined by application response time (RTT probes), least connections, or byte-
per-second.

5. Weighted round robin—If proximity algorithms are not configured or not applicable, available virtual servers are
listed in order based on a simple load balancing algorithm.

 Global load balancing deployment on page 493 shows an example global load balancing deployment with redundant
resources at data centers in China and the United States.

 Global load balancing deployment
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FortiADC-1 is the local SLB for the data center in China. FortiADC-2 is the local SLB for the data center in the United
States. FortiADC-1 and FortiADC-2 are also the GSLB. They host the DNS servers that are authoritative for
www.example.com. When a client clicks a link to www.example.com, the local host DNS resolver commences a DNS
query that is ultimately resolved by the authoritative DNS server on them. The set of possible answers includes the
virtual servers on FortiADC-1 or FortiADC-2. The global load balancing framework uses health status and proximity
algorithms to determine the set of answers that are returned, and the order of the answer list. For example, you can use
the global SLB framework geoproximity feature to direct clients located in China to the virtual server in China, or if the
virtual server in China is unavailable, then to the redundant resources in the United States.

You configure the global load balancing framework and DNS settings only on the global FortiADC (in the example above,
both FortiADC-1 and FortiADC-2 are GSLBs). The virtual server IP addresses and ports can be discovered by the
FortiADC global SLB from the FortiADC local SLBs. The GLB DNS server uses the discovered IP addresses in the DNS
response. The framework also supports third-party IP addresses and health checks for them.

The DNS server supports the following security features:

l DNSSEC—Domain Name System Security Extensions. DNSSEC provides authentication by associating
cryptographically generated digital signatures with DNS resource record (RR) sets. The FortiADC systemmakes it
easy to manage the keys that must be provided to DNS parent domains and the keys that must be imported from
DNS child domains.

l Response rate limit—Helps mitigate DNS denial-of-service attacks by reducing the rate at which the authoritative
name servers respond to high volumes of malicious queries.

l DNS forwarding—In a typical enterprise local area network, the client configuration has the IP address of an internal
authoritative DNS server so that requests for internal resources can be answered directly from its zone data.
Requests for remote resources are sent to another DNS server known as a forwarder. The internal server caches
the results it learns from the forwarder, which optimizes subsequent lookups. Using forwarders reduces the number
of DNS servers that must be able to communicate with Internet DNS servers.
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Further reading:
BIND 9 reference manuals: http://www.bind9.net/manuals
RFC 1035 (DNS): http://tools.ietf.org/html/rfc1035
RFC 4033 (DNSSEC): http://tools.ietf.org/html/rfc4033

Global load balancing configuration overview

In a global load balancing deployment, you configure DNS server and global load balancing details only on the global
FortiADC instance. The configuration framework enables granular administration and fine tuning of both the DNS server
and the global load balancing framework.

  Global load balancing configuration summary on page 495 shows the basic configuration elements for global load
balancing and the recommended order for creating the configuration objects. The order is important for initial
configurations because complex configuration elements like policies often include references to simple configuration
objects like the remote DNS servers (forwarders) or DNS64 rules, but the simple elements must be created first.

  Global load balancing configuration summary
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Basic steps (DNS server)

1. Configure address groups to use in your DNS policy matching rules. The system includes the predefined address
groups any and none.

2. Configure remote DNS servers (forwarders) and the DSSET list that you might reference in the zone configuration.
3. Complete the zone configuration. The global load balancing framework generates the zone configuration for zones

that include the FortiADC virtual servers.
4. Configure DNS64 or response rate limit configurations that you might reference in the DNS policy.
5. Configure the DNS policy that matches a source/destination tuple to a zone. You can also enable and configure

DNSSEC in the DNS policy.
6. Configure general DNS settings to be applied when DNS requests do not match the DNS policy.

Basic steps (Global load balancing)

1. Create the data center, servers, virtual server pool, and host configurations that are the framework for associating
locations with virtual servers and generating the DNS zone configuration and resource records. You can adjust the
dynamic proximity and persistence settings at any time.

2. Review the generated DNS zone configuration.
3. Create a policy that matches traffic to the generated zone configuration.

GLB Wizard

From theGlobal Load Balance > GLB Wizard sub-menu, you can configure a GLB object in the GUI using a step-by-
step tool to easily guide you through the GLB configuration process.
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To configure a GLB wizard:

1. Go toGlobal Load Balance > GLB Wizard.
The configuration page displays the Global Load Balance Wizard configuration editor.

2. In Server, configure the Name, Address, and Data Center Location.
3. In Virtual Server Pool, configure the Name, Preferred and Alternate. Discover the server members that were

previously configured in Server, and select from the given list.
4. It is required to specify the Name, Host Name, and Domain Name. You can also, if you want, specify the Default

Feedback IPv4 or Default Feedback IPv6.
5. After clicking Finished, the Global DNS Configuration will be complete. TheGlobal DNS Configuration radio

button inGLB > Zone Tools > General Settings will be enabled automatically.

In Zone Tools, three things will happen:

1. Under Zone, your new zone will appear.

2. UnderGlobal DNS Policy, select the first policy. If more than one policy exists, choose the first one.

3. A dialogue opens. Under Zone List, you will see that your zone has moved automatically from Available Items to
Selected Items.
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FQDN

TheGlobal Load Balance > FQDN sub-menu allows you to perform the following tasks relating to the FQDN (fully
qualified domain name):

l Configuring hosts on page 499
l Configuring virtual server pools on page 500
l Configuring location lists on page 502
l Configuring GLB settings on page 503

Configuring hosts

Host settings are used to form the zone configuration and resource records in the generated DNS zone used for global
load balancing.

 Host configuration and the generated DNS zone on page 499 shows how the host settings are mapped to zone settings
and resource records. Domain and hostname are used in both the configuration and the generated configuration name.
The IP address and weight are derived from the virtual server pool.

 Host configuration and the generated DNS zone

Before you begin:

l You must have created the global virtual server pools you want to use.
l You must have Read-Write permission for Global Load Balance settings.

After you have created a host configuration object, it can be used to form the zone and resource records in the generated
DNS zone configuration.

To configure a host:

1. Go toGlobal Load Balance > FQDN.
2. Click the Host tab.
3. Click Create New to display the configuration editor.
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4. Complete the configuration as described in Host configuration on page 500.
5. Save the configuration.

Settings Guidelines

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces.
Note: After you initially save the configuration, you cannot edit the name.

Host Name The hostname part of the FQDN, such as www.
Note: You can specify the@ symbol to denote the zone root. The value substituted for @
is the preceding $ORIGIN directive.

Domain Name The domain name must end with a period. For example: example.com.

DNS Policy Select the DNS policy you want the host to use.

Respond Single Record Enable/disable an option to send a single record in response to a query. Disabled by
default. By default, the response is an ordered list of records.

Persistence Enable/disable the persistence table. Disabled by default.
If you enable persistence, the client source address is recorded in the persistence table,
and subsequent requests from the same network or the same host or domain are sent an
answer with the virtual servers listed in the same order (unless a server becomes
unavailable and is therefore omitted from the answer).

Virtual Server Pool
Selection Method

l Weight—If selected, virtual server pool will be responded by weight.
l DNS Query Origin—If selected, virtual server pool with the same topology
information as the local DNS address will be responded.

l Global Availability—If selected, virtual servers will be responded by their global
availability: the first virtual server in queue will always be responded if it is globally
available, and the next virtual server in queue will be responded if the preceding
virtual server is unavailable.

Default Feedback IPv4 Specify an IP address to return in the DNS answer if no virtual servers are available.

Default Feedback IPv6 Specify an IPv6 address to return in the DNS answer if no virtual servers are available.

Virtual Server Pool

Name Enter the mkey.

Virtual Server Pool Select a virtual server pool from the list, or create a new one.

Weight Assign a weight. Valid values range from 1 to 255.

Topology Select a topology from the list, or create a new one.

ISP Select an ISP from the list or create a new one.

Host configuration

Configuring virtual server pools

The virtual server pool configuration defines the set of virtual servers that can be matched in DNS resource records, so it
should include, for example, all the virtual servers that can be answers for DNS requests to resolve www.example.com.
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You also specify the key parameters of the global load balancing algorithm, including proximity options, status checking
options, load balancing method, and weight.

The DNS response is an ordered list of answers. Virtual servers that are unavailable are excluded. Available virtual
servers are ordered based on the following priorities:

1. Geographic proximity
2. Dynamic proximity
3. Weighted round robin

A client that receives DNS response with a list of answers tries the first and only proceeds to the next answers if the first
answer is unreachable.

Before you begin:

l You must have created GLB Servers configuration objects.
l You must have Read-Write permission for Global Load Balance settings.

After you have created a virtual server pool configuration object, you can specify it in the global load balancing host
configuration.

To configure a virtual server pool:

1. Go toGlobal Load Balance > FQDN.
2. Click the Virtual Server Pool tab.
3. Click Create New to display the configuration editor.
4. Complete the configuration as described in Virtual server pool configuration on page 501.
5. Save the configuration.

Settings Guidelines

Name Specify a unique name for the virtual server pool configuration. Valid characters
are A-Z, a-z, 0-9, _, and -. No spaces. You reference this name in the host
configuration.
Note: After you initially save the configuration, you cannot edit the name.

Preferred l None—No preference.
l Geo—If selected, virtual servers with the same GEO information as the local
DNS address will respond.

l Geo-ISP—If selected, virtual servers with the same ISP information as the
local DNS address will respond first, and virtual servers with the same GEO
information as the local DNS address will respond second.

l RTT—Virtual servers with the shortest latency link or closest to the data
center will respond.

l Least-Connnections—Virtual servers with the least connections will respond.
l Connection-Limit—Virtual servers will be responded by their connection limit
determined by virtual servers' weight: the greater the weight of a virtual
server, the more responses it will get.

l Bytes-Per-Second—Virtual servers with the lowest traffic will respond.
l Server-Performance—Virtual servers with better server-performancec in the

Virtual server pool configuration
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Settings Guidelines

CPU or Memory (whichever one you give more weight to) will respond.

Alternate Same as above.

Load Balance Method Weighted Round Robin

Check Server Status Enable/disable polling of the local FortiADC SLB. If the server is unresponsive, its
virtual servers are not selected for DNS answers.

Check Virtual Server Existence Enable/disable checks on whether the status of the virtual servers in the virtual
server list is known. Virtual servers with unknown status are not selected for DNS
answers.

Member

Server Select a GLB Servers configuration object.

Server Member Select the name of the virtual server that is in the servers virtual server list
configuration.

Weight Assigns relative preference among members—higher values are more preferred
and are assigned connections more frequently.
The default is 1. The valid range is 1-255.

Backup Enable to designate the member as a backup. Backup members are inactive until
all main members are down.

Configuring location lists

A location list configuration consists of a list of locations you select.

To configure a location list:

1. Go toGlobal Load Balance > FQDN.
2. Click the Location List tab.
3. Complete the configuration as described in Location List settings on page 502.
4. Click Save.

Settings Guidelines

Name Specify a unique name for the location list.

GEO IP List Create a GEO IP list:
1. Click inside the box.
2. Select an option from the drop-down list menu.
3. Repeat Steps 1 and 2 to add more locations to the list.
Note: To remove an entry off your list, click the corresponding x sign.

Location List settings

Note: Starting from FortiADC 5.x.x, the GUI shows the full country or region names listed in alphabetical order for
location list and data center configuration. The Console uses country or region name abbreviations instead. The
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abbreviations are done in accordance with the ISO standards. So if you configure a location list or data center from the
Console, be sure to consult ISO-3166-1 and/or ISO 3166-2:CN for the correct abbreviations to use. See the following
example commands:

config global-load-balance topology
edit "tp1"

set member ZZ US CN65
next

end

Where ZZ stands for Reserved, US for United States, and CN65 for China, Xingjiang

Configuring GLB settings

Configure the global load balancing settings of the FQDN, including the following:

l Listening interface— The listen port is used for communication for GLB and SLB server.
l Authentication— Configure the authentication between the GLB and the server.
l Dynamic proximity — This is used to order DNS lookup results based on the shortest application response time
(RTT) for ICMP or TCP probes sent by the local SLB to the DNS resolver that sent the DNS request. The system
caches the RTT results for the period specified by the timeout. When there are subsequent requests from clients
that have a source IP address within the same network (as specified by the netmask affinity), the RTT is taken from
the results table instead of a new, real-time probe. This reduces response time.

l Persistence—Configure the source address affinity and a timeout for GSLB persistence. You enable persistence
per host in the GSLB host configuration.
If the DNS query is for a host that has persistence enabled, the DNS server replies with a response that has the
virtual server IP addresses listed in the order determined by the GSLB proximity algorithms, and the client source IP
address (for example 192.168.1.100) is recorded in the persistence table. If source address affinity is set to 24 bits,
subsequent queries for the host from the 192.168.1.0/24 network are sent an answer with the virtual servers listed in
the same order (unless a server becomes unavailable and is therefore omitted from the answer).
Persistence is required for applications that include transactions across multiple hosts, so the persistence table is
also used for queries for other hosts with the same domain. For example, a transaction on a banking application
might include connections to login.bank.com and transfer.bank.com. To support persistence in these cases, the
GSLB persistence lookup accounts for domain as well. The first query for login.bank.com creates a mapping for the
source address network 192.168.1.0/24 and the domain bank.com. When the DNS server receives subsequent
requests, it consults the persistence table for a source network match, then a domain match and a hostname match.
In this example, as long as you have created host configurations for both login.bank.com and transfer.bank.com,
and persistence is enabled for each, the persistence table can be used to ensure the DNS answers to queries from
the same network list the resource records in the same order.

Before you begin:

l You must have Read-Write permission for Global Load Balance settings.

To configure the GLB settings of the FQDN:

1. Go toGlobal Load Balance > FQDN.
2. Click theGLB Setting tab.
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3. Configure the following GLB settings:

Setting Description

Auth Type Select the authentication type:
l None—No password.
l TCPMD5SIG—With password, but cannot be used if NAT is in between
the client and server. This is because, when using the TCPMD5SIG
authentication in a network with NAT in between, the IP layer is
encrypted. So is every packet. Because the IP address will be changed,
the encryption check will always fail.

l Auth Verify — The authentication key is sent to the server after a three-
way handshake. The key is encrypted and NAT in between will not affect
the authentication.

Password The Password option is available if Auth Type is TCP MD5SIG or Auth
Verify.
Enter the password to authenticate the key.
This password is used for authentication between the GLB and the server. The
same password must be set on both, otherwise the two will not be able to
synchronize.

CA Verify Enable/disable the certificate verification when synchronizing the SLB
information to the GSLB server.

Trusted CA Group The Trusted CA Group option is available if CA Verify is enabled.
Select a trusted CA group to verify the peer certificate.

Trusted Intermediate CA Group The Trusted Intermediate CA Group option is available if CA Verify is
enabled.
Select a trusted intermediate CA group to verify the peer certificate.

IPv4 Accessed Status Enable/disable listening for DNS requests on the interface IPv4 address.

IPv6 Accessed Status Enable/disable listening for DNS requests on the interface IPv6 address.

Listen on All Interfaces Enable/disable IPv4/IPv6 network access status on all interfaces.

Listen on Interface List The Listen on Interface List option is available if Listen on All Interfaces is
disabled.
Specify specific interfaces for IPv4/IPv6 network access.

Listen on Port Specify the port to listen on. Default: 5858 Range: 1-65535.

4. Configure the following Proximity settings:

Setting Description

Protocol Select the proximity detection protocol:
l ICMP
l ICMP and TCP

Retry Number Specify the number of retries if the probe fails. The default is 3. The valid range
is 1-10 times.
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Setting Description

Retry Interval Specify the interval between retries if the probe fails. The default is 3. The valid
range is 1-3600 seconds.

IPv4 Prefix Length Specify the number of IPv4 netmask bits that define network affinity for the
RTT table. The default is 24. For example, if the GLB records an RTT for a
client with source IP address 192.168.1.100, the record is stored and applies
to all requests from the 192.168.1.0/24 network.

IPv6 Prefix Length Specify the number of IPv6 netmask bits that define network affinity for the
RTT table. The default is 64.

Aging Timeout Specify the for how long RTT results are cached. This setting specifies the
length of time in seconds for which the RTT cache entry is valid. The default is
86400. The valid range is 60-2,592,000 seconds.

5. Configure the following Persistence settings:

Setting Description

IPv4 Mask Length Specify the number of IPv4 netmask bits that define network affinity for the
persistence table. The default is 24.

IPv6 Mask Length Specify the number of IPv6 netmask bits that define network affinity for the
persistence table. The default is 64.

Aging Period This setting specifies the length of time in seconds for which the entry is
maintained in the persistence table. The default is 86400. The valid range is
60-2,592,000 seconds.

6. Click Save.

Zone Tools

TheGlobal Load Balance > Zone Tools sub-menu allows you to perform the following tasks relating to the zone tools
for global load balancing:

l Configuring a Global DNS policy on page 506
l Configuring DNS zones on page 507
l Configuring general settings on page 511
l Configuring the trust anchor key on page 525
l Configuring DNS64 on page 526
l Configuring the DSSET list on page 527
l Configuring an address group on page 528
l Configuring remote DNS servers on page 529
l Configuring the response rate limit on page 529
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Configuring a Global DNS policy

The Global DNS policy is a rule base that matches traffic to DNS zones. Traffic that matches both the source and the
destination criteria is served by the policy. Traffic that does not match any policy is served by the DNS “general settings”
configuration.

Before you begin:

l You must have a good understanding of DNS and knowledge of the DNS deployment in your network.
l You must have configured address objects, remote servers, DNS zones, and optional configuration objects you
want to specify in your policy.

l You must have Read-Write permission for Global Load Balance settings.

To configure the global DNS policy rule base:

1. Go toGlobal Load Balance > Zone Tools.
2. Click theGlobal DNS Policy tab.
3. Click Create New to display the configuration editor.
4. Complete the configuration as described in Global DNS policy configuration on page 506.
5. Save the configuration.
6. Reorder rules, as necessary.

Settings Guidelines

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces.
After you initially save the configuration, you cannot edit the name.

Source Select an address object to specify the source match criteria. See Configuring an address
group.

Destination Select an address object to specify the destination match criteria. See Configuring an address
group.

Zone List Select one or more zone configurations to serve DNS requests frommatching traffic. See
Configuring DNS zones.

DNS64 List Select one or more DNS64 configurations to use when resolving IPv6 requests. See
Configuring DNS64.

Recursion Enables/disables recursion. If enabled, the DNS server attempts to do all the work required to
answer the query. If not enabled, the server returns a referral response when it does not
already know the answer.

DNSSEC Validation Enables/disables DNSSEC validation.

Forward l First—The DNS server queries the forwarders list before doing its own DNS lookup.
l Only—Only queries the forwarders list. Does not perform its own DNS lookups.

Note: The internal server caches the results it learns from the forwarders, which optimizes
subsequent lookups.

Global DNS policy configuration
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Settings Guidelines

Forwarders If the DNS server zone has been configured as a forwarder, select the remote DNS server to
which it forwards requests. See Configuring remote DNS servers.

Response Rate Limit Select a rate limit configuration object. See Configuring the response rate limit.

Reordering

After you have saved a rule, reorder rules as necessary. The rules table is consulted from top
to bottom. The first rule that matches is applied and subsequent rules are not evaluated.

Configuring DNS zones

The DNS zone configuration is the key to the global load balancing solution. This configuration contains the key DNS
server settings, including:

l Domain name and name server details.
l Type—Whether the server is the primary or a forwarder.
l DNSSEC—Whether to use DNSSEC and the DNSSEC algorithm/key size.
l DNS RR records—The zone configuration contains resource records (RR) used to resolve DNS queries delegated
to the domain by the parent zone.

You can specify different DNS server settings for each zone you create. For example, the DNS server can be a primary
for one zone and a forwarder for another zone.

Before you begin:

l You must have a good understanding of DNS and knowledge of the DNS deployment in your network.
l You must have authority to create authoritative DNS zone records for your network.
l You must have Read-Write permission for Global Load Balance settings.

After you have configured a DNS zone, you can select it in the DNS policy configuration.

To configure the DNS zone:

1. Go toGlobal Load Balance > Zone Tools.
2. Click the Zone tab.
3. Click Create New to display the configuration editor.
4. Complete the configuration as described in DNS zone configuration on page 507.

Settings Guidelines

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces. You reference
the name in the global DNS policy configuration.
Note:
l FortiADC supports third-party domain names.
l After you initially save the configuration, you cannot edit the name.

DNS zone configuration
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Settings Guidelines

Type l Primary—The configuration contains the “primary” copy of data for the zone and is the
authoritative server for it.

l Forward—The configuration allows you to apply DNS forwarding on a per-domain basis,
overriding the forwarding settings in the “general” configuration.

l FQDNGenerate—The zone and its resource record is generated from the global load
balancing framework.

Domain Name The domain name must end with a period. For example: example.com.

DNS policy Select the DNS policy you want the zone to use.

Primary Options

DNSSEC Enable/disable DNSSEC.
The Domain Name System Security Extensions (DNSSEC) is a feature of the Domain Name
System (DNS) that authenticates responses to domain name lookups.
Only when a DNS policy has been set, and DNSSEC is enabled, will the Back Up DSSET
Key, Regenerate DNSSEC Key, and Restore DNSSEC Key appear.
Back Up DSSET Key includes the following types of keys:
l KSK. Type characters for a string key. To regenerate the KSK, disable and re-enable
DNSSEC.

l ZSK. Type characters for a string key. To regenerate the ZSK, disable and re-enable
DNSSEC.

l DSSET. It is generated by the system if DNSSEC is enabled for the zone.
Restore DNSSEC Key should be a tar type file.

DNSSEC Algorithm The DNSSEC Algorithm option is available if DNSSEC is enabled.
Select the cryptographic algorithm to use for authenticating DNSSEC.
l RSA-SHA1
l NSEC3-RSA-SHA1
l RSA-SHA256
l RSA-SHA512
l ECDSAP256-SHA256
l ECDSAP384-SHA384

DNSSEC Key Size The DNSSEC Key Size option is available if DNSSEC is enabled.
Select the key size (number of bits) for the encryption algorithm.
l 1024 bits
l 2048 bits
l 4096 bits

Note:
Prior to FortiADC 7.4.0, the DNSSEC key size only supported 512 bits, so configurations
carried over from previous versions can continue using the 512-bit key. However, we
recommend updating to the new 1024/2048/4096 bit keys as the 512-bit key is less secure
and is no longer supported in the latest BIND 9 version.

DSSET List The DSSET List option is available if DNSSEC is enabled.
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Settings Guidelines

Select a DSSET configuration object. See Configuring the DSSET list.

TTL The $TTL directive at the top of the zone file (before the SOA) gives a default TTL for every
RR without a specific TTL set.
The default is 86,400. The valid range is 0 to 2,147,483,647.

Serial Set the serial number of the zone. Default 10004. Range 1-4294967295.

Negative TTL The last field in the SOA—the negative caching TTL. This informs other servers how long to
cache no-such-domain (NXDOMAIN) responses from you. The default is 3600 seconds. The
valid range is 0 to 2,147,483,647.

Responsible Mail Username of the person responsible for this zone, such as hostprimary.example.com..
Note: Format is mailbox-name.domain.com. (remember the trailing dot). The format
uses a dot, not the@ sign used in email addresses because@ has other uses in the zone file.
Email, however, is sent to hostprimary@example.com.

Primary Server
Name

Sets the server name in the SOA record.

Primary Server
Address

The IP address of the primary server.

Notify Status Enable/Disable notify status. The IP in "also notify IP list" will be notified only when Notify
Status is enabled.

Also Notify IP List Set a list of IP addresses that will be notified if Notify Status is enabled.

Allow Transfer Defines a list of IP addresses that are allowed to transfer the DNS zone information.
By default there will be "Any" and "None."

Forward Options

Forward l First—The DNS server queries the forwarder before doing its own DNS lookup.
l Only—Only query the forwarder. Do not perform a DNS lookup.
l Note: The internal server caches the results it learns from the forwarders, which
optimizes subsequent lookups.

Forwarders Select a remote server configuration object.

FQDN Record

FQDN Record table Displays a summary of all DNS RR for the zone, including generated and manually configured
RR.

A/AAAA Record

Hostname The hostname part of the FQDN, such as www.
Note: You can specify the@ symbol to denote the zone root. The value substituted for @ is
the preceding $ORIGIN directive.

Type l IPv4
l IPv6
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Settings Guidelines

Address Specify the IP address of the virtual server.

Method Weighted Round Robin is the only method supported.

CNAME Record

Alias An alias name to another true or canonical domain name (the target). For instance,
www.example.com is an alias for example.com.

Target The true or canonical domain name. For instance, example.com.

NS Record

Domain Name The domain for which the name server has authoritative answers, such as example.com.
Note: FortiADC supports third-party domain names.

Hostname The hostname part of the FQDN, such as ns.

Type l IPv4
l IPv6

Address Specify the IP address of the name server.

MX Record

Hostname The hostname part of the FQDN for a mail exchange server, such as mail.

Priority Preference given to this RR among others at the same owner. Lower values have greater
priority.

Type l IPv4
l IPv6

Address Specify the IP address.

TXT Record

Name Hostname.
TXT records are name-value pairs that contain human readable information about a host. The
most common use for TXT records is to store SPF records.

Text Comma-separated list of name=value pairs.
An example SPF record has the following form:
v=spf1 +mx a:colo.example.com/28 -all

If you complete the entry from the the Web UI, do not put the string in quotes. (If you complete
the entry from the CLI, you do put the string in quotes.)

SRV Record

Host Name The host name part of the FQDN, e.g., www.

Priority A priority assigned to the target host: the lower the value, the higher the priority.

Weight A relative weight assigned to a record among records of the same priority: the greater the
value, the more weight it carries.
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Settings Guidelines

Port The TCP or UDP port on which the service is provided.

Target Name The canonical name of the machine providing the service.

PTR Record

PTR address A PTR address, such as 10.168.192.in-addr.arpa. or 1

FQDN A fully qualified domain name, such as "www.example.com".

CAA Record

Hostname The hostname of CAA record

Value Specify the value

Flag Range 0-255. Default is 0.

Tag Issue/Issuewild/lodef

Configuring general settings

The general settings configuration specifies the interfaces that listen for DNS requests. By default, the system listens on
the IPv4 and IPv6 addresses of all configured interfaces for DNS requests.

The other settings in the general settings configuration are applied when traffic does not match a Global DNS policy.

From general settings, you can also enable DNS over HTTP/HTTPS (DoH) and DNS over TLS (DoT) to encrypt the DNS
query.

Before you begin:

l You must have a good understanding of DNS and knowledge of the DNS deployment in your network.
l You must have Read-Write permission for Global Load Balance settings.
l If enabling DNS over HTTPS/TLS, you must have prepared a dedicated DNS server domain and a certificate pair
for your DNS over HTTPS/TLS service. For details, see Configuring DNS over HTTPS and DNS over TLS on page
513.

To configure general settings:

1. Go toGlobal Load Balance > Zone Tools.
2. Click theGeneral Settings tab.
3. Complete the configuration as described in General configuration on page 511.
4. Save the configuration.

Settings Guidelines

Global DNS
Configuration

Enables/disables this configuration.

General configuration
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Settings Guidelines

Recursion Enables/disables recursion. If enabled, the DNS server attempts to do all the work required to
answer the query. If not enabled, the server returns a referral response when it does not
already know the answer.

DNSSEC Validation Enables/disables DNSSEC validation.

Minimal Responses Enables/disables Minimal Responses to hide the Authority Section and Additional Section
of DNS queries.
When the DNS query only shows the minimal response, it can significantly increase the
performance of the FortiADC DNS service by increasing the QPS.

Listen on IPv6 Enables/disables listening for DNS requests on the interface IPv6 address.

Listen on IPv4 Enables/disables listening for DNS requests on the interface IPv4 address.

Traffic Log Enables/disables traffic log.

Listen on All
Interface

Enables listening on all interfaces.

Interface List The Interface List option is available if Listen on All Interface is disabled.
If not listening to all interfaces, select one or more ports to listen on.

DNS over HTTPS Enables/disables DNS over HTTPS to encrypt DNS queries using the HTTPS protocol.

DNS over HTTPS
Port

The DNS over HTTPS Port option is available if DNS over HTTPS is enabled.
Specify the port to listen on DNS over HTTPS. Default: 443 Range: 1-65535.

DNS over HTTPS
Interface List

The DNS over HTTPS Interface List option is available if DNS over HTTPS is enabled.
Select the interface(s) to listen on for DNS over HTTPS.

DNS over HTTP Enables/disables DNS over HTTP to encrypt DNS queries using the HTTP protocol.

DNS over HTTP Port The DNS over HTTP Port option is available if DNS over HTTP is enabled.
Specify the port to listen on DNS over HTTP. Default: 80 Range: 1-65535.

DNS over HTTP
Interface List

The DNS over HTTP Interface List option is available if DNS over HTTP is enabled.
Select the interface(s) to listen on for DNS over HTTP.

DNS over TLS Enables/disables DNS over TLS to encrypt DNS queries using the TLS protocol.

DNS over TLS Port The DNS over TLS Port option is available if DNS over TLS is enabled.
Specify the port to listen on DNS over TLS. Default: 853 Range: 1-65535.

DNS over TLS
Interface List

The DNS over TLS Interface List option is available if DNS over TLS is enabled.
Select the interface(s) to listen on for DNS queries for DNS over TLS.

Certificate The Certificate option is available if DNS over HTTPS or DNS over TLS is enabled.
Select the certificate object to apply for DNS over HTTPS or DNS over TLS. This certificate
must refer to the DNS server domain or IP address. For details, see Configuring DNS over
HTTPS and DNS over TLS on page 513.

Forward l First—The DNS server queries the forwarder before doing its own DNS lookup.
l Only—Only queries the forwarder. Does not perform its own DNS lookups.
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Settings Guidelines

Note: The internal server caches the results it learns from forwarders, which optimizes
subsequent lookups.

Use System DNS
Server

Forwards DNS requests to the system DNS server instead of the forwarders list.

Response Rate Limit Selects a rate limit configuration object. See Configuring the response rate limit.

Configuring DNS over HTTPS and DNS over TLS

DNS over HTTPS (DoH) and DNS over TLS (DoT) are protocols used to encrypt communications with DNS resolvers.
DoH encrypts the DNS traffic by passing DNS queries through an HTTPS encrypted session. Whereas DoT adds TLS
encryption on top of the UDP that is used for DNS queries.

The primary difference between the DoH and DoT standards is what port they use. DoT only uses port 853, whereas
DoH uses port 443 (which is the port that all other HTTPS traffic uses as well).

To configure DNS over HTTPS or DNS over TLS on FortiADC, follow the basic steps below:

Step 1: Prepare a full domain name or an IP address for your DoH/DoT service on page 513

Step 2: Prepare a certificate pair for the DoH/DoT service on page 513

Step 3: Enable DoH/DoT service on FortiADC on page 514

Step 4: Enable DoH/DoT service on your browser or local application on page 515

Step 1: Prepare a full domain name or an IP address for your DoH/DoT service

Before you can configure DoH/DoT on FortiADC, you must first prepare a full domain name or an IP address for the
DoH/DoT service. This will then be used for your custom DoH/DoT server URL and to sign the certificate.

You can prepare the full domain using either of the following methods:

l If your organization manages its own public domain, you can add a new record to the domain.
a. Login to you DNS service provider and go to your DNS Domain management page.
b. Add a new record to the existing public domain as dns.yourdomain.com. The IP address is the DNS-over-

HTTPS or DNS-over-TLS service public IP.
l If you want to test your own domain, you can add the full domain name resolution to the local hosts file.
For example: The Ubuntu local hosts file would be located at /etc/hosts, and in Windows it would be at
c:\Windows\System32\Drivers\etc\hosts.

Step 2: Prepare a certificate pair for the DoH/DoT service

Use the full domain name or IP address for the DoH/DoT service previously prepared to create a certificate pair.

You can prepare the certificate pair for your DoH/DoT service using either of the following methods:

l Apply for a public certificate from a public CA with your full domain name or IP address.
l Generate a self-signed certificate. Note: A self-signed certificate cannot be generated through FortiADC.
For example: Generating a self-signed certificate in Ubuntu with OpenSSL
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a. Prepare the prerequisites:

mkdir demoCA
mkdir demoCA/newcerts
echo 01 > demoCA/serial
touch demoCA/index.txt

b. Add the following lines to the file /usr/lib/ssl/openssl.cnf under the [v3_req] section.

subjectAltName = @alt_names
[alt_names]
DNS.1=dns.yourdomain.com
IP.1=yourdomain IP

c. Generate the root CA key.

openssl genrsa -out rootca.key 2048

d. Generate the root CA cert.

openssl req -new -x509 -days 3650 -key rootca.key -out rootca.crt -subj
"/C=Country/ST=State/L=Location/O=Company/OU=Department/CN=yourdomain.com/emailAddre
ss=admin@yourdomain.com"

e. Generate the DNS server private key.

openssl genrsa -out dns-doh.key 2048

f. Generate the DNS server cert (enter y if prompted).

openssl req -new -key dns-doh.key -out dns-doh.csr -subj
"/C=Country/ST=State/L=Location/O=Company/OU=Department/CN=yourdomain.com/emailAddre
ss=admin@yourdomain.com"

openssl ca -in dns-doh.csr -out dns-doh.crt -cert rootca.crt -keyfile rootca.key -
days 365 -extensions v3_req

g. Verify the certificate.

openssl verify -CAfile rootca.crt dns-doh.crt

Step 3: Enable DoH/DoT service on FortiADC

After preparing the certificate pair for the DoH/DoT service, you can import the certificate and then enable the DoH/DoT
function in FortiADC.

1. Go to System > Manage Certificates.
2. Click the Local Certificate tab.
3. Click Import to upload the prepared certificate in FortiADC.
4. Go toGlobal Load Balance > Zone Tools.
5. Click theGeneral Settings tab.
6. Configure the following relevant settings to enable DNS over HTTPS service and save the configuration:

Setting Guidelines

Global DNS Configuration Enable Global DNS Configuration.
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Setting Guidelines

DNS over HTTPS Enable DNS over HTTPS service.

DNS over HTTPS port Default port is 443. Change the HTTPS service port number if it is not the
default HTTPS service port or if there is an IP/port conflict.

DNS over HTTPS Interface List Select the interfaces that allow the DNS over HTTPS service.

Certificate Select the matching certificate.

a. Test your DNS over HTTPS configuration.
For example, you can use a DNS lookup tool such as Dig from a remote system.
dig @yourdomain.com example.com +https
If the DNS over HTTPS is successfully configured, you should get the IP address of example.com:
93.184.216.34.
From Dig's output, you should also see the following:
;; SERVER: 18.217.127.135#443(dns.yourdomain.com) (HTTPS)
This confirms that the query/response operation was performed successfully over HTTPS (TCP port 443)
rather than the traditional UDP port 53.

7. Configure the following relevant settings to enable DNS over TLS service and save the configuration:

Setting Guidelines

Global DNS Configuration Enable Global DNS Configuration.

DNS over TLS Enable DNS over TLS service.

DNS over TLS port Default port is 853.

DNS over TLS Interface List Select the interfaces that allow the DNS over TLS service.

Certificate Select the matching certificate.

a. Test your DNS over TLS configuration.
For example, you can use a DNS lookup tool such as Dig from a remote system.
dig @yourdomain.com example.com +tls
If the DNS over HTTPS is successfully configured, you should get the IP address of example.com:
93.184.216.34.
From Dig's output, you should also see the following:
;; SERVER: 18.217.127.135#853(dns.yourdomain.com) (TLS)
This confirms that the query/response operation was performed successfully over TLS (TCP port 853) rather
than the traditional UDP port 53.

Step 4: Enable DoH/DoT service on your browser or local application

After you have configured DoH/DoT on FortiADC, enable DoH/DoT service on your browser or local application.
However, if you have used a self-signed certificate pair, you need to first import that certificate into the local system
before enabling DoH/DoT on the browser or local application.
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Importing the self-signed certificate pair to the local system for DoH/DoT

Example 1: Importing the self-signed certificate to Windows

1. Launch MMC (mmc.exe). Go to File > Add/Remove Snap-ins.

2. Select Certificates, then click Add.
The Certificates snap-in dialog displays.
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3. In the Certificates snap-in dialog, selectMy user account. Click Finish, then clickOK.

4. Select Certificates - Current User, right-click on Trusted Root Certification Authorities. Then select All Tasks
> Import.

The Certificate Import Wizard dialog displays.
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5. In the Certificate Import Wizard dialog, click Browse to select the rootca.crt file and clickOpen.

6. Select Place all certificates in the following store and set Trusted Root Certification Authorities as the
Certificate store. Click Next and Next again, then click Finish.

7. Click Yes and Finish for the prompt windows.

Example 2: Importing the self-signed certificate to Ubuntu

1. Install or update ca-certificates.

$ sudo apt-get install -y ca-certificates

2. Copy your certificate in PEM format (the format that has ----BEGIN CERTIFICATE---- in it) into
/usr/local/share/ca-certificates and name it with a .crt file extension.

$ sudo cp rootca.crt /usr/local/share/ca-certificates

3. Update your ca chain list.

$ sudo update-ca-certificates
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Enabling DNS over HTTPS on the browser

Example 1: Enable DoH in Chrome (version 105.0.5195.102)

1. Import self-signed certificate to Chrome. You may skip this step if you use a public certificate.
a. Open chrome://settings/privacy and select Security.
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b. Scroll down and selectManage Certificates > Authorities, then click Import.

c. Select the file rootca.crt and open. Check all the boxes and clickOK.

2. Enable custom DNS over HTTPS settings.
a. Go to Settings > Privacy and security > Security.
b. Enable Use secure DNS, selectWith, then select Custom from the drop-down list.
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c. Input the URL that matches your FortiADC DNS server domain and your certificate as
https://yourdomain/dns-query or https://yourIP:port/dns-query.

3. Debugging.
Try the following URL and see if there is a file downloading.
https://yourdomain/dns-query?dns=q80BAAABAAAAAAAAA3d3dwdleGFtcGxlA2NvbQAAAQAB
If downloaded, then all configurations are correct.
Otherwise, the most common error is ERR_CERT_COMMON_NAME_INVALID, which means your server cert CN is
invalid or does not match your FortiADC server.

Example 2: Enable DoH in Firefox (version 104.0.2)

1. Import self-signed certificate to Firefox. You may skip this step if you use a public certificate.
a. Go to Settings > Privacy & Security, under the Certificates section, click View Certificates.
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b. Select Authorities, click Import and select your root CA file. Check all the boxes and clickOK to save.

2. Enable custom DNS over HTTPS settings.
a. Go to Settings > General, under the Network Settings section, click Settings.

b. Select Enable DNS over HTTPS. In the Use Provider field, select Custom from the drop-down list.
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c. Input the URL that matches your FortiADC DNS server domain and your certificate as
https://yourdomain/dns-query or https://yourIP:port/dns-query. ClickOK to save.

3. Debugging.
Try the following URL and see if there is a file downloading.
https://yourdomain/dns-query?dns=q80BAAABAAAAAAAAA3d3dwdleGFtcGxlA2NvbQAAAQAB
If downloaded, then all configurations are correct.
Otherwise, the most common error is ERR_CERT_COMMON_NAME_INVALID, which means your server cert CN is
invalid or does not match your FortiADC server.

Enabling DNS over TLS on your local application

Example 1: Enable DoT in Ubuntu with systemd

1. Check the systemd version.
systemd start to support strict DNS over TLS mode from version 243. Use the following command to check your
version and update it if the version is too old.

$ systemd --v
systemd 249 (249.11-0ubuntu3.6)

2. Set up the systemd configuration.
Modify /etc/systemd/resolved.conf so that it is similar to what is shown below. Be sure to enable DNS over
TLS and to configure the IP addresses of the DNS servers you want to use.

$ cat /etc/systemd/resolved.conf
DNS=10.106.210.81
FallbackDNS=8.8.8.8
#Domains=
#DNSSEC=no
DNSOverTLS=yes
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#LLMNR=yes
#MulticastDNS=yes
#Cache=yes
#DNSStubListener=yes
#ReadEtcHosts=yes

3. Restart services.
To make the settings configured in the previous steps take effect, restart systemd-resolved.

$ sudo systemctl restart systemd-resolved

4. Check that everything is running correctly.

$ resolvectl status
Global

Protocols: -LLMNR -mDNS +DNSOverTLS -DNSSEC
resolv.conf mode: foreign

Current DNS Server: 10.106.210.81
DNS Servers: 10.106.210.81

Fallback DNS Servers: 8.8.8.8

5. Verify the configuration.
Use the following command to perform a DNS query.

$ sudo resolvectl flush-caches
$ resolvectl query google.com
google.com: 142.250.72.206 -- link: ens160

2607:f8b0:4005:801::200e -- link: ens160

-- Information acquired via protocol DNS in 23.8ms.
-- Data is authenticated: no; Data was acquired via local or encrypted transport: yes
-- Data from: network

Use tcpdump to capture the traffic in another terminal. You will find that the traffic goes to DNS server
10.106.210.81 port 853 instead of the regular DNS service port 53.

Example 2: Enable DoT in Ubuntu with Unbound

1. Install Unbound.

# sudo apt install -y unbound
# sudo systemctl enable unbound

2. Edit the configuration file.

# cat /etc/unbound/unbound.conf.d/pihole.conf
server:

port: 53
tls-upstream: yes
tls-cert-bundle: "/etc/ssl/certs/ca-certificates.crt"

forward-zone:
name: "."
forward-addr: 10.106.210.81@853

# unbound-checkconf
unbound-checkconf: no errors in /etc/unbound/unbound.conf
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3. Restart services.

# sudo systemctl restart unbound

4. Verify the configuration.
Perform a simple Dig test and use tcpdump to capture the traffic in another terminal. You will find that all the DNS
traffic goes to Server 10.106.210.81 port 853 instead the regular DNS service port 53.

Example 3: Enable DoT in Windows with YogaDNS

1. Go to https://dns.sb/guide/dot/windows/
2. Set the IP address and optional port to match your FortiADC configuration.
3. Under DNS over TLS options, set the Hostname to match your certificate or you may leave it blank. ClickOK.

Configuring the trust anchor key

DNSSEC validation requires that a DNS name server know the trust anchor key for the root DNS domain in order to
validate already signed responses. In general, trust anchor keys do not change often, but they do change occasionally,
and might change unexpectedly in the event the keys are compromised.

The FortiADC DNS server is preconfigured with a trust anchor key for the root DNS domain. If you are informed that you
must update this key, you can use the configuration editor to paste the new content into the DNS server configuration.

Further reading:

http://data.iana.org/root-anchors/draft-icann-dnssec-trust-anchor.html

Before you begin:
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l You must have a good understanding of DNSSEC and knowledge of the DNS deployment in your network.
l You must have already obtained the key so that you can copy and paste it into the DNS server configuration.
l You must have Read-Write permission for Global Load Balance settings.

To configure the trust anchor key:

1. Go toGlobal Load Balance > Zone Tools.
2. Click the Trust Anchor Key tab.
3. Click Create New to display the configuration editor.
4. Complete the configuration as described in Trust anchor key configuration on page 526.
5. Save the configuration.

Settings Guidelines

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces.
After you initially save the configuration, you cannot edit the name.

Value The key value. The key format is a string with the following format:
\"<domainname>\" <num1> <num2> <num3> \"<content>\"

The following is an example:
\".\" 256 3 5
\"AwEAAbDrWmiIReotvZ6FObgKygZwUxSUJW9z5pjiQMLH0JBGXooHrR16
pdKhI9mNkM8bLUMtwYfgeUOYXIvfagee8rk=\"

Description Description for the key.

Trust anchor key configuration

Configuring DNS64

The DNS64 configuration maps IPv4 addresses to AAAA queries when there are no AAAA records. This feature is
optional. It can be used in network segments that use NAT64 to support IPv6 client communication with IPv4 backend
servers.

Before you begin:

l You must have a good understanding of DNS and knowledge of the DNS deployment in your network.
l You must have configured address objects that specify the network segments for which the DNS64 map applies.
For details, see Configuring an address group.

l You must have Read-Write permission for Global Load Balance settings.

After you have created a DNS64 configuration, you can select it a DNS policy configuration.

To configure DNS64:

1. Go toGlobal Load Balance > Zone Tools.
2. Click the DNS64 tab.
3. Click Create New to display the configuration editor.
4. Complete the configuration as described in DNS64 configuration on page 527.

FortiADC Handbook 526
Fortinet Technologies Inc.



Global Load Balance

Settings Guidelines

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces. You reference
the name in the global DNS policy configuration.
After you initially save the configuration, you cannot edit the name.

IPv6 Prefix IP address and netmask that specify the DNS64 prefix. Compatible IPv6 prefixes have
lengths of 32, 40, 48, 56, 64 and 96 as per RFC 6052.
Each DNS64 configuration has one prefix.Multiple configurations can be defined.

Source Address Select an address object. Only clients that match the source IP use the DNS64 lookup table.

Mapped Address Select an address object that specifies the IPv4 addresses that are to be mapped in the
corresponding A RR set.

Exclude Select an address object. Allows specification of a list of IPv6 addresses that can be ignored.
Typically, you exclude addresses that do have AAAA records.

DNS64 configuration

Configuring the DSSET list

If you enable DNSSEC, secure communication between the FortiADC DNS server and any child DNS servers is based
on keys contained in delegation signer files (DSSET files). In DNSSEC deployments, DSSET files are generated
automatically when the zone is signed by DNSSEC.

You use the DSSET list configuration to paste in the content of the DSSET files provided by child domain servers or stub
domains.

Note: You use the Global DNS zone configuration to generate the DSSET file for this server. The file generated by the
zone configuration editor is the one you give to any parent zone or the registrar of your domain.

Before you begin:

l You must have a good understanding of DNSSEC and knowledge of the DNS deployment in your network.
l You must have used DNSSEC to sign the child domain servers and have downloaded the DSset files to a location
you can reach from your management computer.

l You must have Read-Write permission for Global Load Balance settings.

After you have configured a DSSET list, you can select it in DNS zone configuration.

To configure the DSSET list:

1. Go toGlobal Load Balance > Zone Tools.
2. Click the DSSET List tab.
3. Click Create New to display the configuration editor.
4. Complete the configuration as described in DSset list configuration on page 528.
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Settings Guidelines

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces. You reference
the name in the zone configuration (if you enable DNSSEC).
After you initially save the configuration, you cannot edit the name.

Filename Type the filename. The convention is dsset-<domain>, for example, dsset-example.com.

Content Paste the DSset file content. The content of DSset files is similar to the following:

dns.example.com. IN DS 13447 5 1
A5AD9EFB6840F58CF817F3CC7C24A7ED2DD5559C

DSset list configuration

Configuring an address group

An address group is a configuration object that specifies the source and destination IP addresses that are the matching
criteria for DNS policies.

Before you begin:

l You must have Read-Write permission for Global Load Balance settings.

After you have configured an address group, you can select it in the DNS policy configuration.

To configure address groups:

1. Go toGlobal Load Balance > Zone Tools.
2. Click the Address Group tab.
3. Click Create New to display the configuration editor.
4. Complete the configuration and add members as described in Address group configuration on page 528

Settings Guidelines

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces. You reference
this name in the global DNS policy configuration.
Note: After you initially save the configuration, you cannot edit the name.

Member

Address Type l IPv4
l IPv6

IP/Netmask Address/mask notation to match the IP address in the packet header.
Create objects to match source IP address and different objects to match destination IP
address.

Action l Include—The rule logic creates an address object that includes addresses matching the
specified address block.

Address group configuration
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Settings Guidelines

l Exclude—The rule logic creates an address object that excludes addresses matching the
specified address block.

Configuring remote DNS servers

The remote server configuration is used to create a list of DNS forwarders. DNS forwarders are commonly used when
you do not want the local DNS server to connect to Internet DNS servers. For example, if the local DNS server is behind
a firewall and you do not want to allow DNS through that firewall, you implement DNS forwarding to a remote server that
is deployed in a DMZ or similar network region that can contact Internet DNS servers.

Before you begin:

l You must have a good understanding of DNS and knowledge of the remote DNS servers that can be used to
communicate with Internet domain servers.

l You must have Read-Write permission for Global Load Balance settings.

After you have configured remote DNS servers, you can select them in DNS zone and DNS policy configurations.

To configure a remote server:

1. Go toGlobal Load Balance > Zone Tools.
2. Click the Remote DNS Server tab.
3. Click Create New to display the configuration editor.
4. Complete the configuration and add members as described in Remote DNS server configuration on page 529.

Settings Guidelines

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces. You reference
this name in the zone configuration (if you use forwarders).
Note: After you initially save the configuration, you cannot edit the name.

Member

Address Type l IPv4
l IPv6

Address IP address of the remote DNS server.

Port Port number the remote server uses for DNS. The default is 53.

Remote DNS server configuration

Configuring the response rate limit

The response rate limit keeps the FortiADC authoritative DNS server from being used in amplifying reflection denial of
service (DoS) attacks.

Before you begin:
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l You must have a good understanding of DNS.
l You must have Read-Write permission for Global Load Balance settings.

After you have created a response rate limit configuration, you can select it in the DNS policy and DNS general settings
configurations.

To configure the response rate limit:

1. Go toGlobal Load Balance > Zone Tools.
2. Click the Response Rate Limit tab.
3. Click Create New to display the configuration editor.
4. Complete the configuration as described in Response rate limit configuration on page 530.

Settings Guidelines

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces. You reference
the name in the global DNS policy configuration.
After you initially save the configuration, you cannot edit the name.

Responses per
Second

Maximum number of responses per second. The valid range is 1-2040. The default is 1000.

Response rate limit configuration

Global Object

TheGlobal Load Balance > Global Object sub-menu allows you to perform the following tasks relating to the global
object for global load balancing:

l Configuring servers on page 530
l Configuring a global load balance link on page 535
l Configuring data centers on page 535

Configuring servers

In the context of the global server load balance configuration, servers are the local SLB (FortiADC instances or third-
party servers) to be load balanced. For FortiADC instances, the GLB checks status and synchronizes configuration from
the local SLB so that it can learn the set of virtual servers that can be included in the GLB virtual server pool.

Virtual server discovery on page 530 illustrates configuration discovery. Placement in this list does not include them in
the pool. You also must name them explicitly in the virtual server pool configuration.

Virtual server discovery
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Before you begin:

l You must have created the data center configuration objects that are associated with the local SLB.
l You must have created virtual server configurations on the local FortiADC SLB. In this procedure, the global SLB
discovers them.

l You must have created gateway configuration objects on the local FortiADC SLB if you want to configure a gateway
health check. In this procedure, the global SLB discovers them.

l You must have created an SDN connector configuration.
Note: Currently, the SDN Connector option only supports AWS Connectors

l You must have Read-Write permission for Global Load Balance settings.

After you have created a server configuration object, you can specify it in the global load balancing virtual server pool
configuration.

To configure servers:

1. Go toGlobal Load Balance > Global Object.
2. Click the Server tab.
3. Click Create New to display the configuration editor.
4. Configure the following GLB Server settings:

Setting Description

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces.
You reference this name in the virtual server pool configuration.
Note: After you initially save the configuration, you cannot edit the name.

Type Select the remote server to use for global server load balancing:
l FortiADC SLB— use a FortiADC instance.
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Setting Description

l Generic Host — use a third party ADC or server.
l SDN Connector — use an existing external connector that is connected to
the FortiADC Security Fabric.
Note: Currently, the SDN Connector option only supports AWS
Connectors.

Auth Type The Auth Type option is available if Type is FortiADC SLB.
Select the authentication type:
l None—No password.
l TCPMD5SIG—With password, but cannot be used if NAT is in between
the client and server. This is because, when using the TCPMD5SIG
authentication in a network with NAT in between, the IP layer is
encrypted. So is every packet. Because the IP address will be changed,
the encryption check will always fail.

l Auth Verify — The authentication key is sent to the server after a three-
way handshake. The key is encrypted and NAT in between will not affect
the authentication.

Password The Password option is available if Type is FortiADC SLB and Auth Type is
TCP MD5SIG.
Enter the password to authenticate the key.
The password you enter here must match the password configured on the
FortiADC appliance in a global sever load-balancing configuration.

User Defined Certificate The User Defined Certificate option is available if Type is FortiADC SLB.
Enable to use a self-defined certificate for authentication.

Certificate The Certificate option is available if Type is FortiADC SLB and User
Defined Certificate is enabled.
Select the local certificate object to use for the GSLB server.

Address Type The Address Type option is available if Type is FortiADC SLB.
IPv4 or IPv6.

IP Address/IPv6 Address The IP Address or IPv6 Address option is available if Type is FortiADC
SLB.
Specify the IPv4 or IPv6 address for the FortiADCmanagement interface. This
IP address is used for synchronization and also status checks. If the
management interface is unreachable, the virtual servers for that FortiADC are
excluded from DNS responses.

Port The Port option is available if Type is FortiADC SLB.
Specify the port. Default: 5858 Range: 1-65535.

SDN Connector The SDN Connector option is available if Type is SDN Connector.
Select the SDN Connector to synchronize to the GSLB server.
For public SDN type servers, GSLB can update the public IP dynamically.
Note: Currently, only AWS connectors are supported.

Use SDN Private IP The Use SDN Private IP option is available if Type is SDN Connector.

FortiADC Handbook 532
Fortinet Technologies Inc.



Global Load Balance

Setting Description

Enable to use the SDN Private IP address.

Data Center Select a data center configuration object. The data center configuration object
properties are used to establish the proximity of the servers and the client
requests.

Auto-sync Enable/disable automatic synchronization with the remote server. When
enabled, Global load balancing will synchronize automatically with the server
member.
If auto-sync is enabled for SDN Connector type servers, all instances from the
SDN connector will be added as server members.
Note: When disabling auto-sync, the server member will be cleared and re-
synced.

Health Check Control The Health Check Control option is available if Type isGeneric Host or
SDN Connector.
Enable/disable health checks for the virtual server list. The health check
settings at this configuration level are the parent configuration. When you
configure the list, you can specify whether to inherit or override the parent
configuration.
Note: Health checking is built-in, and you can optionally configure a gateway
health check.

Health Check Relationship The Health Check Relationship option is available if Type isGeneric Host
and Health Check Control is enabled.
l AND—All of the specified health checks must pass for the server to be
considered available.

l OR—One of the specified health checks must pass for the server to be
considered available.

Health Check List The Health Check List option is available if Type isGeneric Host and
Health Check Control is enabled.
Select one or more health check configuration objects.

5. Click Save.
After the GLB Server configuration is saved, the Member section becomes available to configure.

6. Under the Member section, configure the Member list configuration according to the GLB server type.

Setting Description

FortiADC SLB

Discover Populate the member list with virtual servers from the local FortiADC
configuration. After the list had been populated, you can edit the configuration
to add a gateway health check.

Override Select this option if you want to update the discovered virtual server
configuration with the latest configuration information whenever you use the
Discover utility (for example, additions or changes to previously discovered
configurations).
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Setting Description

Unselect this option if you want to preserve the previously discovered
configuration and not have it overwritten by the Discover operation.

Name Must match the virtual server configuration name on the local FortiADC.

Address Type IPv4 or IPv6.

IP Address/IPv6 Address Virtual server IPv4 or IPv6 address.

Gateway Enable an additional health check: is the gateway beyond the FortiADC
reachable?
The list of gateway configuration objects is populated by discovery, but you
must select the appropriate one from the list.

Generic Host

Health Check Inherit Enable to inherit the health check settings from the parent configuration. The
Health Check Inherit option is enabled by default. Disable to specify health
check settings in this member configuration.

Health Check Control The Health Check Control option is available if Health Check Inherit is
disabled.
Enable health checking for the virtual server.

Health Check Relationship The Health Check Relationship option is available if Health Check Inherit is
disabled and Health Check Control is enabled.
l AND—All of the specified health checks must pass for the server to be
considered available.

l OR—One of the specified health checks must pass for the server to be
considered available.

Health Check List The Health Check List option is available if Health Check Inherit is
disabled and Health Check Control is enabled
Specify one or more health check configuration objects.

SDN Connector

SDN Instance Select an instance from the SDN's instance list.

Health Check Inherit Enable to inherit the health check settings from the parent configuration. The
Health Check Inherit option is enabled by default. Disable to specify health
check settings in this member configuration.

Health Check Control The Health Check Control option is available if Health Check Inherit is
disabled.
Enable health checking for the virtual server.

Health Check Relationship The Health Check Relationship option is available if Health Check Inherit is
disabled and Health Check Control is enabled.
l AND—All of the specified health checks must pass for the server to be
considered available.

l OR—One of the specified health checks must pass for the server to be
considered available.
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Setting Description

Health Check List The Health Check List option is available if Health Check Inherit is
disabled and Health Check Control is enabled
Specify one or more health check configuration objects.

Note:
l If Health Check is disabled for SDN connector server members, their health check status will always appear
as available since the status cannot be verified through health check.

l If the SDN instance is changed in the SDN connector, the SDN connector server member status will not be
affected. For example, if the EC2 instance is terminated in AWS, that instance will still remain a server
member in the SDN connector GLB server.

7. Save the Member list configuration and then save the GLB Server configuration to commit the Member list changes.

Configuring a global load balance link

To configure a global load balance link:

1. Go toGlobal Load Balance > Global Object.
2. Click the Link tab.
3. Click Create New to display the configuration editor.
4. Complete the configuration as described in Global load balance link configuration on page 535.
5. Save the configuration.

Settings Guidelines

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces. You reference
this name in the global load balance servers configuration.
Note: After you initially save the configuration, you cannot edit the name.

Data Center Select a data center from the list.
Note: You must the data center(s) configured ahead of time.

ISP Select an ISP from the list.

Gateway

Server Select a server.

Gateway Name Specify the name of a gateway.

or Select Here Click the down arrow to select a gateway from the drop-down list.
Note: Use this option only when you already have a list of gateways configured on the server.

Global load balance link configuration

Configuring data centers

The data center configuration sets key properties: Location and/or ISP and ISP province. These properties are used in
the global load balancing algorithm that selects the FortiADC in closest proximity to the client.
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Before you begin:

l If you want to select a user-defined ISP address book, you must create it before creating the data center
configuration.

l You must have Read-Write permission for Global Load Balance settings.

After you have created a data center configuration object, you can specify it in the global load balance servers
configuration.

To configure a data center:

1. Go to Global Load Balance > Global Object.
2. Click the Data Center tab.
3. Click Create New to display the configuration editor.
4. Complete the configuration as described in Data center configuration on page 536.
5. Save the configuration.

Settings Guidelines

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces. You reference
this name in the global load balance servers configuration.
Note: After you initially save the configuration, you cannot edit the name.

Location Select a location from the drop-down list menu. See the note below.

Description Optional description to help administrators know the purpose or usage of the configuration.

Data center configuration

Note: Stating from FortiADC 5.x.x, the GUI shows the full country or region names listed in alphabetical order for location
list and data center configuration. The Console uses country or region name abbreviations instead. The abbreviations
are done in accordance with the ISO standards. So if you configure a location list or data center from the Console, be
sure to consult ISO-3166-1 and/or ISO 3166-2:CN for the correct abbreviations to use. See the following example
commands:

config global-load-balance topology
edit "tp1"

set member ZZ US CN65
next

end

Where ZZ stands for Reserved, US for United States, and CN65 for China, Xingjiang
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Web Application Firewall

TheWeb Application Firewallmenu contain features and configurations that allow you to use web application firewall
policies to scan HTTP requests and responses against known attack signatures and methods and filter matching traffic.

This section is organized into the following sub-menu topics:

l WAF Profile on page 544
l KnownWeb Attacks on page 555
l Common Attacks Detection on page 563
l Sensitive Data Protection on page 572
l Input Validation on page 593
l Access Protection on page 598
l CORS Protection on page 602
l API Protection on page 608
l Bot Mitigation on page 625
l Web Vulnerability Scanner on page 636

Web application firewall basics

A web application firewall (WAF) is a security policy enforcement point positioned between a client endpoint and a web
application. The primary purpose is to prevent attacks against the web servers. A WAF is deployed separately from the
web application so that the process overhead required to perform security scanning can be offloaded from the web
server, and policies can be administered from one platform to many servers.

A WAF uses methods that complement perimeter security systems, such as the FortiGate next-generation firewall. The
FortiADCWAFmodule applies a set of policies to HTTP scanpoints, which are parsed contexts of an HTTP transaction.

 HTTP scanpoints on page 538 illustrates the scanpoints. In the WAF policy configurations, you have options to enable
rules to detect attacks at the request line, query string, filename, URI, request headers, request body, response code, or
response body.

l Web Attack Signature policy —The signature database includes signatures that can detect known attacks and
exploits that can be found in 29 scanpoints. In your policy configuration, you choose classes of scanpoints to
process: HTTP Headers, HTTP Request Body, and HTTP Response Body.

l URL Protection policy — This policy enables you to create rules that detect patterns in the URI or the file extension.
l HTTP Protocol Constraint policy — This policy enables you to create rules that restrict URI, header, and body
length; HTTP method, or HTTP response code.

l SQL/XSS Injection Detection policy —This policy includes rules to detect SQL/XSS injection in the HTTP Request
URI, HTTP Referer Header, HTTP Cookie Header, or HTTP Request Body.

l Cookie Security policy — This policy enables you to create rules that prevent cookie-based attacks and apply them
in a protection profile.

l Data Leak Prevention policy — This policy enables you to create rules that prevent information leaks, damages and
loss.

l HTTP Header Security policy — This policy enables you to create rules to prevent or mitigate known XSS,
clickjacking, and MIME sniffing security vulnerabilities. These response headers define security policies to client
browsers so that the browsers avoid exposure to known vulnerabilities when handling requests.
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l Input Validation Policy — This policy enables you to create rules to prevent suspicious HTTP requests by verifying
the user input from scan points like URL parameter, HTML form, hidden fields, and upload file.

l Brute Force Attack Detection policy — This policy enables you to create rules to prevent too many login tests.
l Credential Stuffing Defense policy — This policy enables you to create rules to identify login attempts using
username and password that have been compromised using an always up-to-date feed of stolen credentials.

l JSON Detection policy — This policy enables you to create rules that enforce security checks that examine client
HTTP requests for anomalies in JSON data in HTTP POST operations.

l XML Detection policy — This policy enables you to create rules that examine client requests for anomalies in XML
code.

l OpenAPI Detection policy — This policy enables you to create rules through defining a standard, language-agnostic
interface to RESTful APIs, which allows both humans and computers to discover and understand the capabilities of
the service without access to source code, documentation, or through network traffic inspection.

l API Gateway policy — This policy includes an API management tool that sits between a client and a collection of
backend services. It acts as a reverse proxy to accept all API calls and return the appropriate result.

l Bot Detection— This policy includes rules to detect Bots. A Bot is an application that runs automated tasks over the
Internet. The WAF supports two methods for detecting bad Bots: signature detection and behavior detection. You
can also use allowlists to exclude known trusted sources (good Bots) from detection.

l Threshold Based Detection— This policy enables you to create rules to detect bad bots, such as web crawlers,
content scraping, and attack bots.

l Biometrics Based Detection— This policy enables you to create rules that detect bots using behavioral biometrics
such as mouse movement, keyboard, screen touch, and scroll.

l Advanced Protection policy — This policy enables you to create rules that detect web crawlers and content
scraping.

l CSRF Protection policy — This policy enables you to create rules that protect backend servers from CSRF attacks.

Policy rules are enforced (action taken) when scanning is completed at four checkpoints:

l HTTP Request Header
l HTTP Request Body
l HTTP Response Header
l HTTP Response Body

If the HTTP Request Header violates a rule, and the action is Deny, the attempted session is dropped and scanning for
the transaction stops. If the action is Alert, the event is logged and rules processing continues.

 HTTP scanpoints
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Number Attack Solution

1 SQL Injection FortiADC Supports it in two ways to prevent the SQL injection attack:
l Signatures
l SQL/XSS Injection Detection (Under WAF > Common Attacks Detection)

Enable FortiADC's exclusive SQL/XSS Injection Detection function for XSS
attacks prevention .

2 Cross Site Scripting FortiADC Supports it in two ways to prevent the XSS injection attack.
l Signatures
l SQL/XSS Injection Detection (Under WAF > Common Attacks Detection)

Enable FortiADC's exclusive SQL/XSS Injection Detection function for XSS
attacks prevention .

3 Parameter/HTTP
Tampering

FortiADC Supports it with "request-body-detection" signature profile.
l If the signature profile was created by being cloned from "High-Level-
Security" profile, the "request-body-detection" is enabled already.

l If the signature profile was created by "Create New", the "request-body-
detection" is disabled.

You can enable it through CLI, for example:
config security waf web-attack-signature

edit "Poc_Test"
set request-body-detection enable

next
end

4 Sensitive information It can be protected by configuring the Sensitive Data Type in Data Leak
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Number Attack Solution

Prevention (DLP) policy.

5 Cross Site Request
Forging (CSRF)

It can be prevented by configuring “.*” in Parameter Value.

6 Session Hijacking It can be prevented by enabling Cookie Security and configuring Authentication
policy.

7 Blind SQL Injection FortiADC supports it in two ways to prevent the SQL injection attack.
l Signatures
l SQL/XSS Injection Detection (Under WAF > Common Attacks Detection)

It's recommended to enable the Exclusive SQL/XSS Injection Detection
function for SQL attack prevention.

8 Request Smuggling FortiADC strictly follows RFC 7230, section 3.3.3. If both Content-Length and
Transfer-Encoding HTTP Header exist in the request, Content-Length will be
removed. This ensures that the HTTP Request Smuggling attack can be
blocked by FortiADC without any additional settings.

9 Web Scraping FortiADC provides three ways to prevent the Web Scraping attacks.
l WAF Signatures
l Content Detection (Under WAF > Threshold Based Detection)
l Content Scraping (Under WAF > Common Attacks Detection > Advance
Protection)

Web application firewall configuration overview

 WAF configuration overview on page 540 shows the relationship betweenWAF configuration elements. A WAF profile
comprises a Web Attack Signature policy, URL Protection policy, HTTP Protocol Constraint policy, SQL/XSS Injection
Detection, Bot Detection policy, and more. The profile is applied to a load balancing virtual server, so all traffic routed to
the virtual server is subject to the WAF rules. WAF profiles can be applied to HTTP and HTTPS virtual servers but not
HTTP Turbo virtual servers.

 WAF configuration overview
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Predefined configuration elements

The FortiADCWAF includes many predefined configuration elements to help you get started: WAF profiles, Web Attack
Signature policies, HTTP Protocol Constraint policies, SQL/XSS Injection Detection policies, JSON Detection and XML
Detection.

Severity

The severity ratings for predefined Web Attack Signatures and the default severity rating for feature options like
SQL/XSS Injection Detection are based on the OpenWeb Application Security Project (OWASP) Risk Rating
Methodology. In order to harmonize the significance of severity levels in logs, we recommend you use this methodology
to assign severity for any custom elements you create.

Action

You can create an action which FortiADC takes when the conditions are fulfilled for WAF.

Basic Steps

1. Create configuration objects that define the action.
2. Select this action to a WAF rule configuration.

Exceptions

You can create exceptions so that traffic to specific hosts or URL patterns is not subject to processing by WAF rules.
Exception lists are processed before traffic is inspected. If an exception applies, the traffic bypasses the WAF module.

Basic Steps
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1. Create configuration objects that define the exception.
2. Add the exception to a WAF profile configuration or WAF rule configuration.

OWASP TOP10

From theWeb Application Firewall > OWASP TOP10 sub-menu, you can configure a WAF profile based on OWASP
Top 10 attacks. In the configuration wizard, you can select one or more OWASP Top 10 attacks, then FortiADC will
aggregate all the WAF policies that can protect against the selected attacks. After you complete the OWASP TOP10
wizard, it will be listed in the WAF Profile table.

From FortiADC 7.1.0, the OWASP Top 10 list has been updated to the latest 2021
version. The OWASP Top 10Wizard is automatically updated to the 2021 list, and
the OWASP Top 10 2021 log data will be displayed through FortiView.
Log data from OWASP Top 10 2017 can still be accessed through the Security log.

To create a OWASP TOP10 profile:

1. Go toWeb Application Firewall > OWASP TOP10 Wizard
To access this part of the web UI, you must have Read-Write permission for Security settings.
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2. Select the top10 attacks that you want to prevent. Click Next.

3. Select the Security Level, so that this OWASP Top10 profile will protect against the attacks with the corresponding
security level.
a. High: Only the attacks with high security level will be screened out.
b. Medium: Attacks with medium and high security levels will both be screened out.
c. Low: Attacks with low, medium, and high security levels will all be screened out.

FortiADC Handbook 543
Fortinet Technologies Inc.



Web Application Firewall

4. Enter a name and brief description for the profile. Select an exception configuration object. Exceptions identify
specific hosts or URL patterns that are not subject to processing by this rule.

5. Save the configuration.

You can view this profile inWeb Application Firewall > WAF Profile.

WAF Profile

TheWeb Application Firewall > WAF Profile sub-menu allows you to perform the following tasks relating to the WAF
profile for the Web Application Firewall:

l Configuring a WAF Profile on page 544
l Configuring WAF Action objects on page 546
l Configuring WAF Exception objects on page 548

Configuring a WAF Profile

AWAF profile references the WAF policies that are to be enforced.

Predefined WAF profiles on page 544 describes the predefined profiles. In many cases, you can use predefined profiles
to get started.

Predefined Pro-
files

Description

High-Level-Security l Web Attack Signature policy: High-Level-Security
l HTTP Protocol Constraints policy: High-Level-Security
l SQL/XSS Injection Detection policy: High-Level-Security

Medium-Level-
Security

l Web Attack Signature policy: Medium-Level-Security
l HTTP Protocol Constraints policy: Medium-Level-Security
l SQL/XSS Injection Detection policy: Medium-Level-Security

Alert-Only l Web Attack Signature policy: Alert-Only

Predefined WAF profiles
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Predefined Pro-
files

Description

l HTTP Protocol Constraints policy: Alert-Only
l SQL/XSS Injection Detection policy: Alert-Only

If desired, you can create user-defined profiles. The maximum number of profiles per VDOM is 255.

Before you begin:

l You can use predefined WAF profiles, create profiles based on predefined feature options, or create profiles based
on user-defined configuration objects. If you want to add user-defined configuration objects, you must create them
before using this procedure to add them to a WAF profile.

l You must have Read-Write permission for Security settings.

After you have created a WAF profile, you can specify it in a virtual server configuration.

To configure a WAF Profile:

1. Go toWeb Application Firewall > WAF Profile.
2. Click theWAF Profile tab.
3. Click Create New to display the configuration editor.
4. Complete the configuration as described in WAF Profile configuration on page 545.
5. Save the configuration.

Settings Guidelines

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces.
After you initially save the configuration, you cannot edit the name.

Exception Name Select a user-defined exception configuration object. Exceptions identify specific
hosts or URL patterns that are not subject to processing by this rule.

Description A string to describe the purpose of the configuration, to help you and other
administrators more easily identify its use.

Rule Match Record Enable to allow the Security Log to display the part of the rule that is matched
when the security event is logged. This is disabled by default.

Standard Protection

Web Attack Signature Select a predefined or user-defined Web Attack Signature configuration object.

HTTP Protocol Constraint Select a predefined or user-defined HTTP Protocol Constraint configuration
object.

Sensitive Data Protection

Cookie Security Select a user-defined Cookie Security configuration object.

Data Leak Prevention Select a user-defined Data Leak Prevention configuration object.

HTTP Header Security Select a user-defined HTTP Header Security configuration object.

WAF Profile configuration
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Settings Guidelines

Input Protection

SQL/XSS Injection Detection Select a predefined or user-defined SQL/XSS Injection Detection configuration
object.

Input Validation Policy Select a user-defined Input Validation Policy configuration object.

CORS Protection Select a user-defined CORS Protection configuration object.

Access Protection

Brute Force Attack Detection Select a user-defined Brute Force Attack Detection configuration object.

URL Protection Select a user-defined URL Protection configuration object.

Credential Stuffing Defense Select a user-defined Credential Stuffing Defense configuration object.

API Protection

JSON Detection Select a predefined or user-defined JSON Detection configuration object.

XML Detection Select a predefined or user-defined XML Detection configuration object.

OpenAPI Detection Select a user-defined OpenAPI Detection configuration object.

API Gateway Select a user-defined API Gateway configuration object.

Bot Mitigation

Bot Detection Select a user-defined Bot Detection configuration object.

Threshold Based Detection Select a predefined or user-defined Threshold Based Detection configuration
object.

Biometrics Based Detection Select a user-defined Biometrics Based Detection configuration object.

Fingerprint Based Detection Select a user-defined Fingerprint Based Detection configuration object.

Advanced Bot Protection Select a user-defined Advanced Bot Protection configuration object.

Advanced Protection

Advanced Protection Select a user-defined Advanced Protection configuration object.

CSRF Protection Select a user-defined CSRF Protection configuration object.

Configuring WAF Action objects

Configure what action FortiADC should take when it meets the WAF conditions.

After you have created an action object, you can specify it in individual WAF feature rules.

Before you begin:

l You must have Read-Write permission for Security settings.

In many cases, you can use predefined profiles to get started.
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Predefined actions Description

alert WAF policies will allow the traffic to pass and log the event.

block WAF policies will drop the current attack session by HTTP 403 message and
block the attacker (according the attacker’s IP address) for 1 hour, and log the
event.

captcha WAF policies will allow the traffic to pass if the client successfully fulfills the
CAPTCHA request, and log the event.

deny WAF policies will the drop current attack session by HTTP 403 message, and log
the event.

silent-deny WAF policies will drop the current attack session by HTTP 403 message, without
logging the event.

To configure a WAF Action object:

1. Go toWeb Application Firewall > WAF Profile.

2. Click the Action tab.

3. Click Create New to display the configuration editor.

4. Complete the configuration of WAF Action objects.

5. Save the configuration.

Settings Guidelines

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces.
After you initially save the configuration, you cannot edit the name.

Action Type Select which action FortiADC takes when the conditions are fulfilled for WAF:
l Pass— Allow the request.
l Deny— Block the request.
l Period Block— Deny all the HTTP requests from a source IP within a period
which specified by Period Block.

l Redirect — Send a redirect. You must specify the redirect URL.
l Captcha—Requires the client to successfully fulfill the CAPTCHA request.

Deny Code The Deny Code option is available if the Action Type is Deny or Period Block.
Select the HTTP response code, Default: 403.
200, 202, 204, 205, 400, 403, 404, 405, 406, 408, 410, 500, 501, 502, 503, 504

Period Block The Period Block option is available if the Action Type is Period Block.
Specify a time period when action blocks the client. Default: 60 seconds, Range:
1- 3600 seconds.

Redirect URL The Redirect URL option is available if the Action Type is Redirect.
Specify the URL that you want to redirect.

Log Status Enable/Disable log of events
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Settings Guidelines

Comment Enter comment or description of the action for your records.

Configuring WAF Exception objects

WAF exceptions identify specific patterns that are not subject to processing by WAF rules. UseWAF exception rules to
reduce false-positives triggered by legitimate HTTP requests that match an attack signature rule. FortiADC supports
URL, hosts and source IP patterns matching in the WAF exception rules.

You can create and configure WAF Exception objects using either of the following methods:

l From theWeb Application Firewall > WAF Profile > Exceptions tab, you can create/configure exception objects
to then apply to specific WAF profiles and individual WAF feature rules. For detailed steps, see Configuring WAF
exception rules from the WAF Profile > Exceptions tab on page 548.

l From theWAF security log (Log & Report > Security Log or FortiView > Security Logs), you can
create/configure exception objects to directly apply to the specific WAF log. For detailed steps, see Configuring
WAF exception rules from the WAF log on page 550.

Before you begin:

l You must have Read-Write permission for System settings.

For optimal functionality, we recommend keeping the number of WAF exception
rules configured to a minimum. If a large number of WAF exception rules are
configured, none may work effectively due to limitations of the shared memory
(maximum total is 256.0 MBs in the VM platform).

Configuring WAF exception rules from the WAF Profile > Exceptions tab

You can create or configure exception objects to then apply to specific WAF profiles and individual WAF feature rules.

To configure a WAF exception rule from the WAF Profile > Exceptions tab:

1. Go toWeb Application Firewall > WAF Profile.
2. Click the Exceptions tab.
3. Click Create New to display the configuration editor.
4. Configure the following:

Parameter Description

Name Enter a unique name for the WAF Exception. Maximum length is 130
characters.
Note: Once saved, the name of an Exception cannot be changed.

5. Click Save.
6. Under Exception Rule, click Create New to display the configuration editor.
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7. Select the exception pattern Element Type from the drop-down menu.
l URL
l Source IP
l Source IPv6
l HTTPMethod
l HTTP Header
l Cookie
l Parameter

8. Configure the following parameters based on the exception pattern Element Type.

Parameter Description

URL

Exception Host Status Enable/disable the setting exceptions by host pattern.

Host Pattern The Host Pattern option appears if Exception Host Status is enabled.
Specify the matching string. Regular expressions are supported. Maximum
length is 128 characters.
For example, you can specify www.example.com, *.example.com, or
www.example.* to match a literal host pattern or a wildcard host pattern.

URL Pattern Specify the matching string. Must begin with a URL path separator (/). Regular
expressions are supported. Maximum length is 128 characters.
For example, you can specify path names and files with expressions like
\/admin, .*\/data\/1.html, or \/data.*.

Source IP

IPv4/Netmask Specify the IPv4 address and netmask. For example: 192.0.2.5/24

Source IPv6

IPv6/Netmask Specify the IPv6 address and netmask. For example:
2001:0db8:85a3::8a2e:0370:7334/64

HTTP Method

HTTPMethod Select the HTTP method(s):
l GET
l POST
l HEAD
l TRACE
l CONNECT
l DELETE
l PUT
l PATCH
l OPTIONS
l OTHERS

HTTP Header
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Parameter Description

Name Pattern Specify the matching string. Regular expressions are supported. Maximum
length is 1024 characters.
For example: . Content*

Check Value of Specified
Element

Enable/disable value checking for the specified element.

Value Pattern The Value Pattern option appears if Check Value of Specified Element is
enabled.
Specify the matching string. Regular expressions are supported. Maximum
length is 1024 characters.
For example: . Content*

Cookie

Name Pattern Specify the matching string. Regular expressions are supported. Maximum
length is 1024 characters.
For example: . Content*

Check Value of Specified
Element

Enable/disable value checking for the specified element.

Value Pattern The Value Pattern option appears if Check Value of Specified Element is
enabled.
Specify the matching string. Regular expressions are supported. Maximum
length is 1024 characters.
For example: . Content*

Parameter

Name Pattern Specify the matching string. Regular expressions are supported. Maximum
length is 1024 characters.
For example: . Content*

Check Value of Specified
Element

Enable/disable value checking for the specified element.

Value Pattern The Value Pattern option appears if Check Value of Specified Element is
enabled.
Specify the matching string. Regular expressions are supported. Maximum
length is 1024 characters.
For example: . Content*

9. Click Save.

Configuring WAF exception rules from the WAF log

You can create or configure exception objects to directly apply to the specific WAF log. You have the option to create
exception rules in basic mode or advanced mode. Using basic mode, you can apply the URL or Source IP/ Source IPv6
from the WAF log directly to the exception rule. The advanced mode enables you to create and configure exception rules
for all supported element patterns.
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To configure a WAF exception rule from the WAF log using basic mode:

1. Go to Log & Report > Security Log or FortiView > Security Logs.
2. Navigate to the WAF security log and expand the details for which you want to add an exception rule.
3. In the log details, click Add Exception to display the configuration editor.
4. Configure the following parameters.

Parameter Description

Profile Name Select the WAF Profile to apply the WAF exception rule.

Advanced Mode To configure the WAF exception rule using basic mode, ensure Advanced
Mode is disabled.
By default, Advanced Mode is disabled, which enables basic mode.

Element Type Select either of the following:
l URL— To apply the HTTP URL from this WAF log for this exception rule.
l Source IP— To apply the Source from this WAF log for this exception
rule. The Source IP option appears if the Source address is IPv4.

l Source IPv6— To apply the Source IPv6 from this WAF log for this
exception rule. The Source IPv6 option appears if the Source address is
IPv6.

5. Click Save.

To configure a WAF exception rule from the WAF log using advanced mode:

1. Go to Log & Report > Security Log or FortiView > Security Logs.
2. Navigate to the WAF security log and expand the details for which you want to add an exception rule.
3. In the log details, click Add Exception to display the configuration editor.
4. Configure the following:

Parameter Description

Profile Name Select the WAF Profile to apply the WAF exception rule.
Note: The profile name parameter will display according to the WAF
subcategory of the log. For example, if the WAF subcategory of the log is
"cookie security" then the parameter will display as "Cookie Security Profile
Name".

Advanced Mode Enable Advanced Mode to configure the WAF exception rule using advanced
mode.
Once Advanced Mode is enabled, the Element Type drop-down menu will
include all supported exception pattern.

5. Select the exception pattern Element Type from the drop-down menu.
l URL
l Source IP
l Source IPv6
l HTTPMethod
l HTTP Header
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l Cookie
l Parameter

6. Configure the following parameters based on the exception pattern Element Type.

Parameter Description

URL

Exception Host Status Enable/disable the setting exceptions by host pattern.

Host Pattern The Host Pattern option appears if Exception Host Status is enabled.
Specify the matching string. Regular expressions are supported. Maximum
length is 128 characters.
For example, you can specify www.example.com, *.example.com, or
www.example.* to match a literal host pattern or a wildcard host pattern.

URL Pattern Specify the matching string. Must begin with a URL path separator (/). Regular
expressions are supported. Maximum length is 128 characters.
For example, you can specify path names and files with expressions like
\/admin, .*\/data\/1.html, or \/data.*.

Source IP

IPv4/Netmask Specify the IPv4 address and netmask. For example: 192.0.2.5/24

Source IPv6

IPv6/Netmask Specify the IPv6 address and netmask. For example:
2001:0db8:85a3::8a2e:0370:7334/64

HTTP Method

HTTPMethod Select the HTTP method(s):
l GET
l POST
l HEAD
l TRACE
l CONNECT
l DELETE
l PUT
l PATCH
l OPTIONS
l OTHERS

HTTP Header

Name Pattern Specify the matching string. Regular expressions are supported. Maximum
length is 1024 characters.
For example: . Content*

Check Value of Specified
Element

Enable/disable value checking for the specified element.
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Parameter Description

Value Pattern The Value Pattern option appears if Check Value of Specified Element is
enabled.
Specify the matching string. Regular expressions are supported. Maximum
length is 1024 characters.
For example: . Content*

Cookie

Name Pattern Specify the matching string. Regular expressions are supported. Maximum
length is 1024 characters.
For example: . Content*

Check Value of Specified
Element

Enable/disable value checking for the specified element.

Value Pattern The Value Pattern option appears if Check Value of Specified Element is
enabled.
Specify the matching string. Regular expressions are supported. Maximum
length is 1024 characters.
For example: . Content*

Parameter

Name Pattern Specify the matching string. Regular expressions are supported. Maximum
length is 1024 characters.
For example: . Content*

Check Value of Specified
Element

Enable/disable value checking for the specified element.

Value Pattern The Value Pattern option appears if Check Value of Specified Element is
enabled.
Specify the matching string. Regular expressions are supported. Maximum
length is 1024 characters.
For example: . Content*

7. Click Save.

Limitations: Escaped Characters

All Name Pattern and Value Pattern fields support regular expression. However, some characters must be escaped to
be a valid regular expression or be functional as an exception rule. If your expression contains characters that require
escaping, an error message may be triggered to reject the invalid expression. However, it is also possible that an error
may not be triggered by unescaped characters if it is considered syntactically correct — in which case these expressions
would not function as exception rules since they will not match any user traffic.

This section lists the most commonly used special characters that need to be escaped to make an input valid or
functional as an exception rule.

Brackets: []

Brackets ([]) require other characters between the brackets to be a valid exception rule regular expression.
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For example:

Invalid: []

Valid: [123]—Valid

[] is an invalid exception rule regular expression because the input only contain brackets with no other characters in
between. Whereas [123] is valid because there are number characters between the brackets.

Parentheses: ()

Parentheses (()) require a backslash (\) before each parenthesis to be a valid exception rule regular expression— ()
→ \(\)

For example:

Invalid: http://x.x.x.x/login?link=mocha:alert('attack%20success')

Valid: http://x.x.x.x/login?link=mocha:alert\('attack success'\)

Focusing on the parameter value, mocha:alert('attack%20success') is invalid because there is no backslash
before each parenthesis. Whereas mocha:alert\('attack success'\) is valid with the backslash inserted before
each parenthesis.

Asterisk: *

Asterisks (*) require a backslash (\) before each asterisk to be a valid and functional exception rule — *→ \*

For example:

curl -vv -X POST --cookie "Cookie123=abcd"

"http://x.x.x.x/index.php?n123=v123&p_name1=p_value1"

Where the cookie name is "cookie" and the cookie value is "a*"

Invalid: a*

Valid: a\*"

In this case, both a* and a\* are both correct in syntax. However, a* would not be functional as an exception rule
because it would not match any user traffic.

Space: %20

Spaces (%20) in URLs must be replaced with spaces to be a valid exception rule regular expression.

For example:

Invalid: http://x.x.x.x/login?link=mocha:alert('attack%20success')

Valid: http://x.x.x.x/login?link=mocha:alert(\'attack success'\)

Focusing on the parameter value, the invalid expression becomes valid when the %20 is replaced with the space:
mocha:alert('attack%20success')→ mocha:alert(\'attack success'\)

Single Quotes: ''

When the Name Pattern or Value Pattern fields contain single quotes, it will be automatically escaped.

For example:
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In the GUI or CLI, you may enter the parameter value pattern as: alert\('attack%20success'\)

In the CLI, the value pattern will appear as: alert\\(\'attack success\'\\)

Known Web Attacks

TheWeb Application Firewall > Known Web Attacks sub-menu allows you to configure Web Attack Signature
policies. The signature database includes signatures that can detect known attacks and exploits that can be found in 29
scanpoints. In your policy configuration, you choose classes of scanpoints to process: HTTP Headers, HTTP Request
Body, and HTTP Response Body.

l Configuring a Web Attack Signature policy on page 555
l Using the Signature Creation Wizard on page 560

Configuring a Web Attack Signature policy

The FortiGuard Web Attack Signature service provides a database of attack signatures that is updated periodically to
protect against new kinds of attacks. Web Attack Signature categories and subcategories on page 558 summarizes the
categories of threats that are detected by the signatures. The categories are reported in logs.

In the Web Attack Signature policy configuration, you can enable/disable the class of scanpoints and the action when
traffic matches signatures.

There are three classes of scanpoints:

l HTTP Header—Scans traffic against HTTP header signatures. If you enable a policy at all, you are enabling HTTP
header scanning.

l HTTP Request Body—Scans traffic against HTTP request body signatures.
l HTTP Response Body—Scans traffic against HTTP response body signatures.

Header scanning is always a good practice, so enabling a policy always enables header scanning. Body scanning
impacts performance, so you have the option of disabling body scanning if system utilization or latency become an issue.

You can specify separate actions for three levels of event severity:

l High—We recommend you deny traffic for high severity events.
l Medium—We recommend you deny or alert, according to your preference. To be strict, deny; otherwise, alert.
l Low—We recommend you allow the traffic and log an alert for low severity events.

Web Attack Signature predefined policies on page 555 describes the predefined policies. You can select the predefined
policies in your WAF profiles, or you can create policies that enable a different set of scan classes or a different action. In
this release, you cannot exclude individual signatures or create custom signatures. You can enable or disable the scan
classes.

Policy Status Action

High-Level-Security Scan HTTP header—Enabled.
Scan HTTP Request Body—Enabled.
Scan HTTP Response Body—Disabled.

High Severity Action—Deny.
Medium Severity Action—Deny.
Low Severity Action—Alert.

Web Attack Signature predefined policies
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Policy Status Action

Medium-Level-
Security

Scan HTTP header—Enabled.
Scan HTTP Request Body—Enabled.
Scan HTTP Response Body—Disabled.

High Severity Action—Deny.
Medium Severity Action—Alert.
Low Severity Action—Alert.

Alert-Only Scan HTTP header—Enabled.
Scan HTTP Request Body—Disabled.
Scan HTTP Response Body—Disabled.

High Severity Action—Alert.
Medium Severity Action—Alert.
Low Severity Action—Alert.

Basic Steps

1. Configure the connection to FortiGuard so that the system can receive periodic WAF Signature Database updates.
See Configuring FortiGuard service settings.

2. Optionally, if you do not want to use the predefined policies, configure Web Attack Signature policies. See below.
3. When configuring the WAF profile, select a policy that you associate with virtual servers . See Configuring a Web

Attack Signature policy.

Before you begin:

l You must have read-write permission for security settings.

To configure a Web Attack Signature policy:

1. Go toWeb Application Firewall > Known Web Attacks.
2. Click theWeb Attack Signature tab.
3. Click Create New to display the configuration editor.
4. Complete the configuration as described in Web Attack Signature configuration on page 556.
5. Save the configuration.

Settings Guidelines

Category This dialog provides tools for configuring a Web attack signature policy.

Name Specify a unique name for the Web attack signature policy and click Save. Valid characters
are A-Z, a-z, 0-9, _, and -. No space is allowed between characters.
Note: Once saved, the policy name cannot be changed.

Category This section lists the (main) categories of Web attack signatures within the system. Do the
following to include the desired categories of Web attack signature in the policy:
1. In the Name column, identify the categories of Web attack signatures of interest.
2. In the Status column, select (check mark) the categories you like to include in the

policy.
3. In the Action column, select the action you want to apply to the categories that you

select.
4. Double-click the name of a category to view its sub-categories. See Sub-category

below.

Web Attack Signature configuration
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Settings Guidelines

Sub-category This section lists the sub-categories of a (main) category of Web attack signature that you
have opened (double-clicked) from above. Do the following to enable any of the sub-
categories of interest:
1. In the Name column, identify the sub-categories of interest.
2. In the Status column, select (check mark) the sub-categories you like to include in the

policy.

Signature This dialog provides tools for searching through and filtering Web attack signatures
available within the system.

Search Use the following options to search for Web attack signatures to display:
l Description—Enter a descriptive text string and click Search.
l ID—Enter a Web attack signature ID and click Search.
l CVE Number—Enter a CVE number related to a Web attack signature and click
Search.

l Clear Search—Click this button to empty all search fields.
Note: Web attack signatures that match your search criterion show up in the Signature
section below the moment you click the corresponding Search button.

Filters Use any or a combination of the following filters to filter the Web attack signatures to be
displayed in the Signature section below:
l Category—Click the down arrow and select a (main) category of Web attack signatures
from the drop-down menu.

l Sub-category—Click the down arrow and select a sub-category of the category of Web
attack signatures that you have selected.

l Status—Click the down arrow and select either (Enable or Disable) from the drop-
down menu.

l Severity—Click the down arrow and select High, Medium, or Low from the drop-down
menu.

l Exception—Click the down arrow and select either (Yes or No) from the drop-down
menu.

l Clear All—Click this button to clear the existing filters. Note: You can also remove a
specific filter by clicking the corresponding x mark.

Signature This section displays all Web attack signatures that match your search and filter criteria,
showing the following information for each Web attack signature:
l ID
l Status
l Name
l Severity
l Target Application
l Exception Name

Signature Detail This section shows detailed information about the Web attack signature that you've
highlighted (clicked) in the Signature section above.

Detail This tab shows the following information about the selected signature:
l Signature ID
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Settings Guidelines

l Category
l Sub-category
l Severity
l Target Application
l Description
l CVE Number (if one exists)
l Reference (if one exists)
l Found In

Edit Signature This tab provides tools for editing a selected Web attack signature. It contains the following
fields:
l Signature ID—(Read only) Shows the ID of the selected signature.
l Status—Click to enable or disable the signature.
l Exception Name—Click the down arrow and select an exception from the drop-down
menu.

Web Attack Signature categories and subcategories on page 558 summarizes the categories of threats that are detected
by the signatures.

Category (ID) Subcategory (ID)

Cross Site Scripting (1) Generic XSS Attack (42)

SQL Injection (2) Generic SQL Injection (43)

Generic Attacks (3) OS Command Injection (1)
Coldfusion Injection (2)
LDAP Injection (3)
Command Injection (4)
Session Fixation (5)
File Injection (6)
PHP Injection (7)
SSI Injection (8)
UPDF XSS (9)
Email Injection (10)
HTTP Response Splitting (11)
RFI Injection (12)
Xpath Injection (49)
XML External Entities (57)
Insecure Deserialization (59)
HTTP Header Injection (60)
Buffer Overflow (62)
Denial Of Service (64)

Web Attack Signature categories and subcategories
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Category (ID) Subcategory (ID)

Trojans (4) Trojans (44)

Information Disclosure (5) Zope Information Leakage (13)
CF Information Leakage (14)
PHP Information Leakage (15)
ISA Server Existence Revealed (16)
Microsoft Office Document Properties Leakage (17)
CF Source Code Leakage (18)
IIS Information Leakage (19)
Weblogic information leakage (20)
Generic Filename and Directory leakage (21)
ASP/JSP Source Code Leakage (22)
PHP Source Code Leakage (23)
SQL Error leakage (24)
HTTP Header Leakage (25)
WordPress Leakage (26)
Generic Malicious Leakage (47)
Path Travel (58)

Known Exploits (6) Oracle 9i (27)
Coppermine Photo Gallery (28)
Netscape Enterprise Server (29)
Cisco IOS HTTP Service (30)
Microsoft SQL Server (31)
HP OpenView Network Node Manager (32)
Best Sofrware SalesLogix (33)
IBM Lotus DominoWeb Server (34)
Microsoft IIS (35)
Microsoft Windows Media Services (36)
Dave Carrigan Auth_LDAP (37)
427BB (38)
RaXnet Cacti Graph (39)
CHETCPASSWD (40)
SAP (41)
Generic Exploit (48)
Lighttpd Server (53)
Caucho Resin Server (54)
JRunWeb Server (55)
IBM Lotus Domino (56)
WordPress (61)
Struts 2 (63)
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Category (ID) Subcategory (ID)

Joomla! (65)

Credit Card Detection (7) Credit Card Detection (45)

Bad Robot (8) Bad Robot (46)

Cross Site Scripting (Extended) (9) Cross Site Scripting (Extended) (50)

SQL Injection (Extended) (10) SQL Injection (Extended) (51)

Generic Attacks (Extended) (11) Generic Attacks (Extended) (52)

Using the Signature Creation Wizard

The Signature Creation Wizard is a step-by-step tool available in the GUI that helps you configure a Web Attack
Signature policy based on the database, web server, or web application you want to protect. Using your selections, the
Signature Creation Wizard automatically compiles a list of the most applicable WAF Signatures for protecting your
database, web server, or web application. You can then apply those WAF Signatures in a Web Attack Signature policy.

Alternatively, you can custom configure a Web Attack Signature policy without using the Signature Creation Wizard. For
more information, see Configuring a Web Attack Signature policy on page 555.

To configure a Web Attack Signature using the Signature Creation Wizard:

1. Go toWeb Application Firewall > Known Web Attacks.
2. Click theWeb Attack Signature tab.
3. Click Signature Wizard to display the configuration editor.
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4. From the Database tab, select the database(s) you want to protect. Click Next to navigate to theWeb Server tab.
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5. From theWeb Server tab, select the web server(s) you want to protect. Click Next to navigate to theWeb
Application tab, or click Back to navigate to the Database tab.
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6. From theWeb Application tab, select the web application(s) you want to protect. Click Next to navigate to the Add
Signature tab, or click Back to navigate to theWeb Server tab.

7. From the Add Signature tab, enter a name for your Web Attack Signature policy and click Save.
The Category and Sub Category sections display the applicable WAF Signatures that you can apply to your policy.

8. Click Apply to save your Web Attack Signature policy.
9. Optionally, you can click Save and Edit Signature Details to apply WAF Exceptions where applicable.

Common Attacks Detection

TheWeb Application Firewall > Common Attacks Detection sub-menu allows you to perform the following tasks
relating to the Common Attacks Detection for the Web Application Firewall:

l Configuring an Advanced Protection policy on page 563
l Configuring an HTTP Protocol Constraint policy on page 565
l Configuring an SQL/XSS Injection Detection policy on page 568
l Configuring a CSRF protection policy on page 570

Configuring an Advanced Protection policy

The Advanced Protection policy includes the following rules:

l Content Scraping—Checks HTTP response header. If the traffic matches the occurrence limit and is over the
specified percentage match, it detects web scraping, then executes the relevant actions for the traffic.
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l HTTP Response Code—Checks HTTP response code. If the traffic matches the occurrence limit and is over the
specified percentage match, it detects web scraping, then executes the relevant actions for the traffic.

To configure an Advanced Protection policy:

1. Go toWeb Application Firewall > Common Attacks Detection.
2. Click the Advanced Protection tab.
3. Click Create New to display the configuration editor.
4. Complete the configuration as described in Advanced Protection configuration on page 564.

If you want to drop a large number of packets when traffic match the rules, you should set
action to “block” instead of “deny."

5. Save the configuration.

Settings Guidelines

Name Enter a unique Advanced Protection policy name. Valid characters are A-Z, a-z, 0-9, _, and -.
No space is allowed.
Note: Once saved, the name of an Advanced Protection policy cannot be changed.

Content Scraping

Content Type Specify a Content Type for the Content Scraping rule: 
l text/html
l text/plain
l text/xml
l application/xml
l application/soap+xml
l application/json

Occurrence Limit Sets the condition for the limit of the number of responses received from the specified type. If
the number of responses received within the time frame (set in OccurrenceWithin) from the
specified type is above this limit, this condition is fulfilled.

OccurrenceWithin Sets the time span during which to count how many times a response is received from the
specified type.

Percentage Match Sets the condition for what percentage of the traffic received is from the specified type, during
the given time frame. If the specified type, compared to all traffic, is received above this
Percentage Match, this condition is fulfilled.
Default is 0, indicating that this condition is disabled by default.

Action Select which action profile that you want to apply. See Configuring WAF Action objects on
page 546.
The default value is Alert.

Advanced Protection configuration
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Settings Guidelines

Severity When FortiADC records violations of this rule in the attack log, each log message contains a
Severity Level (severity_level) field. Select which severity level FortiADC uses when using
Advanced Protection:
l Low
l Medium
l High

The default value is Low.

HTTP Response Code

Response Code Specify a Response Code for the HTTP Response Code rule.

Occurrence Limit Sets the condition for the limit of the number of responses received from the specified type. If
the number of responses received within the time frame (set in OccurrenceWithin) from the
specified type is above this limit, this condition is fulfilled.

OccurrenceWithin Sets the time span during which to count how many times a response is received from the
specified type.

Percentage Match Sets the condition for what percentage of the traffic received is from the specified type, during
the given time frame. If the specified type, compared to all traffic, is received above this
Percentage Match, this condition is fulfilled.
Default is 0, indicating that this condition is disabled by default.

Action Select which action profile that you want to apply. See Configuring WAF Action objects on
page 546.
The default value is Alert.

Severity l High—Log as high severity events.
l Medium—Log as a medium severity events.
l Low—Log as low severity events.

The default is low.

Configuring an HTTP Protocol Constraint policy

The HTTP Protocol Constraint policy includes the following rules:

l HTTP request parameters—Limit the length of URIs, headers, and body to prevent several types of attacks, such as
buffer overflow and denial of service.

l HTTP request methods—Restrict HTTP methods allowed in HTTP requests. For example, do not allow the PUT
method in HTTP requests to prevent attackers from uploading malicious files.

l HTTP response codes—Drop response traffic containing HTTP response codes that might contain information
attackers can use to craft attacks. For example, some HTTP response codes include fingerprint data like web server
version, database version, OS, and so on.

Predefined HTTP protocol constraint policies on page 566 describes the predefined policies.
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Predefined Rules Description

High-Level-Security Protocol constraints enabled with default values. Action is set to deny. Severity is set to high.

Medium-Level-
Security

Protocol constraints enabled with default values. Action is set to alert. Severity is set to
medium.

Alert-Only Protocol constraints enabled with default values. Action is set to alert. Severity is set to low.

Predefined HTTP protocol constraint policies

If desired, you can create user-defined rules to filter traffic with invalid HTTP request methods or drop packets with the
specified server response codes.

Before you begin:

l You should have a sense of legitimate URI lengths and HTTP request methods for the destination resources.
l You should know whether your servers include application fingerprint information in HTTP response codes.
l You must have Read-Write permission for Security settings.

To configure an HTTP Protocol Constraint policy:

1. Go toWeb Application Firewall > Common Attacks Detection.
2. Click the HTTP Protocol Constraint tab.
3. Click Create New to display the configuration editor.
4. Complete the configuration as described in HTTP Protocol Constraint configuration on page 566.
5. Save the configuration.

Settings Guidelines

Name Enter a unique HTTP protocol constraint policy name. Valid characters are A-Z, a-z, 0-9, _,
and -. No space is allowed.
Note: Once saved, the name of an HTTP protocol constraint policy cannot be changed.

Request Parameters

Maximum
URI Length

Maximum characters in an HTTP request URI. The default is 2048. The valid range is 1-8192.

Illegal Host Name Enable/disable hostname checks. A domain name must consist of only the ASCII alphabetic
and numeric characters, plus the hyphen. The hostname is checked against the set of
characters allowed by the RFC 2616. Disallowed characters, such as non-printable ASCII
characters or other special characters (for example, '<', '>', and the like), are a symptom of an
attack.

Illegal HTTP Version Enable/disable the HTTP version check. Well-formed requests include the version of the
protocol used by the client, in the form of HTTP/v where v is replaced by the actual version
number (one of 0.9, 1.0, 1.1). Malformed requests are a sign of traffic that was not sent from a
normal browser and are a symptom of an attack.

Illegal HTTP
Multipart

Enable/Disable the HTTP body multipart check. If the content-type is multipart media type, the

HTTP Protocol Constraint configuration
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Settings Guidelines

HTTP body must contain one or more body parts, each preceded by a boundary delimiter line
and the last one followed by a closing boundary delimiter line. After its boundary delimiter line,
each body part then consists of a header area, a blank line, and a body area. Malformed
HTTP requests are a sign of traffic that was not sent from a normal browser and are a
symptom of an attack.

Maximum Cookie
Number In Request

Maximum number of cookie headers in an HTTP request. The default is 16. The valid range is
1-32.

Maximum Header
Number In Request

Maximum number of headers in an HTTP request. The default is 50. Requests with more
headers are a symptom of a buffer overflow attack or an attempt to evade detection
mechanisms. The valid configuration range is 1-100.

Maximum Request
Header Name
Length

Maximum characters in an HTTP request header name. The default is 1024. The valid range
is 1-8192.

Maximum Request
Header Value Length

Maximum characters in an HTTP request header value. The default is 4096. Longer headers
might be a symptom of a buffer overflow attack. The valid configuration range is 1-8192.

Maximum URL
Parameter Name
Length

Maximum characters in a URL parameter name. The default is 1024. The valid range is 1-
2048.

Maximum URL
Parameter Value
Length

Maximum characters in a URL parameter value. The default is 4096. The valid range is 1-
8192.

Maximum Request
Header Length

Maximum length of the HTTP request header. The default is 8192. The valid range is 1-
16384.

Maximum Request
Body Length

Maximum length of the HTTP body. The default is 67108864. The valid range is 1-67108864.

Constraint Method
Override

Enable/Disable to scan request method and try to match it in request method rule in following
override headers:
l X-HTTP-Method
l X-Method-Override
l X-HTTP-Method-Override

Request Method Rule

Method Select one or more methods to match in the HTTP request line:
l CONNECT
l DELETE
l GET
l HEAD
l OPTIONS
l POST
l PUT
l TRACE
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Settings Guidelines

l Others
Note: The first 8 methods are described in RFC 2616. The group Others contains not
commonly used HTTP methods defined by Web Distributed Authoring and Version
(WebDAV) extensions.

Action Select the action profile that you want to apply. See Configuring WAF Action objects on page
546.
The default is alert.

Severity l High—Log as high severity events.
l Medium—Log as a medium severity events.
l Low—Log as low severity events.

The default is low.

Exception Select an exception configuration object. Exceptions identify specific hosts or URL patterns
that are not subject to processing by this rule.

Response Code Rule

Minimum Status
Code / Maximum
Status Code

Start/end of a range of status codes to match. You can specify codes 400 to 599.

Action l Alert—Allow the traffic and log the event.
l Deny—Drop the traffic, send a 403 Forbidden to the client, and log the event.

The default is alert.

Severity l High—Log as high severity events.
l Medium—Log as a medium severity events.
l Low—Log as low severity events.

The default is low.

Exception Select an exception configuration object. Exceptions identify specific hosts or URL patterns
that are not subject to processing by this rule.

Configuring an SQL/XSS Injection Detection policy

SQL/XSS Injection Detection policies detect SQL injection and cross-site scripting (XSS) attacks. Injection occurs when
user-supplied data is sent to an interpreter as part of a command or query. In an SQL injection attack, attackers craft
HTTP requests that cause SQL queries to be executed directly against the web application’s database. XSS injection
attacks cause a web browser to execute a client-side script.

In contrast to signature-based detection, the WAF SQL and XSS injection detector module detects SQL and XSS
injection through lexical analysis, which is a complementary method and is faster.

The policy enables/disables scanpoints, the action when traffic matches signatures, and the event severity.

You can enable detection in the following scanpoints:

l SQL Injection: URI—Analyzes content in the URI.
l SQL Injection: Referer—Analyzes content in the HTTP Referer header.
l SQL Injection: Cookie—Analyzes content in the HTTP Cookie header.
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l SQL Injection: Body—Analyzes content in the HTTP request body.
l XSS Injection: URI—Analyzes content in the URI.
l XSS Detection: Referer—Analyzes content in the HTTP Referer header.
l XSS Detection: Cookie—Analyzes content in the HTTP Cookie header.
l XSS Detection: Body—Analyzes content in the HTTP request body.

Header scanning is recommended. Body scanning impacts performance, so you have the option of disabling body
scanning if system utilization or latency become an issue.

Predefined SQL injection and XSS detection policies on page 569 describes the predefined policies.

SQL Injection XSS

Predefined Rules Detection Action Severity Detection Action Severity

High-Level-Security All except Body
SQL Injection
Detection

Deny High All except Body
XSS Injection
Detection

Deny High

Medium-Level-
Security

Only SQL URI
SQL Injection
Detection

Deny High None Alert Low

Alert-Only Only SQL URI
SQL Injection
Detection

Alert High None Alert Low

Predefined SQL injection and XSS detection policies

If desired, you can create user-defined policies.

Before you begin:

l You must have Read-Write permission for Security settings.

After you have created an SQL injection/XSS policy, you can specify it in a WAF profile configuration.

To configure an SQL/XSS Injection Detection policy:

1. Go toWeb Application Firewall > Common Attacks Detection.
2. Click the SQL/XSS Injection Detection tab.
3. Click Create New to display the configuration editor.
4. Complete the configuration as described in SQL/XSS Injection Detection configuration on page 569.
5. Save the configuration.

Settings Guidelines

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces.
After you initially save the configuration, you cannot edit the name.

SQL

SQL/XSS Injection Detection configuration
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Settings Guidelines

SQL Injection
Detection

Enable/disable SQL injection detection.

URI Detection Enable/disable detection in the HTTP request.

Referer Detection Enable/disable detection in the Referer header.

Cookie Detection Enable/disable detection in the Cookie header.

Body Detection Enable/disable detection in the HTTP Body message.

Action Select the action profile that you want to apply. See Configuring WAF Action objects on page
546.
The default is alert, but we recommend using Deny SQL Injection.

Severity l High—Log as high severity events.
l Medium—Log as a medium severity events.
l Low—Log as low severity events.

The default is low, but we recommend you rate this high or medium.

SQL Exception
Name

Select an exception configuration object. Exceptions identify specific hosts or URL patterns
that are not subject to processing by this rule.

XSS

XSS Injection
Detection

Enable/disable XSS injection detection.

URI Detection Enable/disable detection in the HTTP request.

Referer Detection Enable/disable detection in the Referer header.

Cookie Detection Enable/disable detection in the Cookie header.

Body Detection Enable/disable detection in the HTTP Body message.

Action Select the action profile that you want to apply. See Configuring WAF Action objects on page
546.
The default is alert, but we recommend you deny XSS Injection.

Severity l High—Log matches as high severity events.
l Medium—Log matches as a medium severity events.
l Low—Log matches as low severity events.

The default is low, but we recommend you rate this high or medium.

XSS Exception
Name

Select an exception configuration object. Exceptions identify specific hosts or URL patterns
that are not subject to processing by this rule.

Configuring a CSRF protection policy

A cross-site request forgery (CSRF) is an attack that exploits the trust that a site has in a user's browser to transmit
unauthorized commands.

To protect back-end servers from CSRF attacks, you create two lists of items:
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l URL list—The URL list contains all the URLs that you want to protect. FortiADC will verify the anti-csrf token when
you access the URL.

l Page List—When FortiADC receives a request for a web page in the page list, it inserts a javascript in the web page.
The script runs in the client's web browser and automatically appends an anti-csrf token.

Parameter filters
In some cases, a request for a web page and the requests generated by its links have the
same URL. FortiADC cannot distinguish between requests to add javascript to and requests to
check for the anti-CSRF parameter.
To avoid this issue, you create unique Page List and URL List items by adding a parameter
filter to them. The parameter filter allows you to add additional criteria to match in the URL or
HTTP body of a request.

Create your configuration carefully, making sure that all the URLs in the list have corresponding entries in the page list.
When FortiADC checks requests for the token but has not added the script to the corresponding web page, it blocks or
takes other action against the request.

To configure a CSRF Protection policy:

1. Go toWeb Application Firewall.
2. Click the Common Attacks Detection tab.
3. Click the CSRF Protection tab
4. Click Create New to display the configuration editor.
5. Fill in the Name.
6. Enable the Status.
7. Modify the Action or Severity based on your requirements.
8. Click Save to save the configuration.
9. Click Edit to display the CSRF Protection.
10. Click Create New in CSRF Page to display the configuration editor and fill the Full URL Pattern and enable or

disable Parameter Filter based on your security requirements.
11. Click Create New in CSRF URL to display the configuration editor and fill the Full URL Pattern and enable or

disable Parameter Filter based on your security requirements.
12. Click Save to save the configuration.
13. Add the CSRF Protection policy to WAF profile.

Settings Guidelines

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces.
After you initially save the configuration, you cannot edit the name.

Action Select which action profile that you want to apply. See Configuring WAF Action objects on
page 546.
The default value is Alert.

Severity When FortiADC records violations of this rule in the attack log, each log message contains a
Severity Level (severity_level) field. Select which severity level FortiADC uses when it logs a
CSRF attack:
l Low

CSRF Protection configuration
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Settings Guidelines

l Medium
l High

The default value is Low.

Full URL Pattern Supports regular expression.

Parameter Filter Enable/disable Parameter Filter.

Parameter Name Name of the parameter.

Parameter Value Supports regular expression.

Sensitive Data Protection

TheWeb Application Firewall > Sensitive Data Protection sub-menu contains features and configurations for
Sensitive Data Protection that allows the Web Application Firewall (WAF) to prevent information leaks, damage and loss,
including Data Leak Prevention (DLP), Cookie Security, and HTTP Header Security.

l Configuring a Cookie Security policy on page 572
l Configuring an HTTP Header Security policy on page 574

Configuring a Cookie Security policy

A cookie security policy allows you to configure FortiADC features that prevent cookie-based attacks and apply them in a
protection profile. For example, a policy can enable cookie poisoning detection, encrypt the cookies issued by a back-
end server, and add security attributes to cookies.

To configure an Cookie Security policy:

1. Go toWeb Application Firewall > Sensitive Data Protection.
The configuration page displays the Cookie Security tab.

2. Click Create New to display the configuration editor.
3. Complete the configuration as described in Cookie Security configuration on page 572.

If you want to drop a large number of packets when traffic match the rules, you should set
Action to “block” instead of “deny."

4. Save the configuration.

Settings Guidelines

Name Enter a unique Cookie Security policy name. Valid characters are A-Z, a-z, 0-9, _, and -. No
space is allowed.

Cookie Security configuration
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Settings Guidelines

Note: Once saved, the name of an Cookie Security policy cannot be changed.

Security Mode No—Does not apply cookie tampering protection or encrypted cookie.
Signed—Prevents tampering by tracking the cookie by adding a signature.
Encrypted—FortiADC encrypts set-cookie values which have been sent from back-end web
server to clients. Clients can only see the encrypted cookies. FortiADC also decrypts cookies
which have been submitted by clients before sending them to the back-end server to
determine if a cookie attack has been placed.

Samesite Add SameSite attribute to prevent the browser from sending cookies along with cross-site
requests, to mitigate the risk of cross-origin information leakage. It provides Strict, Lax, and
None values for this attribute:
l Strict: any request from the third parties will not carry such cookies;
l Lax: any request from the third parties will not carry such cookies except for GET
requests that navigate to the destination URL.

l None: set the value as none if a cookie is required to be sent by cross origin.
l Nothing: Do not add Samesite attribute to cookies.

The default value is Nothing.

Secure Enable to add the secure flag to cookies. The secure attribute limits the scope of the cookie to
"secure" channels (where "secure" is defined by the user agent). When a cookie has the
Secure attribute, the user agent will include the cookie in an HTTP request only if the request
is transmitted over a secure channel (typically HTTP over Transport Layer Security (TLS).
Note: cookie attribute.

Severity When FortiADC records violations of this rule in the attack log, each log message contains a
Severity Level (severity_level) field. Select which severity level FortiADC uses when using
Cookie Security:
l Low
l Medium
l High

The default value is Low.

Remove Cookie Enable so FortiADC will accept the request, but will also remove the cookie before sending it
to backend web server.
Note:Only applies when Security Mode is set to encrypted or signed.

HTTP Only Enable to add "HTTPOnly" flag to cookies. The HttpOnly attribute limits the scope of the
cookie to HTTP requests. In particular, the attribute instructs the user agent to omit the cookie
when providing access to cookies via "non-HTTP" APIs (such as a web browser API that
exposes cookies to scripts).
Note: cookie attribute.

Encrypted Cookie
Type

All—will encrypt all cookies.
List—will encrypt the cookie that matches with the cookie-list.
Note: Only applies when Security Mode is set to encrypted.

Cookie Replay Disable or enable to allow FortiADC to use the IP address of a request to determine the owner
of the cookie.
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Settings Guidelines

If Cookie Replay is enabled, the client IP address will be appended to the set-cookie value
before encryption. Once the FortiADC receives the cookie, the cookie will be decrypted and
FortiADC will check if the IP matches with the client.
Since the public IP of a client is not static in many environments, we recommend that you do
not enable cookie-replay.
Note:Only applies when Security Mode is set to encrypted. Optional.

Allow Suspicious
Cookies

Never—Never allow suspicious cookies.
Always—Always allow suspicious cookies.
Custom—Don't Block suspicious cookies until the date specified by "Dont_block_until".
Select whether or not FortiADC will allow requests that contain unrecognizable cookies or if
there are missing cookies.
When cookie-replay is enabled, the suspicious cookie is a missing cookie that tracks the client
IP address.

In many cases, when you first introduce the cookie security features, the
cookies that client browsers have cached earlier will generate false
positives. To avoid this problem, either select Never, or select Custom
and enter an appropriate date on which to start taking the specified action
against suspicious cookies.

Note:Only applies when Security Mode is set to encrypted.

Don't Block Until Specify the date to begin blocking suspicious cookies. Applicable only when Allow Suspicious
Cookies is set to custom.
Note:Only applies when Security Mode is set to encrypted.

Max Age Note: cookie attribute.
Default value is 0 (do not add max age ), range 0- 2147483647.
Add the maximum age (in minutes) if the response from the backend server does not already
have a "Max-Age" attribute, or does not have an "Expires" attribute.

Exception See Configuring WAF Exception objects on page 548.

Action Select the action profile that you want to apply. See Configuring WAF Action objects on page
546.
The default value is Alert.

Cookie List The list of cookies to be encrypted.
Note: Only when Security Mode is set to encrypted, and when encrpyted_cookie_type is set
to "list."

Configuring an HTTP Header Security policy

HTTP response security headers are a set of standard HTTP response headers proposed to prevent or mitigate known
XSS, clickjacking, and MIME sniffing security vulnerabilities. These response headers define security policies to client
browsers so that the browsers avoid exposure to known vulnerabilities when handling requests.
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When the HTTP Security Headers feature is enabled, headers with specified values are inserted into HTTP responses
coming from the backend web servers. This is a quick and simple solution to address the security vulnerabilities on
user's website without code and configuration changes.

To configure an HTTP Header Security policy:

1. Go toWeb Application Firewall > Sensitive Data Protection.
2. Click the HTTP Header Security tab.
3. Click Create New to display the configuration editor.

4. Configure the following HTTP Header Security settings:

Setting Description

Name Enter a unique HTTP Header Security policy name. Valid characters are A-Z,
a-z, 0-9, _, and -. No space is allowed.
Note: Once saved, the name of an HTTP Header Security policy cannot be
changed.

Request Status Enable/disable request URL match. This is disabled by default.
l Enable — Responses to the request will be processed with the security
headers only if the URL of a request matches the specified request URL.

l Disable — All responses will be processed with the selected security
header(s).

Request URL The Request URL option is available if Request Status is enabled.
Specify the URL used to match requests so that security headers can be
applied to responses of the matched requests.

Mode Specify header operation mode for the response from the back-end server(s).
l Add-Always— always add the specified header(s).
l Add-Replace—add the specified header(s) if not exist, replace the value
of header(s) which exist already.

l Add-If-Absent — only add the specified header(s) if not exist, do nothing if

FortiADC Handbook 575
Fortinet Technologies Inc.



Web Application Firewall

Setting Description

the same header(s) exist
The default option is Add-Always.

5. Click Save.
Once the HTTP Header Security configuration is saved, the HTTP Header Security Rules section becomes
available to configure.

6. Under the HTTP Header Security Rules section, click Create New to display the configuration editor.

7. Configure the following HTTP Header Security Rules settings:

Setting Description

Name Select the HTTP security header name from the drop-down menu.
l content-security-policy
l x-content-type-options
l x-frame-options
l x-xss-protection
l http-strict-transport-security

Policy The Policy option is available if the Name is content-security-policy.
Enter the header value(s) that setting restrictions on resource types and
sources. For example, default-src 'self';script-src 'self';object-src 'self'.

Report Only The Report Only option is available if the Name is content-security-policy.
Enabling report-only switches to “Content-Security-Policy-Report-Only”
header, which accepts all directives of CSP. However, “report-only” header
only monitors the violations. FortiADC will check the existing of “report-uri”
directive once “report-only” selected.
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Setting Description

Max-age The time, in seconds, that the browser should remember that a site is only to
be accessed using HTTPS. A max-age value of zero (i.e., “max-age=0”)
signals the UA cease regarding the host as a Known HSTS Host, including the
includeSubDomains directive (if asserted for that HSTS Host).

Include Subdomain Optional. If enabled, rule will apply to all of the site's subdomains as well.

Preload Google maintains an HSTS preload service: https://hstspreload.org/. By
following the guidelines and successfully submitting your domain, browsers
will never connect to your domain using an insecure connection. While the
service is hosted by Google, all browsers have stated an intent to use (or
actually started using) the preload list. Most major browsers (Chrome, Firefox,
Opera, Safari, IE 11 and Edge) also have HSTS preload lists based on the
Chrome list. (See the HSTS compatibility matrix.) However, it is not part of the
HSTS specification and should not be treated as official.

8. Click Save.
Once the HTTP Header Security Rules configuration is saved, the editor dialog closes.

9. Click Save to update the HTTP Header Security configuration.
Once the HTTP Header Security policy is saved, you can reference it in a WAF Profile.

HTTP Security Header Names

Security Header Description

Content Security Policy A Content Security Policy (CSP), is an additional layer of security delivered via an
HTTP header. This policy helps prevent attacks such as Cross Site Scripting
(XSS) and other code injection attacks by defining content sources which are
approved thus allowing the browser to load them. Without a CSP, the browser
simply loads all files on a page without considering the source which could be
harmful. This puts both the site and it’s visitors at risk of malicious activity.
There are multiple directives available to website owners who want to implement
a content security policy. A server may also define multiple directives within a
CSP security header.
For a detailed list of examples and references, visit content-security-policy.com.
Additionally, you can use a tool called cspisawesome.com to easily create a CSP
specific to your needs.
FortiADC also provides a “report-only” flag to switch to “Content-Security-Policy-
Report-Only” header, which accepts all directives of CSP, but the difference is
that “report-only” header only monitor the violations. FortiADC will check the
existing of “report-uri” directive once “report-only” selected.

X Content Type options The X Content Type Options response HTTP header is a marker used by the
server to indicate that the MIME types advertised in the Content-Type headers
should not be changed and be followed. This helps reduce the danger of drive-by
downloads and helps treat the content the proper way.
There is only one directive that can be used, which is nosniff. An example of the
header looks like:
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Security Header Description

x-content-type-options: nosniff

X Frame Options The X Frame Options header provides clickjacking protection by not allowing
iframes to load on your website. It is supported by IE 8+, Chrome 4.1+, Firefox
3.6.9+, Opera 10.5+, Safari 4+.
There are three directives available for this header: deny, sameorigin and allow-
from. But “allow-from” is obsolete and no longer works in modern browers,
FortiADC will notsupport it.
On FortiADC, there are two directive options: deny and sameorigin.
Once “deny” selected, the header looks like:
x-frame-options: DENY

Once “sameorigin” selected, the header looks like:
x-frame-options: SAMEORIGIN

X XSS protection The X XSS Protection header is designed to enable the cross-site scripting (XSS)
filter built into modern web browsers. This is usually enabled by default, but using
it will enforce it.
Although these protections are largely unnecessary in modern browsers when
sites implement a strong Content-Security-Policy that disables the use of inline
JavaScript ('unsafe-inline'), they can still provide protections for users of older
web browsers that don't yet support CSP.
On FortiADC, this function has two modes to be choose: sanitizing-mode and
block-mode. Once sanitizing-mode selected (usually default in browsers), an
example looks like:
x-xss-protection: 1

Once block-mode selected, an example looks like:
x-xss-protection: 1; mode=block

HTTP strict transport security l The HTTP strict-transport-security (HSTS) header is a security enhancement
that restricts web browsers to access web servers solely over HTTPS. This
ensures the connection cannot be establish through an insecure HTTP
connection, would helps to protect websites against protocol downgrade
attacks and cookie hijacking.
There are three directives for this header:
max-age=<expire-time>

l includeSubDomains
l preload
An example looks like:
strict-transport-security: max-age=31536000;
includeSubDomains; preload
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Data Loss Prevention

The FortiADC Data Loss Prevention (DLP) module prevents sensitive data from leaving or entering your network by
scanning for various patterns while inspecting traffic passing through the FortiADC. Data matching defined sensitive
data patterns is blocked, logged, or allowed when it passes through the FortiADC.

The FortiADC DLP module has integrated with the FortiGuard DLP service, allowing FortiADC to download DLP
signatures directly from FortiGuard to enrich the FortiADC DLP signature data types. For more information, see
FortiGuard DLP service on page 580.

Alternatively, Data Loss Prevention can still function without the FortiGuard DLP service. You can still configure a DLP
Policy to defend against data loss using only Sensitive Data Type.

The DLP module is configured based on the following components:

Component Description

DLP Policy Define rules for matching a sensor based on file content or an HTTP Payload, and
the email protocol being used to attach files. It also allows you to choose the
action to allow, log, or block the address.

Sensitive Data Type Define the type of pattern that DLP is trying to match. For example, this can be a
predefined type including credit card or US social security number (SSN), or you
can use keyword, regular expression, or a hexadecimal value to match data.

DLP Sensor Define which dictionaries to check. You can match any or all dictionaries. It can
also count the number of dictionary matches to trigger the sensor.
Note: This DLP component requires the FortiGuard DLP service to be enabled.

DLP Dictionary Combine multiple data type entries to match all or any. When selecting a data
type such as keyword, regex or hex, define the pattern that you are looking for.
Note: This DLP component requires the FortiGuard DLP service to be enabled.

In the backend, DLP uses Hyperscan to perform a one-parse algorithm for scanning multiple patterns. This allows DLP
to scale up without any performance downgrade.

Basic configuration

To deploy Data Loss Prevention, follow the workflow below:

1. Configure the DLP Dictionary to define the collection of data type entries to use in the DLP Sensor. For details, see
Configuring a DLP Dictionary object on page 590.

2. Configure the DLP Sensor to define which dictionary to check. For details, see Configuring a DLP Sensor object on
page 588.

3. Configure the Sensitive Data Type to define the type of pattern that DLP is trying to match. For details, see
Configuring a Sensitive Data Type object on page 585.

4. Configure the DLP Policy to define the rules for matching a sensor or sensitive data type. For details, see
Configuring a DLP Policy on page 582.

5. Apply the DLP Policy to a WAF profile. For details, see Configuring a WAF Profile on page 544.
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FortiGuard DLP service

The Data Loss Prevention module in FortiADC integrates with the FortiADC DLP service, allowing FortiADC to download
DLP signatures directly from FortiGuard to enrich the FortiADC DLP signature data types. It uses a customizable
database of more than 500 predefined data patterns and policies to simplify and expedite DLP deployment and
integration into existing environments. The FortiGuard DLP service database undergoes continuous maintenance and
updates to stay in sync with the latest advancements in network security intelligence.

By enabling the FortiGuard Data Loss Prevention service in FortiADC, you will have access to a database of predefined
DLP patterns such as data types, dictionaries, and sensors. If the HTTP payload or files passing through FortiADC
contain data that matches the patterns defined in these dictionaries, FortiADC will initiate specified actions to safeguard
the data.
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FortiGuard DLP service license

You can contact the Fortinet Sales Team to purchase a separate FortiGuard DLP service license, or a bundled license
that includes the FortiGuard DLP service.

Updating the FortiGuard DLP database

1. Register your FortiGuard DLP service license at the Fortinet Customer Service & Support website:
https://support.fortinet.com.

2. Log in to FortiADC. Go to System > FortiGuard and check the status of the FortiGuard DLP service license.
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3. Typically, the system will automatically update the DLP database from FortiGuard. If it is not up-to-date, click
Update to initiate the DLP database update.

Configuring a DLP Policy

The Data Loss Prevention (DLP) feature allows the Web Application Firewall (WAF) to prevent information leaks,
damage and loss. DLP provides desensitization and warning measures for sensitive information leaks on websites, such
as SSN numbers and credit card information, as well as the leakage of sensitive keywords.

You can create a DLP Policy to match a sensor based on file content or an HTTP Payload, and the email protocol being
used to attach files. It also allows you to choose the action to allow, log, or block the IP address.

Before you begin:

l Configure a virtual server with a WAF Profile.
l Configure a DLP Dictionary object. For details, see Configuring a DLP Dictionary object on page 590.
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l Configure a DLP Sensor object. For details, see Configuring a Sensitive Data Type object on page 585.
l Configure a Sensitive Data Type object. For details, see Configuring a Sensitive Data Type object on page 585.

To configure a DLP Policy:

1. Go toWeb Application Firewall > Data Loss Prevention.
The configuration page displays the DLP Policy tab.

2. Click Create New to display the configuration editor.

3. Configure the following DLP Policy settings:

Setting Description

Name Specify a name for the DLP Policy.
Valid characters are A-Z, a-z, 0-9, _, and -. No spaces. The configuration
name cannot be edited once it has been saved.

Status Enable or disable this profile. Default is disable.

Masking TheMasking option is available if Status is enabled.
Enable masking to replace sensitive data with asterisks(*). Default is disable.
Note:
When masking is enabled, all target data will be replaced by an asterisk(*) so
the threshold value won’t take effect here. Masking only works when the action
is alert. The connection will be rejected when the action is set as "deny" or
"block," so no target data will be replaced.

Action The Action option is available if Status is enabled.
Select the action profile that you want to apply. See Configuring WAF Action
objects on page 546. The default is Alert.

Severity The Severity option is available if Status is enabled.
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Setting Description

Set the severity level in the WAF logs for potential attacks detected by the DLP
Policy.
l High
l Medium
l Low

The default option is Low.

4. Click Save.
After the Data Leak Prevention configuration is saved, the Rule section becomes available to configure.

5. Under the Rule section, click Create New to display the Data Loss Prevention Rule configuration editor.

6. Configure the following Data Loss Prevention Rule settings:

Setting Description

Type Select the DLP data type to match:
l Sensitive Data Type
l Sensors
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Setting Description

The default option is Sensitive Data Type.

URI Pattern Specify the URI Pattern in the Data Loss Prevention rules. Scanning and
receiving an empty value means this rule is not working.

Sensitive Data Type The Sensitive Data Type option is available if the Type is Sensitive Data
Type.
Select the Sensitive Data Type you want to apply. See Configuring a Sensitive
Data Type object on page 585.

Threshold The Threshold option is available if the Type is Sensors.
Set a threshold for the Data Loss Prevention rule.
The rule will not take effect until the target data exceeds the threshold's
specified value. Range 1-10000. Default is 1. This will not work if Masking is
enabled.

Sensor The Sensor option is available if the Type is Sensors.
Select the DLP Sensor you want to apply. See Configuring a DLP Sensor
object on page 588.

7. Click Save.
Once the Data Loss Prevention Rule configuration is saved, the editor dialog closes.
You can add more rule items, with a maximum of 256 rules, but detection will stop after matching as many as 8
rules.

8. Click Save to update the DLP Policy configuration.
Once the DLP Policy is saved, you can reference it in a WAF Profile.

Configuring a Sensitive Data Type object

A Sensitive Data Type object is referenced as part of the Data Loss Prevention (DLP) policy to prevent information,
damage and loss by specifying strings as sensitive data.

Predefined Sensitive Data Type objects

You can use the following predefined Sensitive Data Type objects or clone to use as a template.

Predefined Sensitive Data
Type objects

Description

Credit_Card_Number For credit card numbers from MC, Visa, Amex, Diners/CarteBlanche,
Discover/Novus, Enroute, and JCB. Matches 341-1111-1111-1111 | 5431-1111-
1111-1111 | 30569309025904 Non-Matches 30-5693-0902-5904 | 5631-1111-
1111-1111 | 31169309025904.

US_Social_Security_Number This regex validates U.S. social security numbers, within the range of numbers
that have been currently allocated. Matches 078-05-1120 | 078 05 1120 Non-
Matches 987-65-4320 | 000-00-0000 | (555) 555-5555.

Email This regex validates email address. Matches example@fortinet.com Non-
Matches@fortinet.com.
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Predefined Sensitive Data
Type objects

Description

URL This regex validates URL. Matches http://www.fortinet.com |
https://127.0.0.1/path/example.php?name=test1 |
ftp://user:pass@example.com:123 Non-Matches /fortinet.com

Numbers This regex validates numbers. Matches 65535 Non-Matches a123.

Strings This regex validates a string. Matches abc Non-Matches abc123.

Date/Time This regex validates email address. Matches 29/02/1972 | 5-9-98 | 10-11-2002 |
February 29, 2004 | 12:15 | 10:26:59 | 22:01:15 Non-Matches 32/12/2019.

IP Address This regex validates IPv4 or IPv6 address. Matches 127.0.0.1 |
FEDC:BA98:7654:3210:FEDC:BA98:7654:3210 | ::FFFF:129.144.52.38 Non-
Matches 256.0.0.1 | FEDC:BA98:7654:3210 | ::

GUID This regex validates a globally unique identifier. Matches 2064d355-c0b9-41d8-
9ef7-9d8b26524751 | 2064D355-C0B9-41D8-9EF7-9D8B26524751 Non-
Matches 2064D355.

US Phone This regex validates a US phone number WITH area code. It is written to all users
to enter whatever delimiters they want or no delimiters at all. Matches 111-222-
3333 | 111.222.3333 | (111) 222-3333| 1112223333 Non-Matches + 41 111-222-
3333 .

US ZIP Code This regex validates US zip codes. Matches all zip codes of exactly 5 digits except
00000. Optionally, matches zip5+zip4 where zip5 is exactly 5 digits, zip4 is
exactly 4 digits, and zip5 and zip4 are, optionally, separated by a single space or
hyphen. Captures zip5 and zip4 to named groups to facilitate program
manipulation. Matches 12345 | 123456789 | 12345-6789 Non-Matches 123456.

US State Name and Abbrev. This regex validates 50 US States's Name and Abbrev, case insensitive. Matches
California | NewYork | North Carolina | AL.

US Street Address This regex validates a US Street Address. Matches 123 Lincoln Avenu | 123West
Main St | 12345 Via De La Rosa Non-Matches Lincoln Avenu.

UK Vehicle Registration This regex validates a UK vehicle registration system currently in use (as defined
by the DVLA and put into effect from September 2001, and therefore does not
allow registrations prior to this date). Matches AB51DVL | AB 51 DVL Non-
Matches AB-51-DVL.

UK Bank Sort Code This regex validates the format of a UK bank sort code. Matches 20-40-36 | 50-
25-48 | 45-85-66 Non-Matches 204036.

Post Office Box This regex validates a Post Office Box. Matches P. O. Box | p.o. box | PO Box | po
box Non-Matches office box.

Chinese ID card This regex validates a Chinese ID card number. Matches 2064d355-c0b9-41d8-
9ef7-9d8b26524751 | 2064D355-C0B9-41D8-9EF7-9D8B26524751 Non-
Matches 2064D355.

Chinese phone This regex validates a Chinese telphone number. Matches 86 13512341234 | +86
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Predefined Sensitive Data
Type objects

Description

15812341234 | 86 13612341234 Non-Matches 14012341234.

Australian Phone This regex validates a Australian telephone number, most Australian telephone
numbers including 13, 1300, 1800, 1900, std and international +61- format
numbers. It allows optional spaces, dashes and brackets in most cases. Matches
1300 123 123 | 1300123123 | +61212341234 | (02) 1234-1234 | 02 1234 1234
Non-Matches 1400123123.

Canadian Postal Code Canadian Postal Code format is (A1A 1X1) or (a1a 1x1). Its made up of two parts.
Forward Sortation Area (FSA) and Local Delivery Unit (LDU). Read more on
wikipedia. The letters D, F, I, O, Q, or U are not used on postal Code. Matches
M1R 4B0 | L0R 1B1 | L0R1B9 Non-Matches MDR 4B0.

To configure a Sensitive Data Type object:

1. Go toWeb Application Firewall > Data Loss Prevention.
2. Click the Sensitive Data Type tab.
3. Click Create New to display the configuration editor.

4. Configure the following Sensitive Data Type settings:

Setting Description

Name Specify a name for the Sensitive Data Type object.
Valid characters are A-Z, a-z, 0-9, _, and -. No spaces. The configuration
name cannot be edited once it has been saved.

Description Comments about this profile. Describe what this profile is used for and what
kind of data this regex is used to match.

Regex Specify the regex string used to match sensitive data. There are two
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Setting Description

predefined regex strings named Credit_Card_Number and US_Social_
Security_Number.

5. Click Save.
After the Sensitive Data Type configuration is saved, you can reference this object in the Data Loss Prevention rule.

Configuring a DLP Sensor object

A DLP Sensor defines which dictionaries to check. You can match any dictionary or all dictionaries. It can also count the
number of dictionary matches to trigger the sensor.

Before you begin:

l You must have a valid FortiGuard DLP service license and have enabled the service on FortiADC. For details, see
FortiGuard DLP service on page 580.

l Configure a DLP Dictionary object. For details, see Configuring a DLP Dictionary object on page 590.

Predefined DLP Sensor objects

You can use the following predefined DLP Sensor objects in Data Loss Prevention rules.

Predefined DLP
Sensor object

Match
Type

Description Dictionaries

can-hia Any Canadian Health Information Act (HIA)
Sensor

l can-pass-dict
l can-natl_id-sin-dict
l can-phin-dict
l can-health_service-dict

can-pii Any Canadian Personal Identifiable
Information (PII) Sensor

l can-dl-dict
l can-natl_id-sin-dict
l can-pass-dict
l can-health_service-dict
l can-bank_account-dict
l can-phin-dict

source_code Any Source Code Sensor l source_code-python
l source_code-c
l source_code-java

To configure a DLP Sensor:

1. Go toWeb Application Firewall > Data Loss Prevention.
2. Click the DLP Sensor tab.
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3. Click Create New to display the configuration editor.

4. Configure the following DLP Sensor settings:

Setting Description

Name Specify a name for the DLP Sensor object.
Valid characters are A-Z, a-z, 0-9, _, and -. No spaces. The configuration
name cannot be edited once it has been saved.

Match Type Select the match type:
l Any—Data meeting the criteria specified by any one of the dictionaries
will be identified as a match.

l All — Data meeting the criteria specified by all dictionaries will be
identified as a match.

The default is Any.

Description Comments about this DLP Sensor object.

5. Click Save.
After the DLP Sensor configuration is saved, the Dictionaries section becomes available to configure.

FortiADC Handbook 589
Fortinet Technologies Inc.



Web Application Firewall

6. Under the Dictionaries section, click Create New to display the configuration editor.

7. Configure the following Dictionaries settings for the DLP Sensor:

Setting Description

Status Enable the Status if you intend to apply this sensor.

DLP Dictionary Select a DLP Dictionary object from the drop-down menu.

Count Specify the occurrence threshold for the dictionary match. The sensor will be
triggered when the dictionary match reaches the specified number of times.
Default: 1 Range: 1-255.
For example, if the dictionary applies to credit card numbers and the count is
set to 4, the sensor will be triggered when credit card number occurs four times
in the HTTP request or response.

8. Click Save.
Once the Dictionaries configuration is saved, the editor dialog closes.

9. Click Save to update the DLP Sensor configuration.
Once the DLP Sensor is saved, you can reference it in a DLP Policy.

Configuring a DLP Dictionary object

A DLP dictionary defines the patterns of data. The term "pattern" denotes a set of attributes specific to a given data type.
For example, credit card numbers constitute numeric data that follow either the 14-digit or 16-digit patterns associated
with credit cards. If the data adheres to these patterns, FortiADC will identify it as a match.

Before you begin:

l You must have a valid FortiGuard DLP service license and have enabled the service on FortiADC. For details, see
FortiGuard DLP service on page 580.

Predefined DLP Sensor objects

You can use the following predefined DLP Dictionary objects in Data Loss Prevention rules.
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Predefined DLP Dictionary
object

Match
Type

Description

EICAR-TEST-FILE Any EICAR Test File for DLP

can-natl_id-pk Any

can-natl_id-sin-dict Any Canadian SIN Card Number Dictionary

glb-pass-pk Any

can-pass-dict Any Canadian Passport Dictionary

usa-pass-dict Any USA Passport Dictionary

uk-pass-dict Any UK Passport Dictionary

aus-pass-dict Any Australia Passport Dictionary

fra-pass-dict Any France Passport Dictionary

jpn-pass-dict Any Japan Passport Dictionary

can-health_service-pk Any

can-phin-pk Any

can-phin-dict Any Canadian Personal Health Identification Number Dictionary

can-health_service-dict Any Canadian Health Service Dictionary

glb-cc-pk Any

glb-cc-dict Any Global Credit Card Dictionary

usa-natl_id-pk Any

glb-dl-pk Any

can-dl-dict Any Canadian Driver's License Dictionary

can-bank_account-pk Any

can-bank_account-dict Any Canadian Bank Account Dictionary

usa-natl_id-ssn-dict Any USA SSN Card Number Dictionary

glb-swift-pk Any

source_code-python Any Python Source Code Dictionary

source_code-c Any C Source Code Dictionary

source_code-java Any Java Source Code Dictionary

To configure a DLP Dictionary object:

1. Go toWeb Application Firewall > Data Loss Prevention.
2. Click the DLP Dictionary tab.
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3. Click Create New to display the configuration editor.

4. Configure the following DLP Dictionary settings:

Setting Description

Name Specify a name for the DLP Dictionary object.
Valid characters are A-Z, a-z, 0-9, _, and -. No spaces. The configuration
name cannot be edited once it has been saved.

Match Type Select the match type:
l Any—Data meeting the criteria specified by any one of the dictionary
entries will be identified as a match.

l All — Data meeting the criteria specified by all dictionary entries will be
identified as a match.

The default is Any.

Description Comments about this DLP Dictionary object.

5. Click Save.
After the DLP Dictionary configuration is saved, the FortiGuard Data Types section becomes available to configure.
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6. Under the FortiGuard Data Types section, click Create New to display the configuration editor.

7. Configure the following FortiGuard Data Types settings for the DLP Dictionary:

Setting Description

Status Enable the Status if you intend to apply this data type.

FortiGuard Data Type Select a FortiGuard Data Type from the drop-down menu.

Repeat Enable this option if you want to match data exclusively when it appears
multiple times.
With this option enabled, you can specify the times of occurrence in the DLP
Sensor settings.

8. Click Save.
Once the FortiGuard Data Types configuration is saved, the editor dialog closes.

9. Click Save to update the DLP Sensor configuration.
Once the DLP Dictionary is saved, you can reference it in a DLP Sensor.

Input Validation

TheWeb Application Firewall > Input Validation sub-menu contains features and configurations for Input Validation
that enables you to create rules to prevent suspicious HTTP requests by verifying the user input from scan points like
URL parameter, HTML form, hidden fields, and upload file.

l Configuring an Input Validation policy on page 593
l Configuring a Parameter Validation rule on page 594
l Configuring a Hidden Field rule on page 596
l Configuring a File Restriction rule on page 597

Configuring an Input Validation policy

An Input Validation policy can prevent suspicious HTTP requests. This function will verify the user input from scan points
such as URL parameter, HTML form, hidden fields, and uploaded files. If the input format is incorrect or FortiADC detects
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other attacks, the request will be blocked.

Input Validation policies consist of the following components that must have already been configured if they are to be
included in the policy:

l Parameter Validation Rule. For details, see Configuring a Parameter Validation rule on page 594.
l Hidden Field Rule. For details, see Configuring a Hidden Field rule on page 596.
l File Restriction Rule. For details, see Configuring a File Restriction rule on page 597.

To configure an Input Validation policy:

1. Go toWeb Application Firewall > Input Validation.
The configuration page displays the Input Validation Policy tab.

2. Click Create New to display the configuration editor.
3. Enter a unique Input Validation policy name. Valid characters are A-Z, a-z, 0-9, _, and -. No space is allowed. The

name of the policy cannot be changed after saving initially.
4. Click Save to create the Input Validation Policy.

Once the Input Validation Policy has been saved, the Parameter Validation Rule, Hidden Field Rule, and File
Restriction Rule sections are available to configure.

5. Under the Parameter Validation Rule section, add Parameter Validation rules to the Input Validation Policy.
a. Click Create New to display the configuration editor.
b. Select an existing Parameter Validation Rule or create a new configuration.
c. Click Save to submit and exit out of the configuration editor.

6. Under the Hidden Field Rule section, add Hidden Field rules to the Input Validation Policy.
a. Click Create New to display the configuration editor.
b. Select an existing Hidden Field Rule or create a new configuration.
c. Click Save to submit and exit out of the configuration editor.

7. Under the File Restriction Rule section, add File Restriction rules to the Input Validation Policy.
a. Click Create New to display the configuration editor.
b. Select an existing File Restriction Rule or create a new configuration.
c. Click Save to submit and exit out of the configuration editor.

8. Click Save to update the Input Validation policy.

After you have configured your Input Validation policy, you can reference it in a WAF Profile.

Configuring a Parameter Validation rule

Define the Parameter Validation rule for Input Validation to determine whether or not parameters are required, and their
maximum allowed length. Inputs are typically the <input> tags in an HTML form, where the input rules are applicable
for visible inputs only, such as buttons and text areas.

The Parameter Validation rule function can do the following:

l Check the HOST by simple string or regular expression matching.
l Check the URL by simple string or regular expression matching.
l Check the parameter name of inputs filed by matching simple string or regular express. Will also restrict the length
of the name.

If the conditions are successfully matched, it will execute the specified action.
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To configure a Parameter Validation rule:

1. Go toWeb Application Firewall > Input Validation.
2. Click the Parameter Validation tab.
3. Click Create New to display the configuration editor.
4. Configure the following Parameter Validation Rule settings:

Setting Description

Name Enter a unique name for the Parameter Validation Rule. Valid characters are
A-Z, a-z, 0-9, _, and -. No space is allowed.
Note: Once saved, the name of a Parameter Validation Rule cannot be
changed.

Host Status Enable to require that the Host: field of the HTTP request match a protected
host name's entry in order to match the URL access rule. Also configure Host.

Host The Host option is available if Host Status is enabled.
Select which protected host name's entry (either a web host name or
IP address) that the Host: field of the HTTP request must be in to match the
URL access rule.

Request URL The HTTP request URL must be start with /. eg./login. This item must be set
when configuring the rule. FortiADC will match the other item (rule) when
matching the request URL; if the match fails, FortiADC will not attempt to
match others.

Action Select the action profile that you want to apply. See Configuring WAF Action
objects on page 546.
The default value is Alert.

Severity When FortiADC records violations of this rule in the attack log, each log
message contains a Severity Level (severity_level) field. Select which
severity level FortiADC uses when using Input Validation:
l Low
l Medium
l High

The default value is Low.

5. Click Save.
Once the Parameter Validation Rule is saved, the Parameter Validation Rule Element section can be configured.

6. Under the Parameter Validation Rule Element section, click Create New to display the configuration editor.
7. Configure the following Parameter Validation Rule Element settings:

Setting Description

Name Enter a unique name for the Parameter Validation Rule Element. It must match
the value of the name in the input type of the HTML request.

Max Length The maximum length of the Parameter Validation Rule Element name's value.

Use Type Check Enable/disable to check the data type.
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Setting Description

Argument Type The Argument Type option is available if Use Type Check is enabled.
Select to use predefined data type or customized regular expression.

Data Type The Data Type option is available if Use Type Check is enabled and
Argument Type is Data Type.
Match the string by the predefined data type.

Regular Expression The Regular Expression option is available if Use Type Check is enabled
and Argument Type is Regular Expression.
Match the string by regular expression.

8. Click Save to save the Parameter Validation Rule Element configuration and exit from the dialog.
9. Click Save to update the Parameter Validation Rule configuration.

After the Parameter Validation rule has been saved, you can include it in an Input Validation Policy.

Configuring a Hidden Field rule

Define the Hidden Field rule for Input Validation to check for hidden parameters from <input type="hidden"> HTML
tags. These hidden parameters are often written into an HTML page by the web server when it serves that page to the
client, and is not visible on the rendered web page.

The Hidden Field rule function can do the following:

l Check the HOST by simple string or regular expression matching.
l Check the URL by simple string or regular expression matching.
l Match the configuration of the fetched URL.

If the conditions are successfully matched, it will execute the specified action.

To configure a Hidden Field rule:

1. Go toWeb Application Firewall > Input Validation.
2. Click the Hidden Field tab.
3. Click Create New to display the configuration editor.
4. Configure the following Hidden Field settings:

Setting Description

Name Enter a unique name for the Hidden Fields rule. Valid characters are A-Z, a-z,
0-9, _, and -. No space is allowed.
Note: Once saved, the name of a Hidden Field rule cannot be changed.

Host Status Enable to require that the Host: field of the HTTP request match a protected
host name's entry in order to match the URL access rule. Also configure Host.

Host The Host option is available if Host Status is enabled.
Select which protected host name's entry (either a web host name or
IP address) that the Host: field of the HTTP request must be in to match the
URL access rule.
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Setting Description

Request URL The HTTP request URL must be start with /. eg./login. This item must be set
when configuring the rule. FortiADC will match the other item (rule) when
matching the request URL; if the match fails, FortiADC will not attempt to
match others.

Action Select the action profile that you want to apply. See Configuring WAF Action
objects on page 546.
The default value is Alert.

Severity When FortiADC records violations of this rule in the attack log, each log
message contains a Severity Level (severity_level) field. Select which
severity level FortiADC uses when using Input Validation:
l Low
l Medium
l High

The default value is Low.

5. Click Save.
Once the Hidden Field configuration is saved, the Post URL and Hidden Fields sections can be configured.

6. Under the Post URL section, click Create New to display the configuration editor.
7. In the URL field, specify the Post URL on which the hidden fields function can work. Click Save and exit the

configuration dialog.
8. Under the Hidden Fields section, click Create New to display the configuration editor.

To apply this feature, you must enable Session Management in your protection profile.

9. In the Name field, enter a unique Hidden Fields name. It must match the value of the name in the input type of the
HTML request. Click Save and exit the configuration dialog.

10. Click Save to update the Hidden Field configuration.

After the Hidden Field rule has been saved, you can include it in an Input Validation Policy.

Configuring a File Restriction rule

Define the File Restriction rule for Input Validation to restrict file uploads based on file type and size.

The File Restriction rule function can do the following:

l Check the HOST by simple string or regular expression matching.
l Check the URL by simple string or regular expression matching.
l Check the uploaded file type and file size by simple string or regular expression matching.

If the conditions are successfully matched, it will execute the specified action.

To configure a File Restriction rule:

1. Go toWeb Application Firewall > Input Validation.
2. Click the File Restriction tab.
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3. Click Create New to display the configuration editor.
4. Configure the following File Restriction settings:

Setting Description

Name Enter a unique File Restriction policy name. Valid characters are A-Z, a-z, 0-9,
_, and -. No space is allowed.
Note: Once saved, the name of a File Restriction policy cannot be changed.

Host Status Enable to require that the Host: field of the HTTP request match a protected
host name's entry in order to match the URL access rule. Also configure Host.

Host The Host option is available if Host Status is enabled.
Select which protected host name's entry (either a web host name or
IP address) that the Host: field of the HTTP request must be in to match the
URL access rule.

Request URL The HTTP request URL must be start with /. eg./login. This item must be set
when configuring the rule. FortiADC will match the other item (rule) when
matching the request URL; if the match fails, FortiADC will not attempt to
match others.

Action Select the action profile that you want to apply. See Configuring WAF Action
objects on page 546.
The default value is Alert.

Severity When FortiADC records violations of this rule in the attack log, each log
message contains a Severity Level (severity_level) field. Select which
severity level FortiADC uses when using Input Validation:
l Low
l Medium
l High

The default value is Low.

Upload File Status Allow: Only allow the selected file type to upload.
Block: Block any upload of the selected file type.

Upload File Size The maximum size of the uploaded file.

5. Click Save.
Once the File Restriction configuration is saved, the Upload File Type section can be configured.

6. Under the Upload File Type section, click Create New to display the configuration editor.
7. In the Field Type field, select the supported file types for the uploaded file.
8. Click Save to update the File Restriction configuration.

After the File Restriction rule has been saved, you can include it in an Input Validation Policy.

Access Protection

TheWeb Application Firewall > Access Protection sub-menu contains features and configurations for Access
Protection, that include URL Protection, Brute Force Attack Detection, Credential Stuffing Defense.
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l Configuring a URL Protection policy on page 599
l Configuring a Brute Force Attack Detection policy on page 600
l Configuring a Credential Stuffing Defense policy on page 601

Configuring a URL Protection policy

URL protection policies can filter HTTP requests that match specific character strings and file extensions.

Before you begin:

l You must have Read-Write permission for Security settings.

After you have configured URL protection policies, you can select them in WAF profiles.

To configure a URL Protection policy:

1. Go toWeb Application Firewall > Access Protection.
2. Click the URL Protection tab.
3. Click Create New to display the configuration editor.
4. Complete the configuration as described in URL Protection configuration on page 599.
5. Save the configuration.

Settings Guidelines

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces.
After you initially save the configuration, you cannot edit the name.

URL Access Rule

Full URL Pattern Matching string. Regular expressions are supported.

Action Select the action profile that you want to apply. See Configuring WAF Action objects on page
546.
The default is alert.

Severity l High—Log as high severity events.
l Medium—Log as a medium severity events.
l Low—Log as low severity events.

The default is low.

Exception Name Select an exception configuration object. Exceptions identify specific hosts or URL patterns
that are not subject to processing by this rule.

File Extension Rule

File Extension
Pattern

Matching string. Regular expressions are supported.

Action Select the action profile that you want to apply. See Configuring WAF Action objects on page
546.
The default is alert.

URL Protection configuration
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Settings Guidelines

Severity l High—Log as high severity events.
l Medium—Log as a medium severity events.
l Low—Log as low severity events.

The default is low.

Exception Name Select an exception configuration object. Exceptions identify specific hosts or URL patterns
that are not subject to processing by this rule.

Configuring a Brute Force Attack Detection policy

Brute Force Attack Detection policies can prevent too many login tests. If an HTTP client tries to log into a server via
FortiADC and fails too many times, Brute Force Attack Detection policies can stop it.

Before you begin:

l You must have Read-Write permission for Security settings.

After you have configured Brute Force Attack Detection policies, you can select them in WAF profiles.

To configure a Brute Force Attack Detection policy:

1. Go toWeb Application Firewall > Access Protection.
2. Click the Brute Force Attack Detection tab.
3. Click Create New to display the configuration editor.
4. Complete the configuration.

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces.
After you initially save the configuration, you cannot edit the name.

Status On | OFF. If On, this policy will be activated, otherwise it is inactive.

Action Select the action profile that you want to apply. See Configuring WAF Action objects on page
546.
The default is alert.

Severity High—Log as high severity events.
Medium—Log as medium severity events.
Low—Log as low severity events.
The default is low.

Exception Select an exception configuration object. Exceptions identify specific hosts or URL patterns that
are not subject to processing by this rule.

Comments A string to describe the purpose of the configuration.

5. Save the configuration.
6. Edit the new saved configuration.
7. Find “Match Condition” and click Create New.
8. Complete the configuration.
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Host
Status

On | OFF;
If On, Host Pattern will be shown and needed.
The default is OFF.

Host
Pattern

Matching string for host name. Regular expressions are supported.

URL
Pattern

Matching string. Regular expressions are supported. The input string must start with "/".

Login
Failed
Code

Matching failed code (HTTP response code). 0 means it does not match this code.
The default is 0.

IP
Access
Limit

1-65535. Specify the number of consecutive login failures.
Note: If a pair of HTTP request/response match all the settings above (Host Pattern if Host Status is
On, URL Pattern and Login Failed Code if it isn’t 0), this is a login failure.

9. Save the configuration.

You can add multiple match condition rules by repeating steps 6-9.

10. Save the configuration.

Configuring a Credential Stuffing Defense policy

Credential Stuffing Defense identifies login attempts using username and password that have been compromised using
an always up-to-date feed of stolen credentials. Administrators can configure their supported devices to take various
actions if a suspicious login is used including logging, alerts, and blocking.

To configure a Credential Stuffing Defense policy:

1. Go toWeb Application Firewall > Access Protection.
2. Click the Credential Stuffing Defense tab.
3. Click Create New to display the configuration editor.
4. Complete the Credential Stuffing Defense configuration.
5. Save the configuration.

Predefined Rules Description

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces. After
you initially save the configuration, you cannot edit the name.

Status Enable or disable this profile. Default is disable.

Action Select the action profile that you want to apply. See Configuring WAF Action
objects on page 546.
The default is Alert.

FortiADC Handbook 601
Fortinet Technologies Inc.



Web Application Firewall

Predefined Rules Description

Severity High—Log matches as high severity events.
Medium—Log matches as a medium severity events.
Low—Log matches as low severity events.
The default is Low, but we recommend you use High or Medium.

Note: FortiADC has no built-in Credential Stuffing Defense database. At least one FortiGuard update is required to
install the database, otherwise this feature is ineffective. For details, see Configuring FortiGuard service settings on
page 218.

CORS Protection

Cross-Origin Resource Sharing (CORS) is a browser mechanism which enables controlled access to resources located
outside of a given domain The CORS standard works by adding new HTTP headers that allow servers to describe which
origins are permitted to read that information from a web browser. It extends and adds flexibility to the same-origin policy
so that websites would not be restricted to accessing resources from the same origin.

However, in the process of enabling information sharing between sites, the significance of CORS configuration may be
overlooked and allow for vulnerabilities. One such example is the Cross-Origin Request Site, an OWASP TOP10
Security Misconfiguration vulnerability.

To protect your applications against CORS vulnerabilities, use the CORS Protection feature to ensure that only
legitimate CORS requests from allowed web applications can reach your application.

TheWeb Application Firewall > CORS Protection sub-menu includes the following:

l Configuring a CORS Protection Rule on page 602
l Configuring an Allowed Origin List on page 605
l Configuring a CORS Headers List on page 607

Configuring a CORS Protection Rule

The CORS Protection Rule List defines the actions FortiADCmay take to protect the Cross-Origin Resource Sharing
using the Allowed Origin and optionally, the CORS Headers.

Configuration overview

To enable the CORS protection functionality, you need to configure the following:

l Allowed Origin List — see Configuring an Allowed Origin List on page 605.
l CORS Headers List (optional) — see Configuring a CORS Headers List on page 607.
l CORS Protection Rule List.

After you have configured your CORS Protection, you can add it to your WAF profile configuration under the Input
Protection section. For more information, see Configuring a WAF Profile on page 544.
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To create and configure the CORS Protection Rule List:

1. Go toWeb Application Firewall > CORS Protection.
2. Click the CORS Protection tab.
3. Click Create New to display the configuration editor.

Configure the following:

Parameter Description

Name Enter a unique CORS Protection name. Valid characters should match regular
expression /^[A-Za-z0-9.:_-]*$/. No space is allowed.
Note: Once saved, the name of an CORS Protection cannot be changed.

Status Enable/disable CORS protection. This is disabled by default.
Note: The CORS Protection Rule List cannot be configured until CORS
protection is enabled.

4. Click Save.
The newly created CORS Protection is listed under the CORS Protection tab.

5. Locate the newly created CORS Protection on the list and double-click the row or click the (Edit icon).
6. Under CORS Protection Rule List, click Create New to display the configuration editor.

Configure the following:

Parameter Description

Action Specify the WAF action:
l alert
l deny
l block
l silent-block

The default action is block.

Host Status Enable/disable to allow this rule to protect a specific domain name or IP
address. This is disabled by default.

Host Name This option appears if Host Status is enabled.
Specify the host name.

Request URL Specify the request URL as a regular expression. The maximum length is
8192 characters.

Apply to All CORS Traffic Enable/disable to apply the CORS Protection Rule to all CORS traffic. This is
disabled by default.
l Disable — The CORS Protection Rule will take effect if all CORS
protection parameters matches, including Allowed Origin.

l Enable — The CORS Protection Rule will take effect if the Request URL
and/or the Host Name (if Host Status is enabled) matches. Once Apply
to All CORS Traffic is enabled, all options are hidden except Action,
Host Status (Host Name), and Request URL.

Allowed Origin Specify the name of the Allowed Origin.
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Parameter Description

From the drop-down, you may select previously configured Allowed Origin or
select Create New to create and configure an Allowed Origin directly. For
detailed steps, see Configuring an Allowed Origin List on page 605.
The allowed origin list ensures only the CORS traffic from the specified
applications are allowed.

Insert Allow Credentials Enable/disable to allow whether the CORS requests from foreign applications
can include user credentials. This is disabled by default.

Allowed Credentials This option appears if Insert Allow Credentials is enabled.
Select one of the following options:
l True
l False

If the selected Allowed Origin is set to *, then do not select True for Allowed
Credentials.

Insert Max Age Enable/disable to specify a maximum time period before the result of the
preflight request expires.

Allowed Maximum Age This option appears if Insert Max Age is enabled.
Specify the maximum time period in seconds. (Range: 0-86400, default: 0).

Allowed Methods Enable/disable to allow FortiADC to use theMethods specified to verify
whether the methods used in the CORS requests are legitimate. This is
disabled by default.

Methods This option appears if Allowed Methods is enabled.
Specify the method(s):
l GET
l POST
l HEAD
l TRACE
l CONNECT
l DELETE
l PUT
l PATCH

Allowed Headers Enable/disable to allow FortiADC to use the CORS Headers List to verify
whether the headers used in the CORS requests are legitimate. This is
disabled by default.

Allowed Headers List This option appears if Allowed Headers is enabled.
Specify the name of the CORS Headers List to allow.
From the drop-down, you may select previously configured CORS Headers.
For detailed steps, see Configuring a CORS Headers List on page 607.
FortiADC uses the allowed-headers-list to verify whether the headers used in
the CORS requests are legitimate.
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Parameter Description

Exposed Headers Enable/disable to allow FortiADC to expose the specified headers in the
CORS Headers List in JavaScript and share with foreign applications. This is
disabled by default.

Exposed Headers List This option appears if Exposed Headers is enabled.
Specify the name of the CORS Headers List to expose.
From the drop-down, you may select previously configured CORS Headers.
For detailed steps, see Configuring a CORS Protection Rule on page 602.
FortiADC will expose the headers in the exposed-headers-list in JavaScript
and share with foreign applications.

7. Click Save.

Configuring an Allowed Origin List

The Allowed Origin List specifies the allowed domains using the HTTP response header. The header can contain either
a * to indicate that all domains are allowed OR a specified domain to indicate the specified allowed domain.

You can create and configure the Allowed Origin List from the Allowed Origin tab or as part of the CORS Protection
Rule List.

Allowed Origin can only take effect in the CORS Protection rule when the Apply to
All CORS Traffic is disabled. In the CORS Protection Rule List configuration, the
Apply to All CORS Traffic option is disabled by default, which then requires you to
apply an Allowed Origin List for the CORS Protection rule. If the Allowed Origin List is
not applied, the CORS Protection rule would not work as the empty list would not
match the condition.
Enabling the Apply to All CORS Traffic option hides the Allowed Origin option,
making it inapplicable to the CORS Protection rule.

To create and configure the Allowed Origin List from Allowed Origin tab:

1. Go toWeb Application Firewall > CORS Protection.
2. Click the Allowed Origin tab.
3. Click Create New to display the configuration editor.

Configure the following:

Parameter Description

Name Enter a unique Allowed Origin name. Valid characters should match regular
expression /^[A-Za-z0-9.:_-]*$/. No space is allowed.
Note: Once saved, the name of an Allowed Origin cannot be changed.

4. Click Save.
5. Under Allowed Origin List, click Create New to display the configuration editor.

FortiADC Handbook 605
Fortinet Technologies Inc.



Web Application Firewall

Configure the following:

Parameter Description

Protocol Select which type of protocols are allowed for the connections between foreign
applications and your application.
l HTTP
l HTTPS
l ANY

The default is HTTP.

Origin Name Enter the foreign application's domain name or IP address.
Wildcards are supported. (Range: 1-128 characters).

Port Specify the TCP port number for the CORS connections. (Range: 0-65535;
default: 80).

Include Sub Domains Enable/disable to allow/disallow the Origin Value to match with the domains of
its sub level.
This is disabled by default.

6. Click Save.

To create and configure the Allowed Origin List as part of the CORS Protection Rule List:

1. Go toWeb Application Firewall > CORS Protection.
2. Click the CORS Protection tab.
3. Click Create New to display the configuration editor.

Configure the following:

Parameter Description

Name Enter a unique CORS Protection name. Valid characters should match regular
expression /^[A-Za-z0-9.:_-]*$/. No space is allowed.
Note: Once saved, the name of an CORS Protection cannot be changed.

Status Enable/disable CORS protection. This is disabled by default.
Note: The CORS Protection Rule List cannot be configured until CORS
protection is enabled.

4. Click Save.
The newly created CORS Protection is listed under the CORS Protection tab.

5. Locate the newly created CORS Protection on the list and double-click the row or click the (Edit icon).
6. Under CORS Protection Rule List, click Create New to display the configuration editor.
7. In the Allow Origin field, select Create New from the drop-down.

The Allowed Origin configuration editor is displayed.
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8. Configure the following:

Parameter Description

Name Enter a unique Allowed Origin name. Valid characters should match regular
expression /^[A-Za-z0-9.:_-]*$/. No space is allowed.
Note: Once saved, the name of an Allowed Origin cannot be changed.

9. Click Save.
10. Under Allowed Origin List, click Create New to display the configuration editor.

Configure the following:

Parameter Description

Protocol Select which type of protocols are allowed for the connections between foreign
applications and your application.
l HTTP
l HTTPS
l ANY

The default is HTTP.

Origin Name Enter the foreign application's domain name or IP address.
Wildcards are supported. (Range: 1-128 characters).

Port Specify the TCP port number for the CORS connections. (Range: 0-65535;
default: 80).

Include Sub Domains Enable/disable to allow/disallow the Origin Value to match with the domains of
its sub level.
This is disabled by default.

11. Click Save.

Configuring a CORS Headers List

The CORS Headers List specifies the HTTP headers that may be "allowed" or "exposed" in the CORS Protection Rule
List. If allowed, FortiADC will use the headers list to verify whether the headers used in the CORS requests are
legitimate. If exposed, FortiADC will expose the headers in the headers list in JavaScript and share with foreign
applications.

The CORS Headers List can be optional as it is only required if Allowed Headers or Exposed Headers is enabled in
the CORS Protection Rule List.

To create and configure the CORS Headers List:

1. Go toWeb Application Firewall > CORS Protection.
2. Click the CORS Headers tab.
3. Click Create New to display the configuration editor.

Configure the following:
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Parameter Description

Name Enter a unique CORS Headers name. Valid characters should match regular
expression /^[A-Za-z0-9.:_-]*$/. No space is allowed.
Note: Once saved, the name of a CORS Headers cannot be changed.

4. Click Save.
The newly created CORS Headers is listed under the CORS Headers tab.

5. Locate the newly created CORS Headers on the list and double-click the row or click the (Edit icon).
6. Under CORS Headers List, click Create New to display the configuration editor.

Configure the following:

Parameter Description

Header Specify the HTTP header as a string. (Range: 1-63 characters).

7. Click Save.

API Protection

TheWeb Application Firewall > Bot Mitigation sub-menu is organized into the following sections:

l JSON Protection on page 608
l XML Protection on page 611
l OpenAPI Validation on page 615
l API Gateway on page 617
l API Discovery on page 620

JSON Protection

Under the API Protection sub-menu, the JSON Protection page contains the features that allow you to create rules
that enforce security checks that examine client HTTP requests for anomalies in JSON data in HTTP POST operations.

This section includes the following:

l Configuring JSON detection on page 608
l Importing JSON schema on page 610

Configuring JSON detection

Hackers sometimes try to exploit vulnerabilities in JSON data in HTTP POST operations to attack web servers. You can
configure FortiADC's web application firewall (WAF) to enforce security checks that examine client HTTP requests for
anomalies in JSON data in HTTP POST operations. This ensures that JSON data reaching web servers is well-formed.
Some of the security protections include:

l Running format checks on requests containing JSON data in HTTP POST operations to protect potential security
holes.
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l Imposing JSON parsing limits to protect against denial-of-service (DOS) attacks.
l Performing JSON cross-site scripting (XSS) checks and JSON SQL Injection checks.

JSON Check Chain on page 609 illustrates how HTTP packets containing JSON can be examined via sequence
detection when JSON detection is configured.

JSON Check Chain

JSON checks are composed of four parts, and each one carries out a single detection function:

l Format Check—Executes JSON format detection sub-module (JSON-FDM).
l Limit Check—Executes JSON limit detection sub-module (JSON-LDM).
l SQL Injection Detection—Executes JSON cross-site scripting detection sub-module (JSON-XSSDM).
l XSS Detection—Executes JSON cross-site scripting detection sub-module (JSON-SIDM).

Before you begin, you must:

l Configure a virtual server with a WAF Profile. See Configuring virtual servers on page 328 and Configuring a WAF
Profile on page 544.

To configure JSON Detection:

1. Go toWeb Application Firewall > API Protection and select the JSON Detection tab.
2. Click Create New.
3. Complete the configuration as described in JSON Detection on page 609.
4. Click Save.

Settings Guidelines

Name Enter the name of the JSON Detection profile. You will use the name to select the JSON
Detection profile in WAF profiles. No spaces.

JSON Format Checks Enable to configure security checks for incoming HTTP requests to determine whether they
are well-formed. You can set FortiADC response actions to malformed HTTP requests below.

JSON Limit Checks Enable to enforce parsing limits to protect web servers from attacks such as DOS attacks. If
enabled, you may change the configuration for the following parameters:
l Limit Max Array Value
l Limit Max Depth
l Limit Max Object Member

JSON Detection
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Settings Guidelines
l Limit Max String

Limit Max Array Value Limits the maximum number of values within a single array. The default value is 256. The
valid range is 0–4096. Available only when JSON Limit Checks is enabled.

Limit Max Depth Limits the maximum depth in a JSON value. The default value is 16. The valid range is 0–
4096. Available only when JSON Limit Checks is enabled.

Limit Max Object
Member

Limits the number of members in a JSON object. The default value is 64. The valid range is 0–
4096. Available only when JSON Limit Checks is enabled.

Limit Max String Limits the length of a string in a JSON request for a name or a value. The default value is 64.
The valid range is 0–4096. Available only when JSON Limit Checks is enabled.

JSON Xss Checks Enable to examine the bodies of incoming JSON requests that might indicate possible cross-
site scripting attacks. If the request contains a positive match, FortiADC responds with the
corresponding action selected below.

JSON SQL Injection
Checks

Enable to examine the bodies of incoming requests for inappropriate SQL characters and
keywords that might indicate an SQL injection attack. If the request contains a positive match,
FortiADC responds with the corresponding action selected below.

Severity Set the severity level in WAF logs of potential attacks detected by the JSON Detection profile.
Select from one of the following options:
l High
l Medium
l Low

Action Select the action profile that you want to apply. See Configuring WAF Action objects on page
546.
The default is Alert.

Exception Name Optional. Select the exception profile that you want to apply to the JSON Detection profile.
See Configuring WAF Exception objects on page 548.

Importing JSON schema

JSON Schema describes the structure of a JSON document (for instance, required properties and length limitations).
Applications can use this information to validate instances (check that constraints are met), or inform interfaces to collect
user input such that the constraints are satisfied.
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Software architecture

The schema will validate when the user upload it through CLI/WEB GUI. Only the schema that passes the validation can
be saved in ADC.

You can configure FortiADC's web application firewall (WAF) to use trusted JSON schema files to validate JSON content
in HTTP requests that contain JSON. Using JSON schema files to validate JSON content can ensure that client requests
to web servers are well-formed and do not contain any potential attacks.

Before you begin, you must:

l Download a trusted JSON schema file that you can import to FortiADC. Acceptable file types are .tar, .tar.gz,
or .zip.

To import a JSON schema file:

1. Go toWeb Application Firewall > API Protection and select the JSON Schema tab.
2. Click Create New.
3. Enter the name of the JSON schema configuration. You will use the name to select the schema file in

JSON detection profiles. No spaces.
4. Click Choose File and select the JSON schema file that you want to import.
5. Click Save.

XML Protection

Under the API Protection sub-menu, the XML Protection page contains the features that allow you to create rules that
examine client requests for anomalies in XML code.

This section includes the following:

l Configuring XML Detection on page 612
l Importing XML schema on page 614
l Uploading WSDL files on page 615
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Configuring XML Detection

XML is commonly used for data exchange, and hackers sometimes try to exploit security holes in XML code to attack
web servers. You can use FortiADC's web application firewall (WAF) to examine client requests for anomalies in XML
code. TheWAF can also attempt to validate the structure of XML code in client requests using a trusted XML schema
file. Configuring XML detection can help to ensure that the content of requests containing XML does not contain any
potential attacks.

XML Check Chain on page 612 illustrates how HTTP packets containing XML can be examined when XML detection is
configured.

XML Check Chain

XML checks are composed of six parts, and each one carries out a single detection function:

l Format Check—Executes XML format detection.
l XML Schema Validation—Checks to determine whether XML content is well-formed. Must upload an XML schema
file.

l Limit Check—Executes XML limit detection sub-module.
l SQL Injection Detection—Executes XML SQL injection detection.
l XSS Feature Library—Executes XML cross-site scripting detection sub-module (XML-SIDM).

Before you begin, you must:

l Configure a virtual server with a WAF Profile. See Configuring virtual servers on page 328 and Configuring a WAF
Profile on page 544.

To configure XML Detection:

1. Go toWeb Application Firewall > API Protection and select the XML Detection tab.
2. Click Create New.
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3. Complete the configuration as described in XML Detection on page 613.
4. Click Save.

Settings Guidelines

Name Enter the name of the XML Detection profile. You will use the name to select the XML Detection
profile in WAF profiles. No spaces.

XML Format Check Enable to configure security checks for incoming HTTP requests to determine whether they are
well-formed. You can set FortiADC response actions to malformed HTTP requests below.

Soap Format
Check

Enable or disable Soap Format Check.
Note: When enabled, FortiADC will examine the format of incoming SOAP requests and block
those that are ill-formed.
This option is disabled by default. If enabled, you can choose to enable or disable WSDL Checks
below.
FortiADC's Soap format check supports Soap versions 1.1 and 1.2.

WSDL Check Enable or disable WSDL Check.
Note: When enabled, FortiADC will examine the SOAP content in a request against the special
characters and OS commands.
This option becomes available only when Soap Format Check is enabled above. It is disabled by
default. If enabled, you must select a WSDL file below.

WSDL Select a WSDL file from the list menu, which shows all WSDL files that are shown (uploaded) on
the WSDL page.
Note: This option allows FortiADC to check the SOAP content in a request against the selected
WSDL file, and block the content if it fails the check.

XML Schema
Check

Before enabling XML Schema Checks, you must upload an XML schema file to check whether
XML content is well-formed. Enable to use XML schema to validate XML content. See Importing
XML schema on page 614

XML Schema Select the XML schema file that you want to use to check whether XML content is valid.

XML Limit Check Enable to enforce parsing limits to protect web servers from DOS attacks, including XML bombs
and transform injections. If enabled, you may change the configuration for the following
parameters:
l Limit Max Attr
l Limit Max Attr Name Len
l Limit Max Attr Value Len
l Limit Max Cdata Len
l Limit Max Elem Child
l Limit Max Elem Depth
l Limit Max Elem Name Len
l Limit Max Namespace
l Limit Max Namespace Url Len

Max Attribute Limits the maximum number of attributes each individual element is allowed to have. The default
value is 256. The valid range is 1–256. Available only when XML Limit Checks is enabled.

Max Attribute Limits the maximum length of each attribute name. The default value is 128. The valid range is

XML Detection
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Settings Guidelines

Name Length 1–2048. Available only when XML Limit Checks is enabled.

Max Attribute
Value Length

Limits the maximum length of each attribute value. The default value is 128. The valid range is
1–2048. Available only when XML Limit Checks is enabled.

Max Cdata Length Limits the length of the CDATA section for each element. The default value is 65535. The valid
range is 1–65535. Available only when XML Limit Checks is enabled.

Max Element Child Limits the maximum number of children each element is allowed, and includes other elements
and character information. The default value is 65535. The valid range is 1–65535. Available
only when XML Limit Checks is enabled.

Max Element
Depth

Limits the maximum number of nested levels in each element. The default value is 256. The valid
range is 1–65535. Available only when XML Limit Checks is enabled.

Max Element
Name Length

Limits the maximum length of the name of each element. The default value is 128. The valid
range is 1–65535. Available only when XML Limit Checks is enabled.

Max Namespace Limits the number of namespace declarations in the XML document. The default value is 16. The
valid range is 0–256. Available only when XML Limit Checks is enabled.

Max Namespace
URL Length

Limits the URL length for each namespace declaration. The default value is 256. The valid range
is 0–1024. Available only when XML Limit Checks is enabled.

XML XSS Check Enable to examine the bodies of incoming XML requests that might indicate possible cross-site
scripting attacks. If the request contains a positive match, FortiADC responds with the
corresponding action selected below.

XML SQL Injection
Check

Enable to examine bodies of incoming requests for inappropriate SQL characters and keywords
that might indicate an SQL injection attack. If the request contains a positive match, FortiADC
responds with the corresponding action selected below.

Severity Set the severity level in WAF logs of potential attacks detected by the XML Detection profile.
Select one of the following options:
l High
l Middle
l Low

Action Select the action profile that you want to apply. See Configuring WAF Action objects on page
546.
The default is Alert.

Exception Name Optional. Select the exception profile that you want to apply to the XML Detection profile. See
Configuring WAF Exception objects on page 548.

Importing XML schema

XML schema files specify the acceptable structure of and elements in an XML document. When you use XML schema
files to check XML content in HTTP requests, it's easier to describe acceptable content and validate that the content is
well-formed.

You can configure FortiADC's web application firewall (WAF) to use trusted XML schema files to validate XML content in
HTTP requests that contain XML. Using XML schema files to validate XML content can ensure that client requests to
web servers are well-formed and do not contain any potential attacks.
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Before you begin, you must:

l Download a trusted XML schema file that you can import to FortiADC. Acceptable file types are .tar, .tar.gz, or
.zip.

To import an XML schema file:

1. Go toWeb Application Firewall > API Protection and select the XML Schema tab.
2. Click Create New.
3. Enter the name of the XML schema configuration. You will use the name to select the schema file in XML detection

profiles. No spaces.
4. Click Choose File and select the XML schema file that you want to import.
5. Click Save.

Uploading WSDL files

WSDL stands for Web Services Description Language, which is an XML-based interface definition language used to
describe the function of Web services. The acronym can also refer to a WSDL file that contains a specific WSDL
description of a Web service, as it is in our case. WSDL provides a machine-readable description of how a web service
can be called, what parameters it expects, and what data structures it returns.

WSDL is often used in tandem with SOAP and an XML schema to provide Web services. By reading the WSDL file, a
client program connecting to a Web service can find out what operations are available on the server. The WSDL file
contains all special data types used in the form of XML Schema. The client uses SOAP to call the operations listed in the
WSDL file using XML over HTTP.

In FortiADC, WSDL check is an option under Soap Format Check which is part of XML validation. In order to configure
this option, you must upload your WSDL file or files to FortiADC.

To upload a WSDL file:

1. On the navigation bar, clickWeb Application Firewall> API Protection.
2. Click theWSDL tab. Click Create New. TheWSDL dialog opens.
3. Specify a unique name for the WSDL configuration.
4. Click Choose File to browse for and upload the WSDL file.
5. Click Save.

OpenAPI Validation

Under the API Protection sub-menu, theOpenAPI Validation page contains the features that allow you to create rules
through defining a standard, language-agnostic interface to RESTful APIs, which allows both humans and computers to
discover and understand the capabilities of the service without access to source code, documentation, or through
network traffic inspection.

This section includes the following:

l Configuring OpenAPI Detection on page 616
l Importing OpenAPI schema on page 617
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Configuring OpenAPI Detection

The OpenAPI Specification (OAS) defines a standard, language-agnostic interface to RESTful APIs, which allows both
humans and computers to discover and understand the capabilities of the service without access to source code,
documentation, or through network traffic inspection. When properly defined, you can understand and interact with the
remote service with a minimal amount of implementation logic.

FortiADC can parse the OpenAPI description file and provide additional security to APIs by making sure that access is
based on the definitions described in the OpenAPI file.

Note: FortiADC supports OpenAPI 3.0.

To configure OpenAPI Detection:

1. Go toWeb Application Firewall > OpenAPI Validation.
2. Click theOpenAPI Detection tab.
3. Click Create New to display the configuration editor and set up the configuration.
4. Save the configuration.

Settings Guidelines

Name Configure the name. Valid characters are A-Z, a-z, 0-9, _, and -. Whitespaces not
allowed.
Note: Once saved, the name cannot be changed.

OpenAPI Schema Check Before enabling OpenAPI Schema Check, you must upload an OpenAPI schema
file to check whether OpenAPI content is permitted. Enable to use OpenAPI
schema to validate OpenAPI content. See Importing OpenAPI schema on page
617.

OpenAPI Schema Select the OpenAPI schema file that you want to use to check whether OpenAPI
content is valid.

Action Select the action profile that you want to apply. See Configuring WAF Action
objects on page 546.
The default is Alert.

Severity When FortiADC records violations of this rule in the attack log, each log message
contains a Severity Level (severity_level) field. Select the severity level FortiADC
uses when using Input Validation:
l Low
l Medium
l High

The default is Low.

Exception Select an exception configuration object. Exceptions identify specific hosts or
URL patterns that are not subject to processing by this rule.

API Detection Configuration
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Importing OpenAPI schema

An OpenAPI schema file defines or describes the API including information like the API URL, parameter names in the
URL, type of data parameters should have (string, integer, etc), where parameters are submitted (URL, header, body,
etc.), and so on. For more information about OpenAPI files, see https://github.com/OAI/OpenAPI-Specification.

Once you upload the valid OpenAPI schema file, FortiADC will parse the file and then block requests that do not match
the definitions in the file.

Before you begin, you must:

l Prepare a trusted OpenAPI schema file in YAML or JSON format that you can import to FortiADC. Acceptable file

types are .tar, .tar.gz, and .zip.

To import an OpenAPI schema file:

1. Go toWeb Application Firewall > OpenAPI Validation.
2. Click theOpenAPI Schema tab.
3. Click Create New.
4. Enter the name of the OpenAPI schema configuration. You will use the name to select the schema file in OpenAPI

Detection profiles.
5. Click Choose File and select the OpenAPI schema file that you want to import.
6. Click Save.

API Gateway

Under the API Protection sub-menu, the API Gateway allows you to create policies that include an API management
tool that sits between a client and a collection of backend services. It acts as a reverse proxy to accept all API calls and
return the appropriate result.

This section includes the following:

l Configuring an API Gateway policy on page 617
l Configuring an API Gateway User on page 618
l Configuring an API Gateway Rule on page 619

Configuring an API Gateway policy

An API gateway is an API management tool that sits between a client and a collection of backend services. It acts as a
reverse proxy to accept all API calls and return the appropriate result.

API gateway on FortiADC provides the following functions:

l API user management
l API key verification
l API access control
l Rate limit control
l Attach HTTP Header in API call
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To configure an API Gateway Policy:

1. Go toWeb Application Firewall > API Gateway.

2. Click the API Gateway Policy tab.

3. Click Create New to display the configuration editor and set up the configuration.

4. Save the configuration.

Settings Guidelines

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. Whitespaces are
not allowed. After you initially save the configuration, you cannot edit the name.

Rule Name Specify one or more rules created in API Gateway Rule to be used in policy. The
rules will be checked one by one from top to bottom until URL in request is
matched to the Full URL Pattern in a rule.

Configuring an API Gateway User

1. Go toWeb Application Firewall > API Gateway.

2. Click the API Gateway User tab.

3. Click Create New to display the configuration editor and set up the configuration.

4. Save the configuration.

Settings Guidelines

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. Whitespaces are
not allowed. After you initially save the configuration, you cannot edit the name.

Comments (Optional) Enter a description or comments for the user.

UUID Non-editable. Automatically generated when the user is created.

API Key Non-editable. Automatically generated when the user is created.

Restricted Access IPs Restrict this API key so that it may only be used from the specified IP addresses.

Restrict HTTP Referers Restrict this API key so that it may only be used when the specified URLs are
present in the Referer HTTP header. This can be used to prevent an API key from
being reused on other client-side web applications that don’t match this URL.
Only full URLs that begin with http:// or https:// are supported.
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Configuring an API Gateway Rule

1. Go toWeb Application Firewall > API Gateway.
2. Click the API Gateway Rule tab.
3. Click Create New to display the configuration editor and set up the configuration.
4. Save the configuration.

Settings Guidelines

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. Whitespaces are
not allowed. After you initially save the configuration, you cannot edit the name.

Host Status Enable/Disable for applying this rule only to HTTP requests for specific web hosts.

Host Select the name of a protected host that the Host: field of an HTTP request must
be in to match the API gateway rule.
This option is available only if Host Status is enabled.

Full URL Pattern Matching string. Regular expressions are supported.

Method Select one or more HTTP methods are allowed when access the API.

API Key Verification When a user makes an API request, the API key will be included in the HTTP
header or parameter. FortiWeb obtains the API key from the request. When this
option is enabled, FortiWeb verifies the key to check whether the key belongs to
an valid API user.

API Key Carried In Indicate where to find the API key in HTTP request:
l HTTP Parameter
l HTTP Header

Available only when API Key Verification is enabled.

HTTP Header Name Enter the header filed name of the API key.

HTTP Parameter Name Enter the parameter name of the API key.

Rate Limit Status Enable/Disable to do rate limit for API calls.

Rate Limit Requests Sets the condition for the limit of the number of API requests received. If the
number of requests received within the time frame (set in Rate Limit Period), this
condition is fulfilled.

Rate Limit Period Sets the time spent during which to count how many times a request is received.

Action Select the action profile that you want to apply. See Configuring WAF Action
objects on page 546.
The default is Alert.

Severity When FortiADC records violations of this rule in the attack log, each log message
contains a Severity Level (severity_level) field. Select which severity level
FortiADC uses when using Input Validation:
l Low
l Medium
l High

The default value is Low.
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Settings Guidelines

Exception Name Select a user-defined exception configuration object. Exceptions identify specific
hosts or URL patterns that are not subject to processing by this rule.

User Specify one or more users created in API Gateway User to define which users
have the permission to access the API.

Attach HTTP Header Insert specific header lines into HTTP header. Need to specify the fieldname and
value is seach entry.

API Discovery

Under the API Protection sub-menu, the API Discovery page contains the features that allow you to protect your
application against malicious APIs through discovered API endpoints.

Through API Discovery policies, FortiADC is enabled to automatically discover external API endpoints from
HTTP/HTTPS requests and responses that have passed through API validity checks, wherein the API is parsed for
information including the Host, Paths, parameters and their schemas from query requests or entity bodies, as well as
classify parameters that match PII (Personal Identifiable Information) signatures. API Discovery also supports manually
imported OAS files compliant with OpenAPI 3.0 and Swagger 2.0 standard to parse and discover as internal API
endpoints that can also be matched by incoming API requests or responses.

This section includes the following:

l Configuring API Discovery on page 620
l Understanding the API endpoints database in API View on page 623

Configuring API Discovery

API Discovery policies allow FortiADC to automatically discover external API endpoints from HTTP/HTTPS requests and
responses that have passed through API validity checks, wherein the API is parsed for information including the Host,
Paths, parameters and their schemas from query requests or entity bodies, as well as classify parameters that match PII
(Personal Identifiable Information) signatures. API Discovery also supports manually imported OAS files compliant with
OpenAPI 3.0 and Swagger 2.0 standard to parse and discover as internal API endpoints that can also be matched by
incoming API requests or responses. The discovered external and internal API endpoints can then be directly applied in
API security rules based on the Host, Path, and request rate. Once the API requests and responses pass the API validity
check that matches the rule, the specified security action will be triggered to protect against the malicious APIs.

API Discovery is based on VDOMs, where API endpoints are discovered and stored
per VDOM. The total API endpoints database size for each VDOM is 1 G.

API Discovery is based on VDOMs, where API endpoints are discovered and stored per VDOM.

Basic API Discovery workflow

API Discovery policies depend entirely on internal or external API endpoints to function. For external API endpoints to be
discovered, the API Discovery policy must be referenced in a WAF Profile used in an active virtual server. Follow the
basic workflow below to deploy API Discovery.
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Basic steps:

1. Create and enable an API Discovery policy to enable automatic discovery for external API endpoints. For details,
see Configuring automatic discovery for external API endpoints on page 621.

2. Reference the API Discovery policy in a WAF Profile. Once the WAF Profile is used in a virtual server, external API
endpoints will be discovered from HTTP/HTTPS requests and responses. For details, see Configuring a WAF
Profile on page 544.

3. Optionally, import an OAS file to parse and discovery as internal API endpoints. For details, see Manually import
internal API endpoints on page 622.

4. Optionally, check and refresh the API View page for automatically discovered API endpoints.
5. Optionally, check the API Threats page under FortiView > Data Analytics to view all discovered API endpoints

that have triggered attacks.

Configuring automatic discovery for external API endpoints

External API endpoint discovery is automatically activated when the virtual server referencing the API Discovery policy
receives API responses/requests. The API Discovery policy will automatically begin validating APIs and parsing
endpoints to build your API endpoints database which can then be viewed in the API View page. From the API Discovery
policy, you can add API Security rules to trigger alerts and actions against APIs identified as malicious through API
Discovery.

The maximum number of API Discovery policies is 256.

To configure an API Discovery policy:

1. Go toWeb Application Firewall > API Discovery.
The configuration page displays the API Discovery tab.

2. Click Create New to display the configuration editor.
3. Configure the following settings:

Setting Description

Name Enter a unique API Discovery name. Valid characters should match regular
expression /^[A-Za-z0-9.:_-]*$/. No space is allowed.
Note: Once saved, the name of an Allowed Origin cannot be changed.

API Discovery Enable or disable the API Discovery configuration.

4. Click Save.
Once the API Discovery configuration is saved, the API Security Rule section can be configured.

5. Under the API Security Rule section, click Create New to display the configuration editor.
The maximum number of API security rules under one API Discovery policy is 256.

6. Configure the following API Security Rule settings:

Setting Description

Host Specify the HTTP Host header. This is required. Maximum length is 255
characters.
Example: 192.168.0.253, [2001:1234::a41:6e]:8443, or demo.fortinet.com.
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Setting Description

Once the API Discovery policy is activated, the policy matches only if the Host
header matches this value. Complete, exact matching is required. For
example, www.example.commatches www.example.com but not
www.example.com.hk.

Path Specify the API resource path. Text string and simple regex is supported.
Example: /login. Begin with '/'.

API Request Rate Specify the allowable requests per second. Default: 0. Range: 0 - 100000000.
Note: 0 means there is no limit.

Action Specify a WAF action object to apply when a bot is detected. See Configuring
WAF Action objects on page 546.
The default action is alert.

Severity Select the event severity to log when a bot is detected:
l High— Log as high severity events.
l Medium— Log as a medium severity events.
l Low— Log as low severity events.

The default is Low.

7. Click Save.
Once the API Security Rule configuration is saved, the dialog closes.

8. Click Save to update the API Discovery configuration with the API Security Rule changes.

After you have completed the API Discovery policy configuration, reference it in a WAF Profile that will be used in a
virtual server.

If a previously enabled API Discovery policy is disabled, new API endpoints will not
be discovered. However, the API security rules associated with that API Discovery
policy will continue to work.

Manually import internal API endpoints

API Discovery supports manually imported OAS files compliant with OpenAPI 3.0 and Swagger 2.0 standard to parse
and discover as internal API endpoints that can also be matched by incoming API requests or responses.

JSON and YAML file types are supported.

To import an OAS file:

1. Go toWeb Application Firewall > API Discovery.
2. Click the API View tab.
3. Click Choose File to display the file upload dialog.
4. Locate and select the OAS file to import.

After the OAS file is successfully imported, the file contents are parsed into internal API endpoints that can be
viewed on the API View page.
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Understanding the API endpoints database in API View

From the API View tab, you can view your database of discovered internal and external API endpoints. You can refresh
the page to view newly discovered external API endpoints.

Each API endpoint is parsed for the following key elements:

API Information Description

Host The name of the protected host that the Host: field of an HTTP request must be in
to match the API Discovery policy.
Example: 110.ztnatest02.com
Note: Maximum supported length of Host is 255 characters.

Base_URL The base_url consists of the prefix HTTP/HTTPS and the Host.
Example: http://110.ztnatest02.com
Note: Maximum supported length of Base_URL is 255 characters.

Path The resource path of the API.
Example: /api/test

API Endpoint The API endpoint is organized and displayed as the Path with HTTP method.
Example: GET: /api/test

Parameter Parsed from the HTTP query request or entity body.
Example: path, required, internal

API View endpoint organization

Each API endpoint entry is identified and stored by its HTTP method and path. However, each entry is maintained per
method, so in cases where endpoints share the same path but use different HTTP methods, a separate entry will be
maintained per HTTP method.
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API endpoints will be displayed in a simplified view when four or more requests that have a different integer as the last
sub-path are discovered. In which case, the endpoints will be simplified and reorganized as a single endpoint template
with the following specifications:

l The Path of the endpoint will be similar to /v1/users/{users_id}.
l An extra parameter will be generated, named “users_id” with a label “required”.

Supported API types and HTTP methods for API Discovery

l RESTful API —GET/POST/PUT with XML/JSON, or DELETE
l SOAP API — POST with SOAP+XML
l OAS file types— JSON or YAML

Prerequisites for APIs to be discovered

l The return codemust be 200-299.
l The HTTP headers and corresponding entity body must have the following in the request/response:

HTTP Method Requirement

GET “Accept: application/json”, “Accept: application/xml” or “Accept: */*” in the
request, and corresponding “Content-Type:” header with entity body in the
response.

PUT/POST “Content-Type: application/json”, “Accept: application/xml” or “Accept:
application/soap+xml” with corresponding entity body in the request.

DELETE No requirement; all DELETE requests can be discovered.

l For RESTful APIs: the last sub-path should not include the dot (.) character. SOAP API supports including the dot
(.) in the last sub-path.

l For OpenAPI 3.0: servers and paths are required in the OAS file.
l For Swagger 2.0: host, paths & schemes are required in the OAS file.

API endpoint parameters

The API Discovery engine parses through raw API data to extract information that make up an API endpoint. Parameters
can be parsed from the key elements of an API, which refers to HTTP/HTTPS, Host, Path, and Parameters. Further
information can be parsed from the classification or labels of parameters, PII and schema.

Parameters can be parsed from the following API information:

Source Parsed parameters

HTTP query request Parameters can be parsed from the HTTP query request.
For example:
/query?username=admin&password=test
l username = admin
l password = test
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Source Parsed parameters

Elements or keys in the entity
body

For JSON API type, API Discovery parses up to 1 layer.
For XML/SOAP API type, API Discovery parses up to 2 or 3 layers:
l If sub-elements have the same name, the schema of the elements will be
recognized as an "array", and 3 layers of the nested parameters will be
parsed.

l Otherwise, the parameters will be treated as an object, and only 2 layers of
the nested parameters will be parsed.

Classification or labels of
parameters

l Position— requestBody, responseBody, query, path (for external API
endpoints)

l Position (“in”) — query, path, header or cookie (for internal API endpoints)
l Required— the reorganized parameter {api_id} will be labeled as
“required” (for external API endpoints); labeled if "required“ is true in files (for
internal API endpoints)

l Source— external for API endpoints parsed from Automatic discovery, and
internal for imported OAS files

l Description— added automatically for the template parameter (for external
API endpoints); defined in the file (for internal API endpoints)
Note: Maximum supported description length is 2048 characters.

PII (Personal Identifiable
Information)

l Scan name—Username, Password, Token
l Scan value— Credit Card Number, Email, URL, IP Address, GUID
l Scan name & value—CVV

Schema of parameters String, number, integer, Boolean, object, array

Bot Mitigation

TheWeb Application Firewall > Bot Mitigation sub-menu includes the following:

l Configuring a Bot Detection policy on page 625
l Configuring a Threshold Based Detection policy on page 627
l Configuring a Biometrics Based Detection policy on page 632
l Configuring a Fingerprint Based Detection policy on page 634

Configuring a Bot Detection policy

Bot detection policies use signatures and source behavior tracking to detect client traffic likely to be generated by robots
instead of genuine clients. Some bots, such as search engine crawlers, are "good bots" that perform search indexing
tasks that can result in more legitimate users being directed to your site. You enable a allowlist to permit those. "Bad
bots" are known to send traffic that has an negative impact on site availability and integrity, such as DDoS attacks or
content scrapping. You want to block these.

FortiADC Handbook 625
Fortinet Technologies Inc.



Web Application Firewall

To get started, you can use predefined allowlists (known good bots) and blocklists (known bad bots). You can also
specify a rate limit threshold of HTTP requests/second for sources not matched to either allowlist or blocklist. The rate
limit threshold can be useful in detecting "unknown bots".

In the event of false positives, you can use the user-specified allowlist table to fine-tune detection.

Before you begin:

l You must configure the connection to FortiGuard so the system can receive periodic WAF Signature Database
updates, including "good bot" and "bad bot" signatures and lists. See Configuring FortiGuard service settings.

l You must have Read-Write permission for Security settings.

After you have configured Bot Detection policies, you can select them in WAF profiles.

To configure a Bot Detection policy:

1. Go toWeb Application Firewall > Bot Detection.
2. In the Bot Detection tab, click Create New to display the configuration editor.
3. Complete the configuration as described in Bot Detection configuration on page 626.
4. Save the configuration.

Settings Guidelines

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces.
After you initially save the configuration, you cannot edit the name.

Status Enable/disable Bot detection.

Search Engine Bypass Enable/disable the predefined search engine spider allowlist. The list is included in
WAF signature updates from FortiGuard.

Search Engine List Set list of search engines. Default value is all search engines.

Bad Robot Status Enable/disable the predefined bad robot blocklist. The list is included in WAF
signature updates from FortiGuard.

HTTP Request Rate Specify a threshold (HTTP requests/second/source) to trigger the action. Bots send
HTTP request traffic at extraordinarily high rates. The source is tracked by source IP
address and User-Agent.
The default is 0 (off). The valid range is 0-100,000,000 requests per second.

Action Select the action profile that you want to apply. See Configuring WAF Action objects
on page 546.
The default is alert.

Severity l High—Log as high severity events.
l Medium—Log as a medium severity events.
l Low—Log as low severity events.

The default is low.

Allowlist

Bot Detection configuration
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Settings Guidelines

IPv4/Netmask Matching subnet (CIDR format).

URL Pattern Matching string. Regular expressions are supported.

URL Parameter Name Matching string. Regular expressions are supported.

Cookie Name Matching string. Regular expressions are supported.

User Agent Matching string. Regular expressions are supported.

Configuring a Threshold Based Detection policy

Using Threshold Based Detection policies, FortiADC can determine whether requests are generated by robots instead of
a human by detecting suspicious behavior patterns that exceed the normal threshold defined in the policy. Threshold
Based Detection rules are defined by the number of times a type of behavior is allowed to occur within a specified
amount of time. Once the number of occurrence exceeds the defined threshold value, an action is triggered in response
to detecting the suspicious behavior.

FortiADC supports the following three types of Threshold Based Detection:

l Crawler Detection— Detects web crawlers that are usually used to map out your application structure by monitoring
the frequency of HTTP response codes. If the occurrence of a specified HTTP response code exceeds the
allowable threshold in the specified time frame, FortiADC will execute the relevant action for the traffic.

l Content Detection— Detects malicious tools that try to download large amounts of content such as text/HTML and
application/ XML from your website by monitoring the frequency of download activities. If the occurrence of the
download activity exceeds the allowable threshold within the specified time frame, FortiADC will execute the
relevant action for the traffic.

l Attack Detection— Detects suspicious attack behavior patterns indicative of a bot attack by monitoring the
frequency of attacks detected in specific WAF Attack modules. If the occurrence of specific attacks exceeds the
allowable threshold within the specified time frame, FortiADC will execute the relevant action for the traffic.

FortiADC offers Predefined Threshold Based Detection policy configurations on page 630 that can be applied as is or
used as a template for customization.

After you have configured Threshold Based Detection policies, you can select them in WAF profiles.

Before you begin:

l You must have Read-Write permission for Security settings.

To configure a Threshold Based Detection policy:

1. Go toWeb Application Firewall > Threshold Based Detection.
2. In the Threshold Based Detection tab, click Create New to display the configuration editor.
3. Configure the following Biometrics Based Detection settings:

Setting Description

Name Specify a name for the Threshold Based
Detection rule. Valid characters are A-Z, a-z,
0-9, _, and -. No spaces.
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Setting Description

The configuration name cannot be edited once
it has been saved.

Comments Optionally, enter comments about the
Threshold Based Detection policy.

Crawler Detection

Crawler Status Enable/Disable Crawler Detection. This is
disabled by default.

Response Code Specify the 3 digit HTTP response code(s) to
check. Enter as a single code (e.g. 403),
multiple codes (e.g. 403,404), or as a range
(e.g. 500-503). Range: 100-599.

Crawler Action Select the action profile to apply when a web
crawler bot is detected. See Configuring WAF
Action objects on page 546.
The default action is alert.

Crawler Severity Select the event severity to log when a web
crawler bot is detected:
l High— Log as high severity events.
l Medium— Log as a medium severity
events.

l Low— Log as low severity events.
The default is low.

Crawler Occurrence Limit Specify the maximum number of responses
that can be received from the specified
Response Code within the time frame (set in
Crawler Occurrence Within). If the limit is
exceeded, the specified Crawler Action will
be triggered. Default: 100, Range: 1-100000.

Crawler OccurrenceWithin Specify the time span during which to count
how many times a response is received from
the specified Response Code. Default: 60
seconds, Range: 1-600 seconds.

Content Detection

Content Scraping Status Enable/disable Content Detection. This is
disabled by default.

Content Type Select one or more content type to monitor for
content scraping:
l Text/HTML
l Text/Plain
l Text/XML
l Application/XML
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Setting Description

l Application/Soap+XML
l Application/JSON

Content Action Select the action profile to apply when a
content scraping bot is detected. See
Configuring WAF Action objects on page 546.
The default action is alert.

Content Severity Select the event severity to log when a content
scraping bot is detected:
l High— Log as high severity events.
l Medium— Log as a medium severity
events.

l Low— Log as low severity events.
The default is low.

Content Occurrence Limit Specify the maximum number of responses
that can be received from the specified
Content Type within the time frame (set in
Content Occurrence Within). If the limit is
exceeded, the specified Content Action will
be triggered. Default: 100, Range: 1-100000.

Content OccurrenceWithin Specify the time span during which to count
how many times a response is received from
the specified Content Type. Default: 60
seconds, Range: 1-600 seconds.

Attack Detection

Attack Detection Status Enable/disable Attack Detection. This is
disabled by default.

Attack Modules Select one or more attack modules to monitor
for bot attacks:
l Web Attack Signature
l Input Validation
l Brute Force Attack Detection
l URL Protection
l HTTP Protocol Constraint
l Credential Stuffing Defense

Click Advanced to expand the selection list:
l Data Leak Prevention
l SQL/XSS Injection Detection
l Cookie Security
l CSRF Protection
l CORS Protection
l JSON Validation
l OpenAPI Validation
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Setting Description

l XML Protection
l API Gateway

Attack Action Select the action profile to apply when a bot
attack is detected. See Configuring WAF
Action objects on page 546.
The default action is alert.

Attack Severity Select the event severity to log when a bot
attack is detected:
l High— Log as high severity events.
l Medium— Log as a medium severity
events.

l Low— Log as low severity events.
The default is Low.

Attack Occurrence Limit Specify the maximum number of responses
that can be received from the specified Attack
Module within the time frame (set in Attack
Occurrence Within). If the limit is exceeded,
the specified Attack Action will be triggered.
Default: 100, Range: 1-100000.

Attack OccurrenceWithin Specify the time span during which to count
how many times a response is received from
the specified Attack Module. Default: 60
seconds, Range: 1-600 seconds.

4. Click Save.
The newly configured Threshold Based Detection policy is added to the Threshold Based Detection page.

Predefined Threshold Based Detection policy configurations

You can apply any of the predefined Threshold Based Detection policies in WAF profiles or you can clone a predefined
configuration to use as a template to define your own policy.

Name Comments Predefined settings

Bot_Detect Detect suspicious bot with
CAPTCHA action

Crawler Status — Enabled
Response Code— 403,404
Crawler Action— captcha
Crawler Severity —Medium
Crawler Occurrence Limit — 100
Crawler OccurrenceWithin — 60 (seconds)
Content Scraping Status — Enabled
Content Type— Text/HTML, Text/Plain, Text/XML,
Application/XML, Application/Soap+XML,
Application/JSON
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Name Comments Predefined settings

Content Action— captcha
Content Severity —Medium
Content Occurrence Limit — 100
Content OccurrenceWithin — 60 (seconds)
Attack Detection Status — Enabled
Attack Modules—Web Attack Signature, Input
Validation, Brute Force Attack Detection, URL Protection,
HTTP Protocol Constraint, Credential Stuffing Defense
Attack Action— captcha
Attack Severity —Medium
Attack Occurrence Limit — 100
Attack OccurrenceWithin — 60 (seconds)

Content_Scraping_
Detect

Monitor the frequency of illegal
content scraping with ALERT
action

Crawler Status — Disabled
Content Scraping Status — Enabled
Content Type— Text/HTML, Text/Plain, Text/XML,
Application/XML, Application/Soap+XML,
Application/JSON
Content Action— alert
Content Severity — Low
Content Occurrence Limit — 100
Content OccurrenceWithin — 60 (seconds)
Attack Detection Status — Disabled

Crawler_Detect Monitor the frequency of 403 and
404 response codes with ALERT
action

Crawler Status — Enabled
Response Code— 403,404
Crawler Action— alert
Crawler Severity — Low
Crawler Occurrence Limit — 100
Crawler OccurrenceWithin — 60 (seconds)
Content Scraping Status — Disabled
Attack Detection Status — Disabled

High-Level-Security Block all suspicious threshold
violations

Crawler Status — Enabled
Response Code— 403,404
Crawler Action— deny
Crawler Severity — High
Crawler Occurrence Limit — 100
Crawler OccurrenceWithin — 60 (seconds)
Content Scraping Status — Enabled
Content Type— Text/HTML, Text/Plain, Text/XML,
Application/XML, Application/Soap+XML,
Application/JSON
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Name Comments Predefined settings

Content Action— deny
Content Severity — High
Content Occurrence Limit — 100
Content OccurrenceWithin — 60 (seconds)
Attack Detection Status — Enabled
Attack Modules—Web Attack Signature, Input
Validation, Brute Force Attack Detection, URL Protection,
HTTP Protocol Constraint, Credential Stuffing Defense
l Advanced—Data Leak Prevention, SQL/XSS
Injection Detection, Cookie Security, CSRF
Protection, CORS Protection, JSON Validation,
OpenAPI Validation, XML Protection, API Gateway

Attack Action— deny
Attack Severity — High
Attack Occurrence Limit — 100
Attack OccurrenceWithin — 60 (seconds)

Illegal_User_Detect Detect illegal user with
CAPTCHA action

Crawler Status — Disabled
Content Scraping Status — Disabled
Attack Detection Status — Enabled
Attack Modules— Brute Force Attack Detection,
Credential Stuffing Defense
Attack Action— captcha
Attack Severity —Medium
Attack Occurrence Limit — 100
Attack OccurrenceWithin — 60 (seconds)

Vulnerability_Scan Monitor the frequency of web
attack signature violations with
CAPTCHA action

Crawler Status — Disabled
Content Scraping Status — Disabled
Attack Detection Status — Enabled
Attack Modules—Web Attack Signature
Attack Action— captcha
Attack Severity —Medium
Attack Occurrence Limit — 100
Attack OccurrenceWithin — 60 (seconds)

Configuring a Biometrics Based Detection policy

Using Biometrics Based Detection policies, FortiADC can determine whether requests are generated by robots instead
of a human by checking client events within a specified period. With JavaScript enabled on the client browser, FortiADC
can collect behavioral biometrics (such as mouse movement, keyboard, screen touch, and scroll) and monitor as client
events for a specified period. FortiADC can then determine whether the behavioral biometrics from the request is
indicative of a bot or a human.

After you have configured Biometrics Based Detection policies, you can select them in WAF profiles.
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Before you begin:

l You must have Read-Write permission for Security settings.

To configure a Biometrics Based Detection policy:

1. Go toWeb Application Firewall > Biometrics Based Detection.
2. In the Biometrics Based Detection tab, click Create New to display the configuration editor.
3. Configure the following Biometrics Based Detection settings:

Setting Description

Name Specify a name for the Biometrics Based Detection rule. Valid characters are
A-Z, a-z, 0-9, _, and -. No spaces.
The configuration name cannot be edited once it has been saved.

Ignore JS Check Enable/disable redirect to a warning page to enable JavaScript. This is
disabled by default.
l Disable — FortiADC will check if JavaScript is enabled on the client
browser. If JavaScript is not enabled, then FortiADC will redirect to a
warning page to let the user enable JavaScript. If the client does not
enable JavaScript within 10 seconds, the traffic may be recognized as a
bad bot.

l Enable — FortiADC will not check if JavaScript is enabled on the client
browser. If JavaScript is enabled on the client browser, events can be
collected normally and FortiADC can determine if it is a bot or not. But if
JavaScript is disabled on the client browser, the client will be recognized
as a bot after the Event Collection Time, since events cannot be collected
by FortiADC.

Monitor Client Events Select one or more client events to monitor:
l Mouse Movement
l Click
l Keyboard
l Screen Touch
l Scroll

By default, Mouse Movement, Click, and Keyboard are preselected. If the
configuration is saved with no Monitor Client Events selected, it will default to
the preselected client events.

Event Collection Time Specify for how long the events will be collected from the client. Default: 60
Range: 10-3600 seconds.

Bot Effective Time Specify the time interval before FortiADC tests and verifies a bot again, once a
bot has been detected. Default: 5 Range: 1-60 minute(s).

JS Request URL Specify the URL to use to insert JavaScript code to the client browser. Default:
/fadc_client/default_index.js.

Action Specify a WAF action object to apply when a bot is detected. See Configuring
WAF Action objects on page 546.
The default action is alert.
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Setting Description

Severity Select the event severity to log when a bot is detected:
l High— Log as high severity events.
l Medium— Log as a medium severity events.
l Low— Log as low severity events.

The default is Low.

Exception Name Select an exception configuration object. Exceptions identify specific hosts or
URL patterns that are not subject to processing by this rule.

4. Click Save.
Once the configuration is saved, the URL List becomes configurable. The Biometrics Based Detection policy will be
applied to the request URLs in the URL List.

5. Under the URL List section, click Create New to display the configuration editor.
6. Configure the following URL List settings:

Setting Description

Host Status If enabled, require authorization only for the specified host. If disabled, ignore
hostname in the HTTP request header and require authorization for requests
with any Host header. Disabled by default.

Host The Host option is available if Host Status is enabled.
Specify the HTTP Host header. If Host Status is enabled, the policy matches
only if the Host header matches this value. Complete, exact matching is
required. For example, www.example.commatches www.example.com but
not www.example.com.hk.

Request URL The literal URL, such as /index.php, or a regular expression, such as
^/*.php that the HTTP request must contain in order to match the rule.
Multiple URLs are supported.

7. Click Save.
Once the URL List configuration is saved, you are returned to the Biometrics Based Detection configuration editor.

8. Click Save again to apply the newly created URL List configuration to the Biometrics Based Detection configuration.

Configuring a Fingerprint Based Detection policy

Fingerprint Based Detection detects the client's fingerprint using multiple characteristics to ascertain whether an access
request originates from a human or a bot. Using the Fingerprint Based Detection policy, FortiADC collects and monitors
the behavioral fingerprint information, such as WebDriver, WindowsProperties and MimeTypesConsistent, with
JavaScript enabled on the client browser. The collected information forms the client fingerprint that is then checked
against known automation tools and frameworks to determine whether the requests are generated by automation tools
such as Headless Chrome, Selenium or Electron.

After you have configured Fingerprint Based Detection policies, you can select them in WAF profiles.

Before you begin:

l You must have Read-Write permission for Security settings.
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To configure a Fingerprint Based Detection policy:

1. Go toWeb Application Firewall > Fingerprint Based Detection.
2. In the Fingerprint Based Detection tab, click Create New to display the configuration editor.

3. Configure the following Fingerprint Based Detection settings:

Setting Description

Name Specify a name for the Fingerprint Based Detection rule. Valid characters are
A-Z, a-z, 0-9, _, and -. No spaces.
The configuration name cannot be edited once it has been saved.

Ignore JS Check Enable/disable redirect to a warning page to enable JavaScript. This is
disabled by default.
l Disable — FortiADC will check if JavaScript is enabled on the client
browser. If JavaScript is not enabled, then FortiADC will redirect to a
warning page to let the user enable JavaScript. If the client does not
enable JavaScript, Fingerprint Based Detection cannot be activated.

l Enable — FortiADC will not check if JavaScript is enabled on the client
browser. If JavaScript is enabled on the client browser, behavioral
fingerprint information can be collected normally and FortiADC can
determine if it is a bot or not. But if JavaScript is disabled on the client
browser, Fingerprint Based Detection cannot be activated.

Fingerprint Detectors Select one or more fingerprint detectors:
l chrome_headless— Headless Chrome
l selenium—Selenium
l electron— Electron
l others — includes SlimerJS and CefSharp

All fingerprint detectors are preselected by default. If the configuration is saved
with no Fingerprint Detectors selected, it will default to the preselected.

Bot Effective Time Specify the time interval before FortiADC tests and verifies a bot again, once a
bot has been detected. Default: 5 Range: 1-60 minute(s).

JS Request URL Specify the URL to use to insert JavaScript code to the client browser. Default:
/fadc_client/fp_detect.js.
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Setting Description

Action Specify a WAF action object to apply when a bot is detected. See Configuring
WAF Action objects on page 546.
The default action is alert.

Severity Select the event severity to log when a bot is detected:
l High— Log as high severity events.
l Medium— Log as a medium severity events.
l Low— Log as low severity events.

The default is Low.

Exception Name Select an exception configuration object. Exceptions identify specific hosts or
URL patterns that are not subject to processing by this rule.

4. Click Save.
Once the configuration is saved, the URL List becomes configurable. The Fingerprint Based Detection policy will
be applied to the request URLs in the URL List.

5. Under the URL List section, click Create New to display the configuration editor.
6. Configure the following URL List settings:

Setting Description

Host Status If enabled, require authorization only for the specified host. If disabled, ignore
hostname in the HTTP request header and require authorization for requests
with any Host header. Disabled by default.

Host The Host option is available if Host Status is enabled.
Specify the HTTP Host header. If Host Status is enabled, the policy matches
only if the Host header matches this value. Complete, exact matching is
required. For example, www.example.commatches www.example.com but
not www.example.com.hk.

Request URL The literal URL, such as /index.php, or a regular expression, such as
^/*.php that the HTTP request must contain in order to match the rule.
Multiple URLs are supported.

7. Click Save.
Once the URL List configuration is saved, you are returned to the Fingerprint Based Detection configuration editor.

8. Click Save again to apply the newly created URL List configuration to the Fingerprint Based Detection configuration.

Once the Fingerprint Based Detection policy is saved, you can apply it to the WAF profile.

Web Vulnerability Scanner

From theWeb Application Firewall > Web Vulnerability Scanner sub-menu, you can access a set of automated tools
which perform black box test on web applications, to look for security vulnerabilities such as Cross-site scripting, SQL
injection, command injection, source code disclosure and insecure server configuration.
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Scanner

The figure shows the plug-in of the scanner which is configurable in UI/CLI. The user can select which type of
vulnerabilities included in each scan. There are 5 types of signatures in our scanner:

1. Themime signatures warn about server responses that have an interesting mime. For example anything that is
presented as php-source will likely be interesting

2. The files signatures will use the content to determine if a response is an interesting file. For example, a SVN file.
3. Themessages signatures look for interesting server messages. Most are based on errors, such as caused by

incorrect SQL queries or PHP execution failures.
4. The apps signatures will help to find pages and applications who's functionality is a security risk by default. For

example, phpinfo() pages that leak information or CMS admin interfaces.
5. The context signatures are linked to injection tests. They look for strings that are relevant to the current injection

test and help to highlight potential vulnerabilities.

A report will be generated after a web vulnerability scan is completed. FortiADC will generate a WAF profile based on the
results of the scan report. For example, if the scan report detects an SQL injection vulnerability, a WAF profile containing
SQL/XSS Injection Detection settings will be generated and attached to the VIP to protect servers behind VS.

WVS Task

Configuring WVS Task

1. Go toWeb Application Firewall > Web Vulnerability Scanner

2. By default you will end up on theWVS Task tab.

3. Click Create New on the top right. It will open a dialogue box. See the figure WVS Task dialogue below.

4. Complete the configuration as described the table below.

5. Save the configuration.

6. Choose the WVS Task to be scanned by clicking the diamond in the row. It will turn into a square as it scans, and the
Task Status will read "Scanning..." or "In Queue" or "Stopped." See the figure Run/Stop below.

7. A report will be generated andWVS Tool will summarize the results in HTML format, zip and store in HD. See Scan
History on page 641
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Notes

l Only one task can run at the same time. If multiple tasks are started, others are added to task queue to wait to run.
See the figure Status below.

l If a task is already running it can't be trigger again.
l WVS-task only works for ipv4 pool. ipv6 is not supported.
l It will send a scan according to the pool member port.
l If pool member health-check fails, it will still try to send scan.
l It will not send a scan when: 

l there's no pool member.
l pool member port is 0.
l pool member status is disable/maintain

l The tasks are limited to 50.
l It does not support HTTP2
l In HA, only the primary can start the scanning; it will be triggered only if it is primary.
l Crawl limit. If, in one task, the refer pool contains multiple real servers, the crawl limits will be dispatched to all the
real servers. For example, if the crawl limit is 3000, with 3 servers, the ADC will send 1000 requests to each server.

Settings Guidelines

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces.
After you initially save the configuration, you cannot edit the name.

Scheduler Select a scheduler from the schedule group. To configure a scheduler, go to Shared
Resources > Schedule Group. See Schedule Group on page 313

Profile Select a profile. Profiles are configured underWVS Profile, the tab to the right of WVS task.
See Configuring a WVS Profile on page 639

WVS Task configuration

WVS Task Dialogue

Settings Guidelines

Name Name of the task

Task Action Square—Task Status "Scanning..." in process. This task is being scanned.
Blank—Task Status "In Queue," waiting to be scanned.

WVS Task dashboard
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Settings Guidelines

Diamond—Task Status "Stopped."

Report Created Time Time the task was created.

Edit
Delete
Clone

Run/Stop WVS-task

Scan Profile

Under the Web Vulnerability Scanner sub-menu, the Scan Profile page contains the features that allow you to configure
WVS settings:

l Configuring a WVS Profile on page 639
l Configuring a WVS Login on page 640
l Configuring WVS Exceptions on page 641

Configuring a WVS Profile

Creates a WVS Profile that can be selected in Web Vulnerability Scanner on page 636It gives you the option to select
which types of scans you want.

To configure a WVS Profile:

1. Go toWeb Application Firewall > Web Vulnerability Scanner

2. Select theWVS Profile tab.

3. Click Create New on the top right. It will open a dialogue box.

4. Complete the configuration as described the table below.

5. Save the configuration.

6. The configured profile will appear as an option in the WVS Task dialogue box.

WVS Profile dialogue box
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Settings Guidelines

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces.
After you initially save the configuration, you cannot edit the name.

Real Server Pool Select a real sever from the real server pool. To configure a scheduler, you have two options.
You can create it from the WVS profile dialogue, or you can go to Server Load Balance
> Real Server Pool. See Using real server pools on page 448

HTTP Login Option Select an HTTP Login Option. Configure a login option in Configuring a WVS Login on page
640

Mime Scan
File Scan
Message Scan
Apps Scan
Context Scan

You have five scan options. SeeWeb Vulnerability Scanner on page 636

HTTP Cookie Enable HTTP Cookie in Web Vulnerability Scanner profile.

Crawl Limit Specify a crawl limit.

WVS Exceptions Specify a WVS Exception. See Configuring WVS Exceptions on page 641.

WVS Profile configuration

Configuring a WVS Login

To configure a WVS Login:

1. Go toWeb Application Firewall > Web Vulnerability Scanner > Scan Profile. Select theWVS Login tab.
2. Click Create New on the top right. It will open a dialogue box.
3. Save the configuration.

The Login option will now appear in WVS Profile's dialogue box, under HTTP Login Option.
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Settings Guidelines

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces.
After you initially save the configuration, you cannot edit the name.

Login Method

None Nothing to specify.

Basic Username—Specify a username for the login.
Password—Specify a password for the login.

Advanced Username—Specify a username for the login.
Password—Specify a password for the login.
Auth URL—The full URL in POST for authentication.
Auth Target URL—The URL used to POST the form.
Auth Verify URL—Used to verify if the username and password authentication failed.
Username Field—Field name of the username.
Password Field—Field name of the password.
Extend Parameter—Extend the parameter for login.

WVS Login configuration

Configuring WVS Exceptions

Creates a WVS Exception that can be selected in Web Vulnerability Scanner on page 636

To configure a WVS Exception:

1. Go toWeb Application Firewall > Web Vulnerability Scanner > Scan Profile

2. Select theWVS Exceptions tab.

3. Click Create New on the top right. It will open a dialogue box.

4. Complete the configuration as described the table below.

5. Save the configuration.

Settings Guidelines

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces.
After you initially save the configuration, you cannot edit the name.

Full URL Pattern The REGEX pattern used for the exception.

WVS Exceptions configuration

Scan History

After the scan is completed, the report is displayed on Scan History page.
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Settings Guidelines

Name Name of the task.

Created Time Time the report was created.

On the far right.
l Download the report. It can be imported in Scan Integration. See Scan Integration on
page 643.

l Delete the report.
l Preview the report.
l Generate Policy. See Generating Automatic Policy.

Add Filter Add Filter—Sort by Name, Created Time

WVS Report

Generating Automatic Policy

By analyzing the scan results in the imported report, FortiADC automatically generates a WAF profile to prevent the
reported attacks. In the Automatic Policy, you will required to specify the name of the generated WAF profile and the
actions to be taken upon the attacks.

To edit the Automatic Policy:

1. InWeb Application Firewall > Web Vulnerability Scanner > Scan History, find the desired report in the table,

click the Icon to edit the Automatic Policy.
2. Configure the following settings.

Generate Policies
Automatically

If enabled, FortiADC will automatically generate an Automatic Policy and
update it every time it runs the web vulnerability scan.

Merge the Report to Existing
Profile

If disabled, FortiADC generates a newWAF profile based on the scan results.
If enabled, the WAF settings based on the scan results will be merged to an
existing WAF profile. If there are conflict settings, the new ones will overwrite
the existing ones.

Profile Name Enter a name for the newly generated WAF profile, and select an existing WAF
profile.

Action - High Select the action that FortiADC will take if High severity attacks are detected.

Action - Medium Select the action that FortiADC will take if Medium severity attacks are
detected.

Action - Low Select the action that FortiADC will take if Low severity attacks are detected.

3. Click Save.

After the auto policy is saved, you can view it on Scan Integration. See Scan Integration.
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Scan Integration

FortiADC generates a WAF profile based on the results of the scan report. For example, if the scan report detects an
SQL injection vulnerability, a WAF profile containing SQL/XSS Injection Detection settings will be generated and
attached to the VIP to protect servers behind VS.

The Automatic Policy contains the automatically generated WAF profile and specify the actions to be taken on the
attacks. It is displayed on Scan Integration page.

You can also manually generate an Automatic Policy by importing a scan report . FortiADC supports scan reports from
the following products:

l Acunetix
l IBM AppScan Standard
l WhiteHat
l HPWebInspect
l Qualys
l Telefonica FAAST
l ImmuniWeb
l FortiWeb
l FortiADC

To import a scan report:

1. Go toWeb Application Firewall > Web Vulnerability Scanner > Scan Integration.
2. Click Scanner File Import.
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3. Configure the following settings.

Scanner Type Select the type of scanner report you want to import.
l Acunetix
l IBM AppScan Standard
l WhiteHat
l HPWebInspect
l Qualys
l Telefonica FAAST
l ImmuniWeb
l FortiWeb Scanner
l FortiADC Scanner
Some types of reports have specific requirements. For details, see WhiteHat
Sentinel scanner report requirements, Telefónica FAAST scanner report
requirements, and HPWebInspect scanner report requirements.

Upload File Upload the scanner report file.

Generate Policies
Automatically

This is by default enabled.
If disabled, FortiADC will not generate an Automatic Policy the next time it runs
Web Vulnerability Scan.

Merge the Report to Existing
Profile

If disabled, FortiADC generates a newWAF profile based on the scan results.
If enabled, the WAF settings based on the scan results will be merged to an
existing WAF profile. If there are conflict settings, the new ones will overwrite
the existing ones.

Profile Name Enter a name for the newly generated WAF profile, and select an existing WAF
profile.

Action - High Select the action that FortiADC will take if High severity attacks are detected.

Action - Medium Select the action that FortiADC will take if Medium severity attacks are
detected.

Action - Low Select the action that FortiADC will take if Low severity attacks are detected.

4. Click Save.

WhiteHat Sentinel scanner report requirements

To allow [[[Undefined variable FortiWebVariables.FortiWeb]]] to generate rules using a WhiteHat Sentinel scanner
report, ensure that the parameters “display_vulnerabilities” and “display_description” are enabled when you run the
scan.

You can upload aWhiteHat Sentinel scanner report using either a report file you have downloaded manually or directly
import the file from the WhiteHat portal using the RESTful API. Importing a scanner file from the WhiteHat portal requires
the API key and application name that WhiteHat provides.

To retrieve the WhiteHat API key and application name

1. Go to the following location and log in:
https://source.whitehatsec.com/summary.html#dashboard

2. In the top right corner, clickMy Profile.
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3. Click View My API Key and enter your password.
Your API key is displayed. For example:

4. To view the application name, navigate to the Assets tab. The application name is the NAME value. For example:

Telefónica FAAST scanner report requirements

You can upload a Telefónica FAAST scanner report using either a report file you have downloaded manually or directly
import the file from the Telefónica FAAST portal using the RESTful API. Importing a scanner file from the Telefónica
FAAST portal requires the API key that Telefónica FAAST provides. One Telefónica FAAST scanner account can apply
for an API key.

To apply for a Telefónica FAAST API key

1. Go to the following location and log in:
https://cybersecurity.telefonica.com/vulnerabilities/es/api_docs

2. In the session : Authentication page, please select POST > api/session for the method, and fill in the blanks for
username and password. Then click Try it out.
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3. The API key will be gave in the Response Body if the username and password are authorized.

HP WebInspect scanner report requirements

To generate rules from HPWebInspect, when you export the report, for the Details option, select either Full or
Vulnerabilities.
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Web Anti-Defacement

TheWeb Anti-Defacement feature examines a website’s files for changes at specified time intervals. If it detects a
change that could indicate a defacement attack, it will notify you and quickly react by automatically restoring the website
contents to the previous backup.

To configure a Web Anti-Defacement policy:

1. Go toWeb Application Firewall> Web Anti-Defacement.
2. Click Create New to display the configuration editor.
3. Complete the configuration.
4. Click Test Connection to test the connection between the FortiADC and the web server.
5. Save the configuration.

Settings Guidelines

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces. After
you initially save the configuration, you cannot edit the name.

Description A string to describe the purpose of the configuration, to help you and other
administrators more easily identify its use.

Monitor Enable/Disable to monitor the website’s files for changes, and to download
backup revisions for reverting the website to its previous revision.

Host Name/IP Address Type the IP address or FQDN of the web server.

Connection Type Select which protocol to use when connecting to the website in order to monitor its
contents and download website backups.
l FTP
l SSH

Port Enter the TCP port number on which the website’s real server listens. The
standard port number for FTP is 21; the standard port number for SSH is 22. The
valid range is 1 to 65535.

Folder of Web Site Type the path to the website’s folder, such as public_html or wwwroot, on the real
server. The path is relative to the initial location when logging in with the user
name that you specify in Username.

Username Enter the user name that the FortiADC will use to log in to the website’s real
server.

Password Enter the password for the username you entered

Monitor Interval for Root Folder Enter the time interval in seconds between each monitoring connection from the
FortiADC to the web server. During this connection, the FortiADC examines
Folder of Web Site(but not its subfolders) to see if any files have changed by
comparing the files with the latest backup. If it detects any file changes, FortiADC
will download a new backup revision. If you have enabled Restore in Automatic
Action, FortiADC will revert the files to their previous version.
The valid range is 1 to 86400 seconds and default value is 600 seconds.
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Settings Guidelines

Moniter Interval for Other Folder Enter the time interval in seconds between each monitoring connection from the
FortiADC to the web server. During this connection, the FortiADC examines
subfolders to see if any files have been changed by comparing the files with the
latest backup.
If it detects any file changes, the FortiADC will download a new backup revision. If
you have enabled Restore in Automatic Action, FortiADC will revert the files to
their previous version.
The valid range is 1 to 86400 seconds and default value is 600 seconds.

Skip Files Larger Than Type a file size limit in kilobytes (KB) to indicate which files will be included in the
website backup. Files exceeding this size will not be backed up. The valid range is
1 to 102400 KB and the default file size limit is 10240 KB.
Note: Backing up large files can impact performance.

Skip Files with these Extensions Type zero or more file extensions, such as iso, avi, to exclude from the website
backup. Separate each file extension with a comma.
Note: Backing up large files, such as video and audio, can impact performance.

Automatic Action Select to decide which action will be excuted when the FortiADC detects file
changes.
l Disable - Accept changes and record the change in “Total Changed” table
when FortiADC detects that the web site has been changed. You can
manually restore the web site to a previous revision.

l Acknowledge - Automatically accept changes to the web site when FortiADC
detects that the web site has been changed

l Restore - Enable to automatically restore the web site to the previous
revision number when FortiADC detects that the website has been changed.

Accepting or reverting changed files

The anti-defacement feature maintains a list of files that have changed for each website it monitors. You can use this list
to review, accept, and revert the changes.

To restore all the website files, use Automatic Action - Restore.

Alternatively, to automatically acknowledge all changes to files (for example, if you are updating the website), use
Automatic Action - Acknowledge.

To accept or revert changed files:

1. Go toWeb Application Firewall > Web Anti-Defacement. For the appropriate website, click the value in the Total
Changed column.

2. Do one of the following:
a. Select an item in the list, and then click the Acknowledge icon to accept the individual change. FortiADC clears

the item from the list.
b. Select an item in the list, and then click the Revert to icon. In the list of previous versions, click the Revert to this

version icon for the version to revert to. FortiADC adds this revert action as a new version in the list.
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Advanced Bot Protection (ABP)

FortiGuard ABP (Advanced Bot Protection) is a Fortinet SaaS advanced bot mitigation solution designed to detect and
mitigate sophisticated bots that may be used to conduct malicious attacks on online applications, including data
scraping, credential stuffing, DDoS attacks, and fraudulent activities. To safeguard your digital assets, websites, and
applications, FortiGuard Advanced Bot Protection employs advanced deep learning algorithms and behavior analysis to
identify and block suspicious activities. It analyzes user behavior patterns, device fingerprints, and more to distinguish
between genuine users and malicious bots.

The FortiGuard ABP integration with FortiADC works by using client information collected by JavaScript insertion, which
allow the client and FortiADC (via Fabric connector) to communicate with the Advanced Bot Protection Cloud for data
telemetry information (such as headers and device fingerprinting). Once FortiADC is connected with FortiGuard ABP,
you can configure an Advanced Bot Protection policy to apply to Web Application Firewall (WAF) profiles and virtual
servers. FortiADC reports the telemetry data to FortiGuard ABP which then inspects the HTTP request to determine if
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the client is human or a bot and sends instructions back to FortiADC to initiate an action against the request (such as
block, CAPTCHA, or allow).

Prerequisites

Before you begin to integrate FortiGuard Advanced Bot Protection and configure Advanced Bot Protection on FortiADC,
you must have the following:

Valid FortiGuard Advanced Bot Protection license

FortiGuard ABP is available on a Standalone license which is a Fortinet Support account based license that is verified by
the FortiGuard ABP User Portal instead of through FortiGuard. For more information, login to
https://fortiabp.forticloud.com/.

Ensure the account used to register for the FortiGuard ABP license matches the account information from your Fortinet
Support Contract. Otherwise, the FortiADC will not be able to connect to FortiGuard ABP.

FortiGuard ABP and Fortinet Support utilize a common account management system, allowing you to log into FortiGuard
ABP directly using the credentials you have registered in your Fortinet Support contract. Upon logging into FortiGuard
ABP with your account, the system will automatically check the validity of your FortiGuard ABP license. This same
authentication process is applied when FortiADC sends requests to the FortiGuard ABP system to verify the account's
validity to determine whether you can successfully enable FortiGuard ABP in FortiADC.

Note: The Fortinet Support Contract information can be found in System > FortiGuard, under the Support Contract
section.
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Supported FortiADC hardware, VM, or cloud platform

l Hardware— All FortiADC hardware models support FortiGuard ABP.
l VM—All FortiADC VM environments support FortiGuard ABP.
l Cloud platform— FortiADC instances on cloud platforms with BYOL support FortiGuard ABP (PAYG FortiADC
instances do not support FortiGuard ABP).

Supported modes in FortiADC

Server Load Balancing:

l Layer 7 HTTP/HTTPS/HTTP2
l Layer 2 HTTP
l SSLi
l WCCP

Decompression must be enabled to support JavaScript insertion, which is critical to
FortiGuard Advanced Bot Protection functionality.
Ensure a Decompression policy is enabled in your HTTP/HTTPS Application Profile
to allow JavaScript to be inserted into compressed HTTP/HTTPS web content. To
increase performance, most websites utilize HTTP compression to reduce the size
of transmitted data. This compressed HTTP/HTTPS content must be decompressed
to allow FortiADC to insert the required JavaScript tag to the HTML. If the real server
response is not compressed, then decompression is unnecessary. However, if the
real server response is compressed then decompression must be enabled,
otherwise the JavaScript will fail to insert.

Virtual Domain:

l ABP global setting is configured in Global view.
l ABP policies are configured per VDOM, and functions at the VDOM level.
l ABP entries are shared by all VDOMs while their status are identified by each VDOM.

High Availability:

l All HA modes supported: Active-Passive, Active-Active, Active-Active-VRRP.
l ABP global settings and policies are synchronized.
l ABP entries are not synchronized.
l ABP global status is not synchronized. If the secondary node fails to connect to the FortiGuard ABP portal, its status
will not be Connected.

Basic configuration

To deploy Advanced Bot Protection on FortiADC, follow the workflow below:

1. On FortiADC, enable the Advanced Bot Protection Fabric Connector to connect FortiADC to the FortiGuard
Advanced Bot Protection server. For details, see Enabling the Advanced Bot Protection connector on page 652.

2. On the FortiGuard Advanced Bot Protection User Portal, obtain the Application ID of an existing FortiGuard ABP
Application or create a new configuration. This Application ID is required to connect the FortiGuard ABP Application
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to the FortiADC Advanced Bot Protection policy. For details, see Obtaining the Application ID from the FortiGuard
ABP User Portal on page 653.

3. Configure a FortiADC Advanced Bot Protection policy. For details, see Configuring an Advanced Bot Protection
policy on page 658.

4. Apply the Advanced Bot Protection policy to a WAF profile. For details, see Configuring a WAF Profile on page 544.
5. Apply the WAF profile that references the Advanced Bot Protection policy to a virtual server to activate Advanced

Bot Protection for server load balancing.

Enabling the Advanced Bot Protection connector

After you have registered your FortiADC as a connector device in FortiGuard ABP, you can connect your FortiADC to the
FortiGuard ABP server via the Fabric connector.

The Advanced Bot Protection connector can only be enabled and disabled, no further configuration is required. Once
enabled and successfully connected, the Advanced Bot Protection module becomes available under the Web
Application Firewall menu in the GUI.

Before you begin:

l You must have a valid FortiGuard Advanced Bot Protection license.
l You must have registered your FortiADC as a connector device in FortiGuard ABP. For details, see Obtaining the
Application ID from the FortiGuard ABP User Portal on page 653.

To enable the Advanced Bot Protection connector:

1. Go to Security Fabric > Fabric Connectors.
2. UnderOther Fortinet Products section, locate the Advanced Bot Protection connector.
3. Enable the Advanced Bot Protection connector. Once the connector is enabled, the connection status will display.

The Advanced Bot Protection connector is ready when the status is Connected.

4. The and icons indicate whether the Advanced Bot Protection connector has successfully connected to the
FortiGuard ABP server. Hover over the Advanced Bot Protection connector to see the status details. The table
below lists the possible connection statuses for the Advanced Bot Protection connector.

Icon ABP connector status Guidelines

Connected The FortiADC is successfully connected to the FortiGuard ABP
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Icon ABP connector status Guidelines

server.

Account license invalid The FortiGuard ABP license is not valid. Please verify your license
details or contact Fortinet Support.

Couldn't connect to server Unable to connect to the FortiGuard ABP server. Please check
your network settings.

Couldn't resolve hostname Unable to resolve the hostname of the FortiGuard ABP server.
Please check your network settings.

No available SN cert The device does not have an available SN certificate. Please
check your local certificate.

No available CA cert The device does not have an available CA certificate. Please
check your CA certificate.

Problem with the local
certificate

An error occurred with the remote server certificate. Please check
your local certificate.

SSL peer certificate or SSH
remote key was not OK

An error occurred with the remote server certificate involving the
SSL peer certificate or SSH remote key. Please check your local
certificate.

Once the Advanced Bot Protection fabric connector is successfully connected, the Advanced Bot Protection module
becomes available under the Web Application Firewall menu in the GUI.

If you want to disable the Advanced Bot Protection connector, the following settings
will be impacted:
l The Advanced Bot Protection module under Web Application Firewall will be
hidden in the GUI.

l Existing ABP policies will be hidden in the GUI. These ABP policies can be seen
and can be deleted through CLI only.

l In the WAF Profile configuration, the Advanced Bot Protection option will not be
available in the GUI. It can only be set through CLI.

Obtaining the Application ID from the FortiGuard ABP User Portal

The FortiADC Advanced Bot Protection policy binds to the FortiGuard ABP Application through its assigned Application
ID to initiate bot detection and protection for the Application. Before you can configure an Advanced Bot Protection
policy, you will need to obtain the Application ID either from an existing Application or create a new configuration in the
FortiGuard ABP User Portal.

When an Application is created, the Application ID is automatically assigned. You can immediately begin to configure
Advanced Bot Protection policies on FortiADC using this Application ID, however, the Advanced Bot Protection
functionality will not activate until the FortiGuard ABP Application is fully analyzed and Pre-Provisioned to protect the
Application. Pre-Provisioning is required to identify all URLs that should be protected in your Application domain (such
as login URLs), and the locations to which JavaScript need to be inserted to collect client information. Without these
resources, FortiADC will not be able to insert the necessary JavaScript for bot detection.
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Pre-Provisioning is triggered upon creating the Application, and requires 2 to 3 days to complete. During this process,
your FortiGuard ABP Application will be in pending status until Pre-Provisioning is complete. When the Application
status is ready, Advanced Bot Protection can be activated in your FortiADC.

Before you begin:

l You must have a valid FortiGuard Advanced Bot Protection license.
l You must have access to the FortiGuard Advanced Bot Protection User Portal.

To obtain the Application ID from the FortiGuard ABP User Portal:

1. Login to FortiGuard Advanced Bot Protection (https://fortiabp.forticloud.com/).
2. Navigate to Application.
3. On the Application page, locate the entry for your FortiADC FortiGuard ABP Application.
4. Under the Application ID column, copy the ID.

To add your application in FortiGuard ABP:

1. Login to FortiGuard Advanced Bot Protection.
2. Navigate to Application.
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3. Click Create New to display the configuration editor.

4. In the Create Application page, configure the following:

5. Setting Description

Domain Name Enter the domain name of your application.
Once this application is added, the domain name cannot be edited.

Location Select the location for your application servers.
FortiGuard Advanced Bot Protection is hosted in both the EU and US regions
of Google Cloud. Opting for a region near your application server can
significantly decrease network latency when FortiGuard Advanced Bot
Protection processes your traffic.
Once this application is added, the location cannot be edited.

Application Name Provide a distinctive name for your application to facilitate easy identification.
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6. Optionally, click Advanced Settings to enter the login URL of your application.

This setting is optional as your domain will be analyzed in the Pre-Provisioning process and the login URLs/Signup
Protection URLs can be automatically identified during this phase. However, you can manually include additional
login URLs and Signup Protection URLs to ensure they are not overlooked in the Pre-Provisioning process.

7. Click Add.
Your application will be listed in the Application page and automatically assigned an Application ID. The Pre-
Provisioning process is initiated once the application is successfully added.
This application will be in pending status until Pre-Provisioning is complete. Once the Application status is ready,
you can configure the Advanced Bot Protection policies in your FortiADC.

FortiGuard ABP Pre-Provisioning

Once you have added your FortiGuard ABP Application, the Pre-Provisioning process begins. This triggers a request to
the Professional Engagement Team (PET) to analyze your application details and to identify URLs to protect and insert
the required JavaScript to enable the Advanced Bot Protection functionality. This process is currently conducted
internally by the PET and requires 2 to 3 days to complete. If you wish to modify or add entries, please submit a request
with Fortinet Support.

When Pre-Provisioning is complete, you can access the information on the protected URL entries and the locations
where JavaScript is inserted for bot protection from the Pre-Provisioning page under the Configurations menu.
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Configuring an Advanced Bot Protection policy

Once your FortiADC is successfully connected to the FortiGuard Advanced Bot Protection server via the Advanced Bot
Protection Fabric Connector, you can configure an Advanced Bot Protection policy for your virtual server to protect your
online applications from malicious bots and automated attacks. By incorporating FortiGuard ABP into FortiADC's server
policy, client traffic will be directed to the FortiGuard ABP service deployed on Google Cloud where it will be analyzed to
identify any malicious bot behavior and initiate appropriate actions in response.

FortiGuard ABP features a multi-dimensional deep learning engine that learns and tracks bot attacks over time,
delivering the highest possible accuracy of classification between humans, and good and bad bots.

FortiGuard ABP protects against a wide range of threats, including the following:

l Data harvesting
l Credential stuffing attacks
l Account takeover attempts
l DDoS attacks
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No. Description

1 User request reaches FortiADC (as Reverse Proxy).

2 FortiADC inserts a JavaScript to the HTTP/S response for telemetric information.
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No. Description

3 The client and FortiADC (via Fabric connector) share telemetry data (such as IP, headers, and device
fingerprinting) with the Advanced Bot Protection engine.

4 Using Deep Learning, FortiGuard ABP determines if the client is a human or a bot.

5 FortiGuard ABP sends instructions back to FortiADC to initiate an action against the request (such as block,
CAPTCHA, or allow).

After you have configured the Advanced Bot Protection policy, you can reference it in a WAF Profile and apply it in a
virtual server policy. However, the Advanced Bot Protection policy does not activate until the FortiGuard ABP Application
is fully analyzed and Pre-Provisioned to protect the Application.

Pre-Provisioning is required to identify all URLs that should be protected in your Application domain (such as login
URLs), and the locations to which JavaScript need to be inserted to collect client information. Without these resources,
FortiADC will not be able to insert the necessary JavaScript for bot detection.

Pre-Provisioning is triggered upon creating the Application, and requires 2 to 3 days to complete. During this process,
your FortiGuard ABP Application will be in pending status until Pre-Provisioning is complete. When the Application
status is ready, Advanced Bot Protection can be activated in your FortiADC.

When Advanced Bot Protection is initially activated, it is recommended to set the
WAF action that would allow you to observe and log any events detected by the
FortiGuard Advanced Bot Protection, instead of immediately setting to block.
FortiGuard Advanced Bot Protection uses a multidimensional deep learning engine
to learn and track bot attacks over time by using sophisticated AI model training. As
FortiGuard ABP builds its training model, it will continue to improve and refine its bot
detection capabilities. However, this may mean triggering false positives in the initial
stages of the AI model training.

Before you begin:

l You must have enabled and successfully connected the Advanced Bot Protection connector on Security Fabric >
Fabric Connectors.
The Advanced Bot Protection module under Web Application Firewall is available only after the Advanced Bot
Protection connector is enabled.

l You must have Read-Write permission for Security settings.
l You must have access to the FortiGuard Advanced Bot Protection User Portal to obtain the Application ID from an
existing Application or create a new configuration. For more information, see Obtaining the Application ID from the
FortiGuard ABP User Portal on page 653.

Decompression must be enabled to support JavaScript insertion, which is critical to
FortiGuard Advanced Bot Protection functionality.
Ensure a Decompression policy is enabled in your HTTP/HTTPS Application Profile
to allow JavaScript to be inserted into compressed HTTP/HTTPS web content. To
increase performance, most websites utilize HTTP compression to reduce the size
of transmitted data. This compressed HTTP/HTTPS content must be decompressed
to allow FortiADC to insert the required JavaScript tag to the HTML. If the real server
response is not compressed, then decompression is unnecessary. However, if the
real server response is compressed then decompression must be enabled,
otherwise the JavaScript will fail to insert.
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To configure an Advanced Bot Protection policy:

1. Go toWeb Application Firewall > Advanced Bot Protection.
2. In the Advanced Bot Protection tab, click Create New to display the configuration editor.

3. Configure the following Advanced Bot Protection settings:

Setting Description

Name Specify a name for the Advanced Bot Protection policy.
Valid characters are A-Z, a-z, 0-9, _, and -. No spaces. The configuration
name cannot be edited once it has been saved.

Status Enable/disable the status of this Advanced Bot Protection policy.
Statusmust be enabled to display Advanced Bot Protection configuration
options.

Application ID Specify the Application ID assigned to your FortiGuard ABP Application.
The Application ID is used to bind this Advanced Bot Protection policy to the
FortiGuard ABP Application.
For steps on how to obtain the Application ID from the FortiGuard ABP User
Portal, see Obtaining the Application ID from the FortiGuard ABP User Portal
on page 653.

Action Specify a WAF action object to apply when a bot is detected. You can specify a
predefined or user-defined WAF action profile. (See Configuring WAF Action
objects on page 546.)
Predefined WAF actions:
l alert —WAF policies will allow the traffic to pass and log the event.
l block—WAF policies will drop the current attack session by HTTP 403
message and block the attacker (according the attacker’s IP address) for
1 hour, and log the event.
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Setting Description

l captcha—WAF policies will allow the traffic to pass if the client
successfully fulfills the CAPTCHA request, and log the event.

l deny—WAF policies will the drop current attack session by HTTP 403
message, and log the event.

l silent-deny—WAF policies will drop the current attack session by HTTP
403 message, without logging the event.

The default action is alert.

Severity Select the event severity to log when a bot is detected:
l High— Log as high severity events.
l Medium— Log as a medium severity events.
l Low— Log as low severity events.

The default is Low.

Exception Name Select an exception configuration object. Exceptions identify specific hosts or
URL patterns that are not subject to processing by this rule.

4. Optionally, click Verify to validate the inputted Application ID against multiple parameters to ensure the connection
between FortiADC and the FortiGuard ABP Application is successfully established.

For more information, see Verifying the Application ID and connection status to FortiGuard ABP on page 663.
5. Click Save.

Once the Advanced Bot Protection policy is saved, you can reference it in a WAF Profile configuration.

It is strongly recommended to verify the Application ID and FortiGuard ABP server
connection prior to completing the Advanced Bot Protection policy configuration.
Even though this is an optional step, it is helpful to diagnose any potential issues and
apply fixes early.
When the Advanced Bot Protection policy is created, an internal verification is
automatically conducted to verify the status of the Application ID and FortiGuard
ABP server connection. If the Application ID is not valid, or any other validation
parameters has failed, the Advanced Bot Protection policy will fail to function and the
system will log the failure to send the ABP policy.
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Verifying the Application ID and connection status to FortiGuard ABP

The Advanced Bot Protection policy can only function if the Application ID is valid and the connection to the FortiGuard
ABP server is successfully established. FortiADC validates multiple parameters, including if the Application ID is
available, the FortiGuard ABP server connectivity, if the FortiGuard ABP license is valid. There are two types of
messages as differentiated by text color: green text indicates a positive status where all required parameters are
validated successfully; and red text that indicate one or more parameters did not pass validation.

The following table describes some common verification results.

Verification status message Guidelines

Success (green) All required parameters pass validation; application ID is available,
FortiGuard ABP server certificate is valid, network connectivity is good,
etc.

Application not found (red) The Application ID does not exist. This could be an input error.

Account license invalid (red) The FortiGuard ABP license is not valid. Please verify your license
details or contact Fortinet Support.

Couldn't connect to server (red) Unable to connect to the FortiGuard ABP server. Please check your
network settings.

Couldn't resolve hostname (red) Unable to resolve the hostname of the FortiGuard ABP server. Please
check your network settings.

No available SN cert (red) The device does not have an available SN certificate. Please check
your local certificate.

No available CA cert (red) The device does not have an available CA certificate. Please check
your CA certificate.

Problem with the local certificate An error occurred with the remote server certificate. Please check your
local certificate.

SSL peer certificate or SSH remote key
was not OK

An error occurred with the remote server certificate involving the SSL
peer certificate or SSH remote key. Please check your local certificate.

Advanced Bot Protection troubleshooting and debugging

The following tools are available to troubleshoot and debug Advanced Bot Protection issues.

Event logs that record the interactions between FortiADC and FortiGuard Advanced Bot Protection when
system events occur

You can check the system event logs to see the communication between FortiADC and FortiGuard ABP.
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The following system events are logged:

l Configuration changes to the Advanced Bot Protection policy.
l When FortiADC has successfully reports Advanced Bot Protection policy configurations to FortiGuard ABP.
l When FortiADC fails and retries to report Advanced Bot Protection policy configurations to FortiGuard ABP.

Attack Logs that record interactions between FortiADC and FortiGuard ABP when suspicious behavior
is detected

You can check the attack logs to see the WAF action triggered by the response received from FortiGuard ABP.

In the example below, the attack logged a block WAF action that was triggered by FortiGuard ABP detecting suspicious
user behavior.

Some interactions may not trigger an attack log.

l When the WAF action for the Advanced Bot Protection policy is set to allow, triggered attacks will not be logged.
l When FortiADC receives an "empty" response from FortiGuard ABP.
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l When FortiADC receives a 401 Authentication error (or another error) from FortiGuard ABP.
l When FortiADC does not receive a response from FortiGuard ABP until timeout (10 seconds).

CLI commands to view debug logs relating to Advanced Bot Protection

Command Guidelines

diagnose debug module
wafmonitor all

diagnose debug enable

To view the debug information for interactions between the wafmonitor daemon
and the FortiGuard ABP. Interactions include fetching the Advanced Bot
Protection policy entries from FortiGuard ABP and reporting FortiADC
configurations to FortiGuard ABP.
Note: The diagnose debug module wafmonitor all command prints the
debug information for all WAF modules that use the daemon wafmonitor. You will
need to manually check for the debug information regarding the Advanced Bot
Protection module.

diagnose debug module waf
advanced_bot

To view the debug information for traffic processed by the Advanced Bot
Protection policy.

diagnose debug module
framework_http

To view the debug information for HTTP packet processing by WAFmodules.
Note: The diagnose debug module framework_http command prints the
debug information for all WAF modules. You will need to manually check for the
debug information regarding the Advanced Bot Protection module.
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Network Security

The Network Securitymenu contain features and configurations that allow you to protect your network against
malicious attacks.

This section is organized into the following sub-menu topics:

l Firewall on page 666
l Intrusion Prevention on page 673
l AntiVirus on page 678
l IP Reputation on page 684
l Geo IP Protection on page 687
l Zero Trust Network Access (ZTNA) on page 691

Security features basics

In most deployment scenarios, we recommend you deploy FortiGate to secure your network. Fortinet includes security
functionality in the FortiADC system to support those cases when deploying FortiGate is impractical. FortiADC includes
the following security features:

l Firewall—Drop traffic that matches a source/destination/service tuple you specify.
l Security connection limit—Drop an abnormally high volume of traffic from a source/destination/service match.
l IP Reputation service—Drop or redirect traffic from source IPs that are on the FortiGuard IP Reputation list.
l Geo IP—Drop or redirect traffic from source IPs that correspond with countries in the FortiGuard Geo IP database.
l Web application firewall—Drop or alert when traffic matches web application firewall attack signatures and
heuristics.

l AntiVirus—Drop traffic that matches in FortiSandbox's Malware Signature Database.
l Denial of service protection—Drop half-open connections to protect the system from a SYN flood attack.
l IPS—Protect the system based on a robust FortiGuard pattern / signature-based engine.

Firewall

The Network Security > Firewall sub-menu contains features and configurations that allow you to define your Firewall
and Connection Limit policies.

l Configuring an IPv4 firewall policy on page 667
l Configuring an IPv6 firewall policy on page 669
l Configuring an IPv4 connection limit policy on page 671
l Configuring an IPv6 connection limit policy on page 672

FortiADC Handbook 666
Fortinet Technologies Inc.



Network Security

Configuring an IPv4 firewall policy

A firewall policy is a filter that allows or denies traffic based on a matching tuple: source address, destination address,
and service. By default, firewall policy rules are stateful: if client-to-server traffic is allowed, the session is maintained in a
state table, and the response traffic is allowed.

The FortiADC system evaluates firewall policies before other rules. It matches traffic against the firewall policy table,
beginning with the first rule. If a rule matches, the specified action is taken. If the session is denied by a firewall policy
rule, it is dropped. If the session is accepted, system processing continues.

By default, if firewall rules are not configured, the system does not perform firewall processing; all traffic is processed as
if the system were a router, and traffic is forwarded according to routing and other system rules.

Note: You do not need to create firewall rules for routine management traffic associated with the management port or HA
ports. The interface “allow access” option enables permitted protocols. The system automatically permits from-self
traffic, such as health check traffic, and expected responses.

Before you begin:

l You must have a good understanding and knowledge of firewalls.
l You must have created the address configuration objects and service configuration objects that define the matching
tuple in your firewall policy rules.

l You must have Read-Write permission for Firewall settings.

To configure a firewall:

1. Go to Network Security > Firewall.
2. Click the IPv4 Firewall Policy tab.
3. Click Create New to display the configuration editor.
4. Complete the configuration as described in Firewall policy configuration on page 667.
5. Save the configuration.
6. Reorder rules, as necessary.

Settings Guidelines

Default Action Action when no rule matches or no rules are configured:
l Deny—Drop the traffic.
l Accept — Allow the traffic to pass the firewall.

Rule

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces.
After you initially save the configuration, you cannot edit the name.

Ingress Interface Select the interface that receives traffic.

Egress Interface Select an outgoing interface from the drop-down list if your FortiADC is configured for link
load-balancing and/or traffic routing. In both cases, the system will use this interface to
forward traffic to its destination.

Firewall policy configuration
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Settings Guidelines

Note: YouMUST leave this option blank (default) if your FortiADC is configured for server
load-balancing and/or global load-balancing. Otherwise, server load-balancing and/or global
load-balancing packets may not match the firewall policy rule.

Source Type Select the source type to use to form the matching tuple.
l Address
l Address Group
l External Resource

Source The Source option is available if the Source Type is Address.
Specify the Address object to use as the source.

Source Address
Group

The Source Address Group option is available if the Source Type is Address Group.
Specify the Address Group object to use as the source.

Source External
Address Group

The Source External Address Group option is available if the Source Type is External
Resource.
Specify the external IP address list imported through the IP Address connector to use as the
source. For details, see IP Address Connector on page 106.

Destination Type Select the destination type to use to form the matching tuple.
l Address
l Address Group
l External Resource

Destination The Destination option is available if the Destination Type is Address.
Specify the Address object to use as the destination.

Destination Address
Group

The Destination Address Group option is available if the Destination Type is Address
Group.
Specify the Address Group object to use as the destination.

Destination External
Address Group

The Destination External Address Group option is available if the Destination Type is
External Resource.
Specify the external IP address list imported through the IP Address connector to use as the
destination. For details, see IP Address Connector on page 106.

Service Select a service object to use to form the matching tuple.

Action l Deny—Drop the traffic.
l Accept — Allow the traffic to pass the firewall.

Status Enabled by default.
Note: This button simplifies the implementation of firewall policy/NAT rules, allowing you to
turn a policy rule ON or OFF with a click of the button. When a firewall policy rule is disabled, it
will be removed from the relevant IP tables, and will be added to the IP table when the rule is
enabled.

Deny Log The Deny Log option is available is the Action is Deny.
Enable/disable logging for denied action.
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Settings Guidelines

Reordering

Reorder After you have saved a rule, reorder rules as necessary. The rules table is consulted from top
to bottom. The first rule that matches is applied and subsequent rules are not evaluated.

Configuring an IPv6 firewall policy

A firewall policy is a filter that allows or denies traffic based on a matching tuple: source address, destination address,
and service. By default, firewall policy rules are stateful: if client-to-server traffic is allowed, the session is maintained in a
state table, and the response traffic is allowed.

The FortiADC system evaluates firewall policies before other rules. It matches traffic against the firewall policy table,
beginning with the first rule. If a rule matches, the specified action is taken. If the session is denied by a firewall policy
rule, it is dropped. If the session is accepted, system processing continues.

By default, if firewall rules are not configured, the system does not perform firewall processing; all traffic is processed as
if the system were a router, and traffic is forwarded according to routing and other system rules.

Note: You do not need to create firewall rules for routine management traffic associated with the management port or HA
ports. The interface “allow access” option enables permitted protocols. The system automatically permits from-self
traffic, such as health check traffic, and expected responses.

Before you begin:

l You must have a good understanding and knowledge of firewalls.
l You must have created the address configuration objects and service configuration objects that define the matching
tuple in your firewall policy rules.

l You must have Read-Write permission for Firewall settings.

To configure a firewall:

1. Go to Network Security > Firewall.
2. Click the IPv6 Firewall Policy tab.
3. Click Create New to display the configuration editor.
4. Complete the configuration as described in Firewall policy configuration on page 669.
5. Save the configuration.
6. Reorder rules, as necessary.

Settings Guidelines

Default Action Action when no rule matches or no rules are configured:
l Deny—Drop the traffic.
l Accept — Allow the traffic to pass the firewall.

Rule

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces.

Firewall policy configuration
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Settings Guidelines

After you initially save the configuration, you cannot edit the name.

Ingress Interface Select the interface that receives traffic.

Egress Interface Select an outgoing interface from the drop-down list if your FortiADC is configured for link
load-balancing and/or traffic routing. In both cases, the system will use this interface to
forward traffic to its destination.
Note: YouMUST leave this option blank (default) if your FortiADC is configured for server
load-balancing and/or global load-balancing. Otherwise, server load-balancing and/or global
load-balancing packets may not match the firewall policy rule.

Source Type Select the source type to use to form the matching tuple.
l Address
l Address Group
l External Resource

Source The Source option is available if the Source Type is Address.
Specify the Address object to use as the source.

Source Address
Group

The Source Address Group option is available if the Source Type is Address Group.
Specify the Address Group object to use as the source.

Source External
Address Group

The Source External Address Group option is available if the Source Type is External
Resource.
Specify the external IP address list imported through the IP Address connector to use as the
source. For details, see IP Address Connector on page 106.

Destination Type Select the destination type to use to form the matching tuple.
l Address
l Address Group
l External Resource

Destination The Destination option is available if the Destination Type is Address.
Specify the Address object to use as the destination.

Destination Address
Group

The Destination Address Group option is available if the Destination Type is Address
Group.
Specify the Address Group object to use as the destination.

Destination External
Address Group

The Destination External Address Group option is available if the Destination Type is
External Resource.
Specify the external IP address list imported through the IP Address connector to use as the
destination. For details, see IP Address Connector on page 106.

Service Select a service object to use to form the matching tuple.

Action l Deny—Drop the traffic.
l Accept — Allow the traffic to pass the firewall.

Status Enabled by default.
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Settings Guidelines

Note: This button simplifies the implementation of firewall policy/NAT rules, allowing you to
turn a policy rule ON or OFF with a click of the button. When a firewall policy rule is disabled, it
will be removed from the relevant IP tables, and will be added to the IP table when the rule is
enabled.

Deny Log The Deny Log option is available is the Action is Deny.
Enable/disable logging for denied action.

Reordering

Reorder After you have saved a rule, reorder rules as necessary. The rules table is consulted from top
to bottom. The first rule that matches is applied and subsequent rules are not evaluated.

Configuring an IPv4 connection limit policy

The firewall connection limit policy allows or denies traffic based on a matching tuple: source address, destination
address, and service; and connection count. The purpose is to detect anomalous connection requests.

The limit you specify can be based on the following counts:

l Count of concurrent sessions that match the tuple.
l Count of concurrent sessions from a single host that match the tuple.

The FortiADC system evaluates firewall connection limit policy rules before other rules. It matches traffic against the
connection limit table, beginning with the first rule. If no rule matches, the connection is forwarded for further processing.
If a rule matches, and the limit has not been reached, the connection is forwarded for further processing. If a rule
matches and the limit has been reached, the connection is dropped.

By default, if firewall connection limit rules are not configured, the system does not perform connection limit policy
processing. The firewall connection limit can be configured for non-SLB traffic and for Layer 7 SLB traffic, but not Layer 4
SLB traffic.

Note: The purpose of the firewall connection limit is distinct from the virtual server connection limit. The firewall
connection limit setting is a security setting; the virtual server connection limit is a capacity setting.

Before you begin:

l You must have a good understanding and knowledge of the capacity of your backend servers.
l You must have created the address configuration objects and service configuration objects that define the matching
tuple in your connection limit rules.

l You must have Read-Write permission for Firewall settings.

To configure a firewall connection limit:

1. Click Network Security > Firewall > IPv4 Connection Limit Policy.
2. Click Create New to display the configuration editor.
3. Complete the configuration as described in Connection limit configuration on page 672.
4. Save the configuration.
5. Reorder rules, as necessary.
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Settings Guidelines

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces.
After you initially save the configuration, you cannot edit the name.

Ingress Interface Select the interface that receives traffic.

Egress Interface Select the interface that forwards traffic.

Source Select a source address object to use to form the matching tuple.

Destination Select a destination address object to use to form the matching tuple.

Service Select a service object to use to form the matching tuple.

Type Specify whether the limit is per rule or per host.

Side When the connection limit is per host, specify whether the connection counter gets
incremented when the host IP address appears in:
l Source—Only increment the counter if the host is the source address.
l Destination—Only increment the counter if the host is the destination address.
l Both—Increment the counter if the host is the source or destination address.

Limit Maximum concurrent sessions. The default is 1,048,576.

Reordering

After you have saved a rule, reorder rules as necessary. The rules table is consulted from top
to bottom. The first rule that matches is applied and subsequent rules are not evaluated.

Connection limit configuration

Configuring an IPv6 connection limit policy

The firewall connection limit policy allows or denies traffic based on a matching tuple: source address, destination
address, and service; and connection count. The purpose is to detect anomalous connection requests.

The limit you specify can be based on the following counts:

l Count of concurrent sessions that match the tuple.
l Count of concurrent sessions from a single host that match the tuple.

The FortiADC system evaluates firewall connection limit policy rules before other rules. It matches traffic against the
connection limit table, beginning with the first rule. If no rule matches, the connection is forwarded for further processing.
If a rule matches, and the limit has not been reached, the connection is forwarded for further processing. If a rule
matches and the limit has been reached, the connection is dropped.

By default, if firewall connection limit rules are not configured, the system does not perform connection limit policy
processing. The firewall connection limit can be configured for non-SLB traffic and for Layer 7 SLB traffic, but not Layer 4
SLB traffic.

Note: The purpose of the firewall connection limit is distinct from the virtual server connection limit. The firewall
connection limit setting is a security setting; the virtual server connection limit is a capacity setting.
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Before you begin:

l You must have a good understanding and knowledge of the capacity of your backend servers.
l You must have created the address configuration objects and service configuration objects that define the matching
tuple in your connection limit rules.

l You must have Read-Write permission for Firewall settings.

To configure a firewall connection limit:

1. Click Network Security > Firewall > IPv6 Connection Limit Policy.
2. Click Create New to display the configuration editor.
3. Complete the configuration as described in Connection limit configuration on page 673.
4. Save the configuration.
5. Reorder rules, as necessary.

Settings Guidelines

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces.
After you initially save the configuration, you cannot edit the name.

Ingress Interface Select the interface that receives traffic.

Egress Interface Select the interface that forwards traffic.

Source Select a source address object to use to form the matching tuple.

Destination Select a destination address object to use to form the matching tuple.

Service Select a service object to use to form the matching tuple.

Type Specify whether the limit is per rule or per host.

Side When the connection limit is per host, specify whether the connection counter gets
incremented when the host IP address appears in:
l Source—Only increment the counter if the host is the source address.
l Destination—Only increment the counter if the host is the destination address.
l Both—Increment the counter if the host is the source or destination address.

Limit Maximum concurrent sessions. The default is 1,048,576.

Reordering

Reorder After you have saved a rule, reorder rules as necessary. The rules table is consulted from top
to bottom. The first rule that matches is applied and subsequent rules are not evaluated.

Connection limit configuration

Intrusion Prevention

From the Network Security > Intrusion Prevention sub-menu, you can configure an Intrusion Prevention Profile that
uses Intrusion Prevention System (IPS) technology to protect your network against cyberattacks by actively seeking and
blocking external threats before they can reach potentially vulnerable network devices.
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The FortiADC Intrusion Prevention System (IPS) combines signature detection and prevention with low latency and
excellent reliability. With intrusion protection, you can create multiple IPS profiles, each containing a complete
configuration based on signatures. Then, you can apply any IPS profile to any L4 VS.

This section describes how to configure the FortiADC Intrusion Prevention settings.

Predefined Profiles

Every individual IPS Signature takes effect for a particular type of attack, for an effective detection and protection, a well-
considered combination of different IPS signatures plays a key role for the whole IPS system. FortiADC has 8 predefined
Profiles in respect to: action, application, severity, target, etc. are ready for customers for a fast security-set-up.

Predefined Profile Comment

all_default All predefined signatures with default setting.

all_default_pass All predefined signatures with PASS action.

default Prevents critical attacks.

high_security Blocks all Critical/High/Medium and some Low severity vulnerabilities.

protect_client Protect against client-side vulnerabilities.

protect_email_server Protect against email server-side vulnerabilities.

protect_http_server Protect against HTTP server-side vulnerabilities.

sniffer-profile Monitor IPS attacks.

Signature-based defense

Signature-based defense is used against known attacks or vulnerability exploits. These often involve an attacker
attempting to gain access to your network. The attacker must communicate with the host in an attempt to gain access
and this communication will include particular commands or sequences of commands and variables. The IPS signatures
include these command sequences, allowing the FortiADC unit to detect and stop the attack.

Signatures

IPS signatures are the basis of signature-based intrusion prevention. Every attack can be reduced to a particular string
of commands or a sequence of commands and variables. Signatures include this information so your FortiADC unit
knows what to look for in network traffic.

Signatures also include characteristics about the attack they describe. These characteristics include the network
protocol in which the attack will appear, the vulnerable operating system, and the vulnerable application.

The FortiGuard Intrusion Prevention Service (IPS) provides customers with the latest defenses against stealthy network-
level threats through a constantly updated database of known threats and behavior-based signatures.

This update service is backed by a team of threat experts and a close relationship with major application vendors. The
best-in-class team also uncovers significant zero-day vulnerabilities continuously, providing FortiADC units with
advanced protection ahead of vendor patches.

The IPS Signatures Database is able to be updated automatically or manually by System > Settings > FortiGuard
page.
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Protocol decoders

Before examining network traffic for attacks, the IPS engine uses protocol decoders to identify each protocol appearing
in the traffic. Attacks are protocol-specific, so your FortiADC unit conserves resources by looking for attacks only in the
protocols used to transmit them. For example, the FortiADC unit will only examine HTTP traffic for the presence of a
signature describing an HTTP attack.

IPS engine

Once the protocol decoders separate the network traffic by protocol, the IPS engine examines the network traffic for
attack signatures. The engine count is configurable by CLI as well. (The recommendation is configuring the engine count
as the same count of CPU of the FortiADC has, an ips-engine per CPU)

IPS profiles

The IPS engine does not examine network traffic for all signatures. You must first create an IPS profile and specify which
signatures are included. Add signatures to profile individually using signature entries, or in groups using IPS filters.

To view the IPS profiles, go to Security Profiles > Intrusion Prevention.

You can group signatures into IPS profiles for easy selection when applying to L4 VS Security. You can define
signatures for specific types of traffic in separate IPS profiles, and then select those profiles in profiles designed to
handle that type of traffic. For example, you can specify all of the web-server related signatures in an IPS profile, and that
the profile can then be applied to a L4 VS Security that controls all of the traffic to and from a web server protected by the
unit.

The FortiGuard Service periodically updates the signatures, with signatures added to counter new threats. Since the
signatures included in filters are defined by specifying signature attributes, new signatures matching existing filter
specifications will automatically be included in those filters. For example, if you have a filter that includes all signatures
for the Windows operating system, your filter will automatically incorporate newWindows signatures as they are added.

Each filter consists of a number of signatures attributes. All of the signatures with those attributes, and only those
attributes, are checked against traffic when the filter is run. If multiple filters are defined in an IPS profile, they are
checked against the traffic one at a time, from top to bottom. If a match is found, the unit takes the appropriate action and
stops further checking.

The signatures included in the filter are only those matching every attribute specified. When created, a new filter has
every attribute set to all which causes every signature to be included in the filter. If the severity is changed to high, and
the target is changed to server, the filter includes only signatures checking for high priority attacks targeted at servers.

IPS filters

IPS profiles contain one or more IPS filters. A filter is a collection of signature attributes that you specify. The signatures
that have all of the attributes specified in a filter are included in the IPS filter.

For example, if your FortiADC unit protects a Linux server running the Apache web server software, you could create a
new filter to protect it. By setting OS to Linux, and Application to Apache, the filter will include only the signatures that
apply to both Linux and Apache. If you wanted to scan for all the Linux signatures and all the Apache signatures, you
would create two filters, one for each.

To view the filters in an IPS profile, go to Security Profiles > Intrusion Prevention, select the IPS profile containing the
filters you want to view, and select Edit.
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Custom/predefined signature entries

Signature entries allow you to add an individual custom or predefined IPS signature. If you need only one signature,
adding a signature entry to an IPS profile is the easiest way. Signature entries are also the only way to include custom
signatures in an IPS profile.

Another use for signature entries is to change the settings of individual signatures that are already included in a filter
within the same IPS profile. Add a signature entry with the required settings above the filter, and the signature entry will
take priority.

Security - L4 VS

To use an IPS profile, you must select it in a L4 VS security options. An IPS profile that it not selected in a policy options
will have no effect on network traffic.

IPS does not support NAT46

Session timers for IPS sessions

A session time-to-live (TTL) timer for IPS sessions is available to reduce synchronization problems between the
FortiADC Kernel and IPS, and to reduce IPS memory usage.

Creating an IPS Profile

You need to create an IPS profile before specific signatures or filters can be chosen. The signatures can be added to a
new profile before it is saved. However, it is good practice to keep in mind that the profile and its included filters are
separate things, and that they are created separately. (Predefined Profiles)

To create a new IPS Profile

1. Go to Network Security > Intrusion Prevention.
2. Select the Create New icon in the top of the Edit IPS Profile window.
3. Enter the name of the new IPS Profile.
4. Optionally, enter a comment. The comment will appear in the IPS Profile list.
5. SelectOK.
6. A newly created Profile is empty and contains no filters or signatures. You need to add one or more filters or

signatures before the Profile will be of any use.

To add IPS signatures to a Profile

1. Go to Network Security > Intrusion Prevention.
2. Select the IPS Profile to which you want to add the signature and click the edit icon.
3. Under IPS Signatures, click Add Signature.
4. Select one or more signatures from the list and click Apply to add them to the sensor.

You can search through the available signatures using either the CVE Number and/or filter by Action, Application,
Name, OS, Protocol, Severity, or Target.
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5. After the selected signature has been added to the IPS Signatures, the drop-down list of Action, which is on the right
side of the signature, has Default, Pass and Block, is changeable.

6. Click Apply on the bottom of the IPS Profile page

Adding an IPS filter to a Profile

While individual signatures can be added to a Profile, a filter allows you to add multiple signatures to a Profile by
specifying the characteristics of the signatures to be added.

To create a new pattern based signature and filter

1. Go to Network Security > Intrusion Prevention.
2. Select the IPS Profile to which you want to add the signature and click the edit icon.
3. Under IPS Filters, select Add Filter.

You can search through the available signatures using either the CVE Number and/or filters.
4. Configure the filter that you require. Signatures matching all of the characteristics you specify in the filter will be

included in the filter. Once finished, select Apply.
l Application refers to the application affected by the attack and filter options include over 25 applications.
l OS refers to the Operating System affected by the attack. The options include BSD, Linux, MacOS, Other,
Solaris, and Windows.

l Protocol refers to the protocol that is the vector for the attack; filter options include over 35 protocols, including
"other."

l Severity refers to the level of threat posed by the attack. The options include Critical, High, Medium, Low,
and Info.

l Target refers to the type of device targeted by the attack. The options include client and server.
5. After selecting the IPS Filter, configure the Action from the drop-down.

Action Description

Pass Select Pass to allow traffic to continue to its destination.
Note: to see what the default for a signature is, go to the IPS Signatures page
and enable the column Action, then find the row with the signature name in it.

Block Select Block to drop traffic matching any signatures included in the filter.

Default Select Default to use the default action of the signature.

6. Click Apply on the bottom of the IPS Profile page

Adding rate based signatures

These are a subset of the signatures that are found in the database. This group of signatures is for vulnerabilities that are
normally only considered a serious threat when the targeted connections come in multiples, a little like DoS attacks.

Adding a rate based signature is straight forward. Select the enable button in the Rate Based Signature table that
corresponds with the desired signature.

Predefined IPS Profile

FortiADC has 8 predefined IPS Profiles for the convenience and fast-set-up of users to enable the IPS by an easier way,
each predefined profile is created under the attributes of each signature and thoughtful consideration. For users
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demanding a widely protection but yet ready to create a particular customized one, predefined IPS profiles are highly
recommended. They will be kept updated resulted from a periodically database update of the FortiGuard Service. These
Profiles are available by directly selecting from Security -> IPS in L4 VS options as well as be considered as a Quick-
Enabling-IPS.

Enabling IPS

Currently, the IPS Scanning only supports for the L4VS traffic

l The IPS Profile contains filters, signature entries, or both. These specify which signatures are included in the IPS
Profile.

When an IPS Profile is selected in a security option, and all network traffic matching the policy will be checked for the
signatures in the IPS Profile.

Configuring Engine Count

For the consideration of varying demands and the performance of different platforms, the Engine-Count of IPS in
FortiADC is configurable. The more Engine-Count that a FortiADC has, the better the IPS performs. Every coin has two
sides, however, consequently, the more CPU and memory usage will be taken from the whole system.

The default value of the Engine-count is 1, for a better performance accordingly, the configuration could be setting the
Engine-Count depends on CPU-Count of the platform has.

Eg: 4-Engine for a 4-Core device. (Refer to the hardware platform reference at the end of this article)

CLI Syntax

config global
config system ips
set engine-count {1-256}
next
end

AntiVirus

The Network Security > AntiVirus sub-menu allows you to perform the following tasks to configure your anti-virus
security:

l Creating an AV profile on page 679
l Setting AV quarantine policies on page 681
l Setting the AV service level on page 683

Overview

Malware and Advanced Persistent Threats (APT) can cause significant damage to the business of any organization.
Malicious codes are commonly used to steal valuable data, gain unauthorized access to networks, or cause products to
degrade.

Using a suite of integrated security technologies, Anti-virus (AV) solutions provide protection against a variety of threats,
including both known and unknown malicious codes (Malware) and Advanced Targeted Attacks (ATA).
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Integrated with the FortiOS AV engine, FortiADC provides an industry-class malware and APT detection and mitigation
solution to our customers.

AV module topology on page 679 illustrates how FortiADC's AV module works:

1. Automatically updates the latest attack signatures from FortiGuard to ensure real-time protection.
2. Submits all files, including suspicious files, to an on-premise appliance (FortiSandbox) or cloud-based service

(FortiCloud Sandbox) for further analysis after performing the basic AV processing of its own.
3. Malicious files will be dropped or quarantined, and healthy ones will be forwarded to the backend servers.

AV module topology

To use the AV module, you must

l Creating an AV profile on page 679
l Setting AV quarantine policies
l Setting AV service level

Important Notes

l The AV feature does not support HA.
l If FortiADC is in HA mode, you must use the default source-ip for FortiSandbox.
l Try to limit the number of VDOMs when the AV feature is enabled. Otherwise, the capacity of quarantine may
become limited.

l All file types are supported by AV feature.

Creating an AV profile

You must configure AV profiles to use the anti-virus service module, which can be done either from the GUI or the
Console. Once created, you can include your AV profiles when creating advanced virtual server profiles that use the
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HTTP, HTTPS, or SMTP protocol. For more information, refer to Configuring virtual servers.

Configure AV profiles from the GUI

To configure an AV profile from the GUI:

1. Click Network Security > AntiVirus.
2. Select the Profile tab.
3. Click the Create New button.
4. Make the entries or selections as described in AV profile configuration on page 680.
5. Click Save when done.

AV profile configuration

Settings Description

Name A unique name for the AV profile.
An AV profile name can contain up to 63 alphanumeric characters.

Comments A brief description of the profile.
A description can be up to 1024 alphanumeric characters long.

Uncomp Size Limit The maximum size in MB of the memory buffer used to temporarily
decompress files.
The default is 2 MB. Valid values range from 1 to 2000 MB.

Uncomp Nest Limit The maximum number of levels of nesting (compression) allowed for the
system to decompress.
The default is 2. Valid values range from 2 to 100.

Scan Bzip2 Scan archives using the bzip2 algorithm.
This is disabled by default.

Streaming Content Bypass Enable or disable bypass streaming content (rather than buffering it).
This is enabled by default.

Oversize Limit The maximum in-memory file size in KB to be scanned.
The default is 1024 KB. Valid values range from 1 to 12000000 KB.
Note: For AV files larger than 1000 KB, the device memory must be larger
than 32 GB to support the scan.

Oversize Select one of the options for the system to handle over-sized files:
l Bypass— Ignore oversized files.
l Log— Log and block oversized files.
l Block— Block oversized files.

The default option is Bypass.

Options Select an option for the system to handle infected files:
l AVMonitor — Block and log infected files.
l Quarantine—Quarantine and log infected files.

The default is AV Monitor.
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Settings Description

Emulator Enable or disable the Win32 Emulator.
This is disabled by default to improve throughput.

FSA Analytics Select an option to submit files to to FortiSandbox.
l Disable—No file is submitted.
l Suspicious—Only suspicious files are submitted.
l All—All files are submitted.

The default is Disable.

Analytics Max Upload The maximum file size in KB allowed to upload to FortiSandbox.
The default is 1024 KB. Valid values range from 1 to 2048 KB.

Analytics DB Enable or disable supplementing the AV signature databases with the
FortiSandbox signature database.
This is disabled by default.

AV Virus Log Enable or disable logging for anti-virus scanning.
This is enabled by default.

Note that FortiADC currently imposes no restriction on the types of files that can be uploaded for AV analysis or
evaluation. When scanning files for viruses, it makes no distinction between viruses and Trojans, and submits all
suspicious files to FortiSandbox for evaluation. A log is generated whenever a file is uploaded to FortiSandbox.

Configure AV profiles from the Console

To configure an AV profile from the Console, execute the following commands:

config security antivirus profile
edit <name_str>
set comment <var-string>
set uncomp-size-limit <limit_int>
set uncomp-nest-limit <limit_int>
set scan-bzip2 {enable | disable}
set streaming-content-bypass {enable | disable}
set oversize-limit <size_int>
set oversize {bypass | log | block}
set options {avmonitor | quarantine}
set emulator {enable | disable}
set fsa-analytics {disable | suspicious | everything}
set analytics-max-upload <integer>
set analytics-db {disable | enable}
set av-virus-log {enable | disable}
end

Setting AV quarantine policies

The “quarantined” daemon manages the infected or suspicious files. The quarantine destination can be either the local
hard disk.
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It’s a multi-process daemon, which receives quarantine requests from the AV daemon and then processes the requests
in child processes. It can work in tandem with remote devices to compliment the AV service, such as sending suspicious
files to FortiSandbox for deeper inspection or uploading the archive package onto FortiCloud.

In addition, it also manages the use of the storage space, listing the quarantined files, deleting expired files, overriding
old files, or dropping new files when there is no enough storage space available.

Note: For the 5.0.0 release, the AV module only supports quarantine on the hard disk and the integration with
FortiSandbox, as illustrated in AV quarantine process flow on page 682.

AV quarantine process flow

You can configure AV quarantine policies from the GUI or the Console.

Configuring AV quarantine policies from the GUI

To configure AV quarantine policies from the GUI:

1. Click Network Security > AntiVirus.
2. Click theQuarantine tab.
3. Make the entries or selections as described in AV quarantine policy configuration on page 682.
4. Click Save when done.

AV quarantine policy configuration

Settings Description

Destination The destination for quarantined files, which could be either of the following:
l NULL—Disable quarantine.
l Disk—Send quarantined files to the hard disk.

Age Limit The number of hours that quarantined files are kept on the hard disk. The default
is 1 hour. Valid values range form 0 to 336 hours.
Note: If the age limit is set to 0 (zero), it means that there is no age limit and
quarantined files will remain on the hard disk forever.

Max File Size The maximum size (in KB) of a single file that can be quarantined. The default is
1024 (KB). Valid values range from 1 to 2048 KB.
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Settings Description

Note: Files larger than the set Max File Size will not be quarantined. In reality, this
value is subject the available quarantine quota that remains on the hard disk. For
example, when there is less than 1024 KB of quarantine quota (disk space
reserved for quarantined files) remaining, a file of 1024 KB in size still will not be
quarantined even though you've set Max File Size to 1024.

Quarantine Quota The amount of disk space reserved for quarantining files. The default is 512 MB.
Valid values range from 0 to 1024 MB. If the value is set to 0, no files are
quarantined.

Drop Infected Select either or both of the following:
l HTTP
l HTTPS
l SMTP

Note: By default neither option is selected, which means that both types of files
are quarantined. If selected, files involving the specified protocol or protocols will
be dropped (not quarantined).

Lowspace Specify the way in which new files are handled when the system disk space is
running low, which could be either of the following:
l Override Old—Override old quarantine files with new ones.
l Drop New—Drop new quarantine files to retain old ones.

Configuring AV quarantine policies from the Console

To configure an AV quarantine policy from the Console, execute the following commands:

config security antivirus quarantine
set destination {NULL | disk}
set agelimit <integer>
set maxfilesize <integer>
set quarantine-quota <integer>
set drop-infected { http | https | smtp}
set lowspace {drop-new | ovrw-old}
end

Setting the AV service level

FortiADC's AV service relies on the system's AV engine and signature databases. The AV engine is upgraded whenever
new functions are added. The Updated daemon is responsible for updating the AV engine and the signature databases.

The system offers three types of AV signature databases, namely, Normal, Extended, and Extreme. They represent
different levels of AV services. In order for FortiADC to provide you with the level of AV service that you desire, you must
choose the right signature database.
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Configure AV service level from the GUI

To choose a signature database from the GUI,

1. From the navigation bar, click Network Security > AntiVirus.
2. Click the Settings tab.
3. Select a Default DB setting:

Settings Description

Normal The regular virus database, which includes “In the Wild” viruses and most
commonly seen viruses on the network. It provides regular protection.

Extended The extended virus database, which includes both “In the Wild” viruses and a
large collection of zoo viruses that are no longer seen in recent virus studies. It
provides enhanced security protection.

Extreme The extreme virus database, which includes both “In the Wild” viruses and all
known zoo viruses that are no longer seen in recent virus studies. It provides
the highest level of security protection.

4. Specify the Ramdisk size in GB. The default is 0 GB. Valid values range from 0 to 12 GB. Please ensure to enlarge
the RAM disk size to scan large files.
Note: When the changes to the RAM disk configuration is committed, you will be prompted to restart the device for
the configuration to take effect.

5. Click Save.

Configure AV service level from the Console

To set the default signature database from Console, execute the following command:

config security antivirus settings

set default-db {normal | extended | extreme}

set ramdisk-size <integer>

end

IP Reputation

The Network Security > IP Reputation sub-menu allows you to perform the following tasks to configure your IP
protection:

l Managing IP Reputation policy settings on page 685
l Configuring an IP reputation exception on page 686
l Configuring an IP reputation block list on page 686
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Managing IP Reputation policy settings

The FortiGuard IP Reputation service provides a database of known compromised or malicious client IP addresses. The
database is updated periodically.

The IP Reputation configuration allows you to specify the action the system takes when an SLB virtual server receives
traffic from a client with an IP address on the list. IP Reputation actions on page 685 lists limitations for IP Reputation
actions.

Action Profile Limitations

Pass IPv4 only Not supported for RADIUS.

Deny IPv4 only Not supported for RADIUS.

Redirect IPv4 only Not supported for RADIUS, FTP, TCP, UDP.

Send 403 Forbidden IPv4 only Not supported for RADIUS, FTP, TCP, UDP.

IP Reputation actions

Note: IP Reputation is also not supported for Layer 4 virtual servers when the Packet Forwarding Mode is Direct
Routing.

Basic Steps

1. Configure the connection to FortiGuard so the system can receive periodic IP Reputation Database updates. See
Configuring FortiGuard service settings.

2. Optionally, customize the actions you want to take when the system encounters a request from a source IP address
that matches the list; and add exceptions. If a source IP address appears on the exceptions list, the system does not
look it up on the IP Reputation list. See below.

3. Enable IP Reputation in the profiles you associate with virtual servers. See Configuring Application profiles.

Before you begin:

l You must have Read-Write permission for Firewall settings.

To customize IP Reputation policy rules:

1. Go to Network Security > IP Reputation.
2. Make sure to select the IP Reputation tab, which displays all IP reputation policy configuration in FortiADC.
3. Click a policy or the corresponding Edit icon to open the IP Reputation editor.
4. Make the desired changes as described in IP Reputation policy configuration on page 685.
5. Click Save.

Settings Guidelines

Category Depending the configuration on FortiGuard IP Reputation service, the IP reputation policy can
be one of the following categories:
l Anonymous Proxy
l Others

IP Reputation policy configuration
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Settings Guidelines

l Block List

Status Enable or disable the category.

Action l Pass
l Deny
l Redirect
l Send 403 Forbidden

Note: Layer 4 and TCPS virtual servers do not support Redirect or Send 403 Forbidden. If you
apply an IP Reputation configuration that uses these options to a Layer 4 or TCPS virtual
server, FortiADC logs the action as Redirect or Send 403 Forbidden but in fact denies the
traffic.

Severity The severity to apply to the event. Severity is useful when you filter and sort logs:
l Low
l Medium
l High

Log Enable or disable logging.

Configuring an IP reputation exception

To create an IP Reputation exception:

1. Go to Network Security > IP Reputation.
2. Click the IP Reputation Exception tab to add exceptions as described in IP Reputation exception on page 686.
3. Click Save.

Settings Guidelines

Status Enable or disable the exception. You might have occasion to toggle the exception off and on.

Type l IP/netmask: Select this option to allow a specified IP address to pass through.
l IP Range: Select this option to allow a specified range of IP addresses to pass through.

IP/Netmask If IP/netmask is selected in the Type field above, specify a subnet using the address/mask
notation.

Start IP / End IP Is IP Range is selected in the Type field above, specify the starting address and ending
address of the IP range.

IP Reputation exception

Configuring an IP reputation block list

Upload the source IP's or CIDRs that you want the ADC to block in the IP reputation block list. When these source IP's try
to access the VS, the connection will fail. You can create IP/Netmask or IP Range type block list, back up or restore files.

The content of IP reputation block list file should be coded in ASCII and every line can be a IP netmask or IP address
range. There can be 256 IP netmasks or IP address ranges in the file. It looks like this:
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192.168.1.1-192.168.1.10

172.16.1.1-172.16.2.100

10.1.1.0/24

20.1.1.0/24

You use the Restore utility to import the file and the Back Up utility to export it. This operation will back up the current
restored IP reputation block list, however, it does not back up user-configured entries.

You use the Clean utility to erase entries that were imported from the text file. This operation will erase the current
restored IP reputation block list, however, it does not affect user-configured entries.

To create an IP Reputation block list:

1. Go to Network Security > IP Reputation.
2. Click the IP Reputation Blocklist tab.
3. Click Create New and configure a new block list as described in IP Reputation block list on page 687.
4. Click Save.

Settings Guidelines

Status Enable or disable the exception. You might have occasion to toggle the exception off and on.

Type l IP/netmask: Select this option to allow a specified IP address to pass through.
l IP Range: Select this option to allow a specified range of IP addresses to pass through.

IP/Netmask If IP/netmask is selected in the Type field above, specify a subnet using the address/mask
notation.

Start IP / End IP If IP Range is selected in the Type field above, specify the starting address and ending
address of the IP range.

IP Reputation block list

Geo IP Protection

The Network Security > Geo IP Protection sub-menu allows you to perform the following tasks to configure your Geo
IP protection:

l Using the Geo IP block list on page 687
l Using the Geo IP allowlist on page 689
l Special Geo codes on page 690

Using the Geo IP block list

The FortiGuard Geo IP service provides a database that maps IP addresses to countries, satellite providers, and
anonymous proxies. The database is updated periodically.

The Geo IP block list is a policy that takes the action you specify when the virtual server receives requests from IP
addresses in the blocked country’s IP address space.
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For Layer 4 virtual servers, FortiADC blocks access when the first TCP SYN packet arrives. For Layer 7 virtual servers,
FortiADC blocks access after the handshake, allowing it to redirect the traffic if you have configured it to do so.

Geo IP block list actions on page 688 lists limitations for Geo IP block list actions.

Action Profile Limitations

Pass IPv4 only Not supported for HTTP Turbo, RADIUS.

Deny IPv4 only Not supported for HTTP Turbo, RADIUS.

Redirect IPv4 only Not supported for HTTP Turbo, RADIUS, FTP, TCP, TCPS, UDP.

Send 403 Forbidden IPv4 only Not supported for HTTP Turbo, RADIUS, FTP, TCP, TCPS, UDP.

Geo IP block list actions

Basic Steps

1. Configure the connection to FortiGuard so the system can receive periodic Geo IP Database updates. See
Configuring FortiGuard service settings.

2. Create rules to block traffic from locations.
3. Maintain a allowlist to allow traffic from specified subnets even if they belong to the address space blocked by the

Geo IP block list.
4. Select the Geo IP block list and allowlist in the profiles you associate with virtual servers. See Configuring

Application profiles.

Before you begin:

l You must have Read-Write permission for Security settings.

To configure a Geo IP block list:

1. Go to Network Security > Geo IP Protection.
2. Click theGeo IP Protection tab.
3. Click Create New to create a block list as described in Geo IP block list configuration on page 688.
4. Click Save.
5. Edit your new block list to add members as described in Geo IP block list configuration on page 688.
6. Click Save to save your member settings.
7. Click Save.

Settings Guidelines

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces.
After you initially save the configuration, you cannot edit the name.

Default Action l Pass—Allow the traffic.
l Deny—Drop the traffic.
l Redirect—Send a redirect. You specify the redirect URL on the profile configuration
page.

l Send 403 Forbidden—Send the HTTP Response code 403.

Geo IP block list configuration
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Settings Guidelines

Note: Layer 4 and TCPS virtual servers do not support Redirect or Send 403 Forbidden. If you
apply an Geo IP configuration that uses these options to a Layer 4 or TCPS virtual server,
FortiADC logs the action as Redirect or Send 403 Forbidden, but in fact denies the traffic.

Status Enable or disable the Geo IP block list configuration.

Member

Log Enable/disable logging.

Severity The severity to apply to the event. Severity is useful when you filter and sort logs:
l Low
l Medium
l High

Action l Pass—Allow the traffic.
l Deny—Drop the traffic.
l Redirect—Send a redirect. You specify the redirect URL on the profile configuration
page.

l Send 403 Forbidden—Send the HTTP Response code 403.
Note: Layer 4 and TCPS virtual servers do not support Redirect or Send 403 Forbidden. If you
apply an Geo IP configuration that uses these options to a Layer 4 or TCPS virtual server,
FortiADC logs the action as Redirect or Send 403 Forbidden, but in fact denies the traffic.

Regions Select a geolocation object. The list includes countries as well as selections for anonymous
proxies and satellite providers.

Using the Geo IP allowlist

To configure a Geo IP allowlist:

1. Go to Network Security > Geo IP Protection.
2. Click the Allowlist tab to create a allowlist as described in Geo IP allowlist configuration on page 689.
3. Click Save.

Settings Guidelines

Name Configuration name. The name can be up to 35 characters long. Valid characters are A-Z, a-
z, 0-9, _, and -. No space is allowed.
After you initially save the configuration, you cannot edit the name.

Description A string to describe the purpose of the configuration, to help you and other administrators
more easily identify its use.

Status Enable/disable the exception. You might have occasion to toggle the exception off and on.

Member

Geo IP allowlist configuration
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Settings Guidelines

Type Select and configure either of the following:
IP Subnet—Specify the IP address and CIDR-formatted subnet mask, separated by a forward
slash ( / ), such as 192.0.2.0/24. Dotted quad formatted subnet masks are not accepted. IPv6
addresses are not supported.
IP Range—Specify the Start IP and the End IP addresses of the IP range.

Description Enter a brief description of the IP subnet or IP range, depending on which Type you choose.
The description can be up to 1023 characters long. Valid characters are A-Z, a-z, 0-9, _, -,.,
and :. No space is allowed.

Special Geo codes

Special GEO codes and their usage on page 690 below describes the usage of special GEO codes.

GEO code Usage

ZZ Reserved (IP addresses that are not assigned, e.g., 10.0.0.0/24)

A1 Anonymous Proxy (IP addresses that are defined as anonymous proxy in
MaxMind, e.g., 46.19.137.0/24)

A2 Satellite Provider (IP addresses that are defined as satellite provider in MaxMind,
e.g., 57.72.6.0/24)

O1 Other Country (Reserved for further use, and no IP address is assigned to this
region)

Special GEO codes and their usage
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Zero Trust Network Access (ZTNA)

The Network Security > ZTNA sub-menu contains features and configurations relating to Zero Trust Network Access
(ZTNA) in FortiADC:

l How device identity and trust context is established with FortiClient EMS on page 695
l Configuring FortiClient EMS Connector for ZTNA on page 696
l Verifying EMS CA certificate, ZTNA tag, and FortiClient endpoint synchronized from FortiClient EMS on page 700
l Configuring a ZTNA Profile on page 702
l ZTNA troubleshooting and debugging on page 703

ZTNA Overview

Protect your virtual server resources with the FortiADC Zero Trust Network Access (ZTNA) access control method that
uses client device identification and Zero Trust tags to provide role-based application access. It provides administrators
the flexibility to manage network access for On-net local users and Off-net remote users. Access to applications is
granted only after verifying the device and user identity, and then performing context-based posture checks using Zero
Trust tags.

ZTNA telemetry, tags, and policy enforcement
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When On-net and Off-net FortiClient endpoints register to FortiClient EMS, device information, logged on user
information, and security posture are all shared over ZTNA telemetry with the EMS server. Clients also make a certificate
signing request to obtain a client certificate from the EMS that is acting as the ZTNA Certificate Authority (CA).

Based on the client information, EMS applies matching Zero Trust tagging rules to tag the clients. These tags, and the
FortiClient endpoint information (including the device information, logged on user information, and security posture) are
synchronized with the FortiADC in real-time. This allows the FortiADC to verify the client's identity using the client
certificate, and grant access based on the ZTNA tags applied in the ZTNA security rule.

For more information, see How device identity and trust context is established with FortiClient EMS on page 695.

ZTNA in FortiADC server load balancing

The FortiADC ZTNA is a network security feature that allows users to securely access Layer 7 HTTPS and TCPS virtual
server resources for server load balancing. Once the ZTNA security rule has been configured it can be referenced by
Layer 7 HTTPS and TCPS virtual servers to implement role-based zero trust access by using the client certificate and
ZTNA tags for identification and security posture check.

The chart below illustrates the FortiADC ZTNA logic flow.
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Prerequisites

Before you begin to configure ZTNA on the FortiADC unit, you must have the following:
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l FortiClient EMS running version 7.0.3 or later
l FortiClient running 7.0.1 or later
l FortiADC hardware, VM, or cloud platform that support FortiClient EMS.
Supported hardware models:
l FAD-120F
l FAD-220F
l FAD-300F
l FAD-400F
l FAD-1200F
l FAD-2200F
l FAD-4200F
l FAD-5000F

Supported cloud platforms with BYOL (PAYG FortiADC does not support FortiClient EMS):
l AWS (AmazonWeb Services)
l Microsoft Azure
l GCP (Google Cloud Platform)
l OCI (Oracle Cloud Infrastructure)
l Alibaba Cloud

Supported VM environments:
l VMware— ESXi 3.5, 4.x, 5.0, 5.1, 5.5, 6.0, 6.5, 6.7, 7.0
l Microsoft Hyper-V—Windows Server 2012 R2, 2016 and 2019
l KVM— Linux version 3.19.0 qemu-img v2.0.0, qemu-img v2.2
l Citrix Xen— XenServer 6.5.0
l Xen Project Hypervisor — 4.4.2, 4.5

Note: The most recent certificate embedded license is required. If your license was issued prior to April 2021,
please obtain a new certificate embedded license for your VM through Fortinet Customer Service & Support.

l Read-Write access permission for FortiADC Systems settings

Basic ZTNA configuration

To deploy FortiADC ZTNA, follow the basic workflow below:

1. Configure a FortiClient EMS connector to register your FortiADC device as a Fabric Device in the FortiClient EMS.
For details, see Configuring FortiClient EMS Connector for ZTNA on page 696.

2. Verify the information synchronized to FortiADC from FortiClient EMS. For details, see Verifying EMS CA certificate,
ZTNA tag, and FortiClient endpoint synchronized from FortiClient EMS on page 700.

3. Configure a ZTNA profile to define the ZTNA rules. For details, see Configuring a ZTNA Profile on page 702
4. Apply the Security ZTNA profile to a Layer 7 HTTPS or TCPS virtual server to activate ZTNA for server load

balancing. Ensure the corresponding Client SSL profile is enabled for client certificate verification. For details, see
Configuring virtual servers on page 328 and Configuring Client SSL profiles on page 412.

5. Enable security logging for ZTNA. This is optional.

FortiADC Handbook 694
Fortinet Technologies Inc.

http://support.fortinet.com/


Zero Trust Network Access (ZTNA)

How device identity and trust context is established with FortiClient
EMS

Integral to Zero Trust Network Access (ZTNA) is how device identity and trust context is established between FortiClient,
FortiClient EMS, and the FortiADC.

Device roles

The following illustrates how the FortiClient, FortiClient EMS, and FortiADC each function and participate in the ZTNA
workflow.

FortiClient

FortiClient endpoints provide the following information to FortiClient EMS when they register to the EMS:

l Device information (network details, operating system, model, and others)
l Logged on user information
l Security posture (On-net/Off-net, antivirus software, vulnerability status, and others)

FortiClient requests and obtains a client device certificate from the EMS ZTNA Certificate Authority (CA) when it
registers to FortiClient EMS. The client uses this certificate to identify itself to the FortiADC.

FortiClient EMS

FortiClient EMS issues and signs the client certificate with the FortiClient UID, certificate serial number, and EMS serial
number. EMS shares its EMS CA certificate with the FortiADC, so that the FortiADC can use it to verify the clients.
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FortiClient EMS uses Zero Trust tagging rules to tag endpoints based on the information that it has on each endpoint.
The tags are also shared with the FortiADC.

FortiADC

The FortiADCmaintains a continuous connection to the EMS server to synchronize endpoint device information,
including primarily:

l FortiClient UID
l Client certificate SN
l EMS SN
l Device credentials (user/domain)
l Network details (IP and MAC address and routing to the FortiADC)
l ZTNA tags

When a device's information changes, such as when a client moves from on-net to off-net, or their security posture
changes, EMS is updated with the new device information and then updates the FortiADC. The FortiADC's virtual
servers can use this information when processing ZTNA traffic. If an endpoint's security posture change causes it to no
longer match the ZTNA rule criteria then it will be denied in a new session.

Configuring FortiClient EMS Connector for ZTNA

The FortiClient Endpoint Management Server (EMS) connector enables you to establish device identity through client
certificates and device trust context between FortiClient, FortiClient EMS and the FortiADC as part of Zero Trust Network
Access (ZTNA).

You can register your FortiADC device as a Fabric Device through the FortiClient EMS connector. When you create a
FortiClient EMS connector, FortiADC sends a request to the FortiClient EMS server to obtain a EMS CA certificate to
register your FortiADC device. From the FortiClient EMS, you can then authorize the FortiADC as a Fabric Device. Once
authorized, the FortiClient EMS connector will display the status as Connected, indicating the device is registered. After
the FortiADC connects to the FortiClient EMS, it automatically synchronizes ZTNA tags, the EMS CA certificate, and
FortiClient endpoint information.

ZTNA tags are then generated from tagging rules configured on the FortiClient EMS. These tagging rules are based on
various posture checks that can be applied on the endpoints.

In FortiClient EMS, do not use special characters such as ", ', and \ in the ZTNA tag
name. ZTNA tags that contain these special characters in their name may trigger
unexpected behavior when referenced in the ZTNA Profile or in the security logs.

You can create a maximum of three FortiClient EMS connectors.

Requirements:

l FortiClient EMS running version 7.0.3 or later
l FortiClient running 7.0.1 or later
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l FortiADC hardware, VM, or cloud platform that support FortiClient EMS.

FortiClient EMS is supported in most FortiADC platforms but not all of them. The
following lists the hardware models, cloud platforms, and VM environments that
support FortiClient EMS.
Hardware models:
l FAD-120F, FAD-220F, FAD-300F, FAD-400F, FAD-1200F, FAD-2200F,
FAD-4200F, FAD-5000F

Cloud platforms with BYOL (PAYG FortiADC does not support FortiClient EMS):
l AWS (AmazonWeb Services), Microsoft Azure, GCP (Google Cloud
Platform), OCI (Oracle Cloud Infrastructure), Alibaba Cloud

VM environments:
l VMware, Microsoft Hyper-V, KVM, Citrix Xen, Xen Project Hypervisor
Note: The most recent certificate embedded license is required. If your
license was issued prior to April 2021, please obtain a new certificate
embedded license for your VM through Fortinet Customer Service &
Support.

l Read-Write access permission for FortiADC Systems settings

To create and configure a FortiClient EMS connector:

1. Go to Security Fabric > Fabric Connectors.
2. Click Create New.
3. Under Core Network Security, click FortiClient EMS to display the configuration editor.
4. Configure the following FortiClient EMS Settings:

Setting Description

Name Specify the FortiClient Enterprise Management Server (EMS) name. Valid
characters are A-Z, a-z, 0-9, _, and -. No spaces.

IP/Domain name Specify the server IPv4 address or the domain name of the FortiClient EMS
FQDN. For example: 192.0.2.1

HTTPS Port Specify the FortiClient EMS HTTPS access port number. Range: 1-65535,
default: 443

5. Click Save.
The Verify EMS server certificate dialog displays the following message:
In order for the FortiClient EMS and FortiADC to communicate, the following certificate provided by the FortiClient
EMSmust be reviewed for correctness, and accepted if deemed valid.
Do you wish to Accept the certificate as detailed below?

6. After you have verified the EMS server certificate information displayed, clickOK to accept the EMS server
certificate.
The Verify completed dialog displays the following message:
This FortiADC is not authorized on FortiClient EMS yet. Please let FortiClient EMS to authorize it.
Note: This message will only appear if the FortiADC device has not yet been authorized as a Fabric Device through
FortiClient EMS.

7. ClickOK.
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The newly created FortiClient EMS connector is added to the Security Fabric > Fabric Connectors page, under the
Core Network Security section. The FortiClient EMS connector will not be connected until the FortiADC has been
authorized as a Fabric Device in FortiClient EMS.

To authorize the FortiADC as a Fabric Device in FortiClient EMS:

1. Login to FortiClient EMS.
2. From the FortiClient EMS landing page, the Fabric Device Authorization Requests pop-up displays the Serial

Number and IP information of the FortiADC device. Click Authorize.
3. Alternatively, you can go to Administration > Fabric Devices and select the Fabric device you want to authorize.

To check and troubleshoot the FortiClient EMS connector connection:

1. Go to Security Fabric > Fabric Connectors.
2. Under the Core Network Security section, locate the FortiClient EMS connector configurations.

3. The and icons indicate whether FortiClient EMS has successfully authorized the FortiADC Fabric Device
for the corresponding FortiClient EMS connector. Hover over the FortiClient EMS connector to see the status
details. The table below lists the possible connection statuses for the FortiClient EMS connector.

Icon EMS Status Description

Connected The FortiADC has been successfully authorized as a Fabric
Device through FortiClient EMS.

Cert unauthorized FortiADC does not verify the EMS server's CA certificate. You can
edit the FortiClient EMS connector configuration and restart the
verification to accept the EMS CA certificate.

Auth failed The EMS server does not authorize the FortiADC, indicating the
request is either denied or pending authorization. If pending
authorization, the status will change to Connected once
authorization is successful on the EMS server.

Not reachable The EMS server was not reachable. Ensure the EMS server IP and
system router is properly configured.

EMS server connection failed The EMS server connection failed with unknown issue. For
example, an incorrect EMS server port may cause this issue.

No compatible The EMS server connection failed because the server is not
compatible with FortiADC.

Not sent The EMS domain name cannot resolve. Ensure proper
configuration for the DNS server setting, domain name, and
system router.
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If the status is not Connected, edit the FortiClient EMS connector accordingly to troubleshoot the connection issue.
4. Locate the newly created FortiClient EMS connector, click the FortiClient EMS connector configuration then click

Edit, or double click the configuration object to display the configuration editor.

5. Edit the configuration to troubleshoot the connection issue then click Authorize to restart the verification to accept
the EMS CA certificate.
A request is resent to the FortiClient EMS to authorize the FortiADC as a Fabric Device in FortiClient EMS. The
FortiClient EMS connector will not be connected until the FortiADC has been authorized as a Fabric Device in
FortiClient EMS.

FortiClient EMS in virtual domain configurations

Virtual domains (VDOMs) are full FortiADC instances configured within a FortiADC device. Once the FortiADC device is
registered to the FortiClient EMS, the configuration settings are applied globally. Using the same ZTNA tag, each VDOM
can then configure ZTNA security rules that apply individually at the VDOM level.
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FortiClient EMS for High Availability configurations

In a High Availability group, both the FortiADC units must be registered to the FortiClient EMS as individual Fabric
devices. However, you only need to configure the FortiClient EMS connector on one of the FortiADC units. Once the
FortiClient EMS connector configuration has been completed in one of the FortiADC units in the HA group, the
configuration will be synchronized to the second FortiADC unit. The Fabric Device authorization request for both
FortiADC units are sent to FortiClient EMS to complete the device registration.

Verifying EMS CA certificate, ZTNA tag, and FortiClient endpoint
synchronized from FortiClient EMS

After the FortiADC device connects to the FortiClient EMS, it automatically synchronizes ZTNA tags, the EMS CA
certificate and the FortiClient endpoint information from the FortiClient EMS. Verify all the information have successfully
synchronized from FortiClient EMS to FortiADC in the following:

l Systems > Verify > CA tab to view the EMS CA certificate
l Network Security > ZTNA > ZTNA Tags tab to view the ZTNA tags
l FortiView > ZTNA to view the FortiClient endpoint information and status

Systems > Verify > CA tab

The EMS CA certificate is synchronized to Systems > Verify > CA tab. When a ZTNA profile is referenced in a VS
configuration, the corresponding Client SSL profile must enable verification of the client device certificate.

Click the (View icon) to see the EMS CA certificate details.

Network Security > ZTNA > ZTNA Tags tab

ZTNA tags are synchronized to the Network Security > ZTNA > ZTNA Tags tab. After the FortiClient EMS connector
has successfully connected, check the ZTNA Tags page to ensure the corresponding ZTNA tag has been synchronized.
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The Ref. column indicates the number of ZTNA Profile rules that have referenced the ZTNA tag.

FortiView > ZTNA

The FortiClient endpoint information and status are synchronized to the FortiView > ZTNA. From here, you can monitor
the real-time status of the endpoints registered to FortiClient EMS.

You can hover over the Hostname column to view the device details synchronized from the FortiClient EMS.
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Configuring a ZTNA Profile

The ZTNA Profile is the ZTNA policy used to enforce access control to Layer 7 HTTPS and TCPS virtual servers. ZTNA
profiles consist of one or more ZTNA rule that determine the Source IP and ZTNA tags that are allowed access, and the
resulting action to take.

After you have created a ZTNA profile, you can reference the ZTNA profile in Layer 7 HTTPS and TCPS virtual server
Security configurations.

Before you begin:

l You must have registered the FortiADC device through the FortiClient EMS connector. For more information, see
Zero Trust Network Access (ZTNA) on page 691 and Configuring FortiClient EMS Connector for ZTNA on page
696.

l You must have Read-Write permission for System settings.

To create and configure a ZTNA Profile:

1. Go to Network Security > ZTNA.
2. Click the ZTNA Profile tab.
3. Click Create New to display the configuration editor.
4. Configure the following:

Parameter Description

Name Specify the ZTNA Profile name. Valid characters are A-Z, a-z, 0-9, _, and -. No
spaces.

Log Status Enable/disable logging.

Comments Optionally, enter comments about the ZTNA Profile.

5. Click Save.
6. Under Rule List, click Create New to display the configuration editor.
7. Configure the following:

Parameter Description

Source IP Select the source IPs.

ZTNA Tags Select the ZTNA tags.

Action Select either of the following actions:
l Pass
l Deny

Deny is the default action.

Comments Optionally, enter comments about the ZTNA rule.

FortiADC Handbook 702
Fortinet Technologies Inc.



Zero Trust Network Access (ZTNA)

8. Click Save.

Apply the Security ZTNA profile to a Layer 7 HTTPS or TCPS virtual server to activate ZTNA for server load balancing.
Ensure the corresponding Client SSL profile is enabled for client certificate verification. For details, see Configuring
virtual servers on page 328 and Configuring Client SSL profiles on page 412.

ZTNA troubleshooting and debugging

The following CLI commands can be used to troubleshoot ZTNA issues:

Command Description

# execute fctems test-
connectivity <EMS>

Verify the FortiADC to FortiClient EMS connectivity. This provides the connection
status of your FortiClient EMS connector configuration. If the connection is not
successful, further detail is provided for the status condition.

# execute fctems is-
verified <EMS>

Check if the configured EMS server has a verified certificate.

# diagnose debug module
fcnacd

View information about your FortiClient NAC daemon (fcnacd), which handles
FortiADC to FortiClient EMS connectivity.

# diagnose endpoint-
control client list

List the FortiClient endpoints synchronized to FortiADC from FortiClient EMS.

# diagnose endpoint-
control tag list

List the ZTNA tags synchronized to FortiADC from FortiClient EMS.

# diagnose debug module
httproxy ztna

View information about your Layer 7 HTTPS virtual server that has referenced a
ZTNA Profile.

For details of the above commands, see the FortiADC CLI Reference document.

FortiADC Handbook 703
Fortinet Technologies Inc.

https://docs.fortinet.com/document/fortiadc/latest/cli-reference/


DoS Protection

DoS Protection

The DoS Protectionmenu contain features and configurations that allow you to protect your applications against DoS
(denial-of-service) attacks.

This section is organized into the following sub-menu topics:

l DoS Protection Profile on page 704
l Application on page 706
l Networking on page 714

DoS Protection Profile

From the DoS Protection > DoS Protection Profile sub-menu, you can configure a DoS Protection profile that
references the DoS policies that are to be enforced.

Before you begin:

l You must have Read-Write permission for Security settings.

After you have configured DoS Protection profile, you can select them in Server Load Balance > Virtual Server >
Security > DoS Protection Profile.
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To configure a DoS Protection Profile:

1. Go to DoS Protection > DoS Protection Profile.
2. Click Create New to display the configuration editor.
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3. Complete the configuration.

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -.
No spaces.
After you initially save the configuration, you cannot edit the
name.

HTTP Access Limit HTTP Access Limit policy. Limit the request number per second
from an IP.

HTTP Connection Flood HTTP Connection Flood policy. Limit the number of connections
from a client, which is marked by a cookie.

HTTP Request Flood HTTP Request Flood policy. Limit the request number per
second from a client, which is marked by a cookie.

TCP Slow Data Flood Protection After the TCP connection is established (the three-way
handshake is completed), if FortiADC sends data to the client
but the client returns a zero window (a zero window appears
when, for example, the client does not take the data out of the
TCP receive queue of the client OS when the data sent by the
FortiADC fills up the queue), FortiADC will stop sending data. In
this case, FortiADC can actively abort TCP connections and
release related resources to avoid occupying its resources for a
long time.

TCP Connection Access Flood Protection A TCP connection flood attempts to prevent legitimate requests
from being established by flooding the server with requests for
new connections. By setting a threshold limit for TCP requests,
FortiADC can detect and take action to protect against a TCP
connection flood.

DNS Query Flood Protection The DNS Query Flood Protection policy can limit the number of
DNS request per second to mitigate against DNS query flood
attacks that aim to overwhelm DNS servers with high volumes of
illegitimate DNS queries.

DNS Reverse Flood Protection The DNS Reverse Flood Protection policy can limit the number
of ANY type DNS requests per second to mitigate against DNS
reverse flood attacks that aim to overwhelm network resources
with high volumes of DNS responses.

4. Save the configuration.

Application

The DoS Protection > DoS Protection Profile sub-menu allows you to perform the following tasks to configure the
application DoS protection:

l Configuring an HTTP access limit policy on page 707
l Configuring an HTTP connection flood policy on page 707
l Configuring an HTTP request flood policy on page 708
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l Configuring a DNS Query Flood Protection policy on page 709
l Configuring a DNS Reverse Flood Protection policy on page 711

Configuring an HTTP access limit policy

HTTP Access Limit policies can limit the speed of HTTP request from a source IP.

Before you begin:

l You must have Read-Write permission for Security settings.

After you have configured HTTP Access Limit policies, you can select them in DoS Protection Profile.

To configure an HTTP Access Limit policy:

1. Go to DoS Protection > Application.
The configuration page displays the HTTP Access Limit tab.

2. Click Create New to display the configuration editor.
3. Complete the configuration.

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces.

Status Enable | Disable. If Enable, this policy will be activated, otherwise it is inactive.

HTTP Request
Limit

0-65535. Limits the amount of HTTP requests per second from a certain IP. 0 means no limit
for HTTP request.

Action Pass—Allow the traffic.
Deny—Drop the traffic, send a 400 Bad request to the client.
Period Block—Deny all the HTTP request from a source IP within a period which specified by
Period Block.
Captcha—Requires the client to successfully fulfill the CAPTCHA request

Period Block 1-3600 seconds; Default: 60

Log Enable | Disable; If Enable the Action will be log

Severity High—Log as high severity events.
Medium—Log as a medium severity events.
Low—Log as low severity events.
The default value is High.

4. Save the configuration.

Configuring an HTTP connection flood policy

HTTP Connection Flood policy can limit connections from a client which are marked by a cookie.

Before you begin:

l You must have Read-Write permission for Security settings.
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After you have configured HTTP Connection Flood policies, you can select them in DoS Protection Profile.

To configure an HTTP Connection Flood policy:

1. Go to DoS Protection > Application.
2. Click the HTTP Connection Flood tab.
3. Click Create New to display the configuration editor.
4. Complete the configuration.

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces.

Status Enable | Disable. If Enable, this policy will be activated, otherwise is in-active.

HTTP Connection
Number Limit

1-1024. Limits the number of TCP connections with the same session cookie.

Action Pass—Allow the traffic.
Deny—Drop the traffic, send a 400 Bad request to the client.
Period Block—Deny all the HTTP request from a source IP within a period which
specified by Period Block.
Captcha—Requires the client to successfully fulfill the CAPTCHA request

Period Block 1-3600 seconds; Default: 60

Log Enable | Disable; If Enable the Action will be log

Severity High—Log as high severity events.
Medium—Log as a medium severity events.
Low—Log as low severity events.
The default value is High.

5. Save the configuration.

Configuring an HTTP request flood policy

HTTP Request Flood policy can limit the speed of HTTP requests from a client which is marked by a cookie.

Before you begin:

l You must have Read-Write permission for Security settings.

After you have configured HTTP Request Flood policies, you can select them in DoS Protection Profile.

To configure an HTTP Request Flood policy:

1. Go to DoS Protection > Application.
2. Click the HTTP Request Flood tab.
3. Click Create New to display the configuration editor.
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4. Complete the configuration.

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces.

Status Enable | Disable. If enabled, this policy will be activated, otherwise it is inactive.

HTTP Request
Limit

0-65535. Limits the number of HTTP requests per second with the same session cookie. 0
means no limit for HTTP request.

Action Pass—Allow the traffic.
Deny—Drop the traffic, send a 400 Bad request to the client.
Period Block—Deny all the HTTP requests from a source IP within a period specified by Period
Block.
Captcha—Requires the client to successfully fulfill the CAPTCHA request

Period Block 1-3600 seconds; Default: 60

Log Enable | Disable; If Enable the Action will be log

Severity High—Log as high severity events.
Medium—Log as a medium severity events.
Low—Log as low severity events.
The default value is High.

5. Save the configuration.

Configuring a DNS Query Flood Protection policy

The DNS Query Flood Protection policy can limit the number of DNS request per second to mitigate against DNS query
flood attacks.

A DNS query flood is a type of DDoS attack that targets the DNS server using DNS query and response traffic. A DNS
query flood attack aims to overwhelm the target's resources with an excessive volume of fake requests, causing service
unavailability and disrupting legitimate user access to the online service.
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Using the DNS Query Flood Protection policy, you can set a DNS Query Rate Limit to restrict the number of queries that
can be made per second. Once the query rate exceeds the limit, it will trigger a corresponding action (Pass or Deny).

After you have configured a DNS Query Flood Protection policy, you can apply it in a DoS Protection Profile.

To configure a DNS Query Flood Protection policy:

1. Go to DoS Protection > Application.
2. Click the DNS Query Flood Protection tab.
3. Click Create New to display the configuration editor.

4. Configure the following DNS Query Flood Protection settings:

Setting Description

Name Specify a name for the DNS Query Flood Protection policy.
Valid characters are A-Z, a-z, 0-9, _, and -. No spaces. The configuration
name cannot be edited once it has been saved.

Status Enable/disable the status of this DNS Query Flood Protection policy.

DNS Query Rate Limit Specify the allowable number of DNS requests per second. The range is 0 to
1048567. The default is 0, which means that no limit is placed on the number
of DNS queries that can be made per second.
Note:
Multiple "rate limit" type of operations may be executed through various
configurations, however, they cannot be executed all at once. Priority is given
to certain rate limit operations. The following lists the execution sequence.
1. Transaction Rate Limit (from the virtual server configuration).
2. DNS Query Rate Limit (from DNS Query Flood Protection policy).
3. ANY Query Rate Limit (from DNS Reverse Flood Protection policy).

Action Select the corresponding action to take when the DNS Query Rate Limit is
exceeded:
l Pass— Allow the traffic.
l Deny—Drop the traffic, send a 400 Bad request to the client.

Deny is the default option.
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Setting Description

Log Enable/disable logging for the Action. This is disabled by default.

Severity Select the event severity to log when the DNS Query Flood Protection policy is
triggered:
l High— Log as high severity events.
l Medium— Log as a medium severity events.
l Low— Log as low severity events.

The default is High.

5. Click Save.
After the new DNS Query Flood Protection policy has been saved, it will appear in the DNS Query Flood Protection
page. You can now apply this DNS Query Flood Protection policy to a DoS Protection Profile configuration.

Statistical data of DNS Query Flood attacks are recorded in Security logs in detail
(from FortiView and Log & Report), and in the Dashboard Security widget as event
counts.
Typically, Security logs provide the attack count as well, however, due to the speed
at which DNS Query Flood attacks can occur (within milliseconds), the Security logs
cannot accurately count each attack as the logs are counted every 1 second. This
means that when a DNS Query Flood attack occurs, Security logs can only capture
the attack details but not the accurate count of the number of packets that has
exceeded the DNS Query Rate Limit.
To view the correct count of each DNS Query Rate Limit excess event, you can
reference the Security widget from the Dashboard that is a dedicated security event
counter.

Configuring a DNS Reverse Flood Protection policy

The DNS Reverse Flood Protection policy can limit the number of ANY type DNS requests per second to mitigate
against DNS reverse flood attacks.

A DNS reverse flood is a type of DDoS attack that uses high volumes of DNS responses to over-
whelm network resources. When a small request has a disproportionately larger response, the
outbound network pipe can easily become congested and disrupt traffic responses for legit-
imate requests and/or other applications. And since the transport protocol is UDP, these types
of requests can be easily spoofed.

One popular form of DNS reverse flood attack is DNS amplification attack. The Attacker sends
out a DNS query with a forged IP address (the Victim's) to an open DNS resolver, prompting it
to reply back to that address with a DNS response. With numerous fake queries being sent out,
and with several DNS resolvers replying back simultaneously, the Victim's network can easily
be overwhelmed by the high volume of DNS responses.
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Using the DNS Reverse Flood Protection policy, you can set a ANY Query Rate Limit to restrict the number of all types
(ANY) of DNS queries that can be made per second. Once the query rate exceeds the limit, it will trigger a corresponding
action (Pass or Deny).

After you have configured a DNS Reverse Flood Protection policy, you can apply it in a DoS Protection Profile.

To configure a DNS Reverse Flood Protection policy:

1. Go to DoS Protection > Application.
2. Click the DNS Reverse Flood Protection tab.
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3. Click Create New to display the configuration editor.

4. Configure the following DNS Reverse Flood Protection settings:

Setting Description

Name Specify a name for the DNS Reverse Flood Protection policy.
Valid characters are A-Z, a-z, 0-9, _, and -. No spaces. The configuration
name cannot be edited once it has been saved.

Status Enable/disable the status of this DNS Reverse Flood Protection policy.

ANY Query Rate Limit Specify the allowable number of DNS requests per second, with query type
ANY. The range is 0 to 1048567. The default is 0, which means that no limit is
placed on the number of DNS queries that can be made per second.
Note:
Multiple "rate limit" type of operations may be executed through various
configurations, however, they cannot be executed all at once. Priority is given
to certain rate limit operations. The following lists the execution sequence.
1. Transaction Rate Limit (from the virtual server configuration).
2. DNS Query Rate Limit (from DNS Query Flood Protection policy).
3. ANY Query Rate Limit (from DNS Reverse Flood Protection policy).

Action Select the corresponding action to take when the ANY Query Rate Limit is
exceeded:
l Pass— Allow the traffic.
l Deny—Drop the traffic, send a 400 Bad request to the client.

Deny is the default option.

Log Enable/disable logging for the Action. This is disabled by default.

Severity Select the event severity to log when the DNS Reverse Flood Protection policy
is triggered:
l High— Log as high severity events.
l Medium— Log as a medium severity events.
l Low— Log as low severity events.

The default is High.

FortiADC Handbook 713
Fortinet Technologies Inc.



DoS Protection

5. Click Save.
After the new DNS Reverse Flood Protection policy has been saved, it will appear in the DNS Reverse Flood
Protection page. You can now apply this DNS Reverse Flood Protection policy to a DoS Protection Profile
configuration.

Statistical data of DNS Reverse Flood attacks are recorded in Security logs in detail
(from FortiView and Log & Report), and in the Dashboard Security widget as event
counts.
Typically, Security logs provide the attack count as well, however, due to the speed
at which DNS Reverse Flood attacks can occur (within milliseconds), the Security
logs cannot accurately count each attack as the logs are counted every 1 second.
This means that when a DNS Reverse Flood attack occurs, Security logs can only
capture the attack details but not the accurate count of the number of packets that
has exceeded the ANY Query Rate Limit.
To view the correct count of each ANY Query Rate Limit excess event, you can
reference the Security widget from the Dashboard that is a dedicated security event
counter.

Networking

The DoS Protection > Networking sub-menu allows you to perform the following tasks to configure the network DoS
protection:

l Configuring an IP fragmentation policy on page 714
l Configuring a TCP SYN flood protection policy on page 715
l Configuring a TCP slow data flood protection policy on page 715
l Configuring a TCP connection access flood protection policy on page 716

Configuring an IP fragmentation policy

IP Packet fragmentation assures that IP data grams can flow through any other type of network. It allows data grams
created as a single packet to be split into many smaller packets for transmission and reassembled at a receiving host. A
DDoS attack can deny services to the network by creating a fragmented data gram of a large enough size to overrun the
buffers in your router.

The attack purpose is to consume the systemmemory and network bandwidth in the shortest possible time. We can limit
the maximum usage of memory in each socket, the maximum distance counters between fragmentation packages from
the same source IP, and the receiving timeout for an entire package.

Before you begin:

l You must have Read-Write permission for Security settings.

To configure an IP fragmentation policy:

1. Go to DoS Protection > Networking.
The configuration page displays the IP Fragmentation Protection tab.
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2. Click Edit to display the configuration editor.
3. Complete the configuration.

Max Memory
Size Limit

Maximummemory size of the IP fragmentation packet for the vdom. If the limit is reached,
FortiADC will stop doing IP fragmentation reassemble.

Min Memory
Size Limit

When total IP fragmentation memory size drops to this limit, FortiADC will start to do
fragmentation reassemble again.

Timeout Max life time for each fragmentation queue. All the fragmentation packets in the queue will be
dropped if the queue exceed this timeout.

4. Save the configuration.

Configuring a TCP SYN flood protection policy

TCP SYN flood protection is a global setting to protect all virtual server traffic from SYN flood attacks. After the
SYN Cookie option is enabled, each virtual server will monitor SYN rate. If the average SYN rate in 10 seconds exceeds
Maximum Half-Open Sockets, it will perform SYN Cookie on all subsequent new connections (SYN packets) of this
virtual server until the rate drops to below Maximum Half-Open Sockets.

Before you begin:

l You must have Read-Write permission for Security settings.

To configure a TCP SYN Flood Protection policy:

1. Go to DoS Protection > Networking.
2. Click the TCP SYN Flood Protection tab.
3. Click Edit to display the configuration editor.
4. Complete the configuration.

SYN Cookie Enable/disable syn flood protection.

Maximum
Half-Open
Sockets

If the average half-open connection rate in 10 seconds for each VS exceeds this setting, it will
enable SYN Cookie for all new following TCP connections for this virtual server. If the average
rate drops to below this, it will disable SYN Cookie for this virtual server.

5. Save the configuration.

Configuring a TCP slow data flood protection policy

A Slow Data attack sends legitimate application layer requests but reads responses very slowly. With that, it may attempt
to exhaust the target’s connection pool. Slow reading advertises a very small number for the TCP Receive Window size
and at the same time empties the client’s TCP receive buffers slowly. This ensures a very low data flow rate.

The attack purpose is to consume the system resources (memory, CPU time) slowly. We can disable the connection
when sending many probe packages fails in the zero-window timer.
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Before you begin:

l You must have Read-Write permission for Security settings.

After you have configured HTTP Request Flood policies, you can select them in DoS Protection Profile.

To configure a TCP Slow Data Flood Protection policy:

1. Go to DoS Protection > Networking.
2. Click the TCP Slow Data Flood Protection tab.
3. Click Create New to display the configuration editor.
4. Complete the configuration.

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces.

Status Enable | Disable. If Enable, this policy will be activated, otherwise is inactive.

Probe
Interval

Set probe interval time for the TCP zero window timer. After receiving a zero window packet,
FortiADC will probe the peer side periodically until it returns with >0 window, or when probe count
exceeds the max probe-count.

Probe
Count

Max consecutive zero window probe count.

Action Action after exceed max probe count.
Pass—if the probe count exceeds probe-count, stop the probe and pass all the packets in both
directions.
Deny—deny the connection with RST.
Block-period—deny the connection, and block any new connection from the peer side for a period of
time.

Severity High—Log as high severity events.
Medium—Log as a medium severity events.
Low—Log as low severity events.
The default value is High.

Log Enable or disable log

5. Save the configuration.

Configuring a TCP connection access flood protection policy

A TCP connection flood attempts to prevent legitimate requests from being established by flooding the server with
requests for new connections. By setting a threshold limit for TCP requests, FortiADC can detect and take action to
protect against a TCP connection flood.

Before you begin:

l You must have Read-Write permission for Security settings.
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To configure a TCP Connection Access Flood Protection policy:

1. Go to DoS Protection > Networking.
2. Click the TCP Connection Access Flood Protection tab.
3. Click Create New to display the configuration editor.
4. Configure the following settings:

Setting Description

Name Enter a unique name for the TCP Connection Access Flood Protection
configuration. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces.

Status If enabled, this policy will be activated, otherwise it is inactive. This is enabled
by default.

Limit Limit the number of TCP connections per source IP address. Default: 0 Range:
0-65535. 0 means no TCP request limit.

Action Specify the action to take when the TCP connection number exceeds the limit.
l Pass— allow the new connection from this IP address.
l Deny— deny the new connection from this IP address
l Period Block— deny the new connection from this IP address for a period
of time.

The default action is Deny.

Period Block The Period Block option is available if the Action is Period Block.
Specify the number of seconds to block new TCP connections from being
established. During this period, new TCP connection requests will be aborted.
Default: 60 Range: 1-3600 seconds.

Log Enable or disable log. This is disabled by default.

Severity Specify the log severity level.
l Low— Log as low severity events.
l Medium— Log as a medium severity events.
l High— Log as high severity events.

The default severity level is High.

5. Click Save.
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User Authentication

The User Authenticationmenu contain features and configurations relating to user authentication.

This section is organized into the following sub-menu topics:

l Authentication Policy on page 718
l User Group on page 720
l Local User on page 725
l Remote User on page 727
l Authentication Relay on page 742
l SAML on page 747
l AD FS Proxy on page 750
l OAuth Proxy on page 753

Authentication Policy

From the User Authentication > Authentication Policy sub-menu, you can configure authentication policies to set the
conditions that mandate authentication and reference the user group that has authorization.

For example, you can define an auth policy that has the following logic: if the Host header matches example.com and
the URI matches /index.html, then the group example-group is authorized. FortiADC supports the Basic
Authentication Scheme described in RFC 2617.

Authorization and authentication on page 718 illustrates the client-server communication when authorization is required.

Authorization and authentication
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1. The client sends an HTTP request for a URL belonging to a FortiADC virtual server that has an authorization policy.
2. FortiADC replies with an HTTP 401 to require authorization. On the client computer, the user might be prompted

with a dialog box to provide credentials.
3. The client reply includes an Authorization header that gives the credentials.
4. FortiADC sends a request to the server (local, LDAP, or RADIUS) to authenticate the user.
5. The authentication server sends its response, which can be cached according to your user group configuration.
6. If authentication is successful, FortiADC continues processing the traffic and forwards the request to the real server.
7. The real server responds with an HTTP 200 OK.
8. FortiADC processes the traffic and forwards the server response to the client.

Before you begin:

l You must have created the user groups to be authorized with the policy. You also configure users and
authentication servers separately. See Configuring user groups.

l You must have read-write permission for Server Load Balance settings.

After you have configured an auth policy, you can select it in the virtual server configuration. Note the following
requirements:

l Virtual server type must be Layer 2 or Layer 7.
l Profile type must be HTTP or HTTPS.
l The profile option once-only must be disabled.

To configure an authentication policy:

1. Go to User Authentication > Authentication Policy.
2. Click Create New to display the configuration editor.
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3. Complete the configuration as described in Authentication policy configuration on page 720.
4. Save the configuration.

Settings Guidelines

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces. You reference
this name in the virtual server configuration.
Note: After you initially save the configuration, you cannot edit the name.

Member

Host Status If enabled, require authorization only for the specified host. If disabled, ignore hostname in the
HTTP request header and require authorization for requests with any Host header. Disabled
by default.

Host Specify the HTTP Host header. If Host Status is enabled, the policy matches only if the Host
header matches this value. Complete, exact matching is required. For example,
www.example.commatches www.example.com but not www.example.com.hk.

Type Select either of the following:
l Standard
l SAML
l OAuth

User Realm Realm to which the Path URI belongs. The realm is included in the basic authentication
header in the HTTP 401 message sent to the client. If a request is authenticated and a realm
specified, the same credentials are deemed valid for other requests within this realm.
Available only if Standard is selected as the Type.

Path Require authorization only if the URI of the HTTP request matches this pathname. If none is
specified, requests to any URI require authorization. The value is parsed as a match string
prefix. For example, /abcmatches http://www.example.com/abcd and
http://www.example.com/abc/11.html but not
http://www.example.com/1abcd.

User Group Select the user group that is authorized to access the protected resource.
Available only if Standard is selected as the Type.

SAML SSO ID Select the SAML SSO ID that is authorized to access the protected resource.
Available only if SAML is selected as the Type.

OAuth Policy Select the OAuth policy that is authorized to access the protected resource.
Available only ifOAuth is selected as the Type.

Authentication policy configuration

User Group

The User Authentication > User Group sub-menu allows you to perform the following tasks to configure user groups
for user authentication:
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l Configuring user groups on page 721
l Configuring customized authentication forms on page 723

Configuring user groups

User groups are authorized by the virtual server authentication policy. The user group configuration references the
authentication servers that contain valid user credentials.

Suggested steps:

1. Configure LDAP, RADIUS, NTLM, and TACACS+ servers, if applicable.
2. Configure local users.
3. Configure user groups (reference servers and local users).
4. Configure an authentication policy (reference the user group).
5. Configure the virtual server (reference the authentication policy).

Before you begin:

l You must have created configuration objects for any LDAP, RADIUS, NTLM, and/or TACACS+ servers you want to
use, and you must have created user accounts for local users.

l You must have read-write permission for System and User settings.

After you have created user groups, you can specify them in the server load balancing authentication policy
configuration.

To configure a user group:

1. Go to User Authentication > User Group.
The configuration page displays the User Group tab.

2. Click Create New to display the configuration editor.
3. Configure the following User Group settings:

Settings Guidelines

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces.
After you initially save the configuration, you cannot edit the name.

User Cache Enable to cache the credentials for the remote users (LDAP, RADIUS, TACACS+)
once they are authorized.

User Cache Timeout The User Cache Timeout option is available if User Cache is enabled.
Timeout for cached user credentials. The default is 300 seconds. The valid range is
1-86,400 seconds.

Authentication Timeout Timeout for query sent from FortiADC to a remote authentication server. The default
is 2,000 milliseconds. The valid range is 1-60,000 milliseconds.

Authentication Log Specify one of the following logging options for authentication events:
l None—No logging.
l Fail — Log failed attempts.
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Settings Guidelines

l Success— Log successful attempts.
l All — Log all (both failed and successful attempts).

Client Authentication
Method

l HTML Form
l HTTP
l NTLM (only if you want to use NTLM server as a authentication server)

Use Default Form The Use Default Form option is available if Client Authentication Method is
HTML Form.
Enabled by default to use the default authentication form. Disable to use a
customized authentication form.

Customized
Authentication Form

The Customized Authentication Form option is available if Client
Authentication Method is HTML Form and Use Default Form is disabled.
Select a Customized Authentication Form object or create new.

Group Type l Normal — Default. No action is needed.
l SSO—Select to enable Single Sign-On (SSO).

Authentication Relay The Authentication Relay option is available ifGroup Type is SSO.
Select an authentication relay profile.

Authentication Session
Timeout

Specify the authentication session timeout. Valid values range from 1 to 180
minutes. The default is 3 (minutes).

SSO Cross Domain
Support

The SSO Cross Domain Support option is available ifGroup Type is SSO.
Disabled by default. When enabled, you must specify the SSO domain.
Note:
Authentication policies cannot be applied to multiple virtual servers. Due to security
reasons, such as protection against XSS attacks, there is no shared mechanism
between virtual servers to decrypt cookies. As a result, you cannot log into a second
virtual server while already logged into the first virtual server as the virtual servers
are independent from each other.
SSO Cross Domain Support allows you to have multiple domain names on the same
virtual server (the virtual host), where you can specify a first-level domain name to
enable the second-level domain names on the virtual server to decrypt cookies at
the same time.

SSO Domain The SSO Domain option is available ifGroup Type is SSO and SSO Cross
Domain Support is enabled.
Specify the SSO domain.

Log Off URL The Log-off URL option is available ifGroup Type is SSO.
Specify the log-off URL.

4. Click Save.
Once the User Group configuration is saved, theMember section becomes available for configuration.

5. Under theMember section, click Create New to display the configuration editor.
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6. Configure the following Member settings and save the configuration:
a. Select the Type: Local, LDAP, RADIUS, NTLM, or TACACS+.
b. Select the corresponding configuration based on the selected Type.

7. Click Save again to save the Member added to the User Group configuration.

Configuring customized authentication forms

FortiADC allows you to customize your login page with your company brand images and modify the layout/text.

Similar to the GUI of the error page, we allow the user to upload a zip/tar/tar.gz file. The file must include a login.html file
and you must use onsubmit="return Fsb(event)" in your form. It must include the tag %%auth_script%%.

To configure a Customized Authentication Form:

1. 1. Go to User Authentication > Customized Authentication Form.
2. 2. Click Create New to display the configuration editor.
3. 3. Complete the configuration for the customized authentication form.
4. 4. Save the configuration.

Settings Guidelines

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces. After
you initially save the configuration, you cannot edit the name.

File File package for customize Authentication form page. Click ‘Choose File’ to
upload.

Username Field Name The username field name in customize form

Password Field Name The password field name in customize form

Virtual Path Virtual path of customized authentication form function. This path is running on
VS, so it will conflict with other configure like error page’s vpath and Captcha.

The following is an example of a login.html file:

<html>
<head>
<style type="text/css">html, body, div, h1, p, form, section,{fontsize:
100%;font:inherit;vertical-align:baseline;} section {display:block;} body

{lineheight:1;font:13px/20px 'Lucida Grande',Tahoma,Verdana,sansserif;
color:#404040;background:#fff;} .cter {margin:80px auto;width:640px;} .lgin
{position:relative;margin:0 auto;padding:20px 20px
20px;width:270px;background:#f2f2f2;border-radius:3px;} .lgin h1 {margin:-20px -20px
21px;line-height:40px;font-size:15px;font-
weight:bold;color:white;textalign:center;background:#555555;border-bottom:1px solid
#cfcfcf;border-radius:3px 3px 0 0;} .lgin p {margin:20px 0 0;} .lgin p.submit {text-
align:center;} input[type=text], input[type=password] {margin:5px;padding:0
10px;width:160px;height:25px;color:#404040;background:white;border:1px
solid;bordercolor:#c4c4c4 #d1d1d1 #d4d4d4;outline:3px solid #eff4f7;} input
[type=text]:focus, input [type=password]:focus {border-color:#7dc9e2;outline-
color:#dceefc;outline-offset:0;} input[type=submit] {padding:0 18px;height:29px;font-
size:12px;fontweight:bold;color:#527881;background:#cde5ef;border:1px solid;border-
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color:#b4ccce #b3c0c8 #9eb9c2;border-radius:8px;outline:0;} input[type=submit]:active
{background:#dfe7f2;border-color:#9eb9c2 #b3c0c8 #b4ccce;}</style>

</head>
%%auth_script%%
<body >
<section class="cter">
<div class="lgin">
<h1>Web Authentication</h1>
<form method="post" action="/" onsubmit="return Fsb(event)">
<p>UserName: <input type="text" id="customize-username" required></p>
<p>Password : <input type="password" id="pwd" required></p>
<p class="submit"><input type="submit" value="Login"></p>
</form>
</div>
</section>
</body>
</html>

Using the information from the example login.html file, the following is the corresponding Customized Authentication
Form configuration in the GUI.

The corresponding CLI configuration:

config user cust_auth_form
edit "customized-auth-form-example"

set auth_form-file customized-auth-form-example.zip
set username_field customized-username
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set password_field pwdcustomized-password
set virtual_path adcvirtualpath-forAuthForm2

next
end

Using the customized authentication form for 2FA token

To use a token for 2FA, you can upload a zip/tar/tar.gz file. The file must include a token_page.html file that contains the
tag %%token_script%% that you can use in your web page and use onsubmit="return Fsb(event)" in your form.

The following is an example of token_page.html file for 2FA token:

<html>
<head>

<style type="text/css">html, body, div, h1, p, form, section,{font-
size:100%;font:inherit;vertical-align:baseline;} section {display:block;} body {line-
height:1;font:13px/20px 'Lucida Grande',Tahoma,Verdana,sans-
serif;color:#404040;background:#fff;} .cter {margin:80px auto;width:640px;} .lgin
{position:relative;margin:0 auto;padding:20px 20px
20px;width:270px;background:#f2f2f2;border-radius:3px;} .lgin h1 {margin:-20px -20px
21px;line-height:40px;font-size:15px;font-weight:bold;color:white;text-
align:center;background:#555555;border-bottom:1px solid #cfcfcf;border-radius:3px 3px 0 0;}
.lgin p {margin:20px 0 0;} .lgin p.submit {text-align:center;} input[type=text], input
[type=password] {margin:5px;padding:0
10px;width:160px;height:25px;color:#404040;background:white;border:1px solid;border-
color:#c4c4c4 #d1d1d1 #d4d4d4;outline:3px solid #eff4f7;} input[type=text]:focus, input
[type=password]:focus {border-color:#7dc9e2;outline-color:#dceefc;outline-offset:0;} input
[type=submit] {padding:0 18px;height:29px;font-size:12px;font-
weight:bold;color:#527881;background:#cde5ef;border:1px solid;border-color:#b4ccce #b3c0c8
#9eb9c2;border-radius:8px;outline:0;} input[type=submit]:active {background:#dfe7f2;border-
color:#9eb9c2 #b3c0c8 #b4ccce;}</style>

</head>
%%token_script%%
<body >

<section class="cter">
<img align="middle" src="goldbrig.jpg">

<div class="lgin">
<h1>2FA-Mick-page</h1>
<form method="post" action="/" onsubmit="return Fsb(event)">

<p>Token: <input type="text" id="token" required></p>
<p class="submit"><input type="submit" value="Login"></p>

</form>
</div>

</section>
</body>

</html>

Local User

From the User Authentication > Local User sub-menu, you can configure a local authentication server to authenticate
destination server user logins. FortiADC uses FortiToken Cloud as the remote authentication server which provides the
security token needed for two-factor authentication on FortiADC.
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To assign a FortiToken Cloud to a local server, the device must be registered on the same account as the FortiToken
Cloud contracts; see Fortinet Customer Service & Support.

Note: The local authentication server does not have user-initiated password management features, so it does not easily
scale to large groups of users. For large deployments, we recommend you use RADIUS or LDAP and provide
instructions on your website how users can reset, recover, or change their passwords.

The FortiToken Cloud User is only supported if the Client Authentication Method in the User group configuration is HTML
Form.

Basic steps:

1. Add user accounts to the local authentication server.
2. Select the local authentication server configuration and username when you create user groups.

Before you begin:

l You must have Read-Write permission for System settings.

To use a local authentication server:

1. Go to User Authentication > Local User.
2. Click Create New to display the configuration editor.
3. Complete the configuration as described in Local authentication server configuration on page 726.
4. Save the configuration.

Settings Guidelines

Name Name of the user account, such as user1 or user1@example.com.
Do not use spaces or special characters except the ‘at’ symbol ( @) or dot (.). The maximum
length is 35 characters.
After you initially save the configuration, you cannot edit the name.

Password Specify a password. The stored password will be encrypted.

Two-factor
Authentication

l None—Default. Use the local authentication
l FortiToken Cloud— Enable to 2FA authentication using FortiToken Cloud service.

Note: FortiADC does not support FortiToken Cloud functionality in HA condition.

Email Address The email is the email address that will receive the OTP. We will send the registration
information including the QR code to help the user to register on the FortiToken app.

County Dial Code The phone of the country code.

Phone Number Use this phone number to send the OTP in an SMS text message to the mobile device

FortiToken Mobile
Push

Enable two-factor push notifications to your mobile app for fast and secure access.

Local authentication server configuration
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Remote User

The User Authentication > Remote User sub-menu allows you to perform the following tasks to configure remote
servers for user authentication:

l Using an LDAP authentication server on page 727
l Using a RADIUS authentication server on page 737
l Using an NTLM authentication server on page 739
l Using a TACACS+ authentication server on page 740

Using an LDAP authentication server

Lightweight Directory Access Protocol (LDAP) is an application protocol for accessing and maintaining distributed
directory information services over a network. When using LDAP, authentication clients may send “Bind” messages to
servers for authentication. Depending on the circumstances, clients may send different kinds of “Bind” messages.

LDAP bind messages

In a server load-balancing client authentication or admin authentication scenario, FortiADC sends binding request to the
LDAP server for client authentication. Once a client is successfully authenticated, he or she can then access the LDAP
server based on his or her privileges. There are three bind types: simple, anonymous, and regular.

Simple bind

Simple bind means binding with a client's full name.

Anonymous bind

Anonymous bind should be used only if the LDAP server allows it. The LDAP server searches for the client in the entire
sub-branches, starting from the specified DN. This bind has two steps: First, FortiADC sends the binding request to
specify the search entry point. Then, it sends a search request with the specified scope and filter to the LDAP server to
find the given client.

Regular bind

Regular bind can be used when anonymous binding is not allowed on the LDAP server. Regular bind is similar to
anonymous bind. The difference is in the initial step. Unlike anonymous bind, regular bind requires that FortiADC get the
access privileges on the LDAP server with the specified User DN in the first step. After it has obtained the authorization,
FortiADC can then move on to the second step as it does in anonymous bind.

LDAP over SSL (LDAPS) and StartTLS

LDAP over SSL (LDAPS) and StartTLS are used to encrypt LDAPmessages in the authentication process.

LDAPS is a mechanism for establishing an encrypted SSL/TLS connection for LDAP. It requires the use of a separate
port, commonly 636. StartTLS extended operation is LDAPv3 standard mechanism for enabling TLS (SSL) data
confidentiality protection. The mechanism uses an LDAPv3 extended operation to establish an encrypted SSL/TLS
connection within an already established LDAP connection.
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Configuring LDAP binding

You can use an LDAP authentication server to authenticate administrator or destination server user log-ins.

Basic steps:

1. Configure a connection to an LDAP server that can authenticate administrator or user logins.
2. Select the LDAP server configuration when you add administrator users or create user groups.

Before you begin:

l You must know the IP address or FQDN and the port used to access the LDAP server. You must know the CN and
DN where user credentials are stored on the LDAP server.

l You must have Read-Write permission for System settings.

To select an LDAP server:

1. Go to User Authentication > Remote Server.
2. Click the LDAP Server tab.
3. Click Create New to display the configuration editor.
4. Complete the configuration as described in LDAP server configuration on page 728.
5. Click Test Connectivity to validate the configuration.
6. Save the configuration.

Settings Guidelines

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces.
After you initially save the configuration, you cannot edit the name.

Server IP address or FQDN of the LDAP server.
Note: When enabling LDAPS or StartTLS, please use the common name (CN) of
the LDAP server certificate in this field if you want to identify the Server with the
CA profile (see CA Profile on page 729).

Port Port number for the server.
Port 389 is typically used for non-secured connections or for StartTLS-secured
connections, and port 636 is typically used for SSL-secured (LDAPS)
connections.

Common Name Identifier Enter the identifier for the common name (CN) attribute (also called the CNID)
whose value is the user name.
Identifiers vary based on the schema of your LDAP directory. This is often cn or
uid. For Windows Active Directory, it is often the attribute sAMAccountName.
For example, in a default OpenLDAP directory, if a user object is
uid=fortiadc,cn=users,dc=fortinet,dc=com

then the CNID is uid.

Distinguished Name Specifies the Base DN from which the LDAP query starts. This DN is the full path
in the directory to the user account objects.

LDAP server configuration
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Settings Guidelines

For example:
ou=People,dc=example,dc=com

or
cn=users,dc=example,dc=com

You can use the Fetch DN function to get the entire Directory Information Tree,
and select the DN of the LDAP query starting entry.
Note: When using Windows Active Directory as the LDAP server, you may need
to use regular bind for FortiADC to get access permission for LDAP entries when
using the Fetch DN function.

Bind Type l Simple—bind without user search. It can be used only if all the users belong
to the same “branch”.

l Anonymous—bind with user search. It can be used when users are in
different “branches” and only if the server allows “anonymous search”.

l Regular—bind with user search. It can be used when users are in different
“branches” and the server does not allow “anonymous search”.

User DN Available only when Bind Type is Regular.
Enter the bind DN of an LDAP user account with permissions to query the
Distinguished Name (see Distinguished Name on page 728). The maximum
length is 256 characters.
For example:
cn=fortiadc,cn=users,dc=fortinet,dc=com

For Windows Active Directory, the UPN (User Principle Name) is often used
instead of a bind DN (for example, user@domain.com).
This field can be optional if your LDAP server does not require the FortiADC
appliance to authenticate when performing queries.

Password
Enter the password of the User DN.

Secure Connection l Disable
l LDAPS
l STARTTLS

CA Profile Available only when Secure Connection is set to LDAPS or STARTTLS,
regardless of the Bind type being selected.
Select a CA profile to identify the server certificate or you can leave the field blank.
For details on how to import the CA profile, see Importing CAs on page 243.

Group Authentication Available only when Bind Type is Regular.
Enable to filter the query results, only allowing users to authenticate if they are
members of the LDAP group that you define in theGroup DN field. Users that are
not members of that group are not allowed to authenticate.

Group Type Available only when Bind Type is Regular.
Indicate the schema of your LDAP directory as one of the following:
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Settings Guidelines

l OpenLDAP— The directory uses a schema where each user object’s group
membership is recorded in an attribute named gidNumber or a virtual
attribute named memberOf.

l Windows-AD— The directory uses a schema where each user object’s
group membership is recorded in an attribute named memberOf.

l FortiAuthenticator — Group membership attributes may have different
names depending on the LDAP directory schema.
The FortiADC appliance will use the group membership attribute that
matches your directory's schema when querying the group DN.

Group DN Available only when Bind Type is Regular.
Enter the value of the group membership attribute that query results must have in
order to be able to authenticate.
For example:
ou=Groups,dc=example,dc=com or a group ID (GID) such as 100
The value may vary based on your directory's schema. For details, see Setting
the LDAP group on the LDAP server on page 730.

Setting the LDAP group on the LDAP server

Using Windows Active Directory

Set the LDAP group on the LDAP server for when theGroup Type isWindows-AD.

1. Open the Windows Active Directory Administrator Center and create a new group.
For example, add a new group named "fortinet".
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2. Find the Group Distinguished Name. This value is used for theGroup DN field of the FortiADC LDAP server
configuration.

3. Add the user to the group. Ensure you do notmark this group as the primary group for login user.
For example, add the User "fortiadc" to the Group "fortinet".
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4. In FortiADC, configure the LDAP Group DN settings using the Distinguished Name value recorded from step 2.

FortiADC will check if {Common Name Identifier}={login admin name} is the member of the group you
specified.
For example, when logging into FortiADC with the admin name "fortiadc", FortiADC will check if cn=fortiadc is
the member of the group cn=fortinet,cn=users,dc=win2019,dc=comwith the search base dn cn=users,
dc=win2019, dc=com. If the entry exists, FortiADC gets the DN of the entry cn=fortiadc, cn=users,
dc=vm, dc=fadc and binds this entry and its password to Windows AD.

Using OpenLDAP

Set the LDAP group on the LDAP server for when theGroup Type isOpenLDAP. There are two methods to adding a
user in a group.

Method 1:

Create a user with the attribute gidNumber which points to the group.
Specify the GID number in theGroup DN field in the FortiADC LDAP server configuration. For example: 10000.
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Method 2:

Create a group and add the user as the member. Prior to doing this, the memberof overlay must be enabled.

The following is an example of OpenLDAP(sladp) with MDB database installed on Ubuntu. You can reference the
steps below using parameters applicable to your environment.

1. Enable the memberofmodule with the following command:

ldapmodify -Y EXTERNAL -H ldapi:/// <<EOL

dn: cn=module{0},cn=config
add: olcModuleLoad
olcModuleLoad: memberof
EOL

2. Configure OpenLDAP to use the memberofmodule with the following command:

ldapadd -Y EXTERNAL -H ldapi:/// <<EOL
dn: olcOverlay={0}memberof,olcDatabase={1}mdb,cn=config
objectClass: olcConfig
objectClass: olcOverlayConfig
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olcOverlay: memberof
EOL

3. Restart sladp and check if memberofmodule is loaded.

service slapd restart
slapcat -n 0 | grep olcModuleLoad
olcModuleLoad: {0}back_mdb
olcModuleLoad: {0}memberof

4. Create the group with objectClass "groupOfNames" and add the user member in it.
Specify the DN of the group in the Group DN field in the FortiADC LDAP server configuration.
For example: cn=fortinet,ou=group,dc=fadc,dc=com

Using FortiAuthenticator

Set the LDAP group on the LDAP server for when theGroup Type is FortiAuthenticator.

1. In FortiAuthenticator, create a group and add a user to that group.
In the example below, the group "fortinet" is created and the user "fortiadc" is a member of this group.
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2. Add the group and the user to the LDAP tree.

3. Specify the Group DN in the FortiADC LDAP server configuration.
In the example, the value is cn=fortinet,ou=fac,dc=example,dc=com.

FAQs when using an LDAP authentication server

Why does LDAPS or StartTLS not work with Windows AD when a CA profile is selected?

When a CA profile is selected, the CN of the LDAP server certificate must be the same value as the Server field in the
FortiADC LDAP configuration. Below is an example configuration for users using Windows AD with StartTLS.

The CN of the Windows AD certificate:
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LDAP Configuration on FortiADC:
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How do I debug "Test Connectivity" or "Fetch DN" fails when using Windows AD as the LDAP
server?

You can install the LDAP Admin tool on the Windows server to verify whether the configuration onWindows AD is
correct.

Using a RADIUS authentication server

You can use a RADIUS authentication server to authenticate administrator or destination server user logins.

Basic steps:

1. Configure a connection to a RADIUS server that can authenticate administrator or user logins.
2. Select the RADIUS server configuration when you add administrator users or user groups.

Before you begin:

l You must know the IP address, port, authentication protocol, and shared secret used to access the RADIUS server.
l You must have Read-Write permission for System settings.

To create a RADIUS server configuration:

1. Go to User Authentication > Remote Server.
2. Select the RADIUS Server tab.
3. Click Create New to display the configuration editor.
4. Complete the configuration as described in RADIUS server configuration on page 737.
5. Save the configuration.

Settings Guidelines

Name Specify a unique name for the RADIUS server configuration. Valid characters are A-Z, a-z, 0-
9, _, and -. No space is allowed.
After you initially save the configuration, you cannot edit the name.

Server IP address or FQDN of the remote RADIUS server.

Port The listening port of the RADIUS server. The commonly used port for a RADIUS server is
1812.

Shared Secret Shared secret string used when connecting to the server.

Authentication
Protocol

l PAP—Password authentication protocol
l CHAP—Challenge-Handshake Authentication Protocol.
l MS-CHAP—Microsoft version of CHAP.
l MS-CHAPv2—Microsoft version of CHAP, version 2.

RADIUS server configuration
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Settings Guidelines

Timeout Specify the amount of time that FortiADCmust wait for responses from the remote RADIUS
server before it times out the connection. Valid values are from 5 to 60 seconds. The default is
5 seconds.

Test Connection Tests the connectivity of the RADIUS server.

Configuring Duo authentication server support

You can configure FortiADC to support a Duo RADIUS authentication server.

Basic steps:

1. Configure a connection to a RADIUS server that can authenticate administrator or user logins.
2. Select the RADIUS server configuration when you add administrator users or user groups.

Before you begin:

l You must know the IP address, port, authentication protocol, and shared secret used to access the RADIUS server.
l You must have Read-Write permission for System settings.

To configure duo authentication support:

1. Go to User Authentication > Remote Server.
2. Select the RADIUS Server tab.
3. Click Create New to display the configuration editor.
4. Complete the configuration as described in Configuring Duo authentication server support on page 738.
5. Save the configuration.

Settings Guidelines

Name Name the configuration to something like "Duo RADIUS" to differentiate it from other RADIUS
server configurations.

Server Enter the IP address or DQDN of the Duo RADIUS proxy.

Port Specify the listening port of the Duo RADIUS proxy.

Shared Secret Enter the RADIUS secret configured on the Duo RADIUS proxy.

Authentication
Protocol

Be sure to select PAP for Duo RADIUS support.

Timeout Specify the amount of time that FortiADCmust wait for responses from the remote RADIUS
server before it times out the connection. Valid values are from 5 to 60 seconds. For Duo
RADIUS support, we recommend using 60 seconds.

Configure Duo authentication support

You can also configure a Duo RADIUS server using the following commands from the Console:
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config user radius
edit <name>
set auth-type {chap|ms_chap|ms_chapv2|pap}
set port <integer>
set secret <password>
set server <string>
set timeout <integer>
set vdom <datasource>
next

end

Using an NTLM authentication server

You can use a NTLM authentication server to authenticate user login to destination server.

Before you begin:

l You must know the IP address, port, used to access the NTLM server.
l You must have Read-Write permission for User settings.

Basic steps:

1. Configure a connection to an NTLM server that can authenticate user login.
2. Select the NTLM server configuration when you add users or user groups.

To create a NTLM server configuration:

1. Go to User Authentication > Remote Server.

2. Select the NTLM Server tab.

3. Click Create New to display the configuration editor.

4. Complete the configuration as described below.

5. Save the configuration.

Settings Guidelines

Name Specify a unique name for the NTLM server configuration. Valid characters are A-
Z, a-z, 0- 9, _, and -. No spaces allowed.
After you save the configuration, you cannot edit the name.

Server IP address of the remote NTLM server.

Port The listening port of the NTLM server. The commonly used port for an NTLM
server is 445.

After configuring an NTLM server, configure a user group and add a member of NTLM type. This makes it possible for
related authentication policy and virtual server to work under NTLM authentication.

Note: For user groups with “Client Authentication Method” set to “NTLM”, only allow use of an NTLM server as member;
for “Client Authentication Method” set to “HTML form” and “HTTP”, use “NTLM server” is also allowed. Only NTLM
version 1 is supported.
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Using a TACACS+ authentication server

Terminal Access Controller Access-Control System Plus (TACACS+) is a remote authentication protocol that provides
access control for routers, network access servers, and other network computing devices through one or more
centralized servers. TACACS+ allows FortiADC to accept a user name and password and send a query to a TACACS
authentication server. The server host determines whether to accept or deny the request and sends a response back
that allows or denies access to the FortiADC user. The default TCP port for a TACACS+ server is 49.

Once TACACS+ is enabled, a series of checks is performed locally and at the TACACS+ server level. The diagram
below illustrates the TACACS+ authentication flow.

To use a TACACS+ server to authenticate administrators, the server must be configured before configuring the
administrator accounts that will use it.
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Basic steps:

1. Configure a connection to a TACACS+ server that can authenticate administrator or user logins.
2. Select the TACACS+ server configuration when you add administrator users or user groups.

Before you begin:

l You must know the IP address, port, authentication protocol, and shared secret used to access the TACACS+
server.

l You must have Read-Write permission for System settings.

To configure a TACACS+ server:

1. Go to User Authentication > Remote Server.
2. Click the TACACS+ Server tab.
3. Click Create New to display the configuration editor.
4. Configure the following settings:

Setting Description

Name Specify a unique name for the TACACS+ server configuration. Valid
characters are A-Z, a-z, 0-9, _, and -. No space is allowed.
After you initially save the configuration, you cannot edit the name.

Authentication Protocol Select the authentication protocol used for the TACACS+ server:
l Auto— FortiADC tries all authentication protocols in order: MS-CHAP→
CHAP→PAP→ASCII.

l MS-CHAP—Microsoft version of CHAP (Challenge Handshake
Authentication Protocol).

l CHAP—Challenge Handshake Authentication Protocol (defined in RFC
1994).

l PAP—Password Authentication Protocol.
l ASCII — American Standard Code for Information Interchange.

Auto is the default option.

Timeout Specify the amount of time that FortiADCmust wait for responses from the
remote TACACS+ server before it times out the connection. Valid values are
from 5 to 60 seconds. The default is 5 seconds.

Shared Secret Shared secret string used when connecting to the TACACS+ server.

Server Enter the IP address or FQDN of the TACACS+ server.

Test Connectivity Tests the connectivity of the TACACS+ server.

5. Click Save.
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Authentication Relay

From the User Authentication > Authentication Relay sub-menu, you can configure a Kerberos authentication relay
policy.

Kerberos authentication is a computer authentication protocol that works on the basis of tickets (i.e., credentials). It
provides several authentication choices, allowing nodes communicating over a non-secure network to verify each others'
identity securely via a Key Distribution Center (KDC) and Service Tickets (STs). It is primarily used for client-server
authentication model and provides mutual authentication by which both the client and the server verify each others'
identity.

Kerberos authentication is built upon symmetric key cryptography and requires a trusted third party, and may also resort
to the use of public-key cryptography in certain phases of the authentication process. By default, Kerberos
Authentication Relay uses UDP port 88.

The Kerberos authentication consists of the following logical components:

l Client
l Authentication Server (AS)
l Ticket Granting Server (TGS)
l Service Server (SS)

Often, the AS and TGS are located on the same physical server, i.e., the KDC.

Authentication Workflow

The following paragraphs highlight the workflow of Kerberos authentication.

Step 1: Client authentication

The client sends a cleartext (i.e., unencrypted) message of the user ID to the Authentication Server (AS ) requesting
services that the user wants to use. The client does not send either the secret key or the password to the AS. The AS
generates the secret key by hashing the password of the user found at the database, e.g., Active Directory in Windows
Server. The AS then checks to see if the client is in its database. If it is in the database, the AS sends back the following
two messages to the client:

l Message A: Client/TGS Session Key encrypted using the secret key of the client/user.
l Message B: Ticket Granting Ticket (TGT) which includes the client ID, client network address, ticket validity period,
and the client/TGS session key) encrypted using the secret key of the TGS.

Once the client receives Messages A and B, it attempts to decrypt Message A with the secret key generated from the
password entered by the user. If the user entered password does not match the password in the AS database, the
client's secret key will be different and thus unable to decrypt message A. With a valid password and secret key, the
client decrypts Message A to obtain the Client/TGS Session Key. This session key is used for further communications
with the TGS. Note that the client cannot decrypt Message B, as it is encrypted using TGS's secret key. At this point, the
client has enough information to authenticate itself to the TGS.

Step 2: Client service authorization

When requesting services, the client sends the following messages to the TGS:
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l Message C: Composed of the TGT fromMessage B and the ID of the requested service.
l Message D: Authenticator, which is composed of the client ID and the time-stamp, encrypted using the Client/TGS
Session Key.

Upon receiving Messages C and D, the TGS retrieves Message B out of Message C. It decrypts Message B using the
TGS secret key. This gives the TGS the "client/TGS session key". Using this key, the TGS decrypts Message D
(Authenticator) and sends the following two messages to the client:

l Message E: Client-to-server ticket, which includes the client ID, client network address, validity period, and
Client/Server Session Key, encrypted using the service's secret key.

l Message F: Client/Server Session Key encrypted with the Client/TGS Session Key.

Step 3: Client service request

Upon receiving Messages E and F from TGS, the client has enough information to authenticate itself to the SS. The
client connects to the SS and sends the following two messages:

l Message E: From the previous step (the client-to-server ticket, encrypted using service's secret key).
l Message G: A new Authenticator, which includes the client ID and time-stamp encrypted using the Client/Server
Session Key.

The SS decrypts the ticket using its own secret key to retrieve the Client/Server Session Key. Using the sessions key,
the SS decrypts the Authenticator and sends the following message to the client to confirm its true identity and
willingness to serve the client:

l Message H: The time-stamp found in client's Authenticator, plus 1 in version 4, but not necessary in version 5[2][3]),
encrypted using the Client/Server Session Key.

The client decrypts the confirmation using the Client/Server Session Key and checks whether the time-stamp is correct.
If it is correct, then the client can trust the server and start issuing service requests to the server.

The server provides the requested services to the client.

FortiADC Kerberos authentication implementation

Implementation of Kerberos authentication involves the following configurations in FortiADC:

l Authentication Relay. See the following pragraph.
l User Group. See Configuring user groups on page 721.
l Authentication Policy. See Authentication Policy on page 718
l Virtual Server. See Configuring virtual servers on page 328

Configure Authentication Relay (Kerberos)

Use the following steps to configure Kerberos authentication:

1. Click User Authentication > Authentication Relay.
2. Click Create New to open the configuration editor dialog.
3. Make the desired entries or selections as described in Kerberos authentication configuration on page 744.
4. Click Save when done.
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Settings Guidelines

Name Specify the name of the configuration.

Delegation Type l Kerberos (Be sure to select this option.)
l HTTP Basic

KDC IP Enter the IP address of the KDC.

KDC Port 88

Realm Specify the realm in all upper-case characters.

Delegator Account Specify the delegator account. Required.

Delegator Password Specify the delegator password. Required.

Authorization l HTTP Error 404
l Always

Delegated SPN Specify the delegated SPN. Required.

Add Default Domain Disabled by default. When selected, specify the default domain below.

Default Domain Enter the default domain.

Kerberos authentication configuration

Kerberos Connectivity Test

After creating a Kerberos Authentication relay, the Test function will appear:

Click on the Test symbol, and it will open the User Principle dialogue. Set a user name.

If you do the Kerberos relay configuration and the user principle was corrected, you will get this response.
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If it failed, you will get an error prompt.

Using HTTP Basic SSO

When an application uses a Credentials Management API to prompt for user credentials, you must enter the required
information that can be validated either by the operating system or by the web application. You can specify your domain
credentials information in either of the following formats:

l User Principal Name (UPN)
l Down-Level Logon Name

The UPN format is used to specify an Internet-style name, such as UserName@Example.Fortinet.com. Anatomy of a
UPN on page 745 presents an anatomy of a UPN:

Component Comment Example

User name The name of an account JohnDoeII

Separator The at sign (@) @

UPN suffix Also known as the domain name Example.Fortinet.com

Anatomy of a UPN

The down-level logon name format specifies a domain and a user account in that domain, for example,
DOMAIN\UserName. Anatomy of a down-level logon name on page 745 highlights the components of a down-level
logon name:

Component Description Example

NetBIOS domain Domain name Domain

Anatomy of a down-level logon name
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Component Description Example

name

Separator The backslash (\) \

User account name Also known as the login name User name

FortiADC supports HTTP basic SSO when Client Authentication Method is set to be either HTML Form Authentication or
HTML Basic Authentication.

For HTTP basic SSO, FortiADC forwards the client’s credentials to the web application via the HTTP “Authorization”
header. For example, username/password "user1/fortinet" from a client is added to the HTTP header in the
format "Authorization: Basic dXNlcjE6Zm9ydGluZXQ=", and then forwarded to the back-end web
application.

You can use either UPN or down-level logon name to log into a web application, and FortiADC adds the domain offload
of your logon name for your convenience. Automatically adding the default domain prefix enables you to log in using your
user name alone in environments where both user name and domain name are required for the same purpose. This
feature comes in handy when you forget your domain name while trying to log into a web application..

Configure HTTP Basic SSO

Use the following steps to configure HTTP basic SSO authentication:

1. Click User Authentication > Authentication Relay.
2. Click Create New to open the configuration editor dialog.
3. Make the desired entries or selections as described in HTTP Basic SSO authentication configuration on page 746.
4. Click Save when done.

Settings Guidelines

Name Specify the name of the authentication relay configuration.

Delegation Type Select HTTP Basic

Authorization Select either of the following:
l HTTP Error 401—If selected, FortiADC relays the authentication credentials only when it
encounters an HTTP 401 error from the back-end server.

l Always—If selected, FortiADC relays the authentication credentials all the time.

Domain Prefix
Support

This is a switch to enable or disable the default domain prefix function.
Sometimes the domain controller requires the user to log in with the user name format
"domain\username" such as ‘KFOR\user1’
When this option is enabled, the user can also successfully log in by only entering
‘user1’ because FortiADC is able to automatically add the prefix ‘KFOR\’and then send
‘KFOR\user1’to the server.

Domain Prefix The value will be added as the domain prefix when the Domain Prefix Support is enabled
(above), and when the user inputs the username without the domain.
Note: The value of this domain prefix MUST be a valid NetBIOS domain name.

HTTP Basic SSO authentication configuration
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SAML

The User Authentication > SAML sub-menu allows you to perform the following tasks to configure SAML (Security
Assertion Markup Language) settings for user authentication:

l Configure an SAML service provider on page 747
l Import IDP Metadata on page 750

Web Single Sign-on (SSO) is an approach that allows single sign-on (SSO) for multiple web applications that have
established a common agreement on how to exchange user information. End users provide their credentials only once
and are recognized by all of the Web applications, even if they are deployed in different domains and use different
identity stores. Web SSO also allows the use of a single identity store by all of the Web apps.

Security Assertion Markup Language (SAML) defines an XML-based framework for describing and exchanging security
information among online business entities. It is the most popular protocol for implementing Web SSO.

The SAML protocol has two components—the Service Provider (SP) and the Identify Provider (IDP). They use SAML-
defined formatted XML to talk to each other and deliver the identity information called Authentication Assertion.

FortiADC support SAML 2.0, which offers the following benefits:

l Provides support for service provider (SP) and Identity Provider (IDP) Metadata
l Provides single sign-on (SSO) experience for all virtual server resources linked with the user log-in

Functioning as an SP, FortiADC supports the following IDPs:

l FortiAuthenticator (Factory default)
l Shibboleth
l OpenAM/OpenSSO

Configure an SAML service provider

You must configure your SPs in order to use SAML authentication. To configure an SP, you must have the required IDP
metadata file imported into FortiADC ahead of time. See Import IDP Metadata on page 750 for more information.

Once you have imported the needed IDP metadata file into FortiADC, you can use the following steps to configure a
SAML service provider:

1. Go to User Authentication > SAML.
The configuration page displays the SAML Service Providers tab.

2. Click Create New to open the SAML Service Providers configuration editor.
3. Configure the following settings.

Parameter Description

SAML Service Provider

Name Specify a unique name for the SAML service provider.

Entity ID Specify the SAML service provider's entity ID, which is the SAML service provider's
URL.

Local Certification Select a Local Certification from the drop-down. The default is Factory.

FortiADC Handbook 747
Fortinet Technologies Inc.



User Authentication

Parameter Description

Service URL Specify the SAML service URL. The default value is /SSO.

Assertion Consuming
Service Binding Type

Specify the Assertion Consuming Service Binding Type. The default value is Post.

Assertion Consuming
Service Path

Specify the Assertion Consuming Service Path. The default value is /SAML2/Post.

Single Logout Binding
Type

Select either of the following Single Logout Binding Type:
l Post
l Redirect

The default value is Post.

Single Logout Path Specify the Single Logout Path. The default value is /SLO/Logout.

IDP Metadata Select an IDP metadata file from the drop-down.
Note: You must have the IDP metadata file imported into FortiADC ahead of time.

Metadata Export
Service Location

Specify the Metadata Export Service Location. The default value is /Metadata.

Authentication
Session Lifetime

Specify the Authentication Session Lifetime in seconds. (Range: 1-2592000, Default:
28800)

Authentication
Session Timeout

Specify the Authentication Session Timeout in seconds. (Range: 1-86400, Default:
3600)

Assertion Require
Sign

Enable/disable the AuthNRequest algorithm to allow FortiADC to sign the SAML
authentication request.

AuthNRequest Sign
Algo

Select either of the following AuthNRequest algorithm:
l RSA-SHA1
l RSA-SHA256
l RSA-SHA512

The default value is RSA-SHA1.

SSO Status Enable(d) by default, which allows FortiADC to forward SSO information to the real
server, which in turn gets the authentication information and implements the SSO
function.

Export Assertion
Status

Enable(d) by default, which allows FortiADC to send to the real server the URL where
the Authentication Assertion (.i.e., identity information) can be fetched.

Export Assertion Path Specify the Export Assertion Path. The default value is /GetAssertion.

Export Cookie Status Enable(d) by default, which allows FortiADC to send to the real server the cookie of a
site that the user last visited.

Export Assertion ACL

IP Netmask Enter the IP address of the real server (or the IP Netmask if the real server is one of a
group of real servers) that requests authentication assertions.
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4. Click Save when done.
5. Optional: ClickMetadata to export the SP Metadata.

a. Specify the SP Root URL.
b. Click Export.
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Import IDP Metadata

A SAMLmetadata file provides the information of a client, such as its entity ID, credential, and so on. It also contains a of
couple of URLs so that the server knows where to send different requests, e.g., log-in requests, attribute query requests,
etc. You need to import this metadata to your SAML component so that it knows which client it should talk to.

Another purpose is to establish a trust relationship between the Service Provider (SP) and Identity Provider (IdP). In this
case, SAML metadata is used to exchange configuration information between the SP and the IdP, and viceversa. The
metadata can be signed and encrypted so that the data is transferred securely. The other side may need the
corresponding public key to validate and decrypt it and then can be used to understand and establish the connection with
the SP or IdP

To import a SAML IDP metadata file:

1. Go to User Authentication > SAML.
2. Click the IDP Metadata tab.
3. Click Import to open the IDP Metadata configuration editor.
4. Follow the instructions onscreen to import the IDP metadata file.

Note: With the 5.0.0. release, FortiADC has enhanced its SAML IDP file parsing and SP metadata format. For IDP files, it
can accept any XML with or without the default namespace set to 'md'. For SP metadata, the SP metadata no longer
uses the default namespace 'md' and has removed the non-standard extension. In addition, metadata is required in SP
metadata, signing, and encrypt, which is also a required setting for some IDPs.

This enhancement has modified the SP metadata XML file. So if you have an existing SAML configuration in an earlier
version and would like to upgrade to 5.x.x, you MUST upon the upgrade reconfigure your SAMLservice providers and
import the new SPmetadata XML file.

AD FS Proxy

The User Authentication > AD FS Proxy sub-menu allows you to perform the following tasks to configure Microsoft AD
FS (Active Directory Federation Services) settings for user authentication:

l Adding an AD FS Publish on page 751
l Adding an AD FS Proxy on page 752

Microsoft AD FS (Active Directory Federation Services) makes it possible for local users and federated users to use
claims-based single sign-on (SSO) to Websites and services. You can use AD FS to enable your organization to
collaborate securely across Active Directory domains with other external organizations by using identity federation. This
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reduces the need for duplicate accounts, management of multiple log-ons, and other credential management issues that
can occur when you establish cross-organizational trusts.

The AD FS Proxy is a service that brokers a connection between external users and your internal AD FS server. It acts
as a reverse proxy and typically resides in your organization’s perimeter network (aka DMZ). As far as the user is
concerned, they do not know they are talking to an AD FS proxy server, as the federation services are accessed by the
same URLs.

FortiADC can act as a AD FS Proxy to facilitate the deployment of AD FS. If all the users and applications are internal,
there is no need to use FortiADC as AD FS Proxy. If there is a requirement to expose the federation service to the
Internet, use FortiADC to replace the AD FS Proxy is helpful.

Attach AD FS to a Virtual Server

There are two methods to use the AD FS function for a virtual server.

Attach an AD FS Publish

1. Edit a virtual server.
2. ClickGeneral.
3. Select a published service for AD FS Published Service.
4. Save the configuration.

Use an AD FS script

1. After attaching an AD FS Publish, go to Server Load Balance > Scripting.
2. Find the script whose name format is “ADFS_virtual server name_AD FS Publish name." Then clone it.
3. Detach the AD FS Published Service for the virtual server.
4. If the real server pool which was used by the virtual server is different from the AD FS Proxy on which the AD FS

Published Service was published, add content routing configuration for the both pools.
5. Attach the content routing created in step 5 to virtual server.
6. Add the cloned script in step 3 into virtual server.
7. Save the configuration.

Adding an AD FS Publish

1. Go to User Authentication > AD FS Proxy.
The configuration page displays the Publish tab.

2. Click Create New to display the AD FS Publish configuration editor.
3. Make the desired entries or selections, as described in the table below.
4. Save the configuration.

Parameter Description

Name Specify a unique name for the AD FS Proxy;Valid characters are A-Z, a-z, 0-9,_, and -. No
space is allowed.
Note: Once you have saved the configuration, you\ cannot edit the AD FS Proxy name.

AD FS Publish
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Parameter Description

Status Enable—The proxy can be used by AD FS Publish.
Disable—The proxy can’t be used anymore.
Note: If the proxy is used by at least one AD FS Publish，it can’t be disabled.

AD FS Proxy Select an AD FS Proxy to publish on it.

Preauthentication
Method

Pass Through: ADC will not change the message flow, basically it will only forward the
message.
AD FS: ADC will do the pre-authentication, if OK, it will forward the following messages.

Relying Party Relying party trust configuration is received by AD FS Proxy from the AD FS server. This
parameter can only be used in the AD FS mode.

External URL The URL that ADC provide to the external users to serve as the Microsoft Application server
such as Exchange server.
Example: https://certauth.o365.com/owa/

Backend Server URL The URL that used for AD FS Proxy to access the Microsoft Application server such as
Exchange server.
Example: https://certauth.o365.com/owa/

Adding an AD FS Proxy

1. Go to User Authentication > AD FS Proxy.

2. Click the Proxy tab.

3. Click Create New to open the AD FS Proxy configuration editor.

4. Make the desired entries or sections, as described in the following table .

5. Save the configuration.

Parameter Description

Name Specify a unique name for the AD FS Proxy;Valid characters are A-Z, a-z, 0-9,_, and -. No
space is allowed.
Note: Once you have saved the configuration, you\ cannot edit the AD FS Proxy name.

Status Enable—The proxy can be used by AD FS Publish.
Disable—The proxy can’t be used anymore.
Note: If the proxy is used by at least one AD FS Publish，it can’t be disabled.

Method None: no load balance method will be used, proxy will select the first real server in the AD FS
Server Pool. LB METHOD ROUND ROBIN: proxy will select the real server according to
Round Robin algorithm.

AD FS Server Pool Select a real server pool configuration object, which is also an AD FS server farm. See Using
real server pools on page 448.

AD FS Proxy
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Parameter Description

Note: this real server pool must use a SSL profile whose SSL is on, and must also select a
local certificate.

Federation Service
Name

The FQDN string appointed by the AD FS server.

User Name A user name used to login to the AD FS server.

Password The password used to login to the AD FS server.

Server Configuration
Update Interval

1-8640000; The time interval of AD FS Proxy to get some configuration from AD FS server.
Within the interval, the proxy can only use the cached configuration.

Register Timeout 1-3600; the time of AD FS Proxy waiting for the register response from AD FS server.

Connect Timeout 1-3600; the time of AD FS Proxy setup TCP connection with AD FS server

Response Timeout 1-3600; the time of AD FS Proxy waiting for all the response other than register from AD FS
server.

Keepalive Timeout 1-3600; TCP connection keepalive timeout.

OAuth Proxy

From the User Authentication > OAuth Proxy sub-menu, you can configure OAuth 2.0 authentication.

OAuth (Open Authorization) is an authorization framework that can provide client applications with a secure delegated
access to server resources on behalf of a resource owner. OAuth works over HTTPS and authorizes third-party clients
such as devices, APIs, servers, and applications with access tokens rather than credentials with the approval of the
resource owner. The third party then uses the access tokens to access the protected resources hosted by the resource
server. This enables applications to obtain limited access to HTTP services on behalf of a user by delegating the user
authentication to the service that hosts the user account, and authorizing the third-party application to access the user
account.

Through FortiADC's OAuth 2.0 feature, you can:

l Mandate the authentication to a third party that you trust.
l Enable your web application (RealServer) to access resources that belong to the user and do not belong to the web
application (RealServer).

l Implement an alternative to Single SignOn.

FortiADC will only be supporting OAuth 2.0 which is the most widely used form of
OAuth. There will be no backwards compatibility between OAuth 1.0 and OAuth 2.0
as their specifications are so different that they cannot be used together.
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Deploying OAuth 2.0 authentication

To deploy OAuth 2.0 in FortiADC, you need to first set up the OAuth policy to establish the authorization flow between
FortiADC, the token server, and the authorization server. The OAuth policy serves to obtain the authorization code and
access token. After the OAuth policy is set up, it is then applied in the authentication policy, in which you will apply to the
virtual server to complete the OAuth deployment.

To configure the OAuth policy:

1. Go to User Authentication > OAuth Proxy.
2. Click Create New to display the configuration editor.
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3. Configure the following settings:

Settings Description

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces.
After you initially save the configuration, you cannot edit the name.

Client ID The client ID for your application.

Client Secret The secret used to apply for the access token.

Authentication URL The URL of the authorization server.

Token URL The URL of the token server.

Redirect URL The URL of the redirected server.

Logout URL The URL will trigger a logout event in which the user will be logged out and
FortiADC will delete the cookie. For the next access, the OAuth 2.0 process
will need to be conducted again.
The value is parsed as a match string prefix. For example, /abcmatches
http://www.example.com/abcd and
http://www.example.com/abc/11.html but not
http://www.example.com/1abcd.

HTTP Method The HTTP method used for the OAuth transaction.
Select from the following:
l POST
l GET

Relay Mode Enable/disable relay mode allows FortiADC to add an Authorization Header to
the HTTP request after verifying the token.

Include Granted Scopes Select from the following:
l True
l False
l None

This enables applications to use incremental authorization to request access
to additional scopes in context.
If you set this parameter's value to True and the authorization request is
granted, then the new access token will also cover any scopes to which the
user previously granted the application access.

Prompt Select from the following:
l Disable — Disable prompts.
l None—Do not display any authentication or consent screens.
l Consent — Prompt the user for consent.
l Select Account — Prompt the user to select an account.

Token Timeout The amount of time in seconds the token will be valid. (Range: 120-86,400,
default = 3600).
The client will not be allowed to access the scope after this time has elapsed.

4. Click Save.
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To configure the authentication policy:

1. Go to User Authentication > Authentication Policy.
2. Click +Create New.
3. Name the new authentication policy.
4. Configure the following to set theMember as the OAuth for the new OAuth policy.

a. Set the Type asOAuth.
b. Specify the pathname.
c. Select the applicableOAuth Policy.

5. Click Save.

To apply the authentication policy to the virtual server:

1. Go to Server Load Balance > Virtual Server.
2. Click +Create New and select Advanced Mode. Or double-click an existing virtual server configuration from the

list.
3. In theGeneral tab, under the Resources section, select the applicable Auth Policy.
4. Click Save.

OAuth 2.0 scopes

Scopes enable your application to only request access to the resources that it needs while also enabling users to control
the amount of access that they grant to your application. As part of the OAuth policy configuration, add the scopes to the
Scope List to identify the resources your application could access on the user's behalf. These will be shown to the user
to obtain their consent when they access the resource server. However, there is an inverse relationship between the
number of scopes requested and the likelihood of obtaining user consent; the user must consent to all or none of the
requests within the scope.

Note: OAuth 2.0 scopes are restricted to each application. Please refer to the applicable guidelines for your application
to ensure the scopes are valid.
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Log & Report

The Log & Reportmenu contain features and configurations that allow you to view various logs and reports.

The menu is further divided into sub-menus that allow you to configure log and report settings:

l Log Setting on page 770
l Report Setting on page 778
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The Traffic Log table displays logs related to traffic served by the FortiADC deployment.

By default, the log is filtered to display Server Load Balancing - Layer 4 traffic logs, and the table lists the most recent
records first.

You can use the following category filters to review logs of interest:

l SLB Layer 4—Traffic served by Layer-4 virtual servers
l SLB HTTP—Traffic served by virtual servers with HTTP profiles
l SLB TCPS—Traffic served by virtual servers with TCPS profiles
l SLB RADIUS—Traffic served by virtual servers with RADIUS profiles
l GLB—Traffic served by global load balancing policies
l SLB SIP—Traffic served by virtual servers with SIP profiles
l SLB RDP—Traffic served by virtual servers with RDP profiles
l SLB DNS—Traffic served by virtual servers with DNS profiles
l SLB RTSP—Traffic served by virtual servers with RTSP profiles
l SLB SMTP—Traffic served by virtual servers with SMTP profiles
l SLB RTMP—Traffic served by virtual servers with RTMP profiles
l SLB DIAMETER—Traffic served by Diameter profiles
l SLB MySQL—Traffic served by MySQL profiles.
l LLB — Traffic served by LLB profiles.

Within each category, you can use Filter Setting controls to filter the table based on the values of matching data:

l Date
l Time
l Proto
l Service
l Src
l Src_port
l Dst
l Dst_port
l Policy
l Action

The last column in each table includes a link to log details.

Before you begin:

l You must have Read-Write permission for Log & Report settings.

To view and filter the log:

1. Go to Log & Report > Traffic Log to display the traffic log.
2. Click Add Filter to display the filter tools.
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3. Use the tools to filter on key columns and values.
4. Click Apply to apply the filter and redisplay the log.

SLB Layer 4 and SLB TCPS logs on page 759 to GLB log on page 764 list the log columns in the order in which they
appear in the log.

Column Example Description

date date=2014-12-01 Log date.

time time=07:50:36 Log time.

log_id log_id=0102007810 Log ID.

type type=traffic Log type.

subtype subtype=slb_tcps Log subtype: slb_layer4, slb_tcps.

pri pri=information Log level.

vd vd=root Virtual domain.

msg_id msg_id=522030 Message ID.

duration duration=55 Session duration.

ibytes ibytes=138 Bytes in.

obytes obytes=303 Bytes out.

proto proto=6 Protocol.

service service=tcps Service.

src src=31.1.1.103 Source IP address in traffic received by FortiADC.

src_port src_port=5534 Source port.

dst dst=21.1.1.101 Destination IP address in traffic received by FortiADC (IP
address of the virtual server).

dst_port dst_port=443 Destination port.

trans_src trans_src=31.1.1.103 Source IP address in packet sent from FortiADC. Address
might have been translated.

trans_src_port trans_src_port=5534 Source port in packet sent from FortiADC.

trans_dst trans_dst=21.1.1.101 Destination IP address in packet sent from FortiADC (IP
address of the real server).

trans_dst_port trans_dst_port=443 Destination port in packet sent from FortiADC.

policy policy=L7vs Virtual server name.

action action=none For most logs, action=none.

srccountry srccountry=Reserved Location of the source IP address.

dstcountry dstcountry=Reserved Location of the destination IP address.

real_server real_server=2_2_2_10 Real server configured name.

SLB Layer 4 and SLB TCPS logs
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date date=2014-12-01 Log date.

time time=07:50:36 Log time.

log_id log_id=0102007810 Log ID.

type type=traffic Log type.

subtype subtype=slb_http Log subtype: slb_http.

pri pri=information Log level.

vd vd=root Virtual domain.

msg_id msg_id=522030 Message ID.

duration duration=55 Session duration.

ibytes ibytes=138 Bytes in.

obytes obytes=303 Bytes out.

proto proto=6 Protocol.

service service=http Service.

src src=31.1.1.103 Source IP address in traffic received by FortiADC.

src_port src_port=5534 Source port.

dst dst=21.1.1.101 Destination IP address in traffic received by FortiADC (IP
address of the virtual server).

dst_port dst_port=443 Destination port.

trans_src trans_src=31.1.1.103 Source IP address in packet sent from FortiADC. Address
might have been translated.

trans_src_port trans_src_port=5534 Source port in packet sent from FortiADC.

trans_dst trans_dst=21.1.1.101 Destination IP address in packet sent from FortiADC (IP
address of the real server).

trans_dst_port trans_dst_port=443 Destination port in packet sent from FortiADC.

policy policy=L7vs Virtual server name.

action action=none For most logs, action=none.

http_method http_method=get HTTP method.

http_host http_host=10.61.2.100 Host IP address.

http_agent http_agent=curl/7.29.0 HTTP agent.

http_url= http_url=/ip.php Base URL.

http_qry http_qry=unknown URL parameters after the base URL.

http_cookie http_cookie=unknown Cookie name.

http_retcode http_retcode=200 HTTP return code.

SLB HTTP logs

FortiADC Handbook 760
Fortinet Technologies Inc.



Column Example Description

user user=user1 User name.

usergrp usergrp=companyABC User group.

auth_status auth_status=success Authentication success/failure.

srccountry srccountry=Reserved Location of the source IP address.

dstcountry dstcountry=Reserved Location of the destination IP address.

real_server real_server=2_2_2_10 Real server configured name.

Column Example Description

date date=2014-12-01 Log date.

time time=07:50:36 Log time.

log_id log_id=0102007810 Log ID.

type type=traffic Log type.

subtype subtype=slb_radius. Log subtype: slb_radius.

pri pri=information Log level.

vd vd=root Virtual domain.

msg_id msg_id=522030 Message ID.

duration duration=55 Session duration.

ibytes ibytes=138 Bytes in.

obytes obytes=303 Bytes out.

proto proto=6 Protocol.

service service=radius Service.

src src=31.1.1.103 Source IP address in traffic received by FortiADC.

src_port src_port=5534 Source port.

dst dst=21.1.1.101 Destination IP address in traffic received by FortiADC (IP
address of the virtual server).

dst_port dst_port=443 Destination port.

trans_src trans_src=31.1.1.103 Source IP address in packet sent from FortiADC. Address
might have been translated.

trans_src_port trans_src_port=5534 Source port in packet sent from FortiADC.

trans_dst trans_dst=21.1.1.101 Destination IP address in packet sent from FortiADC (IP
address of the real server).

trans_dst_port trans_dst_port=443 Destination port in packet sent from FortiADC.

policy policy=L7vs Virtual server name.

SLB RADIUS log
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Column Example Description

action action=none For RADIUS, action=auth or acct.

user user=user1 RADIUS accounting username.

srccountry srccountry=Reserved Location of the source IP address.

dstcountry dstcountry=Reserved Location of the destination IP address.

real_server real_server=2_2_2_10 Real server configured name.

Column Example Description

date date=2016-03-18 Log date.

time time=11:48:29 Log time.

log_id log_id=107005800 Log ID.

type type=traffic Log type.

subtype subtype=slb_rdp Log subtype: slb_rdp.

pri pri=information Log level.

vd vd=root Virtual domain.

msg_id msg_id=1321705 Message ID.

duration duration=2 Session duration.

ibytes ibytes=92 Bytes in.

obytes obytes=400 Bytes out.

proto proto=6 Protocol.

service service=http Service.

src src=192.168.1.1 Source IP address in traffic received by FortiADC.

src_port src_port=37869 Source port.

dst dst=192.168.1.142 Destination IP address in traffic received by FortiADC (IP
address of the virtual server).

dst_port dst_port=8080 Destination port.

trans_src trans_src=2.2.2.2 Source IP address in packet sent from FortiADC. Address
might have been translated.

trans_src_port trans_src_port=58661 Source port in packet sent from FortiADC.

trans_dst trans_dst=2.2.2.10 Destination IP address in packet sent from FortiADC (IP
address of the real server).

trans_dst_port trans_dst_port=80 Destination port in packet sent from FortiADC.

policy policy=vs-l7 Virtual server name.

action action=none For most logs, action=none.

SLB RDP logs
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Column Example Description

srccountry srccountry=Reserved Location of the source IP address.

dstcountry dstcountry=Reserved Location of the destination IP address.

real_server real_server=r_22210 Real server configured name.

Column Example Description

date date=2016-01-29 Log date.

time time=18:06:48 Log time.

log_id log_id=0106001134 Log ID.

type type=traffic Log type.

subtype subtype=slb_sip Log subtype: slb_sip.

pri pri=information Log level.

vd vd=root Virtual domain.

msg_id msg_id=154799 Message ID.

duration duration=1 Session duration.

ibytes ibytes=44346 Bytes in.

obytes obytes=2.2.2.10 Bytes out.

proto proto=6 Protocol.

service service=http Service.

src src=N/A Source IP address in traffic received by FortiADC.

src_port src_port=43672 Source port.

dst dst=192.168.1.142 Destination IP address in traffic received by FortiADC (IP
address of the virtual server).

dst_port dst_port=8080 Destination port.

trans_src trans_src=2.2.2.2 Source IP address in packet sent from FortiADC. Address
might have been translated.

trans_src_port trans_src_port=80 Source port in packet sent from FortiADC.

trans_dst trans_dst=N/A Destination IP address in packet sent from FortiADC (IP
address of the real server).

trans_dst_port trans_dst_port=none Destination port in packet sent from FortiADC.

policy policy=invite Virtual server name.

action action=sip: bob@1.1.1.1 v2.0 Invite sent to.

sip_method sip_method=from:
alice@2.2.2.2

Invite sent from.

SLB SIP logs
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Column Example Description

sip_uri sip_uri=to: server@3.3.3.3 SIP server IP address.

sip_from sip_from=callid:1111111 SIP call ID.

sip_to sip_to=200

sip_callid sip_callid=Reserved Reserved.

sip_retcode sip_retcode=Reserved Reserved.

srccountry srccountry=Reserved Location of the source IP address.

dstcountry dstcountry=Reserved Location of the destination IP address.

real_server real_server=2_2_2_10 Real server configured name.

Column Example Description

date date=2014-12-01 Log date.

time time=07:50:36 Log time.

log_id log_id=0102007810 Log ID.

type type=traffic Log type.

subtype subtype=dns Log subtype: dns.

pri pri=information Log severity.

vd vd=root Virtual domain.

msg_id msg_id=522030 Message ID.

proto proto=6 Protocol.

src src=31.1.1.103 Source IP address.

src_port src_port=5534 Source port.

dst dst=21.1.1.101 Destination IP address.

dst_port dst_port=443 Destination port.

policy policy=policy Global load balancing policy name.

action action=none For most logs, action=none.

fqdn fqdn=pool.ntp.org FQDN from client request.

resip resip=4.53.160.75 DNS response IP address.

srccountry srccountry=Reserved Location of the source IP address.

dstcountry dstcountry=Reserved Location of the destination IP address.

GLB log
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Column Example Description

date date=2014-12-01 Log date.

time time=07:50:36 Log time.

log_id log_id=0114000000 Log ID.

type type=traffic Log type.

subtype subtype=llb Log subtype: llb

pri pri=information Log severity.

vd vd=root Virtual domain.

msg_id msg_id=522030 Message ID.

duration duration=120 Session duration

ibytes ibytes=1131 Bytes in

obytes obytes=492 Bytes out

proto proto=6 Protocol.

src src=31.1.1.103 Source IP address.

src_port src_port=5534 Source port.

dst dst=21.1.1.101 Destination IP address.

dst_port dst_port=443 Destination port.

policy policy=Link_Policy Link Policy.

action action=vtunnel Group Type (Link Group or Virtual Tunnel) in Link Group

srrcountry srrcountry=Japan Location of the source IP address

dstcountry dstcountry=France location of the destination IP address

gateway gateway=none Gateway in Link Group

LLB log

Using the security log

The Security Log displays logs related to the following FortiADC security features:

l IP Reputation— Traffic logged by the IP Reputation feature.
l DDoS— Traffic logged by the DoS Protection feature.
l WAF— Traffic logged by the Web Application Firewall feature.
l GEO—Traffic logged by the Geo IP block list feature.
l AV— Traffic logged by the Anti Virus module.
l IPS— Traffic logged by the IPS feature.
l Firewall — Traffic logged by the Firewall module.
l ZTNA - Traffic logged by the ZTNA feature.
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Before you begin:

l You must have Read-Write permission for Log & Report settings.
l Have enabled to write security logs on the FortiADC log disk in Log & Report > Log Setting > Local Log.
l Have enabled or disabled related security logs in Log & Report > Log Setting > Local Log.

To view and filter the log:

1. Go to Log & Report > Security Log.
2. From the top navigation, select the security category from the drop-down menu.

The log page displays with the log columns and data specific to the security category.

The following lists the log columns in the order in which they appear in each security log. Use the below links to navigate
to the security log of your choosing:

l IP Reputation log on page 766
l DDoS log on page 767
l WAF log on page 767
l GEO log on page 768
l AV log on page 768
l IPS log on page 769
l Firewall log on page 769
l ZTNA log on page 769

For additional detail on each log, click the (Detail icon) for any log. For further description of each log message, see
the FortiADC Log Reference.

IP Reputation log

Column Description

Date Log date.

Time Log time.

Count Rule match count.

Source Source IP address.

Destination Destination IP address.

Action Action type that was taken as a result.
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Column Description

(Detail icon) Click the (Detail icon) for the log details. For further description of each log
message, see the FortiADC Log Reference.

DDoS log

Column Description

Date Log date.

Time Log time.

Count Rule match count.

Source Source IP address.

Destination Destination IP address.

Action Action type that was taken as a result.

(Detail icon) Click the (Detail icon) for the log details. For further description of each log
message, see the FortiADC Log Reference.

WAF log

Column Description

Date Log date.

Time Log time.

WAF Subcategory Web Application Firewall subcategory.

Severity Security level.

Source Source IP address.

Destination Destination IP address.

Action Action type that was taken as a result.

(Detail icon) Click the (Detail icon) for the log details. For further description of each log
message, see the FortiADC Log Reference.
The following actions may be performed directly from the WAF log details:
l Add Exception— You can addWAF Exceptions directly from the WAF log.
This option appears only for WAF subcategories that support WAF
Exceptions. For details, see Configuring WAF Exception objects on page
548.

l Disable Signature— You can disable WAF signature profiles directly from
the WAF log. This option appears only for Attacks Signature WAF
subcategories. Disable Signature can only be successful if the WAF
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Column Description

signature profile exists, otherwise the disable will fail with the error message
"Entry not found".

l View Signature— You can view the WAF signature status and information
directly from the WAF log. This option appears only for Attacks Signature
WAF subcategories.

GEO log

Column Description

Date Log date.

Time Log time.

Count Rule match count.

Severity Security level.

Source Source IP address.

Destination Destination IP address.

Action Action type that was taken as a result.

(Detail icon) Click the (Detail icon) for the log details. For further description of each log
message, see the FortiADC Log Reference.

AV log

Column Description

Date Log date.

Time Log time.

Source Source IP address.

Destination Destination IP address.

Service Service type.

Severity Security level.

Virus Category Virus category.

Action Action type that was taken as a result.

(Detail icon) Click the (Detail icon) for the log details. For further description of each log
message, see the FortiADC Log Reference.
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IPS log

Column Description

Date Log date.

Time Log time.

Source Source IP address.

Destination Destination IP address.

Service Service type.

Severity Security level.

Rule Name Security rule name

Action Action type that was taken as a result.

(Detail icon) Click the (Detail icon) for the log details. For further description of each log
message, see the FortiADC Log Reference.

Firewall log

Column Description

Date Log date.

Time Log time.

Log Level Log level.

Policy Firewall policy.

Message Security rule name, category, subcategory, and description of the attack.

(Detail icon) Click the (Detail icon) for the log details. For further description of each log
message, see the FortiADC Log Reference.

ZTNA log

Column Description

Date Log date.

Time Log time.

Severity Security level.

Source Source IP address.

Destination Destination IP address.

Action Action type that was taken as a result.
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Column Description

(Detail icon) Click the (Detail icon) for the log details. For further description of each log
message, see the FortiADC Log Reference.

Using the script log

The Script Log table shows all the scripts.

Note: This feature is available for the SLB (server load balance) module only.

Log Setting

The Log & Report > Log Setting sub-menu allows you to perform the following tasks to configure settings for various
logs:

l Configuring local log settings on page 770
l Configuring syslog settings on page 772
l Configuring OFTP settings for FortiAnalyzer logs on page 775
l Configuring fast stats log settings on page 777

Configuring local log settings

The local log is a datastore hosted on the FortiADC system.

Typically, you use the local log to capture information about system health and system administration activities. We
recommend that you use local logging during evaluation and verification of your initial deployment, and then configure
remote logging to send logs to a log management repository where they can be stored long term and analyzed using
preferred analytic tools.

Local log disk settings are configurable. You can select a subset of system events, traffic, and security logs.

Before you begin:

l You must have Read-Write permission for Log & Report settings.

To configure local log settings:

1. Go to Log & Report > Log Setting.
The configuration page displays the Local Log tab.

2. Complete the configuration as described in Local logging configuration on page 771.
3. Save the configuration.
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Settings Guidelines

Status Select to enable local logging.

File Size Maximum disk space for a local log file. The default is 200 MB. When the current log file reaches
this size, a new file is created.

Log Level Select the lowest severity to log from the following choices:

l Emergency—The system has become unstable.
l Alert—Immediate action is required.
l Critical—Functionality is affected.
l Error—An error condition exists and functionality could be affected.
l Warning—Functionality might be affected.
l Notification—Information about normal events.
l Information—General information about system operations.
l Debug—Detailed information about the system that can be used to troubleshoot
unexpected behavior.

For example, if you select Error, the system collects logs with level Error, Critical, Alert, and
Emergency. If you select Alert, the system collects logs with level Alert and Emergency.

Disk Full Select log behavior when the maximum disk space for local logs (30% of total disk space) is
reached:

l Overwrite—Continue logging. Overwrite the earliest logs.
l No Log—Stop logging.

Event Select to enable logging for events.

Event Category
This option becomes available only when the Event check box is selected. In that case, select
the types of events to collect in the local log:

l Configuration—Configuration changes.
l Admin—Administrator actions.
l System—System operations, warnings, and errors.
l User—Authentication results logs.
l Health Check—Health check results and client certificate validation check results.
l SLB—Notifications, such as connection limit reached.
l LLB—Notifications, such as bandwidth thresholds reached.
l GLB—Notifications, such as the status of associated local SLB and virtual servers.
l Firewall—Notifications for the "firewall" module, such as SNAT source IP pool is using all of
its addresses.

Traffic Select to enable logging for traffic processed by the load balancing modules.

Traffic Category The following options become available only when the Traffic check-box is selected. See above.
l SLB—Server Load Balancing traffic logs related to sessions and throughput.
l GLB—Global Load Balancing traffic logs related to DNS requests.
l LLB—Link Load Balancing traffic logs related to session and throughput.

Local logging configuration
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Settings Guidelines

Security Select to enable logging for traffic processed by the security modules.

Security Category l DoS—SYN flood protection logs.
l IP Reputation—IP Reputation logs.
l WAF—WAF logs.
l GEO—Geo IP blocking logs.
l AV—AV logs.
l IPS—IPS logs
l FW—Firewall logs
l ZTNA—ZTNA logs
l Enable All—All types of log mentioned above.

Script Select to enable scripting.

Script Category SLB is selected by default and required.

Configuring syslog settings

A remote syslog server is a system provisioned specifically to collect logs for long term storage and analysis with
preferred analytic tools.

Before you begin:

l You must have Read-Write permission for Log & Report settings.

To configure syslog settings:

1. Go to Log & Report > Log Setting.
2. Click the Syslog Server tab.
3. If the VDOM is enabled, enable/disableOverride to determine which server list to use.

EnableOverride to allow the syslog to use the VDOM FortiAnalyzer server list. Otherwise, disableOverride to use
the Global syslog server list.
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4. Click Create New to display the configuration editor.

5. Configure the following settings:

Setting Description

Status Enable/disable the configuration.

Address Type Select the Address Type of the syslog server:
l IP
l FQDN

Address The Address option is available if the Address Type is IP.
Specify the IP address of the syslog server.

FQDN The FQDN option is available if the Address Type is FQDN.
Specify the FQDN of the syslog server.

Port Specify the port that FortiADC uses to communicate with the log server.
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Setting Description

This is the listening port number of the syslog server. Usually this is UDP port
514.

Proto Select the protocol used for log transfer from the following:
l UDP
l TCP
l TCP SSL

TCP Framing If Proto is TCP or TCP SSL, the TCP Framing options appear.
Select one of the following options:
l Traditional
l Octet Counted

Log Level Select the lowest severity to log from the following options:
l Emergency— The system has become unstable.
l Alert — Immediate action is required.
l Critical — Functionality is affected.
l Error — An error condition exists and functionality could be affected.
l Warning— Functionality might be affected.
l Notification— Information about normal events.
l Information—General information about system operations.
l Debug—Detailed information about the system that can be used to
troubleshoot unexpected behavior.

The exported logs will include the selected severity level and above. For
example, if you select Error, the system sends the syslog server logs with
level Error, Critical, Alert, and Emergency. If you select Alert, the system
collects logs with severity level Alert and Emergency.

CSV Enable to export the logs as a CSV file.

Facility Select the source facility of the logs. We only support the local use facilities
which are not reserved and are available for general use.

Event Enable/disable logging for events.

Event Category If Event is enabled, the Event Category options appear.
Select one or more of the following event categories to include in the event
logs export:
l Configuration— Configuration changes.
l Admin— Administrator actions.
l System—System operations, warnings, and errors.
l User — Authentication results logs.
l Health Check—Health check results and client certificate validation
check results.

l SLB—Notifications, such as connection limit reached.
l LLB—Notifications, such as bandwidth thresholds reached.
l GLB—Notifications, such as the status of associated local SLB and
virtual servers.
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Setting Description

l Firewall — Notifications for the Firewall module, such as SNAT source IP
pool is using all of its addresses.

Traffic Enable/disable logging for traffic processed by the load-balancing modules.

Traffic Category If Traffic is enabled, the Traffic Category options appear.
Select one or more of the following traffic categories to include in the traffic
logs export:
l SLB—Server Load Balancing traffic logs related to sessions and
throughput.

l GLB—Global Load Balancing traffic logs related to DNS requests.
l LLB— Link Load Balancing traffic logs related to session and throughput.

Security Enable/disable logging for traffic processed by the security modules.

Security Category If Security is enabled, the Security Category options appear.
Select one or more of the following security categories to include in the
security logs export:
l DDoS—DoS protection logs.
l IP Reputation— IP Reputation logs.
l WAF—WAF logs.
l GEO—Geo IP blocking logs.
l AV—AV logs.
l IPS— IPS logs.
l FW—Firewall logs.
l ZTNA— ZTNA logs.

6. Click Save.

Configuring OFTP settings for FortiAnalyzer logs

The Optimized Fabric Transfer Protocol (OFTP) is used when information is synchronized between FortiAnalyzer and
FortiADC, as well as for other Fortinet products. Remote logging and archiving can be configured on the FortiADC to
send logs to a FortiAnalyzer unit.

OFTP listens on port TCP/514.

You can configure the OFTP settings from Log & Report > Log Setting, or directly in your FortiAnalyzer connector
configuration (for details, see FortiAnalyzer Connector on page 82).

Requirements:

l Read-Write permission for Log & Report settings.
l The FortiAnalyzer service is required to be exposed on External IP.

FortiADC supports integration with FortiAnalyzer versions 7.0.2 or later. As earlier
versions of FortiAnalyzer is not optimally compatible with FortiADC, unexpected
behavior may occur.
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To configure OFTP settings for FortiAnalyzer logs:

1. Go to Log & Report > Log Setting.
2. Click the FortiAnalyzer tab.
3. If the VDOM is enabled, enable/disableOverride to determine which server list to use.

EnableOverride to use the VDOM FortiAnalyzer server list. Otherwise, disableOverride to use the Global
FortiAnalyzer server list.

4. Click Create New to display the configuration editor.
5. Configure the following settings:

Setting Description

Status Enable/disable the Fabric Connector object.

Address Specify the IP address of the FortiAnalyzer Log server.

Log Level Select the lowest severity to log from the following options:
l Emergency— The system has become unstable.
l Alert — Immediate action is required.
l Critical — Functionality is affected.
l Error — An error condition exists and functionality could be affected.
l Warning— Functionality might be affected.
l Notification— Information about normal events.
l Information—General information about system operations.
l Debug—Detailed information about the system that can be used to
troubleshoot unexpected behavior.

The exported logs will include the selected severity level and above. For
example, if you select Error, the system collects logs with severity level Error,
Critical, Alert, and Emergency. If you select Alert, the system collects logs with
severity level Alert and Emergency.

Event Enable/disable logging for events.

Event Category If Event is enabled, the Event Category options appear.
Select one or more of the following event categories to include in the event
logs export:
l Configuration— Configuration changes.
l Admin— Administrator actions.
l System—System operations, warnings, and errors.
l User — Authentication results logs.
l Health Check—Health check results and client certificate validation
check results.

l SLB—Notifications, such as connection limit reached.
l LLB—Notifications, such as bandwidth thresholds reached.
l GLB—Notifications, such as the status of associated local SLB and
virtual servers.

l Firewall — Notifications for the Firewall module, such as SNAT source IP
pool is using all of its addresses.

Traffic Enable/disable logging for traffic processed by the load-balancing modules.

FortiADC Handbook 776
Fortinet Technologies Inc.



Setting Description

Traffic Category If Traffic is enabled, the Traffic Category options appear.
Select one or more of the following traffic categories to include in the traffic
logs export:
l SLB—Server Load Balancing traffic logs related to sessions and
throughput.

l GLB—Global Load Balancing traffic logs related to DNS requests.
l LLB— Link Load Balancing traffic logs related to session and throughput.

Security Enable/disable logging for traffic processed by the security modules.

Security Category If Security is enabled, the Security Category options appear.
Select one or more of the following security categories to include in the
security logs export:
l DDoS—DoS protection logs.
l IP Reputation— IP Reputation logs.
l WAF—WAF logs.
l GEO—Geo IP blocking logs.
l AV—AV logs.
l IPS— IPS logs.
l FW—Firewall logs.

6. Optionally, click Test Connectivity after entering the Address to check the FortiAnalyzer OFTP connectivity.
The Connection Status appears showing the OFTP connection status.
There are three possible OFTP connection statuses:

Icon OFTP Status Description

Connected The FortiADC has successfully connected to FortiAnalyzer and is
authorized by FortiAnalyzer as a Fabric Device. FortiADC can now
send log data to FortiAnalyzer.

Disconnected The FortiADC cannot connect to FortiAnalyzer. Ensure there are
no network connectivity issues.

Need authorization The FortiADC has successfully connected to FortiAnalyzer but is
not authorized by FortiAnalyzer as a Fabric Device. This status
may indicate the authorization is either denied or pending. If
pending authorization, the status will change to Connected once
authorization is successful on the FortiAnalyzer server.

If the status is not Connected, edit the FortiAnalyzer connector accordingly to troubleshoot the connection issue.
7. Click Save.

Configuring fast stats log settings

The fast stats log feature enables real-time statistics collection for fast reports. By default, the feature is enabled, but you
can disable it if you like.
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Before you begin:

l You must have Read-Write permission for Log & Report settings.

To enable or disable the fast stats log feature:

1. Go to Log & Report > Log Setting.
2. Click the Fast Stats tab.
3. Complete the configuration as described in Fast stats log configuration on page 778.
4. Save the configuration.

Settings Guidelines

Status Enable/disable fast statistics. The feature is enabled by default.

Traffic Enable/disable fast statistics for traffic logs. The feature is enabled by default.

Traffic Category Enable/disable fast statistics for traffic categories. SLB is enabled by default.

Attack Enable/disable fast statistics for attack logs. Disabled by default.

Attack Category Enable/disable fast statistics for attack categories.

Security Select to enable logging for traffic processed by the security modules. Disabled by
default.

Fast stats log configuration

Report Setting

The Log & Report > Report Setting sub-menu allows you to perform the following tasks to configure settings for
various reports:

l Configuring reports on page 778
l Configuring report emails on page 779
l Configuring report queries on page 780
l Configuring fast reports on page 782

Configuring reports

You can configure on-demand or scheduled reports.

Before you begin:

l If you want reports to include user-defined queries, you must configure the queries before you configure the report.
l You must have Read-Write permission for Log & Report settings.

To configure a report:

1. Go to Log & Report > Report Setting.
The configuration page displays the Report tab.
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2. Click Create New to display the configuration editor.
3. Complete the configuration as described in Report configuration on page 779.
4. Save the configuration.

To run an on-demand report:

l In the report table, the final column for has a "run report" icon ( ). Click it.

To view a generated report:

l Go to Log & Report > Report > Overall.

Settings Guidelines

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces. You
reference this name in the zone configuration (if you use forwarders).
Note: After you initially save the configuration, you cannot edit the name.

On Schedule Enable/disable reporting on schedule.

Period Select a report period. If you select absolute or last N-hours, last N-days, or last N-
weeks, additional controls are displayed for you to set these variables.

Schedule Type Daily or on specified days.

Schedule Weekdays If you do not schedule the report daily, specify the days on which to run it.

Schedule Hour 0-23.

Email Format Attachment format. Only PDF is supported. If you schedule reports and set this option,
the report is sent on schedule to all addresses in the Log & Report > Report Email >
Recipient list.

Email Subject Message subject.

Email Body Message body.

Email Attachname Filename for attachment.

Email Compress Enable/disable compression of the attachment.

Query List Select queries to include in the report.

Report configuration

Configuring report emails

You can configure report email objects to work with an SMTPmail server. See Configuring an SMTPmail server for
information on how to set up the connection to the mail server.

Before you begin:

l You must have Read-Write permission for Log & Report settings.
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To configure report email objects:

1. Go to Log & Report > Report Setting.
2. Click the Report Email tab.
3. Click the Create New to display the configuration editor.
4. Complete the configuration as described in Report mail configuration on page 780.
5. Click Save.

Settings Guidelines

Name Enter a name for the report email configuration object, e.g., Accounting. No spaces.

Mail To Enter the email address of the report email recipient.

Mail From Enter the email address of the report email sender.

Report mail configuration

Configuring report queries

The predefined list of queries covers the most common administrator and stakeholder interests. It includes some of the
following:

l SLB-Top-Policy-By-Bytes
l SLB-Top-Source-By-Bytes
l SLB-Top-Source-Country-By-Bytes
l SLB-History-Flow-By-Bytes (total traffic over time)
l LLB-Top-Link-by-Bytes
l LLB-History-Flow-By-Bytes (total traffic over time)
l DNS-Top-Policy-by-Count
l DNS-Top-Source-by-Count
l Attack-Top-Destination-For-IPReputation-By-Count
l Attack-Top-Source-For-IPReputation-By-Count
l Attack-Top-Source-Country-For-IPReputation-By-Count
l Attack-Top-Destination-For-Synflood-By-Count
l Attack-Top-Destination-For-GEO-By-Count
l Attack-Top-Source-For-GEO-By-Count
l Attack-Top-Source-Country-For-GEO-By-Count
l Attack-Top-Destination-For-WAF-By-Count
l Attack-Top-Source-For-WAF-By-Count
l Attack-Top-Source-Country-For-WAF-By-Count
l Event-Top-Admin-Login-By-Count
l Event-Top-Failed-Admin-Login-By-Count
l Event-Top-Admin-Config-By-Count

If necessary, you can create your own query configuration objects.

Before you begin:

l You must have Read-Write permission for Log & Report settings.
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After you have created a query configuration object, you can select it in the report configuration.

To configure report queries:

1. Go to Log & Report > Report Setting.
2. Click theQuery Set tab.
3. Click Create New to display the configuration editor.
4. Complete the configuration as described in Query configuration on page 781.
5. Save the configuration.

Settings Guidelines

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces. You
reference this name in the zone configuration (if you use forwarders).
Note: After you initially save the configuration, you cannot edit the name.

Module l SLB
l LLB
l DNS
l Attack
l Event

SLB

SLB Submodule l All—Queryset will include all SLB queries
l HTTP—Queryset will include only HTTP queries

SubType Submodule All has the following subtypes:
l top_policy (virtual server)
l top_source
l top_source_country
l slb_history_flow (total traffic over time)

Submodule HTTP has the following subtypes: 
l top_policy (virtual server)
l top_pool_member

Traffic Sort Type Submodule All has the following Traffic Sort Types
l sessions
l bytes

Submodule HTTP has the following Traffic Sort Types: 
l sessions
l bytes
l CPS
l RPS
l BPS
l Average Session Duration
l Transaction Latency

LLB

Query configuration
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Settings Guidelines

Traffic Sort Type l sessions
l bytes

LLB Subtype l top_link
l slb_history_flow (total traffic over time)

DNS

DNS Sort Type Only count is applicable.

DNS Subtype l Top_Policy
l top_source

Attack

Attack Sort Type Only count is applicable.

Attack Subtype l top_destip_for_geo
l top_destip_for_ipreputation
l top_destip_for_sysflood
l top_destip_for_waf
l top_source_country_for_geo
l top_source_country_for_ipreputation
l top_source_country_for_waf
l top_source_for_geo
l top_source_for_ipreputation
l top_source_for_waf

Event

Event Sort Type Only count is applicable.

Event Subtype l top_admin_login
l top_failed_admin_login
l top_admin_config

Configuring fast reports

Fast reports are real time statistics displayed on the Dashboard > Data Analytics page.

There are two ways to configure a fast report, through Log & Report or FortiView.

Before you begin:

l You must have Read-Write permission for Log & Report settings.

After you have created a query configuration object, you can select it in the report configuration.

To configure fast reports through Log & Report:

1. Go to Log & Report > Report Setting.
2. Click the Fast Report tab.
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3. Click Create New to display the configuration editor.
4. Complete the configuration as described in Fast report configuration on page 783.
5. Save the configuration.

To configure fast reports through FortiView:

1. Go to FortiView > Data Analytics.
2. Click the Add Widget button in the far right. The Fast Report dialogue will display. It will be the same as in the Log

& Report route.
3. Complete the configuration as described in Fast report configuration on page 783.
4. Save the configuration.

Settings Guidelines

Name Configuration name. Valid characters are A-Z, a-z, 0-9, _, and -. No spaces. You
reference this name in the zone configuration (if you use forwarders).
Note: After you initially save the configuration, you cannot edit the name.

Module Select one of the following options:
l SLB
l Attack

SLB SubType Select an option from the list menu:
l Top Src
l Top Dest
l Top Browser
l Top OS
l Top Dev
l Top Domain
l Top URL
l Top Referrer
l Top Source Country
l Top Session

Attack SubType Select an option from the list menu:
l Top Attack Type for All
l Top Attack Type by VS for All
l Top VS for DDoS
l Top Destination Country for DDoS
l Top VS for GEO
l Top Source for GEO
l Top Destination for GEO
l Top Source Country for GEO
l Top Destination Country for GEO
l Top Action by Source for GEO
l Top Action by Source Country for GEO
l Top Category by VS for IP Reputation
l Top Source for IP Reputation

Fast report configuration
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Settings Guidelines

l Top Destination for IP Reputation
l Top Source Country for IP Reputation
l Top Destination Country for IP Reputation
l Top Attack Type by VS for WAF
l Top Attack Type by Source Country for WAF
l Top Attack Type by Source for WAF
l Top Attack by Destination Country for WAF
l Top Attack by Destination for WAF
l Top platform name by dest for AV
l Top platform name by destcountry for AV
l Top platform name by src for AV
l Top platform name by srccountry for AV
l Top platform name by vs for AV
l Top reference by dest for AV
l Top reference by destcountry for AV
l Top reference by src for AV
l Top reference by srccountry for AV
l Top reference by vs for AV
l Top src for IPS
l Top srccountry for IPS

History Chart Enable/Disable.

Time Range Select an option from the list menu:
l 10MINS
l 1HOUR
l 1DAY
l 1WEEK
l 1MONTH

Data Type Select either of the following:
l Bandwidth
l Session
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AI Threat Analytics

Through the FortiADC integration with Fortinet AI Threat Analytics, you can forward FortiADC security logs to FortiWeb
Cloud where the AI-based Threat Analytics engine identifies unknown attack patterns by parsing through all FortiADC
security logs and then aggregating similar or related security logs into into meaningful security incidents. This allows you
to use these identified attack patterns to protect your application against the identified threats.

AI Threat Analytics is not supported in AWS, AWSOn-Demand, GCP On-Demand,
and Azure On-Demand platforms.

Prerequisites for using AI Threat Analytics for FortiADC security logs:

l You must have a valid AI Threat Analytics service license.
l You must have the AI Threat Analytics service enabled in FortiADC.

14-day Evaluation license

A 14-day Evaluation license is offered to customers who would want to evaluate the AI Threat Analytics service. This 14-
day Evaluation license can only be used once. To activate the 14-day Evaluation license, enable the Threat Analytics
connector from Security Fabric > Fabric Connectors. During this 14-day trial period, you can disable and re-enable AI
Threat Analytics anytime. The 14-day trial period starts from the first time Threat Analytics is enabled.

When you are ready to purchase the full license with the Threat Analytics service, contact the Fortinet Sales team.

Overview

Fortinet AI Threat Analytics leverages machine learning algorithms to identify attack patterns across your entire
application attack surface and aggregate them into comprehensible security incidents. The solution separates significant
threats from informational alerts and false positives by identifying patterns and assigning a severity to help your security
team focus on the threats that matter.

AI Threat Analytics parses through all FortiADC attack logs and aggregates the attack events, grouping them into
incidents by common characteristics. These groupings can allow you to identify attack patterns such as which attack
types occur the most frequently, or which source IP is the most malicious.

You can drill down to view incident details by clicking the incident number. Incident Details include information such as
the attack type, the target application, and source IPs.
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You can use predefined tags for AI Threat Analytics incidents. You can edit the tag name according to your needs to help
in labeling the incidents for future usage, such as sorting, filtering, and acknowledging incidents.
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To enable AI Threat Analytics:

1. Contact the Fortinet Sales team to purchase a license with the Fortinet AI Threat Analytics service, then register the
license on the Fortinet Support site: https://support.fortinet.com/.

2. Log in to FortiADC.
3. Go to System > FortiGuard, log in to your Fortinet Support Contract.

You must be logged into your Fortinet Support Contract to connect FortiADC with the AI Threat Analytics service as
FortiWeb Cloud requires your Email ID to connect.

4. In the Dashboard > Status License widget, check the status of AI Threat Analytics. The status should be displayed
as Valid.

5. Go to Security Fabric > Fabric Connectors. UnderOther Fortinet Products section, locate the Threat
Analytics connector.
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6. Enable the Threat Analytics connector.

Note: When enabling the Threat Analytics connector for the first time, it may take 5-10 minutes to connect.
7. Once the Threat Analytics connector successfully connects FortiADC to the Fortinet AI Threat Analytics service, a

new local certificate and CA will be created. Check the certificates and CA to ensure they are present.
a. Go to System > Manage Certificates to locate the new local certificate with the name Threat_analytics_cert_

<date_of_today>.
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b. Go to System > Verify to locate the new CA with the name Threat_analytics_CA_<date_of_today.

c. A new syslog global_remote server will be created with the FQDN address type and with the comment "fweb_
cloud".
The remote syslog server capacity is three. Prior to enabling AI Threat Analytics, ensure there is at least one
syslog server entry available for the new remote syslog server created when AI Threat Analytics is enabled.

8. Wait to allow FortiADC to generate attack logs and forward them to FortiWeb Cloud.
9. Log in to FortiWeb Cloud with the account you used when registering your license on the Fortinet Support site.

Do not delete or modify the syslog remote and certificate/CA entry. AI Threat
Analytics cannot be functional without these configurations.

AI Threat Analytics in VDOM

When AI Threat Analytics is enabled in VDOMs, Override in the Syslog Server configuration will be disabled in order to
use the global syslog server. If you have previously enabled Override in the Syslog Server configuration, then the default
global syslog server list would be removed and you may use a new syslog server list specifically defined in the VDOM.
By default, the new syslog remote server would also be created in all the VDOMs with AI Threat Analytics enabled, which
disables Override in order to use the global syslog server.

When AI Threat Analytics is enabled, it will always use the global or root DNS, and not the VDOM's DNS.
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AI Threat Analytics in HA

In HA mode, only the primary node is connected to the FortiWeb Cloud server for the Fortinet AI Threat Analytics
service. The certification and syslog configurations from the primary unit are then synchronized to the secondary unit.
This workflow is designed to prevent HA synchronization issues that can arise with having both the primary and
secondary nodes connect to the FortiWeb Cloud at the same time. Once the primary node is connected to the AI Threat
Analytics service, the secondary node will synchronize the connection status and show as "Connected".

AI Threat Analytics troubleshooting and debugging

You can use the following tools to diagnose and troubleshoot Threat Analytics issues in FortiADC.

Dashboard

From the FortiADCmain dashboard, statuses relating to Threat Analytics is displayed in several widgets.

License

From the License widget, you can check the status of your Threat Analytics service license. You must have a Threat
Analytics service license in order to use this integrated service for FortiADC logs. You will not be able to connect to the
FortiWeb Cloud server without a valid license.

Security Fabric

From the Security Fabric widget, you can check the status of the Threat Analytics connector.
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Threat Analytics

The Threat Analytics dashboard widget displays the connection status to the FortiWeb Cloud server and the status of the
FortiADC attack log forwarding.

Threat Analytics connector

When you enable the Threat Analytics connector, the Fortinet AI Threat Analytics service license status will display.

The and icons indicate whether the Threat Analytics connector has successfully connected to the FortiWeb

Cloud server. If the connection is down , FortiADC will first perform an inspection of the Fortinet AI Threat Analytics
license status to determine whether the connection issue is caused by an invalid license. If a valid Fortinet AI Threat
Analytics license exists, then further troubleshooting may be required to determine the root cause of the Threat Analytics
connector issue.

Icon Threat Analytics connector
status

Guidelines

Connected The FortiADC is successfully connected to the FortiWeb Cloud
server.

Valid License A valid license for Fortinet AI Threat Analytics service is present. The
Threat Analytics connector is unable to connect to the FortiWeb
Cloud server due to issues other than the license status. Further
troubleshooting is recommended, such as checking your network
settings.

14-day Trial Started The 14-day evaluation license for Fortinet AI Threat Analytics service
has been activated, but has not yet expired. The Threat Analytics
connector is unable to connect to the FortiWeb Cloud server due to
issues other than the license status. Further troubleshooting is
recommended, such as checking your network settings.

14-day Trial Expired The 14-day evaluation license for Fortinet AI Threat Analytics service
has expired. The Threat Analytics connector is unable to connect to
the FortiWeb Cloud server due to invalid license. Please contact the
Fortinet Sales team to purchase the Fortinet AI Threat Analytics
service license to continue using AI Threat Analytics.

14-day Trial Not Started The 14-day evaluation license for Fortinet AI Threat Analytics service
did not activate because FortiWeb Cloud was unable to identify the
connecting FortiADC through the Fortinet Support Contract Email ID.
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Icon Threat Analytics connector
status

Guidelines

FortiWeb Cloud requires the Email ID registered to the Fortinet
Support Contract to identify and connect your FortiADC to the AI
Threat Analytics service. When you attempt to enable the Threat
Analytics connector before logging into your Fortinet Support
Contract from FortiADC, the Threat Analytics connector will fail to
connect. Please ensure to log into your Fortinet Support Contract
from the System > FortiGuard page.

No license. There is no basic FortiADC license. If the FortiADC is on a trial
license, you also cannot activate the 14-day Evaluation License.
Please contact the Fortinet Sales team to purchase a FortiADC
license.

CLI commands to view debug logs relating to AI Threat Analytics

Command Guidelines

diagnose debug module
wassd

To view the debug information of the wassd daemon.
The wassd daemon forms the connection between FortiADC and FortiWeb Cloud
and performs several integral functions when AI Threat Analytics is enabled. This
includes the following:
l Establishing a web socket connection with the FortiWeb Cloud using a token.
The wassd identifies whether a CA exists before registering to the FortiWeb
Cloud. If a CA does exist, then the wassd will send the issue date of the CA
certificate to the FortiWeb Cloud.

l Updating FortiWeb Cloud with FortiADC configuration changes, such as HA
status changes, member updates, or mode modification.

l Updating device certificates received from the FortiWeb Cloud. If wassd
registered to the FortiWeb Cloud without the issue date of the CA or that the
certificate has expired, then FortiWeb Cloud will send new certificates
(including the certificate, key, and CA) to wassd. The wassd will update to the
local certificate and CA table, and register to FortiWeb Cloud again with the
latest CA issue date.

l Starting the forwarding of FortiADC attack logs to FortiWeb Cloud. If wassd
has successfully registered to FortiWeb Cloud, then it will start the action with
the log server and port from the FortiWeb Cloud.

Note:
The wassd daemon is create for AI Threat Analytics and executes the wassd_ws
Python script when AI Threat Analytics is enabled. The backend log for the
Python script is stored in /var/log/wassd.log.

diagnose debug module
miglogd syslog

To view the debug information for the miglogd syslog.
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Command Guidelines

AI Threat Analytics functionality requires FortiADC to send the attack logs to the
FortiWeb Cloud via syslog (system logging protocol) that uses TCP SSL. In the
case where communication issues arise between FortiADC and FortiWeb Cloud,
you can use the diagnose debug module miglogd syslog command to
print out the key information about these communications to find the cause.

diagnose system threat-
analytics info

To view the system information for AI Threat Analytics.
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SSL Advanced Services

This section includes the following topics:

l SSL offloading on page 794
l SSL decryption by forward proxy on page 796
l SSL profile configurations on page 799
l Certificate guidelines on page 802
l SSL/TLS versions and cipher suites on page 802
l Exceptions list on page 807
l SSL traffic mirroring on page 807
l HSM Integration on page 810

SSL offloading

You can use FortiADC in a Layer-7 load-balancing topology to offload SSL decryption from the real server farm, as
illustrated in SSL offloading on page 795. In such a deployment, the FortiADC unit uses a copy of the real server
certificate and its private key to negotiate the SSL connection. It acts as an SSL proxy for the servers, using the
certificates and their private keys to:

l authenticate itself to clients
l decrypt requests
l encrypt responses

When session data has been decrypted, you can use the FortiADC content rewriting, content routing, and web
application firewall features.
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SSL offloading

FortiADC forwards data unencrypted to the servers, and the servers can maximize performance because they are
processing HTTP and not HTTPS transactions.

To realize the benefits of SSL offloading and maintain security, you must deploy the FortiADC appliance in a trusted
network with a direct path to the real servers so that the connection between the FortiADC and the real server does not
have to be re-encrypted. For example, you connect FortiADC and the real servers through the same switch, and all are
physically located on the same locked rack.

In cases where traffic is forwarded along untrusted paths toward the real servers, you can use a real server SSL profile to
re-encrypt the data before forwarding it to the real servers.
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Basic steps:

1. Import the X.509 v3 server certificates and their private keys that ordinarily belong to the backend servers, as well
as any certificate authority (CA) or intermediate CA certificates that are used to complete the chain of trust between
your clients and servers.

2. Configure a local certificate group that includes the server's local certificate and the Intermediate CA group that
contains the Intermediate CAs.

3. Configure an application profile and a client SSL profile (if needed) that reference the local certificate group and
specify the allowed SSL/TLS versions and list of SSL ciphers that can be used for the SSL connection between the
client and the FortiADC unit. Select this profile when you configure the virtual server.

4. Configure a real server SSL profile that enables or disables SSL for the connection between the FortiADC unit and
the real server. If enabled, specify the SSL/TLS versions and the list of SSL ciphers that can be used. Select this
profile when you configure the real server pool.

SSL decryption by forward proxy

You can use SSL decryption by forward proxy in cases where you cannot copy the server certificate and its private key to
the FortiADC unit because it is either impractical or impossible (in the case of outbound traffic to unknown Internet
servers).

When SSL forward proxy is enabled, FortiADC becomes a proxy to both sides of the connection. The server certificate
and its private key used to negotiate the SSL connection with the client are dynamically derived from the certificate
presented by the real server and optionally chained with an Intermediate CA trusted by the client.

Basic steps:

1. Import a special Intermediate CA and its private key to the local certificate store that you have provisioned for SSL
forward proxy operations.

2. Configure an Intermediate CA group. (Optional)
3. Configure a certificate caching object (or use the pre-defined one).
4. Configure a client SSL profile that enables SSL proxy, references the local certificate, and specifies the allowed

SSL/TLS versions and list of SSL ciphers that can be used for the SSL connection between the client and the
FortiADC unit. Select this profile when you configure the virtual server.

5. Configure all settings required for backend SSL.

Layer 7 deployments

Layer 7 SSL decryption by forward proxy on page 797 illustrates a Layer 7 SSL forward proxy deployment similar to the
SSL offloading example—inbound traffic to your server farm. When the FortiADC virtual server receives the ClientHello
message, it selects a real server and sends its own ClientHello to the server to set up its own SSL session with it
(represented by the dashed line in the figure). FortiADC uses the certificate presented by the server to derive the
certificate to present to the client. This derived certificate is signed by an Intermediate CA that is trusted by the client, so
the client completes its handshake with the FortiADC, and FortiADC can decrypt the traffic.
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Layer 7 SSL decryption by forward proxy

Layer 7 SSL decryption methods on page 797 summarizes the pros and cons of Layer 7 SSL decryption methods.

Layer 7 SSL decryption methods

Method Pros Cons

SSL offloading Better performance.
No feature limitations.
In most cases, you do not need to
maintain SSL functionality (certificates
and keys, SSL ports) on the real servers.

You must be able to copy the local
certificates and private keys from the real
servers.
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Method Pros Cons

SSL forward
proxy

You do not need to copy the local
certificates and keys from the real
servers. Instead, you add only one
Intermediate CA and private key to be
used for all the HTTPS servers.

Performance cost associate with SSL
proxy operations and certificate re-
signing.
You need to maintain SSL functionality on
the real servers.
Incompatible with some features because
the server must be selected before the
client request is decrypted: Incompatible
features include:
l Some load balancing methods (only
Round Robin and Least Connection
are supported)

l Some persistence methods (only
Source Address, Source Address
Hash, Source Address-Port Hash,
and SSL Session ID are supported)

l Client SNI Required option
l Content routing

Layer 2 deployments

You can use FortiADC in a Layer 2 sandwich toplogy to offload SSL decryption tasks from FortiGate.

Layer 2 SSL decryption by forward proxy on page 798 shows the topology. To decrypt traffic to and from external HTTPS
destinations, you must use SSL forward proxy.

When the FortiADC virtual server receives the ClientHello message, it sends its own ClientHello to the destination server
in order to fetch the server certificate so that it can be manipulated. The FortiGate and second FortiADC in the network
path must be configured to pass-through this HTTPS traffic. FortiADC uses the server certificate to derive a certificate to
present to the client. This derived certificate is signed by an Intermediate CA that is trusted by the client, so the client
completes its handshake with the first FortiADC, and FortiADC decrypts the traffic.

In a sandwich deployment like this one, you do not want to re-encrypt the traffic until it egresses the second FortiADC.
You control server-side SSL with the real server SSL profile configuration, discussed next.

Layer 2 SSL decryption by forward proxy
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SSL profile configurations

The application profile and client SSL profile determine the settings` for the client-FortiADC connection; the real server
SSL profile determines settings for the FortiADC-real server connection. This granularity gives you flexibility in how you
leverage FortiADC's SSL transaction capabilities. For example, in the case of SSL offloading, your goal is to eliminate
SSL transactions on the real servers so that you can configure a server-side SSL profile that does not use SSL. Or it
could be the case that the back-end real servers support only SSLv2, but you want to use the more secure TLSv1.2 for
the client-FortiADC segment.

SSL profiles on page 799 illustrates the basic idea of client-side and server-side profiles.

SSL profiles
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The call-outs in Layer 2 sandwich profiles on page 801 have guidance for the two types of profiles used in a Layer 2
sandwich deployment.

In this deployment, the FortiADC 1 virtual server is of a Layer-2 HTTPS virtual server configuration. Its client SSL profile
supports SSL forward proxy, including the special local signing CA. For Layer-2 virtual servers, the "real server" target is
the next hop. In this case, the real server target is the FortiGate pool. Because SSL is not enabled in the real server SSL
profile, FortiADC 1 does not re-encrypt the SSL connection. (However, you can configure allowed SSL versions and
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ciphers in the client SSL profile, and you can also configure an SSL certificate verification policy to enforce rules and
checks on the destination server certificate.) The client SSL profile settings are used when re-encrypting the server
response traffic in the return segment to the client.

The FortiADC 2 virtual server is a Layer 2 HTTP virtual server configuration. It receives unencrypted traffic from
FortiGate. Its server pool is the next hop gateway. On its server side, FortiADC uses the real server SSL profile settings
when it encrypts the outbound SSL connection and decrypts the inbound response traffic.

Layer 2 sandwich profiles

For information on virtual server profile configuration objects, see Configuring Application profiles.
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For information on real server SSL configuration objects, see Configuring real server SSL profiles.

Certificate guidelines

When a client browser requests an HTTPS connection to a web server, the server presents a server certificate to the
client for verification. The client checks the content of the certificate against a local browser database of Certificate
Authorities, and if it finds a match, the connection is made. If no match is found, the browser displays a warning that asks
if you want to continue with the connection.

To avoid this warning, you must upload an Intermediate CA signed by one of the CA vendors that has its root certificates
preinstalled in the web browsers. When the vendor issues you a local server certificate for your website, it typically
includes the Intermediate CAs in your package.

For SSL offloading deployments, you create a local certificate group that references the local certificate for the server
and its Intermediate CA group (a group that references all Intermediate CAs the vendor provided with your certificate
package).

For SSL decryption by forward proxy deployments, you create a local certificate group that references any local
certificate and an Intermediate CA group that includes the Intermediate CA and private key configuration you have
provisioned for the SSL forward proxy operations.

You are not required to obtain SSL certificates from SSL vendors. You can use an
enterprise certificate server (like Microsoft CertSrv) or open-source tools like
OpenSSL or to generate them. Note, however, that a web browser will not trust the
certificate unless it is associated with a certificate installed in the browser. If you use
your own tools to generate the Intermediate CA, you must distribute that certificate to
client browsers in whatever manner you typically do that—automatic update
package from IT, manual distribution, and so on.

For information on importing certificates and configuring certificate configuration objects, see Manage Certificates.

SSL/TLS versions and cipher suites

An SSL cipher is an algorithm that performs encryption and decryption. It transforms plain text into a coded set of data
(cipher text) that is not reversible without a key. During the SSL handshake phase of the connection, the client sends a
list of the ciphers it supports. FortiADC examines the client cipher list in the order it is specified, chooses the first cipher
that matches a cipher specified in the virtual server configuration, and responds to the client. If none of the ciphers
offered by the client are in the cipher suite list for the virtual server, the SSL handshake fails.

To see the list of ciphers supported by the browser you are using, go to a link maintained by the Leibniz University of
Hannover Distributed Computing & Security (DCSec) Research Group:

https://cc.dcsec.uni-hannover.de/

FortiADC SLB profiles support a specific list of RSA ciphers, PFS ciphers, ECDHE ciphers, ECDSA ciphers, Camellia
ciphers, and eNull ciphers.

Cipher suites with RSA key exchange on page 803 lists supported RSA ciphers.
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Abbreviation Cipher Suite Protocol Kx Au Enc MAC

AES256-GCM-
SHA384

TLS_RSA_WITH_AES_
256_GCM_SHA384

TLS 1.2 RSA RSA AESGCM
(256)

AEAD

*AES256-
SHA256

TLS_RSA_WITH_AES_
256_CBC_SHA256

TLS 1.2 RSA RSA AES(256) SHA

*AES256-SHA TLS_RSA_WITH_AES_
256_CBC_SHA

SSL 3.0
TLS 1.2,
1.1, 1.0

RSA RSA AES(256) SHA

AES128-GCM-
SHA256

TLS_RSA_WITH_AES_
128_GCM_SHA256

TLS 1.2 RSA RSA AESGCM
(128)

AEAD

*AES128-
SHA256

TLS_RSA_WITH_AES_
128_CBC_SHA256

TLS 1.2 RSA RSA AES(128) SHA

*AES128-SHA TLS_RSA_WITH_AES_
128_CBC_SHA

SSL 3.0
TLS 1.2,
1.1, 1.0

RSA RSA AES(128) SHA

RC4-SHA SSL_RSA_WITH_RC4_
128_SHA

SSL 3.0 RSA RSA RC4 SHA

TLS_RSA_WITH_RC4_
128_SHA

TLS 1.2,
1.1, 1.0

RSA RSA RC4 SHA

RC4-MD5 SSL_RSA_WITH_RC4_
128_MD5

SSL 3.0 RSA RSA RC4 MD5

TLS_RSA_WITH_RC4_
128_MD5

TLS 1.2,
1.1, 1.0

RSA RSA RC4 MD5

DES-CBC3-SHA SSL_RSA_WITH_3DES_
EDE_CBC_SHA

SSL 3.0 RSA RSA DES-CBC3 SHA

TLS_RSA_WITH_3DES_
EDE_CBC_SHA

TLS 1.2,
1.1, 1.0

RSA RSA DES-CBC3 SHA

*These ciphers are fully supported by hardware SSL (in 400F, 1200F, 2200F, 4200F and 5000F).

Cipher suites with RSA key exchange

With RSA ciphers, the server's public RSA key is part of the server certificate and is typically very long lived. It is not
uncommon for the same public key to be used for months or years. This creates a potential problem: if an SSL server's
private key were to be leaked or stolen, all connections made in the past using that key would be vulnerable. If someone
has recorded your SSL connections, they can use the stolen private key to decrypt them.

Cipher suites with DHE/EDH key exchange on page 804 lists supported Perfect Forward Secrecy (PFS) ciphers with
DHE/EDH key exchange. With PFS, a fresh public key is created for every single connection.That means that an
adversary would need to break the key for each connection individually to read the communication.
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Abbreviation Cipher Suite Protocol Kx Au Enc MAC

DHE-RSA-AES256-
GCM-SHA384

TLS_DHE_RSA_WITH_
AES_256_GCM_SHA384

TLS 1.2 DH RSA AES256 SHA384

*DHE-RSA-AES256-
SHA256

TLS_DHE_RSA_WITH_
AES_256_CBC_SHA256

TLS 1.2 DH RSA AES256 SHA256

*DHE-RSA-AES256-
SHA

TLS_DHE_RSA_WITH_
AES_256_CBC_SHA

SSL 3.0
TLS 1.2,
1.1, 1.0

DH RSA AES256 SHA256

DHE-RSA-AES128-
GCM-SHA256

TLS_DHE_RSA_WITH_
AES_128_GCM_SHA256

TLS 1.2 DH RSA AES128 SHA256

*DHE-RSA-AES128-
SHA256

TLS_DHE_RSA_WITH_
AES_128_CBC_SHA256

TLS 1.2 DH RSA AES128 SHA256

*DHE-RSA-AES128-
SHA

TLS_DHE_RSA_WITH_
AES_128_CBC_SHA

SSL 3.0
TLS 1.2,
1.1, 1.0

DH RSA AES128 SHA

EDH-RSA-DES-CBC3-
SHA

TLS_DHE_RSA_WITH_
3DES_EDE_CBC_SHA

SSL 3.0
TLS 1.2,
1.1, 1.0

DH RSA 3DES SHA

*These ciphers are fully supported by hardware SSL (in 400F, 1200F, 2200F, 4200F and 5000F).

Cipher suites with DHE/EDH key exchange

Cipher suites with EDCHE key exchange on page 804 lists supported PFS ciphers with Elliptic curve Diffie–Hellman
Ephemeral key (ECDHE) key exchange. ECDHE is significantly faster than DHE. The supported suites include both the
Elliptic Curve Digital Signature Algorithm (ECDSA) and RSA key authentication (Au) algorithms.

Abbreviation Cipher Suite Protocol Kx Au Enc MAC

ECDHE-ECDSA-
AES256-GCM-
SHA384

TLS_ECDHE_
ECDSA_WITH_
AES_256_GCM_
SHA384

TLS 1.2 ECDH ECDSA AESGCM256 AEAD

ECDHE-ECDSA-
AES256-SHA384

TLS_ECDHE_
ECDSA_WITH_
AES_256_CBC_
SHA384

TLSv1.2 ECDH ECDSA AES256 SHA384

*ECDHE-ECDSA-
AES256-SHA

TLS_ECDHE_RSA_
WITH_AES_256_
CBC_SHA

SSL 3.0
TLS 1.2,
1.1, 1.0

ECDH ECDSA AES256 SHA

ECDHE-ECDSA-
AES128-GCM-
SHA256

TLS_ECDHE_
ECDSA_WITH_
AES_128_GCM_
SHA256

TLSv1.2 ECDH ECDSA AESGCM128 AEAD

Cipher suites with EDCHE key exchange
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Abbreviation Cipher Suite Protocol Kx Au Enc MAC

*ECDHE-ECDSA-
AES128-SHA256

TLS_ECDHE_
ECDSA_WITH_
AES_128_CBC_
SHA256

TLSv1.2 ECDH ECDSA AES128 SHA256

*ECDHE-ECDSA-
AES128-SHA

TLS_ECDHE_
ECDSA_WITH_
AES_128_CBC_SHA

SSL 3.0
TLS 1.2,
1.1, 1.0

ECDH ECDSA AES128 SHA

ECDHE-ECDSA-
RC4-SHA

TLS_ECDHE_
ECDSA_WITH_
RC4_128_SHA

SSL 3.0
TLS 1.2,
1.1, 1.0

ECDH ECDSA RC4 SHA

ECDHE-ECDSA-
DES-CBC3-SHA

TLS_ECDHE_
ECDSA_WITH_
3DES_EDE_CBC_
SHA

SSL 3.0
TLS 1.2,
1.1, 1.0

ECDH ECDSA 3DES SHA

ECDHE-RSA-
AES256-GCM-
SHA384

TLS_ECDHE_RSA_
WITH_AES_256_
GCM_SHA384

TLS 1.2 ECDH RSA AESGCM256 AEAD

ECDHE-RSA-
AES256-SHA384

TLS_ECDHE_RSA_
WITH_AES_256_
CBC_SHA384

TLS 1.2 ECDH RSA AES256 SHA384

*ECDHE-RSA-
AES256-SHA

TLS_ECDHE_RSA_
WITH_AES_256_
CBC_SHA

TLS 1.2 ECDH RSA AES256 SHA

ECDHE-RSA-
AES128-GCM-
SHA256

TLS_ECDHE_RSA_
WITH_AES_128_
GCM_SHA256

TLS 1.2 ECDH RSA AESGCM128 AEAD

*ECDHE-RSA-
AES128-SHA256

TLS_ECDHE_RSA_
WITH_AES_128_
CBC_SHA256

TLS 1.2 ECDH RSA AES128 SHA256

*ECDHE-RSA-
AES128-SHA

TLS_ECDHE_RSA_
WITH_AES_128_
CBC_SHA

SSL 3.0 ECDH RSA AES128 SHA

ECDHE-RSA-RC4-
SHA

TLS_ECDHE_RSA_
WITH_RC4_128_
SHA

SSL 3.0 ECDH RSA RC4 SHA

ECDHE-RSA-DES-
CBC3-SHA

TLS_ECDHE_RSA_
WITH_3DES_EDE_
CBC_SHA

SSL 3.0 ECDH RSA 3DES SHA

*These ciphers are fully supported by hardware SSL (in 400F, 1200F, 2200F, 4200F and 5000F).
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Profiles support TLS_AES_128_GCM_SHA256 and TLS_AES_256_GCM_SHA384 for
TLSv1.3. They will be set automatically when TLSv1.3 is selected in ssl version. You should
only use TLSv1.3 for testing, not in a production environment.

The Camellia is a symmetric key block cipher with a block size of 128 bits and key sizes of 128, 192 and 256 bits. The
Camellia cipher has been approved for use by the ISO/IEC, the European Union's NESSIE project and the Japanese
CRYPTREC project. It has security levels and processing abilities comparable to the Advanced Encryption Standard.

Camellia Cipher suites on page 806 lists supported Camellia ciphers with ECDHE and DHE key exchange. The
supported suites include both the ECDSA and RSA key authentication algorithms.

Abbreviation Cipher Suite Protocol Kx Au Enc MAC

ECDHE-ECDSA-
CAMELLIA256-
SHA384

TLS_ECDHE_
ECDSA_
WITH_
CAMELLIA_
256_CBC_
SHA384

TLS 1.2 ECDH ECDSA CAMELLIA256 SHA384

ECDHE-RSA-
CAMELLIA256-
SHA384

TLS_ECDHE_
RSA_WITH_
CAMELLIA_
256_CBC_
SHA384

TLS 1.2 ECDH RSA CAMELLIA256 SHA384

DHE-RSA-
CAMELLIA256-
SHA256

TLS_DHE_
RSA_WITH_
CAMELLIA_
256_CBC_
SHA256

TLS 1.2 DH RSA CAMELLIA256 SHA256

ECDHE-ECDSA-
CAMELLIA128-
SHA256

TLS_ECDHE_
ECDSA_
WITH_
CAMELLIA_
128_CBC_
SHA256

TLS 1.2 ECDH ECDSA CAMELLIA128 SHA256

ECDHE-RSA-
CAMELLIA128-
SHA256

TLS_ECDHE_
RSA_WITH_
CAMELLIA_
128_CBC_
SHA256

TLS 1.2 ECDH RSA CAMELLIA128 SHA256

DHE-RSA-
CAMELLIA128-
SHA256

TLS_DHE_
RSA_WITH_
CAMELLIA_
128_CBC_
SHA256

TLS 1.2 DH RSA CAMELLIA128 SHA256

Camellia Cipher suites
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Abbreviation Cipher Suite Protocol Kx Au Enc MAC

DHE-RSA-
CAMELLIA256-
SHA

TLS_DHE_
RSA_WITH_
CAMELLIA_
256_CBC_
SHA

TLS 1.2,
1.1, 1.0

DH RSA CAMELLIA256 SHA

In addition, profiles support an eNull cipher option. This option represents all cipher suites that do not apply encryption to
the application data (integrity check is still applied). The exact cipher suite used depends on the SSL/TLS version used.
As an example, in SSL v3.0, eNULL includes NULL-MD5, NULL-SHA, ECDH-RSA-NULL-SHA, ECDH-ECDSA-NULL-
SHA, and some other non-encryption cipher suites.

Finally, profiles support a user-specified cipher list. You can specify a colon-separated list of OpenSSL cipher suite short
names. The names are validated against the form of the cipher suite short names published on the OpenSSL website:

https://www.openssl.org/docs/manprimary/apps/ciphers.html

Exceptions list

In some jurisdictions, SSL interception and decryption by forward proxy is disfavored for some types of websites or
disallowed entirely. If necessary, you can use the L2 Exception List configuration to define destinations that should not
have its sessions decrypted. You can leverage FortiGuard web filter categories, and you can configure a list of additional
destinations.

You associate the L2 Exception List configuration with virtual servers that are in the path of outbound traffic. The virtual
server evaluates whether an exception applies before processing the initial SSL client hello. If an exception applies, that
connection is passed through, and it is not decrypted.

For information on creating the configuration, see Configuring an L2 exception list.

SSL traffic mirroring

FortiADC supports mirroring packets (HTTPS/TCPS) to specified network interfaces. When the feature is enabled,
SSL traffic will be mirrored to the specified ports by the virtual server after it has been decrypted. See the following
figures.

The feature supports both IPv4 and IPv6. FortiADC can send traffic to up to four outgoing interfaces, including
aggregated and VLAN interfaces. Mirrored traffic is transmitted as a single packet stream, using the original client-side
source and destination IP address and port numbers. The source and destination MAC addresses are 0 (zero) in
mirrored traffic. The feature requires a virtual server set to Layer 7 or Layer 2, with a profile configured for HTTPS or
TCPS. It is supported on all FortiADC platforms.

To configure SSL traffic mirroring

1. Go to Virtual Server. Go to the far right and click Create New. You have to click Advanced Mode if you want traffic
mirroring.

2. In the Basic tab, go to Type, and set it to Layer 7.
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3. Then go to theGeneral tab. Go under Resources to Profile.
4. Select either LB_PROF_HTTPS (not just HTTP, without the 's') or LB_PROF_TCPS
5. When you do this, SSL Traffic Mirror will appear as a tab to the right of General.
6. Go to SSL Traffic Mirror and enable it.
7. Click Save.
8. Click Create New. Two options will drop down: Basic and Advanced.
9. Select Advanced.

10. Set the type to Layer 7.
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11. Click on the Profile tab. It will drop down to reveal a list of options. Choose only between LB_PROF_TCPS and LB_
PROF_HTTPS.

12. The SSL Mirror tab appears.
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Go into it and enable traffic mirroring.

To enable this feature in a policy, execute the following command:

config load-balance virtual-server
edit vs-name
set ssl-mirror enable
set ssl-mirror-intf port1 port2
next
end

HSM Integration

A hardware security module (HSM) is a dedicated device for managing digital keys and performing cryptographic
operations. An HSM can be a plug-in card or an external device directly connected to a computer or network server.
Purposefully designed to protect the crypto-key life cycle, HSMs have been used by some of the world's most security-
conscious entities to protect their cryptographic infrastructure by securely managing, processing, and storing
cryptographic keys inside a hardened, tamper-resistant device.

Because of their strengths in securing cryptographic keys and provisioning encryption, decryption, authentication, and
digital signing services for a wide range of applications, HSMs have been used by enterprises worldwide to safeguard
their online transactions, identities, and applications.

Integrating FortiADC with SafeNet Network HSM

Starting from Version 4.7.2, FortiADC has integrated with SafeNet Network HSM. It enables you to retrieve a per-
connection, SSL session key from the HSM server instead of loading the private key and certificate stored on FortiADC.

The integration requires specific configuration steps on both the FortiADC and the HSM appliances, as outlined below:

On the HSM appliance:

l Create one or more HSM partitions for FortiADC
l Send the FortiADC client certificate to the HSM server
l Register the FortiADC HSM client to the partition(s)
l Retrieve the HSM server certificate

On the FortiADC appliance:

l Configure communication with the HSM server, including using the server and client certificates to register
FortiADC as a client of the HSM server
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l Generate a certificate-signing request (CSR) that includes the HSM's configuration information
l Upload the signed certificate to FortiADC

It must be noted that

l Currently, FortiADC supports the SafeNet Network HSM only.
l HSM support is disabled on FortiADC by default. You must enable it via the CLI for the feature to become available
on the FortiADC GUI. To enable HSM support from the CLI, execute the following commands:
config system global

set hsm enable

l You must have the HSM server certificate available on your local PC or a network drive.
l HSM integration supports all HA modes, i.e., active-active, active-passive, and VRRP.
l HSM partition is a global configuration that can be used from individual VDOMs.
l HSM integration does not support configuration synchronization (config-sync), but local certificate using HSM can
be synchronized to peer FortiADC appliances. Keep in mind that this local certificate may NOT function properly on
peer FortiADC appliances.

l Network Trust Links (NTLs) IP check (ntls ipcheck) must be disabled on the HSM server for HA configuration.

The following instructions assume that you have (1) HSM support enabled on FortiADC and (2) access to the
HSM server certificate from your PC.

Preparing the HSM appliance

Before starting to configure FortiADC-HSM integration, you must configure the SafeNet Network HSM first using the
following steps:

1. On the SafeNet Network HSM, use the partition create command to create and initialize a new HSM partition
that uses password authentication.
Note: This is the partition FortiADC uses on the HSM server. You can create more than one partition, but all the
partitions are assigned to the same client. For more information, see HSM-related documentation.

2. Use the SCP utility and the following command to send the FortiADC client certificate to the HSM:
scp <fortiadc_ip>.pem admin@<hsm_ip>:

3. Using SSH, connect to the HSM server using the admin account. Then, use the following command to register a
client for FortiADC on the HSM server:
lunash:> client register -c <client_name> -ip <fortiadc_ip>, where <client_name> is the
name you specify that identifies the client.

4. Use the following command to assign the client you registered to the partition you've created in Step 1
above:lunash:> client assignPartition -client <client_name> -partition <partition_
name>
You can verify the assignment using the following command:
lunash:> client show -client <client_name>

5. Repeat the client assignment process for any additional partitions you've created for FortiADC.
6. Use the SCP utility and the following command to retrieve the server certificate file from the HSM server:

scp <hsm_username>@<hsm_ip>:server.pem /usr/lunasa/bin/server_<hsm_ip>.pem

7. On the FortiADC GUI, navigate to System>HSM to bring up the HSM configuration page.
8. Complete the HSM configuration as described in HSM Configuration Parameters on page 812. Then move on to

Generating a certificate-signing request on FortiADC on page 813.
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Parameter Description

Client Certificate

Client IP Enter the IP address of the interface (i.e., port) which FortiADC uses to generate the
client certificate.
Note: This IP address is the common name of client certificate. FortiADC is the client
of the HSM server. The client and server certificates are used in SSL connection
between FortiADC and the HSM server.

Generate Click this button to generate the client certificate that you've specified above.
Note: Use this option only if you do not have an existing client certificate on FortiADC.

Download Click this button retrieve the client certificate that you have just generated or stored on
FortiADC.
Note: You must generate a client certificate if you do not have one already residing on
FortiADC. See above.

Configuration Complete the following entries or selections to configure the FortiADC-HSM
integration.

Server IP Enter the IP address of the HSM server.

Port Specify the port via which FortiADC establishes an NTLS connection with the
HSM server. The default value is 1792.

Timeout Specify a timeout value for the connection between FortiADC and the HSM server. The
default is 20000. Valid values range from 5000 to 20000 milliseconds.

Upload Server Certificate File Click Choose File to browse for the server certificate file that you retrieved earlier.

Server FIPS Support Enable/disable server FIPS support.

Register Click this button to register FortiADC as a client of the HSM sever using the specified
server and client certificates.
Note: This action generates a config file, e.g., /example.conf

Unregister Click this button to clear all HSM-related configurations on the back-end.

Partition Click Create New to create partition or Delete to remove a selected partition.
Note: FortiADC can accept only one partition. Once a partition is added, the Register
and Unregister buttons become dimmed out, meaning you cannot make any change to
the HSM configuration. To edit the HSM configuration, you must delete the partition
first.

Partition Name Specify the name of a partition to which the FortiADC HSM client is assigned.

Password Specify the password for the partition.

HSM Configuration Parameters

Note: When configure your CSR to work with an HSM, the CSR generation process creates a private key on both the
HSM and the FortiADC. The private key on the HSM is the "real" key that secures communication when FortiADC uses
the signed certificate. The key found on the FortiADC is used when you upload the certificate to FortiADC.
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Generating a certificate-signing request on FortiADC

Once you have completed configuring the HSM server, you must generate a certificate-signing request which references
the HSM connection and partition from inside FortiADC.

To generate a certificate-signing request:

1. On the FortiADC GUI, navigate to System > Manage Certificates > Local Certificate.
2. Click Generate to bring up the Local Certificate configuration page.
3. Configure the certificate-signing request as described in Generating a certificate-signing request on page 813. Then

move on to Downloading and uploading the certificate request (.csr) file on page 815.

Parameter Description

Generate Certificate Signing
Request

Complete the following entries or selections to configure the FortiADC-HSM
integration.

Certificate Name Specify a name for the certificate request, e.g., www.example.com. This can be the
name of your web site.

Subject Information Specify the information that the certificate is required to contain in order to uniquely
identify the FortiADC appliance. This area varies depending on the ID Type you select.

ID Type Select the type of identifier to use in the certificate to identify the FortiADC appliance:
l Host IP— Select this option if the FortiADC appliance has a static IP address, and
then enter the public IP address of the FortiADC appliance in the IP field. If the
FortiADC appliance does not have a public IP address, use Domain Name or
Email instead. See below.

l Domain Name—Select this option if the FortiADC appliance has a static IP
address and subscribes to a dynamic DNS service. Enter the FQDN of the
FortiADC appliance, such as www.example.com, in the Domain Name field, but do
NOT include the protocol specification (http://) or any port number or path names.

l Email — Select this option if the FortiADC appliance does not require either a
static IP address or a domain name. Enter the email address of the owner of the
FortiADC appliance in the Email field.

The ID type you can select varies by whether or not your FortiADC appliance has a
static IP address, a fully-qualified domain name (FQDN), and by the primarily intended
use of the certificate. For example, if your FortiADC appliance has both a static IP
address and a domain name, but you will primarily use the local certificate for HTTPS
connections to the web UI by the domain name of the FortiADC appliance, you might
prefer to generate a certificate based upon the domain name of the FortiADC appliance
rather than its IP address. Depending on your choice for ID Type, the other options may
vary.

IP Note: This option appears only if the ID Type is Host IP.
Enter the static IP address of the FortiADC appliance, such as 10.0.0.1. The IP address
must be the one visible to clients. Usually, this should be its public IP address on the
Internet, or a virtual IP that you use NAT to map to the appliance’s IP address on your
private network.

Domain Name Note: This option appears only if the ID Type is Domain Name.

Generating a certificate-signing request
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Parameter Description

Enter the fully qualified domain name (FQDN) of the FortiADC appliance, such as
www.example.com. The domain name must resolve to the static IP address of the
FortiADC appliance or a protected server.

Email Note: This option appears only if the ID Type is Email.
Enter the email address of the owner/user of the FortiADC appliance, such as
admin@example.com.

Distinguished Information The following information is OPTIONAL in the certificate; it is NOT required.

Organization unit Enter the name of your organizational unit (OU), such as the name of your department.
To enter more than one OU name, click the + icon, and enter each OU in each separate
field.

Organization Enter the legal name of your organization.

Locality(City) Enter the name of the city or town where the FortiADC appliance is deployed.

State/Province Enter the name of the state or province where the FortiADC appliance is deployed.

Country/Region Select the name of the country where the FortiADC appliance is deployed.

Email Enter an email address that may be used for contact purposes, such as
admin@example.com.

Key Information Enter the information pertinent to the key.

Key Type This field shows the type of algorithm used to generate the key.
Note: It's read-only and cannot be changed. FortiADC 4.7.2 supports RSA key type
only.

Key Size Select one of the following key sizes:
l 512 bit
l 1024 bit
l 1536 bit
l 2048 bit
l 4096 bit

Note: Larger keys may take longer to generate, but provide better security.

HSM Select this option if the private key for the connections is provided by an HSM appliance
instead of FortiADC.
Note: This option is available only if you have enabled HSM via the CLI using the
config system global command. For more information, see Integrating FortiADC
with SafeNet Network HSM on page 810.

Partition Name Enter the name of the partition where the private key for this certificate is located on the
HSM server.
Note: This option becomes available only when HSM is selected. See above.

Enrollment Information

Enrollment Method Select either of the following:
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Parameter Description

l File Based—If selected, you must manually download and submit the resulting
certificate signing request (.csr) file to a certificate authority (CA) for signing. Once
signed, you need to upload the local certificate. This is the only enrollment method
if HSM is selected.

l Online SCEP— If selected, the FortiADC appliance will automatically use HTTP to
submit the certificate-signing request to the simple certificate enrollment protocol
(SCEP) server of a CA, which will validate and sign the certificate.
Note: For this selection, two more options appear: CA Server URL and Challenge
Password. This option is not available if HSM is selected.

Downloading and uploading the certificate request (.csr) file

Normally, when generating a certificate-signing request, the FortiADC appliance creates a private and public key pair.
The generated request includes the public key of the FortiADC appliance and information such as the FortiADC
appliance’s IP address, domain name, or email address. The FortiADC appliance’s private key remains confidential on
the FortiADC appliance. The Status column of the entry is PENDING.

If you configured your CSR to work with the FortiADC-HSM integration, the CSR generation process creates a private
key both on the HSM and on FortiADC appliances. The private key on the HSM is used to secure communication when
FortiADC uses the certificate. The FortiADC private key is used when you upload the certificate to FortiADC.

After you have submitted a certificate-signing request from inside FortiADC as discussed above, you must go back to the
System > Management Certificates > Local Certificate page to download the certificate request (.csr) file, and then
upload that file to your certificate authority (CA) by taking the following steps:

1. On the System > Manage Certificates > Local Certificate page, locate the entry of the certificate request.
2. Click the Download icon.

Note: The time it takes to download the certificate request (.csr) file varies, depending on the size of the file and the
speed of your network connection. After the file is downloaded, save it at a location on your machine.

3. Upload the certificate request (.csr) file to your CA.
Note: Upon receiving the certificate request file, the CA will verify the information in the certificate, give it a serial
number and an expiration date, and sign it with the public key of the CA.

4. If you are not using a commercial CA whose root certificate is already installed by default on web browsers,
download your CA’s root certificate, and then install it on all computers that will be connecting to your FortiADC
appliance.
Note: You must have the certificate installed on the computers. Otherwise, they may not trust your new certificate.
After you have received the signed certificate from the CA, upload it to FortiADC, as discussed below.

Uploading the server certificate to FortiADC

You must have the Read andWrite permission to upload server certificates to the FortiADC appliance.

To upload the server certificate to FortiADC:

1. On the FortiADC GUI, navigate to the System > Manage Certificates > Local Certificate page.
2. Click Import.
3. Make the selections as described in Uploading a server certificate on page 816, and click Save.
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Parameter Description

Type Click the down arrow and select one of the following options from the drop-down menu:
l Local Certificate—Use this option only if you have a CA-signed certificate that was
originated from a CSR generated in [[[Undefined variable
FortiADCVariables.FortiProduct]]] . See HSM Integration on page 810. Note: It is
important to make sure that the load-balancer (FortiADC appliance) you use to
import a local certificate is the same appliance where the CSR was generated
because it is where the key matching the certificate resides. The import operation
will fail without the matching key on the same hardware system.

l PKCS12 Certificate—Use this option only if you have a PKCS #12 password-
encrypted certificate with its key in the same file.

l Certificate—Use this option only if you have a certificate and its key in separate
files.

Note: Additional fields are displayed depending on your selection.

Certificate File Click Browse to locate the certificate file that you want to upload.

Certificate Name The name of the certificate.
Note: This field applies when Type is Certificate or PKCS12.

Key File Click Browse to locate the key file that you want to upload with the certificate.
Note: This option is available only if Type is Certificate.

Password Enter the password used to encrypt the server certificate file.
Note: This enables FortiADC to decrypt and install the certificate. This option is
available only if Type is Certificate or PKCS12 Certificate.

Uploading a server certificate

Once a certificate is uploaded to FortiADC, you can use it in a policy or server pool configuration.
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Best Practices and Fine Tuning

This section is a collection of best practice tips and fine-tuning guidelines. It includes the following topics:

l Regular backups on page 817
l Security on page 818
l Performance tips on page 820
l High availability on page 820

Regular backups

Make a backup before executing disruptive operations, such as:

l Upgrading the firmware
l Running the CLI commands execute factoryreset or execute restore
l Clicking the Reset button in the System Information widget on the dashboard

Always password-encrypt your backups.

Rebooting, resetting, and shutting down the system

The following items have the indicated usage:

l Reboot—Reboots the operating system.
l Reset—Resets the configuration to the default factory values.
l Shut Down—Shuts down the system. When the system is shut down, it is unavailable to forward traffic.

Do not unplug or switch off the FortiADC appliance without first shutting down the
operating system. The shutdown process enables the system to finish writing any
buffered data, and to correctly spin down and park the hard disks. Failure to do so
could cause data loss and hardware problems.

To reboot the system:

Do one of the following:

l Go to the dashboard, and in the System Information widget, click Reboot.
l From the CLI console, enter the following command:

execute reboot

To perform a factory reset to restore the entire device to the original out-of-the-box configuration:

Do one of the following:
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l Go to the dashboard, and in the System Information widget, click Reset.
l From the CLI console, enter the following command:

execute factoryreset

To perform a factory reset to restore factory defaults but retain the interface and VDOM configuration:

From the CLI console, enter the following commands:

execute factoryreset2

To power off the system:

To shut down the system:

l Go to the dashboard, and in the System Information widget, click Shut Down.
l From the CLI console, enter the following command:

execute shutdown

The system does not emit disk activity noise when shutdown is complete.

To completely power off:

l For hardware appliances, press the power button if there is one. Power supplies and switches vary by hardware
model. On some, you press the power button; on others, you flip the switch to either the off (O) or on (I) position.

l For FortiADC-VM, power off the virtual machine.

SCP support for configuration backup

This feature provides a secure method to transfer FortiADC configuration files from FortiADC to your host, using the
Secure Shell (SSH) protocol.

To send your configuration backup file to your host, execute the following command:

execute backup {config|config-file} scp <server user name> <server password> <directory>
<filename> <server ip>[:port]

Example:

execute backup config-file scp fortinet fadc /etc/home/ backup_config 192.1.2.3

Security

This section lists tips to further enhance security.

Topology

l Virtual servers can be on the same subnet as physical servers. This configuration creates a one-arm load balancer.
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For example, the virtual server 10.0.0.2/24 could forward to the physical server 10.0.0.3-200.
If you are deploying gradually, you might want to initially install your FortiADC in a one-arm topology during the
transition phase, and route traffic to it only after you have configured FortiADC to handle it.

Long term, this is not recommended. Unless your network’s routing configuration prevents it, it could allow clients
that are aware of the physical server’s IP address to bypass the FortiADC appliance by accessing the physical
server directly.

l Make sure web traffic cannot bypass the FortiADC appliance in a complex network environment.

l FortiADC appliances are not general-purpose firewalls. While they are security-hardened network appliances,
security is not their primary purpose, and you should not allow to traffic pass through without inspection. FortiADC
and FortiGate complement each other to improve security, availability, and performance.To protect your servers,
install the FortiADC appliance or appliances between the servers and a general purpose firewall such as a
FortiGate. FortiADC complements, and does not replace, general purpose firewalls.

l Disable all network interfaces that should not receive any traffic.

For example, if administrative access is typically through port1, the Internet is connected to port2, and servers are
connected to port3, you would disable (“bring down”) port4. This would prevent an attacker with physical access
from connecting a cable to port4 and thereby gaining access if the configuration inadvertently allows it.

Administrator access

l As soon as possible during initial setup, give the default administrator, admin, a password. This super-administrator
account has the highest level of permissions possible, and access to it should be limited to as few people as
possible.

l Change all administrator passwords regularly. Set a policy—such as every 60 days—and follow it. (Mark the
Change Password check box to reveal the password dialog.)

l Instead of allowing administrative access from any source, restrict it to trusted internal hosts. On those computers
that you have designated for management, apply strict patch and security policies. Always password-encrypt any
configuration backup that you download to those computers to mitigate the information that attackers can gain from
any potential compromise.

l Do not use the default administrator access profile for all new administrators. Create one or more access profiles
with limited permissions tailored to the responsibilities of the new administrator accounts.

l By default, an administrator login that is idle for more than 30 minutes times out. You can change this to a longer
period in Timeout, but Fortinet does not recommend it. Left unattended, a web UI or CLI session could allow anyone
with physical access to your computer to change system settings. Small idle timeouts mitigate this risk.

l Administrator passwords should be at least 8 characters long and include both numbers and letters.
l Restrict administrative access to a single network interface (usually port1), and allow only the management access
protocols needed.

l Use only the most secure protocols. Disable ping, except during troubleshooting. Disable HTTP, SNMP, and Telnet
unless the network interface only connects to a trusted, private administrative network.

l Disable all network interfaces that should not receive any traffic.
l For example, if administrative access is typically through port1, the Internet is connected to port2, and servers are
connected to port3, you would disable (“bring down”) port4. This would prevent an attacker with physical access
from connecting a cable to port4 and thereby gaining access if the configuration inadvertently allows it.

l Immediately revoke certificates that have been compromised. If possible, automate the distribution of certificate
revocation lists.
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Performance tips

When configuring the system and its features, there are many settings and practices that can yield better performance.

System performance

l Delete or disable unused policies. The system allocates memory with each server policy, regardless of whether it is
actually in active use. Configuring extra policies will unnecessarily consume memory and decrease performance.

l To reduce latency associated with DNS queries, use a DNS server on your local network as your primary DNS.
l If your network’s devices support them, you can create one or more VLAN interfaces. VLANs reduce the size of a
broadcast domain and the amount of broadcast traffic received by network hosts, thus improving network
performance.

l If you have enabled the server health check feature and one of the servers is down for an extended period, you can
improve system performance by disabling group membership for the physical server, rather than allowing the server
health check to continue checking for the server's responsiveness.

Reducing the impact of logging on performance

l If you have a FortiAnalyzer, store FortiADC logs on the FortiAnalyzer to avoid resource usage associated with
writing logs to the local hard disk.

l If you do not need a traffic log, disable it to reduce the use of system resources.
l Reduce repetitive log messages. Use the alert email settings to define the interval that emails are sent if the same
condition persists following the initial occurrence.

l Avoid recording log messages using low severity thresholds, such as information or notification, to the local hard
disk for an extended period of time. Excessive logging frequency saps system resources and can cause undue
wear on the hard disk and may cause premature failure.

Reducing the impact of reports on system performance

Generating reports can be resource intensive. To avoid performance impacts, consider scheduling report generation
during times with low traffic volume, such as at night and on weekends.

Keep in mind that most reports are based upon log messages. All caveats regarding log performance also apply.

Reducing the impact of packet capture on system performance

Packet capture can be useful for troubleshooting but can be resource intensive. To minimize the impact on system
performance, use packet capture only during periods of minimal traffic. Use a local console CLI connection rather than a
Telnet or SSH CLI connection, and be sure to stop the command when you are finished.

High availability

We recommend that you deploy high availability (HA). Keep these points in mind when setting up a cluster:
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l Isolate HA interface connections from your overall network.
Heartbeat and synchronization packets contain sensitive configuration information and can consume considerable
network bandwidth. For best results, directly connect the two HA interfaces using a crossover cable. If your system
uses switches instead of crossover cables to connect the HA heartbeat interfaces, those interfaces must be
reachable by Layer 2 multicast.

l When configuring an HA pair, pay close attention to the options ARP Packet Numbers and ARP Packet Interval.
The FortiADC appliance broadcasts ARP packets to the network to ensure timely failover. Delayed broadcast
intervals can slow performance. Set the value of ARP Packet Numbers no higher than needed.
When the FortiADC appliance broadcasts ARP packets, it does so at regular intervals. For performance reasons,
set the value for ARP Packet Interval no greater than required.
Some experimentation might be needed to set these options at their optimum value.

We recommend that you configure an SNMP community and enable the HA heartbeat failed option to generate a
message if the HA heartbeat fails.
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Troubleshooting

This section includes the following topics:

l Logs on page 822
l Tools on page 822
l Debug on page 223
l Solutions by issue type on page 826
l Resetting the configuration on page 833
l Restoring firmware (“clean install”) on page 833
l Additional resources on page 836

Logs

Log messages often contain clues that can aid you in determining the cause of a problem.

Depending on the type, log messages may appear in either the event, attack, or traffic logs. The FortiADC appliance
must be enabled to record event, attack, and traffic log messages; otherwise, you cannot analyze the log messages for
events of that type. To enable logging of different types of events, go to Log & Report > Log Settings.

During troubleshooting, you may find it useful to lower the logging severity threshold for more verbose logs, to include
more information on less severe events. To configure the severity threshold, go to Log & Report > Log Settings.

Tools

This section gives an overview of the following troubleshooting tools:

l execute commands
l diagnose commands
l System dump
l Packet capture
l Diff

execute commands

execute commands

You can use the command-line interface (CLI) execute commands to run systemmanagement utilities, such as
backups, upgrades and reboots; and network diagnostic utilities, such as nslookup, ping, traceroute, and tcpdump.

The following example shows the list of execute commands:

FortiADC-VM # execute ?
backup backup
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caching caching management
certificate certificate
checklogdisk find and auto correct errors on the log disk
clean clean
config-sync config sync
date set/get date and time
discovery-glb-virtual-server Sync virtual servers from glb server, add them to the virtual

server list
dumpsystem dump system information for debugging purpose
dumpsystem-file manipulate the dumped debugging information
factoryreset reset to factory default
fixlogdisk correct errors on the log disk
formatlogdisk format log disk to enhance performance
geolookup lookup geography information for IP address
glb-dprox-lookup lookup GLB dynamic proximity information
glb-persistence-lookup lookup GLB persistence information
ha ha
isplookup lookup ISP name and isp-address for IP address
log log management
nslookup nslookup
packet-capture packet-capture <Port Number> [filter] (Only IPv4)
packet-capture-file packet-capture-file
packet-capture6 packet-capture6 <Port Number> [filter] (Include IPv6)
ping ping <host name | host ip>
ping-option ping option settings
ping6 ping <host name | host ipv6>
ping6-option ping6 option settings
reboot reboot the system
reload reload appliance
restore restore
shutdown shutdown appliance
ssh Simple SSH client.
statistics-db statistics db management
telnet Simple telnet client.
traceroute traceroute
vm vm
web-category-test Test a url find its web-category

For details, see the FortiADC CLI Reference.

diagnose commands

You can use the CLI diagnose commands to gather diagnostic information that can be useful to Fortinet Customer Care
when diagnosing any issues with your system. The commands are similar to the Linux commands used for debugging
hardware, system, and IP networking issues.

The most important command for customers to know is diagnose debug report. This prepares a report you can
give to your Fortinet support contact to assist in debugging an issue.

The following examples show the lists of diagnose commands:

FortiADC-VM # diagnose ?
debug debug
hardware hardware
llb llb
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netlink netlink
server-load-balance server-load-balance
sniffer sniffer
system system

FortiADC-VM # diagnose debug ?
application set/get debug level for daemons
cli set/get debug level for CLI and CMDB
config-error-log read/clear config error information
crashlog crashlog
disable disable debug output
enable enable debug output
flow flow
info show debug info
kernel set/get debug level for kernel
report Report for tech support.
timestamp timestamp

FortiADC-VM # diagnose hardware get ?
deviceinfo list device status and information
ioport read data from an I/O port
pciconfig list information on PCI buses and connected devices
sysinfo list system hardware information

FortiADC-VM # diagnose netlink ?
backlog set netlink backlog length
device display network devices statistic information
interface netlink interface
ip ip
ipv6 ipv6
neighbor netlink neighbor
neighbor6 netlink neighbor for ipv6
route netlink routing table
route6 netlink routing table
tcp display tcp statistic information
udp display udp statistic information

FortiADC-VM # diagnose system ?
top show top process
vm check vm state

For details, see the FortiADC CLI Reference.

System dump

The system includes utilities for generating system dump files that can help Fortinet support engineers analyze an issue
for you. The CLI and Web UI versions have different usage:

l CLI—Used to dump kernel and user space information when the system is still responsive.
l Web UI—Used to dump kernel information when the system is deeply frozen.

The following is an example of CLI command usage:

FortiADC-VM # execute dumpsystem
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This operation will reboot the system!
Do you want to continue? (y/n)y
Begins to dump userspace information
Begins to dump kernel information

FortiADC-VM # execute dumpsystem-file list
-rw------- 1 0 0 96719189 Mar 15 13:35 coredump-2016-03-15-13_35
-rw-r--r-- 1 0 0 16654391 Mar 15 13:34 user_coredump_2016_03_15_13_34_46.tar.bz2

FortiADC-VM # execute dumpsystem-file upload tftp coredump-2016-03-15-13_35 172.30.184.77
coredump-2016-03-15- 7% |** | 7152k 0:09:58 ETA

To use the web UI system dump utility:

1. Go to System > Debug.
2. Click System Dump to generate the file.

After the file has been generated, you are logged out. When you log back in and revisit the page, the system dump
file appears in the file list.

3. Select the file and click Export to download the file.

Diff

You can compare backups of the core configuration file with your current configuration. This can be useful if, for
example:

A previously configured feature is no longer functioning, and you are not sure what in the configuration has changed.

You want to recreate something configured previously, but do not remember what the settings were.

Difference-finding programs, such as WinMerge and the original diff can help you to quickly find all changes. They can
compare your configurations, line by line, and highlight parts that are new, modified, or deleted.

Configuration differences highlighted in WinMerge
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For instructions, see the documentation for your diff program.

Solutions by issue type

Recommended solutions vary by the type of issue.:

l Login issues
l Connectivity issues
l Resource issues

Login issues

If an administrator is entering his or her correct account name and password, but cannot log in from some or all
computers, examine that account’s trusted host definitions. It should include all locations where that person is allowed to
log in, such as your office, but should not be too broad.

Connectivity issues

One of your first tests when configuring a new policy should be to determine whether allowed traffic is flowing to your
servers. Investigate the following connectivity issues if traffic does not reach the destination servers:
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l Is there a FortiADC policy for the destination servers? By default, FortiADC allows traffic to reach a backend server.
However, the virtual servers must also be configured before traffic can pass through.

l If your network utilizes secure connections (HTTPS) and there is no traffic flow, is there a problem with your
certificate?

Checking hardware connections

If there is no traffic flowing from the FortiADC appliance, you want to rule out hardware problems.

To check hardware connections:

l Ensure the network cables are properly plugged in to the interfaces on the FortiADC appliance.
l Ensure there are connection lights for the network cables on the appliance.
l Change the cable if the cable or its connector are damaged or you are unsure about the cable’s type or quality.
l Connect the FortiADC appliance to different hardware to see if that makes a difference.
l In the web UI, go to System > Networking > Interface and ensure the link status is up for the interface. If the status is
down (down arrow on red circle), edit the configuration to change its status to Up.

You can also enable an interface in CLI, for example:

config system interface

edit port2

set status up

end

If any of these checks solve the problem, it was a hardware connection issue. You should still perform some basic
software tests to ensure complete connectivity.

If the hardware connections are correct and the appliance is powered on but you cannot connect using the CLI or web
UI, you may be experiencing bootup problems. See Restoring firmware (“clean install”).

Checking routing

The ping and traceroute utilities are useful for investigating issues with network connectivity and routing.

Since you typically use these tools to troubleshoot, you can allow ICMP, the protocol used by these tools, in firewall
policies and on interfaces only when you need them. Otherwise, disable ICMP for improved security and performance.

By default, FortiADC appliances do not respond to ping and traceroute. However, if the appliance does not respond,
and there are no firewall policies that block it, ICMP type 0 (ECHO_REPSPONSE) might be effectively disabled.

To enable ping and traceroute responses:

1. Go to Networking > Interface.
2. Select the row for the network interface and click the edit icon.
3. Under Allow Access, enable ping.
4. Save the update.

The appliance should now respond when another device such as your management computer sends a ping or
traceroute to that network interface.
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Note: Disabling ping only prevents the system from receiving ICMP type 8 (ECHO_
REQUEST) and traceroute-related UDP. It does not disable CLI commands such as
execute ping or execute traceroute that send such traffic.

To verify routes between clients and your servers:

1. Attempt to connect through the FortiADC appliance, from a client to a backend server, via HTTP and/or HTTPS.
If the connectivity test fails, continue to the next step.

2. Use the ping command on both the client and the server to verify that a route exists between the two. Test traffic
movement in both directions: from the client to the server, and the server to the client. Servers do not need to be
able to initiate a connection, but must be able to send reply traffic along a return path.
If the routing test succeeds, continue with Step 4.
If the routing test fails, continue to the next step.

3. Use the tracert or traceroute command on both the client and the server (depending on their operating
systems) to locate the point of failure along the route.
If the route is broken when it reaches the FortiADC appliance, first examine its network interfaces and routes. To
display network interface addresses and subnets, enter the CLI command:
show system interface
To display all recently-used routes with their priorities, enter the CLI command:
diagnose netlink route list
You may need to verify that the physical cabling is reliable and not loose or broken, that there are no IP address or
MAC address conflicts or blocklisting, misconfigured DNS records, and otherwise rule out problems at the physical,
network, and transport layer.
If these tests succeed, a route exists, but you cannot connect using HTTP or HTTPS, an application-layer problem
is preventing connectivity.

4. For application-layer problems, on the FortiADC, examine the:
l virtual server policy and all components it references
l certificates (if connecting via HTTPS)
l server service/daemon

On routers and firewalls between the host and the FortiADC appliance, verify that they permit HTTP and/or HTTPS
connectivity between them.

Testing for connectivity with ping

The ping command sends a small data packet to the destination and waits for a response. The response has a timer
that may expire, indicating that the destination is unreachable via ICMP.

ICMP is part of Layer 3 on the OSI Networking Model. ping sends Internet Control Message Protocol (ICMP) ECHO_
REQUEST (“ping”) packets to the destination, and listens for ECHO_RESPONSE (“pong”) packets in reply.

Some networks block ICMP packets because they can be used in a ping flood or denial of service (DoS) attack if the
network does not have anti-DoS capabilities, or because ping can be used by an attacker to find potential targets on the
network.

Beyond basic existence of a possible route between the source and destination, ping tells you the amount of packet
loss (if any), how long it takes the packet to make the round trip (latency), and the variation in that time from packet to
packet (jitter).

If ping shows some packet loss, investigate:
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l cabling to eliminate loose connections
l ECMP, split horizon, or network loops
l all equipment between the ICMP source and destination to minimize hops

If ping shows total packet loss, investigate:

l cabling to eliminate incorrect connections
l all firewalls, routers, and other devices between the two locations to verify correct IP addresses, routes, MAC lists,
and policy configurations

If ping finds an outage between two points, use traceroute to locate exactly where the problem is.

To use ping:

Log into the CLI via either SSH, Telnet, or the CLI Console widget of the web UI.

1. If you want to adjust the behavior of execute ping, first use the execute ping-options command.
2. Enter the command:

execute ping <destination_ipv4>
where <destination_ipv4> is the IP address of the device that you want to verify that the appliance can connect
to, such as 192.168.1.1.

3. If the appliance can reach the host via ICMP, output similar to the following appears:
PING 192.168.1.1 (192.168.1.1): 56 data bytes
64 bytes from 192.168.1.1: icmp_seq=0 ttl=253 time=6.5 ms
64 bytes from 192.168.1.1: icmp_seq=1 ttl=253 time=7.4 ms
64 bytes from 192.168.1.1: icmp_seq=2 ttl=253 time=6.0 ms
64 bytes from 192.168.1.1: icmp_seq=3 ttl=253 time=5.5 ms
64 bytes from 192.168.1.1: icmp_seq=4 ttl=253 time=7.3 ms

--- 192.168.1.1 ping statistics ---
5 packets transmitted, 5 packets received, 0% packet loss
round-trip min/avg/max = 5.5/6.5/7.4 ms

If the appliance cannot reach the host via ICMP, output similar to the following appears:

PING 10.0.0.1 (10.0.0.1): 56 data bytes
Timeout ...
Timeout ...
Timeout ...
Timeout ...
Timeout ...

--- 10.0.0.1 ping statistics ---
5 packets transmitted, 0 packets received, 100% packet loss

“100% packet loss” and “Timeout” indicates that the host is not reachable.

To verify that routing is bidirectionally symmetric, you should also ping the appliance.
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Testing routes and latency with traceroute

The traceroute utility sends ICMP packets to test each hop along the route. It sends three packets to the destination, and
then increases the time to live (TTL) setting by one, and sends another three packets to the destination. As the TTL
increases, packets go one hop farther along the route until they reach the destination.

Most traceroute commands display their maximum hop count—that is, the maximum number of steps it will take before
declaring the destination unreachable—before they start tracing the route. The TTL setting may result in routers or
firewalls along the route timing out due to high latency.

Where ping only tells you if the signal reached its destination and returned successfully, traceroute shows each step of
its journey to its destination and how long each step takes. If you specify the destination using a domain name, the
traceroute output can also indicate DNS problems, such as an inability to connect to a DNS server.

By default, the traceroute utility uses UDP with destination ports numbered from 33434 to 33534. The traceroute utility
usually has an option to specify use of ICMP ECHO_REQUEST (type 8) instead, as used by the Windows tracert utility.
If you have a firewall and you want traceroute to work from both machines (Unix-like systems andWindows) you will
need to allow both protocols inbound through your firewall (UDP ports 33434 - 33534 and ICMP type 8).

To use traceroute:

1. Log into the CLI via either SSH, Telnet, or the CLI Console widget of the web UI.
2. Enter the command:
execute traceroute {<destination_ipv4> | <destination_fqdn>}

where {<destination_ipv4> | <destination_fqdn>} is a choice of either the device’s IP address or its fully
qualified domain name (FQDN).

For example, you might enter:

execute traceroute www.example.com

If the appliance has a complete route to the destination, output similar to the following appears:

traceroute to www.fortinet.com (66.171.121.34), 32 hops max, 84 byte packets
1 172.16.1.2 0 ms 0 ms 0 ms
2 209.87.254.221 <static-209-87-254-221.storm.ca> 2 ms 2 ms 2 ms
3 209.87.239.129 <core-2-g0-1-1104.storm.ca> 2 ms 1 ms 2 ms
4 67.69.228.161 2 ms 2 ms 3 ms
5 64.230.164.17 <core2-ottawa23_POS13-1-0.net.bell.ca> 3 ms 3 ms 2 ms
6 64.230.132.234 <core2-ottawatc_POS5-0-0.net.bell.ca> 20 ms 20 ms 20 ms
7 64.230.132.58 <core4-toronto21_POS0-12-4-0.net.bell.ca> 24 ms 21 ms 24 ms
8 64.230.138.154 <bx4-toronto63_so-2-0-0-0.net.bell.ca> 8 ms 9 ms 8 ms
9 64.230.185.145 <bx2-ashburn_so2-0-0.net.bell.ca> 23 ms 23 ms 23 ms
10 12.89.71.9 23 ms 22 ms 22 ms
11 12.122.134.238 <cr2.wswdc.ip.att.net> 100 ms 12.123.10.130 <cr2.wswdc.ip.att.net> 101 ms

102 ms
12 12.122.18.21 <cr1.cgcil.ip.att.net> 101 ms 100 ms 99 ms
13 12.122.4.121 <cr1.sffca.ip.att.net> 100 ms 98 ms 100 ms
14 12.122.1.118 <cr81.sj2ca.ip.att.net> 98 ms 98 ms 100 ms
15 12.122.110.105 <gar2.sj2ca.ip.att.net> 96 ms 96 ms 96 ms
16 12.116.52.42 94 ms 94 ms 94 ms
17 203.78.181.10 88 ms 87 ms 87 ms
18 203.78.181.130 90 ms 89 ms 90 ms
19 66.171.121.34 <fortinet.com> 91 ms 89 ms 91 ms
20 66.171.121.34 <fortinet.com> 91 ms 91 ms 89 ms
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Each line lists the routing hop number, the IP address and FQDN (if any) of that hop, and
the 3 response times from that hop. Typically a value of <1ms indicates a local
router.

If the appliance does not have a complete route to the destination, output similar to the
following appears:

traceroute to 10.0.0.1 (10.0.0.1), 32 hops max, 84 byte packets
1 172.16.1.2 0 ms 0 ms 0 ms
2 172.16.1.10 0 ms 0 ms 0 ms
3 * * *
4 * * *

The asterisks ( * ) indicate no response from that hop in the network routing.

Examining the routing table

When a route does not exist, or when hops have high latency, examine the routing table. The routing table is where the
FortiADC appliance caches recently used routes.

If a route is cached in the routing table, it saves time and resources that would otherwise be required for a route lookup. If
the routing table is full and a new route must be added, the oldest, least-used route is deleted to make room.

To check the routing table in the CLI, enter:

diagnose netlink route list

Examining server daemons

If a route exists, but you cannot connect to the web UI using HTTP or HTTPS, an application-layer problem is preventing
connectivity.

Verify that you have enabled HTTPS and/or HTTP on the network interface. Also examine routers and firewalls between
the host and the FortiADC appliance to verify that they permit HTTP and/or HTTPS connectivity between them. Finally,
you can also use the CLI command to verify that the daemons for the web UI and CLI, such as sshd, cli, nginx, and
php-fpm are running and not overburdened:

diagnose system top delay 10

Checking port assignments

If you are attempting to connect to FortiADC on a given network port, and the connection is expected to occur on a
different port number, the attempt will fail. For a list of ports used by FortiADC, see Port Numbers.

Performing a packet trace

When troubleshooting malformed packet or protocol errors, it helps to look inside the protocol headers of packets to
determine if they are traveling along the route you expect, and with the flags and other options you expect.

If you configure virtual servers on your FortiADC appliance, packets’ destination IP
addresses will be those IP addresses, not the physical IP addresses (i.e., the IP
address of port1, etc.). An ARP update is sent out when a virtual IP address is
configured.

If the packet trace shows that packets are arriving at your FortiADC appliance’s interfaces but no HTTP/HTTPS packets
egress, check that:
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l Physical links are firmly connected, with no loose wires
l Network interfaces are brought up
l Link aggregation peers, if any, are up
l VLAN IDs, if any, match
l Virtual servers exist, and are enabled
l Matching policies exist, and are enabled
l If using HTTPS, valid server/CA certificates exist
l IP-layer and HTTP-layer routes, if necessary, match
l Servers are responsive, if server health checks are configured and enabled

Checking the SSL/TLS handshake & encryption

If the client is attempting to make an HTTPS connection, but the attempt fails after the connection has been initiated,
during negotiation, the problemmay be with SSL/TLS. Symptoms may include error messages such as:

l ssl_error_no_cypher_overlap
(Mozilla Firefox 9.0.1)

l Error 113 (net::ERROR_SSL_VERSION_OR_CIPHER_MISMATCH): Unknown error.
(Google Chrome 16.0.912.75 m)

The handshake is between the client and FortiADC. If the connection cannot be established, verify that the browser
supports one of the key exchanges, encryption algorithms, and authentication (hashes) offered by FortiADC.

If you are not sure which cipher suites are currently supported, you can use SSL tools such as OpenSSL to discover
support. For example, you could use this client-side command to know whether the server or FortiADC supports strong
(HIGH) encryption:

openssl s_client -connect example.com:443 -cipher HIGH

or supports deprecated or old versions such as SSL 2.0:

openssl s_client -ssl2 -connect example.com:443

Resource issues

This section includes troubleshooting questions related to sluggish or stalled performance.

Monitoring traffic load

Heavy traffic loads can cause sustained high CPU or RAM usage. If this is unusual, no action is required. However,
sustained heavy traffic load might indicate that you need a more powerful FortiADCmodel.

In the web UI, you can view traffic load two ways:

l Monitor current HTTP traffic on the dashboard. Go to System > Dashboard >  Virtual Server and examine the
throughput graphs.

l Examine traffic history in the traffic log. Go to Logs & Report >  Log Browsing > Traffic Log.

DoS attacks

A prolonged denial of service (DoS) can bring your servers down if your FortiADC appliance and your network devices
are not configured to prevent it. To prevent DoS attacks, enable the DoS and connection limit features. Also, configure
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protections on your FortiGate and other network devices. DoS attacks can use a variety of mechanisms. For in-depth
protection against a wide variety of DoS attacks, you can use a specialized appliance such as FortiDDoS.

In the web UI, you can watch for attacks in two ways:

l Monitor current traffic on the dashboard. Go to System > Dashboard and examine the system-wide throughput.
l Examine attack history in the traffic log. Go to Logs & Report >  Log Browsing >  Security Log.

Resetting the configuration

If you will be selling your FortiADC appliance, or if you are not sure what part of your configuration is causing a problem,
you can reset it to its default settings and erase data. (If you have not updated the firmware, this is the same as resetting
to the factory default settings.)

Important: Back up the configuration before performing a factory reset.

To delete your data from the system, connect to the CLI and enter this command:

execute formatlogdisk

To reset the configuration, connect to the CLI and enter this command:

execute factoryreset

Restoring firmware (“clean install”)

Restoring (also called re-imaging) the firmware can be useful if:

l you are unable to connect to the FortiADC appliance using the web UI or the CLI
l you want to install firmware without preserving any existing configuration (i.e. a “clean install”)
l a firmware version that you want to install requires a different size of system partition (see the Release Notes
accompanying the firmware)

l a firmware version that you want to install requires that you format the boot device (see the Release Notes
accompanying the firmware)

The procedure in this section applies to physical appliances. Restoring firmware re-images the boot device. Also,
restoring firmware can only be done during a boot interrupt, before network connectivity is available, and therefore
requires a local console connection to the CLI. It cannot be done through an SSH or Telnet connection.

Alternatively, if you cannot physically access the appliance’s local console
connection, connect the appliance’s local console port to a terminal server to which
you have network access. Once you have used a client to connect to the terminal
server over the network, you will be able to use the appliance’s local console through
it. However, be aware that from a remote location, you may not be able to power
cycle the appliance if abnormalities occur.
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For virtual appliances, you can use VMware to backup and restore virtual appliance images.

Important: Back up the configuration before performing a clean install.
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To restore the firmware:

1. Download the firmware file from the Fortinet Customer Service & Support website:
https://support.fortinet.com/

2. Connect your management computer to the FortiADC console port using a RJ-45-to-DB-9 serial cable or a null-
modem cable.

3. Initiate a local console connection from your management computer to the CLI of the FortiADC appliance, and log in
as the admin administrator, or an administrator account whose access profile contains Read-Write permissions in
the Maintenance category.

4. Connect port1 of the FortiADC appliance directly or to the same subnet as a TFTP server.
5. Copy the new firmware image file to the root directory of the TFTP server.
6. If necessary, start your TFTP server. (If you do not have one, you can temporarily install and run one such as tftpd

(Windows, Mac OS X, or Linux) on your management computer.)

TFTP is not secure, and it does not support authentication. You should run it only
on trusted administrator-only networks, and never on computers directly
connected to the Internet. Turn off tftpd off immediately after completing this
procedure.

7. Verify that the TFTP server is currently running, and that the FortiADC appliance can reach the TFTP server.
To use the FortiADC CLI to verify connectivity, enter the following command:
execute ping 192.168.1.168

where 192.168.1.168 is the IP address of the TFTP server.
8. Enter the following command to restart the FortiADC appliance:

execute reboot

As the FortiADC appliances starts, a series of system startup messages appear.
Press any key to display configuration menu........

9. Immediately press a key to interrupt the system startup.

You have only 3 seconds to press a key. If you do not press a key soon enough,
the FortiADC appliance reboots and you must log in and repeat the execute
reboot command.

If you successfully interrupt the startup process, the following messages appears:
[G]: Get firmware image from TFTP server.
[F]: Format boot device.
[B]: Boot with backup firmware and set as default.
[Q]: Quit menu and continue to boot with default firmware.
[H]: Display this list of options.

Enter G,F,B,Q,or H:

Please connect TFTP server to Ethernet port "1".

10. If the firmware version requires that you first format the boot device before installing firmware, type F. Format the
boot disk before continuing.

11. Type G to get the firmware image from the TFTP server.
The following message appears:
Enter TFTP server address [192.168.1.168]:
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Troubleshooting

12. Type the IP address of the TFTP server and press Enter.
The following message appears:
Enter local address [192.168.1.188]:

13. Type a temporary IP address that can be used by the FortiADC appliance to connect to the TFTP server.
The following message appears:
Enter firmware image file name [image.out]:

14. Type the file name of the firmware image and press Enter.
The FortiADC appliance downloads the firmware image file from the TFTP server and displays a message similar to
the following:
MAC:00219B8F0D94

###########################

Total 28385179 bytes data downloaded.

Verifying the integrity of the firmware image..

Save as Default firmware/Backup firmware/Run image without saving:[D/B/R]?

If the download fails after the integrity check with the error message:
invalid compressed format (err=1)
but the firmware matches the integrity checksum on the Fortinet Customer
Service & Support website, try a different TFTP server.

15. Type D.
The FortiADC appliance downloads the firmware image file from the TFTP server. The FortiADC appliance installs
the firmware and restarts. The time required varies by the size of the file and the speed of your network connection.
The FortiADC appliance reverts the configuration to default values for that version of the firmware.

16. To verify that the firmware was successfully installed, log in to the CLI and type:
get system status

The firmware version number is displayed.
17. Either reconfigure the FortiADC appliance or restore the configuration file.

Additional resources

Fortinet also provides these resources:

l The Release Notes provided with your firmware
l Technical documentation (reference guides, installation guides, and other documents)
l Knowledge base (technical support articles)
l Forums
l Online campus (tutorials and training materials)

If you have problem using FortiADC, check within your organization first. You can save time and effort during the
troubleshooting process by checking if other FortiADC administrators have experienced a similar problem before.

If you cannot resolve the issue on your own, contact Fortinet Customer Service & Support.

FortiADC Handbook 836
Fortinet Technologies Inc.

http://docs.fortinet.com/
http://kb.fortinet.com/
http://support.fortinet.com/forum
http://training.fortinet.com/
http://www.fortinet.com/support/contact_support.html


Appendices

Appendices

This section includes the following FortiADC Appendix pages.

l Port Numbers on page 838
l Scripts on page 840
l Maximum Configuration Values on page 887
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Port Numbers

Communications between the FortiADC system, clients, servers, and FortiGuard Distribution Network (FDN) require that
any routers and firewalls between them permit specific protocols and port numbers.

Default ports used by FortiADC for outgoing traffic on page 838 and Default ports used by FortiADC for incoming traffic
(listening) on page 838 list the default port assignments that FortiADC uses for outgoing and incoming traffic,
respectively.

Port Number Protocol Purpose

N/A ARP HA failover of network interfaces.

N/A ICMP l Server health checks.
l execute ping and execute traceroute.

25 TCP SMTP for alert email.

53 UDP DNS queries.

69 UDP TFTP for backups, restoration, and firmware updates. See commands such as
execute backup or execute restore.

80 TCP Server health checks.

123 UDP NTP synchronization.

162 UDP SNMP traps.

389 TCP LDAP authentication queries.

443 TCP l FortiGuard polling.
l Server health checks.

514 UDP Syslog.

6055 UDP HA heartbeat. Layer 2 multicast.

6056 UDP HA configuration synchronization. Layer 2 multicast.

Default ports used by FortiADC for outgoing traffic

Port Number Protocol Purpose

N/A ICMP ping and traceroute responses.

22 TCP SSH administrative CLI access.

23 TCP Telnet administrative CLI access.

53 UDP DNS queries from clients for global load balancing and inbound link load balancing.

Default ports used by FortiADC for incoming traffic (listening)
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Port Number Protocol Purpose

80 TCP l HTTP administrative web UI access.
l Predefined HTTP service. Only occurs if the service is used by a virtual server.

161 UDP SNMP queries.

443 TCP l HTTPS administrative web UI access. Only occurs if the destination address is
a network interface’s IP address.

l Predefined HTTPS service. Only occurs if the service is used by a virtual
server, and if the destination address is a virtual server.

6055 UDP HA heartbeat. Layer 2 multicast.

6056 UDP HA configuration synchronization. Layer 2 multicast.
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Scripts

You can embed Lua scripts to perform tasks that are not supported by the built-in feature set.

This appendix provides guidance for getting started. It includes the following topics:

l Scripting application on page 840
l Events and actions on page 842
l Predefined commands on page 844
l Predefined scripts on page 867
l Control structures on page 869
l Operators on page 870
l String library on page 871
l Functions on page 872
l Special characters on page 874
l Examples on page 875

For general information about Lua, visit http://www.lua.org/docs.html.

Scripting application

HTTP scripts are composed of several functional components that define the trigger events, commands, operators, and
more. The following example demonstrates how HTTP scripting is applied to rewrite the HTTP Host header and path in
an HTTP request.

The HTTP script:

when RULE_INIT {
debug("rewrite the HTTP Host header and path in a HTTP request \n")
}

when HTTP_REQUEST{
host = HTTP:header_get_value("Host")
path = HTTP:path_get()
if host:lower():find("myold.hostname.com") then
debug("found myold.hostname.com in Host %s \n", host)
HTTP:header_replace("Host", "mynew.hostname.com")
HTTP:path_set("/other.html")
end
}

Script component breakdown:

Parameter Example Description

Events— for details, see Events and actions on page 842.
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Parameter Example Description

RULE_INIT The event is used to initialize global or static variables
used within a script. It is triggered when a script is added
or modified, or when the device starts up, or when the
software is restarted.

HTTP_REQUEST The virtual server receives a complete HTTP request
header.

Commands— for details, see Predefined commands on page 844.

Debug(str) Prints the debug information when VS using scripting.

HTTP:header_get_values
(header_name)

Returns a list of value(s) of the HTTP header named
<header_name>, with a count for each value. Note that
the command returns all the values in the headers as a
list if there are multiple headers with the same name.

HTTP:path_get() Returns the string of the HTTP request path.

HTTP:header_replace(header_
name, value)

Replaces the occurrence value of header <header_
name> with value <value>.

HTTP:path_set(value) Sets HTTP request path to the string <value>.

Operators— for details, see Operators on page 870. (Not applicable in this example).

Strings— for details, see String library on page 871.

host:lower():find
("myold.hostname.com")

The string library includes the string-manipulation
functions, such as:
string.lower

string.find(s, pattern)

This example combines the above string manipulation
functions, using lower() to convert the Host strings to
lowercase and then find() to search for the Host
header for a match.

Control structures— for details, see Control structures on page 869.

if...then
end

if condition1 then
…
else if condition2 then
… break
else
… go to location1
end

::location1::

Functions— for details, see Functions on page 872. (Not applicable in this example).
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Events and actions

Scripts are associated with a particular virtual server, and they are event-driven. A script is triggered when the
associated virtual server receives an HTTP request or response. Then, it does the programmed action.

You can set different script priorities when you run multiple scripts at once. See
Prioritize scripts on page 885 for more information.

Script events and actions on page 842 provides the syntax, usage, and examples of the predefined commands that are
useful for writing scripts.

Event/Action Description

Event

HTTP_REQUEST The virtual server receives a complete HTTP request header.

HTTP_RESPONSE The virtual server receives a complete HTTP response header.

RULE_INIT The event is used to initialize global or static variables used within a script. It is triggered
when a script is added or modified, or when the device starts up, or when the software is
restarted.

VS_LISTENER_BIND The virtual server tries to bind.

SERVER_BEFORE_
CONNECT

The virtual server is going to connect to the backend real server.

SERVER_CONNECTED The HTTP proxy deems that the backend real server is connected.

AUTH_RESULT The authentication (HTML Form / HTTP-basic) is done.

HTTP_RESPONSE_
CONTINUE

Triggered immediately when the system receives a 100 continue response from the
server.

HTTP_DATA_REQUEST Triggered whenever an HTTP:collect command finishes processing, after collecting the
requested amount of data.

HTTP_REQUEST_SEND Triggered immediately before a request is sent to a server.

HTTP_DATA_
RESPONSE

Triggered when an HTTP:collect command finishes processing on the server side of a
connection.

CLIENTSSL_
HANDSHAKE

The virtual server receives a complete HTTPS handshake on the client side.

SERVERSSL_
HANDSHAKE

FortiADC receives a complete HTTPS handshake on the server side.

CLIENTSSL_
RENEGOTIATE

The virtual server receives a re-connection request from a peer.

SERVERSSL_ FortiADC sends a re-connection request to a peer.

Script events and actions
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Event/Action Description

RENEGOTIATE

TCP_ACCEPTED The virtual server receives a complete TCP connection.

TCP_CLOSED The virtual server close a TCP connection.

PERSISTENCE Event hook inside process_sticking_rules() in httproxy.

POST_PERSIST Event hook after LB is done and assigns real server according to ADCmethod.

WAF_REQUEST_
BEFORE_SCAN

Event hook before the WAF_SCAN_STAGE_REQ_HEADER starts. If WAF function is
not enabled on VS, then this will not be triggered.

WAF_RESPONSE_
BEFORE_SCAN

Event hook before the WAF_SCAN_STAGE_RES_HEADER starts. If WAF function is
not enabled on VS, then this will not be triggered.

WAF_REQUEST_
ATTACK_DETECTED

Event hook after all request stages when there are attacks detected (violation). If WAF
function is not enabled on VS, then this will not be triggered. If WAF module does not
detect any violations, then this will not be triggered.

WAF_RESPONSE_
ATTACK_DETECTED

Event hook after all response stages when there are attacks detected (violation). If WAF
function is not enabled on VS, then this will not be triggered. If WAF module does not
detect any violations, then this will not be triggered.

SERVER_CLOSED When Httproxy is going to terminate the backend real server connection.

COOKIE_BAKE When FortiADC is done baking an authentication cookie.
Allows PROXY commands, MGM commands and AUTH:get_baked_cookie/set_baked_
cookie.
The COOKIE_BAKE event can occur after AUTH_RESULT, HTTP_REQUEST, or
HTTP_RESPONSE events.

BEFORE_AUTH The BEFORE_AUTH event triggers right before the authentication is performed to allow
the user specified user group to be used instead. The new user group will override the
authentication result of the original authentication policy.
HTTP: header_get_names header_get_values header_get_value header_remove
header_remove2 header_insert header_replace header_replace2 header_exists
header_count version_get version_set redirect_with_cookie redirect_t redirect close
disable_event enable_event set_event set_auto disable_auto enable_auto rand_id get_
session_id cookie cookie_list cookie_crypto respond method_get method_set uri_get
uri_set path_get path_set query_get query_set client_port local_port remote_port
client_addr local_addr remote_addr client_ip_ver
LB: routing get_valid_routing get_current_routing method_assign_server
AUTH: set_usergroup realm usergroup host
SSL: renegotiate cert_request get_verify_depth set_verify_depth client_cert peer_cert
cert
IP: client_port local_port remote_port client_addr local_addr remote_addr client_ip_ver
MGM: rand_id get_session_id disable_event enable_event set_event set_auto disable_
auto enable_auto
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Event/Action Description

Action

in Lua mode An action defined by a Lua script that uses predefined commands and variables to
manipulate the HTTP request/response or select a content route.

Predefined commands

Predefined commands on page 844 provides the syntax, usage, and examples of the predefined commands that are
useful for writing scripts.

Syntax Usage and Example

Global

debug(“msg”, …) Write the message to the debug buffer. For example:

debug("HTTP Request method is %s.\n", HTTP:method_get())

Debug strings can be written to the console when the event is triggered. This is helpful when you
are testing your scripts.

To enable debug strings to be written to the console, use the following CLI commands:

diagnose debug enable
diagnose debug application httproxy scripting

cmp_addr(addr,
addr_group)

Used to match one IP address against a group of IP addresses. It can automatically detect IPv4
and IPv6 and can be used to compare IPv4 addresses with IPv6 addresses.
For example:
cmp_addr(“192.3.2.1/24”, “192.3.2.0/32”)
cmp_addr(“::ffff:192.3.2.1/120”, “::ffff:192.3.2.0/128”)
cmp_addr(“192.3.2.1/24”, “::ffff:192.3.2.0/128”)

Input format:
For an IPv4 ip_addr/[mask], the mask can be a number between 0 and 32 or a dotted format like
255.255.255.0
For an IPv6 ip_addr/[mask], the mask can be a number between 0 and 128.
FortiADC supports address group for the second argument.
when RULE_INIT{
--initialize the address group here
addr_group = "192.168.1.0/24" --first network address
addr_group = addr_group..",::ffff:172.30.1.0/120" --second network address

Predefined commands
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Syntax Usage and Example

--so on and so forth
}
when HTTP_REQUEST{
client_ip=HTTP:client_addr()
match_ip=cmp_addr(client_ip, addr_group)
}

log("fmt", ...) Writes log messages into the SLB log category in the script log part. You must enable Script log
and SLB sub-category under the Script log on the log setting page. For example:

log("This HTTP Request method is %s.\n", HTTP:method_get())

Note: \ and % are handled in a unique way. Special characters that the log supports are
:~!@#$^&*()_+{}][. If you want to print out % in the log, you must use %%; if you want to print out
\, you must use \\.

rand() Generates a random number. For example:

a = rand()
debug(“a=%d\n”,a)

time() Returns the current time as an integer. For example:
The following code will return the current time, in Unix time format, as an integer and store it in
variable "t".

t=time()

ctime() Returns the current time as a string. For example:
The following code will return the current time as a string and store it in variable "ct".

ct=ctime()

md5() Calculates the MD5 of a string input and stores the results in an intermediate variable. For
example:
The following code will calculate the MD5 of the string provided and store it in variable "Md".

Str="test string\1\2"
Md=md5(str)

md5_hex() Calculates the MD5 of a string input of a string input and outputs the results in HEX format.
The following code will calculate the MD5 of the string provided and store it, in HEX format, in
variable "re_hex".

Str="abc"
re_hex=md5_hex(str)

sha1() Calculates the SHA1 of a string input of a string input and stores the results in an intermediate
variable.
The following code will calculate the SHA1 of the string provided and store it in variable "sha".
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Str="abc"
sha=sha1(str)

sha1_hex() Calculates the SHA1 of a string input of a string input and outputs the results in HEX format.

The following code will calculate the SHA1 of the string provided and store it, in HEX format, in
variable "sha".
Str="abc"
sha=sha1_hex(str)

b64_enc() Encodes a string input in base64 and outputs the results in string format.
The following code will encode the string provided and store it in the variable "en".
Str="abc"
en=b64_enc(str)

b64_dec() Decodes a base64 encoded string input and outputs the results in string format.
The following code will encode the string provided and store it in the variable "en".
Str="abc"
en=b64_dec(str)

htonl() Converts a long integer input into network byte order and outputs the results in string format.

The following code will convert the integer provided and store it, as a string, in the variable "b".
a=32
b=htonl(a)

ntohl() Converts a long integer input into host byte order and outputs the results in string format.
The following code will convert the integer provided and store it, as a string, in the variable "b".
a=32
b=ntohl(a)

htons() Converts a short integer input into network byte order and outputs the results in string format.
The following code will convert the integer provided and store it, as a string, in the variable "b".
a=32
b=htons(a)

ntohs() Converts a short integer input into host byte order and outputs the results in string format.
The following code will convert the integer provided and store it, as a string, in the variable "b".
a=32
b=ntohs(a)

string.format() Converts an integer to string format.
The following code will convert the integer provided and store it, as a string, in the variable "b".
a=32
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b=string.format(a)

You may also use the function as shown in the code below. The string "12,pi=3.14" will be stored
in variable "b".
a=12
b=string.format("%s,pi=%.4f",a,3.14);

string.char() Converts a number in string format to its corresponding ASCII char.
The following code will convert the string provided and store it in the variable "test". In this case,
string.char() will return "a".
str=97
test=string.char(str)

{<variable>:byte
(1,-1)}

Creates a table with the codes of all characters in the variable. This table can be used to recreate
the original string using the table_to_string() command.
The following code will create a table, then store the variable 'str" in the table. In this
case,variable "t" is the table, and t[1] is 97, t[2] is 98, t[3] is 99, t[4] is 1, t[5] is 2, t[6] is 0.
str="abc\1\2\0"
t={str:byte(1,-1)}

{<variable>:sub
(i,j)}

Returns a sub-string of the variable indexed from i to j.
The following code will return the string "abc" and store it into variable "t".
str="abc\1\2\0"
t={str:sub(1,3)}

table_to_string() Converts a table to string format.
The following code will convert the table "t" and store it, as a string, in the variable "str".The string
stored in "str" at the end is "abc\1".
t={};
t[1]=97;
t[2]=98;
t[3]=99;
t[4]=1;
str=table_to_string(t);

to_HEX Converts a string to HEX format.
The following code will convert the string "str" and store it to "hex" in HEX format.
str="\0\123\3"
hex=to_HEX(str);

crc32(str); Returns the crc32 check value of the string, or 0 if it is an empty string, For example:
when HTTP_REQUEST {       
str = "any string for crc32 calculation"
crc = crc32(str);
debug("rc is %d\n", crc);
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}

new_key = key_
gen(str_pass, str_
salt, iter_num,
len_num); "

Creates an AES key to encrypt/decrypt data, either generated by password or user specific
defined. For example:
when HTTP_REQUEST {       
new_key = key_gen("pass", "salt", 32, 32);
debug("new key in hex is %s\n", to_HEX(new_key));
}

aes_enc(t) Encrypts a string using AES algorithm, For example:
when HTTP_REQUEST {        t={}; t["message"] = "value";
t["key"] = "aaaaaaaaaabbbbbb";
t["size"]=128 enc = aes_enc(t) debug("encrypted in hex is %s, after b64 encoding %s\n", to_
HEX(enc), b64_enc_str(enc));
}

aes_dec(t) Dencrypts a string using AES algorithm. For example:
when HTTP_REQUEST {        t={}; t["message"] = enc;
t["key"] = "aaaaaaaaaabbbbbb";
t["size"]=128 dec = aes_dec(t);
debug("decrypted in hex is %s\n", to_HEX(dec));
}

EVP_Digest(alg,
str)

EVP_Digest for oneshot digest calculation. For example:
when HTTP_REQUEST {        alg = "MD5"; data = "your data" re = EVP_Digest(alg, data);
debug("the digest in hex is %s\n", to_HEX(re));
}

HMAC(alg, str,
key)

HMACmessage authentication code. For example:
when HTTP_REQUEST {        alg = "MD5"; --must be "MD5", "SHA1", "SHA256", "SHA384",
"SHA512" data = "your data" key = "11234567890ab";
re = HMAC(alg, data, key);
debug("the HMAC in hex is %s\n", to_HEX(re)); }

HMAC_verify(alg,
data, key, verify)

Check if the signature is same as the current digest.
when HTTP_REQUEST {        alg = "MD5"; data = "your data" verify = "your result to compare" key =
"11234567890ab";
re = HMAC_verify(alg, data, key, verify);
if re then debug("verified\n") else debug("not verified\n") end }

G2F(alg, key) Returns a G2F random value . For example:
when HTTP_REQUEST {        alg = "MD5"; key = "11234567890ab";
re = G2F(alg, key);
debug("the G2F value is %d\n", re); }

class_match(str, Used to match the string against an element in list:
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method, list); when HTTP_REQUEST {        url = HTTP:uri_get() status, count, t = class_match(url, "starts_with",
url_list);
debug("status %s, count %s\n", status, count);
for k,v in pairs(t) do debug("index %s, value %s\n", k,v); end }

class_search(list,
method, str);

Used to search the an element in the list against a string:
when HTTP_REQUEST {        status, count, t = class_search(url_list, "starts_with", url);
--or "ends_with", "equals", "contains" for k,v in pairs(t) do debug("index %s, value %s\n", k,v);
end }

ip2country_name
(ip)

Return the GEO information (country name) of an IP address.
when HTTP_REQUEST {         cip = IP:client_addr(); cnm = ip2country_name

(cip); debug("cname %s\n", cnm); }

ip2countryProv_
name(ip)

Return the the GEO information (country name + possible province name) of an IP address.
when HTTP_REQUEST {         cip = IP:client_addr(); cnm = ip2countryProv_name
(cip); debug("cname %s\n", cnm); }

url_enc(str) Converted the url into a valid ASCII format.
when HTTP_REQUEST {         url = "http://foor bar/@!"; enc = url_enc(url);
debug("encoded url is %s\n", enc); }

url_dec(str) converted the encoding-url into a orignal url.
when HTTP_REQUEST {         url = "http://foor.bar/test/"; enc = url_enc(url);
debug("encoded url is %s\n", enc); }

url_parser(str) Extracte the url and host are converted to lower case letters.
when HTTP_REQUEST {         url =
"http://foo:bar@w1.superman.com/very/long/path.html?p1=v1&p2=v2#more-
details" purl = url_parser(url); if purl then debug("parsed url scheme
%s, host %s, port %s, path %s, query %s, fragment %s, username %s,
passowrd %s\n", purl["scheme"], purl["host"], purl["port"],purl
["path"], purl["query"], purl["fragment"], purl["username"], purl
["password"]); end }

url_compare(url1,
url2)

Compare two url string, return true if it's the same.
when HTTP_REQUEST {         url1 = "http://www.example.com/url/path/data" url2
= "httP://WWW.example.com:80/url/path/data" if url_compare(url1, url2)
then debug("url match\n"); else debug("url not match\n"); end }

rand_hex(int) Generate a random number in HEX:
str = rand_hex(16);

rand_alphanum
(int)

Generate a random alphabet+number sequence:
str = rand_alphanum(16);

rand_seq(int) Generate a random in sequence:
str = rand_seq(16)
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md5_str(str) Calculate the MD5 of a string input and stores the results in an intermediate variable, In some
cases you need a this version to deal with it. For example:
Md=md5_str(input); --input can be a cert in DER format

md5_hex_str(str) Calculates the MD5 of a string input of a string input and outputs the results in HEX format, In
some cases you need a this version to deal with it. For example:
Md=md5_hex_str(input); --input can be a cert in DER format

sha1_str() Calculates the SHA1 of a string input of a string input and stores the results in an intermediate
variable, In some cases you need a this version to deal with it. For example:
result=sha1_str(input); --input can be a cert in DER format

sha1_hex_str() Calculates the SHA1 of a string input of a string input and outputs the results in HEX format, In
some cases you need a this version to deal with it. For example:
result=sha1_hex_str(input); --input can be a cert in DER format

sha256() Calculates the SHA256 of a string input of a string input and stores the results in an intermediate
variable. The following code will calculate the SHA256 of the string provided and store it in
variable "sha256".
Str="abc" sha256=sha256(str)

sha256_hex() Calculates the SHA256 of a string input of a string input and outputs the results in HEX format.
The following code will calculate the SHA256 of the string provided and store it, in HEX format, in
variable "sha256".
Str="abc" sha256=sha256_hex(str)

sha256_str() Calculates the SHA256 of a string input of a string input and stores the results in an intermediate
variable. In some cases you need a this version to deal with it. For example:
result=sha256_str(input); --input can be a cert in DER format

sha256_hex_str() Calculates the SHA256 of a string input of a string input and outputs the results in HEX format. In
some cases you need a this version to deal with it. For example:
result=sha256_hex_str(input); --input can be a cert in DER format

sha384() Calculates the SHA384 of a string input of a string input and stores the results in an intermediate
variable. The following code will calculate the SHA384 of the string provided and store it in
variable "sha384".
Str="abc" sha384=sha384(str)

sha384_hex() Calculates the SHA384 of a string input of a string input and outputs the results in HEX format.
The following code will calculate the SHA384 of the string provided and store it, in HEX format, in
variable "sha384".
Str="abc" sha384=sha384_hex(str)

sha384_str() Calculates the SHA384 of a string input of a string input and stores the results in an intermediate
variable. In some cases you need a this version to deal with it. For example:
result=sha384_str(input); --input can be a cert in DER format

sha384_hex_str() Calculates the SHA384 of a string input of a string input and outputs the results in HEX format. In
some cases you need a this version to deal with it. For example:
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result=sha384_hex_str(input); --input can be a cert in DER format

sha512() Calculates the SHA512 of a string input of a string input and stores the results in an intermediate
variable. The following code will calculate the SHA512 of the string provided and store it in
variable "sha512".
Str="abc" sha512=sha512(str)

sha512_hex() Calculates the SHA512 of a string input of a string input and outputs the results in HEX format.
The following code will calculate the SHA512 of the string provided and store it, in HEX format, in
variable "sha512".
Str="abc" sha512=sha512_hex(str)

sha512_str() Calculates the SHA512 of a string input of a string input and stores the results in an intermediate
variable. In some cases you need a this version to deal with it. For example:
result=sha512_str(input); --input can be a cert in DER format

sha512_hex_str() Calculates the SHA512 of a string input of a string input and outputs the results in HEX format. In
some cases you need a this version to deal with it. For example:
result=sha512_hex_str(input); --input can be a cert in DER format

b32_enc() Encodes a string input in base32 and outputs the results in string format. The following code will
encode the string provided and store it in the variable "en".
Str="abc" en=b32_enc(str)

b32_enc_str(str) Encodes a string input in base32 and outputs the results in string format. In some cases you
need a this version to deal with it. For example:
result=b32_enc_str(input); --input can be a cert in DER format

b32_dec() Decodes a base32 encoded string input and outputs the results in string format. The following
code will encode the string provided and store it in the variable "dec".
Str="abc" dec=b32_dec(str)

b32_dec_str() Decodes a base32 encoded string input and outputs the results in string format. In some cases
you need a this version to deal with it. For example:
result=b32_dec_str(input); --input can be a cert in DER format

get_pid() Return the PID value of the VS process. For exmaple:
debug("VS PID is : %d\n", get_pid());

HTTP

cookie_list Returns a list of cookies: their names and values. For example:
ret=HTTP:cookie_list()
for k,v in pairs(ret)
do debug("cookie name%s, value %s\n", k,v);
end

cookie Allows you to GET/SET its value and its attribute, REMOVE a whole cookie, GET the whole
cookie in HTTP RESPONSE, and INSERT a new cookie. For example:
t={};
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t["name"]="test" t["parameter"]="value";--value, cookie, path, domain, expires, secure, maxage,
max-age, httponly, version, port
t["action"]="get"--get, set, remove, insert ret = HTTP:cookie(t)
if ret then
debug("get cookie value succeed %s\n",ret);
else
debug("get cookie value failed\n");
end

cookie_crypto The provided function response_encrypt_cookie can be used to perform cookie encryption in
HTTP RESPONSE and request_decrypt_cookie can be used to perform cookie decryption in
HTTP REQUEST. For example:
--Decrypt cookie "test" in HTTP REQUEST before forwarding to real servers local t={};
t["name"]="cookiename"
t["action"]="encrypt"--encrypt, or decrypt
t["key"]="0123456789ABCDEF";
t["prefix"]="XXXX";
t["size"]=size-- 128, 192, or 256, the corresponding key length is 16, 24, and 32 if HTTP:
cookie_crypto(t) then debug("Encrypt cookie succeed\n");
else
debug("Encrypt cookie failed\n");
end

respond Allows you to return a customized page, For example:
when HTTP_REQUEST{        tt={} tt["code"] = 200;
tt["content"] = "HTTP/1.1 200 OK\r\nConnection: close\r\nContent-Type: text/plain\r\n\r\nXXXXX
Test Page XXXXXXX";
status = HTTP:respond(tt);
debug("HTTP_respond() status: %s\n", status);
}

header_get_
names()

Returns a list of all the headers present in the request or response. For example:

--use header and value
headers = HTTP:header_get_names()
for k, v in pairs(headers) do
debug("The value of header %s is %s.\n", k, v)
end

--only use the header name
for name in pairs(headers) do
debug("The request/response includes header %s.\n", name)
end

FortiADC Handbook 852
Fortinet Technologies Inc.



Syntax Usage and Example

header_get_
values(header_
name)

Returns a list of value(s) of the HTTP header named <header_name>, with a count for each
value. Note that the command returns all the values in the headers as a list if there are multiple
headers with the same name. For example:

cookies=HTTP:header_get_values("Cookie")
for k, cnt in pairs(cookies) do
debug("initially include cookie %s cnt %d\n", k, v)
end

header_get_value
(header_name)

Returns the value of the HTTP header named <header_name>.

Returns false if the HTTP header named <header_name> does not exist. Note: The command
operates on the value of the last header if there are multiple headers with the same name. For
example:

host = HTTP:header_get_value("Host")

header_remove
(header_name)

Removes all headers names with the name <header_name>. For example:

HTTP:header_remove("Cookie")

header_remove2
(header_
name,countid)

header_get_values() returns a count ID for each item. This count ID can be used in both header_
remove2() and header_replace2() to remove and replace a certain header of a given name
referenced by the count ID. For example:

cookies=HTTP:header_get_values("Set-Cookie")
for k, v in pairs(cookies) do
debug("include cookie %s cnt %d\n", k, v)
end
if HTTP:header_remove2("Set-Cookie", 1) then
debug("remove 1st cookie\n")
end

header_insert
(header_name,
value)

Inserts the named HTTP header(s) and value(s) into the end of the HTTP request or response.
For example:

HTTP:header_insert("Cookie", "cookie=server1")

header_replace
(header_name,
value)

Replaces the value of the last occurrence of the header named <header_name> with the string
<value>. Performs a header insertion if the header is not present. For example:

HTTP:header_replace("Host", "www.fortinet.com")

header_replace2
(header_name,
value,countid)

header_get_values() returns a count ID for each item. This count ID can be used in both header_
remove2() and header_replace2() to remove and replace a certain header of a given name
referenced by the count ID. For example:

cookies=HTTP:header_get_values("Set-Cookie")
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for k, v in pairs(cookies) do
debug("include cookie %s cnt %d\n", k, v)
end
if HTTP:header_replace2("Set-Cookie", "new2=value2", 2) then
debug("replace 2nd cookie by new2=value2\n")
end

header_exists
(header_name)

Returns true if the named header is present and not empty on the request or response. For
example:

if HTTP:header_exists("Cookie") then
…
end

header_count
(header_name)

Returns the number of HTTP headers present in the request or response. For example:

count = HTTP:header_count("Cookie")

method_get() Return the string of the HTTP request method. For example:

method = HTTP:method_get()

method_set
(string)

Set the HTTP request method to the string "value". For example:

HTTP:method_set("POST")

path_get() Returns the path part of the HTTP request. For example:

path = HTTP:path_get()

path_set(string) Sets the path part of the HTTP request. The client will not see the update unless the web
application uses the requested path to generate response headers and/or content. If you want
the client to see the update to the path in the browser's address bar, you can send an HTTP
redirect using HTTP:redirect or HTTP:respond. For example:

HTTP:path_set("/other.html")

uri_get() Returns the URI given in the request. For example:

uri = HTTP:uri_get()

uri_set(string) Changes the URI passed to the server. It should always start with a slash. For example:

HTTP:uri_set("/index.html?value=xxxx")

query_get() Returns the query part of the HTTP request. For example:

query = HTTP:query_get()

query_set(string) Sets the query part of the HTTP request. For example:
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HTTP:query_set("value=xxx")

redirect(“URL”, …) Redirects an HTTP request or response to the specified URL. For example:

Host = HTTP:header_get_value("host")
Path = HTTP:path_get()
HTTP:redirect("https://%s%s", Host, Path)

redirect_with_
cookie(URL,
cookie)

Redirects an HTTP request or response to the specified URL with Cookie. For example:

HTTP:redirect_with_cookie(“www.example.com”, “server=nginx”)

redirect_t Redirects an HTTP request or response to the URL specified in the table. For example:

a={}
a["url"]="http://192.168.1.7"
a["code"]="303"
a["cookie"]="test=server"
HTTP:redirect_t(a)

version_get() Returns the HTTP version of the request or response. For example:

vers = HTTP:version_get()

version_set(string) Sets the HTTP version of the request or response. For example:

HTTP:version_set("1.0")

status_code_get() Returns the response status code output as string. For example:

responsestatus=HTTP:status_code_get()

status_code_set
(string)

Sets the response status code. For example:

HTTP:status_code_set("301")

code_get() Returns the response status code,output as integer. For example:

responsestatus=HTTP:code_get()

code_set(integer) Sets the response status code. For example:

HTTP:code_set(301)

reason_get() Returns the response reason. For example:

HTTP:reason_get()

reason_set(string) Sets the response reason. For example:

HTTP:reason_set(string)
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rand_id() Returns a random string of 32-long in hex format, which can be inserted directly as an HTTP
header. For example:

ID=HTTP:rand_id()
HTTP:header_insert("Message-ID", ID)

client_addr() Returns the client IP address of a connection for an HTTP_REQUEST packet, which is the
source address for the HTTP_REQUEST packet. It's a destination address. For example:

CIP=HTTP:client_addr()

local_addr() For HTTP_REQUEST, returns the IP address of the virtual server the client is connected to; for
HTTP_RESPONSE, returns the incoming interface IP address of the return packet. For
example:

LIP=HTTP:local_addr()

remote_addr() Returns the IP address of the host on the far end of the connection. For example:

RIP=HTTP:remote_addr()

server_addr() Returns the IP address of the server in HTTP_RESPONSE.

SIP=HTTP:server_addr()

close() Closes an HTTP connection using code 503. For example:

HTTP:close()

client_port() Returns the client port number in a string format. For example:

HTTP:client_port()

local_port() Returns the local port number in a string format. For example:

HTTP:local_port()

remote_port() Returns the remote port number in a string format. For example:

HTTP:local_port()

server_port() Returns the server port number in a string format. For example:

HTTP:server_port()

client_ip_ver() Returns the client IP version number. For example:

HTTP:client_ip_ver()

server_ip_ver() Returns the server IP version number. For example:

HTTP:server_ip_ver()
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collect Collects data. You may specify a specific amount using the length argument. Used in HTTP_
REQUEST or HTTP_RESPONSE. For example:
t={};
t["size"]=1000; --optional
HTTP:collect(t);

payload (size) Returns the size of the buffered content. Used in HTTP_DATA_REQUEST or HTTP_DATA_
RESPONSE. For example:
t={};
t["operation"]="size"
sz=HTTP:payload(t); --return value is an int

payload (content) Returns the buffered content in a string. Used in HTTP_DATA_REQUEST or HTTP_DATA_
RESPONSE. For example:
t={};
t[“operation”]=”content”
t[“offset”]=12; --optional
t[“size”]=20; --optional
ct = HTTP:payload(t); --return value is a string

payload (set) Replaces the buffered data with new data. Used in HTTP_DATA_REQUEST or HTTP_DATA_
RESPONSE.For example:
t={};
t[“operation”]=”set”
t[“offset”]=12; --optional
t[“size”]=20; --optional
t[“data”]= ”new data to insert”;
ret = HTTP:payload(t); --returns true if operation succeeds

payload (find) Searches for a particular string in the buffered data. Used in HTTP_DATA_REQUEST or HTTP_
DATA_RESPONSE.For example:
t={};
t[“operation”]=”find”
t[“data”]=”sth”; -- can also be a regular expression, like (s.h)
t[“offset”]=12; --optional
t[“size”]=20; --optional
t[“scope”]=”first” -- the scope field can be either “first” or “all”
ct = HTTP:payload(t); --returns the number of occurences found

payload (remove) Removes a particular string from the buffered data. Used in HTTP_DATA_REQUEST or HTTP_
DATA_RESPONSE.For example:
t={};
t[“operation”]=”remove”
t[“data”]=”sth”; -- can also be a regular expression, like (s.h)
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t[“offset”]=12;
t[“size”]=20;
t[“scope”]=”first” -- or “all”
ct = HTTP:payload(t); --returns number of occurrences removed

payload (replace) Replaces a particular string or regular expression with a new string. Used in HTTP_DATA_
REQUEST or HTTP_DATA_RESPONSE. For example:
t={};
t[“operation”]=”replace”
t[“data”]=”sth”; -- can be a regular expression, like (s.h)
t[“new_data”]=”sth new”;
t[“offset”]=12; --optional
t[“size”]=20; --optional
t[“scope”]=”first” -- or “all”
ct = HTTP:payload(t); --returns number of occurrences replaced

set_event Sets a request or response event. For example:
t={};
t["event"] = "data_res"; --can be req,res,data_req, or data_res
t["operation"] = "disable";
HTTP:set_event(t)

set_auto Sets an automatic request or response event. For example:
t={};
t["event"] = "data_res"; --can be req, res, data_req, or data_res
t["operation"] = "disable";
HTTP:set_auto(t)

lookup_tbl Input a hash value to look up the persistence session table and dispatches it in ADC if the hash
value matches the one in the persistence table.
t[“hash_value”] = “hash”

persist HTTP:persist() : (operate in PERSISTENCE and POST_PERSIST)
1. Operation #1. Save the entry to stick table:

Input:
t[“operation”] = “save_tbl”
t[“hash_value”] = “hash”
t[“srv_name”]= “srv name”
Output:
true: success, false: failed

2. Operation #2. Read the tbl entry:
Input:
t[“operation”] = “read_tbl”
t[“hash_value”] = “hash”
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Output:
server name of the entry, or false if no entry found

3. Operation #3. Dump the tbl entry:
Input
t[“operation”] = “dump_tbl”
t[“index”] = 50
t[“count”] = 1000
Output:
A table include hash and server name

4. Operation #4. Get the list o freal server and status:
Input
t[“operation”] = “get_valid_server”
Output
Return the table of usable real server and server state(enable, disable, maintain, backup)

5. Operation #5 Calculate the real server from hash:
Input
t[“operation”] = “cal_server_from_hash”
t[“hash_value”] = “hash”
Output
Return the real server name according to the hash value using our algorithm or False if
failed.

6. Operation #6. Get the real server currently assigned to this session:
Input
t[“operation”] = “get_current_assigned_server”
Output
Return the real server name which is assigned to current session or False if no server is
assigned right now.

Load Balance

routing(content_
route)

Selects a content route. For example:

LB:routing("content2")

TCP

reject() Allow you to reject a TCP connection from a client. Can be used in TCP_ACCEPTED event. For
example:
when TCP_ACCEPTED {       
--Check if the st is true or false
if st then
TCP:reject();
end }
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set_snat_ip(str) Allows user to set the backend TCP connection's source address and port. For example:
when TCP_ACCEPTED {       
addr_group = "172.24.172.60/32"
client_ip = IP:client_addr()
matched = cmp_addr(client_ip, addr_group)
if matched then
if TCP:set_snat_ip("10.106.3.124") then
debug("set SNAT ip to 10.106.3.124\n");
end
end }

clear_snat_ip() Allows you to clear whatever customized ip you ever set using set_snat_ip(). For example:
when TCP_ACCEPTED {       
if TCP:clear_snat_ip() then
debug("Clear SNAT IP !\n");
end }

sockopt(t) Allows user to customize the send buffer and receive buffer size. For example:
when VS_LISTENER_BIND { 
local t = {};
t["op"] = "get";
t["message"] = "snd_buf" --"snd_buf" or "rcv_buf"
if TCP:sockopt(t) then
debug("tcp send buffer is %d\n", tcp_snd_buf);
else
debug("get tcp send buffer failed\n");
end }

SSL

version() Allows you to GET the SSL version, can be used in CLIENTSSL_HANDSHAKE / SERVERSSL_
HANDSHAKE / CLIENTSSL_RENEGOTIATE / SERVERSSL_RENEGOTIATE event. For
example:
ver=SSL:version();

cipher() Allows you to GET the SSL cipher, can be used in CLIENTSSL_HANDSHAKE / SERVERSSL_
HANDSHAKE / CLIENTSSL_RENEGOTIATE / SERVERSSL_RENEGOTIATE event. For
example:
ci=SSL:cipher();

alg_keysize() Allows you to GET the SSL key size, can be used in CLIENTSSL_HANDSHAKE /
SERVERSSL_HANDSHAKE / CLIENTSSL_RENEGOTIATE / SERVERSSL_RENEGOTIATE
event. For example:
alg_keysize=SSL:alg_keysize()
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npn() Allows you to GET the SSL NPN extension, can be used in CLIENTSSL_HANDSHAKE /
SERVERSSL_HANDSHAKE / CLIENTSSL_RENEGOTIATE / SERVERSSL_RENEGOTIATE
event. For example:
npn=SSL:npn();

alpn Allows you to GET the SSL ALPN extension, can be used in CLIENTSSL_HANDSHAKE /
SERVERSSL_HANDSHAKE / CLIENTSSL_RENEGOTIATE / SERVERSSL_RENEGOTIATE
event. For example:
alpn=SSL:alpn();

sni() Allows you to GET the SSL SNI, can be used in CLIENTSSL_HANDSHAKE / SERVERSSL_
HANDSHAKE / CLIENTSSL_RENEGOTIATE / SERVERSSL_RENEGOTIATE event. For
example:
sni=SSL:sni();

client_cert() Returns the client certificate status, can be used in CLIENTSSL_HANDSHAKE / SERVERSSL_
HANDSHAKE / CLIENTSSL_RENEGOTIATE / SERVERSSL_RENEGOTIATE event. For
example:
client_cert=SSL:client_cert()

session(t) Allows you to GET SSL session id / Reused / Remove from cache, can be used in CLIENTSSL_
HANDSHAKE / SERVERSSL_HANDSHAKE / CLIENTSSL_RENEGOTIATE / SERVERSSL_
RENEGOTIATE event. For example:
t={}
t["operation"]="get_id"--or "remove" "reused"
sess_id=SSL:session(t);
if sess_id then
sess_id=to_HEX(sess_id)
debug("client sess id %s\n", sess_id);
else
sess_id="FALSE"
end

cert(t) Allows you to GET the cert info between local or remote, can be used in CLIENTSSL_
HANDSHAKE / SERVERSSL_HANDSHAKE / CLIENTSSL_RENEGOTIATE / SERVERSSL_
RENEGOTIATE event. For example:
t={} t["direction"]="remote";--or "local"
t["operation"]="count";-- or "index", or "issuer"
cert=SSL:cert(t)
if cert then
debug("has %s certs\n", cert)
else
debug("no cert\n")
end

FortiADC Handbook 861
Fortinet Technologies Inc.



Syntax Usage and Example

peer_cert(str) Returns the peer certificate, can be used in CLIENTSSL_HANDSHAKE / SERVERSSL_
HANDSHAKE / CLIENTSSL_RENEGOTIATE / SERVERSSL_RENEGOTIATE event. For
example
cder=SSL:peer_cert("der");--for remote leaf certificate, the input parameter can be "info" or "der"
or "pem".
if cder then
hash=sha1_hex_str(cder);
debug("whole cert sha1 hash is %s\n", hash);
end

IP

client_addr() Returns the client IP address, can be used in all events except VS_LISTENER_BIND. For
example:
cip=IP:client_addr()

local_addr() Returns the local IP address, can be used in all events except VS_LISTENER_BIND /
SERVER_BEFORE_CONNECT. For example:
lip=IP:local_addr()

remote_addr() Returns the remote IP address, can be used in all events except VS_LISTENER_BIND /
SERVER_BEFORE_CONNECT. For example:
rip=IP:remote_addr()

client_port() Returns the client IP port number, can be used in all events except VS_LISTENER_BIND. For
example:
cp=IP:client_port()

local_port() Returns the local port number, can be used in all events except VS_LISTENER_BIND /
SERVER_BEFORE_CONNECT. For example:
lp=IP:local_port()

remote_port() Returns the remote port number can be used in all events except VS_LISTENER_BIND /
SERVER_BEFORE_CONNECT. For example:
rp=IP:remote_port()

client_ip_ver() Returns the client IP version, can be used in all events except VS_LISTENER_BIND. For
example:
cipv=IP:client_ip_ver();

server_addr() Returns the server IP address, can be used in server-side events. For example:
sip=IP:server_addr()

server_port() Returns the server port number, can be used in server-side events. For example:
sp=IP:server_port()

server_ip_ver() Returns the server IP version, can be used in server-side events. For example:
sipv=IP:server_ip_ver();
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Management

get_session_id() Returns the session id, can be used in all events except VS_LISTENER_BIND. For example:
sid=MGM:get_session_id()
debug("sess id %s\n", sid);

rand_id() Returns the rand id, can be used in all events except VS_LISTENER_BIND. For example:
sid=MGM:get_session_id()
debug("rand id %s\n", rid);

set_event(t) Allow user to disable/enable rest of theevents from executing by disabling this event. For
example:
t={};
t["event"]="req"; -- can be "req", "res", "data_req", "data_res", "ssl_client", "ssl_server", "tcp_
accept", "tcp_close", "ssl_renego_client", "ssl_renego_server", "server_connected", "server_
close", "server_before_connect", "vs_listener_bind", "auth_result", "cookie_bake"
t["operation"]="disable"; -- can be "enable", and "disable"
MGM:set_event(t);
debug("disable rest of the HTTP_REQUEST events\n");

set_auto(t) Allow user to enable/disable automatic re-enabling. For example:
t={};
t["event"]="req"; -- can be "req", "res", "data_req", "data_res", "ssl_server", "ssl_renego_server",
"server_connected", "server_close", "server_before_connect" t["operation"]="disable"; -- can be
"enable", and "disable"
MGM:set_auto(t);
debug("disable automatic re-enabling of the HTTP_REQUEST events\n");

Auth

get_baked_cookie
()

Allows you to retrieve the baked cookie, For example:
when COOKIE_BAKE {        cookie = AUTH:get_baked_cookie() debug("baked cookie %s\n",
cookie); }

set_baked_cookie
(cookie)

Allows you to customize cookie attributes the baked cookie, For example:
when COOKIE_BAKE {        cookie = AUTH:get_baked_cookie() --add new attribute HttpOnly new_
cookie = cookie.."; HttpOnly"; AUTH:set_baked_cookie(new_cookie); }

on_off() Returns the authentication is required or not, For example:
on_off = AUTH:on_off();

success() Returns the authentication is successful or not, For example:
succ = AUTH:success();

form_based() Returns the authentication is HTTP form based or not , For example:
fm = AUTH:form_based()

user() Returns the authentication of the user name , For
example:user = AUTH:user()
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pass() Returns the authentication of the password , For
example:pass = AUTH:pass()

usergroup() Returns the authentication of the user group , For
example:userg = AUTH:usergroup()

realm() Returns the authentication of the realm , For
example:userg = AUTH:usergroup()

host() Returns the authentication of the host , For
example:host = AUTH:host()

Proxy

set_auth_key(str) Allows user to customize the crypto key FADC used for encrypt/decrypt authentication cookie,
For example:
when VS_LISTENER_BIND {
AUTH_KEY = ""0123456789ABCDEF0123456789ABCDEF""
if PROXY:set_auth_key(AUTH_KEY) then
debug(""set auth key succeed\n"");
end
}

Init_stick_tbl_
timeout()

Allow user to set the timeout of stick table for persistence.
when RULE_INIT{
env={}
PROXY:init_stick_tbl_timeout(500)
}

WAF

enable() Enables the current session's WAF scan function.
For example:
whenWAF_REQUEST_ATTACK_DETECTED {
local s = WAF:status()
debug("test WAF_REQUEST_ATTACK_DETECTED, status %s\n", s)
WAF:enable()
}

disable() Disables the current session's WAF scan function.
For example:
whenWAF_REQUEST_ATTACK_DETECTED {
local s = WAF:status()
debug("test WAF_REQUEST_ATTACK_DETECTED, status %s\n", s)
WAF:disable()
}
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status() Returns a status string to specify the current status of WAF detection. The status may be
"enable" or "disable".
For example:
whenWAF_REQUEST_ATTACK_DETECTED {
local s = WAF:status()
debug("test WAF_REQUEST_ATTACK_DETECTED, status %s\n", s)
WAF:disable()
}

action() Returns the current session's WAF action. This can only be called in an ATTACK_DETECTED
event.
The return value is a string, which may include the following values:
l "pass"
l "deny"
l "block"
l "redirect"
l "captcha"

For example:
whenWAF_REQUEST_ATTACK_DETECTED {
local s = WAF:action()
debug("test WAF_REQUEST_ATTACK_DETECTED, action %s\n", s)
WAF:override_action("deny", 501);
}

override_action
(str)

Overrides the current stage's detected action to the specified.
For example:
whenWAF_REQUEST_ATTACK_DETECTED {
local s = WAF:action()
debug("test WAF_REQUEST_ATTACK_DETECTED, action %s\n", s)
WAF:override_action("deny", 501);
}

violations() Returns a table that includes all the violations detected by the current WAF stage as string
values.
For example:
whenWAF_REQUEST_ATTACK_DETECTED {
debug("test WAF_REQUEST_ATTACK_DETECTED\n")
local vl = WAF:violations();
for k, v in pairs(vl) do
debug("%d. Violation: signature %d, severity %s, information %s, action %s, sub-category %s,
owasp-top10 %s.\n", k, v["signature"], v["severity"], v["information"], v["action"], v["sub-
category"], v["owasp-top10"]);
}
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raise_violation(str) Raises a violation immediately. This function will send a log by the input arguments. If the
signature ID is already raised by the WAF then this command will override it.
This function will prevent the WAF action from executing as specified. To override the WAF
action, call WAF:override_action(str).
For example:
whenWAF_REQUEST_ATTACK_DETECTED {
debug("test WAF_REQUEST_ATTACK_DETECTED\n")
local vl = WAF:violations();
for k, v in pairs(vl) do
debug("%d. Violation: signature %d.\n", k, v["signature"]);
WAF:abandon_violation(v["signature"]);
end
v = {};
v["signature-id"] = 100010000;
v["severity"] = "high";
v["information"] = "waf raise violation test";
v["action"] = "deny";
v["sub-category"] = "waf_url_protect";
v["owasp-top10"] = "test-owasp10";
WAF:raise_violation(v);
}

abandon_all() Abandons all of the results detected by the WAFmodule, including all of the violations, and
resets the action to "pass".
This command can only be called in the ATTACK_DETECTED event.
For example:
whenWAF_REQUEST_ATTACK_DETECTED {
debug("test WAF_REQUEST_ATTACK_DETECTED\n")
WAF:abandon_all()
}

block(int) Blocks the current session's client IP. Specify the period of the block in seconds as an integer
(Range: 1-2147483647, default = 3600).
For example:
whenWAF_REQUEST_ATTACK_DETECTED {
debug("test WAF_REQUEST_ATTACK_DETECTED\n")
WAF:block(3600)
}

unblock() Unblocks the client IP of the current session if it is already blocked.
For example:
whenWAF_REQUEST_BEFORE_SCAN {
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local s = WAF:status()
debug("test WAF_REQUEST_BEFORE_SCAN, status %s\n", s)
WAF:unblock()
}

Predefined scripts

Predefined scripts on page 867 provides the syntax, usage, and examples of the predefined commands that are useful
for writing scripts.

Predefined script Usage

COMPARE_IP_ADDR_2_
ADDR_GROUP_DEMO

Compares an IP address to an address group to determine if the IP address is included
in the specified IP group. For example ,192.168.1.2 is included in 192.168.1.0/24.
Note: Do NOT use this script "as is". Instead, copy it and customize the IP address and
the IP address group.

CONTENT_ROUTING_
by_URI

Routes to a pool member based on URI string matches. You should not use this script
as is. Instead, copy it and customize the URI string matches and pool member names.

CUSTOMIZE_AUTH_KEY Demonstrate how to customize the crypto key for authentication cookie.

HTTP_DATA_FETCH_
SET_DEMO

Collects data in HTTP request body or HTTP response body. In HTTP_REQUEST or
HTTP_RESPONSE, you could collect specified size data with “size” in collect
().In HTTP_DATA_REQUEST or HTTP_DATA_RESPONSE. You could print the data
use “content”, calculate data length with “size”, and rewrite the data with “set”.
Note: Do NOT use this script "as is". Instead, copy it and manipulate the collected data.

REDIRECTION_by_
USER_AGENT

Redirects requests based on User Agent (for example, a redirect to the mobile version of
a site). You should not use this script as is. Instead, copy it and customize the User
Agent and URL values.

TWO_STEP_
VERIFICATION_2_SAME

Demonstrate how to perform 2-Step Verification for the second authentication group
using the same token group.

OPTIONAL_CLIENT_
AUTHENTICATION

Performs optional client authentication.
Note: Before using this script, you must have the following four parameters configured in
the client-ssl-profile:
l client-certificate-verify—Set to the verify you'd like to use to verify the client
certificate.

l client-certificate-verify-option—Set to optional
l ssl-session-cache-flag—Disable.
l use-tls-tickets—Disable.

PERSIST_COMMANDS Lists the persist event and commands

Predefined scripts
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TWO_STEP_
VERIFICATION_2_NEW

Demonstrate how to perform 2-Step Verification using FortiToken for the second
authentication group.

AUTH_COOKIE_BAKE Allows you to retrieve the baked cookie and edit the cookie content.

HTTP_2_HTTPS_
REDIRECTION_FULL_
URL

Redirects requests to the specified HTTPS URL.
Note: This script can be used directly, without making any change.

REDIRECTION_by_
STATUS_CODE

Redirects requests based on the status code of server HTTP response (for example, a
redirect to the mobile version of a site). Do NOT use this script "as is". Instead, copy it
and customize the condition in the server HTTP response status code and the URL
values.

TWO_STEP_
VERIFICATION_2_NEW

Demonstrate how to perform 2-Step Verification using FortiToken for the second
authentication group.

TWO_STEP_
VERIFICATION_2_SAME

Demonstrate how to perform 2-Step Verification for the second authentication group
using the same token group.

TWO_STEP_
VERIFICATION_
CHANGE_KEY

Demonstrate how to change the AES key and its size for stored token group.

URL_UTILITY_
COMMANDS

Demonstrate how to use those url tools to encode/decode/parser/compare.

USE_REQUEST_
HEADERS_in_OTHER_
EVENTS

Stores a request header value in an event and uses it in other events. For example, you
can store a URL in a request event, and use it in a response event.
Note: Do NOT use this script "as is". Instead, copy it and customize the content you want
to store, use collect() in HTTP_REQUEST to trigger HTTP_DATA_REQUEST,or use
collect() in HTTP_ RESPONSE to trigger HTTP_DATA_ RESPONSE.

UTILITY_FUNCTIONS_
DEMO

Demonstrates how to use the basic string operations and random number/alphabet,
time, MD5, SHA1, SHA2, BASE64, BASE32, table to string conversion, network to host
conversion utility function

Commands

AUTH_EVENTS_n_
COMMANDS

Lists the auth event and commands

COOKIE_COMMANDS Lists the two cookie commands and shows how to use them.

IP_COMMANDS Lists the IP commands and shows how to use them.

MANAGEMENT_
COMMANDS

Lists the management commands and shows how to use them.

PERSIST_COMMANDS Lists the persist event and commands

RAM_CACHING_
COMMANDS

Lists the RAM caching event and commands
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SSL_EVENTS_n_
COMMANDS

Lists the SSL events and commands.

TCP_EVENTS_n_
COMMANDS

Lists the TCP events and commands.

Predefined script Usage

AES_DIGEST_SIGN_2F_
COMMANDS

Demonstrate how to use AES to encryption/decryption data and some tools to generate
the digest.

AUTH_COOKIE_BAKE Allows you to retrieve the baked cookie and edit the cookie content.

AUTH_EVENTS_n_
COMMANDS

Used to get the information from authentication process.

CLASS_SEARCH_n_
MATCH

Demonstrates how to use the class_match and class_search utility function.

COMPARE_IP_ADDR_2_
ADDR_GROUP_DEMO

Compares an IP address to an address group to determine if the IP address is included
in the specified IP group. For example ,192.168.1.2 is included in 192.168.1.0/24.
Note: Do NOT use this script "as is". Instead, copy it and customize the IP address and
the IP address group.

CONTENT_ROUTING_
by_URI

Routes to a pool member based on URI string matches. You should not use this script
as is. Instead, copy it and customize the URI string matches and pool member names.

CONTENT_ROUTING_
by_X_FORWARDED_
FOR

Routes to a pool member based on IP address in the X-Forwarded-For header. You
should not use this script as is. Instead, copy it and customize the X-Fowarded-For
header values and pool member names.

COOKIE_COMMANDS Demonstrate the cookie command to get the whole cookie in a table and how to
remove/insert/set the cookie attribute.

COOKIE_COMMANDS_
USAGE

Demonstrate the sub-function to handle the cookie attribute "SameSite" and others.

COOKIE_CRYPTO_
COMMANDS

Used to perform cookie encryption/decryption on behalf of the real server.

CUSTOMIZE_AUTH_KEY Demonstrate how to customize the crypto key for authentication cookie.

GENERAL_REDIRECT_
DEMO

Redirects requests to a URL with user-defined code and cookie.
Note: Do NOT use this script "as is". Instead, copy and customize the code, URL, and
cookie.

Control structures

Lua control structures on page 870 lists the Lua control structures.
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Type Structure

if then else if condition1 then
…
elseif condition2 then
… break
else
… go to location1
end

::location1::

for --fetch all values of table 't'
for k, v in pairs(t) do
…
end

Lua control structures

Operators

Lua operators on page 870 lists the FortiADC operators.

FortiADC
Operator

Operator
sub-type

Description

- + Arithmetic Unary minus, unary
plus.

~ Bitwise Bitwise NOT.

not Logical Performs a logical
"not" on a value.

* / % Arithmetic Multiple, divide,
remainder.

// Floor division.

^ Exponentiation.

+ - Arithmetic Add and subtract.

<< >> Bitwise Left and right shift.

< > <= >= Relational Boolean less, greater,
less than or equal, and
greater than or equal.

== != Relational Boolean equal and not
equal.

Lua operators
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FortiADC
Operator

Operator
sub-type

Description

& Bitwise Bitwise AND.

~ Bitwise Bitwise exclusive OR.

| Bitwise Bitwise OR.

and Logical Performs a logical
"and" comparison
between two values.

or Logical Performs a logical "or"
comparison between
two values.

starts_with
(a,b)

String Tests to see if String a
starts with String b.
Returns true or false.

ends_with
(a,b)

String Tests to see if String a
ends with String b.
Returns true or false.

contains String Checks to see
whether String a
contains String b.
Returns true or false.

match String Searches for a
specified string.

.. The string
concatenation
operator in Lua is
denoted by two dots
('..'). If both operands
are strings or
numbers, then they
are converted to a
string. It's the same as
__concat.

String library

The FortiADC OS supports only the Lua string library. All other libraries are disabled. The string library includes the
following string-manipulation functions:

l string.byte(s, i)

l string.char(i1,i2…)

l string.dump(function)

l string.find(s, pattern)

l string.format
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l string.gmatch

l string.gsub

l string.len

l string.lower

l string.match

l string.rep

l string.reverse

l string.sub

l string.upper

l string.starts_with

l string.ends_with

For example: uri:starts_with (b), uri:ends_with (b)

Note:

l If you want to do regular expression match, you can use string.match with Lua patterns.
l All relational operators >, <, >=, <=, ~=, == apply to strings. Especially, == can be used to test if one string equals to
another string.

l string.find can be used to test whether one string contains another string.

For a tutorial on scripting with the Lua string library, see http://lua-users.org/wiki/StringLibraryTutorial.

Functions

FortiADC supports the basic commands. If the user want more functions, the user can implement functions to define
more with the basic commands.

Syntax

function function_name(parameter)
…
end

Examples: cookie command usage

FortiADC supports two cookie commands: cookie_list() and cookie(t) with t as a table input

when HTTP_REQUEST {
ret=HTTP:cookie_list()
for k,v in pairs(ret) do
debug("-----cookie name %s, value %s-----\n", k,v);
end

GET value of cookie "test"

value = get_cookie_value(HTTP, "test") --the return value is either boolean false or its
value if exists.

debug("-----get cookie value return %s-----\n", value);

GET attribute path of cookie "test", can be used to get other attributes too

case_flag = 0; -- or 1
ret = get_cookie_attribute(HTTP, "test", "path", case_flag);--return value is either boolean

false or its value if exists
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debug("-----get cookie path return %s-----\n", ret);

SET value of cookie "test"

ret = set_cookie_value(HTTP, "test", "newvalue")--return value is boolean
debug("-----set cookie value return %s-----\n", ret);

REMOVE a whole cookie

ret = remove_whole_cookie(HTTP, "test")--return value is boolean
debug("-----remove cookie return %s-----\n", ret);

INSERT a new cookie.

You need to make sure the cookie was not first created by the GET command. Otherwise, by
design FortiADC shall use SET command to change its value or attributes.

In HTTP REQUEST, use $Path, $Domain, $Port, $Version; in HTTP RESPONSE, use Path, Domain, Port, Version, etc.

ret = insert_cookie(HTTP, "test", "abc.d; $Path=/; $Domain=www.example.com, ")--return value
is boolean

debug("-----insert cookie return %s-----\n", ret);
}
function get_cookie_value(HTTP, cookiename)
local t={};
t["name"]=cookiename
t["parameter"]="value";
t["action"]="get"
return HTTP:cookie(t)
end

attrname can be path, domain, expires, secure, maxage, max-age, httponly, version, port.

case_flag: If you use zero, FortiADC looks for default attributes named Path, Domain, Expires, Secure, Max-Age,
HttpOnly, Version, Port. By setting this to 1, you can specify the case sensitive attribute name to look for in t["parameter"]
which could be PAth, DOmaIn, MAX-AGE, EXpires, secuRE, HTTPONLy, VerSion, Port, etc.

function get_cookie_attribute(HTTP, cookiename, attrname, case_flag)
local t={};
t["name"]=cookiename
t["parameter"]=attrname;
t["case_sensitive"] = case_flag;
t["action"]="get"
return HTTP:cookie(t)
end
function set_cookie_value(HTTP, cookiename, newvalue)
local t={};
t["name"]=cookiename
t["value"]=newvalue
t["parameter"]="value";
t["action"]="set"
return HTTP:cookie(t)
end
function remove_whole_cookie(HTTP, cookiename)
local t={};
t["name"]=cookiename
t["parameter"]="cookie";
t["action"]="remove"
return HTTP:cookie(t)

FortiADC Handbook 873
Fortinet Technologies Inc.



end
function insert_cookie(HTTP, cookiename, value)
local t={};
t["name"]=cookiename
t["value"]=value;
t["parameter"]="cookie";
t["action"]="insert"
return HTTP:cookie(t)
end

Special characters

This section discusses the use of special characters in FortiADC scripting.

Log and debug

FortiADC supports the special characters as listed in Special characters and ways to handle them on page 874 in log
and debug scripts.

Character Name

~ Tilde

! Exclamation

@ At sign

# Number sign (hash)

$ Dollar sign

^ Caret

& Ampersand

* Asterisk

( Left parenthesis

) Right parenthesis

_ Underscore

+ Plus

{ Left brace

} Right brace

[ Left bracket

] Right bracket

. Full stop

? Question mark

Special characters and ways to handle them

When written in a string, these characters look like this (between double quotes: "~!@#$^&*()_+{}[].?"
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Note: The back slash (\) and the percent (%) signs are handled in a unique way in log and debug scripts. To print out %,
you must use %%; to print out \, you must use \\.

HTTP data body commands

HTTP data body commands, such as find, remove, and replacesupport regular expression, which treats special
characters such as (between double quote) "$^?*+.|()[]{}\" in a special way. You MUST escape these characters
to demolish their special meaning. Special characters in HTTP data body commands on page 875 shows how to escape
these special characters.

To print out ... You MUST use ...

$ \\$

^ \\^

? \\?

* \\*

+ \\+

. \\.

| \\|

\ \\\\

(and) \\(and \\)

{and} \\{and \\}

[and] \\[and \\]

Special characters in HTTP data body commands

Note:

l { and } are special because the script syntax looks for the matching { and }. So be sure to use them in pairs.
l The find, remove, and replace commands use special expression. Particularly, p.ge will match the whole
word page and remove and replace the whole word page. However, p*ge will remove and replace only the ge part.

l The HTTP data body set command does not support regular expression. Only \ is special in the setcommand, and
you must use \\ for it.

Examples

This section provides example scripts for common use cases. It includes the following examples:

l Select content routes based on URI string matches. See Select content routes based on URI string matches on
page 876

l Rewrite the HTTP request host header and path. See Rewrite the HTTP request host header and path on page 877
l Rewrite the HTTP response Location header. See Rewrite the HTTP response Location header on page 877
l Redirect HTTP to HTTPS using Lua string substitution. See Redirect HTTP to HTTPS using Lua string substitution
on page 878

l Redirect mobile users to the mobile version of a website. See Redirect mobile users to the mobile version of a
website on page 878
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l Insert randommessage ID into a header. See Insert randommessage ID into a header on page 878
l General HTTP redirect. See General HTTP redirect on page 879
l Use request headers in other events. See Use request headers in other events on page 879
l Compare IP address to address group. See Compare IP address to address group on page 880
l Redirect HTTP to HTTPS. See Redirect HTTP to HTTPS on page 880
l Rewrite HTTP to HTTPS in location. See Rewrite HTTP to HTTPS in location on page 880
l Rewrite HTTP to HTTPS in referer. See Rewrite HTTP to HTTPS in referer on page 880
l Rewrite HTTPS to HTTP in location. See Rewrite HTTPS to HTTP in location on page 881
l Rewrite HTTPS to HTTP in referer. See Rewrite HTTPS to HTTP in referer on page 881
l Fetch data from HTTP events. See Fetch data from HTTP events on page 881
l Replace HTTP body data. See Replace HTTP body data on page 882
l Persist and post_persist. See Persist on page 883 and Post_persist on page 884
l Run multiple scripts. See Run multiple scripts on page 885
l Prioritize scripts. See Prioritize scripts on page 885

Tip: The examples show debug strings. Debug strings can be written to the console when the
event is triggered. This is helpful when you are testing your scripts.

To enable debug strings to be written to the console, use the following CLI commands:
diagnose debug enable
diagnose debug module httproxy scripting

Select content routes based on URI string matches

The content routing feature has rules that match HTTP requests to content routes based on a Boolean AND combination
of match conditions. If you want to select routes based on a Boolean OR, you can configure multiple rules. The content
routing rules table is consulted from top to bottom until one matches.

In some cases, it might be simpler to get the results you want using a script. In the following example, each rule selects
content routes based on ORmatch conditions.

Content routing example
when RULE_INIT {
debug("get header init 1\n")
}

when HTTP_REQUEST{
uri = HTTP:uri_get()
if uri:find("sports") or uri:find("news") or uri:find("government") then
LB:routing("sp2")
debug("uri %s matches sports|news|government\n", uri);
elseif uri:find("finance") or uri:find("technology") or uri:find("shopping") then
LB:routing("sp3")
debug("uri %s matches finance|technology|shopping\n", uri);
elseif uri:find("game") or uri:find("bbs") or uri:find("testing") then
LB:routing("sp4")
debug("uri %s matches game|bbs|testing\n", uri);
elseif uri:find("billing") or uri:find("travel") or uri:find("weibo") then
LB:routing("sp5")
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debug("uri %s matches billing|travel|weibo\n", uri);
else
debug("no matches for uri: %s \n", uri);
end
}

To use a script for content routing:

1. Create the content route configuration objects. In the example above, sp2, sp3, sp4, and sp4 are the names of the
content route configuration objects. You do not need to configure matching conditions for the content routes,
however, because the script does the content matching.

2. Create a script that matches content to the content route configuration objects, as shown above. Create a
configuration object for the script.

3. In the virtual server configuration:
a. Enable content routing and select the content route configuration objects.
b. Select the script.

Rewrite the HTTP request host header and path

You can use the content rewriting feature to rewrite the HTTP request Host header or the HTTP request URL. If you
need more granular capabilities, you can use scripts. The following example rewrites the HTTP Host header and path.

Rewrite the HTTP Host header and path in a HTTP request
when RULE_INIT {
debug("rewrite the HTTP Host header and path in a HTTP request \n")
}

when HTTP_REQUEST{
host = HTTP:header_get_value("Host")
path = HTTP:path_get()
if host:lower():find("myold.hostname.com") then
debug("found myold.hostname.com in Host %s \n", host)
HTTP:header_replace("Host", "mynew.hostname.com")
HTTP:path_set("/other.html")
end
}

Note: You might find it useful to use a combination of string manipulation functions. For example, this script uses lower()
to convert the Host strings to lowercase in combination with find(), which searches for the Host header for a match:
host:lower():find("myold.hostname.com").

Rewrite the HTTP response Location header

You can use the content rewriting feature to rewrite the HTTP response Location header. If you are more comfortable
using Lua string substitution, you can write a script to get the results you want. The following example rewrites the HTTP
response Location header.

Rewrite the HTTP body in the response
when RULE_INIT {
debug("rewrite the HTTP response replacing myold.hostname.com with mynew.hostname.com \n")
}
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when HTTP_RESPONSE{
location = HTTP:header_get_value("Location")
if location:lower():find("myold.hostname.com") then
debug("found myold.hostname.com in Location %s \n", location)
HTTP:header_replace("Location", "mynew.hostname.com")
end
}

Redirect HTTP to HTTPS using Lua string substitution

You can use the content rewriting feature to redirect an HTTP request to an HTTPS URL that has the same host and
request URL using a PCRE regular expression. If you are more comfortable using Lua string substitution, you can write a
script to get the results you want. The following example redirects users to the HTTPS location.

Redirect HTTP to HTTPS
when RULE_INIT {
debug("http to https redirect\n")
}

when HTTP_REQUEST{
host = HTTP:header_get_value("Host")
path = HTTP:path_get()
HTTP:redirect("https://%s%s",host,path);
}

Redirect mobile users to the mobile version of a website

The content rewriting feature does not support matching the User-Agent header. You can write a script that detects
User-Agent headers that identify mobile device users and redirect them to the mobile version of a website.

Redirect mobile users to the mobile version of a website by parsing the User-Agent header
when RULE_INIT {
debug("detect User-Agent and go to mobile site\n")
}

when HTTP_REQUEST{
path = HTTP:path_get()
debug("path=%s\n",path)
agent = HTTP:header_get_value("User-Agent")
if agent:lower():find("iphone") or agent:lower():find("ipad") then
debug("found iphone or ipad in User-Agent %s \n", agent)
HTTP:redirect("https://m.mymobilesite.com%s",path)
end
}

Insert random message ID into a header

FortiADC offers the feature to insert messages and message IDs into HTTP request headers.

when HTTP_REQUEST{
ID=HTTP:rand_id()-- a 32-long string of HEX symbols
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HTTP:header_insert("Message-ID",ID)
}

General HTTP redirect

You can redirect both HTTP requests and HTTP responses to a given location.

GENERAL_REDIRECT_DEMO:
when HTTP_REQUEST{
--can be used in both HTTP_REQUEST and HTTP_RESPONSE
--code and cookie are optional, code can be 301, 302, 303, 307, 308, if missed, 302 is used
t={}
t["code"] = 302;
t["url"] = "www.example.com"
t["cookie"] = "name=value; Expires=Wed, 09 Jun 2021 10:18:14 GMT"
HTTP:redirect_t(t);
}

Use request headers in other events

You can get stored request headers by using the session ID.

when RULE_INIT{
--initialize the global so-called "environment" variable
env={}
}
when HTTP_REQUEST{
sess_id = HTTP:get_session_id()
req={}
--store whatever you want to req, take url as an example
req["url"] = HTTP_uri_get()
env[id] = req
}
when HTTP_RESPONSE{
sess_id = HTTP:get_session_id()
req = env[id]
--now you can access the stored request headers
debug("my stored request url is %s\n", req["url"]);
}
when HTTP_DATA_REQUEST{
sess_id = HTTP:get_session_id()
req = env[id]
--now you can access the stored request headers
debug("my stored request url is %s\n", req["url"]);
}
when HTTP_DATA_RESPONSE{
sess_id = HTTP:get_session_id()
req = env[id]
--now you can access the stored request headers
debug("my stored request url is %s\n", req["url"]);
}
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Compare IP address to address group

You can compare IP addresses to an internal list of IP addresses. The script will return different results signifying
whether the IP is in the list.

when RULE_INIT{
--initialize the address group here
--for IPv4 address, mask can be a number between 0 to 32 or a dotted format
--support both IPv4 and IPv6, for IPv6, the mask is a number between 0 and 128
addr_group = "192.168.1.0/24"
addr_group = addr_group..",172.30.1.0/255.255.0.0"
addr_group = addr_group..",::ffff:172.40.1.0/120"
}
when HTTP_REQUEST{
client_ip = HTTP:client_addr()
matched = cmp_addr(client_ip, addr_group)
if matched then
debug("client ip found in address group\n");
else
debug("client ip not in address group\n");
end
}

Redirect HTTP to HTTPS

You can redirect an HTTP request from an HTTP location to an HTTPS location.

when HTTP_REQUEST{
Host = HTTP:header_get_value("host")
Url = HTTP:uri_get()
HTTP:redirect("https://%s%s", Host, Url)
}

Rewrite HTTP to HTTPS in location

You can rewrite HTTP request headers to replace all HTTP addresses with HTTPS addresses in the redirect location.

when HTTP_RESPONSE{
loc = HTTP:header_get_value("Location")
if loc then
newloc = string.gsub(loc, "http", "https") --replace all http by https in the redirect

location
HTTP:header_replace("Location", newloc);
end
}

Rewrite HTTP to HTTPS in referer

You can rewrite HTTP request headers to replace all HTTP addresses with HTTPS addresses in the redirect referer.

when HTTP_RESPONSE{
ref = HTTP:header_get_value("Referer")
if ref then
newref = string.gsub(ref, "http", "https") --replace all http by https in the referer header
HTTP:header_replace("Referer", newref);
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end
}

Rewrite HTTPS to HTTP in location

You can rewrite HTTP request headers to replace all HTTPS addresses with HTTP addresses in the redirect location.

when HTTP_RESPONSE{
loc = HTTP:header_get_value("Location")
if loc then
newloc = string.gsub(loc, "https", "http") --replace all https by http in the redirect

location
HTTP:header_replace("Location", newloc);
end
}

Rewrite HTTPS to HTTP in referer

You can rewrite HTTP request headers to replace all HTTPS addresses with HTTP addresses in the redirect referer.

when HTTP_RESPONSE{
ref = HTTP:header_get_value("Referer")
if ref then
newref = string.gsub(ref, "https", "http") --replace all https by http in the referer header
HTTP:header_replace("Referer", newref);
end
}

Fetch data from HTTP events

You can collect data from both HTTP request and HTTP response events. You can then manipulate this data.

when HTTP_REQUEST{
--HTTP:collect command can be used in both HTTP_REQUEST and HTTP_RESPONSE events
--size is optional, otherwise, it will collect up to the full length or when 1.25M is

reached
t={}
t["size"] = 100;
HTTP:collect(t)
}
when HTTP_DATA_REQUEST{
--check the size of the content
t={};
t["operation"]="size";
sz=HTTP:payload(t);
debug("content size: %s\n", sz);
--fetch the collected content
--offset and size are optional
t={};
t["operation"]="content";
t["offset"] = 0;
t["size"] = sz;
ct=HTTP:payload(t);
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debug("content: %s\n", ct);
--do your own manipulation on the collected content
--replace the collected content by your new data
--offset and size are optional
t={};
t["operation"]="set";
t["offset"] = 0;
t["size"] = sz;
t["data"]="NEW DATA to SEND";
ret = HTTP:payload(t);
debug("set ret %s\n", ret);
}

Replace HTTP body data

You can find, remove, and replace data in the body of an HTTP request.

when HTTP_REQUEST{
--HTTP:collect command can be used in both HTTP_REQUEST and HTTP_RESPONSE events
--size is optional, otherwise, it will collect up to the full length or when 1.25M is

reached
t={}
t["size"] = 100;
HTTP:collect(t)
}
when HTTP_DATA_REQUEST{
--check the size of the content
t={};
t["operation"]="size";
sz=HTTP:payload(t);
debug("content size: %s\n", sz);
--find a string or a regular expression in the buffered data
--offset, size and scope are optional, if scope is missing, "all" is assumed
t={};
t["operation"]="find";
t["offset"] = 0;
t["size"] = sz;
t["scope"] = "all";-- or "first"
t["data"] = "your string or a regular expression to find";
if HTTP:payload(t) then
debug("found %d occurences\n", ret);
else
debug("not found\n");
end
--remove a string or a regular expression in the buffered data
--offset, size and scope are optional, if scope is missing, "all" is assumed
t={};
t["operation"]="remove";
t["offset"] = 0;
t["size"] = sz;
t["scope"] = "all";-- or "first"
t["data"] = "your string or a regular expression to find";
if HTTP:payload(t) then
debug("removed %d occurences\n", ret);
else
debug("not found\n");
end
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--replace a string or a regular expression in the buffered data by a new string
--offset, size and scope are optional, if scope is missing, "all" is assumed
t={};
t["operation"]="replace";
t["offset"] = 0;
t["size"] = sz;
t["scope"] = "all";-- or "first"
t["data"] = "your string or a regular expression to find";
t["new_data"] = "your new data";
if HTTP:payload(t) then
debug("replaced %d occurences\n", ret);
else
debug("not found\n");
end
}

Persist

You can set the entry to the persist table and real server will be assigned after lookup

when RULE_INIT {
env={}
PROXY:init_stick_tbl_timeout(1000)
}
when PERSISTENCE {
debug("PERSIST \n");
t={};
t["operation"] = "get_valid_server";
ret_tbl = HTTP: persist(t);
if(ret_tbl) then
for srv, state in pairs(ret_tbl) do
debug("server %s status %s\n", srv, state);
end
end
t={};
t["operation"] = "save_tbl";
t["hash_value"]= "hash_str";
t["srv_name"]= "rsrv_70";
ret = HTTP: persist(t)
if ret then
debug("save table success\n");
else
debug("save table failed\n");
end
t={};
t["operation"] = "dump_tbl";
t["index"] = 0;
t["count"] = 500;
ret_tbl = HTTP: persist(t)
if(ret_tbl) then
for k, cnt in pairs(ret_tbl) do
debug(" hash %s srv_name %s\n", k, cnt)
end
end
t={};
t["hash_value"]= "hash_str";
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ret = HTTP:lookup_tbl(t);
if ret then
debug("LOOKUP success\n");
else
debug("LOOKUP fail\n");
end
}

Post_persist

You can get the current assigned server in POST_PERSIT and assign real server you like by setting table and lookup in
PERSISTENCE

when RULE_INIT {
env={}
PROXY:init_stick_tbl_timeout(1000)
}
when PERSISTENCE {
debug("PERSIST \n");
t={};
t["hash_value"]= "hash_str";
ret = HTTP:lookup_tbl(t);
if ret then
debug("LOOKUP success\n");
else
debug("LOOKUP fail\n");
end
}
when POST_PERSIST {
debug("POST PERSIST \n");
t={};
t["operation"] = "get_current_assigned_server"
ret_tbl = HTTP: persist(t)
if ret then
debug("assign to %s\n", ret_tbl);
else
debug("get_current_assigned_server failed\n");
end

t={};
t["operation"] = "save_tbl";
t["hash_value"]= "hash_str";
t["srv_name"]= "rsrv_70";
ret = HTTP: persist(t)
if ret then
debug("save table success\n");
else
debug("save table failed\n");
end

}
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Run multiple scripts

You can run multiple scripts in FortiADC. When running multiple scripts, you may set a priority number for each script.
FortiADC will run them in order from lowest priority to highest priority. The default priority is 500. if two scripts have the
same priority number, they will be executed in the order in which they were added.

--script 1:

when HTTP_REQUEST priority 500 {
LB:routing("cr1")
}

--script 2:

when HTTP_RESPONSE priority 500 {
HTTP:close()
}

--script 3:

when HTTP_REQUEST priority 400 {
LB:routing("cr2")
}

--script 4:

when HTTP_RESPONSE priority 600 {
HTTP:close()
}

Prioritize scripts

While running multiple scripts, you can prioritize scripts. Add a priority number to each script when you create it, and
FortiADC will run them in order from lowest priority to highest priority. The default priority is 500.If two scripts have the
same priority number, they will be executed in the order in which they were added.

when RULE_INIT priority 14 {

--This is one of the script to demo the control of multiple scripts

--please change the priority of each event according to your need

debug("INIT in script 1\n");
}
when HTTP_REQUEST priority 12 {
debug("HTTP_REQUEST in script 1\n");

--add your own manipulation here

--you can disable rest of the HTTP_REQUEST events from executing by disabling this event

t={};
t["event"]="req"; -- can be "req", "res", "data_req", and "data_res"
t["operation"]="disable"; -- can be "enable", and "disable"
HTTP:set_event(t);
debug("disable rest of the HTTP_REQUEST events in script 1\n");

--you can also disable other events, say HTTP_RESPONSE, DATA events
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--in the case of keep-alive, all events will be re-enabled automatically even though they are disabled in previous
TRANSACTION using the HTTP:set_event(t) command. To disable this automatic re-enabling behavior, you can call
HTTP:set_auto(t) as below

t={};
t["event"]="req"; -- can be "req", "res", "data_req", and "data_res"
t["operation"]="disable"; -- can be "enable", and "disable"
HTTP:set_auto(t);
debug("disable automatic re-enabling of the HTTP_REQUEST events in script 1\n");
--you can also disable automatic re-enabling for other events, say HTTP_RESPONSE, DATA

events
}

or
when RULE_INIT priority 24 {
--This is one of the script to demo the control of multiple scripts
--please change the priority of each event according to your need
debug("INIT in script 2\n");
}
when HTTP_REQUEST priority 24 {
debug("HTTP_REQUEST in script 2\n");
--add your own manipulation here
--you can disable rest of the HTTP_REQUEST events from executing by disabling this event
t={};
t["event"]="req"; -- can be "req", "res", "data_req", and "data_res"
t["operation"]="disable"; -- can be "enable", and "disable"
HTTP:set_event(t);
debug("disable rest of the HTTP_REQUEST events in script 2\n");
--you can also disable other events, say HTTP_RESPONSE, DATA events
--in the case of keep-alive, all events will be re-enabled automatically even though they

are disabled in previous TRANSACTION using the HTTP:set_event(t) command. To disable
this automatic re-enabling behavior, you can call HTTP:set_auto(t) as below

t={};
t["event"]="req"; -- can be "req", "res", "data_req", and "data_res"
t["operation"]="disable"; -- can be "enable", and "disable"
HTTP:set_auto(t);
debug("disable automatic re-enabling of the HTTP_REQUEST events in script 2\n");
--you can also disable automatic re-enabling for other events, say HTTP_RESPONSE, DATA

events
}
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Maximum Configuration Values

Maximum configuration objects - hardware models on page 887 and Maximum configuration objects - virtual appliances
on page 892 show the maximum number of configuration objects by hardware or VMmodel. For more information
specific to your FortiADC appliance, refer to your model’sQuickStart Guide or Datasheet.

Note: The maximum number of Layer-7 virtual servers that each model supports varies, depending on the available
systemmemory and the number of features enabled on the unit.

Parameters 100F/120F/200F/22
0F

300D/400D/300F/400F/
1000F/1200F/2000F/220
0F

4000F/4200F/500-
0F

System

Administratio
n

Administrativ
e users

300 300 300

Access
profiles

16 64 64

Virtual
domains
(VDOMs)

100F/120F/200F: 2
220F: 10

300D/400D/300F/1000F/
2000F:10
400F: 20
1200F: 45
2200F: 60

90

Certificates Any
configuration
object

256 256 256

Maximum configuration objects - hardware models
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Parameters 100F/120F/200F/22
0F

300D/400D/300F/400F/
1000F/1200F/2000F/220
0F

4000F/4200F/500-
0F

Shared
Resources

Address 1024 2048 4096

Address
group

256 256 256

Health
checks

128 256 512

ISP address
book

32 32 32

Schedule 256 256 256

Schedule
group

64 64 64

Service 1024 2048 4096

Service
group

256 256 256

SNMP SNMP
community

16 16 16

SNMP
community
Host

16 16 16

SNMP user 16 16 16

Networking

Interface Physical
network
interfaces

100F/120F: 4
200F：6
220F: 8

300D/400D：4
300F：8
400F：10
1000F：21
1200F: 24
2000F：25
2200F 20

4000F: 15
4200F/5000F: 12

VLAN
interfaces

256 512 1024

Routing ARP table
entries (per
VDOM)

4096 4096 4096
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Parameters 100F/120F/200F/22
0F

300D/400D/300F/400F/
1000F/1200F/2000F/220
0F

4000F/4200F/500-
0F

Static routes 2048 4096 4096

Policy routes 64 128 256

ISP routes 32 32 32

NAT Any
configuration
object

256 256 256

QoS Any
configuration
object

256 256 256

Packet
capture

Table 5 5 5

User

Any configuration object 256 256 256

Server Load Balancing

Virtual
Servers

L4 1024 2048 4096

L7 100F/120F/200F：256
220F : 1024

300D/400D/300F/400F：5
12
1000F：1024
1200F/2000F/2200F：204
8

4096

L7 HTTPs 100F/120F/200F：128
220F: 1024

300D/400D/300F/400F：2
56
1000F/2000F：512
1200F/2200F: 2048

2048

Real Server
Pool

Pools 1024 2048 4096

Pool
members

1024 2048 4096

Real server
SSL profiles

256 256 256
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Parameters 100F/120F/200F/22
0F

300D/400D/300F/400F/
1000F/1200F/2000F/220
0F

4000F/4200F/500-
0F

Resources Profiles 256 256 256

Cache
policies

256 256 256

Compression
policies

256 256 256

Persistence
policies

128 256 512

Method
policies

64 128 256

Authenticatio
n policies

256 256 256

Scripts 256 256 256

Content
Rules

Content
routing rules

256 512 1024

Content
rewriting
rules

256 512 1024

Link Load Balancing

Link Group Gateway 1024 2048 4096

Link group 512 1024 2048

Link group
member

1024 2048 4096

Virtual
Tunnel Group

Virtual tunnel
group

512 1024 2048

Virtual tunnel
member

256 256 256

Policy LLB policy
rule

512 1024 1024

Global Load Balancing

Any configuration object 256 256 256
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Parameters 100F/120F/200F/22
0F

300D/400D/300F/400F/
1000F/1200F/2000F/220
0F

4000F/4200F/500-
0F

Security

Any configuration object 256 256 256

Log & Report

Remote Syslog Servers 3 3 3

Maximum configuration values when HW SSL acceleration is enabled

Maximum configuration values - hardware models when HW SSL acceleration is enabled on page 891 show the
maximum number of configuration objects for hardware models able to support HW SSL acceleration.

The maximum number of processes that a virtual server is able to support can be increased by enabling HW SSL
acceleration. This depends on whether the virtual server is enabled for alone mode, and which SSL hardware is
supported by each model. For virtual servers enabled for alone mode, each will be handled by a separate httproxy
process, whereas multiple virtual servers with alone mode disabled may share a single process. This may allow the
number of virtual servers disabled for alone mode be unlimited for a virtual domain for when HW SSL acceleration is
enabled.

For models that support HW SSL acceleration, they will either be compatible with the Cavium SSL or QAT SSL. For
models using QAT SSL, the maximum number of processes depends on whether polling or epoll mode is enabled.
Polling mode allows for four times the number of processes than epoll mode, however, epoll mode is higher performing.
For models using Cavium SSL, there are no restrictions on the number of processes.

Note: Since the 6.2.0 release, the default mode for QAT SSL has been changed to polling.

Parameters 400D/400F/1000F/

1200F/2000F/2200F

4000F/4200F/5000F

Virtual Servers
with alone
mode enabled

2048 4096

HW SSL
Process
Number with
QAT SSL in
polling mode

400F: 64
1200F/2200F: 192

4200F/5000F: 192

HW SSL
Process
Number with
QAT SSL in
epoll mode

400F: 16
1200F/2200F: 48

4200F/5000F: 48

Maximum configuration values - hardware models when HW SSL acceleration is
enabled
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Parameters 400D/400F/1000F/

1200F/2000F/2200F

4000F/4200F/5000F

HWSSL
Process
Number with
Cavium SSL

400D/1000F/2000F: 30720 4000F: 61440

Parameters VM01 VM02 VM04 VM08 VM16 VM32

System

Administration Administrative users 300 300 300 300 300 300

Access profiles 8 16 64 64 64 64

Virtual domains
(VDOMs)

10 10 10 10 15 20

Certificate Any configuration
object

256 256 256 256 256 256

Shared
Resources

Address 512 1024 2048 4096 4096 4096

Address group 256 256 256 256 256 256

Health checks 64 128 256 512 512 512

ISP address book 32 32 32 32 32 32

Schedule 256 256 256 256 256 256

Schedule group 64 64 64 64 64 64

Service 512 1024 2048 4096 4096 4096

Service group 256 256 256 256 256 256

SNMP SNMP community 16 16 16 16 16 16

SNMP community
host

16 16 16 16 16 16

SNMP user 16 16 16 16 16 16

Networking

Interfaces Physical network
interfaces

10 10 10 10 10 10

VLAN interfaces 128 256 512 1024 1024 1024

Routing ARP table entries (per
VDOM)

4096 4096 4096 4096 4096 4096

Maximum configuration objects - virtual appliances
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Parameters VM01 VM02 VM04 VM08 VM16 VM32

Static routes 1024 2048 4096 4096 4096 4096

Policy routes 32 64 128 256 256 256

ISP routes 32 32 32 32 32 32

NAT Any configuration
object

256 256 256 256 256 256

QoS Any configuration
object

256 256 256 256 256 256

Packet Capture Table 5 5 5 5 5 5

User

Any configuration object 256 256 256 256 256 256

Server Load Balancing

Virtual Servers L4 512 1024 2048 4096 4096 4096

L7 128 256 512 1024 1024 1024

L7 HTTPs 64 128 256 512 512 512

Real Server Pool Pools 512 1024 2048 4096 4096 4096

Pool members 512 1024 2048 4096 4096 4096

Real server SSL
profile

256 256 256 256 256 256

Resources Profiles 256 256 256 256 256 256

Cache policies 256 256 256 256 256 256

Compression policies 256 256 256 256 256 256

Persistence policies 128 128 128 256 256 256

Method policies 32 64 128 256 256 256

Authentication
policies

256 256 256 256 256 256

Scripts 256 256 256 256 256 256

Content Rules Content routing rules 128 256 512 1024 1024 1024

Content rewriting
rules

128 256 512 1024 1024 1024

Link Load Balancing
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Parameters VM01 VM02 VM04 VM08 VM16 VM32

Link Group Gateway 512 1024 2048 4096 4096 4096

Link group 256 512 1024 2048 2048 2048

Link group member 512 1024 2048 4096 4096 4096

Virtual Tunnel Virtual tunnel 256 512 1024 2048 2048 2048

Virtual tunnel member 256 256 256 256 256 256

Policy LLB policy rule 256 512 1024 2048 2048 2048

Global Load Balancing

Any configuration object 256 256 256 256 256 256

Security

Any configuration object 256 256 256 256 256 256

Log & Report

Remote Syslog Servers 3 3 3 3 3 3
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